© 2020 Veeam Software.

All rights reserved. All trademarks are the property of their respective owners.

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language in any form by any means, without written permission from Veeam Software (Veeam). The information contained in this document represents the current view of Veeam on the issue discussed as of the date of publication and is subject to change without notice. Veeam shall not be liable for technical or editorial errors or omissions contained herein. Veeam makes no warranties, express or implied, in this document. Veeam may have patents, patent applications, trademark, copyright, or other intellectual property rights covering the subject matter of this document. All other trademarks mentioned herein are the property of their respective owners. Except as expressly provided in any written license agreement from Veeam, the furnishing of this document does not give you any license to these patents, trademarks, copyrights, or other intellectual property.

NOTE:

Read the End User Software License Agreement before using the accompanying software programs. Using any part of the software indicates that you accept the terms of the End User Software License Agreement.
# Contents

**CONTACTING VEEAM SOFTWARE** .................................................................................................................. 12  
**ABOUT THIS DOCUMENT** .......................................................................................................................... 13  
**ABOUT VEEAM BACKUP & REPLICATION** .................................................................................................. 14  
**PLANNING AND PREPARATION** .................................................................................................................... 17   
  - Platform Support ................................................................................................................................. 18  
  - System Requirements ............................................................................................................................ 22  
  - Required Permissions ............................................................................................................................. 42  
  - Used Ports ............................................................................................................................................... 47  
  - Trusted Root Certificates ...................................................................................................................... 69  
  - Naming Conventions ............................................................................................................................... 70  
  - Security Considerations ......................................................................................................................... 71  
**LICENSING** .................................................................................................................................................. 73   
  - Types of Licenses .................................................................................................................................... 75  
  - Obtaining License ................................................................................................................................. 76  
  - Installing License ................................................................................................................................. 77  
  - Merging Licenses ................................................................................................................................. 79  
  - Viewing License Information ............................................................................................................... 81  
  - Revoking License ................................................................................................................................. 84  
  - Removing License ............................................................................................................................... 85  
  - Exceeding License Limit ....................................................................................................................... 87  
  - License Expiration ............................................................................................................................... 89  
  - Updating License ................................................................................................................................... 91  
    - Updating License Manually ................................................................................................................ 92  
    - Updating License Automatically ....................................................................................................... 94  
  - Automatic License Usage Reporting ................................................................................................. 97  
**GETTING TO KNOW VEEAM BACKUP & REPLICATION** ............................................................................ 98   
  - Veeam Backup & Replication UI ........................................................................................................ 99  
    - Main Menu ......................................................................................................................................... 100  
    - Navigation Pane ............................................................................................................................... 101  
    - Ribbon and Tabs ............................................................................................................................... 102  
    - Views ................................................................................................................................................... 103  
    - Working Area ..................................................................................................................................... 105  
    - Job Filter ............................................................................................................................................ 106  
    - Changing Color Theme ..................................................................................................................... 109  
  - Product Editions .................................................................................................................................... 110  
**DEPLOYMENT** .............................................................................................................................................. 111
Installing Veeam Backup & Replication ................................................................. 112
  Before You Begin ............................................................................................... 113
Upgrading to Veeam Backup & Replication 10 .................................................... 128
Uninstalling Veeam Backup & Replication .......................................................... 131
Installing Veeam Backup & Replication Console ............................................... 132
  Before You Begin ............................................................................................... 133
Installing Veeam Backup & Replication in Unattended Mode ............................. 140
  Before You Begin ............................................................................................... 141
Installation Command-Line Syntax ...................................................................... 142

BACKUP INFRASTRUCTURE .................................................................................... 163
Backup Infrastructure Components ....................................................................... 164
  Backup Server .................................................................................................. 165
  Backup & Replication Console ......................................................................... 180
  Virtualization Servers and Hosts ...................................................................... 183
  Off-Host Backup Proxy .................................................................................... 223
  File Proxy ......................................................................................................... 236
  Cache Repository ............................................................................................. 237
  Backup Repository ......................................................................................... 238
  External Repository .......................................................................................... 339
  Scale-Out Backup Repository .......................................................................... 361
  Guest Interaction Proxy .................................................................................... 418
  Gateway Server .............................................................................................. 421
  Mount Server .................................................................................................... 424
  WAN Accelerators ............................................................................................ 426
  Log Shipping Servers ....................................................................................... 427
  Tape Servers ..................................................................................................... 428
  NDMP Servers ................................................................................................. 429
  Veeam Backup Enterprise Manager ................................................................. 430

Deployment Scenarios .......................................................................................... 431
  Simple Deployment ........................................................................................... 432
  Advanced Deployment ....................................................................................... 433
  Distributed Deployment ..................................................................................... 435

Resource Scheduling ............................................................................................ 436
  Limitation of Concurrent Tasks ........................................................................ 437
  Limitation of Read and Write Data Rates for Backup Repositories ..................... 440
  Network Traffic Management .......................................................................... 441
  Performance Bottlenecks .................................................................................. 449

Locations .............................................................................................................. 451
  Creating and Assigning Locations to Infrastructure Objects ............................... 454
Editing Locations ................................................................. 456
Deleting Locations ............................................................... 457
Exporting and Importing Locations List .................................. 458
Veeam Backup & Replication Settings ........................................ 459
  Specifying I/O Settings ..................................................... 460
  Configuring Security Settings .............................................. 463
  Specifying Email Notification Settings .................................. 475
  Specifying SNMP Settings .................................................. 479
  Specifying Other Notification Settings ................................... 483
  Specifying Session History Settings ....................................... 486
Roles and Users ...................................................................... 487
Update Notification .................................................................. 489
  Installing Updates ............................................................. 491
Server Components Upgrade .................................................. 494
Logging ................................................................................. 496
  Exporting Logs .................................................................... 497
Configuration Backup and Restore .......................................... 502
  Configuration Backup ......................................................... 503
  Restoring Configuration Database ....................................... 510
  Migrating Configuration Database ....................................... 526
BACKUP ..................................................................................... 529
  About Backup ...................................................................... 530
    How Backup Works ......................................................... 531
    Backup Architecture ........................................................ 533
    Backup of VMs on Local Storage and CSV .......................... 537
    Backup of VMs on Microsoft SMB3 ...................................... 549
    Backup of VMs on Microsoft Hyper-V 2016 or Later .............. 554
    Backup Chain .................................................................... 555
    Changed Block Tracking ................................................... 585
    Data Compression and Deduplication ................................. 588
    Data Exclusion ................................................................... 591
    Microsoft Hyper-V Guest Quiescence ............................... 601
    Guest Processing ............................................................. 605
    Microsoft SQL Server Log Backup ...................................... 616
    Oracle Log Backup .......................................................... 626
    Backup Job Scheduling ..................................................... 635
    Health Check for Backup Files .......................................... 642
    Compact of Full Backup File .............................................. 648
    Resume on Disconnect ...................................................... 650
Creating Backup Jobs ........................................................................................................... 651
Before You Begin .................................................................................................................. 652
Performing Active Full Backup ............................................................................................ 689
Quick Backup ....................................................................................................................... 690
Retention Policy for Quick Backups ...................................................................................... 691
Performing Quick Backup .................................................................................................... 692
Importing Backups Manually ............................................................................................... 693
Importing Encrypted Backups ............................................................................................. 695
Importing Transaction Logs ............................................................................................... 696
Importing Backup Files from Scale-Out Backup Repositories ............................................ 697
Exporting Backups .............................................................................................................. 698
Performing Export ............................................................................................................... 699
Viewing Session Statistics .................................................................................................. 706
Managing Backups .............................................................................................................. 708
Viewing Properties ............................................................................................................. 709
Removing from Configuration ............................................................................................ 710
Deleting Backups from Disk ............................................................................................... 711
Deleting Backups from Object Storage ............................................................................. 712
Removing Missing Restore Points ...................................................................................... 713
Managing Jobs ..................................................................................................................... 716
Editing Job Settings ........................................................................................................... 717
Cloning Jobs ....................................................................................................................... 718
Disabling and Removing Jobs ............................................................................................. 720
Starting and Stopping Jobs ................................................................................................. 721
Starting and Stopping Transaction Log Backup Jobs ......................................................... 723
Reconfiguring Jobs with Microsoft SQL Server VMs .......................................................... 725
Reporting ............................................................................................................................ 726
Viewing Real-Time Statistics ............................................................................................ 727
Viewing Job Session Results .............................................................................................. 730
Viewing Job and Job Session Reports ................................................................................ 731
REPLICATION ..................................................................................................................... 732
About Replication ................................................................................................................. 733
How Replication Works ...................................................................................................... 734
Replication Architecture .................................................................................................... 736
Replication Chain ................................................................................................................ 740
VM Replica Types .............................................................................................................. 741
Changed Block Tracking ..................................................................................................... 744
Advanced Replication Technologies .................................................................................... 745
Network Mapping and Re-IP ............................................................................................... 750
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Replication Jobs</td>
<td>751</td>
</tr>
<tr>
<td>Before You Begin</td>
<td>752</td>
</tr>
<tr>
<td>Managing Replicas</td>
<td>789</td>
</tr>
<tr>
<td>Viewing Replica Properties</td>
<td>790</td>
</tr>
<tr>
<td>Recscanning Replicas</td>
<td>791</td>
</tr>
<tr>
<td>Removing from Configuration</td>
<td>792</td>
</tr>
<tr>
<td>Deleting from Disk</td>
<td>793</td>
</tr>
<tr>
<td>Replica Failover and Failback</td>
<td>794</td>
</tr>
<tr>
<td>Replica Failover</td>
<td>795</td>
</tr>
<tr>
<td>Permanent Failover</td>
<td>802</td>
</tr>
<tr>
<td>Failover Plan</td>
<td>804</td>
</tr>
<tr>
<td>Planned Failover</td>
<td>814</td>
</tr>
<tr>
<td>Undo Failover</td>
<td>820</td>
</tr>
<tr>
<td>Replica Failback</td>
<td>823</td>
</tr>
<tr>
<td>Commit Failback</td>
<td>836</td>
</tr>
<tr>
<td>Undo Failback</td>
<td>838</td>
</tr>
<tr>
<td>VEEAMZIP</td>
<td>840</td>
</tr>
<tr>
<td>Creating VeeamZIP Backups</td>
<td>841</td>
</tr>
<tr>
<td>BACKUP COPY</td>
<td>843</td>
</tr>
<tr>
<td>About Backup Copy</td>
<td>844</td>
</tr>
<tr>
<td>How Backup Copy Works</td>
<td>845</td>
</tr>
<tr>
<td>Backup Copy Architecture</td>
<td>847</td>
</tr>
<tr>
<td>Backup Copy Modes</td>
<td>849</td>
</tr>
<tr>
<td>Backup Copy Intervals</td>
<td>850</td>
</tr>
<tr>
<td>Restore Point Selection</td>
<td>853</td>
</tr>
<tr>
<td>Transformation Processes</td>
<td>854</td>
</tr>
<tr>
<td>Backup Copy Window</td>
<td>855</td>
</tr>
<tr>
<td>Retention Policy for Backup Copy Jobs</td>
<td>857</td>
</tr>
<tr>
<td>Health Check for Backup Files</td>
<td>874</td>
</tr>
<tr>
<td>Compact of Full Backup File</td>
<td>876</td>
</tr>
<tr>
<td>Backup Copy Job Mapping</td>
<td>877</td>
</tr>
<tr>
<td>Active Full Backup Copies</td>
<td>879</td>
</tr>
<tr>
<td>Automatic Job Retries</td>
<td>880</td>
</tr>
<tr>
<td>Creating Backup Copy Jobs for VMs and Physical Machines</td>
<td>882</td>
</tr>
<tr>
<td>Before You Begin</td>
<td>883</td>
</tr>
<tr>
<td>Creating Backup Copy Jobs for HPE StoreOnce Repositories</td>
<td>908</td>
</tr>
<tr>
<td>Before You Begin</td>
<td>909</td>
</tr>
<tr>
<td>Creating Backup Copy Jobs for Oracle and SAP HANA Databases</td>
<td>920</td>
</tr>
<tr>
<td>Linking Backup Jobs to Backup Copy Jobs</td>
<td>921</td>
</tr>
</tbody>
</table>
Managing Backups .................................................................................................................. 923
Viewing Backup Properties ................................................................................................... 924
Removing Backups from Target Repositories ..................................................................... 925
Removing Missing Restore Points ....................................................................................... 927
Reporting ............................................................................................................................. 930
Managing Jobs ..................................................................................................................... 931
Editing Backup Copy Jobs .................................................................................................... 932
Starting Backup Copy Jobs Manually .................................................................................... 934
Creating Active Full Backups ............................................................................................... 936
Disabling and Removing Jobs .............................................................................................. 937

FILE COPY ............................................................................................................................. 938
Creating File Copy Jobs ........................................................................................................ 939
Before You Begin .................................................................................................................. 940
Copying Files and Folders Manually .................................................................................... 948
Managing Folders ................................................................................................................ 949
Editing and Deleting Files ................................................................................................... 950

RECOVERY VERIFICATION ................................................................................................. 951
SureBackup ........................................................................................................................... 952
How SureBackup Works ....................................................................................................... 953
Backup Recovery Verification Tests ..................................................................................... 954
Application Group ................................................................................................................ 959
Virtual Lab ............................................................................................................................. 970
SureBackup Job ..................................................................................................................... 992
XML Files with VM Roles Description .................................................................................. 1016
Manual Recovery Verification ............................................................................................... 1019

ON-DEMAND SANDBOX .................................................................................................. 1020
Configuring On-Demand Sandbox ...................................................................................... 1021

DATA RECOVERY ................................................................................................................ 1023
Instant VM Recovery ............................................................................................................ 1024
Performing Instant VM Recovery of Workloads to Hyper-V VMs ...................................... 1026
Performing Instant VM Recovery of Workloads to VMware vSphere VMs ...................... 1041
Entire VM Restore ............................................................................................................... 1060
Quick Rollback ..................................................................................................................... 1061
Restoring Entire VM ............................................................................................................ 1063
VM Files Restore ................................................................................................................ 1079
Restoring VM Files .............................................................................................................. 1080
EC2 Instance and Azure VM Disk Export ............................................................................ 1087
Exporting Disks .................................................................................................................. 1088
Guest OS File Recovery ....................................................................................................... 1097
Restore from FAT, NTFS or ReFS ................................................................. 1098
Restore from Linux, Unix and Other File Systems ........................................ 1113
Restore from Other File Systems ................................................................. 1125
Viewing File Restore Session Statistics ....................................................... 1126
Application Items Restore ........................................................................... 1127
Using Veeam Explorer for Microsoft Active Directory ................................. 1128
Using Veeam Explorer for Microsoft Exchange ........................................... 1130
Using Veeam Explorer for Microsoft SharePoint ........................................... 1132
Using Veeam Explorer for Microsoft OneDrive for Business ...................... 1134
Using Veeam Explorer for Microsoft SQL Server ........................................... 1136
Using Veeam Explorer for Oracle ............................................................... 1138

RESTORE TO MICROSOFT AZURE ............................................................... 1139
How Restore to Microsoft Azure Works ....................................................... 1141
Restore Workflow ......................................................................................... 1143
Configuring Initial Settings ......................................................................... 1144
  Adding Microsoft Azure Accounts ............................................................. 1145
  Adding Microsoft Azure Stack Accounts .................................................... 1151
  Creating Custom Role for Azure Account ................................................. 1155
Configuring Helper Appliances .................................................................... 1157
Configuring Azure Proxies ......................................................................... 1163
Removing Azure Proxies ............................................................................ 1173
Restoring Machines ..................................................................................... 1174
Before You Begin ......................................................................................... 1175

RESTORE TO AMAZON EC2 ......................................................................... 1191
How Restore to Amazon EC2 Works ............................................................ 1192
AWS IAM User Permissions ......................................................................... 1194
Restoring Machines ..................................................................................... 1196
Before You Begin ......................................................................................... 1197

SECURE RESTORE ......................................................................................... 1214
How Secure Restore Works ......................................................................... 1216
Antivirus XML Configuration File ............................................................... 1217
Viewing Malware Scan Results ................................................................... 1224

STAGED RESTORE ......................................................................................... 1225

WAN ACCELERATION ..................................................................................... 1227
Global Data Deduplication ........................................................................... 1228
WAN Accelerators ......................................................................................... 1229
  How WAN Acceleration Works ................................................................. 1231
WAN Global Cache ....................................................................................... 1233
WAN Accelerator Sizing ............................................................................... 1239
Contacting Veeam Software

At Veeam Software we value feedback from our customers. It is important not only to help you quickly with your technical issues, but it is our mission to listen to your input and build products that incorporate your suggestions.

Customer Support

Should you have a technical concern, suggestion or question, visit the Veeam Customer Support Portal at www.veeam.com/support.html to open a case, search our knowledge base, reference documentation, manage your license or obtain the latest product release.

Company Contacts

For the most up-to-date information about company contacts and offices location, visit www.veeam.com/contacts.html.

Online Support

If you have any questions about Veeam products, you can use the following resources:

- Full documentation set: www.veeam.com/documentation-guides-datasheets.html
- Community forum at forums.veeam.com
About This Document

This user guide provides information about main features, installation and use of Veeam Backup & Replication in Microsoft Hyper-V environments. The document applies to version 10 and all subsequent versions until it is replaced with a new edition.

Intended Audience

The user guide is intended for anyone who wants to use Veeam Backup & Replication. It is primarily aimed at Microsoft Hyper-V administrators, consultants, analysts and any other IT professionals using the product.
About Veeam Backup & Replication

Veeam® Backup & Replication™ is a data protection and disaster recovery solution developed for virtual, physical and cloud environments.

This document contains a high-level overview of Veeam Backup & Replication, its architecture, features, and instructions on data protection and recovery operations.

In this section:

• The Mission of Veeam Backup & Replication
• Main Features
• Protected Objects
• Protected Applications
• Management and Reporting
• Service Providers

The Mission of Veeam Backup & Replication

The main goal of Veeam Backup & Replication is to be a comprehensive solution that covers main aspects of disaster recovery procedures.

Veeam Backup & Replication handles the following tasks:

• Provides a technology for image-level backup and restore operations that optimizes data transfer and resource consumption
• Maintains secure transfer and storage of backup files in various types of repositories
• Minimizes RPO and RTO
• Provides centralized management of different platform workloads (virtual, physical and cloud)
• Has an easy-to-use interface to manage backup, restore operations and all infrastructure components involved in these processes
• Automates and schedules routine data protection operations
• Provides integration with an advanced reporting and monitoring solution (Veeam One) and solutions for managing and planning enterprise environments (Veeam Backup Enterprise Manager, Veeam Availability Orchestrator, Veeam Management Pack).

Main Features

Main features of Veeam Backup & Replication include:

• Backup: creating image-level backups of virtual, physical, cloud machines and backups of NAS share files.
• Restore: various restore options for different disaster recovery scenarios.
• Replication: creating an exact copy of a VM and maintaining the copy in sync with the original VM.
• Backup Copy: copying backup files to a secondary repository.
• **Storage Systems Support**: backing up and restoring VMs using capabilities of native snapshots created on production storage systems that host VM disks.

• **Tape Devices Support**: integration with tape devices for storing copies of backups.

• **Recovery Verification**: testing VM backups and replicas before recovery.

**Protected Objects**

With Veeam Backup & Replication, you can back up and restore the following objects:

- **Virtual machines**:
  - VMware vSphere VMs
  - Microsoft Hyper-V VMs
  - Nutanix AHV VMs (requires an additional plug-in)

- **Cloud VMs**:
  - AWS EC2 instances (requires an additional plug-in)
  - Microsoft Azure VMs (requires an additional plug-in)

- **NAS share files**

- **Physical machines**:
  - Microsoft Windows
  - Linux
  - Oracle Solaris
  - IBM AIX

Physical machines are backed up using agents installed on each computer. Veeam Backup & Replication functions as a centralized console for deploying and managing agents of all supported OSes. For details, see the Veeam Agent Management Guide.

**Protected Applications**

Native functionality of Veeam Backup & Replication allows you to create application-consistent backups for:

- Microsoft SQL Server
- Oracle Database
- Active Directory
- Microsoft Exchange
- Microsoft OneDrive
- Microsoft SharePoint

Apart from application-consistent backup functionality of Veeam Backup & Replication, you can install the following additional tools:

- **Veeam Backup for Microsoft Office 365**: for full protection of Microsoft Office applications.
• **Veeam Plug-ins for Enterprise Applications:** for integration of Veeam Backup & Replication with Oracle RMAN and SAP HANA backup tools.

### Management and Reporting

Apart from its native capabilities, Veeam Backup & Replication integrates with a set of solutions that provide high-level reporting and management capabilities for enterprise environments:

- **Veeam ONE:** a solution that enables real-time monitoring, business documentation and management reporting for Veeam Backup & Replication, VMware vSphere and Microsoft Hyper-V.
- **Veeam Backup Enterprise Manager:** a management and reporting component that allows you to manage multiple Veeam Backup & Replication installations from a single web console.
- **Management Pack for Veeam Backup & Replication:** a component that integrates Veeam Backup & Replication infrastructure, services and jobs into Microsoft System Center Operations Manager.
- **Veeam Availability Orchestrator:** a solution that orchestrates disaster recovery processes in VMware vSphere environments, supports one-click recovery for critical applications and sites, and provides features for documentation and testing.

### Service Providers

If you are a service provider, you can use [Veeam Service Provider Console](#) to deliver Veeam-powered Backup-as-a-Service (BaaS) and Disaster Recovery-as-a-Service (DRaaS) services to your customers.
Planning and Preparation

Before you install Veeam Backup & Replication, you must make sure that the virtual environment and machines that you plan to use as backup infrastructure components meet product hardware recommendations and system requirements.
Platform Support

Veeam Backup & Replication provides support for the following versions of the Microsoft Hyper-V platform.

Virtual Infrastructure

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| **Platform**  | • Microsoft Windows Server Semi-Annual Channel (including version 2004)  
• Microsoft Windows Server 2019  
• Microsoft Windows Server 2016  
• Microsoft Windows Server 2012 R2  
• Microsoft Windows Server 2012  
• Microsoft Windows Server 2008 R2 SP1 |
| **Hypervisor** | • Windows Server Semi-Annual Channel (including version 2004)  
• Windows Server Hyper-V 2019  
• Windows Server Hyper-V 2016  
• Windows Server Hyper-V 2012 R2  
• Windows Server Hyper-V 2012  
• Windows Server Hyper-V 2008 R2 SP1  
• Microsoft Hyper-V Server (free hypervisor) is supported |

Microsoft Nano Server with Hyper-V role installed is not supported.

Depending on your Windows Server version, some additional hot fixes not included in the Windows Update must be installed. For more information, see this Veeam KB article.

<table>
<thead>
<tr>
<th>Management Server (optional)</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| • Microsoft PowerShell Engine 2.0 (optional, enables networkless guest processing)  
• Microsoft System Center Virtual Machine Manager 2019  
• Microsoft System Center Virtual Machine Manager 1807  
• Microsoft System Center Virtual Machine Manager 1801  
• Microsoft System Center Virtual Machine Manager 2016  
• Microsoft System Center Virtual Machine Manager 2012 R2  
• Microsoft System Center Virtual Machine Manager 2012 SP1 |


VMs

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| Hardware      | • Supported virtual hardware versions are 5.0–9.0 (valid for Hyper-V 2016–2019).  
• Both Generation 1 and 2 virtual machines are supported, including 64 TB VHDX disks.  
• Pass-through virtual disks and guest disks connected via in-guest FC or iSCSI are not supported for host-based backup. Such disks are skipped from processing automatically. If backup of these disks is required, use agent-based backup.  
• [For Hyper-V 2016–2019] VMs with pass-through virtual disks cannot be processed due to Hyper-V 2016 checkpoints limitation. |
| OS            | • All operating systems supported by Hyper-V*.  
• Application-aware processing is not supported for Microsoft Windows 2003 and Nano Server.  
• Application-aware processing for Microsoft Windows VMs with volumes larger than 64 TB is not supported**, because Veeam Backup & Replication uses the Microsoft Software Shadow Copy Provider to create a volume shadow copy during the backup or replication. For more information, see this Microsoft KB article.  
• Microsoft Windows file-level restore option is supported on NTFS, FAT, FAT32 and ReFS file systems (ReFS is supported only if Veeam Backup & Replication is installed on Microsoft Windows Server 2012 or later)  
To restore files from non-Microsoft Windows guests (Linux, Solaris, or BSD), use the Guest File Restore wizard. |
| Software      | Hyper-V integration components (required for application-aware processing). |

* You can back up VMs of Hyper-V clusters in rolling upgrade. However, Veeam Backup & Replication does not use the Resilient Changed Tracking mechanism in such scenario. To perform backup with RCT enabled, make sure your Microsoft Hyper-V environment meets these requirements. It is recommended to complete the rolling upgrade within four weeks. For more information, see Microsoft Docs.

** [For Hyper-V 2012 R2 and earlier] Backup and replication of VMs whose data resides on a Hyper-V host volume of 64 TB and larger is not supported.

File-Level Restore

<table>
<thead>
<tr>
<th>OS</th>
<th>Supported File Systems</th>
</tr>
</thead>
</table>
| Microsoft Windows | • FAT, FAT32  
• NTFS  
• ReFS (ReFS is supported only if Veeam Backup & Replication is installed on Microsoft Windows Server 2012 or later). |
Supported File Systems

<table>
<thead>
<tr>
<th>OS</th>
<th>Supported File Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td>• ext2, ext3, ext4&lt;br&gt;• ReiserFS&lt;br&gt;• JFS&lt;br&gt;• XFS&lt;br&gt;• Btrfs&lt;br&gt;DRBD (Distributed Replicated Block Devices) are not supported.</td>
</tr>
<tr>
<td>BSD</td>
<td>UFS, UFS2</td>
</tr>
<tr>
<td>Mac</td>
<td>HFS, HFS+ (volumes up to 2 TB)</td>
</tr>
<tr>
<td>Solaris</td>
<td>• UFS&lt;br&gt;• ZFS (except any pool versions of Oracle Solaris)</td>
</tr>
<tr>
<td></td>
<td>The FLR appliance uses module ZFSonLinux version 0.7.0. For this reason, Veeam Backup &amp; Replication supports only those versions of pools and features that are available in ZFSonLinux version 0.7.0.</td>
</tr>
</tbody>
</table>

Consider the following:

- You cannot restore pipes and other file system objects. File-level restore supports recovery of files and folders only.

- [For Microsoft Windows workloads] You can restore files from basic disks and dynamic disks (including simple, mirrored and striped volumes).

- [For Linux workloads] You can restore files from basic disks, Linux LVM (Logical Volume Manager) and ZFS pools. Encrypted LVM volumes are not supported.

- Backup of shared VHDX disks is limited:
  - Veeam Backup & Replication backs up shared VHDX disks in a crash-consistent state if they are registered on Microsoft Hyper-V Server 2012 R2.
  - Veeam Backup & Replication does not support processing of VMs with shared VHDX disks that are registered on Microsoft Hyper-V 2016 or later. You must change the disk format to VHD Set (VHDS).

NAS Backup Support

Veeam Backup & Replication supports backup of file shares from the following sources:

- Microsoft Windows- or Linux-managed server
- NFS file shares
- SMB file shares
Consider the following requirements and limitations:

- Only 64-bit versions of operating systems are supported for Microsoft Windows- or Linux-managed server file share.
- NFS file share must run NFS protocol version 3 or 4.1.
- Anonymous or AD/Kerberos authentication is not supported for access to file shares via NFS.
  
  In NFS settings of the source file share, you must explicitly specify what servers will have access to the file share.
- SMB file share must run on SMB version 1.x, 2.x or 3.x.
- To support the VSS for SMB File Shares feature, make sure that requirements listed in this Veeam KB article are met.
- To correctly back up SACL (Ownership) files and folders from the SMB file share and restore them:
  
  a. When you are specifying access settings for the SMB file share, select the This share requires access credentials check box.
  
  b. Make sure that the account you use to access the file share is either added to the Backup Operators group or has the SeBackupPrivilege and SeRestorePrivilege privileges in Windows Server on the file share.

For more information on NAS backup, see NAS Backup Support.

**Network**

Domain names of all managed servers added to the Veeam backup infrastructure and machines you want to back up must be resolvable into IPv4 addresses.
System Requirements

Make sure that servers that you plan to use as backup infrastructure components meet the system requirements listed below.

- Backup server
- Veeam Backup & Replication console
- Off-host backup proxy server
- File proxy server
- Backup repository server
- Cache repository
- WAN accelerator
- Backup target
- Tape server
- Tape
- Gateway server
- Mount server
- Veeam Backup Enterprise Manager
- Supported Applications
- Veeam Explorers

Limitations and Recommendations

Coexistence with Mission-Critical Production Servers

We do not recommend to install Veeam Backup & Replication and its components on mission-critical machines in the production environment such as Microsoft Hyper-V Server, Domain Controller, Microsoft Exchange Server, Small Business Server/ Windows Server Essentials and so on. If possible, install Veeam Backup & Replication and its components on dedicated machines. Backup infrastructure component roles can be co-installed.

Microsoft Windows Server Core

You can assign roles of a backup proxy, backup repository, WAN accelerator, Veeam Cloud Connect infrastructure components and tape infrastructure components to machines running Microsoft Windows Server Core.
Mind that you cannot install Veeam Backup & Replication and Veeam Backup Enterprise Manager on a machine running Microsoft Windows Server Core.
Domain Member

The machine on which you plan to install Veeam Backup & Replication does not necessarily need to be a domain member. However, if you plan to restore Microsoft Exchange items from the Veeam Backup Enterprise Manager UI, you must install Veeam Backup Enterprise Manager on the domain member server from the Microsoft Active Directory forest in which Microsoft Exchange mailboxes are located.

All-in-One Installations

For all-in-one installations, you can subtract 2 GB of memory resources from each but one role. These 2 GB are allotted to the OS itself, assuming each component is installed on the dedicated server.

NAS Backup

We recommend to allocate 4 GB RAM for each of the following NAS backup components: backup repository, file proxy, cache repository. For all-in-one installations, make sure you allocate enough memory resources for all components at the same server.

Backup Server

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware</strong></td>
<td><strong>CPU</strong>: x86-64 processor (4 cores recommended).</td>
</tr>
<tr>
<td></td>
<td><strong>Memory</strong>: 4 GB RAM plus 500 MB RAM for each concurrent job. Memory consumption varies according to number of VMs in the job, size of VM metadata, size of production infrastructure, etc.</td>
</tr>
<tr>
<td></td>
<td>Additionally, for users with tape installations (for file to tape jobs processing more than 1,000,000 files):</td>
</tr>
<tr>
<td></td>
<td>• 1.5 GB RAM for file to tape backup for each 1,000,000 files</td>
</tr>
<tr>
<td></td>
<td>• 2.6 GB RAM for file restore for each 1,000,000 files</td>
</tr>
<tr>
<td></td>
<td>• 1.3 GB RAM for catalog jobs for each 1,000,000 files</td>
</tr>
<tr>
<td></td>
<td><strong>Disk Space</strong>: 5 GB¹ for product installation and 4.5 GB for Microsoft .NET Framework 4.7.2 installation. 10 GB per 100 VM for guest file system catalog folder (persistent data).</td>
</tr>
<tr>
<td></td>
<td><strong>Network</strong>: 1 Gbps or faster for on-site backup and replication, and 1 Mbps or faster for offsite backup and replication. High latency and reasonably unstable WAN links are supported.</td>
</tr>
</tbody>
</table>

¹ Here and throughout this document GB is considered as $2^{30}$ bytes, TB as $2^{40}$ bytes.
<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| OS            | Only 64-bit version of the following operating systems are supported:\n  • Microsoft Windows Server 2019\n  • Microsoft Windows Server 2016\n  • Microsoft Windows Server 2012 R2\n  • Microsoft Windows Server 2012\n  • Microsoft Windows Server 2008 R2 SP1\n  • Microsoft Windows 10 (from version 1607 to version 2004)\n  • Microsoft Windows 8.1\n  • Microsoft Windows 7 SP1

1 Running Veeam backup server or any of Veeam backup infrastructure components on Insider versions of Microsoft Windows OS (both Client and Server) is not supported.
## Specification

### Software

During setup, the system configuration check is performed to determine if all prerequisite software is available on the machine where you plan to install Veeam Backup & Replication. If some of the required software components are missing, the setup wizard will offer you to install missing software automatically. This refers to:

- Microsoft .NET Framework 4.7.2
- Microsoft Windows Installer 4.5
- Microsoft SQL Server Management Objects
- Microsoft SQL Server System CLR Types
- Microsoft Report Viewer Redistributable 2015
- Microsoft Universal C Runtime

The following software must be installed manually:

- Microsoft PowerShell 2.0.
- Firefox, Google Chrome, Microsoft Edge, or Microsoft Internet Explorer 11.0 or later.
- RDP client version 7.0 or later installed on the backup server (required to open the VM console during SureBackup recovery verification of Microsoft Hyper-V VMs). The RDP client is pre-installed on Microsoft Windows 7/WINDOWS Server 2008 R2 OS or later. You can download the RDP client from this Microsoft KB article.

(Optional) To add SCVMM servers to Veeam Backup & Replication infrastructure, the following software is required:

- Microsoft System Center Virtual Machine Manager 2019
- Microsoft System Center Virtual Machine Manager 1807
- Microsoft System Center Virtual Machine Manager 1801
- System Center 2016 Virtual Machine Manager Admin UI (for connecting SCVMM 2016 servers)
- System Center 2012 R2 Virtual Machine Manager Admin UI (for connecting SCVMM 2012 R2 servers)
- System Center 2012 Virtual Machine Manager Admin UI (for connecting SCVMM 2012 servers)

The version of SCVMM Admin UI installed on the backup server must match the SCVMM server version. Make sure that versions of updates also match.

If you plan to install Veeam Backup & Replication in the unattended mode using the command line interface, manually install all prerequisite software before that. For more information, see Installing Veeam Backup & Replication in Unattended Mode.
<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Database</td>
<td>Local or remote installation of the following versions of Microsoft SQL Server:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2019</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2017</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2016 (Microsoft SQL Server 2016 SP2 Express Edition is included in the setup)¹</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2014</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2012 (Microsoft SQL Server 2012 SP4 Express Edition is included in the setup)²</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008</td>
</tr>
</tbody>
</table>

All editions of Microsoft SQL Server are supported. The usage of Microsoft SQL Server Express Edition is limited by the database size up to 10 Gb. If you plan to have larger databases, use other editions of Microsoft SQL Server.

Veeam Backup & Replication and Veeam Backup Enterprise Manager configuration databases can be deployed in Microsoft SQL AlwaysOn Availability Groups. For more information, see this Veeam KB article.

¹ For machines running Microsoft Windows Server 2012 or later.
² For machines running Microsoft Windows 7 or Microsoft Windows Server 2008 R2.

Mind the following:

- If you plan to back up VMs running Microsoft Windows Server 2012 R2 or later, and Data Deduplication is enabled for some VM volumes, it is recommended that you deploy the Veeam Backup & Replication console and mount server on a machine running same or later version of Microsoft Windows Server with Data Deduplication feature enabled. Otherwise, some types of restore operations for these VMs (such as Microsoft Windows File-Level Recovery) may fail.

- Due to its limitations, Microsoft SQL Server Express Edition can only be used for evaluation purposes or in case of a small-scale production environment. For environments with a lot of VMs, it is necessary to install a fully functional commercial version of Microsoft SQL Server.

For more information, see Backup Server.
# Veeam Backup & Replication Console

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| **Hardware**  | *CPU*: x86-64 processor.  
*Memory*: 2 GB RAM  
*Disk Space*: 500 MB for product installation and 4.5 GB for Microsoft .NET Framework 4.7.2 installation.  
*Network*: 1 Mbps connection to the backup server. High latency and low bandwidth impact user interface responsiveness. |
| **OS**        | Only 64-bit version of the following operating systems are supported:  
• Microsoft Windows Server 2019  
• Microsoft Windows Server 2016  
• Microsoft Windows Server 2012 R2  
• Microsoft Windows Server 2012  
• Microsoft Windows Server 2008 R2 SP1  
• Microsoft Windows 10 (from version 1607 to version 2004)  
• Microsoft Windows 8.1  
• Microsoft Windows 7 SP1 |
| **Software**  |  
• Microsoft .NET Framework 4.7.2 (included in the setup)  
• Windows Installer 4.5 (included in the setup)  
• Microsoft PowerShell 2.0  
• Firefox, Google Chrome, Microsoft Edge or Microsoft Internet Explorer 11.0 or later  
• RDP client version 7.0 or later (required to open the VM console during SureBackup recovery verification of Microsoft Hyper-V VMs). The RDP client is pre-installed on Microsoft Windows 7/Windows Server 2008 R2 05 or later. You can download the RDP client from this Microsoft KB article. |

For more information, see [Backup & Replication Console](#).
## Off-Host Backup Proxy Server

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| **Hardware**  | **CPU**: modern x86-64 processor with minimum of 2 cores (vCPUs). It is recommended to add 1 core (vCPU) for each additional concurrent task. Using faster processors improves data processing performance. For more information, see Limitation of Concurrent Tasks.  
**Memory**: 2 GB RAM plus 200 MB for each concurrent task. Using faster memory (DDR3/DDR4) improves data processing performance.  
**Disk Space**: 300 MB.  
**Network**: 1 Gbps or faster for on-site backup and replication, and 1 Mbps or faster for off-site backup and replication. High latency and reasonably unstable WAN links are supported. |
| **OS**        | The following operating systems are supported:  
- Microsoft Windows Server Semi-Annual Channel (including version 2004)  
- Microsoft Windows Server 2019  
- Microsoft Windows Server 2016  
- Microsoft Windows Server 2012 R2  
- Microsoft Windows Server 2012  
- Microsoft Windows Server 2008 R2 SP1  
The Hyper-V role must be enabled on a machine performing the role of an off-host backup proxy server.  
**Note**: Versions of a Microsoft Hyper-V host and off-host backup proxy must coincide. For example, if you use a Microsoft Windows Server 2012 machine with the Hyper-V role enabled as a Microsoft Hyper-V host, you must deploy the off-host backup proxy on a Microsoft Windows Server 2012 machine with the Hyper-V role enabled. |
| **Software**  | For off-host backup from CSV (SAN): VSS hardware provider that supports transportable shadow copies. The VSS hardware provider is typically distributed as a part of client components supplied by the storage vendor.  
Not required for off-host backup from SMB shared storage. |

For more information, see [Off-Host Backup Proxy](Off-Host Backup Proxy).
# File Proxy Server

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| **Hardware**  | *CPU:* x86-64 processor (minimum 2 cores or vCPUs). Using multi-core processors improves data processing performance and allows for more tasks to be processed concurrently.  
*Memory:* 2 GB RAM plus 200 MB for each concurrent task. Using faster memory (DDR3/DDR4) improves data processing performance.  
*Disk Space:* 300 MB.  
*Network:* High latency and reasonably unstable WAN links are supported. |
| **OS**        | 64-bit versions of the following Microsoft Windows operating systems are supported:  
- Microsoft Windows Server Semi-Annual Channel (including version 2004)  
- Microsoft Windows Server 2019  
- Microsoft Windows Server 2016  
- Microsoft Windows Server 2012 R2  
- Microsoft Windows Server 2012  
- Microsoft Windows Server 2008 R2 SP1  
- Microsoft Windows 10 (from version 1607 to version 2004)  
- Microsoft Windows 8.1  
- Microsoft Windows 7 SP1  
File proxies running Microsoft Windows Server 2012 R2 or later support the VSS for SMB File Shares feature. To use it, make sure that all requirements listed in this Veeam KB article are met. |

For more information on the file proxy, see File Proxy in NAS Backup Support.
Backup Repository Server

These requirements also apply to mount servers (if separate from the repository server), gateway servers for file share and deduplicating appliance-based repositories, and cache repository servers (64-bit OS only).

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| **Hardware**  | *CPU:* x86 processor (x86-64 recommended).  

*Memory:* 4 GB RAM, plus up to 2 GB RAM (32-bit OS) or up to 4 GB RAM (64-bit OS) for each concurrently processed machine or file share (depending on machine size, number of disks and backup chain length). For more information, see Limitation of Concurrent Tasks.

*Network:* 1 Gbps or faster for on-site backup and replication, and 1 Mbps or faster for off-site backup and replication. High latency and reasonably unstable WAN links are supported. |
| **OS**        | Both 32-bit and 64-bit (recommended) versions of the following operating systems are supported:  

- Microsoft Windows Server Semi-Annual Channel (including version 2004)  
- Microsoft Windows Server 2019  
- Microsoft Windows Server 2016  
- Microsoft Windows Server 2012 R2  
- Microsoft Windows Server 2012  
- Microsoft Windows Server 2008 R2 SP1  
- Microsoft Windows 10 (from version 1607 to version 2004)  
- Microsoft Windows 8.1  
- Microsoft Windows 7 SP1  
- Linux except Oracle Linux 5 (bash shell, SSH and Perl are required). Check the full list of required Perl modules in this Veeam KB article.  
  64-bit edition of Linux must be able to run 32-bit programs. Pure 64-bit Linux editions are not supported (Perl installation must support 32-bit variables). |

For more information, see Backup Repository.

**NOTE:**

If you plan to use a Microsoft Windows backup repository with Data Deduplication, make sure that you set up the Microsoft Windows server correctly. For more information, see this Veeam KB article.

Cache Repository

The following storage types can be used as a cache repository for NAS backup:

- Direct attached storage. You can add virtual and physical servers as cache repositories:
  - Microsoft Windows server (only 64-bit versions are supported).
- Linux server (only 64-bit versions are supported).

- Network attached storage. You can add CIFS (SMB) Share or NFS Share as a cache repository.

For system requirements of backup repository servers that can be used as a cache repository, see Backup Repository Server.

For more information on the cache repository, see Cache Repository in NAS Backup Support.

### WAN Accelerator

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| Hardware      | **CPU**: x86-64 processor. Using multi-core processors improves data processing performance, and is highly recommended on WAN links faster than 10 Mbps.  
**Memory**: 8 GB RAM. Using faster memory (DDR3/DDR4) improves data processing performance.  
**Disk Space**: Disk space requirements depend on the WAN Accelerator role. For more information, see WAN Accelerator Sizing.  
**Network**: 1 Gbps or faster for on-site backup and replication, and 1 Mbps or faster for off-site backup and replication. High latency and reasonably unstable WAN links are supported. |
| OS            | Only 64-bit versions of the following operating systems are supported:  
- Microsoft Windows Server Semi-Annual Channel (including version 2004)  
- Microsoft Windows Server 2019  
- Microsoft Windows Server 2016  
- Microsoft Windows Server 2012 R2  
- Microsoft Windows Server 2012  
- Microsoft Windows Server 2008 R2 SP1  
- Microsoft Windows 10 (from version 1607 to version 2004)  
- Microsoft Windows 8.1  
- Microsoft Windows 7 SP1 |

For more information, see WAN Accelerators.

**NOTE:**

Global cache is not leveraged by source WAN accelerators, or by WAN accelerators operating in the High bandwidth mode, so it does not need to be allocated and populated in such cases.

### Backup Target

Backups can be performed to the following disk-based storage:

- Local (internal) storage of the backup repository server.
- Direct Attached Storage (DAS) connected to the backup repository server, including external USB/eSATA drives, USB pass through and raw device mapping (RDM) volumes.

- Storage Area Network (SAN). Backup repository server must be connected into the SAN fabric via hardware or virtual HBA, or software iSCSI initiator.

- Network Attached Storage (NAS) able to present its capacity as NFS share (protocol version 3.0 and 4.1 only) or SMB/CIFS share (any protocol version). Using SMB protocol for non-continuously available (CA) file shares is not recommended for reliability reasons. NFS shares are supported both for direct operation and when mounted to a Linux repository server.

- Dell EMC Data Domain (DD OS version 6.0 to 7.1) with DDBoot license. Both Ethernet and Fibre Channel (FC) connectivity is supported.

- ExaGrid (firmware version 5.0.0 or later).

- HPE StoreOnce (firmware version 3.15.1 or later) with Catalyst license. Both Ethernet and Fibre Channel (FC) connectivity is supported.

- Quantum and OEM partners (DXi software 3.4.0 or later). Supported Quantum DXi systems include DXi4700 (NAS configuration), DXi4700 (multi-protocol configuration), DXi 4800, DXi 6900, DXi 6900-S, DXi 9000.

Once backups are created, they can be copied (for redundancy) or offloaded (for long-term retention) to one of the following object storage types using scale-out backup repository functionality:

- Amazon S3 (including AWS Snowball Edge).

- IBM Cloud Object Storage.

- Microsoft Azure Blob Storage (including Microsoft Azure Data Box).

- Any S3-compatible object storage (on-premises appliance, or cloud storage provider).

For information on NAS backup target, see Backup, Archive, Secondary Repositories in NAS Backup Support.

**Tape Server**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware</strong></td>
<td>CPU: x86 processor (x86-64 recommended).</td>
</tr>
</tbody>
</table>
|               | Memory: 2 GB RAM plus 200MB for each concurrent task. Restoring VMs directly from tape requires 400MB of RAM per 1TB of virtual disk size. Additionally (for file to tape jobs processing more than 1,000,000 files):
|               |  800 MB RAM for file to tape backup for each 1,000,000 files
<p>|               |  800 MB RAM catalog jobs for each 1,000,000 files |
|               | Disk Space: 300 MB, plus 10 GB for temporary data storage for backup and restore operations. |
|               | Network: 1 Gbps or faster. |</p>
<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OS</strong></td>
<td>Both 32-bit and 64-bit (recommended) versions of the following operating systems are supported:</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server Semi-Annual Channel (including version 2004)</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2019</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2016</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2012 R2</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2012</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows 10 (from version 1607 to version 2004)</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows 8.1</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows 7 SP1</td>
</tr>
</tbody>
</table>

**Tape**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware</strong></td>
<td>LTO3 or later tape libraries (including VTL) and standalone drives are supported. Tape device must be directly attached to the backup server, to a tape server via SAS, FC or iSCSI interface.</td>
</tr>
<tr>
<td><strong>Software</strong></td>
<td>o Tape devices without device-specific, vendor-supplied OEM drivers for Windows installed will appear in Windows Device Manager as Unknown or Generic and require enabling native SCSI commands mode.</td>
</tr>
<tr>
<td></td>
<td>o If multiple driver installation modes are available for your tape device, use the one that allows for multiple open handles from a host to a drive to exist at the same time. Usually, such drivers are referred to as &quot;non-exclusive&quot;.</td>
</tr>
<tr>
<td></td>
<td>o No other backup server must be interacting with the tape device.</td>
</tr>
</tbody>
</table>

**Gateway Server**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Platform</strong></td>
<td>Physical or virtual machine</td>
</tr>
<tr>
<td>Specification</td>
<td>Requirement</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>OS</strong></td>
<td>Both 32-bit and 64-bit versions of the following operating systems are supported:</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server Semi-Annual Channel (including version 2004)</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2019</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2016</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2012 R2</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2012</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows 10 (from version 1607 to version 2004)</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows 8.1</td>
</tr>
<tr>
<td></td>
<td>o Microsoft Windows 7 SP1</td>
</tr>
</tbody>
</table>

For more information, see [Gateway Server](#).

**Mount Server**

On the mount server machine, Veeam Backup & Replication installs the Veeam Mount Service. The Veeam Mount Service requires Microsoft .NET Framework 4.7.2. If Microsoft .NET Framework 4.7.2 is not installed on the machine, Veeam Backup & Replication will install it automatically. For more information, see [Mount Server](#).

If you plan to restore VM guest OS files from VMs running Microsoft Windows ReFS, you must install Veeam Backup & Replication components on machines running specific OS versions. For more information, see [Veeam Backup & Replication Console](#).

[For Microsoft Windows 2008R2/7] Make sure that you have SHA-2 code signing support installed. Normally, this component is included in Microsoft Windows updates. For more information, see [Microsoft Docs](#).

**Veeam Backup Enterprise Manager Server**

The machine where you plan to install Veeam Backup Enterprise Manager must meet the requirements listed in the System Requirements section of the Enterprise Manager User Guide.
## Supported Applications

You can create transactionally consistent backups or replicas of VMs that run the following applications.

<table>
<thead>
<tr>
<th>Application</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft Active Directory</strong></td>
<td>Veeam Backup &amp; Replication supports domain controller backup for the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Windows Server Semi-Annual Channel (including version 2004)</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Windows Server 2019</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Windows Server 2016</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Windows Server 2012 R2</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Windows Server 2012</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Windows Server 2008</td>
</tr>
<tr>
<td></td>
<td>Minimum supported domain and forest functional level is Windows 2003.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Microsoft Exchange</th>
<th>The following versions of Microsoft Exchange are supported:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Microsoft Exchange 2019</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Exchange 2016</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Exchange 2013 SP1</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Exchange 2013</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Exchange 2010 SP1, SP2, or SP3</td>
</tr>
<tr>
<td>Application</td>
<td>Requirement</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Microsoft SharePoint** | The following versions of Microsoft SharePoint Server (virtualized either on VMware or Hyper-V platform) are supported:  
  o Microsoft SharePoint 2019  
  o Microsoft SharePoint 2016  
  o Microsoft SharePoint 2013  
  o Microsoft SharePoint 2010  
  All editions are supported (Foundation, Standard, Enterprise). |
<table>
<thead>
<tr>
<th>Application</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server</td>
<td>The following versions of Microsoft SQL Server are supported (for application-aware processing and transaction log backup):</td>
</tr>
<tr>
<td></td>
<td>o Microsoft SQL Server 2019 (only for Windows)</td>
</tr>
<tr>
<td></td>
<td>o Microsoft SQL Server 2017 (only for Windows)</td>
</tr>
<tr>
<td></td>
<td>o Microsoft SQL Server 2016 SP2</td>
</tr>
<tr>
<td></td>
<td>o Microsoft SQL Server 2014 SP3</td>
</tr>
<tr>
<td></td>
<td>o Microsoft SQL Server 2012 SP4</td>
</tr>
<tr>
<td></td>
<td>o Microsoft SQL Server 2008 R2 SP3</td>
</tr>
<tr>
<td></td>
<td>o Microsoft SQL Server 2008 SP4</td>
</tr>
<tr>
<td></td>
<td>o Microsoft SQL Server 2005 SP4</td>
</tr>
<tr>
<td></td>
<td>All editions of Microsoft SQL Server are supported.</td>
</tr>
<tr>
<td></td>
<td>The database whose logs you want to back up must use the <em>Full</em> or <em>Bulk-logged</em> recovery model. In this case, all changes of the Microsoft SQL Server state will be written to transaction logs, and you will be able to replay transaction logs to restore the Microsoft SQL Server. You can use the Microsoft SQL Server Management Studio to switch to one of these models. For more information, see Microsoft Docs.</td>
</tr>
<tr>
<td>Application</td>
<td>Requirement</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Oracle on Windows OS</td>
<td>Veeam Backup &amp; Replication supports backup of the following Oracle Database versions:</td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 11g Release 2</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="https://oracle.com">Oracle documentation.</a></td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 12c Release 1</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="https://oracle.com">Oracle documentation.</a></td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 12c Release 2</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="https://oracle.com">Oracle documentation.</a></td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 18c</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="https://oracle.com">Oracle documentation.</a></td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 19c</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="https://oracle.com">Oracle documentation.</a></td>
</tr>
<tr>
<td>Application</td>
<td>Requirement</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Oracle on Linux OS</td>
<td>Veeam Backup &amp; Replication supports backup of the following Oracle Database versions:</td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 11g Release 2</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="#">Oracle documentation</a>.</td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 12c Release 1</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="#">Oracle documentation</a>.</td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 12c Release 2</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="#">Oracle documentation</a>.</td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 18c</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="#">Oracle documentation</a>.</td>
</tr>
<tr>
<td></td>
<td>o <strong>Oracle Database 19c</strong></td>
</tr>
<tr>
<td></td>
<td>For supported operating systems, see <a href="#">Oracle documentation</a>.</td>
</tr>
</tbody>
</table>
Oracle Database configuration

Consider the following:

- Automatic Storage Management (ASM) is supported for Oracle 11g and later; requires ASMLib present.
- Oracle Real Application Clusters (RAC) are not supported within the image-level backup functionality. Use Veeam Plug-in for Oracle RMAN. For details, see the Veeam Plug-in for Oracle RMAN section of the Veeam Plug-ins for Enterprise Applications User Guide.
- Oracle Database Express Edition is supported for Windows-based machines only.
- Configurations with different versions of Oracle Database deployed on the same server are not supported. Use Veeam Plug-in for Oracle RMAN. For details, see the Veeam Plug-in for Oracle RMAN section of the Veeam Plug-ins for Enterprise Applications User Guide.
- To create Oracle database backups, all Oracle servers that use Data Guard must be added to the backup job.
- The database must be in the ARCHIVELOG mode.
- You can use Veeam Plug-in for Oracle RMAN to forward Oracle RMAN backups to Veeam Backup & Replication repositories. For details, see the Veeam Plug-in for RMAN section of the Veeam
<table>
<thead>
<tr>
<th>Application</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Plug-ins for Enterprise Applications User Guide.</td>
</tr>
</tbody>
</table>

**NOTE:**
Consider that 32-bit Oracle running on 64-bit operating systems and Oracle XE on Linux are not supported.

**Veeam Explorers**

- Veeam Explorer for Microsoft Active Directory
- Veeam Explorer for Microsoft Exchange
- Veeam Explorer for Microsoft SharePoint
- Veeam Explorer for Microsoft SQL
- Veeam Explorer for Oracle
Required Permissions

Make sure that user accounts that you plan to use have permissions described in the following sections:

- Installing and Using Veeam Backup & Replication
- Using Virtualization Servers and Hosts
- Performing Guest Processing
- Using Amazon S3 Object Storage

Installing and Using Veeam Backup & Replication

The accounts used for installing and using Veeam Backup & Replication must have the following permissions.

<table>
<thead>
<tr>
<th>Account</th>
<th>Required Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Account</td>
<td>The account used for product installation must have the local Administrator permissions on the target machine.</td>
</tr>
</tbody>
</table>
| Veeam Backup & Replication Console Permissions | The account used to start the Veeam Backup & Replication console must have the local Administrator permissions on the machine where the console is installed.  
    To perform file-level restore for Microsoft Windows VMs, the account must have the following permissions and privileges:  
    - Local Administrator permissions to start the Veeam Backup & Replication console  
    - SeBackupPrivilege and SeRestorePrivilege to connect to the Veeam backup server and start the restore process  
    In most environments, SeBackupPrivilege and SeRestorePrivilege are assigned to user accounts added to the Administrators group. For more information, see Microsoft Docs.  
    Accounts that are members of the Protected Users Active Directory group cannot be used to access the backup server remotely over the Veeam Backup & Replication console. For more information, see Microsoft Docs. |
| Veeam Backup Service Account           | The account used to run the Veeam Backup Service must be a LocalSystem account or must have the local Administrator permissions on the backup server.     |
### Microsoft SQL Server (where the configuration database is stored)

You require different sets of Microsoft SQL permissions in the following cases:

- **Installation (remote or local):** current account needs CREATE ANY DATABASE permission on the SQL server level. After database creation this account automatically gets a `db_owner` role and can perform all operations with the database. If the current account does not have this permission, a Database Administrator may create an empty database in advance and grant the `db_owner` role to the account that will be used for installing Veeam Backup & Replication.

- **Upgrade:** current account should have sufficient permissions for that database. To grant these permissions through role assignment, it is recommended that you use the account with `db_owner` role.

- **Operation:** the account used to run Veeam Backup Service requires `db_datareader` and `db_datawriter` roles as well as permissions to execute stored procedures for the configuration database on the Microsoft SQL Server. Alternatively, you can assign `db_owner` role for this database to the service account.

---

### Using Virtualization Servers and Hosts

The following are required permissions to work with virtualization servers and hosts during data protection tasks.

<table>
<thead>
<tr>
<th>Role</th>
<th>Required Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source/Target Host, SCVMM or cluster</strong></td>
<td>SCVMM Administrator permissions.</td>
</tr>
<tr>
<td><strong>Linux Backup Repository</strong></td>
<td>Root or equivalent permissions.</td>
</tr>
<tr>
<td><strong>SMB Backup Repository</strong></td>
<td>Write permission on the target folder and share.</td>
</tr>
</tbody>
</table>

### Performing Guest Processing

To create transactionally consistent backups using guest OS processing, make sure to configure your accounts according to the requirements listed in this section. For more information about guest processing, see [Guest Processing](#).

All user accounts used for guest processing must have the following permissions:

- *Logon as a batch job* granted
• **Deny logon as a batch job** not set

Other permissions depend on applications that you back up. You can find permissions for backup operations in the following table. For restore operation permissions, see **Required Permissions** sections in the Veeam Explorers User Guide.

<table>
<thead>
<tr>
<th>Application</th>
<th>Required Permission</th>
</tr>
</thead>
</table>
| **Microsoft SQL Server** | To back up Microsoft SQL Server data, the following roles must be assigned:  
  - Administrator role on the target VM.  
  - Sysadmin role on the target Microsoft SQL Server.  
  If you need to provide minimal permissions, the account must be assigned the following roles and permissions:  
  - SQL Server instance-level role: public and dbcreator.  
  - Database-level roles: db_backupoperator, db_denydatareader, public; for system databases (master, model, msdb) – db_backupoperator, db_datareader, public; for system database (msdb) – db_datawriter.  
  - Securables: view any definition, view server state. |
| **Microsoft Active Directory** | To back up Microsoft Active Directory data, the account must be a member of the Domain Admins group. |
| **Microsoft Exchange** | To back up Microsoft Exchange data, the account must have the local Administrator permissions on the machine where Microsoft Exchange is installed. |
| **Oracle** | The account specified at the **Specify Guest Processing Settings** step must be configured as follows:  
  - For a Windows-based VM, the account must be a member of both the Local Administrator group and the ORA_DBA group (if OS authentication is used). In addition, if ASM is used, then such an account must be a member of the ORA_ASMADMIN group (for Oracle 12 and higher).  
  - For a Linux-based VM, the account must be a Linux user elevated to root.  
  To back up Oracle databases, make sure the account specified on the Oracle tab has been granted SYSDBA privileges. You can use either the same account that was specified at the **Specify Guest Processing Settings** step if such an account is a member of the ORA_DBA group for a Windows-based VM and OSASM, OSDBA and OINSTALL groups for a Linux-based VM, or you can use, for example, the SYSOracle account or any other Oracle account that has been granted SYSDBA privileges. |
| **Microsoft SharePoint** | To back up Microsoft SharePoint server, the account must be assigned the Farm Administrator role.  
  To back up Microsoft SQL databases of the Microsoft SharePoint Server, the account must have the same privileges as that of Veeam Explorer for Microsoft SQL Server. |
Consider the following general requirements when choosing a user account for transactionally consistent backups:

- When using Active Directory accounts, make sure to provide an account in the `DOMAIN\Username` format.
- When using local user accounts, make sure to provide an account in the `Username or HOST\Username` format.
- To process a Domain Controller server, make sure that you are using an account that is a member of the `DOMAIN\Administrators` group.
- To back up a Read-Only Domain controller, a delegated RODC administrator account is sufficient. For more information, see this Microsoft article.

### Using Amazon S3 Object Storage

The following are required permissions to use Amazon S3 object storage with immutability disabled.

**NOTE:**
Make sure the account you are using has access to Amazon buckets and folders.

```
{  
  "s3:ListBucket",
  "s3:GetBucketLocation",
  "s3:GetObject",
  "s3:PutObject",
  "s3:DeleteObject",
  "s3:ListAllMyBuckets",
  "s3:HeadBucket",
  "s3:GetBucketVersioning",
  "s3:GetBucketObjectLockConfiguration"
}
```

The following are required permissions to use Amazon S3 object storage with immutability enabled. For more information on immutability, see Immutability.

```
{  
  "s3:ListBucket",
  "s3:GetBucketLocation",
  "s3:GetObject",
  "s3:PutObject",
  "s3:DeleteObject",
  "s3:ListAllMyBuckets",
  "s3:HeadBucket",
  "s3:GetBucketVersioning",
  "s3:GetBucketObjectLockConfiguration",
  "s3:ListBucketVersions",
  "s3:GetObjectVersion",
  "s3:GetObjectRetention",
  "s3:GetObjectLegalHold",
  "s3:PutObjectRetention",
  "s3:PutObjectLegalHold",
  "s3:DeleteObjectVersion"
}
```
For examples, see this Veeam KB article. For more information on permissions, see this Amazon article.
Used Ports

On backup infrastructure components, Veeam Backup & Replication automatically creates firewall rules for the required ports. These rules allow communication between the components.

**IMPORTANT!**

Some Linux distributions require firewall and/or security rules to be created manually. For details, see this Veeam KB article.

You can find the full list of the ports below.

Backup Server Connections

The following table describes network ports that must be opened to ensure proper communication of the backup server with backup infrastructure components.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtualization Servers</td>
<td></td>
<td>WCF</td>
<td>8100</td>
<td>Default VMM Administrator Console to VMM server port required by the Veeam Backup Management.</td>
</tr>
<tr>
<td>SCVMM</td>
<td>TCP</td>
<td></td>
<td>8732</td>
<td>Port used as the control channel to the SCVMM server. This port must be opened on the backup server only.</td>
</tr>
<tr>
<td>Backup server</td>
<td>TCP</td>
<td></td>
<td>135, 137 to 139, 445</td>
<td>Ports required for deploying Veeam Backup &amp; Replication components.</td>
</tr>
<tr>
<td>Microsoft Hyper-V server</td>
<td>UDP</td>
<td></td>
<td>6160</td>
<td>Default port used by the Veeam Installer Service.</td>
</tr>
<tr>
<td></td>
<td>TCP</td>
<td></td>
<td>6162</td>
<td>Default port used by the Veeam Data Mover Service.</td>
</tr>
<tr>
<td></td>
<td>TCP</td>
<td></td>
<td>6163</td>
<td>Default port used to communicate with Veeam Hyper-V Integration Service.</td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>----</td>
<td>----------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as transmission channels for jobs. For every TCP connection that a job uses, one port from this range is assigned.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>49152 to 65535 (for Microsoft Windows 2008 and newer)</td>
<td>Dynamic port range. For more information, see this Microsoft KB article.</td>
</tr>
</tbody>
</table>

**Other Servers**

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>Microsoft SQL Server hosting the Veeam Backup &amp; Replication configuration database</td>
<td>TCP</td>
<td>1433</td>
<td>Port used for communication with Microsoft SQL Server on which the Veeam Backup &amp; Replication configuration database is deployed (if you use a Microsoft SQL Server default instance). Additional ports may need to be open depending on your configuration. For more information, see Microsoft Docs.</td>
</tr>
<tr>
<td></td>
<td>DNS server with forward/reverse name resolution of all backup servers</td>
<td>UDP</td>
<td>53</td>
<td>Port used for communication with the DNS Server.</td>
</tr>
<tr>
<td></td>
<td>Veeam Update Notification Server (dev.veeam.com)</td>
<td>TCP</td>
<td>80</td>
<td>Default port used to download information about available updates from the Veeam Update Notification Server over the Internet.</td>
</tr>
<tr>
<td></td>
<td>Veeam License Update Server (autolk.veeam.com)</td>
<td>TCP</td>
<td>443</td>
<td>Default port used for license auto-update.</td>
</tr>
</tbody>
</table>
### Backup server

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>Backup server</td>
<td>TCP</td>
<td>9501</td>
<td>Port used locally on the backup server for communication between Veeam Broker Service and Veeam services and components.</td>
</tr>
</tbody>
</table>

### Remote Access

#### Management client PC (remote access)

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management client PC (remote access)</td>
<td>Backup server</td>
<td>TCP</td>
<td>3389</td>
<td>Default port used by the Remote Desktop Services. If you use third-party solutions to connect to the backup server, other ports may need to be open.</td>
</tr>
</tbody>
</table>

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.

---

### Veeam Backup & Replication Console Connections

The following table describes network ports that must be opened to ensure proper communication with the Veeam Backup & Replication console installed remotely.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veeam Backup &amp; Replication Console</td>
<td>Backup server</td>
<td>TCP</td>
<td>9392</td>
<td>Port used by the Veeam Backup &amp; Replication console to connect to the backup server.</td>
</tr>
<tr>
<td>Veeam Backup &amp; Replication Console</td>
<td>Backup server</td>
<td>TCP</td>
<td>10003</td>
<td>Port used by the Veeam Backup &amp; Replication console to connect to the backup server only when managing the Veeam Cloud Connect infrastructure.</td>
</tr>
<tr>
<td>Veeam Backup &amp; Replication Console</td>
<td>Backup server</td>
<td>TCP</td>
<td>9396</td>
<td>Port used by the Veeam.Backup.UIService process for managing database connections.</td>
</tr>
</tbody>
</table>
## Microsoft Windows Server Connections

The following table describes network ports that must be opened to ensure proper communication with Microsoft Windows servers.

Each Microsoft Windows server that is a backup infrastructure component or a machine for which you enable application-aware processing must have these ports opened. If you want to use the server as a backup infrastructure component, you must also open ports that the component role requires.

For example, if you assign the role of a backup proxy to your Microsoft Windows server, you must open ports listed below and also ports listed in the Backup Proxy Connections section.

The Microsoft Windows server that acts as an SMB file share requires only network ports listed below. The Microsoft Windows server that acts as an NFS file share requires network ports listed below and also ports listed in the NFS Repository Connections.

### Microsoft Windows Server Connections Table

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veeam Backup &amp; Replication Console</td>
<td>Mount server (if the mount server is not located on the console)</td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as data transmission channels. For every TCP connection that a job uses, one port from this range is assigned.</td>
</tr>
</tbody>
</table>

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.

**Microsoft Windows Server Connections**

The following table describes network ports that must be opened to ensure proper communication with Microsoft Windows servers.

Each Microsoft Windows server that is a backup infrastructure component or a machine for which you enable application-aware processing must have these ports opened. If you want to use the server as a backup infrastructure component, you must also open ports that the component role requires.

For example, if you assign the role of a backup proxy to your Microsoft Windows server, you must open ports listed below and also ports listed in the Backup Proxy Connections section.

The Microsoft Windows server that acts as an SMB file share requires only network ports listed below. The Microsoft Windows server that acts as an NFS file share requires network ports listed below and also ports listed in the NFS Repository Connections.

### Microsoft Windows Server Connections Table

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td></td>
<td>TCP</td>
<td>135, 137 to 139, 445</td>
<td>Ports required for deploying Veeam Backup &amp; Replication components.</td>
</tr>
<tr>
<td>Backup repository</td>
<td></td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as data transmission channels and for collecting log files. For every TCP connection that a job uses, one port from this range is assigned.</td>
</tr>
</tbody>
</table>

Default port used by the Veeam Installer Service.
<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Gateway server</strong></td>
<td>TCP</td>
<td>6162</td>
<td></td>
<td>Default port used by the Veeam Data Mover Service.</td>
</tr>
<tr>
<td><strong>Mount server</strong></td>
<td>TCP</td>
<td>49152 to 65535 (for Microsoft Windows 2008 and newer)</td>
<td>Dynamic port range. For more information, see this Microsoft KB article.</td>
<td></td>
</tr>
<tr>
<td><strong>WAN accelerator</strong></td>
<td>TCP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Tape server</strong></td>
<td>TCP</td>
<td>6160</td>
<td></td>
<td>Default port used by the Veeam Installer Service.</td>
</tr>
<tr>
<td><strong>Backup server</strong></td>
<td>SMB3 server</td>
<td>TCP</td>
<td>6160</td>
<td>Default port used by the Veeam Installer Service.</td>
</tr>
<tr>
<td></td>
<td>TCP</td>
<td>6162</td>
<td></td>
<td>Default port used by the Veeam Data Mover Service.</td>
</tr>
</tbody>
</table>

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.

### Linux Server Connections

The following table describes network ports that must be opened to ensure proper communication with Linux servers.

Each Linux server that is a **backup infrastructure component** or a machine for which you enable **application-aware processing** must have these ports opened. If you want to use the server as a backup infrastructure component, you must also open ports that the component role requires.

For example, if you assign the role of a backup repository to your Linux server, you must open ports listed below and also ports listed in the **Backup Repository Connections** section.

The Linux server that acts as an SMB file share requires only network ports listed below. The Linux server that acts as an NFS file share requires network ports listed below and also ports listed in the **NFS Repository Connections**.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup server</strong></td>
<td>Linux server</td>
<td>TCP</td>
<td>22</td>
<td>Port used as a control channel from the console to the target Linux host.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as data transmission channels. For every TCP connection that a job uses, one port from this range is assigned.</td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------</td>
<td>----------</td>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Linux server</td>
<td>Backup server</td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as data transmission channels. For every TCP connection that a job uses, one port from this range is assigned.</td>
</tr>
</tbody>
</table>

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.

## Backup Proxy Connections

The following table describes network ports that must be opened to ensure proper communication of backup proxies with other backup components. File proxies in NAS backup use the same network ports as backup proxies.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>Off-host backup proxy</td>
<td>Off-host</td>
<td>TCP 6163</td>
<td>Default port used by the Hyper-V Integration Service.</td>
</tr>
<tr>
<td>Backup server</td>
<td>SMB3 server</td>
<td>TCP</td>
<td>6163</td>
<td>Default port used by the Hyper-V Integration Service.</td>
</tr>
<tr>
<td>Backup server</td>
<td>Off-host file proxy</td>
<td>TCP</td>
<td>6210</td>
<td>Default port used by the Veeam Backup VSS Integration Service for taking a VSS snapshot during the SMB file share backup.</td>
</tr>
</tbody>
</table>

## Communication with Backup Repositories

| Hyper-V server/ Off-host backup proxy | Microsoft Windows server | TCP | 49152 to 65535 (for Microsoft Windows 2008 and newer) | Dynamic port range. For more information, see this Microsoft KB article.                                                                 |

---
<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared folder CIFS (SMB) share</td>
<td>Backup proxy (onhost or offhost)</td>
<td>TCP</td>
<td>135, 137 to 139, 445</td>
<td>Ports used as a transmission channel from the backup proxy to the target CIFS (SMB) share.</td>
</tr>
<tr>
<td>Gateway server</td>
<td>Gateway server</td>
<td>TCP</td>
<td>49152 to 65535 (for Microsoft Windows 2008 and newer)</td>
<td>Dynamic port range. For more information, see this Microsoft KB article.</td>
</tr>
</tbody>
</table>

Communication with Backup Proxies

**Hyper-V server**
- Backup proxy (onhost or offhost)
  - Protocol: TCP
  - Port: 2500 to 3300*
  - Default range of ports used as transmission channels for replication jobs. For every TCP connection that a job uses, one port from this range is assigned.

**Microsoft SMB3 server**
- Backup proxy (onhost or offhost)
  - Protocol: TCP
  - Port: 2500 to 3300*
  - Ports used to retrieve CBT information from a Microsoft SMB3 server managing shares that host VM disks.

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.

Backup Repository Connections

The following table describes network ports that must be opened to ensure proper communication with backup repositories. Cache repositories in NAS backup use the same network ports as backup repositories.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hyper-V server/ Off-host backup proxy</td>
<td>Microsoft Windows server performing the role of the backup repository</td>
<td></td>
<td>Ports listed in Microsoft Windows Server Connections must be opened.</td>
<td></td>
</tr>
</tbody>
</table>
### NFS Repository Connections

The following table describes network ports that must be opened to ensure proper communication with NFS shares added as backup repositories.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NFS backup repository</strong></td>
<td>Gateway server (Microsoft Windows/Linux)</td>
<td>TCP UDP</td>
<td>2049</td>
<td>Default NFS port.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP UDP</td>
<td>111</td>
<td>Port used for rpcbind service.</td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>----</td>
<td>----------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>NFS backup repository (for repositories supporting NFS protocol version 3)</td>
<td>Gateway server (Microsoft Windows/Linux)</td>
<td>TCP</td>
<td>mountd_port</td>
<td>Dynamic port used for mountd service. Can be assigned statically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UDP</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>statd_port</td>
<td>Dynamic port used for statd service. Can be assigned statically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UDP</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>lockd_port</td>
<td>Dynamic TCP port used for lockd service. Can be assigned statically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UDP</td>
<td>lockd_port</td>
<td>Dynamic UDP port used for lockd service. Can be assigned statically.</td>
</tr>
<tr>
<td>Microsoft Windows server performing the role of the gateway server</td>
<td>NFS repository</td>
<td>Ports listed in Microsoft Windows Server Connections must be opened.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linux server performing the role of the gateway server</td>
<td>NFS repository</td>
<td>Ports listed in Linux Server Connections must be opened.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gateway server (specified in the NFS repository settings)</td>
<td>NFS repository</td>
<td>TCP</td>
<td>111, 2049</td>
<td>Standard NFS ports used as a transmission channel from the gateway server to the target NFS share.</td>
</tr>
</tbody>
</table>

### Object Storage Repository Connections

The following table describes network ports and endpoints that must be opened to ensure proper communication with object storage repositories.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port/Endpoint</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>443</td>
<td></td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port/Endpoint</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------</td>
<td>----------</td>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Gateway server</td>
<td>Amazon S3 Object Storage</td>
<td>HTTPS</td>
<td>*amazonaws.com (for both <em>Global</em> and <em>Government</em> regions)</td>
<td>Cloud endpoints:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>*amazonaws.com.cn (for <em>China</em> region)</td>
<td>- *.amazonaws.com (for both <em>Global</em> and <em>Government</em> regions)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- *.amazonaws.com.cn (for <em>China</em> region)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>A complete list of connection endpoints can be found in <a href="https://aws.amazon.com">this Amazon article</a>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- *.amazontrust.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>443</td>
<td>Used to communicate with Amazon S3 Object Storage.</td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port/Endpoint</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Microsoft Azure Object Storage</td>
<td></td>
<td>HTTPS</td>
<td><strong>Cloud endpoints:</strong></td>
<td><strong>Used to communicate with Microsoft Azure Object Storage.</strong> Consider the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• xxx.blob.core.windows.net (for <em>Global</em> region)</td>
<td>• The &lt;xxx&gt; part of the address must be replaced with your actual storage account URL, which can be found in the Azure management portal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• xxx.blob.core.chinacloudapi.cn (for <em>China</em> region)</td>
<td>• Certificate verification endpoints (CRL URLs and OCSP servers) are subject to change. The actual list of addresses can be found in the certificate itself.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• xxx.blob.core.cloudapi.de (for <em>Germany</em> region)</td>
<td>• The *.d-trust.net endpoint is used for the <em>Germany</em> region only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• xxx.blob.core.usgovcloudapi.net (for <em>Government</em> region)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Certificate verification endpoints:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• ocsp.digicert.com</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• ocsp.msocsp.com</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• *.d-trust.net</td>
<td></td>
</tr>
<tr>
<td>IBM Cloud Object Storage</td>
<td>TCP/HTTPS</td>
<td>Customizable and depends on device configuration</td>
<td><strong>Used to communicate with IBM Cloud Object Storage.</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Dell EMC Data Domain System Connections

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server or Gateway server</td>
<td>Dell EMC Data Domain</td>
<td>TCP</td>
<td>111</td>
<td>Port used to assign a random port for the mountd service used by NFS and DDBOOST. Mountd service port can be statically assigned.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>2049</td>
<td>Main port used by NFS. Can be modified via the 'nfs set server-port' command. Command requires SE mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>2052</td>
<td>Main port used by NFS MOUNTD. Can be modified via the 'nfs set mountd-port' command in SE mode.</td>
</tr>
<tr>
<td>Backup server</td>
<td>Gateway server</td>
<td>Ports listed in Gateway Server Connections must be opened.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For more information, see Dell EMC Documents.

### HPE StoreOnce Connections

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server or Gateway server</td>
<td>HPE StoreOnce</td>
<td>TCP</td>
<td>9387</td>
<td>Default command port used for communication with HPE StoreOnce.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9388</td>
<td>Default data port used for communication with HPE StoreOnce.</td>
</tr>
<tr>
<td>Backup server</td>
<td>Gateway server</td>
<td>Ports listed in Gateway Server Connections must be opened.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Gateway Server Connections

The following table describes network ports that must be opened to ensure proper communication with gateway servers.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup server</strong></td>
<td>Microsoft Windows server performing the role of the gateway server</td>
<td>Ports listed in Microsoft Windows Server Connections must be opened.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Backup server</strong></td>
<td>Linux server performing the role of the gateway server (if a gateway server is specified explicitly in NFS backup repository settings)</td>
<td>Ports listed in Linux Server Connections must be opened.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Gateway server</strong> (if a gateway server is specified explicitly in CIFS (SMB) backup repository settings)</td>
<td>Shared folder CIFS (SMB) share</td>
<td>TCP UDP</td>
<td>135, 137 to 139, 445</td>
<td>Ports used as a transmission channel from a gateway server to the target CIFS (SMB) share.</td>
</tr>
</tbody>
</table>

Mount Server Connections

The following table describes network ports that must be opened to ensure proper communication with mount servers.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup server</strong></td>
<td>Mount server</td>
<td>Mount server is a Microsoft Windows server, and it requires the ports listed in Microsoft Windows Server Connections to be opened.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

59 | Veeam Backup & Replication | User Guide for Microsoft Hyper-V |
<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mount server (or machine running the Veeam Backup &amp; Replication console)</td>
<td>Backup server</td>
<td>TCP</td>
<td>6170</td>
<td>Port used for communication with a local or remote Mount Service.</td>
</tr>
<tr>
<td>Mount server (or machine running the Veeam Backup &amp; Replication console)</td>
<td>Backup repository</td>
<td>TCP</td>
<td>9401</td>
<td>Port used for communication with the Veeam Backup Service.</td>
</tr>
<tr>
<td>Mount server</td>
<td>Helper appliance</td>
<td>TCP</td>
<td>22</td>
<td>Default SSH port used as a control channel.</td>
</tr>
<tr>
<td>Mount server</td>
<td>VM guest OS</td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used for communicating with the appliance.</td>
</tr>
</tbody>
</table>

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.

Proxy Appliance (Multi-OS FLR) Connections

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>Helper appliance</td>
<td>TCP</td>
<td>22</td>
<td>Port used as a communication channel from the backup server to the proxy appliance in the multi-OS file-level recovery process.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as data transmission channels. For every TCP connection that a job uses, one port from this range is assigned.</td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------</td>
<td>----------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VM guest OS</td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as data transmission channels. For every TCP connection that a job uses, one port from this range is assigned.</td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td>22</td>
<td></td>
<td>Port used as a communication channel from the proxy appliance to the Linux guest OS during multi-OS file-level recovery process.</td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td>20</td>
<td></td>
<td>[If FTP option is used] Default port used for data transfer.</td>
<td></td>
</tr>
<tr>
<td>VM guest OS</td>
<td>Helper appliance</td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as data transmission channels. For every TCP connection that a job uses, one port from this range is assigned.</td>
</tr>
<tr>
<td>TCP</td>
<td>22</td>
<td></td>
<td>Port used as a communication channel from the proxy appliance to Linux guest OS during multi-OS file-level recovery process.</td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td>21</td>
<td></td>
<td>[If FTP option is used] Default port used for protocol control messages.</td>
<td></td>
</tr>
<tr>
<td>Helper appliance</td>
<td>Backup repository</td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used as data transmission channels. For every TCP connection that a job uses, one port from this range is assigned.</td>
</tr>
</tbody>
</table>

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.
### WAN Accelerator Connections

The following table describes network ports that must be opened to ensure proper communication between WAN accelerators used in backup copy jobs and replication jobs.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>WAN accelerator (source and target)</td>
<td>TCP</td>
<td>6160</td>
<td>Default port used by the Veeam Installer Service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>6162</td>
<td>Default port used by the Veeam Data Mover Service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>6164</td>
<td>Controlling port for RPC calls.</td>
</tr>
<tr>
<td>WAN accelerator (source and target)</td>
<td>Backup repository (source and target)</td>
<td>TCP</td>
<td>2500 to 3300*</td>
<td>Default range of ports used by the Veeam Data Mover Service for transferring files of a small size such as GuestIndexData.zip and others. A port from the range is selected dynamically.</td>
</tr>
<tr>
<td>WAN accelerator</td>
<td>WAN accelerator</td>
<td>TCP</td>
<td>6164</td>
<td>Controlling port for RPC calls.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TCP</td>
<td>6165</td>
<td>Default port used for data transfer between WAN accelerators. Ensure this port is open in firewall between sites where WAN accelerators are deployed.</td>
</tr>
</tbody>
</table>

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.

### Tape Server Connections

The following table describes network ports that must be opened to ensure proper communication with tape servers.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>Tape server</td>
<td>Tape server is a Microsoft Windows server, and it requires the ports listed in Microsoft Windows Server Connections to be opened.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>----</td>
<td>----------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>TCP</td>
<td>6166</td>
<td>Controlling port for RPC calls.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td>2500 to 3000*</td>
<td>Default range of ports used as data transmission channels. For every TCP connection that a job uses, one port from this range is assigned.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tape server

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tape server</td>
<td>Backup repository, gateway server or proxy server</td>
<td>TCP</td>
<td>6166</td>
<td>Controlling port for RPC calls.</td>
</tr>
<tr>
<td>Tape server</td>
<td>Tape server is a Microsoft Windows server, and it requires the ports listed in Microsoft Windows Server Connections to be opened.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.

### NDMP Server Connections

The following table describes network ports that must be opened to ensure proper communication with NDMP servers.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway server</td>
<td>NDMP server</td>
<td>NDMP</td>
<td>10000</td>
<td>Port used for data transfer between the components.</td>
</tr>
</tbody>
</table>

### VM Guest OS Connections

The following table describes network ports that must be opened to ensure proper communication of the backup server with the runtime coordination process deployed inside the VM guest OS for application-aware processing and indexing.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>Linux VM guest OS</td>
<td>TCP</td>
<td>22</td>
<td>Default SSH port used as a control channel.</td>
</tr>
<tr>
<td>Backup server</td>
<td>TCP</td>
<td>6190</td>
<td>Port used for communication with the guest interaction proxy.</td>
<td></td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>----</td>
<td>----------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>Guest interaction proxy</td>
<td>TCP</td>
<td>6290</td>
<td>Port used as a control channel for communication with the guest interaction proxy.</td>
<td></td>
</tr>
<tr>
<td>Guest interaction proxy or Mount server</td>
<td>TCP, UDP</td>
<td>137 to 139, 445</td>
<td>Ports used as a transmission channel.</td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows VM guest OS</td>
<td>TCP, UDP</td>
<td>135, 137 to 139, 445</td>
<td>Ports required to deploy the runtime coordination process on the VM guest OS.</td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td>49152 to 65535 (for Microsoft Windows 2008 and newer)</td>
<td>Dynamic port range used by the runtime process deployed inside the VM for guest OS interaction.*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For more information, see <a href="#">this Microsoft KB article</a>.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td>6167, 2500 to 3300**</td>
<td>[For Microsoft SQL logs shipping] Port used by the runtime process on the VM guest OS from which Microsoft SQL logs are collected.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linux VM guest OS</td>
<td>TCP</td>
<td>22</td>
<td>Default SSH port used as a control channel.</td>
<td></td>
</tr>
<tr>
<td>TCP</td>
<td>2500 to 3300**</td>
<td>Default range of ports used as transmission channels during Linux file-level recovery and for Oracle log backup.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For every TCP connection that a job uses, one port from this range is assigned.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* If you use default Microsoft Windows firewall settings, you do not need to configure dynamic RPC ports: during setup, Veeam Backup & Replication automatically creates a firewall rule for the runtime process. If you use firewall settings other than default ones or application-aware processing fails with the "RPC function call failed" error, you need to configure dynamic RPC ports. For more information on how to configure RPC dynamic port allocation to work with firewalls, see [this Microsoft KB article](#).

** This range of ports applies to newly added backup infrastructure components. If you upgrade to Veeam Backup & Replication 10.0 from earlier versions of the product, the range of ports from 2500 to 5000 applies to the already added components.
## Veeam U-AIR Connections

The following table describes network ports that must be opened to ensure proper communication of U-AIR wizards with other components.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>U-AIR wizards</td>
<td>Veeam Backup Enterprise Manager</td>
<td>TCP</td>
<td>9394</td>
<td>Default port used for communication with Veeam Backup Enterprise Manager. Can be customized during Veeam Backup Enterprise Manager installation.</td>
</tr>
</tbody>
</table>

## Azure Proxy Connections

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server/Backup repository</td>
<td>Azure proxy</td>
<td>TCP</td>
<td>443</td>
<td>Default management and data transport port required for communication with the Azure proxy. The port must be opened on the backup server and backup repository storing VM backups. The default port is 443, but you can change it in the settings of the Azure Proxy. For details, see Specify Credentials and Transport Port</td>
</tr>
</tbody>
</table>

## Azure Stack Connections

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>Azure Stack</td>
<td>HTTPS</td>
<td>443, 30024</td>
<td>Default management and data transport port required for communication with the Azure Stack.</td>
</tr>
</tbody>
</table>

## Proxy Appliance Connections (Restore to Amazon EC2)

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server/Backup Repository</td>
<td>Proxy appliance</td>
<td>TCP</td>
<td>22</td>
<td>Port used as a communication channel to the proxy appliance in the restore to Amazon EC2 process.</td>
</tr>
<tr>
<td>From</td>
<td>To</td>
<td>Protocol</td>
<td>Port</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>----</td>
<td>----------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>TCP</td>
<td>443</td>
<td></td>
<td></td>
<td>Default redirector port. You can change the port in proxy appliance settings. For details, see Specify Proxy Appliance.</td>
</tr>
</tbody>
</table>

**Microsoft Active Directory Domain Controller Connections During Application Item Restore**

The following table describes network ports that must be opened to ensure proper communication of the backup server with the Microsoft Active Directory VM during application-item restore.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP</td>
<td>135</td>
<td></td>
<td></td>
<td>Port required for communication between the domain controller and backup server.</td>
</tr>
<tr>
<td>TCP, UDP</td>
<td>389</td>
<td></td>
<td></td>
<td>LDAP connections.</td>
</tr>
<tr>
<td>TCP</td>
<td>636, 3268, 3269</td>
<td></td>
<td></td>
<td>LDAP connections.</td>
</tr>
<tr>
<td>TCP</td>
<td>49152 to 65535 (for Microsoft Windows 2008 and newer)</td>
<td></td>
<td></td>
<td>Dynamic port range used by the runtime coordination process deployed inside the VM guest OS for application-aware processing* For more information, see this Microsoft KB article.</td>
</tr>
</tbody>
</table>

* If you use default Microsoft Windows firewall settings, you do not need to configure dynamic RPC ports: during setup, Veeam Backup & Replication automatically creates a firewall rule for the runtime process. If you use firewall settings other than default ones or application-aware processing fails with the "RPC function call failed" error, you need to configure dynamic RPC ports. For more information on how to configure RPC dynamic port allocation to work with firewalls, see this Microsoft KB article.
# Microsoft Exchange Server Connections During Application Item Restore

The following table describes network ports that must be opened to ensure proper communication of the Veeam backup server with the Microsoft Exchange Server system during application-item restore.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
</table>

# Microsoft SQL Server Connections During Application Item Restore

The following table describes network ports that must be opened to ensure proper communication of the backup server with the VM guest OS system during application-item restore.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>Microsoft SQL VM guest OS</td>
<td>TCP</td>
<td>1433, 1434 and other</td>
<td>Port used for communication with the Microsoft SQL Server installed inside the VM. Port numbers depends on configuration of your Microsoft SQL server. For more information, see <a href="#">Microsoft Docs</a>.</td>
</tr>
</tbody>
</table>

# SMTP Server Connections

The following table describes network ports that must be opened to ensure proper communication of the backup server with the SMTP server.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Protocol</th>
<th>Port</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup server</td>
<td>SMTP server</td>
<td>TCP</td>
<td>25</td>
<td>Port used by the SMTP server. Port 25 is most commonly used but the actual port number depends on configuration of your environment.</td>
</tr>
</tbody>
</table>
Veeam Backup Enterprise Manager Connections

Veeam Explorers Connections

- Veeam Explorer for Microsoft Active Directory Connections
- Veeam Explorer for Microsoft Exchange Connections
- Veeam Explorer for Microsoft SharePoint Connections
- Veeam Explorer for Microsoft SQL Server Connections
- Veeam Explorer for Oracle Connections

Veeam Cloud Connect Connections

Veeam Agent for Microsoft Windows Connections

- Connections for Veeam Agent for Microsoft Windows Operating in Managed Mode
- Connections for Veeam Agent for Microsoft Windows Operating in Standalone Mode

Veeam Agent for Linux Connections

- Connections for Veeam Agent for Linux Operating in Managed Mode
- Connections for Veeam Agent for Linux Operating in Standalone Mode

Veeam Plug-ins for Enterprise Applications Connections

- Veeam Plug-in for SAP HANA Connections
- Veeam Plug-in for Oracle RMAN Connections

Internet Connections

If you use an HTTP(S) proxy server to access the Internet, make sure that WinHTTP settings are properly configured on Microsoft Windows machines with Veeam backup infrastructure components. For information on how to configure WinHTTP settings, see Microsoft Docs.

NOTE:
Tenants cannot access Veeam Cloud Connect infrastructure components through HTTP(S) proxy servers. For information on supported protocols for Veeam Cloud Connect, see the Used Ports section in the Veeam Cloud Connect Guide.
Trusted Root Certificates

There are several root certificates necessary for the Veeam Backup & Replication to operate correctly.

In most cases, these certificates are already installed on Microsoft Windows machines. Some Microsoft Windows installations do not contain needed root certificates authority as trusted root certificates, or have non-current certificates. This may happen on servers with locked down security settings, or servers with no internet access or if the latest updates are not installed.

Removal of these certificates from the backup server may limit the functionality of Veeam Backup & Replication or may cause it to fail.

Make sure the following root certificates are installed on the backup server:

- https://www.digicert.com/CACerts/DigiCertAssuredIDRootCA.crt (DigiCert Assured ID Root CA)
- http://secure.globalsign.com/cacert/gscodesigng3ocsp.crt (GlobalSign CodeSigning CA - G3)
- https://www.digicert.com/CACerts/DigiCertHighAssuranceEVRootCA.crt (DigiCert High Assurance EV Root CA)
- https://www.digicert.com/CACerts/DigiCertEVCodesignCA-SHA2.crt (DigiCert EV Code Signing CA - SHA2)
- https://support.globalsign.com/customer/portal/articles/1426602-globalsign-root-certificates (install R1, R2, and R3 certificates)

If your backup server does not have internet access, download certificate files from another computer.
Naming Conventions

Do not use Microsoft Windows reserved names for names of the backup server, managed servers, backup repositories, jobs, tenants and other objects created in Veeam Backup & Replication: CON, PRN, AUX, NUL, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8, COM9, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8 and LPT9. If you use a reserved name, Veeam Backup & Replication may not work as expected. For more information on naming conventions in Microsoft Windows, see Microsoft Docs.
Security Considerations

When you set up the backup infrastructure, one thing that you must not overlook is security. The backup infrastructure can be potentially used as a backdoor to gain access to your systems and data.

This section includes a number of recommendations that will help you prevent potential security issues and reduce the risk of compromising sensitive data.

General Considerations

Ensure timely guest OS updates on backup infrastructure servers. Install the latest updates and patches on backup infrastructure servers to minimize the risk of exploiting guest OS vulnerabilities by attackers.

Backups and Replicas

A potential source of vulnerability is the backup or replica itself. To secure data stored in backups and replicas, consider the following recommendations:

- **Ensure physical security of target servers.** Check that only authorized personnel have access to the room where your target servers (backup repositories and hosts) reside.
- **Restrict user access to backups and replicas.** Check that only authorized users have permissions to access backups and replicas on target servers.
- **Encrypt data in backups.** Use Veeam Backup & Replication built-in encryption to protect data in backups. To guarantee security of data in backups, follow Encryption Best Practices.

Data Communication Channel

Backup data can be intercepted in-transit, when it is communicated from source to target over a network. To secure the communication channel for backup traffic, consider the following recommendations:

- **Isolate backup traffic.** Use an isolated network to transport data between backup infrastructure components – backup server, backup proxies, repositories and so on.
- **Encrypt network traffic.** By default, Veeam Backup & Replication encrypts network traffic travelling between public networks. To ensure secure communication of sensitive data within the boundaries of the same network, you can also encrypt backup traffic in private networks. For details, see Enabling Network Data Encryption.

Internet Access for Backup Servers

Some Veeam Backup & Replication functionality requires that backup servers have outbound Internet access. For example, to enable product update check, automatic license update and license usage reporting, a backup server must be connected to the Internet and be able to send requests to servers on the Internet.

However, inbound connectivity to backup servers from the Internet must not be allowed. If you want to manage backup servers remotely over the Internet, you can deploy the Veeam Backup & Replication console on a jump server. Service providers who want to manage backup servers remotely can use the Veeam Backup Remote Access functionality. For more information, see the Using Remote Access Console section in the Veeam Cloud Connect Guide.
The account used for RDP access must not have local Administrator privileges on the jump server, and you must never use the saved credentials functionality for RDP access or any other remote console connections. To restrict users from saving RDP credentials, you can use Group Policies. For more information, see Experts Exchange.

Credentials

An attacker who gained high-privilege access to backup infrastructure servers can get credentials of user accounts and compromise other systems in your environment.

Particularly, backup proxies must be considered the target for compromise. During backup, proxies obtain from the backup server credentials required to access virtual infrastructure servers. A person having administrator privileges on a backup proxy can intercept the credentials and use them to access the virtual infrastructure.

One of the most possible causes of a credential theft are missing guest OS updates and use of outdated authentication protocols. To mitigate risks, consider the following recommendations:

- **Choose strong encryption algorithms for SSH.** To communicate with Linux servers deployed as part of the backup infrastructure, Veeam Backup & Replication uses SSH. Make sure that for the SSH tunnel you use a strong and proven encryption algorithm, with sufficient key length. Ensure that private keys are kept in a highly secure place, and cannot be uncovered by a 3rd party.

- **Avoid using password authentication to connect to remote servers over SSH.** Using key-based SSH authentication is generally considered more secure than using password authentication and is not vulnerable to MITM attacks.

Veeam Backup & Replication Database

Another security concern you must consider is protecting the Veeam Backup & Replication configuration database. The database stores credentials of user accounts required to connect to virtual servers and other systems in the backup infrastructure. All passwords stored in the database are encrypted. However, a user with administrator privileges on the backup server can decrypt the passwords, which presents a potential threat.

To secure the Veeam Backup & Replication configuration database, consider the following recommendations:

- **Restrict user access to the database.** Check that only authorized users can access the backup server and the server that hosts the Veeam Backup & Replication configuration database (if the database runs on a remote server).

- **Encrypt data in configuration backups.** Enable data encryption for configuration backup to secure sensitive data stored in the configuration database. For details, see Creating Encrypted Configuration Backups.

Veeam Cloud Connect

Veeam Cloud Connect secures communication between the provider side and tenant side with TLS. If an attacker obtains a provider’s private key, backup traffic can be eavesdropped and decrypted. The attacker can also use the certificate to impersonate the provider (man-in-the-middle attack).

Veeam Cloud Connect providers must consider the following recommendations:

- **Keep the certificate in a secure place.** Make sure that the TLS certificate is kept in a highly secure place and cannot be uncovered by a 3rd party.
Licensing

To work with Veeam Backup & Replication, you must obtain a license key and install it on the backup server. If you do not install the license key, the product will operate in the Veeam Backup & Replication Community (free) Edition. For more information, see Veeam Backup & Replication Community Edition.

Veeam licenses Veeam Backup & Replication in two ways: per instance and per socket.

You can use both instance and socket licenses. For more information, see Merging Licenses.

Instance Licensing

Veeam Backup & Replication can be licensed by the number of instances. Instances are units (or tokens) that you can use to protect your virtual, physical or cloud-based workloads. For more information, see Veeam Licensing Policy.

You must obtain a license with the total number of instances for workloads that you plan to protect in Veeam Backup & Replication.

Workloads that have been processed in the past 31 days are considered protected. Every protected workload consumes instances from the license scope. The number of instances that a workload requires depends on the workload type and product edition.

This licensing model allows you to obtain a license with a certain number of instances without knowing in advance what types of workloads you plan to protect. When a need arises, you can revoke instances from a protected workload, and reuse them to protect other workloads regardless of the workload type.

Mind the following:

- VM templates are regarded as protected VMs and consume license instances.
- VMs and NAS shares processed with backup copy and tape jobs are not regarded as protected VMs and NAS shares and do not consume license instances. These types of jobs provide an additional protection level for VMs and NAS shares that are already protected with backup jobs.
- VMs processed by snapshot-only jobs are regarded as protected VMs and consume license instances. Veeam Backup & Replication will revoke instances from these VMs if you re-add a storage array to the backup infrastructure.

Veeam Backup & Replication keeps track of instances consumed by protected workloads. If the number of consumed instances exceeds the license limit, Veeam Backup & Replication displays a warning when you open the Veeam Backup & Replication console. For more information, see Exceeding License Limit.

Socket Licensing

With the socket licensing model, Veeam Backup & Replication is licensed by the number of CPU sockets on protected hosts. For more information, see Veeam Licensing Policy.

A license is required for every occupied motherboard socket as reported by the hypervisor API.

License is required only for source hosts — hosts on which VMs that you back up or replicate reside. Target hosts (for replication and migration jobs) do not need to be licensed.
NOTE:
If you use a socket license that was obtained for an earlier version of Veeam Backup & Replication, Veeam Software adds up to 6 instances free of charge to your license scope. You can use these instances to protect any type of supported workloads except VMware and Hyper-V VMs — they are covered by the licensed CPU sockets on virtualization hosts.
If the number of licensed sockets is less than 6, you can use the number of instances that equals the number of licensed sockets. For example, if the number of licensed sockets is 5, you can use 5 instances. If the number of licensed sockets is 100, you can use 6 instances.
Types of Licenses

Veeam Software offers the following types of licenses for Veeam Backup & Replication:

Paid Licenses

- **Subscription license** — license that expires at the end of the subscription term. The Subscription license term is normally 1-3 years from the date of license issue.

- **Perpetual license** — permanent license. The support and maintenance period included with the license is specified in months or years. Typically, one year of basic support and maintenance is included with the Perpetual license.

- **Rental license** — license with the license expiration date set according to the chosen rental program (normally 1-12 months from the date of license issue). The Rental license can be automatically updated upon expiration.

  Rental licenses are provided to Veeam Cloud & Service Provides (VCSPs) only. For more information, see the Rental License section in the Veeam Cloud Connect Guide.

Free Licenses

- **Evaluation license** — license used for product evaluation. The Evaluation license is valid for 30 days from the moment of product download.

- **NFR license** — license used for product demonstration, training and education. The person to whom the license is provided agrees that the license is not for resell or commercial use.
Obtaining License

You can obtain an Evaluation or paid license for the product when you download the product from the Veeam website.

Obtaining Paid License

To obtain a paid license, refer to the Veeam Backup & Replication Pricing page.

To obtain a Perpetual Instance license, find a reseller.

Obtaining Evaluation License

To obtain an Evaluation license:

1. Sign in to Veeam.
2. On the Download Veeam products page, click the product link.
3. In the Get trial key section, click the Request Trial Key link to download the Evaluation license.

Renewing License

To renew your maintenance plan, contact Veeam Renewals Team at renewals@veeam.com.
Installing License

When you install Veeam Backup & Replication, you are asked to specify a path to the license file. If you do not specify a path to the license file, Veeam Backup & Replication will run in the Veeam Backup & Replication Community (free) Edition. For more information, see Veeam Backup & Replication Community Edition.

You can install or change the license after product installation:

1. From the main menu, select License.
2. In the **License Information** window, click **Install**.

3. Browse to the LIC file and click **Open**.

### Licenses in Veeam Backup Enterprise Manager

If backup servers are connected to Veeam Backup Enterprise Manager, Veeam Backup Enterprise Manager collects information about all licenses installed on backup servers. When Veeam Backup Enterprise Manager replicates databases from backup servers, it also synchronizes license data: checks if the license installed on the backup server coincides with the license installed on the Veeam Backup Enterprise Manager server. If the licenses do not coincide, the license on the backup server is automatically replaced with the license installed on the Veeam Backup Enterprise Manager server.
Merging Licenses

Merging licenses is an option for customers who have a Perpetual Socket license. If you have a Perpetual Socket license, and want to also protect, for example, your cloud or physical workloads, or work with Veeam plug-ins, you can obtain an instance license and merge it with the socket license.

Under the merged license, the following workloads are processed per socket:

- VMs
- Veeam Plug-ins if the application servers are added to Veeam Backup & Replication
- Veeam Agents if the machines are added to Veeam Backup & Replication.

Other workloads are processed per instance.

License Types Available for Merging

You can merge licenses of the following types:

- Perpetual Socket license and Subscription Instance license
- Perpetual Socket license and Perpetual Instance license.

License Packages Available for Merging

You can merge licenses of the following packages:

<table>
<thead>
<tr>
<th>Type of license</th>
<th>Essentials Socket</th>
<th>Backup Socket</th>
<th>Suite Socket</th>
<th>ONE Socket</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter Instance</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Essentials Instance</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Backup Instance</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Suite Instance</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>ONE Instance</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>
Support Terms in Merged Licenses

If the licenses that you want to merge have different support expiration date, the merged license will take the support that expires first.

Merging Licenses

Before you merge licenses, check the following prerequisites:

- The license type and package allow merging.
- The company names are identical in both licenses. Company name check is case sensitive.

To merge licenses, install a new license over the already installed license. For more information, see Installing License.

Note that if the license types do not allow merging, the newly installed license will replace the previous license.
Viewing License Information

You can view details of the installed license in the **License Information** window.

To open the **License Information** window, from the main menu select **License**.

The following details are available for the current license:

- **Status** — license status (Valid, Invalid, Expired, Not Installed, Warning, Error).
- **Type** — license type (Perpetual, Subscription, Rental, Evaluation, NFR, Free).
- **Support ID** — support ID required for contacting Veeam Support.
- **Licensed to** — name of a person or organization to which the license was issued.
- **Package** — Veeam license pack: Starter, Essentials, Backup, Suite, ONE.
- **Instances** — number of instances that you can use to protect workloads.
- **Sockets** — number of sockets that you can use to protect workloads.
- **Expiration date** — date when the license expires.
- **Support expiration date** — date when the support expires. Valid for Perpetual Socket and Perpetual Instance licenses.
- **Capacity** — protected front end capacity (in TiB) for NAS backup.
To enable automatic license update, select the **Update license automatically** check box. For more information, see **Updating License Automatically**.

**Viewing Information on Sockets**

With socket licenses, Veeam Backup & Replication applies a license to the virtualization host on which the processed VMs reside.

To view to which objects the license is currently applied, open the **Sockets** tab.

![Socket License Information](image)

**Viewing Information on Instances**

With instance licenses, Veeam Backup & Replication applies a license to a protected workload. The number of license instances that a protected workload consumes depends on the workload type and product edition. For details, see **Veeam Licensing Policy**.

To view to which objects the license is currently applied, open the **Instances** tab.
By default, Veeam Backup & Replication allows Veeam Agents to connect to the Veeam backup server and consume instances in the license. If you do not want Veeam Agents to consume instances, clear the **Allow unlicensed agents to consume instances** check box. For more information on Veeam Agents licensing, see **Veeam Agent Management Guide**.

![License Information Table]

<table>
<thead>
<tr>
<th>TYPE</th>
<th>COUNT</th>
<th>MULTIPLIER</th>
<th>INSTANCES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servers</td>
<td>10</td>
<td>1</td>
<td>10</td>
</tr>
<tr>
<td>Workstations &amp; PCs p...</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>
Revoking License

You can revoke licenses from protected workloads or licensed hosts, and re-apply them to other objects that you plan to protect. License revoking can be helpful, for example, if a licensed host goes out of service or you do not want to protect some workloads anymore. To revoke a license, do the following:

1. From the main menu, select License.
2. In the License Information window:
   - For protected workloads, open the Instances tab and click Manage.
   - For licensed hosts, open the Sockets tab and click Manage.
3. In the displayed window, select a protected workload or a licensed host and click Revoke. Veeam Backup & Replication will revoke the license from the selected object, and the license will be freed for other objects in the backup infrastructure.
Removing License

You can remove the installed license. When you remove a license, Veeam Backup & Replication will switch to the Veeam Backup & Replication Community Edition. For more information, see Veeam Backup & Replication Community Edition.

You can also remove a part of merged license. If you do so, Veeam Backup & Replication will operate under the other part of the merged license. For more information, see Merging Licenses.

To remove a license, do the following:

1. From the main menu, select License.
2. In the **License Information** window, click **Remove**.

If you have both socket and instance licenses, you will be asked which license you want to remove.
Exceeding License Limit

For Subscription Instance licenses and Rental Instance licenses, Veeam Backup & Replication allows you to protect more workloads than covered by the number of instances specified in the license. An increase in the number of protected workloads is allowed throughout the duration of the contract (license key).

The license limit can be exceeded by a number of instances, or a percentage of the total number of instances specified in the license (depends on which number is greater). The exceeding limit varies according to the license type.

<table>
<thead>
<tr>
<th>License Type</th>
<th>Exceeding Limit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Perpetual license</strong></td>
<td>Not allowed</td>
<td>Workloads that are exceeding the license limit are not processed.</td>
</tr>
<tr>
<td><strong>Subscription license</strong></td>
<td>Up to 5 instances (or 5% of the total instance count)</td>
<td>All protected workloads are processed normally, Veeam Backup &amp; Replication does not display a warning message.</td>
</tr>
<tr>
<td></td>
<td>5–10 instances (or 5%–10% of the total instance count)</td>
<td>All protected workloads are processed normally. Once a week when you open the Veeam Backup &amp; Replication console, a warning message is displayed notifying that you are out of compliance with the Veeam Licensing Policy.</td>
</tr>
<tr>
<td></td>
<td>Over 10 instances (or 10% of the total instance count)</td>
<td>Workloads that are exceeding the license limit beyond 10 instances (or 10% of the total instance count) are not processed. Every time you open the Veeam Backup &amp; Replication console, a warning message is displayed notifying that you are out of compliance with the Veeam Licensing Policy.</td>
</tr>
<tr>
<td><strong>Rental license</strong></td>
<td>See the Rental License section in the Veeam Cloud Connect Guide.</td>
<td></td>
</tr>
</tbody>
</table>

For example, you have a Subscription license with 500 instances to protect your workloads. According to the table above, you are allowed to use up to 10 instances or 10% of the total instance count (whichever number is greater) over the license limit. As the number of instances in your license is 500, you are allowed to use additional 50 instances (50 makes 10% of 500, and 50 is greater than 10). Consider the following:

- Until the license limit is not exceeded by more than 5% of the total instance count (up to 25 instances), Veeam Backup & Replication processes all protected workloads with no restrictions.

- When the license limit is exceeded by 5%–10% (25.01 to 50 instances), Veeam Backup & Replication processes protected workloads, and displays a warning message once a week when you open the Veeam Backup & Replication console. In the message, Veeam Backup & Replication provides information on the number of exceeded instances and the number of instances by which the license can be further exceeded.
If the license limit is exceeded by more than 10% (50.01 instances and more), Veeam Backup & Replication does not process the workloads exceeding the limit, and displays a warning message every time you open the Veeam Backup & Replication console. In the message, Veeam Backup & Replication provides information on the number of instances by which the license is exceeded.
License Expiration

When the license expires, Veeam Backup & Replication behaves in the following way depending on the license type:

- Evaluation and NFR licenses: Veeam Backup & Replication will stop processing workloads.
- Paid licenses: Veeam Backup & Replication will switch to the grace period.

Perpetual Socket and Perpetual Instance licenses do not expire. However, such licenses have support expiration date. Veeam Backup & Replication will inform you about the support expiration date.

Grace Period

To ensure a smooth license update and provide sufficient time to install a new license file, Veeam Backup & Replication offers a grace period. Grace period is available for paid licenses.

During the grace period, you can perform all types of data protection and disaster recovery operations. However, Veeam Backup & Replication will inform you about the license expiration when you open the Veeam Backup & Replication console. The license status in the License Information window will appear as Expired.

You must update your license before the end of the grace period. If you do not update the license, Veeam Backup & Replication stops processing workloads. All existing jobs fail with the Error status. However, you will be able to restore machine data from existing backups.

Grace Period Duration

Before the license expires, Veeam Backup & Replication notifies you about soon license expiration.

The number of days for notification and grace period depends on the type of license:

<table>
<thead>
<tr>
<th>License Type</th>
<th>License Expiration Notification</th>
<th>Grace Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscription</td>
<td>30 days</td>
<td>30 days</td>
</tr>
<tr>
<td>Perpetual Instance</td>
<td>14 days before Support expiration date</td>
<td>n/a</td>
</tr>
<tr>
<td>Perpetual Socket</td>
<td>14 days before Support expiration date</td>
<td>n/a</td>
</tr>
<tr>
<td>Rental</td>
<td>7 days</td>
<td>60 days</td>
</tr>
<tr>
<td>Evaluation</td>
<td>30 days</td>
<td>0 days</td>
</tr>
<tr>
<td>NFR</td>
<td>30 days</td>
<td>0 days</td>
</tr>
</tbody>
</table>
Switching to Veeam Backup & Replication *Community Edition*

If you do not want to renew your license, you can switch to the free product version named Veeam Backup & Replication Community (free) Edition. For more information, see Veeam Backup & Replication Community Edition.

To do so, remove your license. For details, see Removing License.

Expiration of Merged Licenses

If you merged licenses with different expiration dates, the merged license will expire on the date that is closer. For example, if you merged a Perpetual license and a Subscription license, the expiration date will be inherited from the Subscription license.

In such case, you can update your Subscription license or continue using the Perpetual license. To continue using the Perpetual license, remove the Subscription license. For more information, see Removing License.
Updating License

To be able to use all data protection and disaster recovery features, you must update your license upon expiry. There are two methods to update the license in Veeam Backup & Replication:

- Update the license manually
- Update the license automatically
Updating License Manually

You can update the license manually on demand. When you update the license manually, Veeam Backup & Replication connects to the Veeam License Update Server, downloads a new license from it (if the license is available) and installs it on the backup server.

The new license key differs from the previously installed license key in the license expiration date or support expiration date. If you have obtained a license for a greater number of instances, counters in the new license also display the new number of license instances.

To update the license:

1. From the main menu, select License.
2. In the License Information window, click Update Now.

Statistics on the manual license update process is available under the System node in the History view. You can double-click the License key auto-update job to examine session details for the license update operation.

Manual License Update Results

Manual license update can complete with the following results:

- **Operation is successful.** A new license key is successfully generated, downloaded and installed on the backup server or Veeam Backup Enterprise Manager server.
- **A new license is not required.** The currently installed license key does not need to be updated.
- **The Veeam License Update Server has failed to generate a new license.** Such situation can occur due to some error on the Veeam License Update Server side.
• **Veeam Backup & Replication has received an invalid answer.** Such situation can occur due to connectivity issues between the Veeam License Update Server and Veeam Backup & Replication.

• **Licensing by the contract has been terminated.** In such situation, Veeam Backup & Replication automatically disables automatic license update on the backup server or Veeam Backup Enterprise Manager server.
Updating License Automatically

You can instruct Veeam Backup & Replication to automatically update the license installed on the backup server or Veeam Backup Enterprise Manager server. With automatic license update, you do not need to download and install the license manually each time when you purchase the license extension. If the automatic update option is enabled, Veeam Backup & Replication proactively communicates with the Veeam License Update Server to obtain and install a new license before the current license expires.

Requirements and Limitations for Automatic License Update

- Automatic license update is not available in the Veeam Backup & Replication Community Edition.
- Only licenses that contain a real contract number in the Support ID can be updated with the Update license key automatically option.
- If you are managing backup servers with Veeam Backup Enterprise Manager, all license management tasks must be performed in the Veeam Backup Enterprise Manager console. Automatic update settings configured in Veeam Backup Enterprise Manager override automatic update settings configured in Veeam Backup & Replication.

For example, if the automatic update option is enabled in Veeam Backup Enterprise Manager but disabled in Veeam Backup & Replication, automatic update will be performed anyway. For more information, see the Veeam Backup Enterprise Manager User Guide.

NOTE:

Veeam Backup & Replication does not automatically update an existing per-VM or socket license that was obtained for an earlier version of the product to a new instance license.

To overcome this issue, after you upgrade to Veeam Backup & Replication 10, you must obtain in the Veeam Customer Support Portal a new instance license and install it on the backup server manually.

How Automated License Update Works

To update installed licenses automatically, Veeam Backup & Replication performs the following actions:

1. After you enable automatic license update, Veeam Backup & Replication starts sending requests to the Veeam License Update Server on the web (autolk.veeam.com) and checks if a new license key is available. Veeam Backup & Replication sends requests once a week. Communication with the Veeam License Update Server is performed over the HTTPS protocol.

2. Seven days before the expiration date of the current license, Veeam Backup & Replication starts sending requests once a day.

3. When a new license key becomes available, Veeam Backup & Replication automatically downloads it and installs on the backup server or Veeam Backup Enterprise Manager server.

The new license key differs from the previously installed license key in the license expiration date and support expiration date. If you have obtained a license for a greater number of instances, counters in the new license also display the new number of license instances.
Automatic License Update Results

Automatic license update can complete with the following results:

- **Operation is successful.** A new license key is successfully generated, downloaded and installed on the backup server or Veeam Backup Enterprise Manager server.

- **A new license is not required.** The currently installed license key does not need to be updated.

- **The Veeam License Update Server has failed to generate a new license.** Such situation can occur due to some error on the Veeam License Update Server side.

- **Veeam Backup & Replication has received an invalid answer.** Such situation can occur due to connectivity issues between the Veeam License Update Server and Veeam Backup & Replication.

- **Licensing by the contract has been terminated.** In such situation, Veeam Backup & Replication automatically disables automatic license update on the backup server or Veeam Backup Enterprise Manager server.

Automatic Update Retries

If Veeam Backup & Replication fails to update the license, it displays a notification in the session report and sends an email notification to users specified in the global email settings (if global email settings are configured on the backup server). You can resolve the issue, while Veeam Backup & Replication will keep retrying to update the license.

Veeam Backup & Replication retries to update the license key in the following way:

- If Veeam Backup & Replication fails to establish a connection to the Veeam License Update Server, retry takes place every 60 min.

- If Veeam Backup & Replication establishes a connection but you are receiving the "**General license key generation error has occurred**" message, the retry takes place every 24 hours.

The retry period ends one month after the license expiration date or the support expiration date (whichever is earlier). The retry period is equal to the number of days in the month of license expiration. For example, if the license expires in January, the retry period will be 31 day; if the license expires in April, the retry period will be 30 days.

If the retry period is over but the new license has not been installed, the automatic update feature is automatically disabled.

For more information about error cases, see Appendix A. License Update Session Data.

Enabling Automatic License Update

By default, automatic license update is disabled. To enable automatic license update:

1. From the main menu, select **License**.
2. In the License Information window, select the Update license key automatically check box.

Statistics on the automatic license update process is available under the System node in the History view. You can double-click the License key auto-update job to examine session details for the scheduled or ad-hoc automatic license update.

NOTE:
[For Rental licenses] Enabling license auto update activates Automatic License Usage Reporting.
Automatic License Usage Reporting

When license auto update is enabled for Rental licenses, Veeam Backup & Replication performs automatic license usage reporting.

As part of reporting, Veeam Backup & Replication collects statistics on the current license usage and sends it periodically to the Veeam License Update Server. The report provides information about the contract ID, product installation ID, and the maximum number of licensed objects that were managed by Veeam Backup & Replication over the past week (high watermark). The reporting process runs in the background mode, once a week at a random time and day.

The type of reported objects is defined by the product and the installed license. The report can include information about VMs, workstations or servers protected with Veeam backup agents, and so on.

The collected data does not include information on the usage of Veeam Backup & Replication by any individual person identifiable for Veeam, or any data protected by Veeam Backup & Replication.

The collected data allows our back-end system to automatically approve your monthly usage reports as long as they do not deviate from the high watermark value significantly. This helps to keep our report processing costs low, thus allowing us to maintain low rental prices for our solution. Veeam may also use collected data for any other internal business purposes it deems appropriate, including (but not limited to) evaluation, improvement and optimization of Veeam licensing models.

By enabling license auto update you agree with collection, transmission and use of the reporting data. You must not enable license auto update in case you do not agree with such collection, transmission and use.
Getting to Know Veeam Backup & Replication

After you install Veeam Backup & Replication, you can get familiar with the product UI, learn about product editions and modes, and find out what functionality these editions and modes offer.

- Veeam Backup & Replication UI
- Product Editions
Veeam Backup & Replication UI

The user interface of Veeam Backup & Replication is designed to let you quickly find commands that you need and perform data protection and disaster recovery tasks.

- **Main Menu**
- **Navigation Pane**
- **Ribbon and Tabs**
- **Views**
- **Working Area**

**TIP:**
To open online help, press [F1] in any Veeam Backup & Replication wizard or window. You will be redirected to the corresponding section of the user guide.
Main Menu

The main menu in Veeam Backup & Replication contains commands related to general application settings. You can perform the following operations using the main menu:

- Upgrade backup infrastructure components
- Manage credentials
- Manage cloud credentials
- Manage passwords
- Configure application settings
- Set up user roles
- Configure network traffic rules
- Perform configuration backup and restore
- Start PuTTY and Microsoft PowerShell consoles, and open a remote desktop connection to the backup server
- Change color theme
- Work with licenses
- View Veeam Backup & Replication help and export program logs
- Exit Veeam Backup & Replication
Navigation Pane

The navigation pane, located on the left of the window, provides centralized navigation and lets you easily access Veeam Backup & Replication items organized in views.

The navigation pane consists of two areas:

- The upper pane, or the inventory pane, displays a hierarchy or list of items relevant for a specific view. Items displayed in the inventory pane differ depending on the active view. For example, in the **Backup Infrastructure** view, the inventory pane displays a list of backup infrastructure components — virtualization servers, backup proxies, backup repositories and so on. In the **Inventory** view, the inventory pane displays a list of servers added to the backup infrastructure.

- The lower pane contains a set of buttons that let you switch between views. For more information on views and how to show/hide a view button, see **Views**.
Ribbon and Tabs

Operation commands in Veeam Backup & Replication are organized in logical groups and displayed under tabs on the ribbon. The ribbon is displayed at the top of the main application window.

On the ribbon, the following tabs are displayed:

- The **Home** tab provides quick access to the most common operations. It lets you configure different types of jobs, perform restore and import operations. This tab is always available, no matter which view is currently active.

- Other tabs contain commands specific for certain items and appear when these items are selected. For example, if you open the **Home** view and select a backup job in the working area, the **Job** tab containing buttons for operations with jobs will appear on the ribbon. If you open the **Files** view and select a file or folder, the **File Tools** tab containing buttons for operations with files will appear on the ribbon.

**TIP:**

Commands for operations with items in Veeam Backup & Replication are also available from the shortcut menu.

You can minimize the ribbon. To do so, right-click anywhere on the ribbon and select **Minimize the Ribbon**. To restore the ribbon, right-click on the minimized ribbon and clear the **Minimize the Ribbon** option.
Views

Veeam Backup & Replication displays its items in views. When you click the button of a specific view in the navigation pane, the view content is displayed in the working area of Veeam Backup & Replication.

Veeam Backup & Replication offers the following views:

- **The Home view** is intended for work with jobs. It also displays a list of created backups and replicas that can be used for various restore operations, and provides statistics for recently performed jobs. For more information about job statistics, see Reporting.

- **The Inventory view** displays the inventory of the virtual infrastructure. The inventory can be presented from different perspectives: Computer, Storage, VM Folders, VM Tags and vCloud. You can use this view to work with VMs, and VM containers or groups.

- **The Backup Infrastructure view** displays a list of backup infrastructure components: servers, hosts, backup proxies, backup repositories and so on. You can use this view for backup infrastructure setup — here you can configure backup infrastructure components that will be used for data protection and disaster recovery tasks.

- **The Tape Infrastructure view** displays a hierarchy of tape libraries connected to the tape server. You can use this view to archive data to tapes and restore data from tapes.

- **The Cloud Connect Infrastructure view** displays components of the Veeam Cloud Connect infrastructure. This view can be used by SP to manage TLS certificates, configure cloud gateways and create accounts for users who plan to work with cloud resources.

- **The Files view** displays a file tree of servers added to the backup infrastructure. You can use this view for file copying operations.

- **The History view** displays statistics on operations performed with Veeam Backup & Replication.

In some situations, some views may not be displayed. Mind the following:

- Right after installation, Veeam Backup & Replication displays only Backup Infrastructure and History views. To display other views, you must add at least one server or virtualization host to the backup infrastructure.

- Right after installation, Veeam Backup & Replication does not save changes that you make to the navigation pane or views: for example, if you resize panes, display or hide specific views. After you restart the Veeam Backup & Replication console, the main window settings are back to default ones. To save these settings, you must add at least one server or virtualization host to the backup infrastructure.

- To display the Cloud Connect Infrastructure view, you must install a valid license that supports the Veeam Cloud Connect functionality.

You can hide views that you do not plan to use. For example, if you do not use tapes for data archiving, you can hide the Tape Infrastructure view.

To hide a view:

1. Click the arrow icon (🔍) at the bottom of the navigation pane.
2. Click the view in the list.
Working Area

The working area of Veeam Backup & Replication displays a list of items relating to a specific view.

The working area looks different depending on the view that is currently active. For example, if you open the History view, the working area will display a list of job sessions and restore tasks performed with Veeam Backup & Replication. If you open the Inventory view, the working area will display a list of VMs that reside on servers connected to Veeam Backup & Replication.

Every item is described with a set of properties that are presented as column headers. You can click column headers to sort items by a specific property. For example, to sort VMs by the amount of provisioned storage space, click the Provisioned Size header.

To hide or display properties, right-click a column header and, in the opened menu, clear or select check boxes near property names.
Job Filter

A job filter allows you to filter jobs by different parameters. For example, you can create a filter that will show only VM backup copy jobs.

Creating Job Filters

To create a filter, do the following:

1. Open the **Home** view.
2. In the inventory pane, select the **Jobs** node.
3. At the top of the working area, click the **All jobs** filter.
4. Select **Add new**.
5. In the **Add View** window, specify a filter name. The name must be up to 200 characters long.
6. In the **Workload** section, select workloads which jobs must process:
   - **Application** — Veeam Backup & Replication will show Veeam Plug-in jobs and jobs in which SQL transaction log backup or Oracle archive log backup is enabled.
   - **Cloud VM** — Veeam Backup & Replication will show jobs that process VMs stored in clouds.
   - **File** — Veeam Backup & Replication will show jobs that process files.
   - **Server** — Veeam Backup & Replication will show Veeam Agent jobs that process servers. For more information on processed computer types, see **Selecting Protected Computer Type**.
   - **Workstation** — Veeam Backup & Replication will show Veeam Agent jobs that process workstations. For more information on processed computer types, see **Selecting Protected Computer Type**.
   - **VM** — Veeam Backup & Replication will show jobs that process VMs.
7. In the **Job type** section, select job types:
   - **Backup** — backup jobs. For example, **VM backup jobs** or **file share backup jobs**.
   - **Backup copy** — backup copy jobs. For example, **VM backup copy jobs** or **file share backup copy jobs**.
   - **Copy** — copy jobs. For example, **file copy jobs**.
   - **Replication** — replication jobs.
   - **SureBackup** — **SureBackup jobs**.
   - **Tape** — tape jobs. For example, **backup to tape jobs** or **file to tape jobs**.
8. In the **Last result** section, select statuses with which jobs must finish: **Success**, **Warning** or **Failed**. Jobs that that have never started are considered as **Failed**.
9. In the **Status** section, select states of jobs: **Running**, **Inactive** or **Disabled**. Backup copy jobs in the **Idle** state are considered Inactive.
10. If you want to show jobs that were inactive for some period of time, select the **Last run is over** check box and specify the period in days.
11. If you want to show jobs whose names include specific keywords, select the **Job name includes** check box and enter keywords.

To show jobs that include any of the specified keywords, separate these keywords by a semicolon without a space. For example, if you enter "Backup Job;Daily", Veeam Backup & Replication will show all jobs that include "Backup Job" or "Daily" keywords in their names.

**NOTE:**

Only the user who creates filters can access them — that is, other users cannot use these filters.

---

**Editing and Deleting Job Filters**

To edit or delete a job filter, do the following:

1. Open the **Home** view.
2. In the inventory pane, select the **Jobs** node.
3. At the top of the working area, click the filter icon.
4. Hover the mouse over a job that you want to edit or delete.
5. Click the ellipsis button.
6. Select **Edit view** or **Delete view**.
Changing Color Theme

By default, Veeam Backup & Replication uses a ‘Sea Green’ color theme for the UI. If necessary, you can change the color theme. Changing the color theme can be helpful, for example, if you connect to different backup servers from one remote machine on which the Veeam Backup & Replication console is installed. In this case, you will be able to easily differentiate with which backup server you are currently working.

To change the color theme for Veeam Backup & Replication:

1. From the main menu, select **Color Theme**.
2. Choose one of color themes: **Veeam Green, Sea Green, Marine Blue, Ocean Graphite**.

**NOTE:**

Color theme settings are applicable for a specific combination of a backup server and user account. For example, the color theme is initially set to the default one. You log on to the Veeam Backup & Replication console under some user account and change the color theme to **Marine Blue**. If you log on to the same backup server under the same account next time, the color theme will be set to **Marine Blue**. If you log on to the same backup server under another account, Veeam Backup & Replication will use the color theme that was previously set for this account — that is, the default color theme.
Product Editions

Veeam Backup & Replication is available in four editions: Community, Standard, Enterprise, and Enterprise Plus. For more information about product editions, pricing and features available for them, see Veeam Editions Comparison.
Deployment

To start working with Veeam Backup & Replication, you must configure a backup server — install Veeam Backup & Replication on a machine that meets the system requirements. To do this, you can use the setup wizard or install the product in the unattended mode.

When you install Veeam Backup & Replication, the Veeam Backup & Replication console is automatically installed on the backup server. If you want to access Veeam Backup & Replication remotely, you can install the Veeam Backup & Replication console on a dedicated machine.
Installing Veeam Backup & Replication

Before you install Veeam Backup & Replication, check prerequisites. Then use the Veeam Backup & Replication setup wizard to install the product.
Before You Begin

Before you install Veeam Backup & Replication, check the following prerequisites:

- A machine on which you plan to install Veeam Backup & Replication must meet the system requirements. For more information, see System Requirements.

- A user account that you plan to use for installation must have sufficient permissions. For more information, see Required Permissions.

- Backup infrastructure components communicate with each other over specific ports. These ports must be open. For more information, see Used Ports.

- Veeam Backup & Replication requires Microsoft SQL Server deployed either locally on the backup server or remotely. If Microsoft SQL Server is not installed, the Veeam Backup & Replication setup will install it locally on the backup server. For more information, see System Requirements.

  If Microsoft SQL Server is installed by the previous product version, Veeam Backup & Replication will connect to the existing configuration database, upgrade it (if necessary) and use it for work.

- You must remove Veeam Backup & Replication components of versions that are not supported by the upgrade procedure from the target machine. You may also need to remove earlier versions of other Veeam products and components.
Step 1. Start Setup Wizard

To start the setup wizard:

1. Download the latest version of the Veeam Backup & Replication installation image from the Download Veeam Products page.

2. Mount the installation image to the machine on which you plan to install Veeam Backup & Replication or burn the image file to a flash drive or other removable storage device. If you plan to install Veeam Backup & Replication on a VM, use built-in tools of the virtualization management software to mount the installation image to the VM.

   To extract the content of the ISO, you can also use the latest versions of utilities that can properly extract data from ISOs of large size and can properly work with long file paths.

3. After you mount the image or insert the disk, Autorun will open a splash screen with installation options. If Autorun is not available or disabled, run the Setup.exe file from the image or disk.

4. In the Veeam Backup & Replication section of the splash screen, click Install.

   **IMPORTANT!**

   It is strongly recommended that you install Veeam Backup & Replication using Autorun or the Setup.exe file. If you run other installation files from the ISO folders, you may miss some components that need to be installed, and Veeam Backup & Replication may not work as expected.
Step 2. Read and Accept License Agreement

At the License Agreement step of the wizard, you must accept the license agreement for Veeam and 3rd party components that Veeam incorporates. If you do not accept the license agreement, you will not be able to pass to next step of the setup wizard.

1. Read the license agreement.
   To view the license agreement for 3rd party components, click View.
2. Select the I accept the terms of the Veeam license agreement check box.
3. Select the I accept the terms of the 3rd party components license agreement check box.
Step 3. Provide License File

At the **Provide License** step of the wizard, you must specify what license for Veeam Backup & Replication you want to install. For more information, see **Licensing**.

If a valid license is already installed on the machine, the setup wizard will inform you about it. In this case, you can skip the **Provide License** step and move to the next step of the wizard.

If you do not install a license, the product will operate in the Veeam Backup & Replication Community (free) Edition. For more information, see **Veeam Backup & Replication Community Edition**.

To install a license:

1. Next to the **License file for Veeam Backup & Replication** field, click **Browse**.
2. Select a valid license file for Veeam Backup & Replication.
Step 4. Review Components and Select Installation Folder

At the Program Features step of the wizard, you can check what components the setup wizard will install on the machine and choose the installation folder.

The setup wizard installs the following components:

- Veeam Backup & Replication
- Veeam Backup Catalog (component responsible for storing VM guest OS indexing data)
- Veeam Backup & Replication Console

The setup wizard also installs the following components in the background:

- Veeam Explorer for Microsoft Active Directory
- Veeam Explorer for Microsoft Exchange
- Veeam Explorer for Oracle
- Veeam Explorer for Microsoft SQL Server
- Veeam Explorer for Microsoft SharePoint
- Veeam Explorer for Microsoft OneDrive for Business
- Veeam Backup PowerShell Snap-In
- Veeam Distribution Server

The distribution server is an architecture component in the Veeam Agent management infrastructure used for deployment of Veeam Agent setup files to protected computers. For more information, see the Veeam Agent Management Infrastructure section in the Veeam Agent Management Guide.

These components do not require additional licenses. They are integrated with Veeam Backup & Replication.

To choose the installation folder:

1. On the right of the Install to field, click Browse.
2. In the **Browse for Folder** window, select the installation folder for the product. The default installation folder is `C:\Program Files\Veeam\Backup and Replication\`. 
Step 5. Install Missing Software

At the **System Configuration Check** step of the wizard, the setup wizard checks if all prerequisite software is installed on the machine. If required software components are missing, the setup wizard will offer you to install them.

You can install missing components automatically or manually.

- To install missing components automatically, click **Install**. The setup wizard will not interrupt the installation process and install the missing components during the current work session.

- To install missing components manually:
  a. Click **Cancel** and exit the setup wizard.
  b. Install and enable the necessary components manually on the machine.
  c. Start the setup wizard again, pass to the **System Configuration Check** step of the wizard and click **Re-run** to repeat the verification.

**NOTE:**

If all required components are already installed on the machine, the **System Configuration Check** step will be skipped.
Step 6. Specify Installation Settings

At the Default Configuration step of the wizard, you can select to install Veeam Backup & Replication with default installation settings or specify custom installation settings.

By default, the setup wizard installs Veeam Backup & Replication with the following settings:

- **Installation folder**: C:\Program Files\Veeam\Backup and Replication.

- **Catalog service port**: 9393. The catalog service port is used by the Veeam Guest Catalog Service to replicate catalog data from backup servers to Veeam Backup Enterprise Manager.

- **Service account**: LOCAL SYSTEM. The service account is the account under which the Veeam Backup Service runs.

- **Service port**: 9392. The service port is used by Veeam Backup Enterprise Manager to collect data from backup servers. In addition to it, the Veeam Backup & Replication console uses this service port to connect to the backup server.

- **Secure connections port**: 9401. The secure connections port is used by the mount server to communicate with the backup server.

- **SQL Server**: LOCALHOST|VEEAMSQL2012 or LOCALHOST|VEEAMSQL2016. During installation, the Veeam Backup & Replication setup installs a new instance of Microsoft SQL Server locally on the backup server:
  - For machines running Microsoft Windows 7 or Microsoft Windows Server 2008 R2, the setup installs Microsoft SQL Server 2012 SP4 Express Edition.
  - For machines running Microsoft Windows Server 2012 or later, the setup installs Microsoft SQL Server 2016 SP2 Express Edition.

- **Database name**: VeeamBackup. Veeam Backup & Replication deploys the Veeam Backup & Replication configuration database on the locally installed instance of Microsoft SQL Server.

To use default installation settings:

1. Leave the Let me specify different settings check box not selected.
2. Click Install. The installation process will begin.
To use custom installation settings, select the **Let me specify different settings** check box. The setup wizard will include additional steps that will let you configure installation settings.
Step 7. Specify Service Account Settings

The **Service Account** step of the wizard is available if you have selected to configure installation settings manually.

You can select an account under which you want to run the Veeam Backup Service:

- LOCAL SYSTEM account (recommended, used by default)
- Another user account

The user name of the account must be specified in the `DOMAIN\USERNAME` format.

The user account must have the following rights and permissions:

- The account must be a member of the *Administrators* group on the machine where Veeam Backup & Replication is installed.
- The account must have *db_owner* rights for the configuration database.

Veeam Backup & Replication automatically grants the *Log on as service* right to the specified user account.
Step 8. Select Microsoft SQL Server

The SQL Server Instance step of the wizard is available if you have selected to configure installation settings manually.

You can select a Microsoft SQL Server on which you want to deploy the configuration database, and choose the authentication mode.

1. Select a Microsoft SQL Server:
   - If a Microsoft SQL Server is not installed locally or remotely, select the Install new instance of SQL Server option. The setup will install Microsoft SQL Server locally on the backup server:
     - For machines running Microsoft Windows 7 or Microsoft Windows Server 2008 R2, the setup will install Microsoft SQL Server 2012 SP4 Express Edition.
     - For machines running Microsoft Windows Server 2012 or later, the setup will install Microsoft SQL Server 2016 SP1 Express Edition.
   - If a Microsoft SQL Server is already installed locally or remotely, select the Use existing instance of SQL Server option. Enter the instance name in the HOSTNAME.INSTANCE format. In the Database field, specify a name for the Veeam Backup & Replication configuration database.

2. Select an authentication mode to connect to the Microsoft SQL Server instance: Microsoft Windows authentication or SQL Server authentication. If you select the SQL Server authentication, enter credentials for the Microsoft SQL Server account.

If the configuration database already exists on the Microsoft SQL Server (for example, it was created by a previous installation of Veeam Backup & Replication), the setup wizard will notify about it. To connect to the detected database, click Yes. If necessary, Veeam Backup & Replication will automatically upgrade the database to the latest version.
Step 9. Specify Service Ports

The **Port Configuration** step of the wizard is available if you have selected to configure installation settings manually.

You can customize port number values that will be used for communication between backup infrastructure components:

- **Catalog service port.** The catalog service port is used by the Veeam Guest Catalog Service to replicate catalog data from backup servers to Veeam Backup Enterprise Manager. By default, port 9393 is used.

- **Veeam Backup Service port.** The service port is used by Veeam Backup Enterprise Manager to collect data from backup servers. In addition to it, the Veeam Backup & Replication console uses this service port to connect to the backup server. By default, port 9392 is used.

- **Secure connections port.** The secure connections port is used by the mount server to communicate with the backup server. By default, port 9401 is used.
Step 10. Specify Data Locations

The **Data Locations** step of the wizard is available if you have selected to configure installation settings manually.

You can specify where the write cache and indexing data must be stored.

1. [For VMware environments] In the **Instant recovery write cache** section, specify a path to the IR cache folder. The IR cache folder stores the write cache for machines that are started from backups during recovery verification or restore operations. Make sure that you have at least 10 GB of free disk space to store the write cache.

   By default, the setup wizard creates the IR cache folder on a volume with the maximum amount of free space, for example, \ProgramData\Veeam\Backup\IRCache.

   You do not need to configure this data location for Microsoft Hyper-V environments.

2. In the **Guest file system catalog** section, specify a path to the folder where index files must be stored.

   By default, the setup wizard creates the **VBRCatalog** folder on a volume with the maximum amount of free space, for example: \VBRCatalog.
Step 11. Begin Installation

The **Ready to Install** step of the wizard is available if you have selected to configure installation settings manually.

You can review installation settings and start the installation process.

1. If you want Veeam Backup & Replication to periodically check and notify you about product updates, select the **Check for updates once the product is installed and periodically** check box.

2. Click **Install** to begin the installation.

3. Wait for the installation process to complete and click **Finish** to exit the setup wizard.
Step 12. Install Available Patches

It is recommended that you periodically check for Veeam Backup & Replication patches and updates and install them when they are available. Installation of updates and patches lets you make sure that you use the latest version of the product and use its functionality to the full.

You can check for product updates manually or configure Veeam Backup & Replication to automatically notify you about available updates and patches. For more information, see Specifying Other Notification Settings.

---

**TIP:**

When you install updates for Veeam Backup & Replication, in the update wizard, select the **Update remote components automatically** check box. Veeam Backup & Replication will automatically update its components on all servers added to the backup infrastructure. For more information, see Server Components Upgrade.
Upgrading to Veeam Backup & Replication 10

To perform upgrade of Veeam Backup & Replication to version 10, you must be running version 9.5 Update 3 or later on the supported operating system (refer to the System Requirements section of this document). To upgrade from previous versions, contact Veeam Customer Support.

Upgrade Checklist

Check the following prerequisites before you upgrade Veeam Backup & Replication:

1. Make sure that servers that you plan to use as backup infrastructure components meet the system requirements listed in the System Requirements section of this document.

2. Make sure that the virtual environment you are going to protect with Veeam Backup & Replication meets the requirements listed in the Platform Support section of this document.

3. Are you running Veeam Backup & Replication 9.5 Update 3 or later? If yes, perform the upgrade procedure described below. To upgrade from previous versions, contact Veeam Customer Support.

4. Are you using Veeam Availability for Nutanix AHV 1.0? Veeam Backup & Replication 10 is not compatible with this version. If you upgrade to Veeam Backup & Replication 10, you must also upgrade from Veeam Availability for Nutanix AHV 1.0 to Veeam Backup for Nutanix AHV 2.0. For instructions, see the Upgrading from Veeam Availability for Nutanix 1.0 section of the Veeam Backup for Nutanix AHV User Guide.

5. Are you using Veeam Availability Orchestrator 1.0 or 2.0? Veeam Backup & Replication 10 is not compatible with these versions. Please wait until Veeam Availability Orchestrator 3.0 is generally available before upgrading.

6. Are you using an instance license to protect some of your vSphere or Hyper-V VMs with agent-based backup jobs in presence of a socket license? As an enforcement of the existing licensing policy, hosts where such VMs are running will require and consume socket licenses with Veeam Backup & Replication 10. This may result in your agent-based backup jobs failing after the upgrade due to insufficient socket licenses.

7. Veeam Backup & Replication 10 uses a new license file format. The setup wizard will offer to download your version 10 license automatically. This requires uploading your currently installed license to Veeam servers. If your backup server has no Internet connection, or if you prefer not to have your license uploaded, or in case of license upgrade issues, download your version 10 license from the Veeam Customer Portal manually. Note that you must have an active maintenance agreement at the time when you access the portal.

There can be situations where you encounter one of the following error messages after the upgrade: Cannot find any supported licenses for current product version or Invalid license. To learn how to fix them, see this Veeam KB article.

8. Make sure that there is enough space provided for Microsoft SQL Server configuration database upgrade. To calculate the required space, add at least 25% of free space to the Microsoft SQL Server configuration database size.

By default, the setup wizard installs Veeam Backup & Replication with Microsoft SQL Server Express. Mind that the maximum configuration database size for Microsoft SQL Server Express is 10 GB.
9. Perform backup of the corresponding Microsoft SQL Server configuration databases used by backup and Enterprise Manager servers, so that you can easily go back to the previous version in case of issues with upgrade. Note that the built-in configuration backup functionality does not protect Enterprise Manager configuration.

10. Are you using Veeam Backup Enterprise Manager? If yes, start the upgrade procedure from this component. Note that Enterprise Manager 10 supports backup server version 9.5 Update 3 or later, so you can potentially run both old and new product versions side by side.

11. Are you using Veeam ONE to monitor your backup infrastructure? If yes, upgrade it first. Veeam ONE supports monitoring of backup server version 9.5 Update 3 or later.


13. Check if the backup server you plan to upgrade is installed on the supported operating system. If not, you must migrate the server to the supported OS first, before performing the upgrade. For information on how to perform the migration, see this Veeam KB article.

14. Are you using Cloud Connect? If yes, check with your Cloud Connect service provider if they have already upgraded their system to at least the version you are upgrading to.

15. Are you using Veeam Availability Console? If yes, first upgrade it at least to version 3.0.0.2795, as described in this Veeam KB article.

16. Are you using Veeam Backup for Microsoft Office 365? If yes, upgrade it to version 4b or 4c to provide the compatibility with Veeam Backup & Replication 10. For details about version 4b, see this Veeam KB article, about version 4c — this Veeam KB article.

17. Make sure there is no active processes, such as any running jobs and restore sessions. We recommend that you do not stop running jobs and let them complete successfully. Disable any periodic and backup copy jobs, so that they do not start during the upgrade.

18. Are you using Veeam Agents version 2 and earlier operating in the standalone mode together with Veeam Backup & Replication? If yes, after you upgrade Veeam Backup & Replication to version 10, you must upgrade Veeam Agent on protected computers at least to version 3.0.

If you use Veeam Agents in the managed mode, Veeam Backup & Replication automatically upgrades them to the required version after you upgrade Veeam Backup & Replication itself.

Performing Upgrade

To upgrade Veeam Backup & Replication to version 10, perform the following steps:

1. Make sure you have checked all the prerequisites listed in the Upgrade Checklist.

2. Download the latest version of the Veeam Backup & Replication ISO from the Veeam Backup & Replication Download page.

3. Make sure the latest run for all existing jobs has completed successfully. Rerun the failed jobs.

4. Make sure there are no running jobs, restore sessions, Instant VM Recovery sessions and SureBackup jobs. We recommend that you do not stop running jobs and let them complete successfully. Disable any periodic and backup copy jobs temporarily to prevent them from starting during the upgrade.

5. Mount the product ISO and use autorun, or run the Setup.exe file.

6. Click the Upgrade tile to launch the upgrade wizard.
7. Follow the same steps as described in the Installing Veeam Backup & Replication section. Be sure to select the same SQL database and instance that was used by the previous product version.

   At the **Ready to Install** step of the upgrade wizard, select the **Update remote components automatically** check box to automatically upgrade Veeam Backup & Replication components on all servers added to the backup infrastructure. For more information, see Server Components Upgrade.

8. Wait for the setup program to perform the upgrade.

9. Open the Veeam Backup & Replication console. If necessary, the automated upgrade wizard will automatically appear, prompting you to upgrade the product components running on remote servers. Follow the wizard to complete the upgrade process.

10. If some remote servers are unavailable at the time of upgrade, you can run the upgrade wizard at any time later from the main product menu, or by closing and re-opening the Veeam Backup & Replication console. Note that the out-of-date product components cannot be used by jobs until they are updated to the backup server version.

11. Enable any scheduled jobs that you have disabled before the upgrade.

   Note that immediately after upgrade, the backup server performance may decrease. This happens due to the maintenance job that optimizes the configuration database. The process may take up to an hour depending on the database size.

**IMPORTANT!**

You must upgrade Veeam components on all remote servers with which the backup server communicates during data protection and disaster recovery tasks. If you do not upgrade components on remote servers, Veeam Backup & Replication jobs will fail. For more information, see Server Components Upgrade.

### Unattended Upgrade

To correctly upgrade Veeam Backup & Replication in the unattended mode, perform the following steps:

1. Uninstall the previous version of the product.

2. Install a newer version of the product in the unattended mode. You must connect to the configuration database that was used by the previous product version.

   For information on how to install Veeam Backup & Replication in the unattended mode, see Installing Veeam Backup & Replication in Unattended Mode.
Uninstalling Veeam Backup & Replication

To uninstall Veeam Backup & Replication:

1. From the Start menu, select Control Panel > Programs and Features.

2. In the programs list, right-click Veeam Backup & Replication and select Uninstall. If you have Veeam Backup Enterprise Manager installed on this machine, Veeam Backup & Replication will uninstall both components. Wait for the process to complete.

3. If the program list contains additional Veeam Backup & Replication components, right-click the remaining components and select Uninstall.

The Veeam Backup & Replication configuration database is not removed during the uninstall process. All configuration data stored in the database remains as well.
Installing Veeam Backup & Replication Console

By default, the Veeam Backup & Replication console is installed on the backup server automatically when you install Veeam Backup & Replication. You do not need to install the console manually.

However, in addition to the default console, you can install the Veeam Backup & Replication console on a dedicated machine to access the backup server remotely. You can install as many remote consoles as you need. For more information, see Backup & Replication Console.

Before you install the Veeam Backup & Replication console, check prerequisites. Then use the Veeam Backup & Replication Console Setup wizard to install the console.
Before You Begin

Before you install the Veeam Backup & Replication console, check the following prerequisites:

- The Veeam Backup & Replication console must be of the same version as Veeam Backup & Replication installed on the backup server.

- A machine on which you plan to install the Veeam Backup & Replication console must meet the system requirements. For more information, see System Requirements.

- A user account that you plan to use for installation must have sufficient permissions. For more information, see Required Permissions.

- Backup infrastructure components communicate with each other over specific ports. These ports must be open. For more information, see Used Ports.
Step 1. Start Setup Wizard

To start the setup wizard:


2. Use disk image emulation software to mount the installation image to the machine where you plan to install Veeam Backup & Replication or burn the image file to a flash drive or other removable storage device. If you plan to install Veeam Backup & Replication on a VM, use built-in tools of the virtualization management software to mount the installation image to the VM.

   To extract the content of the ISO, you can also use the latest versions of utilities that can properly extract data from ISOs of large size and can properly work with long file paths.

3. After you mount the image or insert the disk, Autorun will open a splash screen with installation options. If Autorun is not available or disabled, run the Setup.exe file from the image or disk.

4. On the splash screen, click Veeam Backup & Replication Console.

**IMPORTANT!**

It is strongly recommended that you install the Veeam Backup & Replication console using Autorun or the Setup.exe file. If you run other installation files from the ISO folders, you may miss some components that need to be installed, and Veeam Backup & Replication may not work as expected.
Step 2. Read and Accept License Agreement

At the License Agreement step of the wizard, you must accept the license agreement for Veeam and 3rd party components that Veeam incorporates. If you do not accept the license agreement, you will not be able to pass to next step of the setup wizard.

1. Read the license agreement.
   To view the license agreement for 3rd party components, click View.
2. Select the I accept the terms of the Veeam license agreement check box.
3. Select the I accept the terms of the 3rd party components license agreement check box.
4. Click Next.
Step 3. Install Missing Software

At the **System Configuration Check** step of the wizard, the setup wizard checks if all prerequisite software is installed on the machine. If required software components are missing, the setup wizard will offer you to install them.

You can install missing components automatically or manually.

- To install missing components automatically, click **Install**. The setup wizard will not interrupt the installation process and install the missing components in the current session.

- To install missing components manually:
  a. Click **Cancel** and exit the setup wizard.
  b. Install and enable the necessary components manually on the machine.
  c. Start the setup wizard again, pass to the **System Configuration Check** step of the wizard and click **Re-run** to repeat the verification.
Step 4. Specify Installation Settings

At the Default Configuration step of the wizard, you can select to install the Veeam Backup & Replication console with default installation settings or specify custom installation settings.

By default, the setup wizard installs the Veeam Backup & Replication console with the following settings:

installation folder – C:\Program Files\Veeam\Backup and Replication.

To use default installation settings:

1. Leave the Let me specify different settings check box not selected.
2. Click Install. The installation process will begin.

To specify custom installation settings, select the Let me specify different settings check box. The setup wizard will include additional steps that will let you configure installation settings.
Step 5. Specify Installation Path

The **Installation Path** step of the wizard is available if you have selected to configure installation settings manually.

At the **Installation Path** step of the wizard, you can choose the installation folder for the Veeam Backup & Replication console.

1. On the right of the **Install Veeam Backup & Replication Console to the following folder** field, click **Browse**.
2. In the **Browse for Folder** window, select the installation folder for the product. The default folder is C:\Program Files\Veeam\Backup and Replication\.
Step 6. Begin Installation

The **Ready to Install** step of the wizard is available if you have selected to configure installation settings manually.

At the **Ready to Install** step of the wizard, you can review the installation settings and start the installation process.

1. Click **Install** to begin the installation.
2. Wait for the installation process to complete and click **Finish** to exit the setup wizard.
Installing Veeam Backup & Replication in Unattended Mode

You can install Veeam Backup & Replication in the unattended mode using the command line interface. The unattended installation mode does not require user interaction. You can use it to automate the installation process in large deployments.

Installation Order

Veeam Backup & Replication components must be installed in the order specified below. The order depends on the type of server that you plan to deploy: backup server or Veeam Backup Enterprise Manager server.

Backup Server

If you want to deploy the backup server (server running Veeam Backup & Replication), you must install components in the following order:

1. Veeam Backup Catalog
2. Veeam Backup & Replication Server
3. Veeam Explorers:
   - Veeam Explorer for Active Directory
   - Veeam Explorer for Exchange
   - Veeam Explorer for Oracle
   - Veeam Explorer for SharePoint and Veeam Explorer for Microsoft OneDrive for Business
   - Veeam Explorer for Microsoft SQL

Veeam Backup & Replication Console

If you want to deploy the Veeam Backup & Replication console, you must install the Veeam Backup & Replication console component.

Veeam Backup Enterprise Manager Server

If you want to deploy the Veeam Backup Enterprise Manager server (server running Veeam Backup Enterprise Manager), you must install components in the following order:

1. Veeam Backup Catalog
2. Veeam Backup Enterprise Manager

Veeam Cloud Connect Portal

If you want to deploy Veeam Cloud Connect Portal, you must install components in the following order:

1. Veeam Backup Enterprise Manager
2. Veeam Cloud Connect Portal
Before You Begin

Before you start unattended installation, perform the following steps:

1. [For backup server] Manually install the SQL server and software components required for the backup server operation. For more information, see Backup Server in System Requirements.

2. [For Veeam Explorers] Make sure that the version of a Veeam Explorer that you plan to install matches the version of the Veeam Backup & Replication console on the target machine.

3. [For Veeam Backup Enterprise Manager server] Manually install the SQL server and software components required for the operation of the Veeam Backup Enterprise Manager server. For more information, see the System Requirements section of the Enterprise Manager User Guide.

4. Download the Veeam Backup & Replication installation image from the Veeam website. You can burn the downloaded image to a flash drive or mount the image to the target machine using disk image emulation software.

5. Log on to the target machine under the account that has the local Administrator permissions on the machine. For more information, see Required Permissions.

6. Obtain a license file. The license file is required for Veeam Backup Enterprise Manager installation and is optional for Veeam Backup & Replication installation. If you do not specify a path to the license file during Veeam Backup & Replication installation, Veeam Backup & Replication will operate in the Community Edition mode.
Installation Command-Line Syntax

You can install the following Veeam Backup & Replication components in the unattended mode:

- Veeam Backup Catalog
- Veeam Backup & Replication Server
- Veeam Backup & Replication Console
- Veeam Explorer for Microsoft Active Directory
- Veeam Explorer for Microsoft SQL Server
- Veeam Explorer for Microsoft Exchange
- Veeam Explorer for Microsoft SharePoint and Veeam Explorer for Microsoft OneDrive for Business
- Veeam Explorer for Oracle
- Veeam Backup Enterprise Manager
- Veeam Cloud Connect Portal

Veeam Backup Catalog

To install Veeam Backup Catalog, use a command with the following syntax:

```
msiexec.exe [/L*v "<path_to_log>" /qn /i "<path_to_msi>" ACCEPT_THIRDPARTY_LICENSES="1" [INSTALLDIR="<path_to_installdir >"] [VM_CATALOGPATH="<path_to_catalog_shared_folder>"] [VBRC_SERVICE_USER="<Veeam_Guest_Catalog_Service_account>" [VBRC_SERVICE_PASSWORD="<Veeam_Guest_Catalog_Service_account_password>" [VBRC_SERVICE_PORT="<Veeam_Guest_Catalog_Service_port>"]
```

The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output. Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared. Example: /L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\Catalog.txt&quot;</td>
</tr>
<tr>
<td>/q</td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to “no”, which means no user interaction is needed during installation.</td>
</tr>
<tr>
<td>Option</td>
<td>Parameter</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/i</td>
<td>setup file</td>
<td>Yes</td>
<td>Installs Veeam Backup Catalog. Specify a full path to the setup file as the parameter value. Example: /i &quot;C:\Veeam\VeeamBackupCatalog64.msi&quot;</td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation. Example: ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</td>
</tr>
<tr>
<td>INSTALLDIR</td>
<td>path</td>
<td>No</td>
<td>Installs the component to the specified location. By default, Veeam Backup &amp; Replication uses the Backup Catalog subfolder in the C:\Program Files\Veeam\Backup and Replication\ folder. Example: INSTALLDIR=&quot;C:\Catalog&quot; The component will be installed to the C:\Catalog\Backup Catalog folder.</td>
</tr>
<tr>
<td>VM_CATALOGPATH</td>
<td>path</td>
<td>No</td>
<td>Specifies a path to the catalog folder where index files must be stored. By default, Veeam Backup &amp; Replication creates the VBRCatalog folder on a volume with the maximum amount of free space, for example C:\VBRCatalog. Example: VM_CATALOGPATH=&quot;C:\Backup&quot; Index files will be stored to the C:\Backup\VBRCatalog folder.</td>
</tr>
<tr>
<td>VBRC_SERVICE_USER</td>
<td>user</td>
<td>No</td>
<td>Specifies a user account under which the Veeam Guest Catalog Service will run. The account must have full control NTFS permissions on the VBRCatalog folder where index files are stored. If you do not specify this parameter, the Veeam Guest Catalog Service will run under the LocalSystem account. Together with the VBRC_SERVICE_USER parameter, you must specify the VBRC_SERVICE_PASSWORD parameter. Example: VBRC_SERVICE_USER=&quot;BACKUPSERVER\Administrator&quot;</td>
</tr>
</tbody>
</table>
### Option | Parameter | Required | Description
--- | --- | --- | ---
VBRC_SERVICE_PASSWORD | password | No | This parameter must be used if you have specified the VBRC_SERVICE_USER parameter. Specifies a password for the account under which the Veeam Guest Catalog Service will run.  
Example: `VBRC_SERVICE_PASSWORD="1234"`

VBRC_SERVICE_PORT | port | No | Specifies a TCP port that will be used by the Veeam Guest Catalog Service. By default, port number 9393 is used.  
Example: `VBRC_SERVICE_PORT="9393"`

### Example

Suppose you want to install Veeam Backup Catalog with the following configuration:

- No user interaction
- Path to the MSI file: `E:\Veeam\VeeamBackupCatalog64.msi`
- Installation folder: default
- Catalog folder: default
- Service user account: `VEEAM\Administrator`
- Service user account password: 1234
- TCP communication port: 9391

The command to install Veeam Backup Catalog with such configuration will have the following parameters:

```
msiexec.exe /qn /i "E:\Veeam\VeeamBackupCatalog64.msi" ACCEPT_THIRDPARTY_LICENSES="1" VBRC_SERVICE_USER="VEEAM\Administrator" VBRC_SERVICE_PASSWORD="1234" VBRC_SERVICE_PORT="9391"
```
Veeam Backup & Replication Server

To install the Veeam Backup & Replication server, use a command with the following syntax:

```
msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPTEULA="yes" ACCEPT_THIRDPARTY_LICENSES="1" [INSTALLDIR="<path_to_installdir>"] [VBR_LICENSE_FILE="<path_to_license_file>"] [VBR_SERVICE_USER="<Veeam_B&R_Service_account>"] [VBR_SERVICE_PASSWORD="<Veeam_B&R_Service_account_password>"] [VBR_SERVICE_PORT="<Veeam_B&R_Service_port>"] [VBR_SECURE_CONNECTIONS_PORT="<SSL_port>"] [VBR_SQL_SERVER_SERVER="<SQL_server>"] [VBR_SQLSERVER_DATABASE="<database_name>"] [VBR_SQLSERVER_AUTHENTICATION="0"] [VBR_SQLSERVER_USERNAME="<SQL_auth_username>"] [VBR_SQLSERVER_PASSWORD="<SQL_auth_password>"] [VBR_CHECK_UPDATES="1"] [VBR_AUTO_UPGRADE="yes"]
```

The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output. Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared. Example: <code>/L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\Backup.txt&quot;</code></td>
</tr>
<tr>
<td>/q</td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to “no”, which means no user interaction is needed during installation.</td>
</tr>
<tr>
<td>/i</td>
<td>setup file</td>
<td>Yes</td>
<td>Installs the Veeam Backup &amp; Replication server. Specify a full path to the setup file as the parameter value.                              Example: <code>/i &quot;C:\Veeam\Server.x64.msi&quot;</code></td>
</tr>
<tr>
<td>ACCEPTEULA</td>
<td>yes/no</td>
<td>Yes</td>
<td>Specifies if you want to accept the Veeam license agreement. Specify <code>yes</code> to accept the license agreement and proceed with installation. Example: <code>ACCEPTEULA=&quot;yes&quot;</code></td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation. Example: <code>ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</code></td>
</tr>
<tr>
<td>Option</td>
<td>Parameter</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------</td>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>INSTALLDIR</td>
<td>path</td>
<td>No</td>
<td>Installs the component to the specified location. By default, Veeam Backup &amp; Replication uses the Backup subfolder of the C:\Program Files\Veeam\Backup and Replication\ folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> INSTALLDIR=&quot;C:\Backup&quot;                                                                                          The component will be installed to the C:\Backup\Backup folder.</td>
</tr>
<tr>
<td>VBR_LICENSE_FILE</td>
<td>license path</td>
<td>No</td>
<td>Specifies a full path to the license file. If you do not specify this parameter, Veeam Backup &amp; Replication will operate in the Community Edition mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> VBR_LICENSE_FILE=&quot;C:\Users\Administrator\Desktop\enterprise-veeam_backup_trial_0_30.lic&quot;</td>
</tr>
<tr>
<td>VBR_SERVICE_USER</td>
<td>user</td>
<td>No</td>
<td>Specifies the account under which the Veeam Backup Service will run. The account must have full control NTFS permissions on the VBRCatalog folder where index files are stored and the Database owner rights for the configuration database on the Microsoft SQL Server where the configuration database is deployed. If you do not specify this parameter, the Veeam Backup Service will run under the LocalSystem account. Together with the VBR_SERVICE_USER parameter, you must specify the VBR_SERVICE_PASSWORD parameter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> VBR_SERVICE_USER=&quot;BACKUPSERVER\Administrator&quot;</td>
</tr>
<tr>
<td>VBR_SERVICE_PASSWORD</td>
<td>password</td>
<td>No</td>
<td>This parameter must be used if you have specified the VBR_SERVICE_USER parameter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Specifies a password for the account under which the Veeam Backup Service will run.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> VBR_SERVICE_PASSWORD=&quot;1234&quot;</td>
</tr>
<tr>
<td>VBR_SERVICE_PORT</td>
<td>port</td>
<td>No</td>
<td>Specifies a TCP port that will be used by the Veeam Backup Service. By default, the port number 9392 is used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> VBR_SERVICE_PORT=&quot;9395&quot;</td>
</tr>
</tbody>
</table>

146 | Veeam Backup & Replication | User Guide for Microsoft Hyper-V
<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VBR_SECURE_CONNECTIONS_PORT</td>
<td>port</td>
<td>No</td>
<td>Specifies a port used for communication between the mount server and the backup server. By default, port 9401 is used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> <code>VBR_SECURE_CONNECTIONS_PORT=&quot;9402&quot;</code></td>
</tr>
<tr>
<td>VBR_SQLSERVER_SERVER</td>
<td>SQL server\instance</td>
<td>No</td>
<td>Specifies a Microsoft SQL server and instance on which the configuration database will be deployed. By default, Veeam Backup &amp; Replication uses the (local)\VEEAMSQL2012 server for machines running Microsoft Windows 7 or Microsoft Windows Server 2008 R2, and (local)\VEEAMSQL2016 for machines running Microsoft Windows Server 2012 or later.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> <code>VBR_SQLSERVER_SERVER=&quot;BACKUPSERVER\VEEAMSQL2016_MY&quot;</code></td>
</tr>
<tr>
<td>VBR_SQLSERVER_DATABASE</td>
<td>database</td>
<td>No</td>
<td>Specifies a name for the configuration database. By default, the configuration database is deployed with the VeeamBackup name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> <code>VBR_SQLSERVER_DATABASE=&quot;VeeamBackup&quot;</code></td>
</tr>
<tr>
<td>VBR_SQLSERVER_AUTHENTICATION</td>
<td>0/1</td>
<td>No</td>
<td>Specifies if you want to use the SQL Server authentication mode to connect to the Microsoft SQL Server where the Veeam Backup &amp; Replication configuration database is deployed. Specify 1 if you want to use the SQL Server authentication mode. If you do not specify this parameter, Veeam Backup &amp; Replication will connect to the Microsoft SQL Server in the Microsoft Windows authentication mode (default value is 0).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Together with this parameter, you must specify the following parameters: <code>VBR_SQLSERVER_USERNAME</code> and <code>VBR_SQLSERVER_PASSWORD</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> <code>VBR_SQLSERVER_AUTHENTICATION=&quot;1&quot;</code></td>
</tr>
<tr>
<td>Option</td>
<td>Parameter</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------</td>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VBR_SQLSERVER_USERNAME</td>
<td>user</td>
<td>No</td>
<td>This parameter must be used if you have specified the VBR_SQLSERVER_AUTHENTICATION parameter. Specifies a LoginID to connect to the Microsoft SQL Server in the SQL Server authentication mode. Example: VBR_SQLSERVER_USERNAME=&quot;sa&quot;</td>
</tr>
<tr>
<td>VBR_SQLSERVER_PASSWORD</td>
<td>password</td>
<td>No</td>
<td>This parameter must be used if you have specified the VBR_SQLSERVER_AUTHENTICATION parameter. Specifies a password to connect to the Microsoft SQL Server in the SQL Server authentication mode. Example: VBR_SQLSERVER_PASSWORD=&quot;1234&quot;</td>
</tr>
<tr>
<td>VBR_CHECK_UPDATES</td>
<td>0/1</td>
<td>No</td>
<td>Specifies if you want Veeam Backup &amp; Replication to automatically check for new product patches and versions and hypervisor updates for Microsoft Hyper-V hosts. Specify 0 if you do not want to check for updates. If you do not specify this parameter, Veeam Backup &amp; Replication will automatically check for updates (default value is 1). Example: VBR_CHECK_UPDATES=&quot;0&quot;</td>
</tr>
<tr>
<td>VBR_AUTO_UPGRADE</td>
<td>yes/no</td>
<td>No</td>
<td>Specifies if you want Veeam Backup &amp; Replication to automatically upgrade existing components in the backup infrastructure. Veeam Backup &amp; Replication performs automatic upgrade after the Veeam Backup Service is started on the backup server. Specify yes to enable automatic upgrade. Example: VBR_AUTO_UPGRADE=&quot;yes&quot;</td>
</tr>
</tbody>
</table>

**Example**

Suppose you want to install Veeam Backup & Replication with the following configuration:

- **Installation log location**: C:\logs\log1.txt
- **No user interaction**
- **Path to the MSI file**: E:\Veeam\Server.x64.msi
- **Installation folder**: D:\Program Files\Veeam
- **License file location**: C:\License\veeam_license.lic
- **Service user account**: VEEAM\Administrator
- **Service user account password**: 1243
- **Service port**: default
- **TLS port**: default
- **Configuration database and database name**: default

The command to install Veeam Backup & Replication with such configuration will have the following parameters:

```
msiexec.exe /L*v "C:\logs\log1.txt" /qn /i "E:\Veeam\Server.x64.msi" ACCEPTEULA="yes" ACCEPT_THIRDPARTY_LICENSES="1" INSTALLDIR="D:\Program Files\Veeam" VBR_LICENSE_FILE="C:\License\veeam_license.lic" VBR_SERVICE_USER="VEEAM\Administrator" VBR_SERVICE_PASSWORD="1234"
```

**Veeam Backup & Replication Console**

To install the Veeam Backup & Replication console, use a command with the following syntax:

```
msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPTEULA="yes" ACCEPT_THIRDPARTY_LICENSES="1" [INSTALLDIR="<path_to_installdir >"]
```

The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/L</code></td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output. Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared. Example: <code>/L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\Console.txt&quot;</code></td>
</tr>
<tr>
<td><code>/q</code></td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to “no”, which means no user interaction is needed during installation.</td>
</tr>
<tr>
<td><code>/i</code></td>
<td>setup file</td>
<td>Yes</td>
<td>Installs the Veeam Backup &amp; Replication console. Specify a full path to the setup file as the parameter value. Example: <code>/i &quot;C:\Veeam\Shell.x64.msi&quot;</code></td>
</tr>
<tr>
<td>Option</td>
<td>Parameter</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------</td>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ACCEPTEULA</td>
<td>yes/no</td>
<td>Yes</td>
<td>Specifies if you want to accept the Veeam license agreement. Specify yes to accept the license agreement and proceed with installation.</td>
</tr>
<tr>
<td>Example:</td>
<td></td>
<td></td>
<td>ACCEPTEULA=&quot;yes&quot;</td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation.</td>
</tr>
<tr>
<td>Example:</td>
<td></td>
<td></td>
<td>ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</td>
</tr>
<tr>
<td>INSTALLDIR</td>
<td>path</td>
<td>No</td>
<td>Installs the component to the specified location.</td>
</tr>
<tr>
<td>Example:</td>
<td>INSTALLDIR=&quot;C:\Backup&quot;</td>
<td>The component will be installed to the C:\Backup\Console folder.</td>
<td></td>
</tr>
</tbody>
</table>

**Example**

Suppose you want to install the Veeam Backup & Replication console with the following configuration:

- No user interaction
- Path to the MSI file: E:\Veeam\Shell.x64.msi
- Installation folder: C:\Backup

The command to install the Veeam Backup & Replication console with such configuration will have the following parameters:

```
msiexec.exe /L*v "C:\logs\log1.txt" /qn /i "E:\Veeam\Shell.x64.msi" ACCEPTEULA="yes" ACCEPT_THIRDPARTY_LICENSES="1" INSTALLDIR="C:\Backup\"
```

**Veeam Explorer for Microsoft Active Directory**

To install Veeam Explorer for Microsoft Active Directory, use a command with the following syntax:

```
msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPT_EULA="1" ACCEPT_THIRDPARTY_LICENSES="1"
```
The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output. Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared. Example: <code>/L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\VEAD.txt&quot;</code></td>
</tr>
<tr>
<td>/q</td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to “no”, which means no user interaction is needed during installation.</td>
</tr>
<tr>
<td>/i</td>
<td>setup file</td>
<td>Yes</td>
<td>Installs Veeam Explorer for Microsoft Active Directory. Specify a full path to the setup file as the parameter value. Example: <code>/i &quot;C:\Explorers\VeeamExplorerforActiveDirectory.msi&quot;</code></td>
</tr>
<tr>
<td>ACCEPT_EULA</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the Veeam license agreement. Specify 1 to accept the license agreement and proceed with installation. Example: ACCEPT_EULA=&quot;1&quot;</td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation. Example: ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</td>
</tr>
</tbody>
</table>

**Veeam Explorer for Microsoft SQL Server**

To install Veeam Explorer for Microsoft SQL Server, use a command with the following syntax:

```plaintext
msiexec.exe [/L*v "<path_to_log>" ] /qn /i "<path_to_msi>" ACCEPT_EULA="1" ACCEPT_THIRDPARTY_LICENSES="1"
```
The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output. Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared. Example: <code>/L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\VESQL.txt&quot;</code></td>
</tr>
<tr>
<td>/q</td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to &quot;no&quot;, which means no user interaction is needed during installation.</td>
</tr>
<tr>
<td>/i</td>
<td>setup file</td>
<td>Yes</td>
<td>Installs Veeam Explorer for Microsoft SQL Server. Specify a full path to the setup file as the parameter value. Example: <code>/i &quot;C:\Explorers\VeeamExplorerforSQL.msi&quot;</code></td>
</tr>
<tr>
<td>ACCEPT_EULA</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the Veeam license agreement. Specify 1 to accept the license agreement and proceed with installation. Example: <code>ACCEPT_EULA=&quot;1&quot;</code></td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation. Example: <code>ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</code></td>
</tr>
</tbody>
</table>

Veeam Explorer for Microsoft Exchange

To install Veeam Explorer for Microsoft Exchange, use a command with the following syntax:

```
msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPT_EULA="1" ACCEPT_THIRDPARTY_LICENSES="1"
```
The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output. Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared. Example: /L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\VEX.txt&quot;</td>
</tr>
<tr>
<td>/q</td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to “no”, which means no user interaction is needed during installation.</td>
</tr>
<tr>
<td>/i</td>
<td>setup file</td>
<td>Yes</td>
<td>Installs Veeam Explorer for Microsoft Exchange. Specify a full path to the setup file as the parameter value. Example: /i &quot;C:\Explorers\VeeamExplorerforExchange.msi&quot;</td>
</tr>
<tr>
<td>ACCEPT_EULA</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the Veeam license agreement. Specify 1 to accept the license agreement and proceed with installation. Example: ACCEPT_EULA=&quot;1&quot;</td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation. Example: ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</td>
</tr>
</tbody>
</table>

Veeam Explorer for Microsoft SharePoint and Veeam Explorer for Microsoft OneDrive for Business

Veeam Explorer for Microsoft SharePoint is installed together with Veeam Explorer for Microsoft OneDrive for Business from the same setup file.
To install Veeam Explorer for Microsoft SharePoint and Veeam Explorer for Microsoft OneDrive for Business, use a command with the following syntax:

```
msiexec.exe [/L*v "<path_to_log>" ] /qn /i "<path_to_msi>" ACCEPT_EULA="1" ACCEPT_THIRDPARTY_LICENSES="1"
```

The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Specify a full path to the log file as the parameter value. A setup log file</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>created during the previous installation is cleared.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: /L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\VESP.txt&quot;</td>
</tr>
<tr>
<td>/q</td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to &quot;no&quot;, which means no user interaction is</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>needed during installation.</td>
</tr>
<tr>
<td>/i</td>
<td>setup file</td>
<td>Yes</td>
<td>Installs Veeam Explorer for Microsoft SharePoint and Veeam Explorer for</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microsoft OneDrive for Business.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Specify a full path to the setup file as the parameter value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Veeam Backup &amp; Replication installs both Veeam Explorer for Microsoft</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SharePoint and Veeam Explorer for Microsoft OneDrive for Business from the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>same setup file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: /i &quot;C:\Explorers\VeeamExplorerforSharePoint.msi&quot;</td>
</tr>
<tr>
<td>ACCEPT_EULA</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the Veeam license agreement. Specify 1 to</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>accept the license agreement and proceed with installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: ACCEPTEULA=&quot;1&quot;</td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>components that Veeam incorporates. Specify 1 to accept the license</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>agreement and proceed with installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</td>
</tr>
</tbody>
</table>
To install Veeam Explorer for Oracle, use a command with the following syntax:

```
msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPT_EULA="1" ACCEPT_THIRDPARTY_LICENSES="1"
```

The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: <code>/L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\VEO.txt&quot;</code></td>
</tr>
<tr>
<td>/q</td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to &quot;no&quot;, which means no user interaction is needed during installation.</td>
</tr>
<tr>
<td>/i</td>
<td>setup file</td>
<td>Yes</td>
<td>Installs Veeam Explorer for Oracle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Specify a full path to the setup file as the parameter value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: <code>/i &quot;C:\Explorers\VeeamExplorerforOracle.msi&quot;</code></td>
</tr>
<tr>
<td>ACCEPT_EULA</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the Veeam license agreement. Specify 1 to accept the license agreement and proceed with installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: ACCEPT_EULA=&quot;1&quot;</td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</td>
</tr>
</tbody>
</table>
Veeam Backup Enterprise Manager

To install Veeam Backup Enterprise Manager, use a command with the following syntax:

```bash
msiexec.exe [/L*v "<path_to_log>" ] /qn /i "<path_to_msi>">
ACCEPTEULA="yes"
ACCEPTEULA_THIRDPARTY_LICENSES="1"
INSTALLDIR="<path_to_installdir >"
VBREM_LICENSE_FILE="<path_to_license_file>"
VBREM_SERVICE_USER="<Veeam_EM_Service_account>"
VBREM_SERVICE_PASSWORD="<Veeam_EM_Service_account_password>"
VBREM_SERVICE_PORT="<Veeam_EM_Service_port>"
VBREM_SQLSERVER_SERVER="<SQL_server>"
VBREM_SQLSERVER_DATABASE="<database_name>"
VBREM_SQLSERVER_AUTHENTICATION="0"
VBREM_SQLSERVER_USERNAME="<SQL_auth_username>"
VBREM_SQLSERVER_PASSWORD="<SQL_auth_password>"
VBREM_TCP_PORT="<TCP_port_for_web_site>">
VBREM_SSLPORT="<SSL_port_for_web_site>"
VBREM_THUMBPRINT="<certificate_hash>"
VBREM_RESTAPISVC_PORT="<TCP_port_for_RestApi_service>">
VBREM_RESTAPISVC_SSLPORT="<SSL_port_for_RestApi_service>"
```

The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output.</td>
</tr>
</tbody>
</table>
|              |                            |          | Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared. Example: /L*v "C:\ProgramData\Veeam\Setup\Temp\Logs\EM.txt"
| /q           | n                          | Yes      | Sets the user interface level to "no", which means no user interaction is needed during installation. |
| /i           | setup file                 | Yes      | Installs Veeam Backup Enterprise Manager.                                  |
|              |                            |          | Specify a full path to the setup file as the parameter value. Example: /i "C:\Veeam\EnterpriseManager\BackupWeb_x64.msi"
<p>| ACCEPTEULA   | yes/no                     | Yes      | Specifies if you want to accept the Veeam license agreement. Specify yes to accept the license agreement and proceed with installation. Example: ACCEPTEULA=&quot;yes&quot; |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</td>
</tr>
<tr>
<td>INSTALLDIR</td>
<td>path</td>
<td>No</td>
<td>Installs the component to the specified location. By default, Veeam Backup &amp; Replication uses the Enterprise Manager subfolder of the <code>C:\Program Files\Veeam</code> folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: INSTALLDIR=&quot;C:\Backup&quot; The component will be installed to the <code>C:\Backup\Enterprise Manager</code> folder.</td>
</tr>
<tr>
<td>VBREM_LICENSE_FILE</td>
<td>license path</td>
<td>Yes</td>
<td>Specifies a full path to the license file. Example: <code>VBREM_LICENSE_FILE=&quot;C:\Users\Administrator\Desktop\enterprise - veeam_backup_trial_0_30.lic&quot;</code></td>
</tr>
<tr>
<td>VBREM_SERVICE_USER</td>
<td>user</td>
<td>No</td>
<td>Specifies the account under which the Veeam Backup Enterprise Manager Service will run. The account must have full control NTFS permissions on the <code>VBRCatalog</code> folder where index files are stored and the <code>Database owner</code> rights for the Veeam Backup Enterprise Manager configuration database on the Microsoft SQL Server that you plan to use. If you do not specify this parameter, the Veeam Backup Enterprise Manager Service will run under the LocalSystem account. Together with the <code>VBREM_SERVICE_USER</code> parameter, you must specify the <code>VBREM_SERVICE_PASSWORD</code> parameter. Example: <code>VBRC_SERVICE_USER=&quot;BACKUPSERVER\Administrator&quot;</code></td>
</tr>
<tr>
<td>VBREM_SERVICE_PASSWORD</td>
<td>password</td>
<td>No</td>
<td>Specifies a password for the account under which the Veeam Backup Enterprise Manager Service will run. Example: <code>VBREM_SERVICE_PASSWORD=&quot;1234&quot;</code></td>
</tr>
<tr>
<td>Option</td>
<td>Parameter</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VBREM_SERVICE_PORT</td>
<td>Port</td>
<td>No</td>
<td>Specifies a TCP port that will be used by the Veeam Backup Enterprise Manager Service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>By default, the port number 9394 is used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> VBREM_SERVICE_PORT = &quot;9394&quot;</td>
</tr>
<tr>
<td>VBREM_SQLSERVER_SERVER</td>
<td>SQL server\instance</td>
<td>No</td>
<td>Specifies a Microsoft SQL Server and instance on which the Veeam Backup Enterprise Manager configuration database will be deployed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>By default, Veeam Backup &amp; Replication uses the (local) \VEEAMSQL2012 server for machines running Microsoft Windows 7 or Microsoft Windows Server 2008 R2, and (local) \VEEAMSQL2016 for machines running Microsoft Windows Server 2012 or later.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> VBREM_SQLSERVER_SERVER = &quot;BACKUPSERVER\VEEAMSQL2012_MY&quot;</td>
</tr>
<tr>
<td>VBREM_SQLSERVER_DATABASE</td>
<td>database</td>
<td>No</td>
<td>Specifies a name of the Veeam Backup Enterprise Manager database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>By default, the database is deployed with the VeeamBackupReporting name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> VBREM_SQLSERVER_DATABASE = &quot;VeeamBackupReporting01&quot;</td>
</tr>
<tr>
<td>VBREM_SQLSERVER_AUTHENTICATION</td>
<td>0/1</td>
<td>No</td>
<td>Specifies if you want to use the Microsoft SQL Server authentication mode to connect to the Microsoft SQL Server where the Veeam Backup Enterprise Manager is deployed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Set this parameter to 1 if you want to use the SQL Server authentication mode. If you do not specify this parameter, Veeam Backup Enterprise Manager will connect to the Microsoft SQL Server in the Microsoft Windows authentication mode (default value is 0).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Together with this parameter, you must specify the following parameters: VBREM_SQLSERVER_USERNAME and VBREM_SQLSERVER_PASSWORD.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Example:</strong> VBREM_SQLSERVER_AUTHENTICATION = &quot;1&quot;</td>
</tr>
<tr>
<td>Option</td>
<td>Parameter</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VBREM_SQLSERVER_USERNAME</td>
<td>user</td>
<td>No</td>
<td>This parameter must be used if you have specified the VBREM_SQLSERVER_AUTHENTICATION parameter. Specifies a LoginID to connect to the Microsoft SQL Server in the SQL Server authentication mode. Example: VBREM_SQLSERVER_USERNAME=&quot;sa&quot;</td>
</tr>
<tr>
<td>VBREM_SQLSERVER_PASSWORD</td>
<td>password</td>
<td>No</td>
<td>This parameter must be used if you have specified the VBR_SQLSERVER_AUTHENTICATION parameter. Specifies a password to connect to the Microsoft SQL Server in the SQL Server authentication mode. Example: VBREM_SQLSERVER_USERNAME=&quot;1234&quot;</td>
</tr>
<tr>
<td>VBREM_TCP_PORT</td>
<td>port</td>
<td>No</td>
<td>Specifies a TCP port that will be used by the Veeam Backup Enterprise Manager website. By default, the port number 9080 is used. Example: VBREM_TCP_PORT=&quot;9080&quot;</td>
</tr>
<tr>
<td>VBREM_SSL_PORT</td>
<td>port</td>
<td>No</td>
<td>Specifies a port that will be used by the Veeam Backup Enterprise Manager website. By default, the port number 9443 is used. Example: VBREM_SSL_PORT=&quot;9443&quot;</td>
</tr>
<tr>
<td>VBREM_THUMBPRINT</td>
<td>hash</td>
<td>No</td>
<td>Specifies the certificate to be used by Veeam Backup Enterprise Manager Service and Veeam RESTful API Service. If this parameter is not specified, a new certificate will be generated by openssl.exe. Example: VBREM_THUMBPRINT=&quot;0677d0b8f27cacc966b15d807b41a101587b488&quot;</td>
</tr>
<tr>
<td>VBREM_RESTAPISVC_PORT</td>
<td>port</td>
<td>No</td>
<td>Specifies a TCP port that will be used by the Veeam Backup Enterprise Manager RESTful API Service. By default, the port number 9399 is used. Example: VBREM_RESTAPISVC_PORT=&quot;9399&quot;</td>
</tr>
<tr>
<td>Option</td>
<td>Parameter</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VBREM_RESTAPISVC_SSLPORT</td>
<td>port</td>
<td>No</td>
<td>Specifies a port that will be used by the Veeam RESTful API Service. By default, the port number 9398 is used. Example: VBREM_RESTAPISVC_SSLPORT=&quot;9398&quot;</td>
</tr>
<tr>
<td>VBREM_CONFIG_SCHANNEL</td>
<td>0/1</td>
<td>No</td>
<td>Specifies if the TLS 1.2 protocol will be used for secure communication with the Veeam Backup Enterprise Manager website.</td>
</tr>
</tbody>
</table>

**Example**

Suppose you want to install Veeam Backup Enterprise Manager with the following settings:

- **Installation log location:** C:\logs\log1.txt
- No user interaction
- **Path to the MSI file:** E:\Veeam\EnterpriseManager\BackupWeb_x64.msi
- **Installation folder:** D:\Program Files\Veeam
- **License file location:** C:\License\veeam_license.lic
- **Service user account:** VEEAM\Administrator
- **Service user account password:** 1234
- **Service port:** default
- **Microsoft SQL Server database:** BACKUPSERVER\VEEAMSQL2012_MY
- **Database name:** VeeamReporting01
- **TCP and TLS ports:** default
- **Certificate:** default
- **TCP port for RESTful API:** 9396
- **TLS port for RESTful API:** 9397

The command to install Veeam Backup Enterprise Manager with such configuration will have the following parameters:

```cmd
msiexec.exe /L*v "C:\logs\log1.txt" /qn /i "E:\Veeam\EnterpriseManager\BackupWeb_x64.msi" ACCEPTEULA="yes" ACCEPT_THIRDPARTY_LICENSES="1" INSTALLDIR="D:\Program Files\Veeam" VBREM_LICENSE_FILE="C:\License\veeam_license.lic" VBREM_SERVICE_USER="VEEAM\Administrator" VBREM_SERVICE_PASSWORD="1234" VBREM_SQLSERVER_SERVER="BACKUPSERVER\VEEAMSQL2012_MY" VBREM_SQLSERVER_DATABASE="VeeamReporting01" VBREM_RESTAPISVC_PORT="9396"
```
Veeam Cloud Connect Portal

Veeam Cloud Connect Portal requires Veeam Backup Enterprise Manager of the same version to be installed on the target machine.

To install Veeam Cloud Connect Portal, use a command with the following syntax:

```
msiexec.exe [/L*v "<path_to_log>" ] /qn /i "<path_to_msi>" ACCEPTEULA="yes" ACCEPT_THIRDPARTY_LICENSES="1" [INSTALLDIR="<path_to_installdir>"] VBCP_SSLPORT="<SSL_port>">
```

The command has the following parameters:

<table>
<thead>
<tr>
<th>Option</th>
<th>Parameter</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L</td>
<td>*v logfile</td>
<td>No</td>
<td>Creates an installation log file with the verbose output. Specify a full path to the log file as the parameter value. A setup log file created during the previous installation is cleared. Example: <code>/L*v &quot;C:\ProgramData\Veeam\Setup\Temp\Logs\CloudPortal.txt&quot;</code></td>
</tr>
<tr>
<td>/q</td>
<td>n</td>
<td>Yes</td>
<td>Sets the user interface level to “no”, which means no user interaction is needed during installation.</td>
</tr>
<tr>
<td>/i</td>
<td>setup file</td>
<td>Yes</td>
<td>Installs the Veeam Cloud Connect Portal. Specify a full path to the setup file as the parameter value. Example: <code>/i &quot;C:\Cloudportal\BackupCloudPortal_x64.msi&quot;</code></td>
</tr>
<tr>
<td>ACCEPTEULA</td>
<td>yes/no</td>
<td>Yes</td>
<td>Specifies if you want to accept the Veeam license agreement. Specify yes to accept the license agreement and proceed with installation. Example: ACCEPTEULA=&quot;yes&quot;</td>
</tr>
<tr>
<td>ACCEPT_THIRDPARTY_LICENSES</td>
<td>0/1</td>
<td>Yes</td>
<td>Specifies if you want to accept the license agreement for 3rd party components that Veeam incorporates. Specify 1 to accept the license agreement and proceed with installation. Example: ACCEPT_THIRDPARTY_LICENSES=&quot;1&quot;</td>
</tr>
<tr>
<td>Option</td>
<td>Paramet er</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>INSTALLDIR</td>
<td>path</td>
<td>No</td>
<td>Installs the component to the specified location. By default, Veeam Backup &amp; Replication uses the CloudPortal subfolder of the C:\Program Files\Veeam\Backup and Replication folder. <strong>Example:</strong> INSTALLDIR=&quot;C:\Backup&quot;. The component will be installed to the C:\Backup\CloudPortal folder</td>
</tr>
<tr>
<td>VBCP_SSLPORT</td>
<td>port</td>
<td>No</td>
<td>Specifies a port that will be used by the Veeam Cloud Connect Portal website. By default, the port number 6443 is used. <strong>Example:</strong> VBREM_SSLPORT=&quot;7443&quot;</td>
</tr>
</tbody>
</table>

**Example**

Suppose you want to install Veeam Cloud Connect Portal with the following configuration:

- No user interaction
- Path to the MSI file: E:\Cloud portal\BackupCloudPortal_x64.msi
- Installation folder: C:\Backup
- TLS port: default

The command to install Veeam Cloud Connect Portal with such configuration will have the following parameters:

```bash
msiexec.exe /qn /L*v "C:\logs\log1.txt" /qn /i "E:\Cloud portal\BackupCloudPortal_x64.msi" ACCEPTEULA="yes" ACCEPT_THIRDPARTY_LICENSES="1" INSTALLDIR="C:\Backup"
```
Backup Infrastructure

Veeam Backup & Replication is a modular solution that lets you build a scalable backup infrastructure for environments of different sizes and configuration. The installation package of Veeam Backup & Replication includes a set of components that you can use to configure the backup infrastructure. Some components are mandatory and provide core functionality; some components are optional and can be installed to provide additional functionality for your business and deployment needs. You can co-install Veeam Backup & Replication components on the same machine, physical or virtual, or you can set them up separately for a more scalable approach.
Backup Infrastructure Components

The Veeam backup infrastructure comprises a set of components. Some components can be deployed with the help of the setup file. Other components can be deployed via the Veeam Backup & Replication console.
Backup Server

The backup server is a Windows-based physical or virtual machine on which Veeam Backup & Replication is installed. It is the core component in the backup infrastructure that fills the role of the “configuration and control center”. The backup server performs all types of administrative activities:

- Coordinates backup, replication, recovery verification and restore tasks
- Controls job scheduling and resource allocation
- Is used to set up and manage backup infrastructure components as well as specify global settings for the backup infrastructure

In addition to its primary functions, a newly deployed backup server also performs the role of the default backup repository, storing backups locally.

Backup Server Services and Components

The backup server uses the following services and components:

- **Veeam Backup Service** is a Windows service that coordinates all operations performed by Veeam Backup & Replication such as backup, replication, recovery verification and restore tasks. The Veeam Backup Service runs under the LocalSystem account or account that has the local Administrator permissions on the backup server.

- **Veeam Guest Catalog Service** manages guest OS file system indexing for VMs and replicates system index data files to enable search through guest OS files. Index data is stored in the Veeam Backup Catalog—a folder on the backup server. The Veeam Guest Catalog Service running on the backup server works in conjunction with search components installed on Veeam Backup Enterprise Manager and (optionally) a dedicated Microsoft Search Server.

- **Mount Service** mounts backups and replicas for file-level access, browsing the VM guest file system and restoring VM guest OS files and application items to the original location.

- **Veeam Backup & Replication Configuration Database** stores data about the backup infrastructure, jobs, sessions and so on. The database instance can be located on a SQL Server installed either locally (on the same machine where the backup server is running) or remotely. For more information, see the following guidelines: [Veeam Backup & Replication Best Practices](#).

  Veeam Backup & Replication maintains the configuration database. Veeam Backup & Replication runs the DatabaseMaintenance system job once a week and when the Veeam Backup Service is restarted. The job updates the database internal statistics, defragments indexes and clears unused data. For details, see the Job.DatabaseMaintenance log file in the %ProgramData%\Veeam\Backup folder.

- **Veeam Backup & Replication Console** provides the application user interface and allows user access to the application's functionality.

- **Veeam Backup PowerShell Snap-In** is an extension for Microsoft Windows PowerShell 2.0 or later. Veeam Backup PowerShell adds a set of cmdlets to allow users to perform backup, replication and recovery tasks through the command-line interface of PowerShell or run custom scripts to fully automate operation of Veeam Backup & Replication.

Credentials Manager

You can use the Credentials Manager to create and maintain a list of credentials records that you plan to use to connect to components in the backup infrastructure.
The Credentials Manager lets you create the following types of credentials records:

- Standard account
- Linux account (user name and password)
- Linux private key (Identity/Pubkey)

**Standard Accounts**

You can create a credentials record for an account that you plan to use to connect to a Microsoft Windows server, a VM running Microsoft Windows OS or a storage system.

To create a new standard credentials record:

1. From the main menu, select **Manage Credentials**.
2. Click **Add > Standard account**.
3. In the **Username** field, enter a user name for the account that you want to add. You can also click **Browse** to select an existing user account.
4. In the **Password** field, enter a password for the account that you want to add. To view the entered password, click and hold the eye icon on the right of the field.
5. In the **Description** field, enter a description for the created credentials record. As there can be a number of similar account names, for example, **Administrator**, it is recommended that you provide a meaningful unique description for the credentials record so that you can distinguish it in the list. The description is shown in brackets, following the user name.

**Linux Accounts (User Name and Password)**

You can create a credentials record for the account that you plan to use to connect to a Linux server or VM running Linux OS.
To create a new credentials record with a user name and password for a Linux server:

1. From the main menu, select Manage Credentials.
2. Click Add > Linux account.
3. In the Username field, enter a user name for the account that you plan to add.
4. In the Password field, enter a password for the account that you want to add. To view the entered password, click and hold the eye icon on the right of the field.
5. In the SSH port field, specify the SSH port over which you want to connect to a Linux server. By default, port 22 is used.
6. If you specify data for a non-root account that does not have root permissions on a Linux server, you can use the Non-root account section to grant sudo rights to this account.
   a. To provide a non-root user with root account privileges, select the Elevate specified account to root check box.
   b. To add the user account to sudoers file, select the Add account to the sudoers file automatically check box. In the Root password field, enter the password for the root account.
      If you do not enable this option, you will have to manually add the user account to the sudoers file.
   c. When registering a Linux server, you have an option to failover to using the su command for distros where the sudo command is not available.
      To enable the failover, select the Use "su" if "sudo" fails check box and in the Root password field, enter the password for the root account.
7. In the Description field, enter a description for the created credentials record. As there can be a number of similar account names, for example, Root, it is recommended that you provide a meaningful unique description for the credentials record so that you can distinguish it in the list. The description is shown in brackets, following the user name.
IMPORTANT!

- You can create a separate user account intended for work with Veeam Backup & Replication on a Linux-based VM, grant root privileges to this account and specify settings of this account in the Credentials Manager. It is recommended that you avoid additional commands output for this user (like messages echoed from within ~/.bashrc or command traces before execution) because they may affect Linux VM processing.
- Cases when root password is required to elevate account rights to root using sudo are no longer supported.

Linux Private Keys (Identity/Pubkey)

You can log on to a Linux server or VM running Linux OS using the Identity/Pubkey authentication method. The Identity/Pubkey authentication method helps protect against malicious applications like keyloggers, strengthens the security level and simplifies launch of automated tasks.

To use the Identity/Pubkey authentication method, you must generate a pair of keys — a public key and private key:

- Public key is stored on Linux servers to which you plan to connect from the backup server. The key is kept in a special `authorized_keys` file containing a list of public keys.

- Private key is stored on the client machine — backup server. The private key is protected with a passphrase. Even if the private key is intercepted, the eavesdropper will have to provide the passphrase to unlock the key and use it.

For authentication on a Linux server, the client must prove that it has the private key matching the public key stored on the Linux server. To do this, the client generates a cryptogram using the private key and passes this cryptogram to the Linux server. If the client uses the “correct” private key for the cryptogram, the Linux server can easily decrypt the cryptogram with a matching public key.
Veeam Backup & Replication has the following limitations for the Identity/Pubkey authentication method:

- Veeam Backup & Replication does not support keys that are stored as binary data, for example, in a file of DER format.
- Veeam Backup & Replication supports only keys whose passphrase is encrypted with algorithms supported by PuTTY:
  - AES (Rijndael): 128-bit, 192-bit and 256-bit CBC or CTR (SSH-2 only)
  - Blowfish: 128-bit CBC
  - Triple-DES: 168-bit CBC
- If you choose to use VMware VIX/vSphere Web Services, Veeam Backup & Replication does not support usage of public keys for guest processing on Linux guest servers.

To add a credentials record using the Identity/Pubkey authentication method:

1. Generate a pair of keys using a key generation utility, for example, ssh-keygen.
2. Place the public key on a Linux server. To do this, add the public key to the `authorized_keys` file in the `.ssh/` directory in the home directory on the Linux server.
3. Place the private key in some folder on the backup server or in a network shared folder.
4. In Veeam Backup & Replication, from the main menu select Manage Credentials.
5. Click Add > Linux private key.
6. In the Username field, specify a user name for the created credentials record.
7. In the Password field, specify the password for the user account. The password is required in all cases except when you use root or a user with enabled NOPASSWD:ALL setting in `/etc/sudoers`.
8. In the Private key field, enter a path to the private key or click Browse to select a private key.
9. In the Passphrase field, specify a passphrase for the private key on the backup server. To view the entered passphrase, click and hold the eye icon on the right of the field.
10. In the SSH port field, specify a number of the SSH port that you plan to use to connect to a Linux server. By default, port 22 is used.
11. If you specify data for a non-root account that does not have root permissions on a Linux server, you can use the Non-root account section to grant sudo rights to this account.
   a. To provide a non-root user with root account privileges, select the Elevate specified account to root check box.
   b. To add the user account to sudoers file, select the Add account to the sudoers file automatically check box. In the Root password field, enter the password for the root account.
      If you do not enable this option, you will have to manually add the user account to the sudoers file.
   c. When registering a Linux server, you have an option to failover to using the su command for distros where the sudo command is not available.
      To enable the failover, select the Use "su" if "sudo" fails check box and in the Root password field, enter the password for the root account.
12. In the Description field, enter a description for the created credentials record. As there can be a number of similar account names, for example, Root, it is recommended that you supply a meaningful unique description for the credentials record so that you can distinguish it in the list. The description is shown in brackets, following the user name.
IMPORTANT!

Cases when root password is required to elevate account rights to root using sudo are no longer supported.

Editing and Deleting Credentials Records

You can edit or delete credentials records that you have created.

To edit a credentials record:

1. From the main menu, select Manage Credentials.
2. Select the credentials record in the list and click Edit.
3. If the credentials record is already used for any component in the backup infrastructure, Veeam Backup & Replication will display a warning. Click Yes to confirm your intention.
4. Edit settings of the credentials record as required.

To delete a credentials record:

1. From the main menu, select Manage Credentials.
2. Select the credentials record in the list and click Remove. You cannot delete a record that is already used for any component in the backup infrastructure.
NOTE:
The Credentials Manager contains 3 system credentials records:
- A credentials record for the Veeam FLR appliance
- A credentials record for the tenant-side network extension appliance
- A credentials record for Microsoft Azure helper appliance.
You cannot delete these credentials records. However, you can edit them: change a password and record description.

Cloud Credentials Manager

You can use the Cloud Credentials Manager to create and maintain a list of credentials records that you plan to use to connect to cloud services.

The Cloud Credentials Manager lets you create the following types of credentials records:
- Veeam Cloud Connect Accounts
- Access Keys for AWS Users
- Microsoft Azure Storage Accounts
- Microsoft Azure Compute Accounts

Veeam Cloud Connect Accounts

You can add a credentials record for a tenant account — an account that you plan to use to connect to a service provider (SP).
Before you add a credentials record, the SP must register a tenant account on the SP Veeam backup server. Tenants without accounts cannot connect to the SP and use Veeam Cloud Connect resources. For more information, see the Registering Tenant Accounts section in the Veeam Cloud Connect Guide.

To create a credentials record for a tenant account:

1. From the main menu, select Manage Cloud Credentials.
2. Click Add > Veeam Cloud Connect service provider account.
3. In the Username field, enter a user name for the account that the SP has provided to you.

   **NOTE:**
   If the SP used vCloud Director to allocate replication resources to you, you must enter a user name for the vCloud Director tenant account in the following format: Organization\Username. For example: TechCompanyOrg\Administrator.

4. In the Password field, enter a password for the account that the SP has provided to you. To view the entered password, click and hold the eye icon on the right of the field.
5. In the Description field, enter a description for the created credentials record.

---

**Access Keys for AWS Users**

You can create a record for credentials that you plan to use to connect to AWS.

To access AWS resources, you can use Identity and Access Management (IAM) user credentials or AWS account root user credentials. However, AWS recommends that you use the IAM user credentials. For details, see the AWS Account Root User Credentials vs. IAM User Credentials section in the AWS General Reference. The permissions that you must provide to the user are listed in the Required Permissions section.
Since Veeam Backup & Replication uses AWS CLI commands to perform operations in AWS, instead of a user name and password you must specify an AWS access key. AWS access keys are long-term user credentials that consist of two parts: an access key ID and a secret access key. For details, see the Managing Access Keys for IAM Users section in the AWS IAM User Guide.

To create a credentials record:

1. From the main menu, select Manage Cloud Credentials.
2. Click Add > Amazon AWS access key.
3. In the Access key field, enter an access key ID.
4. In the Secret key field, enter a secret access key. To view the entered secret key, click and hold the eye icon on the right of the field.
5. In the Description field, enter a description for the created credentials record.

**IMPORTANT!**

It is recommended that the user whose credentials you plan to use to connect to AWS S3 has administrative permissions — access to all AWS S3 actions and resources.

---

**Microsoft Azure Storage Accounts**

You can create a credentials record for an account that you plan to use to connect to Microsoft Azure Blob storage.
The following types of storage accounts are supported.

<table>
<thead>
<tr>
<th>Storage account type</th>
<th>Supported services</th>
<th>Supported performance tiers</th>
<th>Supported access tiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>General-purpose V2</td>
<td>Blob (block blobs only)</td>
<td>Standard</td>
<td>Cool, Hot</td>
</tr>
<tr>
<td>BlobStorage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General-purpose V1</td>
<td>Blob (block blobs only)</td>
<td>Standard</td>
<td>N/A</td>
</tr>
<tr>
<td>BlockBlobStorage</td>
<td>Blob (block blobs only)</td>
<td>Premium</td>
<td>N/A</td>
</tr>
</tbody>
</table>

For more information about the types of storage accounts in Azure, see [Microsoft Docs](https://docs.microsoft.com).

To create a record for a Microsoft Azure storage account:

1. From the main menu, select **Manage Cloud Credentials**.
2. Click **Add > Microsoft Azure storage account**.
3. In the **Account** field, enter the storage account name.
4. In the **Shared key** field, enter the storage account shared key. To view the entered key, click and hold the eye icon on the right of the field.
5. In the **Description** field, enter an optional description for the credentials record.
TIP:
If you do not have a Microsoft Azure storage account, you can create it in the Azure portal, as described in the Azure Storage Documentation.

Microsoft Azure Compute Accounts
You can create a credentials record for accounts that will be used for restore to Microsoft Azure.

To create a record for a Microsoft Azure or Microsoft Azure Stack account:
1. From the main menu, select Manage Cloud Credentials.
2. Click Add > Microsoft Azure compute account.
3. Follow the steps of the Initial Configuration wizard as described in Adding Microsoft Azure Accounts or Adding Microsoft Azure Stack Accounts sections.

Editing and Deleting Credentials Records
You can edit or delete existing cloud credentials records.

To edit a credentials record:
1. From the main menu, select Manage Cloud Credentials.
2. Select the credentials record in the list and click Edit.
3. Edit settings of the credentials record as required.

To delete a credentials record:
1. From the main menu, select Manage Credentials.
2. Select the credentials record in the list and click **Remove**. You cannot delete a record that is already used for any component in the backup infrastructure.

**TIP:**
You can use the Cloud Credentials Manager to change the password for a tenant account provided by the SP. For more information, see the Changing Password for Tenant Account section in the Veeam Cloud Connect Guide.

**Password Manager**

You can use the Password Manager to create and maintain a list of passwords that you plan to use for data encryption. Password management can be helpful in the following situations:

- You want to create new passwords. You can use one password per job or share the same password between several jobs on the backup server.
- You want to edit an existing password, for example, change its hint, or delete a password.

**TIP:**
Periodical change of passwords is a security best practice. You can create new passwords as often as you need based on your company security needs and regulatory requirements.

**Creating Passwords**

You can use the Password Manager to create one or more passwords.

To create a new password:

1. From the main menu, select **Manage Passwords**. Alternatively, you can use job properties to create a new password:
   a. Open the **Home** view.
   b. In the inventory pane, select **Jobs**.
   c. In the working area, right-click the backup or backup copy job and select **Edit**.
   d. At the **Storage** step of the wizard (for backup job) or **Target** step of the wizard (for backup copy job), click **Advanced**.
   e. Click the **Storage** tab.
   f. In the **Encryption** section of the Advanced Setting window, select the **Enable backup file encryption** check box and click the **Manage passwords** link.

   Veeam Backup & Replication will open the Password Manager.

2. In the Password Manager, click **Add**.

3. In the **Hint** field, specify a hint for the created password. It is recommended that you provide a meaningful hint that will help you recall the password. The password hint is displayed when you import an encrypted file on the backup server and access this file.

4. In the **Password** field, enter a password. To view the entered password, click and hold the eye icon on the right of the field.
IMPORTANT!
Always save a copy of the password you create in a secure place. If you lose the password, you will not be able to restore it.

Editing Passwords

You can edit passwords you have created using the Password Manager.

To edit a password:

1. From the main menu, select Manage passwords. Alternatively, you can use job properties to edit the password:
   a. Open the Home view.
   b. In the inventory pane, select Jobs.
   c. In the working area, right-click the backup or backup copy job and select Edit.
   d. At the Storage step of the wizard (for backup job) or Target step of the wizard (for backup copy job), click Advanced.
   e. Click the Storage tab.
   f. In the Encryption section of the Advanced Setting window, select the Enable backup file encryption check box and click the Manage passwords link.

   Veeam Backup & Replication will open the Password Manager.

2. In the Password Manager, select the password and click Edit.
3. Edit the password data: hint and password, as required.

Deleting Passwords

You can delete passwords using the Password Manager.

You cannot remove a password that is currently used by any job on the backup server. To remove such password, you first need to delete a reference to this password in the job settings.

To delete a password:

1. From the main menu, select Manage passwords. Alternatively, you can use job properties to delete passwords:
   a. Open the Home view.
   b. In the inventory pane, select Jobs.
   c. In the working area, right-click the backup or backup copy job and select Edit.
   d. At the Storage step of the wizard (for backup job) or Target step of the wizard (for backup copy job), click Advanced.
   e. Click the Storage tab.
   f. In the Encryption section of the Advanced Setting window, select the Enable backup file encryption check box and click the Manage passwords link.

Veeam Backup & Replication will open the Password Manager.
2. In the Password Manager, select the password and click **Remove**.
Backup & Replication Console

The Veeam Backup & Replication console is a client-side component that provides access to the backup server. The console allows you to log in to Veeam Backup & Replication and perform all kinds of data protection and disaster recovery operations on the backup server.

The console does not have a direct access to the backup infrastructure components and configuration database. Such data as user credentials, passwords, roles and permissions are stored on the backup server side. To access this data, the console needs to connect to the backup server and query this information periodically during the work session.

To make users work as uninterrupted as possible, the remote console maintains the session for 5 minutes if the connection is lost. If the connection is re-established within this period, you can continue working without re-logging to the console.

Backup & Replication Console Deployment

The console is installed locally on the backup server by default. You can also use it in a standalone mode — install the console on a dedicated machine and access Veeam Backup & Replication remotely over the network.

You can install as many remote consoles as you need so that multiple users can access Veeam Backup & Replication simultaneously. Veeam Backup & Replication prevents concurrent modifications on the backup server. If several users are working with Veeam Backup & Replication at the same time, the user who saves the changes first has the priority. Other users will be prompted to reload the wizard or window to get the most recent information about the changes in the configuration database.

If you have multiple backup servers in the infrastructure, you can connect to any of them from the same console. For convenience, you can save several shortcuts for these connections.

IMPORTANT!

You cannot use the same console to connect to backup servers with different versions of Veeam Backup & Replication. Mind this if you have more than one backup server in your backup environment, and these backup servers run different versions of Veeam Backup & Replication. For example, if one of your backup servers run version 9.5 Update 3, and another backup server runs version 9.5 Update 4, you will need to use 2 separate consoles for connecting to these servers.

The console supports automatic update. Every time you connect to the backup server locally or remotely, the console checks for updates. If the backup server has a patch or updates installed, the console will be updated automatically.

Mind the following:

- Upgrade to another Veeam Backup & Replication major product version is not supported. If you upgrade Veeam Backup & Replication to another major version, you must upgrade the console to the same version manually. Automatic upgrade is not supported for Preview, Beta or RTM versions of Veeam Backup & Replication.

- Downgrade of the console is not supported. If the console is of a higher version than the backup server (for example, you have upgraded the console manually), the connection to the server will fail.

If other Veeam Backup & Replication components, such as Veeam Cloud Connect Portal or Veeam Backup Enterprise Manager, are installed on the machine where the console runs, these components will also be upgraded.
Backup & Replication Console Components

When you install a remote console on a machine, Veeam Backup & Replication installs the following components:

- Veeam Backup PowerShell Snap-In
- Veeam Explorer for Microsoft Active Directory
- Veeam Explorer for Microsoft Exchange
- Veeam Explorer for Oracle
- Veeam Explorer for Microsoft SQL
- Veeam Explorer for Microsoft SharePoint
- Veeam Explorer for Microsoft OneDrive for Business
- Mount server

Backup & Replication Console User Access Rights

To log in to Veeam Backup & Replication via the console, the user must be added to the Local Users group on the backup server or a group of domain users who have access to the backup server. The user can perform the scope of operations permitted by his or her role in Veeam Backup & Replication. For more information, see Assigning Roles to Users.

Requirements for Backup & Replication Console

A machine on which you install the Veeam Backup & Replication console must meet the following requirements:

- The machine must meet the system requirements. For more information, see System Requirements.
- The remote console can be installed on a Microsoft Windows machine (physical or virtual).
- If you install the console remotely, you can deploy it behind NAT. However, the backup server must be outside NAT. The opposite type of deployment is not supported: if the backup server is deployed behind NAT and the remote console is deployed outside NAT, you will not be able to connect to the backup server.

Limitations for Backup & Replication Console

The Veeam Backup & Replication console has the following limitations:

- You cannot perform restore from the configuration backup via the remote console.
- The machines on which the remote console is installed are not added to the list of managed servers automatically. For this reason, you cannot perform some operations, for example, import backup files that reside on the remote console machine or assign roles of backup infrastructure components to this machine. To perform these operations, you must add the remote console machine as a managed server to Veeam Backup & Replication. For more information, see Managing Servers.
Logging on to Veeam Backup & Replication

To log on to Veeam Backup & Replication, you must open the Veeam Backup & Replication console and specify connection settings to access the backup server.

1. To open the Veeam Backup & Replication console, do one of the following:
   - Double-click the console icon on the desktop.
   - From the Microsoft Windows Start menu, select All Programs > Veeam > Veeam Backup & Replication Console.
   - Use the Microsoft Windows search to find the Veeam Backup & Replication Console program on the computer.

2. In the Server field, type the name or IP address of the backup server or select it from the list of recent connections. By default, the console connects to the backup server installed locally — localhost.

3. In the Port field, enter the port over which you want to connect to the backup server. The port number is set at the Port Configuration step of the setup wizard for Veeam Backup & Replication. By default, port 9392 is used.

4. In the Username and Password fields, enter credentials of the user account that you want to use to connect to the backup server. The user account must be added to the Local Users group on the backup server or a group of domain users who have access to the backup server.

   You can also select the Use Windows session authentication check box. In this case, you will log on to Veeam Backup & Replication using the account under which you are currently logged on to Microsoft Windows.

5. To create a shortcut for the connection, click Save shortcut. You can create as many shortcuts as you need.

NOTE:

If you create a shortcut for a connection, the credentials for this connection will be stored in the Windows Credentials Manager. The credentials are saved after the first successful logon.
Virtualization Servers and Hosts

You can add the following types of servers and hosts to the backup infrastructure:

- **Microsoft Hyper-V Server**
- **Microsoft SMB3 Server**
- **Microsoft Windows Server**
- **Linux Server**

You can add physical machines and VMs to the backup infrastructure and assign different roles to them. The table below describes which roles can be assigned to the different types of servers.

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Source Host</th>
<th>Target Host</th>
<th>Off-Host Backup Proxy</th>
<th>Backup Repository</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Hyper-V Server (standalone Microsoft Hyper-V host, SCVMM or Hyper-V cluster)</td>
<td>🟢</td>
<td>🟢</td>
<td>🌴</td>
<td>🌴 (not recommended)</td>
</tr>
<tr>
<td>Microsoft SMB3 server</td>
<td>🟢</td>
<td>🌴</td>
<td>🌴</td>
<td>🌴</td>
</tr>
<tr>
<td>Microsoft Windows server</td>
<td>🌴</td>
<td>🌴</td>
<td>🌴</td>
<td>🌴</td>
</tr>
<tr>
<td>Linux server</td>
<td>🌴</td>
<td>🌴</td>
<td>🌴</td>
<td>🌴</td>
</tr>
</tbody>
</table>

**NOTE:**

You can also add the following servers:

- Hyper-V servers. For more information on how to add servers, see the Adding Microsoft Hyper-V Servers section in the Veeam Backup & Replication User Guide for Microsoft Hyper-V.
- Veeam Backup for AWS servers. For more information on how to add servers, see the Deployment and Configuration section in the Plug-in for Veeam Backup for AWS User Guide.
- Nutanix AHV clusters. For more information on how to add clusters, see the Deployment section in the Veeam Backup for Nutanix AHV User Guide.

**Related Topics**

- Rescanning Servers
- Editing Server Settings
- Removing Servers
Adding Microsoft Hyper-V Servers

You must add to the backup infrastructure Microsoft Hyper-V hosts that you plan to use as source and target for backup, replication and other activities.

You can connect standalone Hyper-V hosts, Hyper-V clusters or SCVMM servers. If a Hyper-V host is added to a cluster, it is recommended that you add to the backup infrastructure a cluster, not a standalone Hyper-V host. If you move VMs between hosts in the cluster, you will not have to reconfigure jobs in Veeam Backup & Replication. Veeam Backup & Replication will automatically locate migrated VMs and continue processing them as usual.

Note that it is not necessary to add SCVMM servers to Veeam Backup & Replication — you can add directly Hyper-V hosts or clusters managed by SCVMM.

Before you add a Microsoft Hyper-V server, check prerequisites. Then use the New Hyper-V Server wizard to add the server.

NOTE:

If you add a Hyper-V host to a cluster that is already added to your backup infrastructure, Veeam Backup & Replication may not display this Hyper-V host in the list of managed servers. To display the Hyper-V host and make it accessible from the Veeam Backup & Replication console, do the following:

- If the Hyper-V host is added to a cluster that is managed by SCVMM, right-click the SCVMM server, select Properties and go through the steps of the Edit Hyper-V Server wizard.
- If the Hyper-V host is added to a cluster that is not managed by SCVMM, right-click the cluster and select Rescan.

To ensure that all Veeam Backup & Replication components on the Hyper-V host are up to date, right-click the Hyper-V host, select Properties and go through the steps of the Edit Hyper-V Server wizard.

Before You Begin

Before you add a Microsoft Hyper-V server to the backup infrastructure, check the following prerequisites:

- Make sure that you do not add to the backup infrastructure Hyper-V hosts or clusters managed by an SCVMM server if this SCVMM server is already added to the backup infrastructure.

- File and printer sharing must be enabled in network connection settings of the added Microsoft Hyper-V host. On every connected Microsoft Hyper-V host, Veeam Backup & Replication deploys a set of components:
  o Veeam Installer Service
  o Veeam Data Mover Service
  o Veeam Hyper-V Integration Service

If file and printer sharing is not enabled on the host, Veeam Backup & Replication will fail to deploy these components.

- [For SCVMM] SCVMM Admin UI must be installed on the backup server. Otherwise, you will not be able to add SCVMM servers to the backup infrastructure.
  SCVMM console version must match the management server version.

- Make sure that the NETBIOS name of the Microsoft Hyper-V Server is successfully resolved.
Step 1. Launch New Hyper-V Server Wizard

To launch the New Hyper-V Server wizard, do one of the following:

- Open the Backup Infrastructure view. In the inventory pane, select the Managed Servers node and click Add Server on the ribbon or right-click the Managed Servers node and select Add Server. In the Add Server window, click Microsoft Hyper-V > Hyper-V.

- Open the Inventory or Files view. In the inventory pane select the Microsoft Hyper-V node and click Add Server on the ribbon. You can also right-click the Microsoft Hyper-V node and select Add Server.

Microsoft Hyper-V

Select the type of a Microsoft server you want to add to inventory.

- **Hyper-V**
  - Adds SCVMM server, Hyper-V cluster, or standalone host (2008 R2 or later) to the inventory.

- **SMB3**
  - Adds SMB3 server cluster, or standalone SMB3 server.
Step 2. Specify Server Name or Address

At the **Name** step of the wizard, specify an address and description for the Microsoft Hyper-V server.

1. Enter a full DNS name or IP address of the Microsoft Hyper-V server.

2. Provide a description for future reference. The default description contains information about the user who added the server, date and time when the server was added.

![New Hyper-V Server dialog box](image)
Step 3. Choose Server Type

At the **Type** step of the wizard, select the type of server that you want to add.

- **Select Microsoft System Center Virtual Machine Manager** if you want to add SCVMM that manages several Microsoft Hyper-V hosts. Veeam Backup & Replication will pull information about Microsoft Hyper-V hosts and clusters managed by SCVMM and add them to the list of servers as a part of the SCVMM hierarchy.

- **Select Microsoft Hyper-V cluster** if you want to add a Microsoft Hyper-V cluster not managed by SCVMM.

- **Select Microsoft Hyper-V server** if you want to add a standalone Microsoft Hyper-V host that is not a part of the Microsoft Hyper-V cluster and is not managed by SCVMM.
Step 4. Specify Credentials

At the **Credentials** step of the wizard, specify credentials for the Microsoft Hyper-V server.

1. From the **Credentials** list, select credentials for the account that has administrator privileges on the Microsoft Hyper-V server. If you have not set up credentials beforehand, click the **Manage accounts** link or click **Add** on the right to add the credentials. For more information, see **Managing Credentials**.

Veeam Backup & Replication will use the provided credentials to deploy the following components on every added server:

- Veeam Installer Service
- Veeam Data Mover Service
- Veeam Hyper-V Integration Service

If you are adding SCVMM, the same credentials will be applied to all Microsoft Hyper-V hosts managed by SCVMM. If some Microsoft Hyper-V hosts use their own credentials different from those you have provided, Veeam Backup & Replication will fail to deploy components on these hosts. You will have to specify credentials for such Microsoft Hyper-V hosts separately.

After you connect SCVMM, expand it in the inventory pane to see the list of managed Microsoft Hyper-V hosts. Right-click the host, select **Properties** and use the **Edit Hyper-V Server** wizard to specify the credentials for this host.

2. To customize network ports used by Veeam Backup & Replication components, click **Ports**. By default, Veeam Backup & Replication components use the following ports:

- Veeam Installer Service: port 6160
- Veeam Data Mover Service: port 6162
- Veeam Hyper-V Integration Service: port 6163

If necessary, adjust port numbers.

3. In the Data transfer options section of the Network Settings window, specify connection settings for file copy operations. Provide a range of ports that will be used as transmission channels between the source host and target host (one port per task). By default, Veeam Backup & Replication uses port range 2500-5000. If the virtual environment is not large and data traffic will not be significant, you can specify a smaller range of ports, for example, 2500-2510 to run 10 concurrent jobs at the same time.

4. If the Microsoft Hyper-V host is deployed outside NAT, in the Preferred TCP connection role section select the Run server on this side check box. In the NAT scenario, the outside client cannot initiate a connection to the server on the NAT network. As a result, services that require initiation of the connection from outside can be disrupted. With this option selected, you will be able to overcome this limitation and initiate a 'server-client' connection — that is, a connection in the direction of the Microsoft Hyper-V host.
Step 5. Review Components

At the **Apply** step of the wizard, review what Veeam Backup & Replication components are already installed on the server and what components will be installed.

1. If you add SCVMM or a Microsoft Hyper-V cluster, Veeam Backup & Replication will check every managed Microsoft Hyper-V host to install or update the components. If you do not plan to use some Microsoft Hyper-V hosts for data protection operations, you can clear check boxes next to these hosts in the list. Veeam Backup & Replication will not deploy or update its components on excluded hosts, although such hosts will be available in the SCVMM hierarchy.

   If necessary, you can instruct Veeam Backup & Replication to install components on hosts that were initially excluded later. To do this, open the **Backup infrastructure** view, in the inventory pane select the added SCVMM or Microsoft Hyper-V cluster. In the working area right-click the Microsoft Hyper-V host and select **Properties**.

2. If you add a standalone Microsoft Hyper-V host, in the **Max concurrent tasks** field specify the number of tasks that the Microsoft Hyper-V host must handle in parallel. If this value is exceeded, Veeam Backup & Replication will not start a new task against the Microsoft Hyper-V host until one of current tasks is finished.

   Veeam Backup & Replication creates one task per every VM disk. By default, the **Max concurrent tasks** value is set to 4.

   Limiting the number of concurrent tasks may be necessary if you plan to work in the on-host backup mode (where the Microsoft Hyper-V host performs the role of the default backup proxy) and want to balance the workload in the backup infrastructure.
The Max concurrent tasks field is displayed only for standalone Microsoft Hyper-V hosts. To limit the number of concurrent tasks for hosts managed by SCVMM or Microsoft Hyper-V cluster, you need to set this value in settings of each Microsoft Hyper-V host in the SCVMM hierarchy or cluster separately. To do this, open the Backup Infrastructure view, in the inventory pane select the added SCVMM or Microsoft Hyper-V cluster, in the working area right-click the Microsoft Hyper-V host and select Properties.
Step 6. Finish Working with Wizard

At the **Results** step of the wizard, complete the procedure of Microsoft Hyper-V server adding.

1. Review details of the Microsoft Hyper-V server.
2. Click **Next**, then click **Finish** to exit the wizard.
Step 7. Specify Settings for Connected Volumes

After you add a Microsoft Hyper-V host to the backup infrastructure, you can configure the following settings for the host:

- Enable or disable changed block tracking
- Specify volume-specific settings
- Enable or disable failover to a software VSS provider

Before you specify settings for a Microsoft Hyper-V host, you must rescan volumes of the added host. During volume rescan, Veeam Backup & Replication retrieves information about disks and volumes that are currently connected to the Microsoft Hyper-V host and writes this information to the configuration database.

Veeam Backup & Replication automatically performs volume rescan every 4 hours. You can also start volume rescan manually:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Managed servers.
3. In the working area, select the host and click Rescan on the ribbon. Alternatively, you can right-click the host and select Rescan.

Changed Block Tracking Settings

By default, Veeam Backup & Replication uses changed block tracking for processing Microsoft Hyper-V VMs. You can disable changed block tracking, for example, for testing purposes.

Change block tracking is enabled and disabled at the level of the Microsoft Hyper-V host.

**IMPORTANT!**

The Disable changed block tracking for this host option does not affect changed block tracking on Microsoft Hyper-V Server 2016 and later.

To disable changed block tracking:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Managed servers.
3. In the working area, select the host and click Manage Volumes on the ribbon. Alternatively, you can right-click the host and select Manage Volumes.
4. In the Manage Volumes window, select the Disable changed block tracking for this host check box.

![](image)

Volume-Specific Settings

You can define volume-specific settings for a Microsoft Hyper-V host: select what VSS provider must be used for snapshot creation and specify the maximum number of concurrent snapshots that must exist for the volume.

To specify volume-specific settings:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Managed servers.
3. In the working area, select the host and click Manage Volumes on the ribbon. Alternatively, you can right-click the host and select Manage Volumes.
4. Select the volume in the list and click Edit.
5. [For Microsoft Hyper-V 2012 R2 and earlier] To take a VSS snapshot of a specific volume, Veeam Backup & Replication uses one of VSS providers available for this volume. To explicitly define what VSS provider must be used for the volume, select the VSS provider from the VSS provider list. If a VSS provider is not set explicitly, Veeam Backup & Replication will scan the list of available VSS providers and select the most appropriate one automatically.
6. [For Microsoft Hyper-V 2012 R2 and earlier] You can simultaneously store 4 snapshots of one volume. To change this number, specify the Max snapshots value. It is not recommended that you increase the number of snapshots for slow storage. Many snapshots existing at the same time may cause VM processing failures.

[For Microsoft Hyper-V Server 2016 and later] You can simultaneously store 4 VM checkpoints on one volume. To change this number, specify the Max snapshots value. Note that this limitation works only for checkpoints created during Veeam Backup & Replication data protection tasks.

VSS Provider Failover Settings

If you have selected to use a hardware VSS provider, Veeam Backup & Replication uses the specified hardware VSS provider for volume snapshot creation. If the hardware VSS provider does not manage to create a volume snapshot for some reason, Veeam Backup & Replication automatically fails over to a software VSS provider.

By default, the failover option is enabled. To disable failover to a software VSS provider:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Managed servers.
3. In the working area, select the host and click Manage Volumes on the ribbon. Alternatively, you can right-click the host and select Manage Volumes.
4. In the Manage Volumes window, clear the Failover to Software VSS Provider if Hardware VSS Provider fails, or is not available check box.

Adding Microsoft SMB3 Servers

Veeam Backup & Replication supports Microsoft Hyper-V VMs whose disks reside on Microsoft SMB3 file shares and lets you perform backup, replication and file copy operations for such VMs.

To work with VMs residing on Microsoft SMB3 shared folders, you must add to the backup infrastructure the following components:

- Microsoft Hyper-V host on which VMs are registered
- Microsoft SMB3 server or cluster hosting shared folders with VM disks

If you do not add a Microsoft SMB3 server or cluster to the backup infrastructure, Veeam Backup & Replication will not be able to use the changed block tracking mechanism to process such VMs.

If the SMB3 server host has several assigned roles (e.g. if the host is a Hyper-V server and an SMB3 server for another Hyper-V host), Veeam Backup & Replication will not be able to use the changed block tracking mechanism.

NOTE:

If VMs whose disks reside on SMB3 shared folders are registered on Microsoft Hyper-V Server 2016 or later, adding a Microsoft SMB3 server is not required. Note, however, that if you do not add the Microsoft SMB3 server, you will not be able to specify the Max snapshots and latency control settings for SMB3 shared folders.

Before you add a Microsoft SMB3 server or cluster, check prerequisites. Then use the New SMB3 Server wizard to add the server or cluster.
Before You Begin

Before you add a Microsoft SMB3 server or cluster to the backup infrastructure, check the following prerequisites:

- Microsoft SMB3 servers must run Microsoft Windows Server 2012 or later. Veeam Backup & Replication supports only these types of Microsoft SMB3 servers.
- Microsoft SMB3 shared folders must be properly configured. For a full list of requirements for Microsoft SMB3 shared folders, see the Requirements and supported configurations section at Microsoft Docs.
- VMs must not reside on hidden shared folders or default shared folders such as C$ or D$. When rescanning Microsoft SMB3 file shared folders, Veeam Backup & Replication skips these types of folders.
- [For Veeam Cloud Connect Replication scenario] You cannot use Microsoft SMB3 shared folder as a storage for VM replicas.
- To read/write data from/to an SMB3 share, Veeam Backup & Replication uses the account that you provide when adding the Microsoft SMB3 server or cluster. Make sure that this account has Full Control permissions in the security settings for SMB3 shares configured on the scale-out file server.
Step 1. Launch New SMB3 Server Wizard

To launch the **New SMB3 Server** wizard, do the following:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, right-click the **Managed Servers** node and select **Add Server**. Alternatively, you can click **Add Server** on the ribbon.
3. In the **Add Server** window, click **Microsoft Hyper-V > SMB3**.

---

**Microsoft Hyper-V**
Select the type of a Microsoft server you want to add to inventory.

- **Hyper-V**
  - Adds SCVMM server, Hyper-V cluster, or standalone host (2008 R2 or later) to the inventory.

- **SMB3**
  - Adds SMB3 server cluster, or standalone SMB3 server.
Step 2. Specify Server Name or Address

At the **Name** step of the wizard, specify an address and description for the Microsoft SMB3 server or cluster.

1. Enter a full DNS name or IP address of the Microsoft SMB3 server or cluster.
2. Provide a description for future reference. The default description contains information about the user who added the server, date and time when the server was added.

![New SMB3 Server dialog box](image-url)
Step 3. Specify Server Type

At the **Type** step of the wizard, select what type of Microsoft SMB3 server you want to add.

- Select **Clustered file server** if you want to add a Microsoft SMB3 cluster to the backup infrastructure. Veeam Backup & Replication supports high availability and scale-out Microsoft SMB3 clusters.
- Select **Standalone file server** if you want to add a standalone Microsoft SMB3 server to the backup infrastructure.
Step 4. Specify Credentials

At the **Credentials** step of the wizard, specify credentials for the Microsoft SMB3 server or cluster.

1. From the **Credentials** list, select credentials for the account that has administrator privileges on the Microsoft SMB3 server or cluster. If you have not set up credentials beforehand, click the **Manage accounts** link or click **Add** on the right to add the credentials. For more information, see Managing Credentials.
   - For domain user accounts, the user name must be specified in the `DOMAIN\USERNAME` format.
   - For local user accounts, the user name must be specified in the `HOSTNAME\USERNAME` format.

Veeam Backup & Replication will use the provided credentials to deploy the following components on the Microsoft SMB3 server or cluster nodes:
   - Veeam Installer Service
   - Veeam Data Mover Service
   - Veeam Hyper-V Integration Service

2. To customize network ports used by Veeam Backup & Replication components, click **Ports**. By default, Veeam Backup & Replication components use the following ports:
   - Veeam Installer Service: port 6160
   - Veeam Data Mover Service: port 6162
   - Veeam Hyper-V Integration Service: port 6163

   If necessary, adjust port numbers.
3. In the **Data transfer options** section of the **Network Settings** window, specify connection settings for file copy operations. Provide a range of ports that will be used as transmission channels between the source server and target server (one port per task). By default, Veeam Backup & Replication uses port range 2500-5000. If the virtual environment is not large and data traffic will not be significant, you can specify a smaller range of ports, for example, 2500-2510 to run 10 concurrent jobs at the same time.

4. If the Microsoft SMB3 server or cluster is deployed outside NAT, in the **Preferred TCP connection role** section select the **Run server on this side** check box. In the NAT scenario, the outside client cannot initiate a connection to the server on the NAT network. As a result, services that require initiation of the connection from outside can be disrupted. With this option selected, you will be able to overcome this limitation and initiate a ‘server-client’ connection — that is, a connection in the direction of the Microsoft SMB3 server or cluster.
Step 5. Review Components

At the **Apply** step of the wizard, review what Veeam Backup & Replication components are already installed on the server and what components will be installed.

1. Review the components.
2. Click **Apply** to add the Microsoft SMB3 server or cluster to the backup infrastructure.
Step 6. Finish Working with Wizard

At the Result step of the wizard, complete the procedure of Microsoft SMB3 server or cluster adding.

1. Review details of the Microsoft SMB3 server or cluster.
2. Click Next, then click Finish to exit the wizard.
Step 7. Configure SMB3 Shares

After you have added a Microsoft SMB3 server, you can configure the following settings for shared folders hosted on this server:

- Enable or disable changed block tracking
- Define the number of concurrent snapshots for a shared folder

Before you specify settings for a Microsoft SMB3 server, you must rescan shared folders on this server. During shared folders rescan, Veeam Backup & Replication retrieves information about shared folders that are currently hosted on a Microsoft SMB3 server, updates the list of shared folders and writes this information to the configuration database.

Veeam Backup & Replication automatically rescans the list of shared folders every 4 hours. You can also start shared folders rescan manually:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Managed servers.
3. In the working area, select the Microsoft SMB3 server and click Rescan on the ribbon. Alternatively, you can right-click the Microsoft SMB3 server and select Rescan.

Changed Block Tracking Settings

By default, Veeam Backup & Replication uses changed block tracking for processing all VMs that reside on shared folders hosted by a Microsoft SMB3 server. You can disable changed block tracking, for example, for testing purposes.

Change block tracking is enabled and disabled at the level of the Microsoft Hyper-V host.

**IMPORTANT!**

The Disable changed block tracking for this host setting does not apply to VMs that are registered on Microsoft Hyper-V Server 2016 and later.

To disable changed block tracking:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Managed servers.
3. In the working area, select the Microsoft SMB3 server and click Shared Folders on the ribbon. Alternatively, you can right-click the Microsoft SMB3 server and select Shared Folders.
4. In the Manage Volumes window, select the Disable changed block tracking for this host check box.

Shared Folder Settings

You can specify the maximum number of concurrent Hyper-V snapshots that must exist for a shared folder hosted by a Microsoft SMB3 server.

To specify shared folder settings:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Managed servers.
3. Select the necessary Microsoft SMB3 server in the working area and click Manage Volumes on the ribbon. Alternatively, you can right-click the necessary Microsoft SMB3 server in the working area and select Manage Volumes.
4. Select the necessary shared folder in the list and click Edit.
5. By default, jobs working with the same shared folder can take up to 4 snapshots of a folder simultaneously. If necessary, you can increase or decrease the number of snapshots that can exist at the same time. It is not recommended to increase the number of snapshots for slow storage: a great number of snapshots existing at the same time may cause VM processing failures.
NOTE:
For VMs hosted on Microsoft Hyper-V Server 2016 and later, the **Snapshots** value defines the maximum number of checkpoints that may be retained for a processed VM. The setting is specified at the level of a shared folder in which VM disks reside.

Adding Microsoft Windows Servers

You must add to the backup infrastructure Microsoft Windows servers that you plan to use as backup infrastructure components and servers that you plan to use for various types of restore operations.

Before you add a Microsoft Windows server, check prerequisites. Then use the **New Windows Server** wizard to add the server.

Before You Begin

Before you add a Microsoft Windows server to the backup infrastructure, check network connection settings of this server.

- File and printer sharing must be enabled in network connection settings of the added Microsoft Windows server. On every connected Microsoft Windows server, Veeam Backup & Replication deploys two components:
  - Veeam Installer Service
  - Veeam Data Mover Service

  If file and printer sharing is not enabled, Veeam Backup & Replication will fail to deploy these components.

- If you plan to use PowerShell Direct, Microsoft PowerShell 2.0 must be installed on the added server.
Step 1. Launch New Windows Server Wizard

To launch the New Windows Server wizard, do one of the following:

- Open the Backup Infrastructure or Files view, in the inventory pane select the Microsoft Windows node and click Add Server on the ribbon.

- Open the Backup Infrastructure view. In the inventory pane, select the Managed Servers node and click Add Server on the ribbon or right-click the Managed Servers node and select Add Server. In the Add Server window, select Microsoft Windows.

Add Server

Select the type of a server you want to add to your backup infrastructure. All already registered servers can be found under the Managed Servers node on the Backup Infrastructure tab.

- **VMware vSphere**
  Adds VMware private cloud infrastructure servers to the inventory.

- **Microsoft Hyper-V**
  Adds Microsoft private cloud infrastructure servers to the inventory.

- **Microsoft Windows**
  Add Microsoft Windows server (Windows 2008 or later).

- **Linux**
  Adds Linux server (must use bash shell, and have SSH and Perl installed).
Step 2. Specify Server Name or Address

At the **Name** step of the wizard, specify an address and description for the Microsoft Windows server.

1. Enter a full DNS name or IP address of the Microsoft Windows server.
2. Provide a description for future reference. The default description contains information about the user who added the server, date and time when the server was added.

![New Windows Server dialog box with fields for DNS name or IP address and description.](image)
Step 3. Specify Credentials

At the **Credentials** step of the wizard, specify credentials for the Microsoft Windows server.

1. From the **Credentials** list, select credentials for the account that has administrator privileges on the Microsoft Windows server. If you have not set up credentials beforehand, click the **Manage accounts** link or click **Add** on the right to add the credentials. For more information, see **Managing Credentials**.

Veeam Backup & Replication will use the provided credentials to deploy its components on the added server.

2. To customize network ports used by Veeam Backup & Replication components, click **Ports**. For default ports used by the Veeam Backup & Replication components, see **Used Ports**.

   If necessary, adjust port numbers.

3. In the **Data transfer options** section of the **Network Settings** window, specify connection settings for file copy operations. Provide a range of ports that will be used as transmission channels between the source server and target server (one port per task). By default, Veeam Backup & Replication uses port range 2500-5000.

   If the virtual environment is not large and data traffic will not be significant, you can specify a smaller range of ports, for example, 2500-2510 to run 10 concurrent tasks at the same time. Keep in mind that Veeam Backup & Replication processes each VM disk as a separate task.
4. If the Microsoft Windows server is deployed outside NAT, in the **Preferred TCP connection role** section select the **Run server on this side** check box. In the NAT scenario, the outside client cannot initiate a connection to the server on the NAT network. As a result, services that require initiation of the connection from outside can be disrupted. With this option selected, you will be able to overcome this limitation and initiate a ‘server-client’ connection — that is, a connection in the direction of the Microsoft Windows server.
Step 4. Review Components

At the **Review** step of the wizard, review what Veeam Backup & Replication components are already installed on the server and what components will be installed.

1. Review the components.
2. Click **Apply** to add the Microsoft Windows server to the backup infrastructure.
Step 5. Finish Working with Wizard

At the **Apply** step of the wizard, complete the procedure of Microsoft Windows server adding.

1. Review details of the Microsoft Windows server.
2. Click **Next**, then click **Finish** to exit the wizard.

Adding Linux Servers

You must add to the backup infrastructure Linux servers that you plan to use as backup repositories and servers that you plan to use for various types of restore operations.

To add a Linux server, use the **New Linux Server** wizard.
Step 1. Launch New Linux Server Wizard

To launch the **New Linux Server** wizard, do one of the following:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, right-click the **Managed Servers** node and select **Add Server**. Alternatively, you can click **Add Server** on the ribbon.
3. In the **Add Server** window, select **Linux**.
Step 2. Specify Server Name or Address

At the **Name** step of the wizard, specify an address and description for the Linux server.

1. Enter a full DNS name or IP address of the Linux server.
2. Provide a description for future reference. The default description contains information about the user who added the server, date and time when the server was added.

![New Linux Server dialog box](image)

- **Name**: Specify DNS name or IP address of Linux server. The server must have SSH and Perl installed.
- **DNS name or IP address**: 172.17.53.63
- **Description**: Linux File Server
Step 3. Specify Credentials and SSH Settings

At the SSH Connection step of the wizard, specify credentials for the Linux server.

1. From the Credentials list, select credentials for the account that has administrator privileges on the Linux server. You can select a credentials record that uses the password authentication method or credentials record that uses the Identity/Pubkey authentication method.

   If you have not set up credentials beforehand, click the Manage accounts link or click Add on the right to add the credentials. For more information, see Managing Credentials.

2. To configure advanced SSH settings, click Advanced.
   
   a. In the Service console connection section, specify an SSH timeout. By default, the SSH timeout is set to 20000 ms. If a task targeted at the Linux server is inactive after the specified timeout, Veeam Backup & Replication will automatically terminate the task.

   b. In the Data transfer options section, specify connection settings for file copy operations. Provide a range of ports that will be used as transmission channels between the source host and target host (one port per task). By default, Veeam Backup & Replication uses port range 2500-5000. If the virtual environment is not large and data traffic will not be significant, you can specify a smaller range of ports, for example, 2500-2510 to run 10 concurrent jobs at the same time.
c. If the Linux server is deployed outside NAT, in the Preferred TCP connection role section select the Run server on this side check box. In the NAT scenario, the outside client cannot initiate a connection to the server on the NAT network. As a result, services that require initiation of the connection from outside can be disrupted. With this option selected, you will be able to overcome this limitation and initiate a 'server-client' connection — that is, a connection in the direction of the Linux server.

3. When you add a Linux server, Veeam Backup & Replication saves a fingerprint of the Linux host SSH key to the configuration database. During every subsequent connection to the server, Veeam Backup & Replication uses the saved fingerprint to verify the server identity and avoid the man-in-the-middle attack.

To let you identify the server, Veeam Backup & Replication displays the SSH key fingerprint:

- If you trust the server and want to connect to it, click Yes.
- If you do not trust the server, click No. Veeam Backup & Replication will display an error message, and you will not be able to connect to the server.
NOTE:
If you update the SSH key on the server, you must acknowledge the new key in the server connection settings. To do this, in the Backup Infrastructure view open the server settings, pass through the Edit Server wizard and click Trust to acknowledge the new key.
Step 4. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of Linux server adding.

1. Review details of the Linux server.
2. Click **Next**, then click **Finish** to exit the wizard.

---

Rescanning Servers

In some cases, you may need to rescan hosts or servers in the backup infrastructure. The rescan operation may be required if you have added or removed new disks and volumes to/from the host or server and want to display actual information in Veeam Backup & Replication. During the rescan operation, Veeam Backup & Replication retrieves information about disks and volumes that are currently connected to a host or server and stores this information to the configuration database.

Veeam Backup & Replication automatically performs a rescan operation every 4 hours. You can also start the rescan operation manually:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select **Managed servers**.
3. In the working area, select the server or host and click **Rescan** on the ribbon. Alternatively, you can right-click the server or host and select **Rescan**.

---

**Editing Server Settings**

To edit settings of a server in the backup infrastructure:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select **Managed servers**.
3. In the working area, select the server and click **Edit Server** on the ribbon or right-click the server and select **Properties**.
4. You will follow the same steps as you have followed when adding the server. Edit server settings as required.

Removing Servers

If you do not plan to use some server anymore, you can remove it from the backup infrastructure.

You cannot remove a server that has any dependencies. For example, you cannot remove a server that is referenced by a backup or replication job, performs the role of a backup proxy or backup repository. To remove such server, you will need to delete all referencing jobs and roles first.

When you remove a server that is used as a target host or backup repository, backup files and replica files are not removed from disk. You can easily import these files later to Veeam Backup & Replication if needed. To remove a server from the backup infrastructure:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Managed servers.
3. In the working area, select the server and click **Remove Server** on the ribbon or right-click the server and select **Remove**.
Off-Host Backup Proxy

An off-host backup proxy is component required for off-host backup mode. You can deploy an off-host backup proxy to remove unwanted overhead on the production Hyper-V host. In this case, the off-host backup proxy will retrieve VM data from the source datastore, process it and transfer to the destination. For more information, see Off-Host Backup.

Off-Host Backup Proxy Deployment

When you assign the role of an off-host backup proxy to the selected machine, Veeam Backup & Replication automatically installs on it light-weight components and services required for backup proxy functioning. Unlike the backup server, backup proxies do not require a dedicated SQL database — all settings are stored centrally, within the configuration database used by Veeam Backup & Replication.

NOTE:
Versions of a Microsoft Hyper-V host and off-host backup proxy must coincide. For more information, see System Requirements.

Off-Host Backup Proxy Services

To enable a Hyper-V host or a Windows machine to act as an off-host backup proxy, Veeam Backup & Replication installs the following services on it:

- **Veeam Installer Service** is an auxiliary service that is installed and started on any Windows (or Hyper-V) server once it is added to the list of managed servers in the Veeam Backup & Replication console. This service analyzes the system, installs and upgrades necessary components and services.

- **Veeam Data Mover** is a component that performs data processing tasks on behalf of Veeam Backup & Replication, such as retrieving source VM data, performing data deduplication and compression, and storing backed-up data on the target storage.

- **Veeam Hyper-V Integration Service** is responsible for communicating with the VSS framework during backup, replication and other jobs, and performing recovery tasks. The service also deploys a driver that handles changed block tracking for Hyper-V.

General Requirements for Off-Host Backup Proxy

A machine performing the role of an off-host backup proxy must meet the following requirements:

- The machine must meet the system requirements. For more information, see System Requirements.

- The role of an off-host backup proxy can be assigned only to a physical machine.

  For evaluation and testing purposes, you can assign the off-host backup proxy role to a VM. To do this, you must enable the Hyper-V role on this VM (use nested virtualization). For more information, see Nesting Hyper-V with VMware Workstation 8 and ESXi 5 or How to Install Hyper-V on a Virtual Machine in Hyper-V articles. However, it is not recommended that you use virtualized off-host backup proxies in the production environment.
Requirements for Off-Host Backup Proxy and CSV (SAN) Storage

If you back up VMs located on a CSV (SAN) storage, a machine performing the role of an off-host backup proxy must meet the following requirements:

- If you plan to perform off-host backup for a Microsoft Hyper-V cluster with CSV, you must deploy an off-host backup proxy on a host that is not a part of the cluster. If the off-host backup proxy is deployed on a node of the cluster, the cluster will fail during VM data processing.

- The source Microsoft Hyper-V host and the off-host backup proxy must be connected to the shared storage through a SAN configuration. Make sure that the off-host backup proxy has read access to the storage LUNs.

- If you back up or replicate VMs whose disks reside on a CSV with Data Deduplication enabled, make sure that versions of a Microsoft Hyper-V host and off-host backup proxy coincide and the Data Deduplication option is enabled on this off-host backup proxy. Otherwise, off-host backup will fail.

- To create and manage volume shadow copies on the shared storage, you must install and properly configure a VSS hardware provider that supports transportable shadow copies on the off-host proxy and the Microsoft Hyper-V host. Typically, when configuring a VSS hardware provider, you need to specify a server controlling the LUN and disk array credentials to provide access to the array.

  The VSS hardware provider is usually distributed as a part of client components supplied by the storage vendor. Any VSS hardware provider certified by Microsoft is supported. Some storage vendors may require additional software and licensing to work with transportable shadow copies.

Requirements for Off-Host Backup Proxy and SMB Shared Storage

If you back up VMs located on an SMB shared storage, a machine performing the role of an off-host backup proxy must meet the following requirements in addition to the general requirements listed earlier in this section:

- The off-host backup proxy must have read access to the SMB shared storage.

- The LocalSystem account of the off-host backup proxy must have read access permissions on the Microsoft SMB3 file share.

- The off-host backup proxy must be located in the same domain where the Microsoft SMB3 server resides. Alternatively, the domain where the Microsoft SMB3 server resides must be trusted by the domain in which the off-host backup proxy is located.

Adding Off-Host Backup Proxies

You can configure one or more off-host backup proxies in the backup infrastructure.

Before you add an off-host backup proxy, check prerequisites. Then use the New Hyper-V Off-Host Backup Proxy wizard to add the off-host backup proxy.
Step 1. Launch New Hyper-V Off-Host Backup Proxy Wizard

To launch the **New Hyper-V Off-Host Backup Proxy** wizard, do either of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select the **Backup Proxies** node, click **Add Proxy** on the ribbon and select **Hyper-V**.

- Open the **Backup Infrastructure** view, in the inventory pane right-click the **Backup Proxies** node and select **Add Hyper-V Off-Host Backup Proxy**.
Step 2. Choose Server

At the **Server** step of the wizard, specify server settings for the off-host backup proxy.

1. From the **Choose server** list, select a Microsoft Windows server to which you want to assign the off-host backup proxy role. If the server is not added to the backup infrastructure yet, you can click **Add New** to open the **New Windows Server** wizard. For more information, see **Adding Microsoft Windows Servers**.

2. In the **Proxy description** field, provide a description for future reference. The default description contains information about the user who added the off-host backup proxy, date and time when the off-host backup proxy was added.

3. In the **Connected volumes** field, specify from which volumes the off-host backup proxy must be able to retrieve VM data. By default, Veeam Backup & Replication automatically detects all volumes accessible by the off-host backup proxy.

   You can set up the list of volumes manually if you want the off-host backup proxy to work with specific volumes. Click **Choose** on the right of the **Connected volumes** field, choose **Manual selection** and add volumes from which the off-host backup proxy must be able to retrieve VM data.

4. In the **Max concurrent tasks** field, specify the number of tasks that the off-host backup proxy must handle in parallel. If this value is exceeded, the off-host backup proxy will not start a new task until one of current tasks is finishes.

   Veeam Backup & Replication creates one task per every VM disk. The recommended number of concurrent tasks is calculated automatically based on available resources. Off-host backup proxies with multi-core CPUs can handle more concurrent tasks. For example, for a 4-core CPU, it is recommended to specify maximum 4 concurrent tasks, for an 8-core CPU — 8 concurrent tasks. When defining the number of concurrent tasks, keep in mind network traffic throughput in the virtual infrastructure.
Step 3. Configure Traffic Rules

At the Traffic Rules step of the wizard, configure network traffic rules. These rules help you throttle and encrypt traffic transferred between backup infrastructure components. For more information, see Configuring Network Traffic Rules.

The list of network traffic rules contains only the rules that are applicable to the off-host backup proxy. The rule is applied to the off-host backup proxy if the IP address of the off-host backup proxy falls into an IP range of the rule.

To view rule settings:

1. Select the rule in the list.
2. Click View on the right of the rule list.

You can open global network traffic settings and modify them directly from the New Hyper-V Off-Host Proxy wizard. To do this, click the Manage network traffic rules link at the bottom of the wizard.
Step 4. Review Components

At the **Review** step of the wizard, review what Veeam Backup & Replication components are already installed on the off-host backup proxy and what components will be installed.

1. Review the components.
2. Click **Next** to add the off-host backup proxy.
Step 5. Finish Working with Wizard

At the **Apply** step of the wizard, complete the procedure of off-host backup proxy configuration.

1. Review details of the off-host backup proxy.
2. Click **Next**, then click **Finish** to exit the wizard.

**Editing Backup Proxy Settings**

You can edit settings of off-host backup proxies you have configured.

To edit off-host backup proxy settings:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **Backup Proxies** node.
3. In the working area, select the off-host backup proxy and click **Edit Proxy** on the ribbon or right-click the off-host backup proxy and select **Properties**.
4. Edit off-host backup proxy settings as required.

Disabling and Removing Backup Proxies

You can temporarily disable an off-host backup proxy or remove it from the backup infrastructure.

Disabling Backup Proxies

When you disable an off-host backup proxy, Veeam Backup & Replication does not use this off-host backup proxy for any jobs configured on the backup server. Off-host backup proxy disabling can be helpful if you instruct Veeam Backup & Replication to automatically select off-host backup proxies for jobs and do not want Veeam Backup & Replication to use specific off-host backup proxies.

To disable an off-host backup proxy:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **Backup Proxies** node.
3. In the working area, select the off-host backup proxy and click **Disable Proxy** on the ribbon or right-click the off-host backup proxy and select **Disable proxy**.

You can enable a disabled off-host backup proxy at any time:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **Backup Proxies** node.
3. In the working area, select the off-host backup proxy and click **Disable Proxy** on the ribbon once again or right-click the off-host backup proxy and select **Disable proxy**.
Removing Backup Proxies

You can permanently remove an off-host backup proxy from the backup infrastructure. When you remove an off-host backup proxy, Veeam Backup & Replication unassigns the off-host backup proxy role from the server, and this server is no longer used as an off-host backup proxy. The actual server remains in the backup infrastructure.

You cannot remove an off-host backup proxy that is explicitly selected in any backup or replication job. To remove such off-host backup proxy, you first need to delete a reference to this off-host backup proxy in the job settings.

To remove a backup proxy:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **Backup Proxies** node.
3. In the working area, select the off-host backup proxy and click **Remove Proxy** on the ribbon or right-click the off-host backup proxy and select **Remove**.

Configuring Advanced Options for Off-Host Backup Proxies

When you configure a backup or replication job, you can instruct Veeam Backup & Replication to automatically assign an off-host backup proxy to the job. To select an appropriate off-host backup proxy, Veeam Backup & Replication uses a static topology scheme — a scheme of available connections in the backup infrastructure. The static topology scheme is updated once in 4 hours, when Veeam Backup & Replication performs automatic rescan of backup infrastructure components.
In some situations, the static topology scheme may not be enough. In some storage systems (for example, iSCSI SAN), the hardware VSS provider configures connections to volume snapshots on the fly. When a volume snapshot is created, the hardware VSS provider automatically creates a new target for the volume snapshot or enables a connection to the volume snapshot for the off-host backup proxy.

In such case, the mechanism of automatic off-host backup proxy detection will not work properly. To overcome this situation, you can manually present volumes to the off-host backup proxy and assign the necessary off-host backup proxy to the job.

**Presenting Volumes to Off-Host Backup Proxies**

To present volumes to an off-host backup proxy:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select the Backup Proxies node.
3. In the working area, select the off-host backup proxy and click Edit Proxy on the ribbon or right-click the off-host backup proxy and select Properties.
4. At the Server step of the wizard, click Choose next to the Connected volumes field.
5. In the Connected Volumes window, choose Manual selection and click Populate. Veeam Backup & Replication will display a list of volumes accessible by the off-host backup proxy.
If the off-host backup proxy has access to a volume but the volume is not in the list, you can add it manually. To do that, click **Add** and select the necessary volume.

### Assigning Off-Host Backup Proxies to Jobs

If the automatic proxy detection mechanism does not work correctly, you can manually assign an off-host backup proxy to a job.

1. Open the **Home** view.
2. In the inventory pane, select the **Jobs** node.
3. In the working area, right-click the job and click **Edit** on the ribbon or right-click the job and select **Edit**.
4. At the **Storage** step of the wizard, click **Choose** next to the **Backup proxy** field.

5. Select the **Use the following backup proxy servers only** check box.

6. Select check boxes next to off-host backup proxies you want to use for the job.
When you start the configured job, Veeam Backup & Replication will check the topology scheme of connections for off-host backup proxies that you have selected in the list and choose one of them for the job. If none of these backup proxies can be used for the job and you have selected the **Failover to on-host backup mode if no suitable off-host proxies available** check box, Veeam Backup & Replication will fail over to the on-host backup mode. If you have not enabled the failover option, the job will fail.
File Proxy

A file proxy is a special type of backup proxy that operates as a data mover and transfers data from the source file share to the backup repository. For more information about file proxy, see NAS Backup Support.
Cache Repository

A cache repository is a storage location where Veeam Backup & Replication keeps temporary cached metadata for the data backed up by the file share backup jobs. For more information about cache repository, see NAS Backup Support.
Backup Repository

A backup repository is a storage location where Veeam keeps backup files and metadata for replicated VMs. To configure a backup repository, you can use the following storage types:

- **Direct attached storage.** You can add virtual and physical servers as backup repositories:
  - Microsoft Windows server
  - Linux server

- **Network attached storage.** You can add the following network shares as backup repositories:
  - CIFS (SMB) share
  - NFS share

- **Deduplicating storage appliances.** You can add the following deduplicating storage appliances as backup repositories:
  - Dell EMC Data Domain
  - ExaGrid
  - HPE StoreOnce
  - Quantum DXi

- **Object storage.** You can use cloud storage services as backup repositories. For details, see [Object Storage Repository].

**NOTE:**
Do not configure multiple backup repositories pointing to the same location or using the same path.

Related Topics

- Scale-Out Backup Repository
- External Repository

**Microsoft Windows Server**

You can use a Microsoft Windows server with local or directly attached storage as a backup repository. The storage can be a local disk, directly attached disk-based storage (such as a USB hard drive), or iSCSI/FC SAN LUN in case the server is connected into the SAN fabric.

**Microsoft Windows Repository Deployment**

To communicate with a Microsoft Windows-based repository, Veeam Backup & Replication uses two Data Mover Services that are responsible for data processing and transfer:

- Veeam Data Mover on a backup proxy
- Veeam Data Mover on the Microsoft Windows repository
When any job addresses the backup repository, the Data Mover Service on the backup proxy establishes a connection with the Data Mover Service on the backup repository, enabling efficient data transfer over LAN or WAN.

The Data Mover is installed automatically when you add a server to Veeam Backup & Replication as a managed server.

Requirements for Microsoft Windows Server Based Repositories

A machine performing the role of a repository must meet the following requirements:

- The machine must meet the system requirements. For more information, see System Requirements.
- The role of the repository can be assigned to a Microsoft Windows machine (physical or virtual).
- You must add the machine to the Veeam Backup & Replication console as a managed server.
- If you want to use Fast Clone in the Microsoft Windows backup repository, the machine must also meet requirements listed in the Fast Clone section.

Linux Server

You can add Linux server with local, directly attached storage or mounted NFS as a backup repository. The storage can be a local disk, directly attached disk-based storage (such as a USB hard drive), NFS share, or iSCSI/FC SAN LUN in case the server is connected into the SAN fabric.

Linux Backup Repository Deployment

To communicate with a Linux-based repository, Veeam Backup & Replication uses two Data Mover Services that are responsible for data processing and transfer:

- Veeam Data Mover on the backup proxy
- Veeam Data Mover on the Linux backup repository

Linux repository does not host the Veeam Data Mover permanently. When any task addresses a Linux repository, Veeam Backup & Replication deploys and starts the Veeam Data Mover on the backup repository.
The Data Mover Service establishes a connection with the source-side Data Mover Service on the backup proxy, enabling efficient data transfer over LAN or WAN.

Requirements for Linux Backup Repositories

A machine performing the role of a repository must meet the following requirements:

- The machine must meet the system requirements. For more information, see System Requirements.
- The role of the repository can be assigned to a Linux machine (physical or virtual).
- You must add the machine to the Veeam Backup & Replication console as a managed server.
- Veeam Backup & Replication uses the SSH protocol to communicate with Linux backup repositories and requires the SCP utility in Linux repositories. Make sure that the SSH daemon is properly configured and SCP utility is available on the Linux host.
- If you want to use Fast Clone in the Linux backup repository, the machine must also meet requirements listed in the Fast Clone section.

CIFS (SMB) Share

You can use CIFS (SMB) shares as backup repositories.

SMB Backup Repository Deployment

To communicate with an SMB backup repository, Veeam Backup & Replication uses two Data Mover Services that are responsible for data processing and transfer:

- Veeam Data Mover on the backup proxy
- Veeam Data Mover on the gateway server

An SMB share cannot host Veeam Data Movers. For this reason, to communicate with the SMB share, you need to deploy a gateway server. Veeam Backup & Replication will automatically deploy a Veeam Data Mover on this gateway server. For more information, see Gateway Server.

When any job addresses the SMB backup repository, the Data Mover Service on the gateway server establishes a connection with the Data Mover Service on the backup proxy, enabling efficient data transfer over LAN or WAN.
If you plan to move VM data to an offsite SMB repository over a WAN link, it is recommended that you deploy an additional gateway server in the remote site, closer to the SMB repository.

Requirements for SMB Backup Repositories

A machine performing the role of an SMB repository must meet the following requirements:

- The machine must meet the system requirements. For more information, see System Requirements.
- The role of the repository can be assigned to a Microsoft Windows machine (physical or virtual).

NFS Share

You can use NFS shares as backup repositories.

NFS Backup Repository Deployment

To communicate with an NFS backup repository, Veeam Backup & Replication uses two Data Mover Services that are responsible for data processing and transfer:

- Veeam Data Mover on the backup proxy
- Veeam Data Mover on the gateway server

An NFS share cannot host Veeam Data Movers. For this reason, to communicate with the NFS share, you need to deploy a gateway server. Veeam Backup & Replication will automatically deploy a Veeam Data Mover on this gateway server. For more information, see Gateway Server.

When any job addresses the NFS backup repository, the Data Mover Service on the gateway server establishes a connection with the Data Mover Service on the backup proxy, enabling efficient data transfer over LAN or WAN.
If you plan to move VM data to an offsite NFS repository over a WAN link, it is recommended that you deploy an additional gateway server in the remote site, closer to the NFS repository.

**Requirements and Limitations for NFS Backup Repositories**

A machine performing the role of an NFS repository must meet the following requirements:

- The machine must meet the system requirements. For more information, see [System Requirements](#).
- The role of the NFS repository can be assigned to a Microsoft Windows or Linux machine (physical or virtual) or to NAS storage supporting NFS protocol.
- The NFS repository must present read and write access rights to the gateway.

Mind that Veeam Backup & Replication does not support multipathing for NFS repository.

**Requirements for NFS Gateway Server**

A machine performing the role of an NFS gateway server must meet the following requirements:

- The machine must meet the system requirements. For more information, see [System Requirements](#).
- The role of the gateway server can be assigned to a Microsoft Windows or Linux machine (physical or virtual).
- You must add the machine to the Veeam Backup & Replication console as a managed server.
- [For automatic gateway selection] The backup server must have read and write access in the NFS repository.
- [For automatic gateway selection] If you configure automatic gateway selection for NFS repository, Veeam Backup & Replication may use the same machines as gateways for the repository and as proxies for backup jobs. Make sure that the backup proxies meet the following requirements:
  - If you explicitly choose backup proxies for backup jobs, provide read and write access rights to all proxies chosen for backup jobs that are targeted to the NFS repository.
  - If you configure automatic proxy selection for backup jobs, provide read and write access rights to all proxies in the Veeam Backup & Replication infrastructure.
  - If backup jobs that are targeted to the NFS repository use Linux proxies, check that the NFS client package is installed on the Linux proxy server.
Requirements and Limitations for Linux Gateway Server

In addition to the general requirements, the Linux gateway server must meet the following requirements:

- The Linux gateway server must have NFS client package installed.
- The credentials to authenticate with the Linux gateway server must have root or elevated to root permission.
- Veeam Backup & Replication uses the highest NFS protocol version supported by the gateway and the repository.
  
  Note that the suffix indicating the NFS version in the NFS share properties may not be displayed correctly, this is a known issue.

**TIP:**
If the NFS protocol version has changed (for example, if you updated the NFS share), click through the **Edit Backup Repository** wizard to update the information in Veeam Backup & Replication.

Deduplicating Storage Appliances

You can add deduplicating storage appliances as backup repositories.

In This Section

- Dell EMC Data Domain
- ExaGrid
- HPE StoreOnce
- Quantum DXi

Dell EMC Data Domain

You can use Dell EMC Data Domain storage systems with Data Domain Boost (DD Boost) as backup repositories.

To support the DD Boost technology, Veeam Backup & Replication leverages the following Dell EMC Data Domain components:

- **DD Boost library.** The DD Boost library is a component of the Dell EMC Data Domain system. The DD Boost library is embedded into the Veeam Data Mover Service setup. When you add a Microsoft Windows server to the backup infrastructure, the DD Boost Library is automatically installed on the added server together with the Data Mover Service.

- **DD Boost server.** The DD Boost server is a target-side component. The DD Boost server runs on the OS of the Dell EMC Data Domain storage system.

Dell EMC Data Domain Deployment

To communicate with Dell EMC Data Domain, Veeam Backup & Replication uses two Data Mover Services that are responsible for data processing and transfer:

- Veeam Data Mover on the backup proxy
• Veeam Data Mover on the gateway server

The Dell EMC Data Domain storage cannot host Veeam Data Mover Service. For this reason, to communicate with the Dell EMC Data Domain storage, you need to deploy a gateway server. Veeam Backup & Replication will automatically deploy a Veeam Data Mover on this gateway server. For more information, see Gateway Server.

When any job addresses the backup repository, the Data Mover Service on the gateway server establishes a connection with the Data Mover Service on the backup proxy, enabling efficient data transfer over LAN or WAN.

You define what gateway server to use when you assign a backup repository role to Dell EMC Data Domain. You can define the gateway server explicitly or instruct Veeam Backup & Replication to select it automatically.

IMPORTANT!

For Dell EMC Data Domain storage systems working over Fibre Channel, you must explicitly define the gateway server that will communicate with Dell EMC Data Domain. As a gateway server, you must use a Microsoft Windows server that is added to the backup infrastructure and has access to Dell EMC Data Domain over Fibre Channel.

Supported Protocols

Veeam Backup & Replication supports Dell EMC Data Domain storage systems working over the following protocols:

- TCP/IP protocol: Veeam Backup & Replication communicates with the Dell EMC Data Domain server by sending commands over the network.
- Fibre Channel protocol: Veeam Backup & Replication communicates with the Dell EMC Data Domain Fibre Channel server by sending SCSI commands over Fibre Channel.

Limitations for Dell EMC Data Domain

If you plan to use Dell EMC Data Domain as a backup repository, mind the following limitations:

- Use of Dell EMC Data Domain with DD Boost does not guarantee improvement of job performance. It reduces the load on the network and improves the network throughput.
- NFS services must be enabled on Dell EMC Data Domain. Otherwise, Veeam Backup & Replication will not be able to access the storage system.
- Dell EMC Data Domain does not support the reverse incremental backup method.
• You cannot use Dell EMC Data Domain backup repositories as sources or targets for file copy jobs.

• When you create a backup job targeted at an Dell EMC Data Domain backup repository, Veeam Backup & Replication will offer you to switch to optimized job settings and use the 4 MB size of data block for VM data processing. It is recommended that you use optimized job settings. Large data blocks produce a smaller metadata table that requires less memory and CPU resources to process.

• The length of forward incremental and forever forward incremental backup chains (chains that contain one full backup and a set of subsequent incremental backups) cannot be greater than 60 restore points. To overcome this limitation, schedule full backups (active or synthetic) to split the backup chain into shorter series. For example, to perform backups at 30-minute intervals 24 hours a day, you must schedule synthetic fulls every day. In this scenario, intervals immediately after midnight may be skipped due to duration of synthetic processing. For more information, see How Synthetic Full Backup Works.

• If you connect to an Dell EMC Data Domain backup repository over Fibre Channel, you must explicitly define a gateway server to communicate with Dell EMC Data Domain. As a gateway server, you must use a Microsoft Windows server that is added to the backup infrastructure and has access to the Dell EMC Data Domain backup repository over Fibre Channel.

• During backup repository rescan, Veeam Backup & Replication detects if the hard stream limit is set for a storage unit, and displays this information in backup repository rescan statistics. If the hard stream limit is exceeded when Veeam Backup & Replication runs tasks against the backup repository, Veeam Backup & Replication will fail to create new I/O streams.

For more information and recommendations on working with Dell EMC Data Domain, see this Veeam KB article.

**Dell EMC Data Domain Supported Features**

The DD Boost technology offers a set of features for advanced data processing. Veeam Backup & Replication supports the following features:

- **Distributed Segment Processing**
- **Advanced Load Balancing and Link Failover**
- **Virtual Synthetics**

In addition to these technologies, Veeam Backup & Replication supports **in-flight data encryption** and **per storage unit streams**.

**NOTE:**

You cannot configure Managed File Replication using Veeam Backup & Replication. However, you can import and map backups replicated between Data Domain storage systems to backup, backup copy or replication jobs, or perform restore operations from such backups.

**Distributed Segment Processing**

Distributed Segment Processing lets Dell EMC Data Domain ‘distribute’ the deduplication process and perform a part of data deduplication operations on the backup proxy side.

Without Distributed Segment Processing, Dell EMC Data Domain performs deduplication on the Dell EMC Data Domain storage system. The backup proxy sends unfiltered data blocks to Dell EMC Data Domain over the network. Data segmentation, filtering and compression operations are performed on the target side, before data is written to disk.
With Distributed Segment Processing, operations on data segmentation, filtering and compression are performed on the backup proxy side. The backup proxy sends only unique data blocks to Dell EMC Data Domain. As a result, the load on the network reduces and the network throughput improves.

**Advanced Load Balancing and Link Failover**

Advanced Load Balancing and Link Failover allow you to balance data transfer load and route VM data traffic to a working link in case of network outage problems.

Without Advanced Load Balancing, every backup server connects to Data Domain on a dedicated Ethernet link. Such configuration does not provide an ability to balance the data transfer load across the links. If a network error occurs during the data transfer process, the backup job fails and needs to be restarted.

Advanced Load Balancing allows you to aggregate several Ethernet links into one interface group. As a result, Dell EMC Data Domain automatically balances the traffic load coming from several backup servers united in one group. If some link in the group goes down, Dell EMC Data Domain automatically performs link failover, and the backup traffic is routed to a working link.

**Virtual Synthetics**

Veeam Backup & Replication supports Virtual Synthetic Fulls by Dell EMC Data Domain. Virtual Synthetic Fulls let you synthesize a full backup on the target backup storage without physically copying data from source volumes. To construct a full backup file, Dell EMC Data Domain uses pointers to existing data segments on the target backup storage. Virtual Synthetic Fulls reduce the workload on the network and backup infrastructure components and increase the backup job performance.

**In-Flight Data Encryption**

Veeam Backup & Replication supports in-flight encryption introduced in Dell EMC Data Domain Boost 3.0. If necessary, you can enable data encryption at the backup repository level. Veeam Backup & Replication will leverage the Dell EMC Data Domain technology to encrypt data transported between the DD Boost library and Data Domain system.

**Per Storage Unit Streams**

Veeam Backup & Replication supports per storage unit streams on Dell EMC Data Domain. The maximum number of parallel tasks that can be targeted at the backup repository (the **Limit maximum concurrent tasks to N** setting) is applied to the storage unit, not the whole Dell EMC Data Domain system.

**Supported Protocols**

Veeam Backup & Replication supports Dell EMC Data Domain storage systems working over the following protocols:

- **TCP/IP protocol**: Veeam Backup & Replication communicates with the Dell EMC Data Domain server by sending commands over the network.
- **Fibre Channel protocol**: Veeam Backup & Replication communicates with the Dell EMC Data Domain Fibre Channel server by sending SCSI commands over Fibre Channel.
Accelerated Restore of Entire VM

To speed up entire VM restore on Dell EMC Data Domain, Veeam Backup & Replication uses the mechanism of sequential data reading from backups and parallel VM disks restore.

Dell EMC Data Domain storage systems are optimized for sequential I/O operations. However, data blocks of VM disks in backup files are stored not sequentially, but in the random order. If data blocks of VM disks are read at random, the restore performance from backups on Dell EMC Data Domain degrades.

To accelerate the restore process, Veeam Backup & Replication creates a map of data blocks in backup files. It uses the created map to read data blocks of VM disks from backup files sequentially, as they reside on disk. Veeam Backup & Replication writes data blocks to target in the order in which they come from the target Veeam Data Mover, restoring several VM disks in parallel.

This accelerated restore mechanism is enabled by default, and is used for the entire VM restore scenario.

**NOTE:**

To further accelerate the process of entire VM restore, Veeam Backup & Replication reads VM data from Dell EMC Data Domain in multiple threads.

How Accelerated Restore Works

Entire VM restore from backups on Dell EMC Data Domain is performed in the following way:

1. Veeam Backup & Replication opens all backup files in the backup chain, reads metadata from these backup files and caches this metadata on the backup proxy that is assigned for the restore task.

2. Veeam Backup & Replication uses the cached metadata to build a map of data blocks. The map contains references to VM data blocks, sorted by VM disks.

3. Every VM disks is processed in a separate task. For every task, Veeam Backup & Replication starts a separate Veeam Data Mover on the backup proxy.

   Veeam Data Movers read data blocks of VM disks from the backup repository sequentially, as these blocks reside on disk, and put read data blocks to the buffer on the backup proxy.
Veeam Backup & Replication restores all disks of a VM through one backup proxy. In Microsoft Hyper-V environments, the role of a backup proxy is assigned to the target Microsoft Hyper-V host — host to which the VM is restored.

For every VM disk, Veeam Backup & Replication starts a separate Veeam Data Mover on the backup proxy. For example, if you restore a VM with 10 disks, Veeam Backup & Replication starts 10 Veeam Data Movers on the backup proxy.

The backup proxy assigned for the entire VM restore task must have enough RAM resources to be able to restore VM disks in parallel. For every VM disk, 200 MB of RAM is required. The total amount of required RAM resources is calculated by the following formula:

\[
\text{Total amount of RAM} = \text{Number of VM disks} \times 200 \text{ MB}
\]

Before starting the restore process, Veeam Backup & Replication checks the amount of RAM resources on the backup proxy. If the backup proxy does not have enough RAM resources, Veeam Backup & Replication displays a warning in the job session details and automatically fails over to a regular VM disks processing mode (data of VM disks is read at random and VM disks are restored sequentially).

Limitations for Accelerated Restore

The accelerated restore of entire VM has the following limitations:

- Accelerated restore works on Dell EMC Data Domain systems with DD Boost.
- If you restore a VM with dynamically expanding disks, the restore process may be slow.
- If Dell EMC Data Domain is added as an extent to a scale-out backup repository, you must set the backup file placement policy to Locality. If the backup file placement policy is set to Performance, parallel VM disk restore will be disabled.
ExaGrid

You can use ExaGrid appliances as backup repositories.

Adaptive Deduplication

ExaGrid uses adaptive deduplication. Data deduplication is performed on the target storage system. After VM data is written to disk, ExaGrid analyses bytes in the newly transferred data portions. ExaGrid compares versions of data over time and stores only the differences to disk.

ExaGrid deduplicates data at the storage level. Identical data is detected throughout the whole storage system, which increases the deduplication ratio.

ExaGrid Deployment

To communicate with ExaGrid, Veeam Backup & Replication uses two Data Mover Services that are responsible for data processing and transfer:

- Veeam Data Mover on the backup proxy
- Veeam Data Mover on the ExaGrid appliance

ExaGrid does not host the Veeam Data Mover permanently. When any task addresses an ExaGrid storage, Veeam Backup & Replication deploys and starts the Veeam Data Mover on the ExaGrid appliance.

The Data Mover Service establishes a connection with the Data Mover Service on the backup proxy, enabling efficient data transfer over LAN or WAN.

Requirements and Recommendations for ExaGrid

To perform backup to ExaGrid appliances, it is recommended to configure backup repositories and jobs in the following way:

Backup repositories

Configure ExaGrid backup repositories in the following way:

1. Create at least one share on each ExaGrid appliance. Enable the ExaGrid-Veeam Accelerated Data Mover transport option for the created share. Leave default compression and deduplication settings for the share.
2. In Veeam Backup & Replication, perform the following actions:
   a. Configure ExaGrid backup repositories and point them at the created shares on each ExaGrid appliance. Set the **Limit maximum concurrent tasks to N** option to 10 tasks. This limit can be tuned up or down with assistance from ExaGrid Customer Support.

   When you add ExaGrid servers to the Veeam backup infrastructure, and you use the UPN format for an Active Directory account user name (for example, john.doe@domain.local), make sure you enter the user name in lowercase letters only.

   b. Add ExaGrid backup repositories as extents to a scale-out backup repository.

**Backup Jobs**

Configure backup jobs in the following way:

1. Backup job settings:
   a. Use the forward incremental backup method.
   b. Enable synthetic full backups and schedule them to run on a weekly basis.
   c. Enable active full backups and schedule them to run on a monthly basis.

2. Backup target: Assign backup jobs to the scale-out backup repository with ExaGrid appliances as extents.

   **NOTE:**

   Do not create multiple backup repositories directed at the same folder/path on the same device.

For more information and recommendations on working with ExaGrid, see [this Veeam KB article](#).

**HPE StoreOnce**

You can use HPE StoreOnce storage appliances as backup repositories.

To work with HPE StoreOnce, Veeam Backup & Replication leverages the HPE StoreOnce Catalyst technology and two HPE StoreOnce components:

- **HPE StoreOnce Catalyst agent.** The HPE StoreOnce Catalyst agent is a component of the HPE StoreOnce Catalyst software. The HPE StoreOnce Catalyst agent is embedded into the Veeam Data Mover Service setup. When you add a Microsoft Windows server to the backup infrastructure, the HPE StoreOnce Catalyst agent is automatically installed on the added server together with the Data Mover Service.

- **HPE StoreOnce appliance.** The HPE StoreOnce appliance is an HPE StoreOnce storage system on which Catalyst stores are created.

**HPE StoreOnce Deployment**

To communicate with HPE StoreOnce, Veeam Backup & Replication uses two Data Mover Services that are responsible for data processing and transfer:

- Veeam Data Mover on the backup proxy
- Veeam Data Mover on the gateway server
The HPE StoreOnce storage cannot host Veeam Data Mover Service. For this reason, to communicate with the HPE StoreOnce storage, you need to deploy a gateway server. Veeam Backup & Replication will automatically deploy a Veeam Data Mover on this gateway server. For more information, see Gateway Server. For communicating with the HPE StoreOnce storage appliances, the gateway server must run a 64-bit Microsoft Windows version.

When any job addresses the backup repository, the Data Mover Service on the gateway server establishes a connection with the Data Mover Service on the backup proxy, enabling efficient data transfer over LAN or WAN.

The gateway server is selected when you assign a backup repository role to the HPE StoreOnce appliance. You can define the gateway server explicitly or instruct Veeam Backup & Replication to select it automatically.

**TIP:**
For work with HPE StoreOnce, Veeam Backup & Replication uses the Catalyst agent installed on the gateway server. If you want to reduce the load on the network between the source and target side, assign the gateway server role to a machine on the source side, closer to the backup proxy.

**Limitations for HPE StoreOnce**

If you plan to use HPE StoreOnce as a backup repository for NAS backup, mind that the vendor recommends to use the repository of this type to store up to 1,000,000 backup files per storage system including different versions of files and not more than 10 TB of backup data.

If you plan to use HPE StoreOnce as a backup repository for Veeam Plug-in for Oracle RMAN or Veeam Plug-in for SAP HANA, the total number of stored files (data and metadata) must not exceed 1,000,000 per storage system.

If you plan to use HPE StoreOnce as a backup repository for VM backup, mind the following limitations. Limitations apply only if you use HPE StoreOnce in the integration mode, not the shared folder mode.

- When you create a backup job targeted at HPE StoreOnce, Veeam Backup & Replication will offer you to switch to optimized job settings and use the 4 MB size of data block for VM data processing. It is recommended that you use optimized job settings. Large data blocks produce a smaller metadata table that requires less memory and CPU resources to process.

- The HPE StoreOnce backup repository always works in the Use per-VM backup files mode. For more information, see Per-VM Backup Files.

- HPE StoreOnce does not support the reverse incremental backup method.
• HPE StoreOnce does not support the forever forward incremental backup method. When creating a backup job, you must enable synthetic and/or active full backups. Otherwise, you will not be able to create a backup job.

• The HPE StoreOnce backup repository does not support the **Defragment and compact full backup file** option (for backup and backup copy jobs).

• You cannot perform quick migration for Microsoft Hyper-V VMs started with Instant VM Recovery from the backup that resides in the HPE StoreOnce backup repository.

• You cannot use HPE StoreOnce backup repositories as sources or targets for file copy jobs.

• You cannot copy backup files (VBK, VIB and VRB) manually to the HPE StoreOnce backup repository. To copy such files, use backup copy jobs.

• You cannot use the HPE StoreOnce backup repository as a cloud repository.

• HPE StoreOnce has a limit on the number of concurrently opened files. Due to this limit, the maximum length of backup chains (chains that contain one full backup and a set of subsequent incremental backups) on HPE StoreOnce is also limited and depends on the particular storage model:

<table>
<thead>
<tr>
<th>Product</th>
<th>Maximum number of restore points per backup chain</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VSA</strong></td>
<td></td>
</tr>
<tr>
<td>VSA Gen3</td>
<td>7</td>
</tr>
<tr>
<td>VSA Gen4</td>
<td>7 to 14 (for version 4.1.1 varies depending on the amount of available memory)</td>
</tr>
<tr>
<td><strong>Proliant Gen7</strong></td>
<td></td>
</tr>
<tr>
<td>6200</td>
<td>14 (per node)</td>
</tr>
<tr>
<td><strong>Proliant Gen8</strong></td>
<td></td>
</tr>
<tr>
<td>2700</td>
<td>7</td>
</tr>
<tr>
<td>2900</td>
<td>14</td>
</tr>
<tr>
<td>4500</td>
<td>14</td>
</tr>
<tr>
<td>4700</td>
<td>14</td>
</tr>
<tr>
<td>4900</td>
<td>28</td>
</tr>
<tr>
<td>6500</td>
<td>28 (per node)</td>
</tr>
<tr>
<td>Product</td>
<td>Maximum number of restore points per backup chain</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Proliant Gen9</td>
<td></td>
</tr>
<tr>
<td>3100</td>
<td>7</td>
</tr>
<tr>
<td>3500</td>
<td>14</td>
</tr>
<tr>
<td>5100</td>
<td>21</td>
</tr>
<tr>
<td>5500</td>
<td>35</td>
</tr>
<tr>
<td>6600</td>
<td>42 (per node)</td>
</tr>
<tr>
<td>Proliant Gen10</td>
<td></td>
</tr>
<tr>
<td>3620</td>
<td>14</td>
</tr>
<tr>
<td>3640</td>
<td>14</td>
</tr>
<tr>
<td>5200</td>
<td>28</td>
</tr>
<tr>
<td>5250</td>
<td>28</td>
</tr>
<tr>
<td>5650</td>
<td>42</td>
</tr>
</tbody>
</table>

**Several Backup Repositories on HPE StoreOnce**

You can configure several backup repositories on one HPE StoreOnce appliance and associate them with different gateway servers.

Mind the following:

- If you configure several backup repositories on HPE StoreOnce and add them as extents to a scale-out backup repository, make sure that all backup files from one backup chain are stored on one extent. If backup files from one backup chain are stored to different extents, the performance of transformation processes will be lower. For more information about transformation performance, see this Veeam blog post.

- HPE StoreOnce has a limit on the number of opened files that applies to the whole appliance. Tasks targeted at different backup repositories on HPE StoreOnce and run in parallel will equally share this limit.

- For HPE StoreOnce working over Fibre Channel, there is a limitation on the number of connections from one host. If you connect several backup repositories to one gateway, backup repositories will compete for connections.
• Deduplication on HPE StoreOnce works within the limits of one object store.

• If your VMs contain similar data, it is recommended to create backup repositories on a single HPE StoreOnce Catalyst Store. This minimizes backup job duration and reduces disk space used for backups. For details, see this Veeam KB article.

For more information and recommendations on working with HPE StoreOnce, see this Veeam KB article.

Operational Modes

Depending on the storage configuration and type of the backup target, HPE StoreOnce can work in the following modes:

• Source-side deduplication
• Target-side deduplication
• Shared folder mode

Source-Side Data Deduplication

HPE StoreOnce performs source-side deduplication if the backup target meets the following requirements:

• You have a Catalyst license installed on HPE StoreOnce.
• You use a Catalyst store as a backup repository.
• The Catalyst store is configured to work in the Low Bandwidth mode (Primary Transfer Policy).
• The HPE StoreOnce Catalyst is added to the backup repository as a deduplicating storage appliance, not as a shared folder.

To deduplicate data on the source side, HPE StoreOnce uses the HPE StoreOnce Catalyst agent. The HPE StoreOnce Catalyst agent is a component of the HPE StoreOnce Catalyst software. It is installed on the gateway server communicating with the HPE StoreOnce appliance.

HPE StoreOnce deduplicates data on the source side, before writing it to target:

1. During the backup job session, HPE StoreOnce analyzes data incoming to the HPE StoreOnce appliance in chunks and computes a hash value for every data chunk. Hash values are stored in an index on disk.
2. The HPE StoreOnce Catalyst agent calculates hash values for data chunks in a new data flow and sends these hash values to target.
3. HPE StoreOnce identifies which data blocks are already saved on disk and communicates this information to the HPE StoreOnce Catalyst agent. The HPE StoreOnce Catalyst agent sends only unique data blocks to target.

As a result, the load on the network reduces, the backup job performance improves, and you can save on disk space.
Target-Side Data Deduplication

HPE StoreOnce performs target-side deduplication if the backup target is configured in the following way:

- For a Catalyst store:
  - The Catalyst store works in the High Bandwidth mode (Primary Transfer Policy is set to High Bandwidth).
  - The Catalyst license is installed on the HPE StoreOnce (required).
  - The Catalyst store is added to the backup repository as a deduplicating storage appliance, not as a shared folder.

- For a CIFS store:
  - The Catalyst license is not required.
  - The CIFS store is added as a shared folder backup repository to the backup infrastructure.

For more information about working with CIFS stores, see Shared Folder Mode.

HPE StoreOnce deduplicates data on the target side, after the data is transported to HPE StoreOnce:

1. HPE StoreOnce analyzes data incoming to the HPE StoreOnce appliance in chunks and creates a hash value for every data chunk. Hash values are stored in an index on the target side.

2. HPE StoreOnce analyzes VM data transported to target and replaces identical data chunks with references to data chunks that are already saved on disk.

As a result, only new data chunks are written to disk, which helps save on disk space.

Shared Folder Mode

If you do not have an HPE StoreOnce Catalyst license, you can add the HPE StoreOnce appliance as a shared folder backup repository. In this mode, HPE StoreOnce will perform target-side deduplication.

If you work with HPE StoreOnce in the shared folder mode, the performance of backup jobs and transformation processes is lower (in comparison with the integration mode, when HPE StoreOnce is added as a deduplicating storage appliance).

HPE StoreOnce Supported Features

The HPE StoreOnce Catalyst technology offers a set of features for advanced data processing. Veeam Backup & Replication supports the following features:
Synthetic Full Backups

HPE StoreOnce Catalyst improves synthetic full backup file creation and transformation performance. When Veeam Backup & Replication creates or transforms a synthetic full backup, HPE StoreOnce does not physically copy data between the existing backup chain and the target full backup file. Instead, it performs a metadata-only operation — updates pointers to existing data blocks on the storage device. As a result, the operation completes much faster. This mechanism helps improve performance of primary backup jobs and backup copy jobs that are scheduled to create periodic archive full backups (GFS).

Accelerated Data Recovery

Integration with HPE StoreOnce improves data recovery performance for different restore scenarios: Instant VM Recovery, file-level recovery and application items recovery with Veeam Explorers.

WAN-based Catalyst Store Support

Veeam Backup & Replication provides advanced support for WAN-based HPE Catalyst stores. If a WAN connection to HPE StoreOnce is weak, you can instruct Veeam Backup & Replication to compress VM data and calculate checksums for data blocks going from the source side to HPE StoreOnce.

HPE StoreOnce Replication

HPE StoreOnce replication improves copying data between two HPE StoreOnce backup repositories. For more information on copying, see Creating Backup Copy Jobs for HPE StoreOnce Repositories.

Supported Protocols

Veeam Backup & Replication supports HPE StoreOnce storage systems working over the following protocols:

- TCP/IP protocol: Veeam Backup & Replication communicates with the HPE StoreOnce appliance by sending commands over the LAN.
- Fibre Channel protocol: Veeam Backup & Replication communicates with the HPE StoreOnce appliance by sending SCSI commands over Fibre Channel.
  
  Data processing over Fibre Channel (FC) connectivity enables local area network-free backup to HP StoreOnce, eliminates the load from backup activities and increases availability of LAN resources to production workloads.

Quantum DXi

You can use Quantum DXi appliances as backup repositories.

Quantum DXi Deduplication

Quantum DXi appliances use Quantum's patented data deduplication technology. During backup data transfer, Quantum analyses blocks in a data stream. Instead of copying redundant data blocks Quantum uses reference pointers to existing blocks on the storage device.
Quantum DXi Deployment

To communicate with Quantum DXi, Veeam Backup & Replication uses two Data Mover Services that are responsible for data processing and transfer:

- Veeam Data Mover on the backup proxy
- Veeam Data Mover on the Quantum DXi appliance

Quantum DXi does not host the Veeam Data Mover permanently. When any task addresses a Quantum DXi storage, Veeam Backup & Replication deploys and starts the Veeam Data Mover on the Quantum DXi system.

The Data Mover Service establishes a connection with the Data Mover Service on the backup proxy, enabling efficient data transfer over LAN or WAN.

Backup Repositories with Rotated Drives

A backup repository can use rotated drives. Rotated drives can be detachable USB or eSATA hard drives. This scenario can be helpful if you want to store backups on several external hard drives that you plan to regularly move between different locations.

To use rotated drives, you must enable the This repository is backed by rotated hard drives option in the advanced settings of the backup repository. When this option is enabled, Veeam Backup & Replication recognizes the backup target as a backup repository with rotated drives and uses a specific algorithm to make sure that the backup chain created on these drives is not broken.

Limitations for Backup Repositories with Rotated Drives

Backup repositories with rotated drives have the following limitations:

- On one managed server, you must create only one repository with rotated drives.
- You cannot store archive full backups (GFS backups) created with backup jobs or backup copy jobs in backup repositories with rotated drives.
- You cannot store per-VM backup files in backup repositories with rotated drives.
- You cannot rescan backup repositories with rotated drives.
• Scale-out backup repositories do not support rotated drives. If you enable the **This repository is backed by rotated hard drives** setting on an extent, Veeam Backup & Replication will ignore this setting and will work with such repository as with a standard extent.

• Repositories with rotated drives are not supported as primary backup repositories, archive repositories, and secondary target repositories for NAS backup.

**How Repository with Rotated Drives Works**

**Microsoft Windows Backup Repository**

A job targeted at a backup repository with rotated drives is performed in the following way.

For backup jobs:

1. Veeam Backup & Replication creates a regular backup chain on the currently attached drive.

2. When a new job session starts, Veeam Backup & Replication checks if the backup chain on the currently attached drive is consistent. The consistent backup chain must contain a full backup and all incremental backups that have been produced by the job. This requirement applies to all types of backup chains: forever forward incremental, forward incremental and reverse incremental.

   If external drives have been swapped, and the full backup or any incremental backups are missing from the currently attached drive, Veeam Backup & Replication starts the backup chain anew. It creates a new full backup file on the drive, and this full backup is used as a starting point for subsequent incremental backups.

3. [For external drives attached to Microsoft Windows servers] Veeam Backup & Replication checks the retention policy set for the job. If some backup files in the backup chain are outdated, Veeam Backup & Replication removes them from the backup chain.

4. When you swap drives again, Veeam Backup & Replication checks the backup chain for consistency and creates a new full backup.

**NOTE:**

When you specify retention settings for a backup job targeted at a backup repository with rotated drives, you must define the total number of restore points that you want to retain on all drives in the set. For example, if you set retention to 14, the job will keep the total of 14 restore points across all drives.
For backup copy jobs:

1. Veeam Backup & Replication creates a regular backup chain on the currently attached drive.

2. When you swap drives, and the attached drive is empty, Veeam Backup & Replication creates a full backup on it. If there is a backup chain on the drive, Veeam Backup & Replication creates a new incremental backup and adds it to the backup chain. The latest incremental backup existing in the backup chain is used as a starting point for the new incremental backup.

3. [For external drives attached to Microsoft Windows servers] Veeam Backup & Replication checks the retention policy set for the job. If some backup files in the backup chain are outdated, Veeam Backup & Replication removes them from the backup chain.

**NOTE:**

When you specify retention settings for a backup copy job targeted at a backup repository with rotated drives, you must define the number of restore points per drive. For example, if you set retention to 7, the job will keep 7 restore points on every drive in the set.

### Drive Detection

Drive letters for external drives may change when you add new volumes or storage hardware such as CD-ROM on the server. In Microsoft Windows backup repositories, Veeam Backup & Replication can keep track of drives and detect them even if the drive letter changes.

To detect a drive correctly, Veeam Backup & Replication must have a record about it in the configuration database. Consider the following requirements:

- When you insert a drive for the first time, the drive is not registered in the configuration database. Such drive must have the same letter as the one specified in the *Path to folder* field in backup repository settings. For more information, see [Configuring Path and Load Control Settings](#).

  If the drive has some other letter, Veeam Backup & Replication will not be able to detect and use it.

- When you insert a drive that has already been used and has some restore points on it, the drive is already registered in the configuration database. Veeam Backup & Replication will be able to detect and use it, even if the drive letter changes.

### Linux and Shared Folder Backup Repository

If you use a Linux server or a shared folder as a backup repository with rotated drives, Veeam Backup & Replication employs a "cropped" mechanism of work with rotated drives. Veeam Backup & Replication keeps information only about the latest backup chain in the configuration database. Information about previous backup chains is removed from the database. For this reason, the retention policy set for the job may not work as expected.

A job targeted at a backup repository with rotated drives is performed in the following way:

1. During the first run of the job, Veeam Backup & Replication creates a regular backup full backup on the drive that is attached to the backup repository server.

2. During the next job session, Veeam Backup & Replication checks if the current backup chain on the attached drive is consistent. The consistent backup chain must contain a full backup and all incremental backups subsequent to it. This requirement applies to all types of backup chains: forever forward incremental, forward incremental and reverse incremental.

   - If the current backup chain is consistent, Veeam Backup & Replication adds a new restore point to the backup chain.
If external drives have been swapped, and the current backup chain is not consistent, Veeam Backup & Replication always starts a new backup chain (even if restore points from previous backup chains are available on the attached drive). Veeam Backup & Replication creates a new full backup file on the drive, and this full backup is used as a starting point for subsequent incremental backups.

As soon as Veeam Backup & Replication starts a new backup chain on the drive, it removes information about restore points from previous backup chains from the configuration database. Backup files corresponding to these previous restore points are not deleted, they remain on disk. This happens because Veeam Backup & Replication applies the retention policy only to the current backup chain, not to previous backup chains.

---

**Adding Backup Repositories with Rotated Drives**

To add a backup repository with rotated drives:

1. Attach one of external drives from the set to a Microsoft Windows or Linux server. The server must be added to the backup infrastructure. For more information on how to add a server, see Virtualization Servers and Hosts.

   You can also attach the external hard drive to the backup server itself. In this case, the VM traffic will path through the backup server, which will produce additional workload on it.

2. Launch the **Add New Backup Repository** wizard.
3. At the **Server** step of the wizard, select the server to which the drive is attached.

4. At the **Repository** step of the wizard, in the **Path to folder** field, specify a path to the folder where backup files must be stored.

**IMPORTANT!**

Later, when you attach another external hard drive to the server for the first time, this drive must have the same drive letter as specified in the **Path to folder** field. For more information, see Drive Detection.
5. Click the **Advanced** button and select the **This repository is backed by rotated hard drives** check box.

6. Configure other settings of the backup repository as required and finish working with the wizard.

### Object Storage Repository

An object storage repository is a repository intended for long-term data storage and based on either a cloud solution or an S3 compatible storage solution.

Veeam Backup & Replication supports the following types of object storage repositories:

- IBM Cloud
- Microsoft Azure Blob and Data Box
- Amazon S3 and AWS Snowball Edge
- S3 compatible

Object storage repositories can be used in the following ways:

- In **Scale-Out Backup Repository** as a part of **Capacity Tier**. Capacity tier of scale-out backup repository allows to offload existing backup data directly to cloud-based object storage such as Amazon S3, Microsoft Azure Blob Storage and IBM Cloud Object Storage, or using on-premises S3 compatible devices. For more information, see **Capacity Tier**.

- As target archive repositories for **NAS Backup**.

### Considerations and Limitations

This section lists considerations and known limitations for object storage repositories.
General

- Make sure to open required ports to communicate with object storage repositories in advance, as described in Used Ports.

- Make sure the S3 Compatible device you are adding supports AWS v4 signature. For more information about authentication requests, see this Amazon article.

- When adding Amazon S3 object storage, only the Standard, Standard-IA and One Zone-IA storage classes are supported. For more information about Amazon S3 storage classes, see this Amazon article.

- For Microsoft Azure Blob Storage, Veeam Backup & Replication supports specific types of storage accounts and tiers. For more information, see Microsoft Azure Storage Accounts.

- For IBM Cloud Object Storage on-premise, Veeam Backup & Replication supports versions starting from 3.15.0.44.

- Object storage gateway appliances that are used to store backup data in filer (CIFS/NFS) or block device mode (iSCSI/FC/SAS) are not supported if the backup data is offloaded to object storage and is no longer stored directly on the appliance.

Such gateway appliances are only supported in the following cases:

- All of the backup data is stored on the appliance altogether (that is, all of the backup chains are stored on the appliance as a whole and not scattered across multiple devices) and only additional copies of the backup data are transported to object storage.

- These appliances emulate a tape system (VTL) as an access protocol for Veeam Backup & Replication.

- Data in object storage bucket/container must be managed solely by Veeam Backup & Replication, including retention and data management. Enabling lifecycle rules is not supported, and may result in backup and restore failures.

- If a backup chain contains backup files that are marked as corrupted by Health Check, then such corrupted files, as well as all subsequent files that go after the corrupted one are never offloaded. In such a scenario, offload is only possible starting from the full backup file that succeeds the backup chain with corrupted backups.

- Different object storage repositories mapped to the same cloud folder can be used for storing both the Capacity Tier backups and the NAS backups.

**IMPORTANT!**

The same object storage repository (mapped to the same cloud folder) must not be used across multiple Veeam Backup & Replication servers for the same purposes as it leads to unpredictable system behavior and inevitable data loss.

For the same reason, two object storage repositories mapped to the same cloud folder must not be added to different scale-out backup repositories within one Veeam Backup & Replication server.

Immutability

- When enabling Object Lock on an S3 bucket, use the None option for the object lock configuration mode. Otherwise, you will not be able to register the bucket with Veeam Backup & Replication. Note that Veeam Backup & Replication will automatically use Compliance object lock mode for each uploaded object.
• If you plan to use the immutability feature with the existing S3 bucket containing backups created by 9.5 Update 4, keep in mind that both Versioning and Object Lock must be enabled on the bucket simultaneously and immediately before enabling the immutability feature. Any other approach will lead to backup offload failures and inability to correctly interact with backups in the bucket.

• The immutability feature is applicable only to the Capacity Tier backups. It does not support the NAS backups.

• Immutable data is preserved as described in Block Generation.

Adding Object Storage Repositories

You can add the following types of object storage repositories:

- IBM Cloud Object Storage
- Microsoft Azure Object Storage and Data Box
- Amazon S3 Object Storage
- S3 Compatible Object Storage

Adding IBM Cloud Object Storage

For more information about IBM Cloud Object Storage, see this IBM article.

To add IBM Cloud Object Storage, do the following:

1. Launch New Object Repository Wizard
2. Specify Object Storage Name
3. Specify Object Storage Account
4. Specify Object Storage Settings
5. Finish Working with Wizard
Step 1. Launch New Object Repository Wizard

To launch the **New Object Repository** wizard, do either of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select the **Backup Repositories** node and click **Add Repository** on the ribbon. In the **Add Backup Repository** dialog, select **Object Storage > IBM Cloud Object Storage**.

- Open the **Backup Infrastructure** view, in the inventory pane right-click the **Backup Repositories** node and select **Add Backup Repository**. In the **Add Backup Repository** dialog, select **Object Storage > IBM Cloud Object Storage**.

### Object Storage

Select the type of object storage you want to use as a backup repository:

- **S3 Compatible**
  - Adds an on-premises object storage system, or a cloud object storage provider.

- **Amazon S3**
  - Adds Amazon S3 storage. Both Standard and Infrequent Access (IA) storage classes are supported.

- **Microsoft Azure Blob Storage**
  - Adds Microsoft Azure blob storage. Both hot and cold storage tiers are supported.

- **IBM Cloud Object Storage**
  - Adds IBM Cloud object storage. S3 compatible versions of both on-premises and IBM Cloud storage offerings are supported.
Step 2. Specify Object Storage Name

At the **Name** step of the wizard, do the following:

- In the **Name** field, specify a new name for the object storage repository that is being added.
- In the **Description** field, enter optional description.

![New Object Storage Repository dialog box](image)
Step 3. Specify Object Storage Account

At the **Account** step of the wizard, do the following:

1. In the **Service point** field, specify a service point address of your IBM cloud object storage.
2. In the **Region** field, specify a region.
3. In the **Credentials** drop-down list, select user credentials to access your IBM cloud object storage.

   If you already have a credentials record that was configured in advance, select such a record in the drop-down list. Otherwise, click **Add** and provide your access and secret keys, as described in Cloud Credentials Manager.

If your organization uses NAT or different types of firewalls and your access to the internet is limited, you can employ a dedicated Windows or Linux-based gateway server to govern inbound/outbound traffic management. For more information on how to add such a server to your environment, see Adding Microsoft Windows Servers and Adding Linux Servers respectively.

To use a gateway server, select the **Use the following gateway server** check box and choose an appropriate server from the list. If no gateway server is selected, all scale-out backup repository extents must have direct network access to the storage.
Step 4. Specify Object Storage Settings

At the **Bucket** step of the wizard, do the following:

1. In the **Bucket** drop-down list, select a bucket.
   
   Make sure that the bucket you want to use to store your backup data was created in advance.

2. In the **Select Folder** field, select a cloud folder to which you want to map your object storage repository and which will be used to store data.
   
   To select a folder, click **Browse** and either select an existing folder or create a new one by clicking **New Folder**.

To define a soft limit for your object storage consumption that can be exceeded temporarily, select the **Limit object storage consumption to** check box and provide the value in TB or PB.

**NOTE:**

The **Make recent backups immutable for** check box is currently unavailable for IBM Cloud Object Storage, since IBM does not currently support S3 Object Lock feature required for the immutability.
Step 5. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of object storage repository configuration:

1. Review details of the object storage repository.
2. Click **Finish** to exit the wizard.

Adding Microsoft Azure Object Storage and Data Box

To add Microsoft Azure blob storage or Azure Data Box, do the following:

1. **Launch New Object Repository Wizard**
2. **Select Azure Storage Type**
Step 1. Launch New Object Repository Wizard

To launch the **New Object Repository** wizard, do either of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select the **Backup Repositories** node and click **Add Repository** on the ribbon. In the **Add Backup Repository** dialog, select **Object Storage > Microsoft Azure Blob Storage**.

- Open the **Backup Infrastructure** view, in the inventory pane right-click the **Backup Repositories** node and select **Add Backup Repository**. In the **Add Backup Repository** dialog, select **Object Storage > Microsoft Azure Blob Storage**.

---

### Object Storage

Select the type of object storage you want to use as a backup repository:

- **S3 Compatible**
  - Adds an on-premises object storage system, or a cloud object storage provider.

- **Amazon S3**
  - Adds Amazon S3 storage. Both Standard and Infrequent Access (IA) storage classes are supported.

- **Microsoft Azure Blob Storage**
  - Adds Microsoft Azure blob storage. Both hot and cold storage tiers are supported.

- **IBM Cloud Object Storage**
  - Adds IBM Cloud object storage. S3 compatible versions of both on-premises and IBM Cloud storage offerings are supported.
Step 2. Select Azure Storage Type

At the Microsoft Azure Blob Storage step of the wizard, select either of the following storage types:

- Azure Blob Storage
- Azure Data Box

Adding Azure Blob Storage

For more information about Azure blob storage, see this Microsoft article.

To add Microsoft Azure blob storage, do the following:

1. Specify Object Storage Name
2. Specify Object Storage Account
3. Specify Object Storage Settings
4. Finish Working with Wizard
Step 1. Specify Object Storage Name

At the **Name** step of the wizard, do the following:

- In the **Name** field, specify a new name for the object storage repository that is being added.
- In the **Description** field, enter optional description.
Step 2. Specify Object Storage Account

At the **Account** step of the wizard, do the following:

1. **In the Credentials drop-down list, select user credentials to access your Azure blob storage.**
   
   If you already have a credentials record that was configured in advance, select such a record in the drop-down list. Otherwise, click **Add** and provide your account name and a shared key. For more information about supported account types, see [Microsoft Azure Storage Accounts](#).

2. **In the Region drop-down list, select an Azure region.**

If your organization uses NAT or different types of firewalls and your access to the internet is limited, you can employ a dedicated Windows or Linux-based gateway server to govern inbound/outbound traffic management. For more information on how to add such a server to your environment, see [Adding Microsoft Windows Servers](#) and [Adding Linux Servers](#) respectively.

To use a gateway server, select the **Use the following gateway server** check box and choose an appropriate server from the list.
Step 3. Specify Object Storage Settings

At the **Container** step of the wizard, do the following:

1. In the **Container** drop-down list, select a container.
   
   Make sure that the container you want to use to store your backup data was created in advance.

   **NOTE:**
   
   The default *Root* container is not supported. For more information about this container, see this [Microsoft article](#).

2. In the **Select Folder** field, select a cloud folder to which you want to map your object storage repository and which will be used to store data.

   To select a folder, click **Browse** and either select an existing folder or create a new one by clicking **New Folder**.

To define a soft limit for your object storage consumption that can be exceeded temporarily, select the **Limit object storage consumption to** check box and provide the value in TB or PB.
Step 4. Finish Working with Wizard

At the Summary step of the wizard, complete the procedure of object storage repository configuration:

1. Review details of the object storage repository.
2. Click Finish to exit the wizard.

Adding Azure Data Box Storage

Azure Data Box is a physical device that is requested for a short period of time from Microsoft and which can be used as object storage that can be temporarily attached to your Veeam Backup & Replication backup infrastructure. For more information about ordering Azure Data Box and preparing to use it, see this Microsoft article.

This device might become useful when you need to offload a large number of backup files that are occupying a lot of storage space on your extents, as offloading data to the Azure Data Box device occurs a lot faster than transferring the same amount of data directly to Azure object storage.

Once you have offloaded backups to Azure Data Box, you need to ship the device back to Microsoft for further data synchronization with your Azure storage account, as described in Seeding Backups to Azure Blob Storage.

NOTE:

Consider that Veeam Backup & Replication supports Azure Data Box devices that are capable of reading/writing data via REST API only; the Azure Data Box Disk type is not supported.

To add Microsoft Azure Data Box storage, do the following:

1. Perform the steps described in the Before You Begin section.
2. Specify Object Storage Name
3. **Specify Object Storage Account**
4. **Specify Object Storage Settings**
5. **Finish Working with Wizard**

**Before You Begin**

Before you add Microsoft Azure Data Box into the Veeam Backup & Replication backup infrastructure, complete the following steps:

- Configure Name Resolutions
- Download and Install SSL Certificate

**Configuring Name Resolutions**

To resolve a DNS name of your Azure Data Box device, make sure to add the following DNS addresses to the `HOST` file that is located on both the Veeam Backup & Replication server and the gateway server (if any additional gateway server is used):

- `<ip_address> <mydataboxno>.microsoftdatabox.com`
- `<ip_address> <storageaccountname>.blob.<mydataboxno>.microsoftdatabox.com`

For more information on how to know your `<ip_address>`, `<mydataboxno>` and `<storageaccountname>`, see [this Microsoft article](#).

As an `<ip_address>`, use any of the IP-addresses listed under the **Data N** section. You can also use the address specified under the **MGMT** section, but due to its slow connection rate (limited to 1 GbE), using such an address is not recommended.

The following is an example of the `HOST` file.

![Example Host File](image-url)
NOTE:
Consider the following:

- Make sure to configure name resolutions on each server that might be used as a gateway.
- Alternatively, you can create a microsoftdatabox.com DNS zone with corresponding records on your DNS server if you prefer not to modify the HOST file.

**Downloading and Installing SSL Certificate**

To establish a secure connection to the Azure Data Box device, make sure to download and import an SSL certificate and install it on both the Veeam Backup & Replication server and the gateway server (if any additional gateway server is used).

For more information on how to download an SSL certificate, see this Microsoft article.

When installing a certificate, do the following:

1. In the Certificate Import Wizard dialog, select Local Machine.
2. In the Certificate Store step, select Place all certificates in the following store and click Browse.

**Sizing Gateway Server**

In case any additional gateway server is used, note that the gateway server requires 8 CPU cores for offload job speed at about 300 MB/sec.
Step 1. Specify Object Storage Name

At the **Name** step of the wizard, do the following:

- In the **Name** field, specify a new name for the object storage repository that is being added.
- In the **Description** field, enter optional description.
Step 2. Specify Object Storage Account

At the **Account** step of the wizard, do the following:

1. In the **Service endpoint** field, specify a service endpoint address of your Azure Data Box device.
2. In the **Credentials** drop-down list, select user credentials to access your Azure Data Box storage.
   
   If you already have a credentials record that was configured in advance, select such a record in the drop-down list. Otherwise, click **Add** and provide your access and secret keys, as described in **Cloud Credentials Manager**.

For more information on where to find connection parameters of your Azure Data Box device, see **Getting Data Box Connection Parameters**.

To use a gateway server, select the **Use the following gateway server** check box and choose an appropriate server from the list. Consider using Windows-based server as a gateway. For more information on how to add such a server to your environment, see **Adding Microsoft Windows Servers**.

---

### Getting Data Box Connection Parameters

To find connection parameters of your Azure Data Box device, do the following:

1. Open the Microsoft Azure Data Box portal.
2. In the navigation pane, click **Connect and Copy**.
3. Under the **Access Settings** column of the storage account that you want to use, click **REST** and in the **Access storage account and upload data** dialog, copy the following:
   
   a. Under **Storage Account Name**, copy the Azure storage account name.
   b. Under **Key**, copy the storage account key.
c. Under **Blob Service Endpoint**, copy the service endpoint address that starts exactly after the `blob` word.

For example, if the complete service endpoint address is `https://qadataboxstoracc03.blob.ZTS18510049.microsoftdata.box.com`, then you will need to copy everything that starts from `ZTS` only. That is, `ZTS18510049.microsoftdata.box.com`. Make sure not to copy the last slash (`/`) symbol.
Step 3. Specify Object Storage Settings

At the **Container** step of the wizard, do the following:

1. In the **Container** drop-down list, select a container.
   
   Make sure that the container you want to use to store your backup data was created in advance, before you have requested Azure Data Box delivery.
   
   To create a container, you can use Microsoft Azure Storage Explorer on the Azure portal.
   
   In case you forgot to create a container beforehand, and after you have received the device, you can also use Microsoft Azure Storage Explorer to create a container manually.
   
   For more information on how to connect to the Azure Data Box device via Microsoft Azure Storage Explorer, see this Microsoft article.

2. In the **Select Folder** field, select a cloud folder to which you want to map your object storage repository and which will be used to store data.
   
   To select a folder, click **Browse** and either select an existing folder or create a new one by clicking **New Folder**.
Step 4. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of object storage repository configuration:

1. Review details of the object storage repository.
2. Click **Finish** to exit the wizard.

---

Adding Amazon S3 Object Storage

To add Amazon S3 storage or Amazon Snowball Edge, do the following:

1. **Launch New Object Repository Wizard**
2. **Select Amazon S3 Storage Type**
Step 1. Launch New Object Repository Wizard

To launch the **New Object Repository** wizard, do either of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select the **Backup Repositories** node and click **Add Repository** on the ribbon. In the **Add Backup Repository** dialog, select **Object Storage > Amazon S3**.
- Open the **Backup Infrastructure** view, in the inventory pane right-click the **Backup Repositories** node and select **Add Backup Repository**. In the **Add Backup Repository** dialog, select **Object Storage > Amazon S3**.

**Object Storage**
Select the type of object storage you want to use as a backup repository.

- **S3 Compatible**
  Adds an on-premises object storage system or a cloud object storage provider.

- **Amazon S3**
  Adds S3 object storage or an AWS Snowball Edge appliance.

- **Microsoft Azure Blob Storage**
  Adds Microsoft Azure Blob storage. Both Azure Blob Storage and Azure Data Box are supported.

- **IBM Cloud Object Storage**
  Adds IBM Cloud object storage. S3 compatible versions of both on-premises and IBM Cloud storage offerings are supported.
Step 2. Select Amazon S3 Storage Type

At the Amazon S3 step of the wizard, select either of the following storage types:

- Amazon S3 Storage
- AWS Snowball Edge Storage

Adding Amazon S3 Storage

For more information about Amazon S3 object storage, see this Amazon article.

To add Amazon S3 object storage, do the following:

1. Specify Object Storage Name
2. Specify Object Storage Account
3. Specify Object Storage Settings
4. Finish Working with Wizard
Step 1. Specify Object Storage Name

At the Name step of the wizard, do the following:

- In the Name field, specify a new name for the object storage repository that is being added.
- In the Description field, enter optional description.
Step 2. Specify Object Storage Account

At the **Account** step of the wizard, do the following:

1. In the **Credentials** drop-down list, select user credentials to access your Amazon S3 object storage.
   
   If you already have a credentials record that was configured in advance, select such a record in the drop-down list. Otherwise, click **Add** and provide your access and secret keys, as described in Cloud Credentials Manager.

2. In the **Data center region** drop-down list, select a region type.

If your organization uses NAT or different types of firewalls and your access to the internet is limited, you can employ a dedicated Windows or Linux-based gateway server to govern inbound/outbound traffic management. For more information on how to add such a server to your environment, see Adding Microsoft Windows Servers and Adding Linux Servers respectively.

To use a gateway server, select the **Use the following gateway server** check box and choose an appropriate server from the list. If no gateway server is selected, all scale-out backup repository extents must have direct Internet access.

<table>
<thead>
<tr>
<th>Name</th>
<th>Account</th>
<th>Bucket</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Credential:</strong></td>
<td>[X:XXXXXXX] (last edited: less than a day ago)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Data center region:**
  - Global
  - S3vCloud (US)
  - China

- **Use the following gateway server:**
  - storage1.local

Select a gateway server to proxy access to Amazon S3. If no gateway server is specified, all scale-out backup repository extents must have direct Internet access.
Step 3. Specify Object Storage Settings

At the **Bucket** step of the wizard, do the following:

1. In the **Data center region** drop-down list, select a region.
2. In the **Bucket** drop-down list, select a bucket.
   
   Make sure that the bucket you want to use to store your backup data was created in advance.
3. In the **Folder** field, select a cloud folder to which you want to map your object storage repository and which will be used to store data.
   
   To select a folder, click **Browse** and either select an existing folder or create a new one by clicking **New Folder**.

**IMPORTANT!**

Veeam Backup & Replication supports specific storage classes. For more information, see **Considerations and Limitations**.

To define a soft limit for your object storage consumption that can be exceeded temporarily, select the **Limit object storage consumption to** check box and provide the value in TB or PB.

To prohibit deletion of blocks of data from object storage, select the **Make recent backups immutable for** check box and specify the immutability period. For more information about immutability, see **Immutability**.

If you plan to access your backup data in an infrequent manner, select the **Use infrequent access storage class** check box to mark each block as **Standard IA (Standard Infrequent Access)**. To enable **Amazon S3 One Zone-Infrequent Access**, select the **Store backups in a single availability zone only** check box. For more information, see this Amazon article.
Step 4. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of object storage repository configuration:

1. Review details of the object storage repository.
2. Click **Finish** to exit the wizard.

**Adding AWS Snowball Edge Storage**

AWS Snowball Edge is a physical device that is requested for a short period of time from Amazon. It can be temporarily attached to your Veeam Backup & Replication backup infrastructure and used as an object storage. For more information about ordering AWS Snowball Edge and preparing to use it, see this Amazon article.

This device might become useful when you need to offload a large number of backup files that are occupying a lot of storage space on your extents, as offloading data to the AWS Snowball Edge device might occur a lot faster that transferring the same amount of data directly to Amazon object storage.

Once you have offloaded backups to AWS Snowball Edge, you need to ship the device back to Amazon for further data synchronization with your storage account, as described in Seeding Backups to AWS Snowball Edge Storage.

To add AWS Snowball Edge storage, do the following:

1. **Specify Object Storage Name**
2. **Specify Object Storage Account**
3. **Specify Object Storage Settings**
4. **Finish Working with Wizard**
Step 1. Specify Object Storage Name

At the **Name** step of the wizard, do the following:

- In the **Name** field, specify a new name for the object storage repository that is being added.
- In the **Description** field, enter optional description.

![New Object Storage Repository](image)
Step 2. Specify Object Storage Account

At the **Account** step of the wizard, do the following:

1. In the **Service point** field, specify a service point address of your AWS Snowball Edge device.
2. In the **Region** field, fill in your region.
3. In the **Credentials** drop-down list, select user credentials to access your AWS Snowball Edge storage.
   
   If you already have a credentials record that was configured in advance, select such a record in the drop-down list. Otherwise, click **Add** and provide your access and secret keys, as described in Cloud Credentials Manager.

If your organization uses NAT or different types of firewalls and your access to the internet is limited, you can employ a dedicated Windows or Linux-based gateway server to govern inbound/outbound traffic management. For more information on how to add such a server to your environment, see Adding Microsoft Windows Servers and Adding Linux Servers respectively.

To use a gateway server, select the **Use the following gateway server** check box and choose an appropriate server from the list. If no gateway server is selected, all scale-out backup repository extents must have direct Internet access.
Step 3. Specify Object Storage Settings

At the **Bucket** step of the wizard, do the following:

1. In the **Bucket** drop-down list, select a bucket.
   
   Make sure that the bucket you want to use to store your backup data was created in advance.

2. In the **Folder** field, select a cloud folder to which you want to map your object storage repository and which will be used to store data.
   
   To select a folder, click **Browse** and either select an existing folder or create a new one by clicking **New Folder**.

To define a soft limit for your object storage consumption that can be exceeded temporarily, select the **Limit object storage consumption to** check box and provide the value in TB or PB.

![New Object Storage Repository](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Account</th>
<th>Bucket: veeam-qe-beu-central-1</th>
<th>Folder: TEMP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Summary</td>
<td>Limit object storage consumption to: 10 TB</td>
<td></td>
</tr>
</tbody>
</table>

This is a soft limit to help control your object storage spend. If the specified limit is exceeded, already-running backup offload tasks will be allowed to complete, but no new tasks will be started.
Step 4. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of object storage repository configuration:

1. Review details of the object storage repository.
2. Click **Finish** to exit the wizard.

### Adding S3 Compatible Object Storage

S3 Compatible storage is any device that conforms to the Amazon S3 protocol.

To add S3 Compatible object storage, do the following:

1. **Launch New Object Repository Wizard**
2. **Specify Object Storage Name**
3. **Specify Object Storage Account**
4. **Specify Object Storage Settings**
5. **Finish Working with Wizard**
Step 1. Launch New Object Repository Wizard

To launch the **New Object Repository** wizard, do either of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select the **Backup Repositories** node and click **Add Repository** on the ribbon. In the **Add Backup Repository** dialog, select **Object Storage > S3 Compatible**.

- Open the **Backup Infrastructure** view, in the inventory pane right-click the **Backup Repositories** node and select **Add Backup Repository**. In the **Add Backup Repository** dialog, select **Object Storage > S3 Compatible**.

### Object Storage

Select the type of object storage you want to use as a backup repository.

- **S3 Compatible**
  Adds an on-premises object storage system, or a cloud object storage provider.

- **Amazon S3**
  Adds Amazon S3 storage. Both Standard and Infrequent Access (IA) storage classes are supported.

- **Microsoft Azure Blob Storage**
  Adds Microsoft Azure blob storage. Both hot and cold storage tiers are supported.

- **IBM Cloud Object Storage**
  Adds IBM Cloud object storage. S3 compatible versions of both on-premises and IBM Cloud storage offerings are supported.
Step 2. Specify Object Storage Name

At the **Name** step of the wizard, do the following:

- In the **Name** field, specify a new name for the object storage repository that is being added.
- In the **Description** field, enter optional description.
Step 3. Specify Object Storage Account

At the **Account** step of the wizard, do the following:

1. In the **Service point** field, specify an endpoint address of your S3 Compatible object storage.
2. In the **Region** field, specify a region.
3. In the **Credentials** drop-down list, select user credentials to access your S3 Compatible object storage.

   If you already have a credentials record that was configured in advance, select such a record in the drop-down list. Otherwise, click **Add** and provide your access and secret keys, as described in Cloud Credentials Manager.

If your organization uses NAT or different types of firewalls and your access to the internet is limited, you can employ a dedicated Windows or Linux-based gateway server to govern inbound/outbound traffic management. For more information on how to add such a server to your environment, see Adding Microsoft Windows Servers and Adding Linux Servers respectively.

To use a gateway server, select the **Use the following gateway server** check box and choose an appropriate server from the list.
Step 4. Specify Object Storage Settings

At the **Bucket** step of the wizard, do the following:

1. In the **Bucket** drop-down list, select a bucket.
   
   Make sure that the bucket you want to use to store your backup data was created in advance.

2. In the **Select Folder** field, select a cloud folder to which you want to map your object storage repository and which will be used to store data.
   
   To select a folder, click **Browse** and either select an existing folder or create a new one by clicking **New Folder**.

To define a soft limit for your object storage consumption that can be exceeded temporarily, select the **Limit object storage consumption to** check box and provide the value in TB or PB.

To prohibit deletion of blocks of data from object storage, select the **Make recent backups immutable for** check box and specify the immutability period. For more information about immutability, see **Immutability**.

![New Object Storage Repository](image-url)
Step 5. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of object storage repository configuration:

1. Review details of the object storage repository.
2. Click **Finish** to exit the wizard.

Managing Object Storage Repositories

You can manage your object storage repositories in various ways: edit settings of an object storage repository, switch it to Maintenance or Seal mode or remove an object storage repository.

Editing Settings of Object Storage Repository

After you have added an object storage repository, you may want to edit its settings.

To edit object storage settings, do the following:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select **Backup Repositories**.
3. In the working area, select an object storage repository and click **Edit Repository** on the ribbon or right-click an object storage repository and select **Properties**.
4. Follow the steps of the **Edit Object Storage Repository** wizard and edit settings as required. Mind that some settings cannot be modified and will remain disabled while being edited.

Switching to Maintenance Mode

Maintenance mode imposes limitations on usage of object storage repositories, as described in **Maintenance Mode Limitations**.

An object storage repository can be put into both the maintenance and seal modes at the same time. When both modes are applied, limitations of maintenance mode override limitations of seal mode.

To put an object storage repository into maintenance mode, do the following:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **Backup Repositories** node.
3. In the working area, select an object storage repository and click Maintenance mode on the ribbon or right-click an object storage repository and select Maintenance mode.

To switch back to normal, repeat steps 1 and 2, and at the step 3, click the Maintenance mode button once again or clear the Maintenance mode check box.

### Maintenance Mode Limitations

The following table lists limitations that are imposed right after the object storage repository was put into maintenance mode.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Restriction Level</th>
<th>Related Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moving to object storage.</td>
<td></td>
<td>Moving Inactive Backup Chains to Object Storage</td>
</tr>
<tr>
<td>Copying to object storage.</td>
<td></td>
<td>Copying Backups to Object Storage</td>
</tr>
<tr>
<td>Downloading from object storage.</td>
<td></td>
<td>Downloading Data from Object Storage</td>
</tr>
<tr>
<td>Moving to capacity tier (manual operation).</td>
<td></td>
<td>Moving to Capacity Tier</td>
</tr>
<tr>
<td>Activity</td>
<td>Restriction Level</td>
<td>Related Topic</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>Copy to performance tier (manual operation).</td>
<td>☐</td>
<td>Copying to Performance Tier</td>
</tr>
<tr>
<td>Restore from offloaded backups.</td>
<td>☐</td>
<td>Data Restore</td>
</tr>
<tr>
<td>Export as .vbk from offloaded backups.</td>
<td>☐</td>
<td>Exporting Backups</td>
</tr>
<tr>
<td>Removal of backups from configuration.</td>
<td>☐</td>
<td>Removing from Configuration</td>
</tr>
<tr>
<td>Retention policies.</td>
<td>☐ Synchronization is skipped for backup chains located in object storage repositories. Obsolete restore points will only be removed from backup chains on the extents.</td>
<td>Retention Policy</td>
</tr>
<tr>
<td>Removal of backups or VMs created with the Per-VM method.</td>
<td>☐</td>
<td>Removing Backups from Object Storage Repository</td>
</tr>
<tr>
<td>Scale-out backup repository rescan.</td>
<td>☐ Synchronization is skipped for object storage repositories.</td>
<td>Rescanning Scale-Out Repositories</td>
</tr>
<tr>
<td>Evacuation of storage along with indexes from on-premise extents.</td>
<td>☐</td>
<td>Evacuating Backups from Performance Tiers</td>
</tr>
</tbody>
</table>

### Switching to Seal Mode

Veeam Backup & Replication allows you to put an object storage repository into *Seal* mode.

Sealing up object storage gives you the ability to gradually remove data located in such storage by applying a retention policy. You can use this feature to gracefully stop using some of your object storage as backup repositories and exclude them from the scale-out backup repository configuration altogether.

When sealing up object storage, Veeam Backup & Replication restricts any further data transfer to such a sealed storage and allows only operations listed in *Seal Mode Limitations*.

All restore points that exceed the specified retention period will be continuously removed from the sealed object storage, as described in *Retention Policy*. 
Consider the following:

- An object storage repository can be put into seal mode only if it is a member of the scale-out backup repository.
  
  If an object storage repository was not added as part of any of your scale-out backup repositories, the Seal Extent option will not be available.

- An object storage repository can be put into both maintenance and seal modes at the same time.
  
  When both modes are applied, limitations of maintenance mode override limitations of seal mode.

To put an object storage repository into seal mode, do the following:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select the Backup Repositories node.
3. In the working area, select an object storage repository and click Seal Extent on the ribbon or right-click an object storage repository and select Seal extent.

To switch back to normal, repeat steps 1 and 2, and at the step 3, click the Sealed button once again or clear the Sealed check box.

Seal Mode Limitations

The following table lists limitations that are imposed right after the object storage repository was put into seal mode.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Restriction Level</th>
<th>Related Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moving to object storage.</td>
<td>☑</td>
<td>Moving Inactive Backup Chains to Object Storage</td>
</tr>
</tbody>
</table>
### Activity | Restriction Level | Related Topic
--- | --- | ---
Copying to object storage. | | Copying Backups to Object Storage
Downloading from object storage. | | Downloading Data from Object Storage
Moving to capacity tier (manual operation). | | Moving to Capacity Tier
Copy to performance tier (manual operation). | | Copying to Performance Tier
Restore from offloaded backups. | | Data Restore
Export as .vbk from offloaded backups. | | Exporting Backups
Removal of backups from configuration. | | Removing from Configuration
Retention policies. | | Retention Policy
Removal of backups or VMs created with the Per-VM method. | | Removing Backups from Object Storage Repository
Removal of a VM from a single storage. | | Deleting from Disk
Scale-out backup repository rescan. | | Rescanning Scale-Out Repositories
Evacuation of storage along with indexes from on-premise extents. | | Evacuating Backups from Performance Tiers

### Removing Object Storage Repository

You can remove any object storage repository from the application scope if you no longer need it.

Consider the following:

- An object storage repository cannot be removed if it is part of a scale-out backup repository.
  
  To remove such a repository, you must first exclude an object storage repository from the scale-out backup repository configuration, as described in Excluding Capacity Tier from Scale-Out Repositories.

- An object storage repository cannot be removed if backups located in this repository was imported, as described in Importing Backups.
  
  To remove such a repository, you must first detach object storage, as described in Detaching Object Storage.
When an object storage repository is being removed from the environment, the actual offloaded data remains completely unaffected.

To learn how to remove data, see Removing Backups from Object Storage Repository.

To remove an object storage repository, do the following:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Backup Repositories.
3. In the working area, select an object storage repository and click Remove Repository on the ribbon or right-click an object storage repository and select Remove.

Managing Object Storage Backups

You can manage your object storage backups in various ways: import, detach or remove object storage backups or seed them to Azure Blob Storage.

Importing Object Storage Backups

Veeam Backup & Replication allows you to import backups located in object storage repositories into the Veeam Backup & Replication console so that you can perform disaster recovery operations in case the configuration of the scale-out backup repository was permanently lost and is unavailable.

Consider the following:

- The Import Backups option is available only if object storage is not part of a scale-out backup repository.
- Before you start importing backups, make sure to add an object storage repository that stores data you want to import.
- If you have imported backups from an object storage repository, you will not be able to select this repository as a capacity extent at the Add Capacity Tier step.
- The Import Backups option is applicable only to the Capacity Tier backups. It does not support the NAS backups.

To import backups, do the following:

1. Launch Import Wizard
2. Specify Password
3. Wait for Import
4. Finish Working with Wizard
Step 1. Launch Import Wizard

To launch the **Import Backup** wizard, do either of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select the **Backup Repositories** node and in the preview pane, right-click object storage that contains backups that you want to import and select **Import backups**.

- Open the **Backup Infrastructure** view, in the inventory pane select the **Backup Repositories** node, in the preview pane, select object storage that contains backups that you want to import and select **Import Backups**.
Step 2. Specify Password

At the **Password** step of the wizard, in the **Password** field, specify the password that was used to encrypt data during offload or copy sessions.

This step is only available when importing encrypted backups.
Step 3. Wait for Import

At the **Import** step of the wizard, wait until Veeam Backup & Replication prepares a temporary database to which information about backups will be added upon import.
Step 4. Finish Working with Wizard

At the **Summary** step of the wizard:

1. Review details of the import operation.
2. Click **Finish** to run a **Configuration Database Resynchronize** session.
   
   During this session, all existing backups will be imported into the Veeam Backup & Replication console.

### Viewing Imported Backups

To view **imported** backups, do the following:

1. Open the **Home** view.
2. In the navigation pane, select the **Backups > Object Storage (Imported)** node.
3. In the preview pane, review imported backups.

Detaching Object Storage Backups

You can detach imported object storage after you have finished working with it. After object storage is detached, the imported backups become unavailable.

To detach imported object storage, do the following:

1. Open the **Backup Infrastructure** view.
2. In the navigation pane, select the **Backup Repositories** node.
3. In the preview pane, select object storage the backups of which have been imported and click **Detach Repository** on the toolbar or right-click object storage and select **Detach Repository**.

Seeding Backups to Azure Blob Storage

After you have completed moving backup data to the Azure Data Box device, you need to ship this device back to Microsoft so that this data can be synchronized with your Azure storage account.

To prepare Azure Data Box for shipping, do the following:

1. Put an object storage repository that is associated with the Azure Data Box device into **Maintenance** mode, as described in [Switching to Maintenance Mode](#).
2. Perform the steps described in [this Microsoft article](#).

After mailing the device, wait until it is accepted by Microsoft and notification of successful data upload to your Azure storage account is received. After that, do the following:

1. Add an Azure blob storage, as described in [Adding Azure BLOB Storage](#).
2. In the **Capacity Tier** step, change your Azure Data Box object storage to Azure blob storage that you have created in the previous step.
3. Remove Azure Data Box object storage from the Veeam Backup & Replication backup infrastructure, as described in [Removing Object Storage Repository](#).

Seeding Backups to AWS Snowball Edge Storage

After you have completed moving backup data to the AWS Snowball Edge device, you need to ship this device back to Amazon so that this data can be synchronized with your storage account. For more information about returning AWS Snowball Edge, see [this Amazon article](#).
To prepare AWS Snowball Edge for shipping, put the object storage repository that is associated with the AWS Snowball Edge device into Maintenance mode, as described in Switching to Maintenance Mode. You can learn in more detail about preparing AWS Snowball Edge for shipping in this Amazon article.

After mailing the device, wait until it is accepted by Amazon and notification of successful data upload to your storage account is received (if you subscribed for such notification). After that, do the following:

1. Add an Amazon S3 storage, as described in Adding Amazon S3 Storage. At the Specify Object Storage Settings step, select the same bucket and folder that you have selected for your AWS Snowball Edge device.

2. Open the Edit Scale-out Backup Repository wizard, as described in Editing Settings of Scale-Out Backup Repositories. In the Capacity Tier step, change your AWS Snowball Edge object storage to Amazon S3 storage that you have created in the previous step. Save the new setting.

3. Remove the AWS Snowball Edge object storage from the Veeam Backup & Replication backup infrastructure, as described in Removing Object Storage Repository.

Removing Backups from Capacity Tier

To remove moved or copied backups from the capacity extent, use the Delete from disk feature, as described in Deleting Backups from Object Storage Repositories.

Consider the following:

- When removing offloaded backup files from the backup chain that was created with the Per-VM method, the associated blocks of data will be removed from the capacity extent altogether.
  
  For more information about Per-VM backups, see Per-VM Backup Files.

- When removing offloaded backup files from the backup chain that was created as a single storage backup file, then nothing will be removed until either of the following occurs:
  
  o All the VMs were removed from the backup.
  
  o The backup itself was removed.

- Immutable backups cannot be removed.
  
  For more information, see Immutability.

- If the capacity extent has been put into maintenance mode, the removal of data from such a repository is not possible until it is switched back to normal.
  
  For more information, see Switching to Maintenance Mode.

- When backup is removed from the capacity extent, associated indexes will be removed as well.
  
  For more information, see Indexes.

- During data removal, not only will blocks be removed, but also the entire folder structure starting from the repository folder (<repository_folder_name>) will be completely purged.
  
  For more information on how Veeam stores data in the capacity extent, see Capacity Extent Structure.

- If backup files with metadata that are located on your extents have been removed locally in any way other than by using the Deleting from Disk feature, Veeam will not be able to synchronize the backup chain state with that of the capacity extent. Therefore, the offloaded blocks of data will continue to remain in cloud storage. To remove such blocks, use your cloud platform abilities.
Adding Backup Repositories

This section describes how to add direct attached storage, network attached storage, and deduplicating storage appliances as backup repositories.

For information on how to add object storage repositories, see Adding Object Storage Repositories.

Before you add a backup repository, check prerequisites. Then use the New Backup Repository wizard to add the backup repository.

Before You Begin

Before you configure a backup repository, check the following prerequisites.

Dell EMC Data Domain

- Dell EMC Data Domain must meet software and/or hardware requirements. For more information, see System Requirements.
- The DD Boost license must be installed on the Dell EMC Data Domain system, DD Boost must be enabled and configured.
- The gateway server that you plan to use for work with Dell EMC Data Domain must be added to the backup infrastructure.

If the Dell EMC Data Domain storage system does not meet these requirements, you can add it as a CIFS (SMB) folder. In this case, Veeam Backup & Replication will not use the DD Boost technology to work with Dell EMC Data Domain. For more information, see Dell EMC Data Domain.

ExaGrid

- ExaGrid must meet software and/or hardware requirements. For more information, see System Requirements.
- To use ExaGrid as a backup repository, you must configure an ExaGrid share in a proper way in ExaGrid Manager. For more information, see the ExaGrid documentation.
- When you add ExaGrid servers to the Veeam backup infrastructure, and you use the UPN format for an Active Directory account user name (for example, john.doe@domain.local), make sure you enter the user name in lowercase letters only.

HPE StoreOnce

- HPE StoreOnce must meet software and/or hardware requirements. For more information, see System Requirements.
- The HPE StoreOnce Catalyst license must be installed on the HPE StoreOnce system.
- You must use a Catalyst store as a backup target.
- The gateway server that you plan to use for work with HPE StoreOnce system must be added to the backup infrastructure.
- The client account that you plan to use to connect to HPE StoreOnce must have access permissions on the Catalyst store where backup data will be kept.
If the HPE StoreOnce storage system does not meet these requirements, you can add it as a shared folder. In this case, Veeam Backup & Replication will perform target-side deduplication. For more information, see HPE StoreOnce.

Quantum DXi

- Quantum DXi must meet software and/or hardware requirements. For more information, see System Requirements.
- To use Quantum DXi as a backup repository, you must configure a Quantum DXi share in a proper way. For more information, see Quantum DXi documentation.

Storage Appliances

- Storage appliances that are used to store backup data in filer (CIFS/NFS) or block device mode (iSCSI/FC/SAS) are not supported if the backup data is offloaded to tapes and is no longer stored directly on the filer/block device (Hierarchical Storage Management with Tape tier).
  To offload data to tapes, make sure that:
  - All of the backup data is stored on the appliance altogether (that is, all of the backup chains are stored on the appliance as a whole and not scattered across multiple devices) and only copies are stored on tapes.
  - These appliances emulate a tape system (VTL) as an access protocol for Veeam Backup & Replication.

**NOTE:**
Consider reading the Considerations and Limitations section that describes prerequisites for object storage.
Step 1. Launch New Backup Repository Wizard

To launch the New Backup Repository wizard, do the following:

1. Open the Backup Infrastructure view.
2. In the inventory pane, right-click the Backup Repositories node and select Add Backup Repository. Alternatively, you can click Add Repository on the ribbon.
3. In the Add Backup Repository window, select the type of the backup repository you want to add.

The New Backup Repository wizard will guide you through steps for adding direct attached storage, network attached storage, and deduplicating storage appliances as backup repositories.

For information on how to add object storage repositories, see Adding Object Storage Repositories.
Step 2. Specify Backup Repository Name and Description

At the Name step of the wizard, specify a name and description for the backup repository.

1. In the Name field, specify a name for the backup repository.

2. In the Description field, provide a description for future reference. The default description contains information about the user who added the backup repository, date and time when the backup repository was added.
Step 3. Specify Server or Shared Folder Settings

Options that you can specify at the Server step of the wizard depend on the type of backup repository you are adding.

In this section:

- Microsoft Windows or Linux Server
- SMB Share
- NFS Share
- Dell EMC Data Domain
- ExaGrid or Quantum DXi
- HPE StoreOnce

Microsoft Windows or Linux Server

To configure settings for a Microsoft Windows or Linux server:

1. From the Repository server list, select a Microsoft Windows or Linux server that you want to use as a backup repository. The Repository server list contains only those servers that are added to the backup infrastructure. If the server is not added to the backup infrastructure yet, you can click Add New on the right to open the New Windows Server or New Linux Server wizard.

   Note that you cannot add ExaGrid or Quantum DXi servers as Linux backup repositories. ExaGrid and Quantum DXi are integrated with Veeam Backup & Replication, and thus must be added as deduplicating storage appliances.

2. Click Populate to see a list of disks connected to the server, their capacity and free space.
SMB Share

To configure settings for an SMB share:

1. In the **Shared folder** field, specify a UNC path to the SMB shared folder that you want to use as a backup repository.

2. If you must specify user credentials to access the shared folder, select the **This share requires access credentials** check box. From the **Credentials** list, select a credentials record for a user account that has Full Control permissions on the shared folder. Note that the username must be in the **down-level logon name format**. For example, `DOMAIN\username` or `HOSTNAME\username`.

   If you have not set up credentials beforehand, click the **Manage accounts** link at the bottom of the list or click **Add** on the right to add the credentials. For more information, see **Managing Credentials**.

3. In the **Gateway server** section, specify settings for the gateway server:
   
   o If a network connection between the source volume and backup repository is fast, choose **Automatic selection**. In this case, Veeam Backup & Replication will automatically select a gateway server.

   o If you perform backup and replication over WAN or slow connections, choose **The following server**. From the list below, select a Microsoft Windows server on the target site that you want to use as a gateway server. The selected server must have a direct access to the SMB share and must be located as close to the SMB share as possible.

NFS Share

To configure settings for an NFS share:

1. In the **Shared folder** field, specify a path to the NFS shared folder that you want to use as a backup repository.
2. In the **Gateway server** section, specify settings for the gateway server:

   o If a network connection between the source volume and backup repository is fast, choose **Automatic selection**. In this case, Veeam Backup & Replication will automatically select a gateway server.

   o If you perform backup and replication over WAN or slow connections, choose **The following server**. From the list below, select a Microsoft Windows or a Linux server on the target site that you want to use as a gateway server. The selected server must have a direct access to the NFS share and must be located as close to the NFS share as possible.

   ![New Backup Repository](image)

### Dell EMC Data Domain

To configure settings for Dell EMC Data Domain:

1. Specify connection settings for Dell EMC Data Domain:

   o If Dell EMC Data Domain works over TCP, in the **Type in Data Domain server name** field enter a full DNS name or IP address of the Dell EMC Data Domain server.

   o If Dell EMC Data Domain works over Fibre Channel, select the **Use Fibre Channel (FC) connectivity** check box. In the **Type in Data Domain server name** field, enter a name of the Data Domain Fibre Channel server. To get the Data Domain Fibre Channel server name, in Data Domain System Manager open the **Data Management > DD Boost > Fibre Channel** tab.

2. In the **Credentials** field, specify credentials of the user account to connect to the Dell EMC Data Domain server or Dell EMC Data Domain Fibre Channel server. If you have not set up credentials beforehand, click the **Manage accounts** link at the bottom of the list or click **Add** on the right to add the credentials. For more information, see Managing Credentials.

   To connect to the Dell EMC Data Domain server, you must use credentials for the DD Boost User. To specify the DD Boost User account settings, in Data Domain System Manager, open the **Data Management > DD Boost Settings** tab.
3. To use in-flight encryption between the backup proxy and Dell EMC Data Domain, select the **Enable DDBoostrap encryption** check box and choose the encryption level — *Medium* or *High*. The encryption option works for Dell EMC Data Domain version 5.5 to 7.0.

4. In the **Gateway server** section, specify settings for the gateway server:
   - If a network connection between the source volume and Dell EMC Data Domain appliance is fast, choose **Automatic selection**. In this case, Veeam Backup & Replication will automatically select a gateway server.
   - If you perform backup over WAN or slow connections, choose **The following server**. From the list below, select a Microsoft Windows server on the target site that you want to use as a gateway server. The server must have a direct access to the Dell EMC Data Domain appliance and must be located as close to the appliance as possible.

**IMPORTANT!**

If you connect to Dell EMC Data Domain over Fibre Channel, you must explicitly define the gateway server to communicate with Dell EMC Data Domain. The server you select must be added to the backup infrastructure and must have access to the Dell EMC Data Domain appliance over Fibre Channel.

![New Backup Repository](image)

**ExaGrid or Quantum DXi Deduplicating Appliance**

To configure settings for ExaGrid or Quantum DXi deduplicating appliance:

1. From the **Repository server** list, select an appliance that you want to use as a backup repository. The **Repository server** list contains only those servers that are added to the backup infrastructure. If the server is not added to the backup infrastructure yet, you can click **Add New** to open the **New Linux Server** wizard. For more information, see **Managing Servers**.
2. Click **Populate** to see the appliance capacity and available free space.

**HPE StoreOnce Deduplicating Appliance**

To configure settings for HPE StoreOnce:

1. In the **Type in HPE StoreOnce server name** field, enter a full DNS name or IP address of the HPE StoreOnce appliance.

2. If HPE StoreOnce works over Fibre Channel, select the **Use Fibre Channel (FC) connectivity** check box.

3. In the **Credentials** field, specify credentials of the client account to connect to the HPE StoreOnce appliance. If you have not set up credentials beforehand, click the **Manage accounts** link at the bottom of the list or click **Add** on the right to add the credentials. For more information, see **Managing Credentials**.

   The client account that you plan to use to connect to HPE StoreOnce must have access permissions on a Catalyst store where backup data will be kept. To check the client account permissions, in the HPE StoreOnce management console, select the Catalyst store and open the **Permissions** tab for it.

4. In the **Gateway server** section, specify settings for the gateway server:

   - If you want Veeam Backup & Replication to pick the gateway server automatically, choose **Automatic selection**. In this case, Veeam Backup & Replication will automatically select a gateway server.

   - If you want to define the gateway server explicitly, choose **The following server**. From the list below, select a Microsoft Windows server that you want to use as a gateway server.

**IMPORTANT!**

If you connect to HPE StoreOnce over Fibre Channel, you must explicitly define the gateway server to communicate with HPE StoreOnce appliance. The server you select must be added to the backup infrastructure and must have access to the HPE StoreOnce appliance over Fibre Channel.
5. If a WAN connection between the gateway server and the HPE StoreOnce appliance is weak, select the **Gateway server and StoreOnce are connected over WAN** check box. Veeam Backup & Replication will compress VM data transported from the gateway server to the HPE StoreOnce appliance, and calculate checksums for data blocks going from the gateway server to the HPE StoreOnce appliance.
Step 4. Configure Path and Load Control Settings

At the **Repository** step of the wizard, specify path and load control repository settings.

1. In the **Location** section, specify a path to the folder where backup files must be stored. Click **Populate** to check capacity and available free space in the selected location.
   - For Dell EMC Data Domain, click **Browse** and select a location from the list of available paths.
   - For HPE StoreOnce, select a Catalyst store from the list.

2. [For Linux repository] Select the **Use fast cloning on XFS volumes** check box to enable copy-on-write functionality. In terms of Veeam Backup & Replication, this functionality is known as Fast Clone. For more information, see Fast Clone.

3. Use the **Load control** section to limit the number of concurrent tasks and data ingestion rate for the backup repository. These settings will help you control the load on the backup repository and prevent possible timeouts of storage I/O operations.
   - Select the **Limit maximum concurrent tasks** check box and specify the maximum allowed number of concurrent tasks for the backup repository. If this value is exceeded, Veeam Backup & Replication will not start a new task until one of current tasks finishes. For more information, see Limiting the Number of Concurrent Tasks.

   - Select the **Limit read and write data rates** check box and specify the maximum rate to restrict the total speed of reading and writing data to the backup repository disk. For more information, see Limiting Combined Data Rate for Backup Repositories.
NOTE:

The Limit read and write data rates to settings does not apply to health checks performed as part of backup and backup copy jobs. Even if you limit read/write rate for a backup repository, the health check will consume resources of the backup repository regardless of this setting. Bear this limitation in mind when configuring basic and health check schedules for backup and backup copy jobs.

4. Click **Advanced** to configure additional settings for the backup repository:

   - For storage systems using a fixed block size, select the **Align backup file data blocks** check box. Veeam Backup & Replication will align VM data saved to a backup file at a 4 KB block boundary. This option provides better deduplication across backup files but can result in greater amount of unused space on the storage device and a higher level of fragmentation.

   - When you enable compression for a backup job, Veeam Backup & Replication compresses VM data at the source side and then transports it to the target side. Writing compressed data to a deduplicating storage appliance results in poor deduplication ratios as the number of matching blocks decreases. To overcome this situation, select the **Decompress backup data blocks before storing** check box. If data compression is enabled for a job, Veeam Backup & Replication will compress VM data on the source side, transport it to the target side, decompress VM data on the target side and write raw VM data to the storage device to achieve a higher deduplication ratio.

   **NOTE:**

   Veeam Backup & Replication does not compress VM data if encryption is enabled for a job, and the **Decompress backup data blocks before storing** check box is selected in the settings of the target backup repository. Therefore, in the job statistics, you may observe a higher amount of transferred data (the **Transferred** counter) as compared to a job for which encryption is disabled. For details on job statistics, see **Viewing Real-Time Statistics**.
If you plan to use rotated drives for the backup repository, select the **This repository is backed by rotated hard drives** check box. For more information, see Configuring Backup Repositories with Rotated Drives.

To create a separate backup file for every VM in the job, select the **Use per-VM backup files** check box. This setting is recommended if you use a deduplicating storage appliance as a backup repository. Veeam Backup & Replication will write VM data to the backup repository in several streams, which will improve the backup job performance. However, in this case Veeam Backup & Replication will not deduplicate data between VMs added to the job. For more information, see Per-VM Backup Files.

Settings for Deduplicating Storage Appliances

If you use a deduplicating storage appliance as a backup repository, Veeam Backup & Replication automatically sets advanced settings to the following ones:

**Dell EMC Data Domain**

- The **Align backup file data blocks** option is disabled and cannot be changed.
- The **Decompress backup data blocks before storing** option is enabled.
- The **This repository is backed by rotated hard drives** option is disabled and cannot be changed.
- The **Use per-VM backup files** option is enabled.

**ExaGrid**

- The **Align backup file data blocks** option is disabled and must not be changed.
- The **Decompress backup data blocks before storing** option is disabled.
- The **This repository is backed by rotated hard drives** option is disabled and cannot be changed.
- The **Use per-VM backup files** option is enabled.
- **Limit max concurrent tasks** is equal to 10 (recommended).

Quantum DXi

- The **Align backup file data blocks** option is disabled and must not be changed.
- The **Decompress backup data blocks before storing** option is enabled.
- The **This repository is backed by rotated hard drives** option is disabled and cannot be changed.
- The **Use per-VM backup files** option is enabled.

HPE StoreOnce

- The **Align backup file data blocks** option is disabled and must not be changed.
- The **Decompress backup data blocks before storing** option is enabled.
- The **This repository is backed by rotated hard drives** option is disabled and cannot be changed.
- The **Use per-VM backup files** option is enabled and cannot be changed.
Step 5. Specify Mount Server Settings

At the Mount Server step of the wizard, specify settings for the mount server that you plan to use for file-level and application items restore.

1. From the Mount Server list, select a server that you want to use as a mount server. The mount server is required for file-level and application items restore. During the restore process, Veeam Backup & Replication will mount the VM disks from the backup file residing in the backup repository to the mount server. As a result, VM data will not have to travel over the network, which will reduce the load on the network and speed up the restore process. For more information, see Mount Server.

   The Mount Server list contains only Microsoft Windows servers that are added to the backup infrastructure. If the server is not added to the backup infrastructure yet, click Add New on the right to open the New Windows Server wizard. For more information, see Adding Microsoft Windows Servers.

2. In the Instant recovery write cache folder field, specify a folder that will be used for writing cache during mount operations.

   IMPORTANT!

   vPower NFS settings are not applicable in Microsoft Hyper-V environments.
Step 6. Review Properties and Components

At the Review step of the wizard, review details of the backup repository and specify importing settings.

1. Review the backup repository settings and list of components that will be installed on the backup repository server.

2. If the backup repository contains backups that were previously created with Veeam Backup & Replication, select the Import existing backups automatically check box. Veeam Backup & Replication will scan the backup repository to detect existing backup files and display them in the Veeam Backup & Replication console under the Imported > Backups node.

3. If the backup repository contains guest file system index files that were previously created by Veeam Backup & Replication, select the Import guest file system index check box. Index files will be imported with backup files, and you will be able to search for guest OS files inside imported backups.

![New Backup Repository window]

**Review**

Please review the settings, and click Apply to continue.

<table>
<thead>
<tr>
<th>Name</th>
<th>Server</th>
<th>Repository</th>
<th>Mount Server</th>
<th>Review</th>
<th>Apply</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Table</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following components will be processed on server filer sever01.tech.local:

<table>
<thead>
<tr>
<th>Component name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport</td>
<td>already exists</td>
</tr>
<tr>
<td>Mount Server</td>
<td>already exists</td>
</tr>
</tbody>
</table>

- [ ] Search the repository for existing backups and import them automatically
- [ ] Import guest file system index data to the catalog

< Previous  Apply  Finish  Cancel>
Step 7. Apply Backup Repository Settings

At the **Apply** step of the wizard, wait for Veeam Backup & Replication to install and configure all required components. Then click **Next** to complete the procedure of adding the backup repository to the backup infrastructure.
Step 8. Finish Working with Wizard

At the **Summary** step of the wizard, review details of the added backup repository. Then click **Finish** to exit the wizard.

Managing Backup Repositories

You can manage your backup repositories and the data therein in various ways: edit settings of the backup repositories, set up access permissions, rescan backup repositories or remove backup repositories.

In This Section

- Editing Settings of Backup Repositories
- Access Permissions
- Rescanning Backup Repositories
- Removing Backup Repositories
- Fast Clone

Editing Settings of Backup Repositories

You can edit settings of backup repositories that you have added to the backup infrastructure.

To edit settings of a backup repository:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **Backup Repositories** node.

3. In the working area, select the backup repository and click **Edit Repository** on the ribbon or right-click the backup repository and select **Properties**.

4. Edit the backup repository settings as required.

Access Permissions

You need to set up access permissions on backup repositories if you want to store the following backups in the backup repository:

- Backups of virtual and physical machines created with [Veeam Agent for Microsoft Windows](https://www.veeam.com/veeam-agent-for-microsoft-windows) or [Veeam Agent for Linux](https://www.veeam.com/veeam-agent-for-linux)

- Backups of Nutanix AHV virtual machines created with [Veeam Backup for Nutanix AHV](https://www.veeam.com/veeam-backup-for-nutanix-ahv)

- Backups of Oracle and SAP HANA databases created with [Veeam Plug-ins for Enterprise Applications](https://www.veeam.com/veeam-plugins-for-enterprise-applications).

Access permissions are granted to security principals such as users and AD groups by the backup administrator working with Veeam Backup & Replication. Users with granted access permissions can target Veeam Agent backup jobs at this backup repository and perform restore from backups located in this backup repository.

**NOTE:**

If you plan to create backups in a Veeam backup repository with Veeam Agent backup jobs configured in Veeam Backup & Replication, you do not need to grant access permissions on the backup repository to users. In the Veeam Agent management scenario, to establish a connection between the backup server and protected computers, Veeam Backup & Replication uses a TLS certificate. To learn more, see the **Configuring Security Settings** section in the Veeam Agent Management Guide.

Right after installation, access permissions on the default backup repository are set to *Allow to everyone* for testing and evaluation purposes. If necessary, you can change these settings.
After you create a new backup repository, access permissions on this repository are set to *Deny to everyone*. To allow users to store backups in the backup repository, you must grant users with access permissions to this repository.

To grant access permissions to a security principal:

1. In Veeam Backup & Replication, open the **Backup Infrastructure** view.
2. In the inventory pane, click one of the following nodes:
   - The **Backup Repositories** node — if you want to grant access permissions on a regular backup repository.
   - The **Scale-out Repositories** node — if you want to grant access permissions on a scale-out backup repository.
3. In the working area, select the necessary backup repository and click **Set Access Permissions** on the ribbon or right-click the backup repository and select **Access permissions**. If you do not see the **Set Access Permissions** button on the ribbon or the **Access permissions** command is not available in the shortcut menu, press and hold the [CTRL] key, right-click the backup repository and select **Access permissions**.
4. In the **Access Permissions** window, specify to whom you want to grant access permissions on this backup repository:
   - **Allow to everyone** — select this option if you want all users to be able to store backups in this backup repository. Setting access permissions to *Everyone* is equal to granting access rights to the *Everyone* Microsoft Windows group (*Anonymous* users are excluded). Note, however, this scenario is recommended for demo environments only.
5. If you want to encrypt Veeam Agent backup files stored in the backup repository, select the **Encrypt backups stored in this repository** check box and choose the necessary password from the field below. If you have not specified a password beforehand, click **Add** on the right or the **Manage passwords** link to add a new password. Veeam Backup & Replication will encrypt files at the backup repository side using its built-in encryption mechanism.

![Access Permissions](image)

### Rescanning Backup Repositories

You can rescan a backup repository configured in the backup infrastructure. Backup repository rescan may be required, for example, if you have archived backups from a backup repository to tape and deleted backup files in the backup repository. Or you have copied backups to the backup repository manually and want to work with them in Veeam Backup & Replication.

During the rescan operation, Veeam Backup & Replication gathers information about backups that are currently available in the backup repository and updates the list of backups in the configuration database. After the rescan operation, backups that were not in this configuration database will be shown on the **Home** view in the **Backups > Disk (Imported)** node. If backups are encrypted, they will be shown in the **Backups > Disk (Encrypted)** node.

**NOTE:**

It is recommended that you stop or disable all jobs before performing the rescan. Veeam Backup & Replication skips from scanning backups created by active jobs.

To rescan a backup repository:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **Backup Repositories** node.
3. In the working area, select the backup repository and click **Rescan Repository** on the ribbon or right-click the backup repository and select **Rescan repository**.

**Removing Backup Repositories**

You can permanently remove a backup repository from the backup infrastructure. When you remove a backup repository, Veeam Backup & Replication unassigns the backup repository role from the server and this server is no longer used as a backup repository. The actual server remains in the backup infrastructure.

Veeam Backup & Replication does not remove backup files and other data stored in the backup repository. You can re-connect the backup repository at any time and import backups from this backup repository to Veeam Backup & Replication.

You cannot remove a backup repository that is used by any job. To remove such backup repository, you first need to delete a reference to this backup repository in the job settings.

To remove a backup repository:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **Backup Repositories** node.
3. In the working area, select the backup repository and click **Remove Repository** on the ribbon or right-click the backup repository and select **Remove**.

Fast Clone

Fast Clone is the Veeam Backup & Replication technology that helps create quick file copies. Fast Clone increases the speed of synthetic backup creation and transformation, reduces disk space requirements and decreases the load on storage devices.

With this technology, Veeam Backup & Replication references existing data blocks on volumes instead of copying data blocks between files. Data blocks are copied only when files are modified.

Veeam Backup & Replication supports Fast Clone for the following types of backup repositories:

- Linux server
- Microsoft Windows server
- SMB share

Depending on the repository type, Fast Clone uses different technologies and has different requirements and limitations. For more information, see [Fast Clone for Linux Repositories](#) and [Fast Clone for Microsoft Windows and SMB Repositories](#).

Veeam Backup & Replication uses Fast Clone for the following operations:

- **In backup jobs**: merge of backup files, creation of synthetic full backups, transformation of reverse incremental backups and compact of full backup files.
- **In backup copy jobs**: merge of backup files, creation of GFS backups (synthetic method) and compact of full backup files.
When Veeam Backup & Replication performs an operation with Fast Clone, it reports this information to the session details of this operation.

Fast Clone for Linux Repositories

For Linux backup repositories, Fast Clone is based on the reflink technology.

Requirements for Linux Repositories

To use Fast Clone, Veeam Backup & Replication requires that Linux backup repositories meet the following conditions:

- Linux distribution has the reflink kernel module.
  Supported distributions: Ubuntu 18.04 or later. For other distributions, Fast Clone support is experimental.
- File system is XFS.
- Cyclic redundancy check (CRC) is enabled.
- The minimum supported data block size is 1 KB. The maximum supported block size is 4KB.
Configuring a Linux Repository

To configure a Linux backup repository for work with Fast Clone, use the following XFS volume format string:

```
mkfs.xfs -b size=4096 -m reflink=1,crc=1 /dev/sda1
```

where:

- `size=4096` sets file system block size to 4096 bytes,
- `reflink=1` enables reflinking for the XFS instance (disabled by default),
- `crc=1` enables checksums, required for reflink=1 (enabled by default).

Limitations

After you have moved backup chains to a Linux backup repository with Fast Clone support, you must create active full backups for these chains to activate Fast Clone. You can also schedule the backup file compact operation instead of active full backup.

Fast Clone for Microsoft Windows and SMB Repositories

For Microsoft Windows and SMB backup repositories, Fast Clone is based on block cloning technology of Microsoft. For more information on block cloning, see Microsoft Docs.

By default, Veeam Backup & Replication uses Fast Clone for all Microsoft Windows and SMB backup repositories that meet the requirements. You can disable this option with a registry key. For more information, contact Veeam Customer Support.

Requirements for Microsoft Windows and SMB Repositories

**Microsoft Windows Backup Repository**

To use Fast Clone, Veeam Backup & Replication requires that Microsoft Windows backup repositories meet the following conditions:

- OS is Microsoft Windows Server 2016 (and later) or Microsoft Windows 10 Pro for Workstations.
- File system is ReFS 3.1 (or later).

**Shared Folder Backup Repository**

To use Fast Clone, Veeam Backup & Replication requires that SMB backup repositories support `FSCTL_DUPLICATE_EXTENTS_TO_FILE` and `FSCTL_SET_INTEGRITY_INFORMATION`. SMB shares configured on Microsoft Windows machines must also support the SMB 3.1.1 protocol and the ReFS 3.1 (or later) file system.
Depending on the type of the performed job, Veeam Backup & Replication also imposes the following requirements on backup infrastructure components.

<table>
<thead>
<tr>
<th>Type of Job</th>
<th>Requirements to backup infrastructure components</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup job</strong></td>
<td>Protocol: SMB 3.1.1</td>
</tr>
<tr>
<td></td>
<td>OS: Microsoft Windows Server 2016 (and later) or Microsoft Windows 10 Pro for Workstations on the following backup infrastructure components:</td>
</tr>
<tr>
<td></td>
<td>• If a gateway is selected manually: Gateway server.</td>
</tr>
<tr>
<td></td>
<td>• If a gateway is selected automatically:</td>
</tr>
<tr>
<td></td>
<td>[For forward incremental chains] Mount server associated with the backup repository, or backup server.</td>
</tr>
<tr>
<td></td>
<td>[For reverse incremental chains] Fast clone is supported if the source host runs Microsoft Hyper-V Server 2016 or later. For earlier versions of hypervisor, fast clone is not supported.</td>
</tr>
<tr>
<td><strong>Backup copy job</strong></td>
<td>Protocol: SMB 3.1.1</td>
</tr>
<tr>
<td></td>
<td>OS: Microsoft Windows Server 2016 (and later) or Microsoft Windows 10 Pro for Workstations on the following backup infrastructure components:</td>
</tr>
<tr>
<td></td>
<td>• If a gateway is selected manually: Gateway server.</td>
</tr>
<tr>
<td></td>
<td>• If a gateway is selected automatically:</td>
</tr>
<tr>
<td></td>
<td>[For direct data transport path] Mount server associated with the backup repository, or backup server.</td>
</tr>
<tr>
<td></td>
<td>[For data transport path over WAN accelerators] Microsoft Windows Server 2016 (and later) or Microsoft Windows 10 Pro for Workstations on the target WAN accelerator.</td>
</tr>
</tbody>
</table>

**Limitations**

The following limitations apply when Veeam Backup & Replication uses Fast Clone for Microsoft Windows or SMB backup repositories:

- Veeam Backup & Replication does not use Fast Clone for backup repositories configured with Veeam Backup & Replication 9.5 or an earlier version. After upgrade, such backup repositories will work as backup repositories without Fast Clone support. To leverage Fast Clone, edit settings of such backup repositories and complete the Edit Backup Repository wizard without changing settings.

- After you have enabled Fast Clone for existing repositories as described in the previous paragraph or have moved backup chains to backup repositories with Fast Clone support, you must create active full backups for backup chains stored in / moved to the repositories to activate Fast Clone. You can also schedule the backup file compact operation instead of performing active full backup.

- Due to Microsoft limitations, all backup files in the backup chain must be stored on the same volume. For more information, see Restrictions and Remarks at Microsoft Docs.

- Fast Clone requires that source and destination files are stored on the same ReFS volume. If you add a backup repository with Fast Clone support as an extent to a scale-out backup repository, make sure that you enable the Data Locality placement policy for this scale-out backup repository. If backup files are stored on different extents, Fast Clone will not be used.
• Veeam Backup & Replication automatically aligns data blocks at a 4KB or 64 KB block boundary depending on the volume configuration or SMB share used storage. We recommend that you use ReFS volume formatted with 64 KB cluster size to provide better performance with large data volumes.

• When you copy data from a ReFS volume to another location, the file system downloads cloned data blocks. For this reason, copied data occupy more space in the target location than it used to occupy in the source location. This can happen, for example, if you evacuate an extent that supports block cloning from a scale-out backup repository and migrate VM backup data to another extent: copied data will require more space than it originally took.

• If you plan to assign the role of a backup repository to Microsoft Windows Server 2016 version 1709 and later or Microsoft Windows 10 Pro for Workstations, mind the following limitations:
  o Fast Clone and Windows data deduplication cannot be used simultaneously. Thus, if you target a backup job to a repository supporting Fast Clone and enable Windows data deduplication, the Fast Clone technology will not be used for this job.
  o If you target a backup job to a CIFS ReFS repository and enable Windows data deduplication, the job will fail. Veeam Backup & Replication does not support such scenario.
External Repository

An external repository is a read-only repository. You can use Veeam Backup & Replication to copy and/or restore backups created by Veeam Backup for AWS and Veeam Backup for Microsoft Azure from external to on-premises repositories and perform data migration between cloud, on-premises and virtual infrastructures.

Veeam Backup & Replication supports the following types of external repositories:

- Amazon S3
- Azure Blob

To start working with backups created by Veeam Backup for AWS and Veeam Backup for Microsoft Azure, you must add a repository that contains backups of Amazon EC2 instances or Azure VMs to the Veeam Backup & Replication infrastructure as an external repository. After that, you can perform the following operations:

- Copy backups to on-premises repositories
- Restore EC2 instances and Azure VMs to AWS
- Restore EC2 instances and Azure VMs to Microsoft Azure
- Restore guest OS files and folders
- Export disks of EC2 instances and Azure VMs
- Govern retention policies
- Perform Instant VM Recovery

**NOTE:**

- During the process of copying backups, or restore to Amazon EC2 or Microsoft Azure, data of EC instances and Azure VMs may migrate from one geographic location to another. In this case, Veeam Backup & Replication displays a warning and stores a record about data migration to job or task session details. For more information, see Locations.
- You cannot use an external repository as a target for backup or backup copy jobs.

How External Repository Works

Continue with this section to learn more on how external repositories work.

Ownership

Ownership defines what entity can own an Amazon S3 or Azure Blob storage repository at a time.

How Does Taking Ownership Occur

After Veeam Backup for AWS or Veeam Backup for Microsoft Azure has finished its initial backup job session, it becomes the rightful owner of both a storage repository and backup files in that repository.
Taking ownership of such a repository along with its backup files by the Veeam Backup & Replication client consists of the following consecutive steps:

- **Step 1.** Taking ownership of a repository.
  Reclaiming ownership of a repository occurs every time a client adds object storage as an external repository to the Veeam Backup & Replication console.

- **Step 2.** Taking ownership of backup files in the repository.
  Becoming an owner of backup files in object storage is only possible after Veeam Backup for AWS or Veeam Backup for Microsoft Azure launches the backup job session which is referring to backups you are trying to take ownership of (i.e. backup files that are located in the repository you have added at the step one).

  During its session, Veeam Backup for AWS or Veeam Backup for Microsoft Azure verifies the owner of a repository and if it finds out that the owner has been changed, it changes the owner of each backup file in that repository by creating a new checkpoint that refers to a new rightful owner. Such a checkpoint will be used during subsequent sessions of a backup job to repeat owner verification.

It is possible, however, that after you add an external repository, you never launch the associated backup job again. In such a scenario, Veeam Backup & Replication will not be able to manage retention policies, but you will still be able to restore external repository data, remove backups from external repositories and perform backup copy.

**Taking Ownership by Another Veeam Backup & Replication Client**

Ownership of a repository along with its backup files can only be granted to one Veeam Backup & Replication client at a time.

Therefore, if a client $A$ adds an external repository that has previously been added by the client $B$, the client $B$ completely loses its ownership privileges.

Losing privileges means that the client $B$ will no longer be able to manage retention policies. All the previously created backup copy jobs and restore sessions will be failing.

Ownership, however, can easily be reclaimed by re-adding the same object storage anew.

**Cache**

Veeam Backup & Replication caches data that is being retrieved from external repositories every time a backup copy job or restore session is performed.

Such an approach helps not only to reduce the number of cost-expensive operations incurred by AWS or Microsoft Azure, but also decrease the amount of traffic being sent over the network.

Consider the following:

- **Cache is created on a gateway server while the following activities are being processed:**
  - Backup copy jobs.
  - Restore sessions.
- **Cache is not created upon the addition of an external repository to the Veeam Backup & Replication console.**
- **Cache consists of metadata of blocks being retrieved from external repositories.**
• Cache is written to:
  o On a Windows-based gateway server: C:\ProgramData\Veeam\ExternalCache
  o On a Linux-based gateway server: /var/veeam/ExternalCache

• Cache is reused and updated during each subsequent execution of a backup copy job or restore session.

• Cache size limit is 10GB. Once reached, Veeam will purge obsolete cache by 20% preserving most frequently used parts. Purging is done by the maintenance job.

• Cache is removed in the following cases:
  o An external repository has been removed from the Veeam Backup & Replication console.
  o The gateway server has been changed in the settings of the external repository configuration.
  o The backup file has been removed from the external repository.
  o During the maintenance job session.

• Cache can be removed manually without affecting the backup infrastructure in any negative way.

Encryption

Backups that reside in Amazon S3 buckets and Azure Blob storage can be encrypted by Veeam Backup for AWS and Veeam Backup for Microsoft Azure. Moreover, password for such encrypted backups may change on a daily basis. For example, there is a backup chain in Amazon S3 bucket that consists of 10 restore points, each of which was encrypted with different password. Therefore, there are 10 different passwords in total that have been used.

To be able to decrypt each restore point in such a backup chain without having to provide each previously used password separately, Veeam Backup & Replication implements the ability of backward hierarchical decryption.

Backward hierarchical decryption requires you to provide only the latest password so that all the previously created restore points can be decrypted as well. For example, there are three restore points: A, B, and C. The point A was encrypted with password 1, B with password 2, and C with password 3. Therefore, you will only need to know the password of the C point to decrypt points C, B, and A.

If you plan to perform data recovery operations with encrypted backups, you must provide a password for these backups in the New External Repository wizard:

• [For Veeam Backup for AWS] At the Bucket step of the wizard.
• [For Veeam Backup for Microsoft Azure] At the Container step of the wizard.

Managing Retention Policy

A retention policy is set in the backup policy settings of Veeam Backup for AWS and Veeam Backup for Microsoft Azure and defines the number of restore points to keep in repositories.

Retention policies are initially managed by Veeam Backup for AWS or Veeam Backup for Microsoft Azure until a Veeam Backup & Replication client reclaims ownership of a repository and all the backup files in such a repository.

Once ownership is reclaimed, Veeam Backup for AWS or Veeam Backup for Microsoft Azure ceases to govern retention policies and the Veeam Backup & Replication client becomes responsible for removing obsolete restore points from repositories.
The restore points that fall under the retention policy will be removed upon the next successful session of the maintenance job.

When a Veeam Backup & Replication client removes an external repository from its scope, it relinquishes its ownership which then goes directly to Veeam Backup for AWS or Veeam Backup for Microsoft Azure until another Veeam Backup & Replication client reclaims it anew and so forth.

**IMPORTANT!**

A retention policy can only be applied by the Veeam Backup & Replication client that is the rightful owner of an Amazon S3 object storage repository and its backup files.

### Maintenance Job

The maintenance job is a system job that is executed automatically every 24 hours.

The maintenance job does the following:

- Purges obsolete restore points that fall under the retention policy.
  
  To be able to purge obsolete restore points from external repositories due to the retention policy threshold, a Veeam Backup & Replication client must be the owner of a repository and its backup files.

- Purges cache by 20% of the size limit. By default, the size limit is 10GB.

- Saves its session results to the configuration database.
  
  The session results can be found in the **History** view under the **System** node.

### Adding External Repositories

You can add Amazon S3 and Azure Blob storage as an external repository:

- Adding External Amazon S3 Storage
- Adding External Azure Blob Storage

#### Adding External Amazon S3 Storage

To add an external Amazon S3 storage repository to the backup infrastructure, use the **New Backup Repository** wizard.

**NOTE:**

If you installed **Plug-in for Veeam Backup for AWS**, and the Veeam Backup for AWS appliance is present in the Veeam Backup & Replication infrastructure, see instructions in the **Adding S3 Repositories** section in the Plug-in for Veeam Backup for AWS User Guide.
Step 1. Launch New External Repository Wizard

To launch the New Backup Repository wizard, do either of the following:

- Open the Backup Infrastructure view, in the inventory pane select the External Repositories node and click Connect to Repository on the ribbon. At the Connect to External Repository window, select Veeam Backup for AWS.

- Open the Backup Infrastructure view, in the inventory pane right-click the External Repositories node and select Connect to... At the Connect to External Repository window, select Veeam Backup for AWS.

Connect to External Repository

Select the type of a backup appliance you want to connect an object storage repository from. External repositories can only be used as a source of backups for all restore functionality, and for Backup Copy jobs.

- Veeam Backup for AWS
  Connects an Amazon S3 object storage bucket with backups created by Veeam Backup for AWS.

- Veeam Backup for Microsoft Azure
  Connects a Microsoft Azure blob storage container with backups created by Veeam Backup for Microsoft Azure.
Step 2. Specify External Repository Name and Description

At the **Name** step of the wizard, specify a name and description for the external repository.

1. In the **Name** field, enter a name for the external repository.
2. In the **Description** field, enter a description for future reference.

The default description contains information about the user who added the external repository, date and time when the external repository was added.
Step 3. Specify Cloud Repository Account

At the **Account** step of the wizard, specify Amazon S3 connection settings:

1. From the **Credentials** drop-down list, select user credentials to access an Amazon S3 bucket with Amazon EC2 instance backups.
   
   If you have not set up credentials beforehand in the **Cloud Credentials Manager**, click the **Manage cloud accounts** link or click **Add** on the right to add the necessary credentials.

2. From the **Data center region** drop-down list, select the AWS region where the Amazon S3 bucket is located: **Global**, **GovCloud (US)**, or **China**.

3. From the **Gateway server** drop-down list, select a server that will be used to access the Amazon S3 bucket.

   You can select any Microsoft Windows or Linux server that is added to your backup infrastructure and has internet connection. It is required that you use a gateway server, for example, if your organization has NAT or different types of firewalls and your access to the Internet is limited. By default, the role of a gateway server is assigned to the machine where Veeam Backup & Replication is installed.

   On the gateway server, Veeam Backup & Replication deploys the Veeam transport service. The Veeam transport service is responsible for handling ingress/egress requests that are sent to/from the gateway server when you work with EC2 instance data in Veeam Backup & Replication. If the Veeam transport service becomes outdated, you must upgrade it as described in the **Upgrading External Repositories** section.

   Gateway servers store cached data. For more information, see **Cache**.
Step 4. Specify Cloud Storage Details

At the Bucket step of the wizard, specify an Amazon S3 bucket and folder where Amazon EC2 instance backups reside:

1. From the Data center region drop-down list, select an AWS region where the Amazon S3 bucket is located.
2. From the Bucket drop-down list, select the necessary Amazon S3 bucket where EC2 instance backups reside.
3. Click Browse to select a folder in the Amazon S3 bucket where EC2 instance backups reside.
   
   If you do not see the required folder, make sure that the repository you are trying to add is created on the Veeam Backup for AWS server.

4. If the selected folder contains encrypted backups, select the Use this password for encrypted backups check box and provide a password. If you skip this step for encrypted backups, such backups will be added to the External Repository (Encrypted) node as described in the Viewing External Repository Data section.

For more information about encryption, see Encryption.

NOTE:

If another Veeam Backup & Replication client has already added the same folder, you will be prompted whether to reclaim ownership of such a folder. For more information about ownership, see Ownership.
Step 5. Apply Settings

At the **Apply** step of the wizard, wait for Veeam Backup & Replication to install and configure all required components. Then click **Next** to complete the procedure of adding the external repository to the backup infrastructure.
Step 6. Finish Working with Wizard

At the **Summary** step of the wizard, review the external repository settings and click **Finish**.

Adding External Azure Blob Storage

To add an external Microsoft Azure Blob storage repository, do the following:

1. **Launch New External Repository Wizard**
2. **Specify Repository Name**
3. **Specify Cloud Repository Account**
4. **Select Azure Blob Container**
5. **Apply Settings**
6. **Finish Working with Wizard**
Step 1. Launch New External Repository Wizard

To launch the **New External Repository** wizard, do one of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select the **External Repositories** node and click **Connect to Repository** on the ribbon. At the **Connect to External Repository** window, select **Veeam Backup for Microsoft Azure**.

- Open the **Backup Infrastructure** view, in the inventory pane right-click the **External Repositories** node and select **Connect to...** At the **Connect to External Repository** window, select **Veeam Backup for Microsoft Azure**.

### Connect to External Repository

Select the type of a backup appliance you want to connect an object storage repository from. External repositories can only be used as a source of backups for all restore functionality, and for Backup Copy jobs.

- **Veeam Backup for AWS**
  
  Connects an Amazon S3 object storage bucket with backups created by Veeam Backup for AWS.

- **Veeam Backup for Microsoft Azure**
  
  Connects a Microsoft Azure blob storage container with backups created by Veeam Backup for Microsoft Azure.
Step 2. Specify Repository Name

At the Name step of the wizard, specify a name and description for the external repository.

1. In the Name field, enter a name for the external repository.
2. In the Description field, enter a description for future reference.

The default description contains information about the user who added the external repository, date and time when the external repository was added.
Step 3. Specify Cloud Repository Account

At the **Account** step of the wizard, specify settings for an account which will be used to connect to Azure Blob storage:

1. From the **Credentials** drop-down list, select user credentials to access your Azure Blob storage.
   
   If you have not set up credentials beforehand in the Cloud Credentials Manager, click the Manage cloud accounts link or click Add on the right to add the necessary credentials.

2. From the **Data center region** drop-down list, select the region type: Azure Global, Azure Germany, Azure China, Azure Government.

3. From the **Gateway server** drop-down list, select a server that will be used to access Azure Blob storage.

   You can select any Microsoft Windows or Linux server that is added to your backup infrastructure and has Internet connection. It is required that you use a gateway server, for example, if your organization has NAT or different types of firewalls and your access to the Internet is limited. By default, the role of a gateway server is assigned to the machine where Veeam Backup & Replication is installed.

   On the gateway server, Veeam Backup & Replication deploys the Veeam transport service. The Veeam transport service is responsible for handling ingress/egress requests that are sent to/from the gateway server during working with the external repository data in Veeam Backup & Replication. If the Veeam transport service becomes outdated, you must upgrade it as described in the Upgrading External Repositories section.

   Gateway servers store cached data. For more information, see Cache.
Step 4. Select Azure Blob Container

At the Container step of the wizard, specify Azure Blob storage container settings:

1. From the Container drop-down list, select a container that contains backups created with Veeam Backup for Microsoft Azure.

2. Click Browse to select a folder that contains backups created with Veeam Backup for Microsoft Azure.

   If you do not see the required folder, make sure that the repository you are trying to add is created on the Veeam Backup for Microsoft Azure server.

3. If the selected folder contains encrypted backups, select the Use this password for encrypted backups check box and provide a password. If you skip this step for encrypted backups, such backups will be added to the External Repository (Encrypted) node as described in the Viewing External Repository Data section.

   For more information about encryption, see Encryption.

   NOTE:

   If another Veeam Backup & Replication client has already added the same folder, you will be prompted whether to reclaim ownership of such a folder. For more information about ownership, see Ownership.
Step 5. Apply Settings

At the **Apply** step of the wizard, wait for Veeam Backup & Replication to install and configure all required components. Then click **Next** to complete the procedure of adding the external repository to the backup infrastructure.
Step 6. Finish Working with Wizard

At the **Summary** step of the wizard, review the repository configuration settings and click **Finish**.

Viewing External Repository Data

After you add an external repository to the backup infrastructure, you can view backups in **External Repository** and **External Repository (Encrypted)** nodes of the **Backups** node in the **Home** view.

- In the **External Repository** node, Veeam Backup & Replication displays:
  - Amazon EC2 instance backups that were encrypted by Veeam Backup for AWS or were decrypted at the **Bucket** step of the New External Repository wizard.
  - Microsoft Azure VMs that were encrypted by Veeam Backup for Microsoft Azure or were decrypted at the **Container** step of the New External Repository wizard.

- In the **External Repository (Encrypted)** node, Veeam Backup & Replication displays:
  - EC2 instance backups that were encrypted by Veeam Backup for AWS.
Microsoft Azure VMs that were encrypted by Veeam Backup for Microsoft Azure.

To decrypt backups, select a backup policy that created the backups you want to decrypt, click **Specify Password** on the ribbon, provide a password and click **OK**.

---

**Removing Backups from External Repository**

If you want to remove backups from external repositories, you can use the **Delete from disk** operation. Consider the following:

- Data will be removed from the Veeam Backup & Replication console, configuration database and associated object storage repository.
- Data cannot be removed if the maintenance job is in progress.
- Data cannot be removed if at least one restore session of external repository data is in progress.
- Ownership is not required to remove data from external repositories.

To remove backups from an external repository, do the following:

1. Open the **Home** view.
2. In the inventory pane, expand the **Backups** node and click **External Repository**.
3. In the working area, select a backup or a separate instance or VM in the backup and click **Remove from Disk** on the ribbon.

Alternatively, you can right-click a backup or an instance and select **Delete from disk**.

---

### Rescanning External Repository

To synchronize the state of an external repository with the state of an object storage (Amazon S3 or Azure Blob), you can use the rescan feature.

Consider the following:

- By default, rescan is done automatically every 24 hours and synchronizes your external repository state with that of object storage to fetch newly created restore points and other required metadata.
- Rescan is done automatically after you add an external repository to the backup infrastructure.
- Rescan session results are saved to the configuration database and can be found in the **History** view under the **System** node.

To rescan external repositories manually:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, click **External Repositories**.
3. Select a repository you want to rescan and click **Rescan** on the ribbon menu or right-click a repository and select **Rescan**.
If you have more than one external repository added to the scope, you may want to rescan all the repositories altogether. For that, right-click the root **External Repositories** node in the navigation pane and select **Rescan**.

---

**Upgrading External Repositories**

When you upgrade an external repository, a new version of the Veeam transport service is uploaded to the gateway server. The Veeam transport service is responsible for handling ingress/egress requests that are sent to/from the gateway server during working with the external repository data in Veeam Backup & Replication.

Upload of the Veeam transport service is done directly to a gateway server which you specify at the **Account** step of the **New External Repository** wizard.

To upgrade an external repository:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, click **External Repositories**.
3. Select a repository you want to upgrade and click **Upgrade** on the ribbon menu or right-click a repository and select **Upgrade**.

![Image of Veeam Backup & Replication interface]

### Removing External Repositories

You can remove an external repository from the backup infrastructure.

When you remove an external repository, Veeam Backup & Replication does the following:

- Removes the corresponding checkpoint in associated object storage to relinquish ownership (if any).
- Removes associated external repository records from the configuration database.
- Removes associated cache from the gateway server.

To remove an external repository:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, click **External Repositories**.
3. In the working area, select an external repository and click **Remove Repository** on the ribbon or right-click the external repository and select **Remove**.

## Editing Settings of External Repository

To edit settings of an external repository:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, click **External Repositories**.
3. In the working area, select an external repository and click **Edit Repository** on the ribbon or right-click the external repository and select **Properties**.
4. Follow the steps of the **Edit External Repository** wizard and edit settings as required. Mind that some settings cannot be modified and will remain disabled during editing.
Scale-Out Backup Repository

A scale-out backup repository is a repository system with horizontal scaling support for multi-tier storage of data. The scale-out backup repository consists of one or more backup repositories called performance extents, and can be expanded with an on-premises or cloud-based object repository called capacity extent. All the storage devices and systems inside the scale-out backup repository are joined into a system, with their capacities summarized.

The main benefits of this feature are as follows:

- It provides a convenient way of managing the backup storage.
- The scale-out backup repository can be expanded at any moment: if the performance extents of your scale-out backup repository run out of space, you can add a new performance extent to the existing scale-out backup repository. For example, if backup data grows and the backup repository reaches the storage limit, you can add a new storage system to the scale-out backup repository. The free space on this storage system will be added to the capacity of the scale-out backup repository. As a result, you will not have to move backups to a backup repository of a larger size.
- It supports any backup target supported by Veeam: Windows or Linux servers with local or DAS storage, network shares, deduplicating storage appliances. All the features of any storage device or system are preserved.
- It allows you to set up granular performance policy. For more information, see Backup File Placement.
- It provides practically unlimited cloud-based storage capacity: you can instruct Veeam Backup & Replication to offload data from extents to the cloud for long-term storage. For details, see Capacity Tier.

A scale-out backup repository can comprise different tiers, or logical levels of storage.

- Performance tier is the level used for the fast access to the data. It consists of one or more backup repositories called performance extents.
  
  For more information, see Performance Tier.

- Capacity tier is an additional level for storing data that needs to be accessed less frequently. However, you still can restore your data directly from it. The capacity tier consists of one cloud-based or on-premises object storage repository called capacity extent.
  
  For more information, see Capacity Tier.

A scale-out backup repository can be used for the following types of jobs and tasks:

- Backup jobs
• Backup copy jobs.
  You can copy backups that reside in scale-out backup repositories and store backup copies in scale-out backup repositories
• Veeam backups for Amazon and Azure (via backup copy jobs)
• VeeamZIP tasks
• Backup jobs created by Veeam Agent for Linux 2.0 or later
• Backup jobs created by Veeam Agent for Microsoft Windows 2.0 or later
• NAS backup jobs
• Backup jobs for Nutanix AHV

Backup files stored in the scale-out repository can be used for all types of restores, replication from backup and backup copy jobs. You can verify such backups with SureBackup jobs. The scale-out backup repository can be used as a staging backup repository for restore from tape media. Files restored from the tape media are placed to the extents according to data placement policy configured for the scale-out backup repository. For more information, see Backup File Placement.

To deploy a scale-out backup repository, you must configure one or more backup repositories and add them to a scale-out backup repository as performance extents. You can mix backup repositories of different types in one scale-out backup repository:

• Microsoft Windows backup repositories
• Linux backup repositories
• Shared folders
• Deduplicating storage appliances

For example, you can add a Microsoft Windows backup repository and deduplicating storage appliance to the same scale-out backup repository.

Limitations for Scale-Out Backup Repositories

Scale-out backup repositories have the following limitations:

• The scale-out backup repository functionality is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.
  If you configure a scale-out backup repository and then downgrade to the Standard license, you will not be able to run jobs targeted at the scale-out backup repository. However, you will be able to perform restore from the scale-out backup repository.
• You cannot use the scale-out backup repository as a target for the following types of jobs:
  o Configuration backup job
  o Replication jobs (including replica seeding)
  o Veeam Agent backup jobs created by Veeam Agent for Microsoft Windows 1.5 or earlier
  o Veeam Agent backup jobs created by Veeam Agent for Linux 1.0 Update 1 or earlier.
• You cannot add a backup repository as a performance extent to the scale-out backup repository if any job of unsupported type is targeted at this backup repository or if the backup repository contains data produced by jobs of unsupported types (for example, replica metadata). To add such backup repository as a performance extent, you must first target unsupported jobs to another backup repository and remove the job data from the backup repository in question.

• Scale-out backup repositories do not support rotated drives. If you enable the This repository is backed by rotated hard drives setting on an extent, Veeam Backup & Replication will ignore this setting and will work with such repository as with a standard performance extent.

• If a backup repository is added as a performance extent to the scale-out backup repository, you cannot use it as a regular backup repository. You cannot target jobs to this backup repository. Instead, you have to target jobs to the configured scale-out backup repository.

• You cannot add a scale-out backup repository as a performance extent to another scale-out backup repository.

• You cannot add a backup repository as a performance extent if this backup repository is already added as an extent to another scale-out backup repository.

• You cannot add a backup repository as a performance extent if this backup repository is already used as a backup destination by vCloud Director organizations.

• You cannot add a backup repository in which some activity is being performed (for example, a backup job or restore task) as a performance extent to the scale-out backup repository.

• If you use Enterprise edition of Veeam Backup & Replication, you can create 2 scale-out backup repositories.

  For each scale-out backup repository, you can add 1 object storage repository as a capacity extent and 4 standard backup repositories as performance extents: 3 active, and 1 inactive (that is put to the Maintenance mode). You can add inactive extents, for example, if any of active extents has no free space, and you want to evacuate backup data from it.

  If you add 4 performance extents and do not put any of them to the Maintenance mode, the jobs targeted at the scale-out backup repository will fail.

  Enterprise Plus edition has no limitations on the number of scale-out backup repositories or performance extents.

• The Extract and Backup Validator utilities do not work with backups stored in scale-out backup repositories.

• To let Veeam Backup & Replication automatically import backups during rescans of a scale-out backup repository, names of VBM files and paths to VBM files (starting from the backup repository root to VBM files) must contain only allowed characters:

  o Alphanumeric characters: a-zA-Z0-9

  o Special characters: _-+=@^

  Names of VBM file and paths to VBM files must not contain spaces.

  If a name of a VBM file or a path to a VBM file contains prohibited characters, Veeam Backup & Replication will fail to import such backup during rescans of the scale-out backup repository. To import such backup, you can replace prohibited characters with the underscore character, for example: C:\My Repository\Backup_Job\Backup_Job.vbm. You do not need to rename backup files themselves.

• Veeam Backup & Replication does not split one backup file across multiple extents.

• You cannot assign the role of a cache repository for file share backup to a scale-out backup repository and its extents. To learn more about cache repository, see NAS Backup Support.
Performance Tier

Performance tier of a scale-out backup repository is the level used for fast access to the data.

The performance tier of a scale-out backup repository can comprise one or more performance extents. A performance extent is a backup repository (except an object storage repository) added to the scale-out backup repository. The list of the performance extents is displayed in the scale-out backup repository wizard, on Step 3. Add Backup Repository Extents.

On every performance extent, Veeam Backup & Replication creates the definition.erm file. This file contains a description of the scale-out backup repository and information about its performance extents.

The backup repository added to the scale-out backup repository as a performance extent ceases to exist as an individual backup repository.

When a backup repository is added as a performance extent, some of its original settings are kept, and some are not. The following settings are kept, or inherited:

- Number of tasks that can be performed simultaneously
- Read and write data rate limit
- Data decompression settings
- Block alignment settings

The following settings are not inherited:

- Rotated drive settings. Rotated drive settings are ignored and cannot be configured at the level of the scale-out backup repository.
- Per-VM backup file settings. Per-VM settings can be configured at the level of the scale-out backup repository.

Limitations

The same limitations that are specific for certain types of backup repositories apply to the performance extents. For example, if you add Dell EMC Data Domain as a performance extent to the scale-out backup repository, you will not be able to create a backup chain longer than 60 points in this scale-out backup repository.

The performance extents of the scale-out backup repository should be located in the same site. Technically, you can add to the scale-out backup repository the performance extents that reside in different sites. However, in this case Veeam Backup & Replication will have to access VM backup files on storage devices in different locations, and the backup performance will degrade.

Backup File Placement

Veeam Backup & Replication stores backup files on all performance extents of the scale-out backup repository.

When you configure a scale-out backup repository, you must set the backup file placement policy for it. The backup file placement policy describes how backup files are distributed between extents. You can choose one of two policies:

- Data locality
- Performance
You can also select an extent for backup file placement, which has its nuances if you set the Performance policy for the scale-out backup repository:

- **Extent Selection**
- **Extent Selection for Backup Repositories with Performance Policy**

Keep in mind that in the beginning of the job session, Veeam Backup & Replication estimates how much space the backup file requires and checks the amount of free space on extents. For details, see Backup Size Estimation.

The backup file placement policy is not strict. If the necessary extent is not accessible, Veeam Backup & Replication will disregard the policy limitations and attempt to place the backup file to the extent that has enough free space for the backup file.

For example, you have set the Performance policy for the scale-out backup repository and specified that full backup files must be stored on *Extent 1* and incremental backup files must be stored on *Extent 2*. If before an incremental backup job session *Extent 2* goes offline, the new incremental backup file will be placed to *Extent 1*.

**NOTE:**

Veeam Backup & Replication places backups of Microsoft SQL transaction logs and Oracle archived logs to the extent configured for storing incremental backup files. If such extent is not accessible, Veeam Backup & Replication will attempt to place log backups to any other extent that has enough free space.

**Data Locality**

If you set the Data locality policy for a scale-out backup repository, all backup files that belong to the same backup chain are stored on the same extent of the scale-out backup repository.

The Data locality policy does not put any limitations to backup chains. A new backup chain may be stored on the same extent or another extent. For example, if you create an active full backup, Veeam Backup & Replication may store the full backup file to another extent, and all dependent incremental backup files will be stored together with this full backup file.

However, if you use a deduplicating storage appliance as an extent to the scale-out backup repository, Veeam Backup & Replication will attempt to place a new full backup (active or synthetic) to the extent where the full backup from the previous backup chain resides. Such behavior will help increase the data deduplication ratio.
Performance

If you set the *Performance* policy for a scale-out backup repository, full backup files and incremental backup files that belong to the same backup chain are stored on different extents of the scale-out backup repository. If necessary, you can explicitly specify on which extents full backup files and incremental backup files must be stored.

The *Performance* policy can improve performance of transformation processes if you use raw data devices as extents. When Veeam Backup & Replication performs transformation, it needs to access a number of backup files in the backup repository. If these files are located on different storage devices, the I/O load on the devices hosting backup files will be lower.

If you set the *Performance* policy, you must make sure that the network connection between extents is fast and reliable. You must also make sure all extents are online when the backup job, backup copy job or a restore task starts. If any extent hosting backup files in the current backup chain is not available, the backup chain will be broken, and Veeam Backup & Replication will not be able to complete the task. To avoid data loss in this situation, you can enable the *Perform full backup when required extent is offline* option for the scale-out backup repository. With this option enabled, Veeam Backup & Replication will create a full backup instead of incremental backup if some files are missing from the backup chain.

Extent Selection

To select an extent for backup file placement, Veeam Backup & Replication checks the following conditions:

1. Availability of extents on which backup files reside. If some extent with backup files from the current backup chain is not accessible, Veeam Backup & Replication will trigger a full backup instead of incremental (if this option is enabled). For more information, see *Adding Backup Repository Extents*.
2. Backup placement policy set for the scale-out backup repository.
3. Load control settings — maximum number of tasks that the extent can process simultaneously.
4. Amount of free space available on the extent — the backup file is placed to the extent with the most amount of free space.
5. Availability of files from the current backup chain — extents that host incremental backup files from the current backup chain (or current VM) have a higher priority than extents that do not host such files.

Extent Selection for Backup Repositories with Performance Policy

If you set the *Performance* policy for the scale-out backup repository, Veeam Backup & Replication always stores full backup files and incremental backup files that belong to the same backup chain on different extents. To choose the extent to which a backup file can be stored, Veeam Backup & Replication applies this policy and policies mentioned above.
For example, a scale-out backup repository has 2 extents that have 100 GB and 200 GB of free space. You set the Performance policy for the scale-out backup repository and define that all types of backup files (full and incremental) can be placed on both extents.

When a backup job runs, Veeam Backup & Replication picks the target extent in the following manner:

1. During the first job session, Veeam Backup & Replication checks to which extent a full backup file can be stored. As both extents can host the full backup file, Veeam Backup & Replication checks which extent has more free space, and picks the extent that has 200 GB of free space.

2. During incremental job session, Veeam Backup & Replication checks to which extent an incremental backup file can be stored. As both extents can host the incremental backup file, Veeam Backup & Replication picks the extent that does not store the full backup file — the extent that has 100 GB of free space.

### Backup Size Estimation

At the beginning of the job session, Veeam Backup & Replication estimates how much space the backup file requires and checks the amount of free space on extents. Veeam Backup & Replication assumes that the following amount of space is required for backup files:

- The size of a full backup file is equal to 50% of source VM data.
- The size of an incremental backup file is equal to 10% of source VM data.

In case of reverse incremental backup chains, during incremental job sessions Veeam Backup & Replication allocates 10% of source VM data on the extent where a rollback file is placed and additional 10% on the extent where the full backup file resides.

This mechanism is also applied to backup files created with backup copy jobs.

Mind the following:

- On every extent of a scale-out backup repository, Veeam Backup & Replication reserves 1% of storage space to guarantee correct update of backup metadata files (VBM) and success of merge operations.
- Make sure that you have enough free space on the extent where the full backup file resides. Veeam Backup & Replication requires 10% of the size of the full backup file to perform merge operations in the backup chain. If the disk space is low, merge operations may fail.
- Veeam Backup & Replication does not timely update the information about the amount of free space on the extent, if several active tasks are targeted at this extent. For more information, see the [Veeam KB2282](https://kb.veeam.com/articles/Veeam%20KB2282) article.

### Capacity Tier

Capacity tier is an additional tier of storage that can be attached to a scale-out backup repository. Applicable data from the scale-out backup repository performance extents can be transported to the capacity tier for long-term storage.

This feature is most useful if:

- You are running out of storage space.
- Your organization policies allow you to store only a certain amount of data on your extents, while the outdated data should be stored elsewhere.
- You seek to store data on several sites to ensure its safety in case of a disaster.
With capacity tier you can:

- Move inactive backup chains to the capacity extent, as described in Moving Backups to Capacity Tier and Manually Moving Backups to Capacity Tier.
- Copy new backup files as soon as these files are created, as described in Copying Backups to Capacity Tier.
- Download data that was moved from the capacity extent back to the performance extents, as described in Downloading Data from Capacity Tier.
- Restore your data. For more information, see Data Restore. In particular, you can promptly restore data from capacity tier in case of disaster without creating a scale-out backup repository anew. For more information about this feature, see Importing Object Storage Backups.

The capacity tier consists of only one capacity extent. The capacity extent can be either cloud-based object storage repository or on-premises object storage repository, such as:

- S3-compatible object storage repository
- Amazon S3
- Microsoft Azure Blob Storage
- Microsoft Azure Data Box
- IBM Cloud Object Storage

Before an object storage repository can be configured as a capacity extent, it must be added to Veeam Backup & Replication. For more information, see Adding Object Storage Repositories.

The capacity extent is displayed in the scale-out backup repository wizard, on the Add Capacity Tier step.

For information on configuring capacity tier and synchronizing capacity tier data, see Add Capacity Tier.

**NOTE:**

Before you start using the capacity tier, make sure to check the pricing plans of your cloud storage provider to avoid additional costs for offloading and downloading backup data.
## Capacity Extent Structure

When data is being transferred to the capacity extent, Veeam Backup & Replication creates and maintains the following structure of directories:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
<th>Misc</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;bucket_name&gt; or &lt;container_name&gt;</code></td>
<td>A bucket or container name. Buckets and containers must be created in advance.</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Veeam/Archive/</strong></td>
<td>Standard folders created by Veeam Backup &amp; Replication.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;repository_folder_name&gt;</code></td>
<td>A repository folder that you create when adding a new capacity extent.</td>
<td></td>
</tr>
<tr>
<td><code>&lt;backup_id&gt;</code></td>
<td>Contains objects in a backup.</td>
<td>These folders are automatically removed during data removal.</td>
</tr>
<tr>
<td><code>&lt;objects_in_backup_id&gt;</code></td>
<td>An identifier of an object in a backup.</td>
<td></td>
</tr>
<tr>
<td>• If a backup was created using the Per-VM method, then each VM will be placed to its own directory.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• If a backup was created as a single storage, then all the VMs will be placed to a unique directory.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>objs</strong></td>
<td>Contains meta information and other auxiliary data.</td>
<td></td>
</tr>
<tr>
<td><strong>storages</strong></td>
<td>Contains a replicated version of offloaded backup files with metadata that also remain on the source extents.</td>
<td></td>
</tr>
<tr>
<td><strong>blocks</strong></td>
<td>Contains offloaded data blocks created by the offload session, as described in Data Transfer.</td>
<td></td>
</tr>
<tr>
<td>Directory</td>
<td>Description</td>
<td>Misc</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>checkpoints</td>
<td>Contains meta information about the state of offloaded backup chains. Such meta information is updated upon each successful offload session.</td>
<td></td>
</tr>
<tr>
<td>Encryption</td>
<td>Contains required information to work with encrypted backups.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Immutability**

Veeam Backup & Replication allows you to prohibit deletion of data from the capacity extent of the capacity tier by making that data temporarily immutable. It is done for increased security: immutability protects your data from loss as a result of attacks, malware activity or any other injurious actions.

To make the data immutable, Veeam Backup & Replication uses the Object Lock technology provided by Amazon and some S3-Compatible providers. Once imposed, the object lock prohibits deletion of data from the capacity extent until the immutability expiration date comes.

You can enable the immutability feature when adding (or editing) an Amazon S3 or S3 Compatible object storage repository as a capacity extent, at the Bucket step of the Adding Amazon S3 Object Storage or Adding S3 Compatible Object Storage wizards. The immutability expiration date is specified at the same point.

The immutable data within the capacity extent cannot be subject to the following operations:

- Manual removal of data, as described in Removing Backups from Capacity Tier.
- Removal of data by the retention policy, as described in Retention Policy.
- Removal of data using any cloud service provider tools.
- Removal of data by the cloud service provider technical support department.
- Removal of data by the Remove deleted items data after option, as described in Maintenance Settings.

**Preparing to Use Immutability**

In order to use immutability, you need to enable the Object Lock and Versioning features on your S3 bucket at the time you create the bucket. Keep in mind that you can enable Object Lock only at the time of creating the bucket.

For more information on enabling the Object Lock and Versioning features, see these Amazon articles: How do I create an S3 Bucket? and How do I enable or suspend versioning for an S3 bucket?

For considerations and limitations on immutability, see Considerations and Limitations.

**Block Generation**

When you configure immutability, keep in mind that an additional period of up to 10 (by default) days will be automatically added to the immutability expiration date. This period is called Block Generation. For example, if you set your immutability period to 30 days, 10 days will be added, and total immutability period will be up to 40 days.
Block Generation works in the following way. When the first data block (a full backup) arrives, its immutability period is set to $30 + 10 = 40$ days. The first full backup starts its generation, that will be appended with the incremental backups. All the incremental backups within the generation (i.e. within the 10-days period) will have the same immutability expiration date as the full backup. For instance, a data block that was offloaded on day 9 will have the same immutability expiration date as a data block offloaded on day 1. Thus we ensure that the immutability period for all the data blocks within a generation is no less than 30 days.

Consider this example: within one forward incremental backup chain, a full backup file can not be removed before an incremental backup file. On the other hand, an incremental backup file makes no sense without relevant full backup file. So the immutability period is extended for all data blocks in the backup chain.

The Block Generation period was introduced in order to reduce the number of requests to the capacity tier, thereby saving traffic and reducing costs that might be incurred by your storage provider. With 10 days of immutability automatically added, it means there is no need to extend the immutability period for the incremental backups in forward chain and for the unchanged blocks of current full backups in reverse chain offloaded within those 10 days. On the 11th day, though, the immutability period will have to be extended (in order to ensure that the immutability period for all the data blocks within a generation is no less than 30 days).

The immutable blocks of data may be reused during the offload. Veeam Backup & Replication continues to keep reused or dependent blocks of data locked by continuously assigning them to new generations, thereby extending their immutability expiration period. This is valid both for forward and reverse incremental backup chains.

The extension of immutability works differently in different cases, as follows:

**Forward incremental backup chain**
- New full backup file in the new generation:
  - Immutability is extended for the data blocks that are being reused from the old backup chain,
  - Immutability is set anew for the new blocks of the new full backup file.
- New incremental backup file in the new generation:
  - Immutability is extended for all the data blocks from the current backup chain,
  - Immutability is set anew for the new blocks of the latest incremental backup file.

**Reverse incremental backup chain**
- New full backup file in the new generation:
  - Immutability is extended for the data blocks that are being reused from the previous full backup file,
  - Immutability is set anew for the new blocks of the new full backup file.
- Current full backup file in the new generation:
  - Immutability is extended for all the data blocks of this full backup file that are already stored in the capacity tier,
  - Immutability is set anew for the new blocks of this full backup file.

**Managing Capacity Tier**

You can manage your capacity tier and the data therein in the following ways:
- Download previously offloaded data from the capacity extent back to the performance extents,
- Migrate data to another capacity tier,
• Reduce the number of cost-based operations incurred by your cloud storage provider and decrease the amount of traffic being sent over the network when moving or copying data to the capacity tier. For more information, see Indexes,
• Configure the retention policy,
• Exclude the capacity extent from the scale-out backup repository scope.

Data Transfer

Veeam Backup & Replication offers the following opportunities of data transfer to and from the capacity extent:
• Copy policy: the backups are copied to the capacity extent automatically,
• Move policy: the inactive backup chains can be transferred to the capacity extent,
• Previously offloaded data can also be downloaded from the capacity tier back to the performance extents.

To manage data transfer to and from the capacity extent, Veeam Backup & Replication uses system sessions.

In This Section

• Copying Backups to Capacity Tier
• Backup Chain Detect
• Moving Backups to Capacity Tier
• Manually Moving Backups to Capacity Tier
• Removing Backups from Capacity Tier
• Downloading Data from Capacity Tier
• Viewing Capacity Tier Sessions Statistics

Copying Backups to Capacity Tier

Veeam Backup & Replication allows you to copy backups from the performance extents of your scale-out backup repository to the capacity extent as soon as these backups are created.

To copy data to the capacity extent, Veeam Backup & Replication uses a copy session that is executed automatically upon completion of a backup (or backup copy) job that is targeted to a scale-out backup repository that was extended with the capacity extent.

A complete name of each copy session is built up of the backup (or backup copy) job name + the Offload postfix. That is, if your backup (or backup copy) job name is Amazon, the copy session name will be Amazon Offload.

Before your data can be copied to the capacity tier, Veeam Backup & Replication performs the following mandatory verifications and required actions:
• Verifies whether performance extents are available and have not been put into maintenance mode.
• Builds and maintains indexes to verify whether data that is being moved is unique and has not been offloaded earlier.

Backup files with metadata are created, as described in Moving Backups to Capacity Tier.
Once the backup (or backup copy) job is complete, Veeam Backup & Replication initiates a new copy session which simply extracts data blocks and metadata from each new backup file (.vbk, .vib, .vrb) created on any of the performance extents of your scale-out backup repository and copies these blocks and metadata to the capacity extent, thereby making an identical replica of your backup data.

Having such a replica gives you the ability to quickly restore data as of the latest state in case of trouble with any backup files, any unexpected failure of any of your performance extents, or even of the entire scale-out backup repository, as described in Restore Scenarios.

To enable data copy, make sure to select the Copy backups to object storage as soon as they are created option, as described in Add Capacity Tier.

Combining Copy and Move Operations

You can combine both the Copy backups to object storage as soon as they are created option and the Move backups to object storage as they age out of the operational restores window option. In such a scenario, a copy session will be copying newly created backups right upon creation.

Once the backup chain becomes inactive (for example, sealed) and exceeds the operational restore window, data blocks will be removed from each associated backup file in such an inactive backup chain and only metadata will be preserved. Such a behavior mimics data movement, but instead of moving data that was already copied, Veeam Backup & Replication simply purges associated data blocks from the performance extents, thereby saving traffic and reducing costs that might be incurred by your storage provider for performing read/write operations.

The following figure shows an example in which both options are enabled, suggesting that each backup file has been copied to object storage upon its creation.

The backup chain on the left becomes inactive after a new full backup file is created and consists of one .vbk file and five .vib files. Since only the first four backup files (represented as grey blocks) in this inactive backup chain exceed the operational restore window, Veeam Backup & Replication removes blocks of data from these four files only and leaves the other two .vib files (created on Thursday and Friday) as they are until the operational restore window moves forward, and so on.

After copy is complete, the new Object Storage node appears in the Home view, under the Backups node and shows backups that have been copied to the capacity extent.

**NOTE:**

The copy is not performed during prohibited hours specified in the backup window configuration.

Backup Chain Detect

Veeam Backup & Replication will transfer to the capacity extent only those restore points that belong to inactive backup chains. To ensure a backup chain is inactive, Veeam Backup & Replication verifies its state. This does not apply to the copy policy: all newly created restore points are copied immediately.
Inactive Backup Chain of a Backup Job

When a backup job runs for the first time, Veeam Backup & Replication creates an initial full backup file. It contains complete information about the VMs that are being backed up. With each subsequent backup job session, new incremental backup files are created. They contain only the changes that have occurred since the last backup session.

For forward incremental backup method, the active backup chain is the one that has not yet been sealed with a new full backup file.

To transform an active backup chain into inactive, a new active full (or synthetic full) backup file must be created for this chain. This can be done either manually, as described in Performing Active Full Backup. Else, you can configure a schedule according to which new active or synthetic full backups will be created automatically, as described in Active Full Backup and Synthetic Full Backup.

Once a new full backup file is created and the offload session is being executed, Veeam Backup & Replication collects all the restore points (full and incremental) that were created prior to the latest active full, verifies that they belong to an inactive chain, and prepares them to be moved to the capacity extent. This process is called detect. For more information, see Moving Backups to Capacity Tier.

Note that Veeam Backup & Replication will not transfer to the capacity tier the corrupted restore points and the files dependent on those. For more information on the corrupted restore points, see Health Check for Backup Files.

The same applies to the backup chains created with the reverse-incremental method. In this case, all the .vrb files starting from the third restore point will be considered inactive automatically. Thus, you do not need to create an active full (nor synthetic full) backup manually unless you want to offload all the restore points including the most recent .vbk file and the first two .vrb files.

Consider the following examples:

- Four .vrb files are inactive and can be offloaded:

- Six .vrb files and a .vbk file belong to an inactive chain and can be offloaded:

**NOTE:**

Mind that a full backup file and the first two incremental backup files (that is, two .vrb files that immediately follow the most recent .vbk file) will not be offloaded until another full backup file is created successfully.
The structure of the backup chains can be different. That depends on whether your backups were created using the per-VM method (for more information, see Per-VM Backup Files) or as a single storage, with all VMs placed into a single file. The type of the backup chain structure does not affect the offload process.

For more information on how Veeam Backup & Replication creates and manages backup chains, see Backup Chain.

### Inactive Backup Chain of a Backup Copy Job

When offloading backup chains created by backup copy jobs, Veeam Backup & Replication will move only full backup files that have a GFS flag.

To enable the GFS retention policy for the files, select the following check boxes at the Target step of the New Backup Copy Job wizard:

- **Keep the following restore points as full backups for archival purposes** check box
- **[Optional] Read the entire restore point from source backup instead of synthesizing it from increments.**

For more information on how to configure a backup copy job and how the GFS retention works, see Creating Backup Copy Jobs and GFS Retention Policy respectively.

Consider the following examples:

- A backup chain consists of two .vbk files and five .vib files created with the synthetic full method.
  
  The weekly full backup file has a GFS flag (Weekly) assigned to it and can be offloaded to object storage. The second full backup file cannot be offloaded until it is also assigned a GFS flag. It will happen after another full backup file is created.

- A backup chain consists of three .vbk files and 11 .vib files created with the active full method.
  
  In this case, the full backup file 1 does not have any GFS flag and will not be offloaded at all.
  
  A full backup file 2 has a Weekly flag, so it can be offloaded to object storage. The full backup file 3 also has a Weekly flag, but this file is active. It will not be offloaded until another full backup file is created.

**NOTE:**

The following types of backup files are never offloaded from backup chains created by backup copy jobs:

- Full backup files (.vbk) that have not been assigned any GFS flag.
- Incremental backup files (.vib).
Moving Backups to Capacity Tier

To collect backup files that belong to inactive backup chains from the performance extents and move them to the capacity tier, Veeam Backup & Replication uses an offload session which is executed automatically every 4 hours.

A complete name of each offload session is built up of the scale-out backup repository name + the Offload postfix. That is, if your scale-out backup repository name is Amazon, the offload session name will be Amazon Offload.

The offload session manages the following:

- Validation Process
- Data Transfer

Validation Process

Before your data can safely be moved to the capacity tier, Veeam Backup & Replication performs the following mandatory verifications and required actions:

- Verifies whether data that is about to be moved belongs to an inactive backup chain.
  For more information, see Backup Chain Detect.

- Verifies whether performance extents are available and have not been put into maintenance mode.
  Consider that data will not be offloaded from Linux-based performance extents that have internet access via HTTP(S) proxy. All Linux-based performance extents configured in your scale-out backup repository must have direct access to the internet.

- Verifies whether the capacity extent has not been put into maintenance or seal mode.
  For more information, see Switching to Maintenance Mode and Switching to Seal Mode.

- Verifies whether configuration parameters that define how and when inactive backup chains must be moved to the capacity extent are met.
  Such parameters are configured, as described in Add Capacity Tier.

- Builds and maintains indexes to verify whether data that is being moved is unique and has not been offloaded earlier.
  For more information, see Indexes.

- Synchronizes the backup chain state between the performance and capacity extents to maintain retention policies.
  For more information, see Retention Policy.

Data Transfer

After the validation process is complete, the SOBR Offload session does the following:

- Collects backup files that have passed verification.
  Such verified backup files are collected from all the performance extents added to a scale-out backup repository.
• Extracts data blocks from these files and moves these blocks to the capacity extent leaving the backup files only with metadata (i.e. free of data blocks).

Such backup files (without data blocks) will remain on the performance extents and will also be replicated to the capacity extent.

Having a copy of such dummy files on your performance extents allows you to:

  o Download back to the performance extents the data that has been moved to the capacity extent, as described in Data Download.

  o Restore data back to production servers, to Azure or Amazon EC2 cloud platforms or to your virtual machine, as described in Data Restore.

In this example, there is a scale-out backup repository and an object storage repository in the same scale-out backup repository.

The performance extent A has an inactive backup chain consisting of one .vbk file and three .vib files, that is, four restore points in total. Each of these files comprises metadata and the actual blocks of data. During the offload session, Veeam Backup & Replication will collect the actual blocks of data from all the backup files (.vbk and .vib) and offload these blocks to the object storage repository.

Each offloaded block might be of different size, which is defined during configuring storage optimization. The offloaded blocks are placed to the blocks directory in your capacity extent.

Backup files with metadata (or dummy files) will be replicated to the capacity extent and will be placed to the storages directory.

Such approach will be applied to all inactive backup chains that satisfy validation criteria.

After offload is complete, the new Object Storage node appears in the Home view, under the Backups node and shows backups that have been moved to the capacity extent.

**Offload Session Statistics**

The offload session results are saved to the configuration database and available for viewing, as described in Viewing Offload Job Session Results.

**Manually Moving Backups to Capacity Tier**

The Move to capacity tier option allows you to manually offload selected backup files to the capacity extent.

Consider that backup files you want to offload must belong to an inactive backup chain. For more information, see Backup Chain Detect.

To move backup data to capacity tier, do the following:

1. Open the Home view.
2. In the inventory pane, select the Backups > Disk node.
3. In the working area, right-click a backup job and select Properties.

4. In the Properties window, right-click a backup file that you want to offload and select Move to capacity tier.

   Alternatively, you can use the Move to capacity tier control at the bottom.

5. Select either of the following options:
   - For .vib/.vbk backup files:
     - **This backup and all dependent increments** — to offload the selected backup along with its increments or to remove the copied blocks of data from the selected backup and its increments.
   - For .vbk backup files:
     - **This backup** — to offload the selected full backup only or to remove the copied blocks of data from such a full backup.
     - **This backup and all dependent increments** — to offload the selected full backup along with its increments or to remove the copied blocks of data from the selected backup and its increments.

---

### Removing Backups from Capacity Tier

To remove moved or copied backups from the capacity extent, use the **Delete from disk** feature, as described in Deleting Backups from Object Storage Repositories.

Consider the following:

- When removing offloaded backup files from the backup chain that was created with the Per-VM method, the associated blocks of data will be removed from the capacity extent altogether.

  For more information about Per-VM backups, see Per-VM Backup Files.
When removing offloaded backup files from the backup chain that was created as a single storage backup file, then nothing will be removed until either of the following occurs:

- All the VMs were removed from the backup.
- The backup itself was removed.

Immutable backups cannot be removed.
For more information, see Immutability.

If the capacity extent has been put into maintenance mode, the removal of data from such a repository is not possible until it is switched back to normal.
For more information, see Switching to Maintenance Mode.

When backup is removed from the capacity extent, associated indexes will be removed as well.
For more information, see Indexes.

During data removal, not only will blocks be removed, but also the entire folder structure starting from the repository folder (<repository_folder_name>) will be completely purged.
For more information on how Veeam stores data in the capacity extent, see Capacity Extent Structure.

If backup files with metadata that are located on your extents have been removed locally in any way other than by using the Deleting from Disk feature, Veeam will not be able to synchronize the backup chain state with that of the capacity extent. Therefore, the offloaded blocks of data will continue to remain in cloud storage. To remove such blocks, use your cloud platform abilities.

### Downloading Data from Capacity Tier

In Veeam Backup & Replication, you can manually download offloaded backups back to the performance extents.

You can download one backup at a time using the Copy to Performance Tier option, or get all offloaded backups in bulk using the Download feature. For more information, see below Downloading Single Backup Chain and Downloading All Backups, respectively.

For more information on how data is downloaded, see How Downloading from Capacity Tier Works.

#### Downloading Single Backup Chain

To download previously offloaded backup data back to the performance extents, one backup at a time, do the following:

1. Open the Home view.
2. In the inventory pane, select the Backups > Object Storage node.
3. In the working area, right-click a backup job and select Properties.
4. In the Properties window, right-click an offloaded backup file and select Copy to performance tier. Alternatively, you can use the Copy to performance tier control at the bottom.
5. Select either of the following options:
   - For .vib/.vbk backup files:
     - **This backup and all dependent increments** — to copy the selected backup along with its increments.
For `.vbk` backup file:

- **This backup** — to copy the full backup only.
- **This backup and all dependent increments** — to copy the selected backup along with its increments.

**NOTE:**

To remove copied blocks from the performance extents, use the **Move to capacity tier** option, as described in *Moving Inactive Backup Chains to Capacity Tier*.

### Downloading All Backups

To download all offloaded backups back to the performance extents, do the following:

1. Open the **Home** view.
2. In the inventory pane, select the **Backups > Object Storage** node.
3. On the toolbar, click **Download** or in the working area, right-click a backup job and select **Download**.
   - If the latest backup chain is already present on your performance extent, you will be asked if you wish to download all other backup files. Click **Yes** if you wish to do so or **No** to cancel the download.
   - If the latest backup chain is not on your performance extent yet, you will be asked which backup files you would like to download. Click **All Backups** to download all backup files or **Latest Only** to download just the latest backup chain.
NOTE:
To remove downloaded data from the performance extents, use the Move to capacity tier option, as described in Moving Inactive Backup Chains to Capacity Tier.

How Downloading from Capacity Tier Works

To download data from the capacity extent back to the performance extents, Veeam Backup & Replication uses the SOBR download job.

The SOBR download job is triggered right after you select the Copy to performance tier option; it collects offloaded blocks of data from the capacity extent and copies them back to the performance extents. For more information, see Downloading from Capacity Tier.

Consider the following:

- Before copying data blocks, Veeam Backup & Replication verifies whether any of such blocks exist on any of the performance extents of your scale-out backup repository. If found, Veeam Backup & Replication will reuse the existing blocks instead of downloading the exact same data from the capacity extent.
NOTE:
If the password in the backup job has been changed, in some cases Veeam Backup & Replication may not be able to reuse the performance tier data in the course of the download.

- If a performance extent is unable to accommodate data being copied due to lack of free storage space, Veeam Backup & Replication will find another extent in the associated scale-out backup repository that has sufficient storage capacity to receive the data. If your scale-out backup repository has no performance extents other than the one running out of space, the copy will not be possible.
- If you have removed any of the performance extents from a scale-out backup repository without evacuating backup files with metadata, the copy will not be possible.
  
  Backup files with metadata are created, as described in Moving Inactive Backup Chains to Capacity Tier.
- The SOBR download session results are saved to the configuration database and available for viewing, as described in Viewing Download Job Session Results.

Viewing Capacity Tier Sessions Statistics

Continue with this section to learn more about:

- Viewing Offload Session Results
- Viewing Copy Session Results
- Viewing Download Session Results

Viewing Offload Session Results

To review offload session results, do the following:

1. Open the History view.
2. In the inventory pane, select the Storage management node.
3. In the working area, right-click an offload session and select Statistics.
For more information about moving inactive backup chains to capacity tier, see Moving Inactive Backup Chains to Capacity Tier.

Veeam Backup & Replication displays offload job session statistics for the following counters:

- The **Job progress** bar shows percentage of the offload session completion.
- The **Summary** box shows general information about the offload session:
  - **Duration** — duration of the offload session.
  - **Processing rate** — average speed of VM data processing. This counter is a ratio between the amount of data that has actually been read and the offload session duration.
  - **Bottleneck** — bottleneck in the data transmission process. To learn more about bottlenecks, see Performance Bottlenecks.
- The **Data** box shows information about processed data:
  - **Processed** — total size of all VM disks processed by the offload session.
  - **Read** — the amount of data read from the extents.
  - **Transferred** — the amount of data transferred from the extents to object storage.
- The **Status** box shows information about the job results. This box informs how many tasks have completed with the **Success**, **Warning** and **Error** statuses (1 task per 1 VM).
- The pane in the lower-left corner shows a list of objects processed by the offload session.
The pane in the lower-right corner shows a list of operations performed during the session. To see a list of operations for a specific object, click the object in the pane on the left. To see a list of operations for the whole offload session, click anywhere on the blank area in the left pane.

**Viewing Copy Session Results**

To review copy session results, do the following:

1. Open the **History** view.
2. In the inventory pane, select the **Storage management** node.
3. In the working area, right-click a copy session and select **Statistics**.

For more information about moving inactive backup chains to capacity tier, see [Moving Inactive Backup Chains to Capacity Tier](#).

Veeam Backup & Replication displays offload job session statistics for the following counters:

- The **Job progress** bar shows percentage of the copy session completion.
- The **Summary** box shows general information about the copy session:
  - **Duration** — duration of the copy session.
  - **Processing rate** — average speed of VM data processing. This counter is a ratio between the amount of data that has actually been read and the offload session duration.
  - **Bottleneck** — bottleneck in the data transmission process. To learn more about bottlenecks, see [Performance Bottlenecks](#).
- The **Data** box shows information about processed data:
  - **Processed** — total size of all VM disks processed by the copy session.
Read — the amount of data read from the extents.

Transferred — the amount of data transferred from the extents to object storage.

- The Status box shows information about the copy results. This box informs how many tasks have been completed with the Success, Warning and Error statuses (1 task per 1 VM).

- The pane in the lower-left corner shows a list of objects processed by the copy session.

- The pane in the lower-right corner shows a list of operations performed during the session. To see a list of operations for a specific object, click the object in the pane on the left. To see a list of operations for the whole copy session, click anywhere on the blank area in the left pane.

Viewing Download Session Results

To review SOBR Download job session results, do the following:

1. Open the History view.
2. In the inventory pane, select the Storage management node.
3. In the working area, right-click a SOBR Download session and select Statistics.

For more information about the SOBR Download session, see How Downloading Data from Capacity Tier Works.

Veeam Backup & Replication displays SOBR Download job session statistics for the following counters:

- The Job progress bar shows percentage of the job completion.
• The **Summary** box shows general information about the job session:
  o **Duration** — duration of the job session.
  o **Processing rate** — average speed of data processing. This counter is a ratio between the amount of data that has actually been read and the job session duration.
  o **Bottleneck** — bottleneck in the data transmission process. To learn more about bottlenecks, see [Performance Bottlenecks](#).

• The **Data** box shows information about processed data:
  o **Processed** — total size of data blocks being downloaded from object storage repository plus blocks (if any) being taken from the extents of your scale-out backup repository.
  o **Read** — the amount of data read from both the object storage repository and extents of your scale-out backup repository.
  o **Transferred** — the amount of data downloaded from object storage.

• The **Status** box shows information about the job results. This box informs how many tasks have completed with the **Success**, **Warning** and **Error** statuses.

• The pane in the lower-left corner shows a list of objects processed by the job.

• The pane in the lower-right corner shows a list of operations performed during the session. To see a list of operations for a specific object, click the object in the pane on the left. To see a list of operations for the whole job session, click anywhere on the blank area in the left pane.

### Migrating Data To Another Capacity Tier

You can migrate your data from an object storage repository to another one. After that you can add the new object storage repository as a capacity extent instead the previous one.

The migration option may be useful if you want, for instance, switch your provider.

Such a migration can be done under the following scenarios:

- **Migrating data between different cloud providers**
  To be used to migrate data from one object storage provider to another. For example, you may have been using an Amazon S3 object storage repository for quite some time and decided to change it to Azure BLOB storage or any other storage provider.

- **Migrating data between different buckets**
  To be used to migrate data between different buckets of the same cloud provider.

### Migrating Data Between Different Cloud Providers

You can migrate your data from an object storage repository to another one. After that you can add the new object storage repository as a capacity extent instead the previous one.

1. Download data from an object storage repository back to the performance extents, as described in [Downloading Data from Capacity Tier](#).
2. Add a new object storage repository to the Veeam Backup & Replication environment, as described in [Adding Object Storage Repositories](#).
3. Change an object storage repository to a new one that you have created at the previous step, as described in [Add Capacity Tier](#).
4. Copy or move your data to a new object storage repository, as described in *Moving to Capacity Tier*.

**Migrating Data Between Different Buckets**

To migrate data located in an object storage repository between different buckets of the same cloud provider, do the following:

1. Use any available 3rd-party tool to copy cloud data to a different bucket of your cloud storage.
2. Add a new object storage repository to the Veeam Backup & Replication environment, as described in *Adding Object Storage Repositories*.
3. Change the capacity extent to a new one that you have created at the previous step, as described in *Add Capacity Tier*.
4. Synchronize your data, as described in *Synchronizing Capacity Tier Data*.

**Indexes**

To reduce the number of cost-based operations incurred by your cloud storage provider and to decrease the amount of traffic being sent over the network when moving or copying data to object storage, Veeam Backup & Replication uses indexes.

Index behavior is as follows:

- Indexes are created (or updated) during each offload or copy session and consist of hash values of blocks that are being transferred to the capacity tier. These hashes are retrieved from meta information of your backup files (`.vbk`, `.vib`, or `.vrb`).
- Indexes are stored in the *ArchiveIndex* directory that is located on the Performance Tier.
  
  On each subsequent offload/copy session, Veeam Backup & Replication reuses these indexes to verify whether new blocks that are about to be transferred to the capacity tier have not been offloaded earlier. Verification is done by comparing existing indexes hashes with that of a block being transferred.
- For backups created using the *per-VM method*, indexes are built per backup chain and cannot have any cross references to any other backup chains. For backups created as a single storage, indexes are built for the whole backup.
- Indexes are updated every time a backup chain is modified.
  
  For example, some data might have been removed due to the retention policy threshold, or you may have removed it manually. Both scenarios will modify your indexes upon the next successful offload or copy session to maintain consistency.
- Corrupted indexes can be rebuilt by using the *Rescan* feature, as described in *Rescanning Scale-Out Repositories*.
  
  Once an index is rebuilt, Veeam Backup & Replication will have to wait for 24 hours before it can offload any data again. This is necessary to comply with the *Eventual Consistency* model of Amazon S3.
ArchivelIndex Directory Structure

When Veeam Backup & Replication creates indexes, it also creates and maintains the following directory structure on each extent.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArchivelIndex</td>
<td>The root directory for keeping indexes.</td>
</tr>
<tr>
<td>&lt;backup_id&gt;</td>
<td>Contains objects in a backup file.</td>
</tr>
<tr>
<td>&lt;objects_in_backup_id&gt;</td>
<td>An identifier of an object in a backup file.</td>
</tr>
<tr>
<td></td>
<td>• If a backup was created using the per-VM method, then each VM will be</td>
</tr>
<tr>
<td></td>
<td>placed to its own directory.</td>
</tr>
<tr>
<td></td>
<td>• If a backup was created as a single storage, then all the VMs will be</td>
</tr>
<tr>
<td></td>
<td>placed to a unique directory.</td>
</tr>
<tr>
<td>stg_index</td>
<td>Contains indexes of offloaded backup files (.vbk, .vib, or .vrb).</td>
</tr>
<tr>
<td>index_data.vbk</td>
<td>Contains meta information on hash values stored in index files.</td>
</tr>
</tbody>
</table>

Retention Policy

Retention policy defines the number of restore points to keep on your performance extents and is configured in the Specify Backup Storage Settings step of the backup job configuration wizard.

You can manage retention policies to remove obsolete restore points both from the performance extents and the capacity tier.

The restore points that fall under the retention policy will be removed both from the performance and capacity extents in the following manner:

- An earliest restore point will be removed from the backup chain on the associated extent.
- Data blocks that correspond to the restore point that is being removed will be purged from the capacity extent upon the next offload or copy session.

Make sure that the capacity extent has not been put into maintenance mode, as this mode prevents synchronization of the state of the backup chain in the performance tier with that of the capacity tier.

For more information about the move and copy offload sessions, see Moving Inactive Backup Chains to Capacity Tier and Copying Backups to Capacity Tier respectively.
• Immutable blocks of data are removed after the immutability period is over.

When a retention policy encounters immutable copied/moved blocks of data, it removes such blocks from the associated backup files on the extents only and then updates indexes, informing Veeam Backup & Replication that these blocks no longer exist and must be removed from the capacity tier once mutable.

For more information about immutability, see Immutability.

• Associated indexes will be updated for consistency purposes.

For more information, see Indexes.

Excluding Capacity Tier from Scale-Out Repositories

You can exclude a capacity extent from the scale-out backup repository scope, for example, if you no longer want to utilize any third party services to store your data.

Consider that after you exclude an object storage repository that is being used as a capacity extent and which stores offloaded backup data, Veeam Backup & Replication automatically puts the excluded object storage repository into maintenance mode. Once a repository is in maintenance mode, you will not be able to restore your data from it. To switch back to normal, you will have to add that repository as an extent of any other capacity tier and synchronize existing backup chains with your performance extents. After the synchronization is complete, the existing backups will become available as imported. For more information, see Synchronizing Capacity Tier Data.

To exclude a capacity extent from the scale-out backup repository scope, do the following:

1. Open the Backup Infrastructure view.
2. In the inventory pane, click Scale-out Repositories.
3. In the working area, select a scale-out backup repository and click Edit Scale-out Repository on the ribbon, or right-click a scale-out backup repository and select Properties.
4. Move to the Capacity tier step of the wizard.
5. Clear the **Extend scale-out backup repository capacity with object storage** check box.

You will be asked to confirm the action in the dialog shown below, whereupon an object storage repository will be immediately put into maintenance mode.

---

**Data Restore**

You can restore your data directly from the capacity tier back to production servers or to Azure or Amazon EC2 cloud platforms. Capacity tier data recovery does not differ from that of a standard backup data recovery and can be performed by using any of the following methods:

- Instant VM Recovery
- Entire VM Recovery
- VM Files Restore
- Guest OS File Recovery
- Instant VM Disk Recovery
- Application Items Restore
- Exporting Backups

Data recovery can also be done directly to Amazon EC2 or Microsoft Azure, as described in the **Restore to Amazon EC2** and **Restore to Microsoft Azure** sections, respectively.

**Restore Scenarios**

This section explains possible restore scenarios from the capacity tier.
Unavailability of Backup Files

If one of the offloaded backup files becomes unavailable on any of the extents in a scale-out backup repository, you can restore it by doing the following:

1. Rescan a scale-out backup repository.
   For more information on how to rescan a scale-out backup repository, see Rescanning Scale-Out Repositories.

2. Copy data from the capacity tier to the performance tier.
   For more information on how to copy data, see Copying to Performance Tier.

**NOTE:**
The performance or capacity extents must not be in Maintenance mode.

Unavailability of Extents

A performance extent in a scale-out backup repository may become unavailable or be in maintenance mode. To restore data in such case, you can use any method described in Data Recovery.

For example, you are restoring a virtual machine consisting of three data blocks, of which two blocks reside on the *Extent 1* and another required block is stored on the *Extent 2* which is unavailable. In such scenario, Veeam Backup & Replication gets two blocks from the *Extent 1* and another required block from the capacity tier.

Unavailability of Scale-Out Backup Repository

To restore data if the entire scale-out backup repository is unavailable, you can use any method described in Data Recovery.

If the entire scale-out backup repository becomes unavailable, Veeam Backup & Replication restores data from the capacity tier only.
For example, both performance extents that store required backup files to restore a virtual machine are not available. In such a scenario, Veeam Backup & Replication restores data from the capacity tier only.

Unavailability of Backup Server

To get access to backups in the capacity tier in case the entire configuration of the backup server becomes corrupted and your scale-out backup repositories are no longer available, you can:

- Restore the configuration of the backup server from the configuration backup, as described in Configuration Backup and Restore.
- Import backups from the capacity tier, as described in Importing Backups.

Adding Scale-Out Backup Repositories

Before you add a scale-out backup repository, check prerequisites. Then use the New Scale-out Backup Repository wizard to configure the scale-out backup repository.

Before You Begin

Before you add a scale-out backup repository to the backup infrastructure, check the following prerequisites:

- Backup repositories that you plan to add as performance extents to the scale-out backup repository must be added to the backup infrastructure. For more information, see Adding Backup Repositories.
- You must check limitations for scale-out backup repositories. For more information, see Limitations for Scale-Out Backup Repositories.
Step 1. Launch New Scale-Out Backup Repository Wizard

To launch the **New Scale-out Backup Repository** wizard, do either of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select **Scale-out Repositories** and click **Add Scale-out Repository** on the ribbon.

- Open the **Backup Infrastructure** view, in the inventory pane right-click **Scale-out Repositories** and select **Add Scale-out Backup Repository**.
Step 2. Specify Scale-Out Backup Repository Name

At the **Name** step of the wizard, specify a name and description for the scale-out backup repository.

1. In the **Name** field, specify a name for the scale-out backup repository.
2. In the **Description** field, provide a description for future reference. The default description contains information about the user who added the backup repository, date and time when the backup repository was added.
Step 3. Add Performance Extents

At the Performance Tier step of the wizard, specify which backup repositories you want to add as performance extents, and configure options for the scale-out backup repository.

1. On the right of the Extents list, click Add.
2. In the Extents window, select check boxes next to backup repositories that you want to add as performance extents.
3. Click OK.
4. At the lower right corner of the Extents list, click Advanced.
5. Specify advanced options for the scale-out backup repository:

   a. Select the Use per-VM backup files check box if you want to create a separate backup chain for every VM in the job. With this option enabled, during one backup job session Veeam Backup & Replication will produce a number of backup files — one per every VM, and will write these files to the backup repository in multiple streams simultaneously. It is recommended that you enable this option to achieve better storage and compute resource utilization, especially if you use as a backup repository a deduplicating storage appliance that supports multiple write streams.

   b. To preserve the consistency of backup chains in the scale-out backup repository, select the Perform full backup when required extent is offline check box. If an extent that contains previous restore points from the current backup chain gets offline, the backup chain will be broken. Veeam Backup & Replication will not be able to add a new incremental backup file. With this option enabled, Veeam Backup & Replication will create a full backup file instead of an incremental backup file. If you enable this option, you must make sure that you have enough free space in the scale-out backup repository to host a full backup file.
If a backup repository that you add as a performance extent is already used by jobs of supported type or there are backups pointing at the backup repository (for example, independent backups created with VeeamZIP), Veeam Backup & Replication will offer you to update a link to the backup repository in the job properties. Click **Yes** to update the link and target the jobs and backups at the scale-out backup repository. If you click **No**, you will not be able to pass to the next steps of the wizard.
Step 4. Specify Backup Placement Policy

At the **Policy** step of the wizard, specify how you want to store backup files on performance extents of the scale-out backup repository.

1. Set the backup file placement policy for the scale-out backup repository:
   
   - Select **Data locality** if you want to store backup files that belong to the same backup chain together. In this case, a full backup file and subsequent incremental backup files will be stored to the same performance extent of the scale-out backup repository. The new backup chain may be stored to the same performance extent or to another performance extent (unless you use a deduplicating storage appliance as a performance extent).
   
   - Select **Performance** if you want to store full and incremental backup files to different performance extents of the scale-out backup repository. If you set the Performance policy, you must make sure that the network connection is fast and reliable so that Veeam Backup & Replication can access all backup files from the backup chain.

   For more information, see [Backup File Placement](#).

2. If you select the **Performance** policy, you can restrict which types of backup files can be stored on a specific performance extent. For example, if you have added three performance extents to the scale-out backup repository, you may want to store full backup files on one extent and incremental backup files — on the other two extents.
   
   a. Click **Customize**.
   
   b. In the **Backup Placement Settings** window, select a performance extent and click **Edit**.
   
   c. Select a check box next to the type of backup files that you want to store on the extent: **Full backup files** or **Incremental backup files**. By default, Veeam Backup & Replication can store both full and incremental backup files on the same extent.
Step 5. Add Capacity Tier

At the **Capacity Tier** step of the wizard, select an object storage repository that you want to add as a capacity extent and specify when to move and/or copy data.

Consider the following:

- You can add only one capacity extent per scale-out backup repository.
- An object storage repository cannot be added as part of two or more different scale-out backup repositories at the same time.
- If the selected object storage contains offloaded backup data, you will be offered to synchronize this data with your performance extents.
  
  For more information, see [Synchronizing Capacity Tier Data](#).
- Object storage the backups of which have been imported cannot be selected.
  
  For more information, see [Importing Object Storage Backups](#).

To configure capacity tier, do the following:

1. Select the **Extend scale-out backup repository capacity with object storage** check box.
2. Select an object storage repository to which you want to offload your data.
   
   Make sure that this storage has been added to your environment in advance. In case an object storage repository has not been configured, click **Add** and follow the associated steps of the wizard, as described in [Adding Object Storage Repository](#).
3. Click **Window** and specify when it is allowed or prohibited to move or copy data to object storage.
4. Select the **Copy backups to object storage as soon as they are created** check box to copy new backups as soon as they are created, as described in [Copying Backups to Capacity Tier](#).
   
   When selecting this option, you will be asked whether to copy all backup files that you might already have on any of the performance extents, or only those that have been created recently.
   
   If you select **Latest**, only backup files that belong to the last active backup chain will be copied from each of the performance extents. If you select **All**, Veeam Backup & Replication will copy all backup files that belong to all backup chains located on any of the specified extents.
5. Select the **Move backups to object storage as they age out of the operational restores window** check box to move inactive backup chains to the capacity extent, as described in [Moving Backups to Capacity Tier](#).
   
   In the **Move backup files older than X days** field, specify the operational restore window to define a period after which inactive backup chains on your performance extents would be considered outdated and, therefore, should be moved to the capacity extent. Consider that "0" is an acceptable value, which you can specify to offload inactive backup chains on the same day they are created.
   
   To override behavior of moving old backups, click **Override**, select the **Move oldest backup files sooner if scale-out backup repository is reaching capacity** check box and define a threshold in percent to force data transfer if a scale-out backup repository has reached the specified threshold.
6. To offload data encrypted, select **Encrypt data uploaded to object storage** and provide a strong password.
   
   With this option selected, the entire collection of blocks along with the metadata will be encrypted while being offloaded.
   
   If you have not created the password beforehand, click **Add** or use the **Manage passwords** link to specify a new password.
**TIP:**

You can combine both the **Copy backups to object storage as soon as they are created** option and the **Move backups to object storage as they age out of the operational restores window** option, as described in Copying Backups to Capacity Tier.

---

**Synchronizing Capacity Tier Data**

When you add as a capacity extent an object storage repository that contains offloaded backup data, you will be prompted to synchronize this data with the performance extents in the scale-out backup repository.

Consider the following:

- An object storage repository can only be added as a capacity extent after existing data (if any) is synchronized.

- During synchronization, Veeam Backup & Replication downloads backup files with metadata located in object storage to the performance extents that are part of the scale-out backup repository that is being added.

  These files are created as described in Moving Backups to Capacity Tier.

- Extents to which backup data is going to be downloaded (synchronized), will be selected automatically, depending on the available resources.

- The actual data blocks will not be downloaded and will continue to remain in object storage.

- When synchronizing encrypted storage, make sure to provide the same exact password with which the data was encrypted.
After the synchronization is complete, the associated backup files located in object storage will become available as imported and will be displayed in the **Home** view, under the **Object Storage (Imported)** node in the inventory pane.

The following figure shows an example of prompting you to synchronize existing object storage data with your extents.
Step 6. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of scale-out backup repository configuration.

Wait for the scale-out backup repository to be added to the backup infrastructure. The process may take some time.

1. Review details of the scale-out backup repository.
2. Click **Finish** to exit the wizard.

---

Managing Scale-Out Backup Repositories

You can manage your scale-out backup repositories and the data therein in various ways: edit settings of the scale-out backup repository, rescan scale-out backup repositories automatically or manually, discover on which performance extent of the scale-out backup repository a particular backup file is stored, extend scale-out backup repository or remove certain performance extents from it, perform service actions or remove the scale-out backup repository.

Editing Settings of Scale-Out Backup Repositories

You can edit settings of the scale-out backup repository, for example, if you want to change the backup file placement policy or specify other advanced settings for the backup repository.

Mind the following:

- If you enable or disable the **Use per-VM backup file** option, Veeam Backup & Replication will apply new settings after a new full backup file is created.
If you enable or disable the **Perform full backup when required extent is offline** option, Veeam Backup & Replication will apply the new settings starting from the next session of the job targeted at this scale-out backup repository.

If you change the backup file placement policy settings, Veeam Backup & Replication will apply the new settings starting from the next session of the job targeted at this scale-out backup repository.

To change the scale-out backup repository settings:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, click **Scale-out Repositories**.
3. In the working area, select the scale-out repository and click **Edit Scale-out Repository** on the ribbon or right-click the scale-out backup repository and select **Properties**.
4. Follow the steps of the **Edit Scale-out Backup Repository** wizard and edit settings as required.

**Rescanning Scale-Out Repositories**

Veeam Backup & Replication periodically rescans scale-out backup repositories. During the rescan process, it gets the following information:

- State of every performance extent added to the scale-out backup repository: online or offline.
- Status of Veeam Data Movers on extents: up-to-date or outdated.
- Space available in the scale-out backup repository.

The rescan operation is performed automatically by a rescan process that works permanently in the background. The process is started every 24 hours. It can be also started when a new task session starts, and the Veeam Backup Service requires information about the infrastructure to be refreshed.
In addition to the automated rescan process, you can manually start rescan of the scale-out backup repository. Backup repository rescan may be helpful, for example, if you want to discover backup files that were manually relocated from one performance extent to another one.

Consider the following:

- Information about backup files location is updated only if you perform manual rescan of scale-out backup repositories.
- Veeam Backup & Replication rescans scale-out backup repositories when you perform backup files import.
- To successfully rediscover relocated backups files created by backup copy jobs, make sure to disable these jobs manually prior to rescanning.
  
  For more information, see Disabling and Removing Jobs.

To start the rescan process:

1. Open the Backup Infrastructure view.
2. In the inventory pane select Scale-out Repositories.
3. In the working area, select the scale-out repository and click Rescan Repository on the ribbon or right-click the scale-out backup repository and select Rescan repository.

Discovering Backups in Scale-Out Backup Repositories

To discover on which performance extent of the scale-out backup repository a particular backup file is stored, you can examine the job session statistics or check the backup properties.

To view the job session statistics:

1. Open the Home view.
2. In the inventory pane, click **Backup** under **Jobs**.

3. In the working area, right-click the job and select **Statistics**.

4. In the bottom left pane of the window, click the VM name. In the **Action** pane, locate the message: *Using N scale-out repository extent.*

To view the backup properties:

1. Open the **Home** view.

2. In the inventory pane, select **Disk** under **Backups**.

3. In the working area, right-click the backup and select **Properties**.
4. Veeam Backup & Replication will display the extent where the backup file resides in the headline of the **Backup Properties** window. To see the path to the backup file, right-click the job and select **Copy path**.

### Backup Properties Table

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Size</th>
<th>Backup Size</th>
<th>Dedup Compression</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>127.08</td>
<td>12.70</td>
<td>65%</td>
<td>12/12/2010 12:05PM</td>
</tr>
</tbody>
</table>

### Backup Objects Table

<table>
<thead>
<tr>
<th>Name</th>
<th>Original Size</th>
<th>Date</th>
<th>Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>alpha</td>
<td>122.08</td>
<td>12/12/10 12:05 PM</td>
<td>Full</td>
<td>OK</td>
</tr>
</tbody>
</table>

### Backup State Indicators

These user interface icons indicate the states of the restore points in the scale-out backup repository.

<table>
<thead>
<tr>
<th>Icon</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Full" /></td>
<td>Full restore point; on performance tier only</td>
</tr>
<tr>
<td><img src="image" alt="Full" /></td>
<td>Full restore point; on performance tier and offloaded to capacity tier</td>
</tr>
<tr>
<td><img src="image" alt="Full" /></td>
<td>Full restore point; on capacity tier only</td>
</tr>
<tr>
<td><img src="image" alt="Full" /></td>
<td>Full restore point; on capacity tier and partially downloaded to performance tier</td>
</tr>
<tr>
<td><img src="image" alt="Full" /></td>
<td>(This can happen when download to the performance tier fails)</td>
</tr>
<tr>
<td><img src="image" alt="Incremental" /></td>
<td>Incremental restore point; on performance tier only</td>
</tr>
<tr>
<td><img src="image" alt="Incremental" /></td>
<td>Incremental restore point; on performance tier and offloaded to capacity tier</td>
</tr>
<tr>
<td><img src="image" alt="Incremental" /></td>
<td>Incremental restore point; on capacity tier only</td>
</tr>
<tr>
<td>Icon</td>
<td>State</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| ![Icon](image1.png) | Incremental restore point; on capacity tier and partially downloaded to performance tier  
*(This can happen when download to the performance tier fails)* |
| ![Icon](image2.png) | Rollback restore point; on performance tier only |
| ![Icon](image3.png) | Rollback restore point; on performance tier and offloaded to capacity tier |
| ![Icon](image4.png) | Rollback restore point; on capacity tier only |
| ![Icon](image5.png) | Rollback restore point; on capacity tier and partially downloaded to performance tier  
*(This can happen when download to the performance tier fails)* |

### Extending Scale-Out Repositories

You can add a backup repository as a performance extent to the scale-out backup repository at any time. For example, the scale-out backup repository may run low on space, and you will need to add storage capacity to it.

To add a backup repository as an extent to the scale-out backup repository:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, click **Scale-out Repositories**.
3. In the working area, select the scale-out repository and click **Edit Scale-out Repository** on the ribbon or right-click the backup repository and select **Properties**.
4. Move to the **Performance tier** step of the wizard.
5. Click **Add**.
6. In the **Extents** window, select a check box next to the backup repository that you want to add as a performance extent to the scale-out backup repository.

   If a backup repository that you add as a performance extent is already used by jobs of supported type or there are backups pointing at the backup repository (for example, independent backups created with VeeamZIP), Veeam Backup & Replication will offer you to update a link to the backup repository in the job properties. Click **Yes** to update the link and target the jobs and backups at the scale-out backup repository. If you click **No**, you will not be able to pass to the next steps of the wizard.

7. Pass through the next wizard steps and finish working with the wizard. The new performance extent will be added to the scale-out backup repository.
NOTE:
After you add a backup repository to the scale-out backup repository as a performance extent, you will not be able to use it as an individual backup repository.

Service Actions with Scale-Out Backup Repositories

In some cases, you may want to perform service actions with extents of the scale-out backup repository. For example, you need to upgrade the backup repository server and add more memory to it. Or you want to replace a storage device backing the extent and need to relocate backup files.

You can perform service actions with extents of scale-out backup repositories:

- **Switching to Maintenance Mode**
- **Evacuating Backups from Extents**

Switching to Maintenance Mode

Maintenance Mode

Veeam Backup & Replication allows you to put any of the performance extents of your scale-out backup repository into *Maintenance* mode. You can use this mode if you need to perform service actions, such as upgrading a performance extent or installing a patch on it. Putting a performance extent into maintenance mode is mandatory to evacuate backups, as described in *Evacuating Backups from Extents*.

An extent in the Maintenance mode operates with the limited functionality:

- Veeam Backup & Replication does not start new tasks targeted at this performance extent.
• You cannot restore VM data from backup files residing on the performance extent. You also cannot restore VM data from backup files residing on other performance extents if a part of the backup chain resides on the extent in the Maintenance mode.

When you switch the Maintenance mode, Veeam Backup & Replication launches the Repository Maintenance job. The Repository Maintenance job checks the status of jobs and tasks targeted at the extent and puts the extent to one of the following modes:

• If no tasks using the performance extent are currently running, the job puts the extent to the Maintenance mode immediately.

• If the performance extent is busy with any task, for example, a backup job, the job puts the extent to the Maintenance pending state and waits for the task to complete. When the task is complete, the extent is put to the Maintenance mode.

To put a performance extent into maintenance mode:
1. Open the Backup Infrastructure view.
2. In the inventory pane, select the scale-out backup repository under Scale-out Repositories.
3. In the working area, select the extent and click Maintenance Mode on the ribbon or right-click the extent and select Maintenance mode.

To exit maintenance mode, select the extent and click Maintenance Mode on the ribbon or right-click it and select Maintenance mode once again.

Evacuating Backups from Performance Extents

If you want to remove a performance extent from the scale-out backup repository, you first need to evacuate backups from this extent. When you evacuate backups, Veeam Backup & Replication moves backup files from the performance extent in question to other performance extents that belong to the same scale-out backup repository.
You must put the performance extent to the Maintenance mode before you evacuate backups from it. For more information, see Switching to Maintenance Mode.

To evacuate backup files from a performance extent:

1. [Recommended] Stop and disable jobs targeted at the performance extent from which you plan to evacuate backups.
2. Open the Backup Infrastructure view.
3. In the inventory pane, select the scale-out backup repository under Scale-out Repositories.
4. In the working area, select the performance extent and click Evacuate Backups on the ribbon or right-click the extent and select Evacuate backups.
5. If you have disabled jobs, enable them.

When selecting the target performance extent for evacuated files, Veeam Backup & Replication attempts to keep to the backup placement settings specified for remaining extents. For example, you have 3 performance extents in the scale-out backup repository with the following backup file placement settings:

- On Extent 1, full backup files are stored.
- On Performance Extents 2 and 3, incremental backup files are stored.

If you evacuate backup files from Performance Extent 2, Veeam Backup & Replication will relocate them to Performance Extent 3.

After you evacuate backups, you can proceed to removing the performance extent from the scale-out backup repository. For more information, see Removing Performance Extents from Scale-Out Repositories.
Switching to Seal Mode

Veeam Backup & Replication allows you to put any of the performance extents of your scale-out backup repository into Seal mode.

Sealing up performance extents gives you the ability to gradually remove data located on these extents by applying a retention policy. You can use this feature to gracefully stop using some of your performance extents and exclude them from the scale-out backup repository configuration.

When sealing up a performance extent, Veeam Backup & Replication restricts any further data saving to such a sealed extent and allows only read operations such as restore, merge and remove.

All backup jobs that are targeted to a scale-out backup repository with the sealed performance extents that store active backup chains will be forced to create a new active full backup on the next run. The new active full will be saved to another available performance extent in the scale-out backup repository scope, thereby forming a new active backup chain. The extent to which the new active full is going to be saved is chosen automatically by Veeam Backup & Replication, depending on the available resources.

All restore points that exceed the specified retention period will be continuously removed from the sealed performance extents on each subsequent backup session.

Consider the following:

- A performance extent can be put into both the maintenance and seal modes at the same time.
  
  When both modes are applied, maintenance mode overrides seal mode.

- When putting a performance extent into seal mode, you will still be able to restore, merge and remove data without exiting this mode.

To put a performance extent into seal mode:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the scale-out backup repository under the **Scale-out Repositories node**.
3. In the working area, select a performance extent and click **Seal Mode** on the ribbon or right-click an extent and select **Seal mode**.

### Receiving Scale-Out Backup Repository Reports

Veeam Backup & Replication is capable of sending reports that contain information about processing results of your scale-out backup repositories data.

Consider the following:

- Reports are sent only after you have enabled and configured email notifications, as described in [Configuring Global Email Notification Settings](Configuration/Global/Email_Notify).

- Reports are sent daily at time specified in global notification settings.

- Reports are sent for all notification types selected in global notification settings, such as **Success**, **Warning** and **Failure**.

- The title of a report is built up of "**Scale-out Backup Repository**" + a repository name. That said, if your scale-out backup repository name is Amazon, then the report title would be **Scale-out Backup Repository Amazon**.

Each report is divided into sections and contains the following information:

- **Performance Tier** (upper-left) section:
  - **Used Space**. Shows the used disk space of your scale-out backup repository.
  - **Capacity**. Shows the total storage capacity of your scale-out backup repository.

- **Capacity Tier** (upper-right) section:
  - **Used Space**. Shows the occupied storage space in your object storage repository.
- **Space Limit.** Shows the space limit (if any). A space limit is specified when adding a new object storage repository, as described in *Adding Object Storage Repositories*.

- **Performance Tier** (middle) section:
  - **Extent.** Shows extents of a scale-out backup repository.
  - **Capacity.** Shows the total storage capacities of your performance extents.
  - **Used Space.** Shows the amount of disk space used on your extents.
  - **Status.** Shows the status of each extent, as described in *Description of Report Statuses*.

- **Capacity Tier** (lower) section:
  - **Extent.** Shows the name of the capacity extent.
  - **Space Limit.** Shows the space limit (if any).
  - **Used Space.** Shows the occupied storage space in your capacity extent.
  - **Status.** Shows the status of the capacity extent, as described in *Description of Report Statuses*.

  If an automatic offload job session exits with any status other than *Success*, you will see the associated status message in this field. For more information about the offload job, see *Moving Inactive Backup Chains to Object Storage*.

### Description of Report Statuses

The following table lists possible combinations of *Warning* and *Error* messages shown under the **Status** column of a report.

If none of the conditions listed in the **Extent state** column is true, then the report status will be shown as *Success*.

<table>
<thead>
<tr>
<th>Extent type</th>
<th>Extent state</th>
<th>Status message</th>
<th>Report type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performance tier</strong></td>
<td>Maintenance mode</td>
<td>Maintenance mode</td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>Threshold limit exceeded. Threshold is specified in the <strong>Backup storage</strong> section, as described in <em>Specifying Other Notification Settings</em>.</td>
<td>Reaching capacity</td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>Unavailable</td>
<td>Offline</td>
<td>Error</td>
</tr>
<tr>
<td><strong>Capacity tier</strong></td>
<td>Maintenance mode</td>
<td>Maintenance mode</td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>Space limit exceeded. Space limit is specified when adding a new object storage repository, as described in <em>Adding Object Storage Repositories</em>.</td>
<td>Out of capacity</td>
<td>Error</td>
</tr>
<tr>
<td>Extent type</td>
<td>Extent state</td>
<td>Status message</td>
<td>Report type</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Unavailable</td>
<td>Offline</td>
<td>Error</td>
</tr>
<tr>
<td></td>
<td>Threshold limit exceeded. Threshold is specified in the Backup storage section, as described in Specifying Other Notification Settings.</td>
<td>Reaching capacity</td>
<td>Warning</td>
</tr>
</tbody>
</table>

**Report Examples**

**Success Reports**

The following figure shows an example of a report consisting of two performance extents (*Backup Volume 01* and *Backup Volume 02*); both share 253.3 GB of storage capacity, of which 52.4 GB is occupied.

Both extents have OK status, which means that neither extent was put into maintenance mode, nor has any of these performance extents exceeded the allowed threshold limit.

This report also includes the Capacity Tier section consisting of a capacity extent with no Space Limit applied. This capacity extent stores 29.6 GB of data and has the OK status.

**Warning Reports**

The figure below demonstrates a report with the Warning status.
As per example, the *Backup Volume 01* performance extent has been put into maintenance mode, and the *Backup Volume 02* performance extent has exceeded the allowed threshold both of which have caused a report to be generated with the *Warning* status.

### Error Reports

In the figure below a report has been generated with the *Error* status caused by the *Amazon S3 Object Storage* performance extent which has exceeded its allowed space limit.
Removing Performance Extents from Scale-Out Repositories

You can remove a performance extent from the scale-out backup repository, for example, if you do not want to store backup files on the underlying storage anymore. When you remove a performance extent, Veeam Backup & Replication puts the relevant backup repository to the Maintenance mode and unassigns the performance extent role from it. The backup repository ceases to exist as a part of the scale-out backup repository and becomes an individual backup repository.

If the performance extent contains backup files, it is strongly recommended that you perform the following actions before you remove the extent:

1. Put the performance extent to the Maintenance Mode.
2. Evacuate backups from the extent. For more information, see Evacuating Backups from Performance Extents.

In this case, backup files will be moved to other performance extents of the scale-out backup repository, and the backup chain will remain consistent. If you do not evacuate backups from the performance extent, the backup chain may get broken as some restore points will be missing from it.

To remove a performance extent from the scale-out backup repository:

1. Open the Backup Infrastructure view.
2. In the inventory pane, click Scale-out Repositories.
3. In the working area, select the scale-out backup repository and click Edit Scale-out Repository on the ribbon or right-click the scale-out backup repository and select Properties.
4. Move to the Performance tier step of the wizard.
5. In the Extents list, select the performance extent and click Remove.

If the performance extent contains backup files, Veeam Backup & Replication will suggest evacuating them. To evacuate files, click No, close the wizard and evacuate backup files. For more information, see Evacuating Backups from Performance Extents.
If you do not want to evacuate the backup files, click **Yes** and proceed with the wizard.

![Edit Scale-out Backup Repository](image)

**Removing Scale-Out Backup Repositories**

You can remove the scale-out backup repository at any time. When you remove the scale-out backup repository, Veeam Backup & Replication unassigns the performance extent role from all the backup repositories configured into it, and they become individual backup repositories. Backup files are not removed from backup repositories – they remain on the disk.

You cannot remove a scale-out backup repository at which at least one job is currently targeted. First, you need to target jobs to another backup repository in the backup infrastructure.

To remove a scale-out backup repository:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, click **Scale-out Repositories**.
3. In the working area, select the scale-out repository and click **Remove Repository** on the ribbon or right-click the backup repository and select **Remove**.
Guest Interaction Proxy

The guest interaction proxy is a backup infrastructure component that sits between the backup server and processed VM. This component is needed if the backup or replication jobs perform the following processing of VMs:

- Application-aware processing
- Guest file system indexing
- Transaction logs processing

To interact with the VM guest OS, Veeam Backup & Replication needs to deploy a runtime process in each VM. The task of deploying the runtime process in a VM is performed by the guest interaction proxy.

The guest interaction proxy allows you to communicate with the VM guest OS even if the backup server and processed VM run in different networks.

**IMPORTANT!**

The guest interaction proxy deploys the runtime process only in Microsoft Windows VMs. In VMs with another guest OS, the runtime process is deployed by the backup server.

**Guest Interaction Proxy Deployment**

You can use multiple guest interaction proxies to improve performance. Multiple guest interaction proxies will deploy runtime processes in VMs faster compared to the same operation performed by one guest interaction proxy.

In a backup infrastructure with multiple remote sites, you can deploy a guest interaction proxy in each site. This can reduce load on the backup server and produce less traffic between the backup server and remote site.

**Requirements for Guest Interaction Proxy**

The guest interaction proxy functionality is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.

A machine performing the role of a guest interaction proxy must meet the following requirements:

- The role of a guest interaction proxy can be assigned to a Microsoft Windows server (physical or virtual).
- You must add the machine to the Veeam Backup & Replication console as a managed server.
- Guest interaction proxy must have a LAN connection to the VM that will be backed up or replicated.
If you plan to use PowerShell Direct connection to back up VMs that reside on Hyper-V Server 2016 or later and run Microsoft Windows 10 or Microsoft Windows Server 2016 or later, the guest interaction proxy must have Microsoft PowerShell 2.0 or later installed.

The guest interaction proxy role can be performed by any machine that meets the requirements, including backup proxy, backup repository, WAN accelerator, Microsoft Hyper-V host or backup server.

Guest Interaction Proxy Selection

When you add a Microsoft Windows machine to the backup infrastructure, Veeam Backup & Replication deploys the Data Mover Service on it. The Data Mover Service includes the components responsible for runtime process deployment during guest OS interaction.

To assign a guest interaction proxy for the job, you must select a Microsoft Windows machine that will perform the role of the guest interaction proxy at the Guest Processing step of the backup or replication job wizard. You can assign the guest interaction proxy manually, or let Veeam Backup & Replication do it automatically.

Veeam Backup & Replication uses the following priority rules to select the guest interaction proxy:

1. A machine in the same network as the protected VM that does not perform the backup server role.
2. A machine in the same network as the protected VM that performs the backup server role.
3. A machine in another network that does not perform the backup server role.
4. A machine in another network that performs the backup server role.

If Veeam Backup & Replication finds several available machines of equal priority, it selects the less loaded machine. The load is defined by the number of tasks that the machine already performs.
Failover from Guest Interaction Proxy to Backup Server

If the guest interaction proxy fails to connect to a Microsoft Windows VM, the guest interaction proxy will not be able to access the VM and deploy a runtime process in it. In this case, the backup server will take over the role of guest interaction proxy and deploy the runtime process in the VM.
Gateway Server

A gateway server is an auxiliary backup infrastructure component that “bridges” the backup server and backup repository. The gateway server is required if you deploy the following types of backup repositories in the backup infrastructure:

- Shared folder backup repositories
- Dell EMC Data Domain deduplicating storage appliance
- HPE StoreOnce deduplicating storage appliance

Such backup repositories cannot host Data Mover Services — Veeam components that establish a connection between a backup proxy and backup repository (in case of backup jobs) or between backup repositories (in case of backup copy jobs). To overcome this limitation, Veeam Backup & Replication uses gateway servers.

In the backup infrastructure, a gateway server hosts the target Veeam Data Mover. Veeam Backup & Replication establishes a connection between the source Veeam Data Mover and target Veeam Data Mover, and transports data from/to backup repositories via gateway servers.

Gateway Servers Deployment

The role of a gateway server can be assigned to a Microsoft Windows machine added to the backup infrastructure. To configure a gateway server, you must first add a machine that you plan to use as a gateway server to the backup infrastructure using the **New Windows Server wizard**. After that, you must go through the **Add New Backup Repository** wizard and define gateway server settings. You can select a gateway server explicitly or instruct Veeam Backup & Replication to select it automatically.

If you select a gateway server explicitly, Veeam Backup & Replication uses the selected machine as a gateway server and performs synthetic operations on it. The machine to which you assign the role of a gateway server must be located as close to the backup repository as possible. However, if you use a deduplicating storage appliance with source-side data deduplication, it is reasonable to assign the role of a gateway server to a machine that is located closer to the backup proxy. This will help you reduce the amount of traffic traveling over the network. For more information, see **Dell EMC Data Domain** and **HPE StoreOnce**.
If you instruct Veeam Backup & Replication to select the gateway server automatically, Veeam Backup & Replication uses the following backup infrastructure components:

<table>
<thead>
<tr>
<th>Type of job</th>
<th>Component used as gateway server</th>
<th>Component used as gateway server for synthetic operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup job</td>
<td>Backup proxy (onhost or offhost)</td>
<td>Synthetic operations are performed on the mount server associated with the backup repository. If the mount server is not accessible, Veeam Backup &amp; Replication fails over to the backup server.</td>
</tr>
</tbody>
</table>
| Backup copy job           | • Direct data path: mount server associated with the backup repository. If the mount server is not accessible, Veeam Backup & Replication fails over to the backup server.  
• Over WAN accelerators: source and/or target WAN accelerator (depending on the shared folder backup repository location). | Synthetic operations are performed on the mount server associated with the backup repository. If the mount server is not accessible, Veeam Backup & Replication fails over to the backup server. These rules are applied to the direct data path and processing over WAN accelerators. |
| Tape job                  | If there is a direct connection between a backup repository and tape device, the role of a gateway server is assigned to the tape server. Otherwise, the role of a gateway server is assigned to the backup server. | Synthetic operations are performed on the mount server associated with the backup repository. If the mount server is not accessible, Veeam Backup & Replication fails over to the backup server. |
| Veeam Agent backup job    | Backup server                    | Synthetic operations are performed on the backup server. |
| Restore operations        | Backup proxy used for a restore operation* | — |
| Replication from backup   | Target backup proxy assigned for a replication operation* | — |

When you enable automatic gateway selection, Veeam Backup & Replication may use one or several gateway servers to process VMs in backup jobs. The number of gateway servers depends on the backup repository settings:

- If the **Use per-VM backup files** option is disabled, Veeam Backup & Replication selects one gateway server for the whole backup repository.
- If the **Use per-VM backup files** option is enabled, Veeam Backup & Replication selects a gateway server per every VM in the job.
For example, a backup job processes 2 VMs. The job is targeted at a backup repository for which the **Use per-VM backup files** option is enabled. In this case, Veeam Backup & Replication will detect which backup proxies were used to process VMs in the job. If VMs were processed with 2 different backup proxies, Veeam Backup & Replication will assign the role of gateway servers to these backup proxies. If VMs were processed with the same backup proxy, Veeam Backup & Replication will assign the role of a gateway server to this backup proxy, and will use it for both VMs in the job.

For scale-out backup repositories, Veeam Backup & Replication uses one gateway server per every extent. The rules of gateway server selection are described above.

### Requirements for Gateway Servers

A machine that performs the role of a gateway server must meet the following requirements:

- The machine must meet the system requirements. For more information, see [System Requirements](#).
- The gateway server can run on a physical or virtual machine.
- The gateway server can run on a Microsoft Windows machine or Microsoft Hyper-V host.
- You must add the machine to the Veeam Backup & Replication console as a managed server.
- The machine must have access to the backup repository — shared folder, Dell EMC Data Domain or HPE StoreOnce.

### Limitations for Gateway Servers

The following limitations apply to a machine that performs the role of a gateway server:

- For deduplicating storage appliances working over Fibre Channel, you must explicitly select a gateway server that will communicate with the appliance. As a gateway server, you must use a Microsoft Windows machine that is added to the backup infrastructure and has access to the appliance over Fibre Channel.
- For HPE StoreOnce deduplicating storage appliances, you must assign the role of a gateway server to a 64-bit machine.

### Related Topics

- [Backup Repository](#)
- [Scale-Out Backup Repository](#)
- [Dell EMC Data Domain](#)
- [HPE StoreOnce](#)
- [Specifying Server or Shared Folder Settings](#)
Mount Server

The mount server is required if you restore VM guest OS files and application items to the original location or perform secure restore. The mount server lets you route VM traffic by an optimal way, reduce load on the network and speed up the restore process.

When you perform file-level, application item or secure restore, Veeam Backup & Replication needs to mount the content of the backup file to a staging server (or the original VM for restore to the Microsoft SQL Server and Oracle VMs). Once the VM backup is mounted, Veeam Backup & Replication copies files or items to their destination via this mount server or VM. For more information about possible mount points, see File-Level Restore Scenarios.

The staging server must be located in the same site as the backup repository where backup files are stored. In this case, you will be able to keep the VM traffic in one site. If the staging server is located in some other site, the data will need to travel across the network between the sites.

Mount Server Deployment

The mount server is created for every backup repository and is associated with it. When you configure a backup repository, you define which server you want to use as a mount server for this backup repository. By default, Veeam Backup & Replication assigns the mount server role to the following machines:

- **Backup repository.** For Microsoft Windows backup repositories, the mount server role is assigned to the backup repository server itself.

- **Veeam backup server.** For Linux, shared folder backup repositories and deduplicating storage appliances, the mount server role is assigned to the Veeam backup server.

- **Veeam Backup & Replication console.** The mount server role is also assigned to a machine on which the Veeam Backup & Replication console is installed. Note that this type of mount server is not registered in the Veeam Backup & Replication configuration database.

For scale-out backup repositories, you must define the mount server for every extent.

If you do not want to use default mount servers, you can assign the mount server role to any 64-bit Microsoft Windows machine in the backup infrastructure. It is recommended that you configure at least one mount server in each site and associate this mount server with the backup repository residing in this site. The mount server and backup repository must be located as close to each other as possible.
NOTE:
For cloud repositories and hosts that store replicas or backups from storage snapshots, the mount server role is assigned to the Veeam backup server. For such repositories, you cannot assign the mount server role to a different machine.

Mount Servers Services and Components
On the mount server machine, Veeam Backup & Replication installs the Veeam Mount Service. The Veeam Mount Service requires Microsoft .NET Framework 4.7.2. If Microsoft .NET Framework 4.7.2 is not installed on the machine, Veeam Backup & Replication will install it automatically.

Requirements for Mount Servers
A machine that performs the role of a mount server must meet the following requirements:

- You can assign the role of a mount server to a Microsoft Windows machine.
- You can assign the role of a mount server to a 64-bit machine.
- The mount server must have access to the backup repository with which it is associated and to the original VM (VM to which you restore files or application items).
WAN Accelerators

WAN accelerators are dedicated components that Veeam Backup & Replication uses for WAN acceleration. WAN accelerators are responsible for global data caching and data deduplication. For more information, see WAN Acceleration.
Log Shipping Servers

Log shipping servers are dedicated components that Veeam Backup & Replication uses for backup of Microsoft SQL Server transaction logs and Oracle archive logs. For more information, see Microsoft SQL Server Logs Backup and Oracle Logs Backup.
Tape Servers

Tape servers are dedicated components responsible for transferring data between data source and tape device. For more information, see the Tape Devices Support Guide.
NDMP Servers

If your NAS device supports the NDMP protocol, you can back up data from it to tape. To do this, you need to add the NAS device as an NDMP server. For more information, see the Tape Devices Support Guide.
Veeam Backup Enterprise Manager

Veeam Backup Enterprise Manager is an optional component intended for distributed enterprise environments with multiple backup servers. Veeam Backup Enterprise Manager federates backup servers and offers a consolidated view of these servers through a web browser interface. You can centrally control and manage all jobs through a single “pane of glass”, edit and clone jobs, monitor job state and get reporting data across all backup servers. Veeam Backup Enterprise Manager also enables you to search for VM guest OS files in all current and archived backups across your backup infrastructure, and restore these files in one click.

Veeam Backup Enterprise Manager Deployment

Veeam Backup Enterprise Manager can be installed on a physical or virtual machine. You can deploy it on the backup server or use a dedicated machine.

Veeam Backup Enterprise Manager Services and Components

Veeam Backup Enterprise Manager uses the following services and components:

- **Veeam Backup Enterprise Manager Service** coordinates all operations of Veeam Backup Enterprise Manager, aggregates data from multiple backup servers and provides control over these servers.

- **Veeam Backup Enterprise Manager Configuration Database** is used by Veeam Backup Enterprise Manager for storing data. The database instance can be located on a SQL Server installed either locally (on the same machine as Veeam Backup Enterprise Manager Server) or remotely.

- **Veeam Guest Catalog Service** replicates and consolidates VM guest OS file system indexing data from backup servers added to Veeam Backup Enterprise Manager. Index data is stored in Veeam Backup Enterprise Manager Catalog (a folder on the Veeam Backup Enterprise Manager Server) and is used to search for VM guest OS files in backups created by Veeam Backup & Replication.
Deployment Scenarios

Veeam Backup & Replication can be used in virtual environments of any size and complexity. The architecture of the solution supports onsite and offsite data protection, operations across remote sites and geographically dispersed locations. Veeam Backup & Replication provides flexible scalability and easily adapts to the needs of your virtual environment.

Before you install Veeam Backup & Replication, familiarize yourself with common deployment scenarios and carefully plan your backup infrastructure layout.
Simple Deployment

The simple deployment scenario is good for small virtual environments or the purpose of the Veeam Backup & Replication evaluation. In this scenario, Veeam Backup & Replication is installed on a single Windows-based machine.

**IMPORTANT!**

It is not recommended to install Veeam Backup & Replication directly on the Hyper-V host. Instead, install it on a VM on this host.

The machine where Veeam Backup & Replication is installed performs the following roles:

- Backup server that coordinates all jobs, controls their scheduling and performs other administrative activities.
- Default backup repository where backup files are stored. During installation, Veeam Backup & Replication checks volumes of the machine on which you install the product and identifies a volume with the greatest amount of free disk space. On this volume, Veeam Backup & Replication creates the Backup folder that is used as the default backup repository.
- Mount server that is needed for restoring of VM guest OS files.
- Guest interaction proxy that is needed for application-aware processing, guest file system indexing and transaction log processing.

The role of the default backup proxy is assigned to the source Hyper-V server. It handles job processing and transfers backup traffic directly to the target server. All services necessary for the backup proxy are installed directly on the source Hyper-V server.

Veeam Backup & Replication is ready for use right after the installation. The only thing you must do is add Microsoft Hyper-V servers that you plan to use as source and target for backup, replication and other activities. For details, see Adding Microsoft Hyper-V Servers.

In Hyper-V environments that require a large number of backup or replication activities to be performed, the simple deployment scheme is not appropriate due to the following reasons:

- The backup server might not have enough disk capacity to store the required amount of backup data.
- A significant load is placed on production servers that combine the roles of backup proxies and source hosts.

To take the overhead off the backup server and source Hyper-V servers, you can use the advanced deployment scenario. For details, see Advanced Deployment.
Advanced Deployment

For mid-size and large-scale Hyper-V environments with a great number of backup and replication jobs, the advanced deployment scenario can be a good choice.

The advanced deployment includes the following components:

- Virtual infrastructure servers — Hyper-V hosts used as source and target for backup and replication.
- Backup server — a configuration and control center of the backup infrastructure.
- Off-host backup proxy — a “data mover” component used to retrieve VM data from the source datastore, process it and deliver to the target.
- Backup repository — a location used to store backup files and auxiliary replica files.
- Dedicated mount servers — component required for VM guest OS files and application items restore to the original location.
- Dedicated guest interaction proxies — components used to deploy the runtime process in Microsoft Windows VMs.

In the advanced deployment scenario, data processing is shifted from the Hyper-V server to an off-host backup proxy — a dedicated machine that is deployed on the source side, closer to the source Hyper-V host. The off-host backup proxy functions as a “data mover”, processing VM data and mediating the backup traffic from source to target. Therefore, the job processing overhead and data transport is offloaded from the source Hyper-V host.

In the advanced deployment scenario, backup data is no longer stored to the backup repository on the backup server. Instead, data is transported to dedicated backup repositories. The backup server becomes a “manager” for off-host backup proxies and backup repositories.

With the advanced deployment scenario, you can expand your backup infrastructure horizontally in a matter of minutes to meet your data protection requirements. Instead of growing the number of backup servers or constantly tuning job scheduling, you can install multiple backup infrastructure components and distribute the backup workload among them. The installation process is fully automated, which simplifies deployment and maintenance of the backup infrastructure in your virtual environment.
In virtual environments with several proxies, Veeam Backup & Replication dynamically distributes the backup traffic among these proxies. A job can be explicitly mapped to a specific proxy. Alternatively, you can let Veeam Backup & Replication choose an off-host backup proxy. In this case, Veeam Backup & Replication will check settings of available backup proxies and select the most appropriate one for the job. The backup proxy should have access to the source and target hosts, and to backup repositories to which files will be written.

To regulate the backup load, you can specify the maximum number of concurrent tasks per backup proxy and set up throttling rules to limit the proxy bandwidth. For a backup repository, you can set the maximum number of concurrent tasks and define a combined data rate.
Distributed Deployment

The distributed deployment scenario is recommended for large geographically dispersed virtual environments with multiple backup servers installed across different sites. These backup servers are federated under Veeam Backup Enterprise Manager — an optional component that provides centralized management and reporting for these servers through a web interface.

Veeam Backup Enterprise Manager collects data from backup servers and enables you to run backup and replication jobs across the entire backup infrastructure through a single "pane of glass", edit them and clone jobs using a single job as a template. It also provides reporting data for various areas (for example, all jobs performed within the last 24 hours or 7 days, all VMs engaged in these jobs and so on). Using indexing data consolidated on one server, Veeam Backup Enterprise Manager provides advanced capabilities to search for VM guest OS files in VM backups created on all backup servers (even if they are stored in backup repositories on different sites), and recover them in a single click. Search for VM guest OS files is enabled through Veeam Backup Enterprise Manager itself.

With flexible delegation options and security roles, IT administrators can delegate the necessary file restore or VM restore rights to authorized personnel in the organization – for example, allow database administrators to restore Oracle or SQL server VMs.

If you use Veeam Backup Enterprise Manager in your backup infrastructure, you do not need to install licenses on every backup server you deploy. Instead, you can install one license on the Veeam Backup Enterprise Manager server and it will be applied to all servers across your backup infrastructure. This approach simplifies tracking license usage and license updates across multiple backup servers.
Resource Scheduling

Veeam Backup & Replication has the built-in mechanism of resource scheduling. Resource scheduling lets Veeam Backup & Replication automatically define what backup infrastructure resources are required for data protection and disaster recovery jobs and tasks, select optimal resources and assign them for the jobs and tasks.

Resource scheduling is performed by the Veeam Backup Service running on the backup server. When a job or task starts, it communicates with the service and informs it about the resources it needs. The service analyzes job settings, parameters specified for backup infrastructure components, current load on the components, and automatically allocates optimal resources to the job.

For resource scheduling, Veeam Backup Service uses the following settings and features:

- Limitation of Concurrent Tasks
- Limitation of Read and Write Data Rates for Backup Repositories
- Network Traffic Management
- Performance Bottlenecks
Limitation of Concurrent Tasks

When you start a data protection or disaster recovery job, Veeam Backup & Replication analyzes the list of VMs added to the job, and creates a separate task for every disk of every VM to be processed. Veeam Backup & Replication then defines what backup infrastructure components must be used for the job, checks what backup infrastructure components are currently available, and assigns necessary components to process the created job tasks.

Backup infrastructure components typically process several tasks at the same time. You can limit the number of tasks that backup infrastructure components must process concurrently. Task limitations helps you balance the workload across the backup infrastructure and avoid performance bottlenecks.

Veeam Backup & Replication lets you limit the number of concurrent tasks for the following backup infrastructure components:

- **Backup proxies**
- **Backup repositories**

**NOTE:**

Task limits set for backup infrastructure components influence the job performance. For example, you add a VM with 4 disks to a job and assign a backup proxy that can process maximum 2 tasks concurrently for the job. In this case, Veeam Backup & Replication will create 4 tasks (1 task per each VM disk) and start processing 2 tasks in parallel. The other 2 tasks will be pending.

How Task Limitation Works

Task limiting is performed by the Veeam Backup Service. The Veeam Backup Service is aware of all backup proxies and backup repositories in the backup infrastructure, and task limitation settings configured for them.

When a job starts, it informs the Veeam Backup Service about the list of tasks created for the job, and backup infrastructure resources that must be used for the job. The Veeam Backup Service detects the number of tasks that required backup infrastructure components are currently processing, and analyzes the number of allowed tasks for these components. If the number of currently processed tasks has reached the allowed limit, the backup infrastructure component will not start processing a new task until one of the currently running tasks finishes.

Task Limitation for Backup Proxies

To limit the number of concurrent tasks on a backup proxy, you must define the **Max concurrent tasks** setting for the backup proxy. For onhost backup, you must define the **Task limit** setting for the source Microsoft Hyper-V host.
The maximum number of concurrent tasks depends on the number of CPU cores available on the backup proxy. It is strongly recommended that you define task limitation settings using the following rule: 1 task = 1 CPU core. For example, if a backup proxy has 4 CPU cores, it is recommended that you limit the number of concurrent tasks for this backup proxy to 4.

**Task Limitation for Backup Repositories**

To limit the number of concurrent tasks in a backup repository, you must enable the **Limit maximum concurrent tasks to <N>** option on the backup repository and define the necessary task limit.

The maximum number of concurrent tasks depends on the number of CPU cores available in the backup repository. It is strongly recommended that you define task limitation settings using the following rule: 1 task = 1 CPU core.

It is recommended to configure 2 GB RAM per core. In case of shared folder backup repositories, the same amount of resources is required for gateway servers.

Synthetic operations performed in the backup repository (such as synthetic full backup, backup files merge and transformation) are also regarded as tasks. The number of tasks performed during these operations depends on the type of backup chains stored on the backup repository:

- For regular backup chains, Veeam Backup & Replication creates 1 task per job.
- For per-VM backup chains, Veeam Backup & Replication creates 1 task per every VM chain (that is, every VM added to the job).

If you use backup repositories for backup copy jobs, you must also consider tasks for read operations.
NOTE:
When you limit the number of tasks for the backup repository, bear in mind the storage throughput. If the storage system is not able to keep up with the number of tasks that you have assigned, it will be the limiting factor. It is recommended that you test components and resources of the backup infrastructure to define the workload that they can handle.

Task Limitation for Components with Several Roles

One machine can perform several roles. For example, you can assign roles of the backup proxy and backup repository to the same machine, or use a backup proxy as a gateway server for a shared folder backup repository. In such situation, you must make sure that the backup infrastructure component is able to process the cumulative number of tasks specified for different roles.
Limitation of Read and Write Data Rates for Backup Repositories

Veeam Backup & Replication can limit the speed with which Veeam Backup & Replication must read and write data to/from the backup repository. The data read and write speed is controlled with the Limit read and write data rates to <N> MB/s option that you can enable in backup repository settings.

The Veeam Backup Service is aware of read and write data rate settings configured for all backup repositories in the backup infrastructure. When a job targeted at a backup repository starts, the Veeam Backup Service informs the Veeam Data Mover running on this backup repository about the allowed read/write speed set for this repository so that the Veeam Data Mover can limit the read/write speed to the specified value.

If the backup repository is used by a number of tasks simultaneously, Veeam Backup & Replication splits the allowed read/write speed rate between these tasks equally. Note that the specified limit defines the allowed read speed and the allowed write speed at the same time.

For example, you set the Limit read and write data rates to option to 8 MB/s and start two backup jobs. Each job processes 1 VM with 1 VM disk. In this case, Veeam Backup & Replication will create 2 tasks and target them at the backup repository. The data write rate will be split between these 2 tasks equally: 4 MB/s for one task and 4 MB/s for the other task.

If at this moment you start some job reading data from the same backup repository, for example, a backup copy job processing 1 VM with 1 disk, Veeam Backup & Replication will assign the read speed rate equal to 8 MB/s to this job. If you start 2 backup copy jobs at the same time (each processing 1 VM with 1 disk), Veeam Backup & Replication will split the read speed rate between these 2 jobs equally: 4 MB/s for one backup copy job and 4 MB/s for the other backup copy job.
Network Traffic Management

Data protection requires large amount of data to be transferred through networks. This may cause heavy network loads.

Veeam Backup & Replication offers the following capabilities to reduce the load:

- Configuring Network Traffic Rules
- Managing Upload Streams
- Specifying Preferred Networks

Configuring Network Traffic Rules

Network traffic rules control traffic transferred between backup infrastructure components. These rules allow you to do the following:

- Throttle network traffic
- Encrypt transferred data

The rules apply only to the backup infrastructure components, so you do not have to change your network infrastructure.

How Network Rules Work

Each network rule contains IP address ranges for source and target components. When a job starts, Veeam Backup & Replication checks the rules against the components involved in the job. If the IP addresses of the components fall into the IP address ranges of a rule, the rule applies.

For example, 192.168.0.1–192.168.0.255 is the source range, and 172.16.0.1–172.16.0.255 is the target range. 192.168.0.12 is the IP address of one component, and 172.16.0.31 is the IP address of another component. Both IP addresses fall into the ranges, so the rule will apply.

Note that the rules are reversible. The rule from the example will also apply to the specified components if you swap the ranges: make 192.168.0.1–192.168.0.255 the target range and 172.16.0.1–172.16.0.255 the source range.

TIP:
You can define a rule for specific components. For this, specify a single IP address in the source range and in the target range.

Creating Network Rules

You must create network rules at the backup server level. For details, see Enabling Traffic Throttling and Enabling Data Encryption.

Veeam Backup & Replication has a predefined rule for traffic transferred between public networks. For more information, see Adjusting Internet Rule.
TIP:
If you created a rule for an off-host backup proxy, you can check whether it applies. For this, open the Traffic Rules step of the backup proxy wizard. The rule must be in the list of rules.

Enabling Traffic Throttling

Traffic throttling setting in a network rule allows you to limit the impact of Veeam Backup & Replication tasks on network performance. Traffic throttling prevents jobs from utilizing the entire bandwidth available in your environment and makes sure that other network operations get enough traffic.

IMPORTANT!
Traffic throttling does not apply to restore tasks.

When several jobs that fall into the same network rule run simultaneously, Veeam Backup & Replication equally splits the throttled traffic between them. For example, if two jobs run at a time, each job gets half of the throttled traffic. Once one job finishes, the other gets the entire bandwidth allowed by the rule.

NOTE:
It is recommended that you throttle network traffic if you perform offsite backup or replicate VMs to a DR site over slow WAN links.
Infrastructure Components

Traffic can be throttled only between the backup infrastructure components on which Veeam Data Movers are deployed. These components differ depending on a data protection scenario. The following table shows this dependency.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup to a Microsoft Windows or Linux backup repository*</td>
<td>Backup proxy (onhost or offhost) and backup repository</td>
</tr>
<tr>
<td>Backup to an SMB share, Dell EMC Data Domain and HPE StoreOnce*</td>
<td>Backup proxy (onhost or offhost) and gateway server</td>
</tr>
<tr>
<td>Backup copy*</td>
<td>Source and target backup repositories, gateway servers or WAN accelerators (if they are involved in the backup copy process)</td>
</tr>
<tr>
<td>Replication</td>
<td>Source and target backup proxies (onhost or offhost) or WAN accelerators (if they are involved in the replication process)</td>
</tr>
<tr>
<td>Backup to tape*</td>
<td>Backup repository and tape server</td>
</tr>
<tr>
<td>SOBR data offload</td>
<td>Gateway server and Amazon S3/Azure object storage</td>
</tr>
</tbody>
</table>

* Veeam Backup & Replication throttles traffic between the listed components also if backups are created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux operating in the standalone or managed mode.

Configuring Traffic Throttling

To configure traffic throttling settings in a rule:

1. From the main menu, select Network Traffic Rules.
2. In the Global Network Traffic Rules window, click Add.
3. In the Name field, specify a name for the rule.
4. In the Source IP address range section, specify a range of IP addresses for the backup infrastructure components on the source side.
5. In the Target IP address range section, specify a range of IP addresses for the backup infrastructure components on the target side.
6. Select the Throttle network traffic to check box.
7. In the Throttle network traffic to field, specify the maximum speed that must be used to transfer data from source to target.
8. In the section below the **Throttle network traffic to** field, specify the time interval during which the speed must be limited. You can throttle the traffic all the time or at specific time intervals, for example, during business hours.

![](image)

**Several Rules with Traffic Throttling**

If you create several rules with the same ranges of IP addresses, make sure that time intervals of the rules do not overlap. For example, to manage network traffic during business and non-business hours, you can create the rules as shown below. These rules have the same ranges of IP addresses.

- **Rule 1.** Speed limit: 1 Mbps; time interval: Monday through Friday from 7 AM to 7 PM.
- **Rule 2.** Speed limit: 10 Mbps; time interval: Saturday through Sunday from 7 AM to 7 PM.

With such rules, Veeam Backup & Replication will limit the speed up to 1 Mbps during business hours and up to 10 Mbps during non-business hours.

If several rules have the same target/source IP address range but different speed limits, the lowest limit is used. For example, if you configure the following rules:


In this case, Veeam Backup & Replication will use the lowest speed limit — 1 Mbps.
This rule also applies if traffic is throttled by Veeam Backup & Replication and also Veeam Agent for Microsoft Windows. For more information on how to throttle traffic by Veeam Agent for Microsoft Windows, see the Veeam Agent Management Guide and Veeam Agent for Microsoft Windows User Guide.

Enabling Data Encryption

Network rules also allow you to encrypt transferred data. Data transferred through public networks is encrypted by default. For details, see Adjusting Internet Rule.

To create a network rule with data encryption:

1. From the main menu, select Network Traffic Rules.
2. In the Name field, specify a name for the rule.
4. In the Source IP address range section, specify a range of IP addresses for backup infrastructure components on the source side.
5. In the Target IP address range section, specify a range of IP addresses for backup infrastructure components on the target side.
6. Select the Encrypt network traffic check box.

Related Topics

Data Encryption

Adjusting Internet Rule

The Internet rule is a predefined network rule. This rule manages traffic transferred through public networks — all networks whose IP ranges differ from 10.0.0.0/8, 172.16.0.0/12 and 192.168.0.0/16. The Internet rule also encrypts traffic for such networks. You cannot delete the Internet rule — you can only adjust or turn it off.

To turn off the Internet rule, clear the Throttle network traffic to and Encrypt network traffic check boxes.
To adjust the rule:

1. From the main menu, select **Network Traffic Rules**.
2. In the **Global Network Traffic Rules** window, select **Internet** from the list and click **Edit**.
3. In the **Edit Network Traffic Rule** window:
   - To disable encryption, clear the **Encrypt network traffic** check box.
   - To enable network traffic throttling, select the **Throttle network traffic** check box. For details, see Enabling Traffic Throttling.

Managing Upload Streams

By default, Veeam Backup & Replication uses multithreaded data transfer for every job session. VM data going from source to target is transferred over 5 TCP/IP connections. However, if you schedule several jobs to run at the same time, load on the network may be heavy. If the network capacity is not sufficient to support multiple data transfer connections, you can disable multithreaded data transfer or change the number of TCP/IP connections.

To change the number of connections:

1. From the main menu, select **Network Traffic Rules**.
2. In the **Global Network Traffic Rules** window, specify new data transfer settings:
   - To disable multithreaded data transfer, clear the **Use multiple upload streams per job** check box. Veeam Backup & Replication will use only one TCP/IP transfer connection for every job session.
   - To change the number of TCP/IP connections, leave the **Use multiple upload streams per job** check selected and specify the necessary number of connections in the field on the right.
NOTE:

Veeam Backup & Replication performs a CRC check for the TCP traffic going between the source and the target. When you perform backup and replication operations, Veeam Backup & Replication calculates checksums for data blocks going from the source. On the target, it re-calculates checksums for received data blocks and compares them to the checksums created on the source. If the CRC check fails, Veeam Backup & Replication automatically re-sends data blocks without any impact on the job.

Specifying Preferred Networks

You can choose networks over which Veeam Backup & Replication must transport data when you perform data protection and disaster recovery tasks. This option can be helpful if you have a non-production network and want to route data traffic over this network instead of the production one.

Preferred network rule applies only to traffic between the following backup infrastructure components:

- Backup server
- WAN accelerator*
- Gateway server**
- Off-host backup proxy***
- Microsoft Hyper-V Server***
- Backup repository
- Log shipping server
- Tape server

* The rule applies only to traffic between the source and target WAN accelerators.
** The rule does not apply to traffic between the gateway server and backup repository. For the list of backup repositories with which the gateway server communicates, see Gateway Server.
*** If you need to specify IP ranges other than ranges received by automatic DNS resolution, you need to use a registry key. For more information, see this Veeam KB article.
To define networks for data transfer, you must create a list of preferred networks. When Veeam Backup & Replication needs to transfer data, it uses networks from this list. If a connection over preferred networks cannot be established for some reason, Veeam Backup & Replication will automatically fail over to the production network.

To set a network priority list:

1. From the main menu, select **Network Traffic Rules**.
2. In the **Global Network Traffic Rules** window, click **Networks**.
3. In the **Preferred Networks** window, select the **Prefer the following networks for backup and replication traffic** check box.
4. Click **Add**.
5. Specify a network address using a CIDR notation or a network mask and click **Add**.
6. Repeat steps 4-5 for all networks that you want to add.
Performance Bottlenecks

As any backup application handles a great amount of data, it is important to make sure the data flow is efficient and all resources engaged in the backup process are optimally used. Veeam Backup & Replication provides advanced statistics about the data flow efficiency and lets you identify bottlenecks in the data transmission process.

Veeam Backup & Replication processes VM data in cycles. Every cycle includes a number of stages:

1. Reading VM data blocks from the source
2. Processing VM data on the backup proxy
3. Transporting data over the network
4. Writing data to the target

When one data processing cycle is over, the next cycle begins. VM data therefore goes over the "data pipe".

To evaluate the data pipe efficiency, Veeam Backup & Replication analyzes performance of all components in the data flow working as the cohesive system, and evaluates key factors on the source and target sides. Veeam Backup & Replication checks the following points in the data pipe:

1. **Source** — source disk reader component responsible for retrieving data from the source storage.
2. **Proxy** — backup proxy component responsible for processing VM data.
3. **Source WAN accelerator** — WAN accelerator deployed on the source side. Used for backup copy and replication jobs working via WAN accelerators.
4. **Network** — network queue writer component responsible for getting processed VM data from the backup proxy and sending it over the network to the backup repository or another backup proxy.
5. **Target WAN Accelerator** — WAN accelerator deployed on the target side. Used for backup copy and replication jobs working via WAN accelerators.
6. **Target** — target disk writer component (backup storage or replica datastore).

The resource usage level for these points is evaluated in percent. This percent rate defines the amount of time for which components are busy during the job. An efficient data flow assumes that there is no latency at any point of the data pipe, and all its components work for approximately equal amount of time.

If any of the components operates inefficiently, there may appear a bottleneck in the data path. The insufficient component will work 100% of time while the others will be idling, waiting for data to be transferred. As a result, the whole data flow will slow down to the level of the slowest point in the data path, and the overall time of data processing will increase.
To identify a bottleneck in the data path, Veeam Backup & Replication detects the component with the maximum workload: that is, the component that works for the most time of the job. For example, you use a low-speed storage device as the backup repository. Even if VM data is retrieved from the SAN storage on the source side and transported over a high-speed link, VM data flow will still be impeded at the backup repository. The backup repository will be trying to consume transferred data at the rate that exceeds its capacity, and the other components will stay idle. As a result, the backup repository will be working 100% of job time, while other components may be employed, for example, for 60% only. In terms of Veeam Backup & Replication, such data path will be considered insufficient.

The bottleneck statistics for a job is displayed in the job session data. The bottleneck statistics does not necessarily mean that you have a problem in your backup infrastructure. It informs you about the weakest component in the data path. However, if you feel that the job performance is low, you may try taking some measures to get rid of the bottleneck. For example, in the case described above, you can limit the number of concurrent tasks for the backup repository.

Throttling as Bottleneck

In addition to main points in the data pipe, Veeam Backup & Replication may report throttling as a bottleneck. This can happen in the following cases:

- If you limit the read and write data rates for a backup repository, a backup repository may become a bottleneck. Veeam Backup & Replication will report *Throttling* in the bottleneck statistics.
- If you set up network throttling rules, network may become a bottleneck. Veeam Backup & Replication will report *Throttling* in the bottleneck statistics.
Locations

To control data migration in the virtual infrastructure, Veeam Backup & Replication introduces a notion of location. A location defines a geographic region, or country, in which an infrastructure object resides. You can create a list of locations, and assign to backup infrastructure objects information about locations to which they belong.

Veeam Backup & Replication allows you to assign information about locations to the following infrastructure objects:

- Virtual infrastructure objects: SCVMM, clusters and hosts.
- Backup infrastructure objects: backup repositories, external repositories, scale-out backup repositories, tape libraries and tape vaults.
- Agent management objects: protection groups.
- Veeam Cloud Connect for service providers: cloud repositories and hardware plans.

Information about infrastructure objects location is stored in the Veeam Backup & Replication configuration database. When VM data in the virtual infrastructure migrate from one location to another, Veeam Backup & Replication displays a warning and stores a record about data migration to job or task session details. In addition to it, Veeam Backup & Replication logs this information to Microsoft Windows event logs. For example, if you back up VMs from a host that resides in Germany to a backup repository that resides in Australia, Veeam Backup & Replication will display a warning that VM data changes its location in the backup job wizard, display information about data migration in the backup job session details and log it to Microsoft Windows event logs.

![Job progress](image)

**SUMMARY**

- **Duration:** 02:08
- **Processing rate:** 140 MB/s
- **Data:**
  - Processed: 9.8 GB (99%)
  - Read: 8.5 GB
  - Transferred: 5.3 GB (1.6x)
- **Status:**
  - Success: 0
  - Warnings: 0
  - Errors: 0

**THROUGHPUT (LAST 5 MIN)**

- Speed: 154.6 MB/s

**NAME**

- **Apache Backup (Active Full)**
- **Status:** 95%

**ACTION**

- VM processing started at 1/25/2019-6:14:15 AM
- VM size: 127.8 GB (95% used)
- VM is now in the required state for processing
- Preparing to create snapshot
- Hyper-V Integration Services are not up to date
- Creating snapshot Microsoft Software Shadow Copy provider 1.0 (C:
  - Using source proxy: \host \host 
- Potential data sovereignty violation: target Storage 01 location (UK) does not m...
- Saving 7E084BD-99CE-AF89-89B7-2E69F803F95.xml
- Upgrading auxiliary data backup disk
- Upgrading auxiliary data writer disk
- Hard disk 1 (137.3 GB) 6.5 GB read at 140 MB/s

**DURAT...**

- 00:00
- 00:00
- 00:00
- 00:00
- 00:00
- 01:05

Hide Details  OK
Veeam Backup & Replication displays information about VM data migration in statistics for the following types of jobs:

- **Backup jobs** — Veeam Backup & Replication compares the location of the source host on which VMs are registered with the location of the target backup repository or cloud repository.

- **Backup copy jobs** — Veeam Backup & Replication compares the location of the source host with the location of the target host.

- **VeeamZIP tasks** (except the cases when you select to store the VeeamZIP file in a local or shared folder) — Veeam Backup & Replication compares the location of the source host on which VMs are registered with the location of the target backup repository.

- **Replication jobs** — Veeam Backup & Replication compares the location of the source host on which VMs are registered with the location of the target host.

- **Replica failback tasks** — Veeam Backup & Replication compares the location of the source host with the location of the host to which the VM is restored.

- **Entire VM restore tasks** — Veeam Backup & Replication compares the location of the source host with the location of the host to which VMs are restored.

- **External repository tasks**:
  - Backup copy jobs: Veeam Backup & Replication compares the location of the source external repository with the location of the target backup repository.
  - Restore to Amazon EC2: Veeam Backup & Replication compares the geographic region of the backed-up Amazon EC2 instance with the geographic region of the target EC2 instance.
  - Restore to Microsoft Azure: Veeam Backup & Replication always displays a warning about VM data migration when restore to Microsoft Azure is performed from external repositories.

- **SureBackup jobs** — Veeam Backup & Replication compares the source location with the target location. The target location is always a host on which the virtual lab is registered. The source location may be one of the following:
  - If a VM is added to the application group, Veeam Backup & Replication compares the host on which the VM is registered (or was registered at the moment of backup) with the target location.
  - If a VM is added to the SureBackup job from the linked job, Veeam Backup & Replication compares the backup repository on which the backup file resides with the target location.

- **Tape tasks**:
  - Backup to tape jobs: In backup to tape jobs, Veeam Backup & Replication compares the location of the source job or repository with the location of the tape library in the target media pool. If the media pool spans multiple tape libraries, Veeam Backup & Replication analyzes locations of all libraries in the media pool.
  - Vaults: If a tape job exports offline backups to a vault, Veeam Backup & Replication compares the location of the source job or repository with the location of the vault. If a GFS tape job exports tapes to multiple vaults, Veeam Backup & Replication analyzes all vaults configured for target media pools of the GFS tape job.
  - Media pools: Veeam Backup & Replication compares locations of all tape libraries added to the media pool. If the media pool exports tapes to a vault, Veeam Backup & Replication analyzes all vaults configured for the media pool.
Limitations for Locations

For SureReplica jobs, Veeam Backup & Replication does not compare information about source and target hosts location.

Veeam Backup & Replication does not display a warning about VM data migration for file copy jobs.
Creating and Assigning Locations to Infrastructure Objects

You can create a list of locations in Veeam Backup & Replication and assign locations to infrastructure objects. If you assign a location to root infrastructure host (SCVMM), it will be applied to all child hosts (clusters and HV Hosts). You can also assign the location to a child host.

To create a location:

1. In the Inventory or Backup Infrastructure view, right-click the infrastructure object and select Location > Manage locations.
2. In the Manage Locations window, click Add.
3. In the Name field, enter a name of the location.
To assign a location to an infrastructure object, in the **Inventory** or **Backup Infrastructure** view, right-click the infrastructure object and select **Location** > `<Location name>`. If the location is not in the list, select **Location** > **Manage Locations** and add the location to the list.

**NOTE:**

When assigning a location to a scale-out backup repository, the location will be global for all extents. If you add an extent whose location differs from the global location, it will be changed in favor of the location of the scale-out repository.
Editing Locations

You can edit a location in the locations list, for example, if you want to change the location name.

To edit a location:

1. In the **Inventory** or **Backup Infrastructure** view, right-click the infrastructure object and select **Location** > **Manage locations**.
2. In the **Manage Locations** window, select the location and click **Edit**.
3. In the **Name** field, change the location name as required.
Deleting Locations

You can delete a location from the locations list, for example, if you no longer host infrastructure objects in this location.

To delete a location:

1. In the Inventory or Backup Infrastructure view, right-click the infrastructure object and select Location > Manage locations.

2. In the Manage Locations window, select the location and click Delete. If the location is currently assigned to some infrastructure objects, Veeam Backup & Replication will display a warning with the list of objects that belong to this location. Click Yes to confirm the location deletion.
Exporting and Importing Locations List

You can export and import the list of locations to/from a file of XML format.

The import and export functionality facilitates the process of locations creation and maintenance. For example, if you need to set up the same list of locations throughout the whole backup infrastructure, you can create a list of locations on one backup server manually, export this list to an XML file, and then import the list on other backup servers and machines running the Veeam Backup & Replication console.

TIP:

If you delete and recreate a location, Veeam Backup & Replication will create an object with a new ID in the database and consider it as a new location. Thus, to preserve the uniqueness of the location, use the location export/import operations.

To export the locations list:

1. In the Inventory or Backup Infrastructure view, right-click an infrastructure object and select Location > Manage locations.
2. In the Manage Locations window, click Export and specify a name of the XML file to which the locations list must be exported.

To import the locations list:

1. In the Inventory or Backup Infrastructure view, right-click an infrastructure object and select Location > Manage locations.
2. In the Manage Locations window, click Import and browse to the XML file from which the locations list must be imported.
Veeam Backup & Replication Settings

You can set up general settings for Veeam Backup & Replication. General settings are applied to all jobs, backup infrastructure components and other objects managed by the backup server.
Specifying I/O Settings

You can specify data processing settings.

Mind the following:

- The **Enable storage latency control** option is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.

- The **Set custom thresholds on individual datastores** option is available in Veeam Backup & Replication Enterprise Plus edition only.

To specify data processing settings:

1. From the main menu, select **General Options**.
2. Click the **I/O Control** tab.
3. To control the I/O load on the production storage where VMs reside, select the **Enable storage latency control** check box. When you enable storage latency control, Veeam Backup & Replication monitors storage read latency on production volumes during data protection and disaster recovery activities. To monitor the storage latency, Veeam Backup & Replication uses real-time metrics from the hypervisor where VMs reside. Metrics from the hypervisor are collected every 10 seconds.

Specify two thresholds:

a. In the **Stop assigning new tasks to datastore at** field, specify the I/O latency limit at which Veeam Backup & Replication must not assign new tasks targeted at the volume.

b. In the **Throttle I/O of existing tasks at** field, specify the I/O latency limit at which Veeam Backup & Replication must decrease the speed of data retrieval or writing to/from the volume. When the I/O latency for this volume reaches this value, the Veeam Data Mover working with this volume will slow down data retrieval or writing.

The value in the **Stop assigning new tasks to datastore at** field cannot be greater than the value in the **Throttle I/O of existing tasks at** field.
NOTE:
If you enable the storage latency control option, Veeam Backup & Replication starts processing VM disks residing on the same datastore with a 40-60 second time offset. This offset helps Veeam Backup & Replication evaluate the current I/O load on the datastore. For example, if you launch a job processing a VM with two disks, Veeam Backup & Replication will start processing the first VM disk, wait for 40-60 seconds to evaluate the I/O workload on the datastore, and then start processing the second VM disk.

Keep in mind this behavior. If you schedule jobs that process multiple VM disks residing on the same datastore to start at the same time, the jobs performance will degrade.

You can set the I/O latency limit for every storage in the virtual infrastructure separately.

To set the I/O latency limit for every storage separately:

1. From the main menu, select **General Options**.
2. Click the **I/O Control** tab.
3. Click **Configure**.
4. Click **Add > Volume**, select the necessary volume and click **OK** to add it to the storage list.
5. Select the added volumes in the list and click **Edit**.
6. Specify the I/O thresholds for the volumes as described above.
Configuring Security Settings

In the **Security** tab, you can configure the following:

- **TLS Certificates**
  Configure a TLS certificate to establish secure communication between the backup server and the Microsoft Hyper-V server or storage systems.

- **Linux Hosts Authentication**
  Enable the fingerprint check for Linux machines to protect connection from man-in-the-middle attacks.

- **Audit Logs Location**
  Select a folder for storing audit logs.

**TLS Certificates**

When you configure the Veeam Backup & Replication infrastructure, you can specify what TLS certificate must be used to establish a secure connection between the backup server and the Microsoft Hyper-V server or storage systems. Veeam Backup & Replication offers the following options for TLS certificates:

- You can choose to keep the default self-signed TLS certificate generated by Veeam Backup & Replication at the process of upgrading to a new version of Veeam Backup & Replication.

- You can use Veeam Backup & Replication to generate a new self-signed TLS certificate. To learn more, see Generating Self-Signed Certificates.

- You can select an existing TLS certificate from the certificates store. To learn more, see Importing Certificates from Certificate Store.

- You can import a TLS certificate from a file in the PFX format. To learn more, see Importing Certificates from PFX Files.

**NOTE:**

If you plan to use a certificate issued by your own CA, make sure that the certificate meets the following requirements:

1. The following Key Usage extensions are enabled in the certificate: **Digital Signature**, **Certificate Signing**, **Off-line CRL Signing**, **CRL Signing**.

2. The Key Type in the certificate is set to **Exchange**.

**Generating Self-Signed Certificates**

You can use Veeam Backup & Replication to generate a self-signed certificate for authenticating parties in the Veeam Backup & Replication infrastructure.

To generate TLS certificates, Veeam Backup & Replication employs the RSA Full cryptographic service provider by Microsoft Windows installed on the Veeam backup server. The created TLS certificate is saved to the **Shared** certificate store. The following types of users can access the generated TLS certificate:

- User who created the TLS certificate
- LocalSystem user account
- Administrators group
If you use a self-signed TLS certificate generated by Veeam Backup & Replication, you do not need to take any additional actions to deploy the TLS certificate on a protected computer. When Veeam Backup & Replication discovers a Microsoft Hyper-V server or a storage system, a matching TLS certificate with a public key is installed on the protected computer automatically. During discovery, Veeam Installer Service deployed on the protected computer retrieves the TLS certificate with a public key from the backup server and installs a TLS certificate with a public key on the protected computer.

**NOTE:**
When you generate a self-signed TLS certificate with Veeam Backup & Replication, you cannot include several aliases to the certificate and specify a custom value in the **Subject** field. The **Subject** field value is taken from the Veeam Backup & Replication license installed on the Veeam backup server.

To generate a self-signed TLS certificate:

1. From the main menu, select **General Options**.
2. Click the **Security** tab.
3. In the **Security** tab, click **Install**.
4. At the **Certificate Type** step of the wizard, select **Generate new certificate**.

![Manage Certificate](image)

- **Generate new certificate**
  - Generate a new self-signed certificate that is verifiable with the thumbprint.
- **Select certificate from the Certificate Store**
  - Use an existing certificate already present in the local Certificate Store of this server.
- **Import certificate from a file**
  - Select this option to import certificate from .PFX file. The certificate will be automatically imported into the local Certificate Store of this server.
5. At the **Generate Certificate** step of the wizard, specify a friendly name for the created self-signed TLS certificate.

![Manage Certificate](image)

The certificate created by this feature will not originate from a trusted certification authority (CA). Cloud Connect users will be notified about this fact when establishing the initial connection to your service, and provided with the ability to verify the certificate with the thumbprint.

6. At the **Summary** step of the wizard, review the certificate properties. Use the **Copy to clipboard** link to copy and save information about the generated TLS certificate. You will be able to use the copied information to verify the TLS certificate with the certificate thumbprint.
7. Click **Finish**. Veeam Backup & Replication will save the generated certificate in the *Shared* certificate store on the Veeam backup server.

![Manage Certificate](image)

Importing Certificates from Certificate Store

If your organization has a TLS certificate signed by a CA and the TLS certificate is located in the Microsoft Windows Certificate store, you can use this certificate for authenticating parties in the Veeam Backup & Replication infrastructure.

To select a certificate from the Microsoft Windows Certificate store:

1. From the main menu, select **General Options**.
2. Click the **Security** tab.
3. In the **Security** tab, click **Install**.
4. At the **Certificate Type** step of the wizard, choose **Select certificate from the Certificate Store**.

5. At the **Pick Certificate** step of the wizard, select a TLS certificate that you want to use. You can select only certificates that contain both a public key and a private key. Certificates without private keys are not displayed in the list.

6. At the **Summary** step of the wizard, review the certificate properties.
7. Click Finish to apply the certificate.

**Importing Certificates from PFX Files**

You can import a TLS certificate in the following situations:

- Your organization uses a TLS certificate signed by a CA and you have a copy of this certificate in a file of PFX format.
- You have generated a self-signed TLS certificate in the PFX format with a third-party tool and you want to import it to Veeam Backup & Replication.

**IMPORTANT!**

The TLS certificate must pass validation on the Veeam backup server. In the opposite case, you will not be able to import the TLS certificate.

To import a TLS certificate from a PFX file:

1. From the main menu, select **General Options**.
2. Click the **Security** tab.
3. In the **Security** tab, click **Install**.
4. At the **Certificate Type** step of the wizard, choose **Import certificate from a file**.

5. At the **Import Certificate** step of the wizard, specify a path to the PFX file.
6. If the PFX file is protected with a password, specify the password in the field below.

![Manage Certificate](image)

7. At the **Summary** step of the wizard, review the certificate properties. Use the **Copy to clipboard** link to copy and save information about the TLS certificate. You can use the copied information on a protected computer to verify the TLS certificate with the certificate thumbprint.

8. Click **Finish** to apply the certificate.

**Linux Host Authentication**

In the **Linux hosts authentication** section of the Veeam Backup & Replication settings, you can specify SSH fingerprint verification settings for protected Linux machines.

You can select one of the following options:

- **Add all discovered hosts to the list automatically** — with this option enabled, Veeam Backup & Replication allows all added Linux VMs and Linux servers to connect to the backup server.

- **Add unknown hosts to the list manually (more secure)** — with this option enabled, only the following Linux machines can connect to the backup server:
  - Protected machines that have already established a connection to the backup server and have their fingerprints stored in the Veeam Backup & Replication database.
  
  Veeam Backup & Replication displays the number of trusted machines in the **Trusted hosts** field. To export the list of trusted machines to the `known_hosts` file, click **Export** and specify a path to the folder to save the file.
- Protected machines specified in the `known_hosts` file imported to Veeam Backup & Replication. To import the `known_hosts` file, click **Import** and specify a path to the folder where the file resides.

Machines that do not meet the above-mentioned conditions cannot connect to the Veeam backup server and download Veeam Agent for Linux installation packages during discovery. Also, guest OS processing of untrusted VMs will fail.

Veeam Backup & Replication displays these computers under the **Untrusted** node in the inventory. To start managing an untrusted computer, you need to validate its fingerprint manually in the Veeam Backup & Replication console. To learn more, see **Validating SSH Fingerprints**.

---

### Validating SSH Fingerprints

Veeam Backup & Replication treats fingerprints of Linux VMs and Linux hosts differently:

- **Validating SSH Fingerprints of Linux VMs**
- **Validating SSH Fingerprints of Linux Hosts**

### Validating SSH Fingerprints of Linux VMs

When you enable the **Add unknown hosts to the list manually (more secure)** option in Veeam Backup & Replication settings, Linux-based computers whose fingerprints are not stored in the Veeam Backup & Replication database or the `known_hosts` file become unable to communicate to the Veeam backup server. During discovery, Veeam Backup & Replication puts such computers to the **Untrusted** protection group. To start managing an untrusted computer, you need to validate its fingerprint manually in the Veeam Backup & Replication console.

To validate the SSH fingerprint:

1. Open the **Inventory** view.
2. In the inventory pane, expand the **Virtual Infrastructure** node and click **Untrusted**.
3. In the working area, Veeam Backup & Replication will display a list of computers whose fingerprints need to be validated. Check fingerprints of the computers in the list and validate them in one of the following ways:

- To validate fingerprints of all untrusted computers at once, select the **Untrusted** node in the inventory pane and click **Trust All** on the ribbon. Alternatively, you can right-click the **Untrusted** node and select **Trust all**.
Validating SSH Fingerprints of Linux Hosts

If the SSH public key fingerprint of a Linux host is changed, Veeam Backup & Replication places this host in the Unavailable folder. To be able to use this server, do the following:

1. In the Backup Infrastructure view, expand the Managed Servers node and select Unavailable.
2. Right-click the Linux server and select Properties.
3. In the SSH Connection step of the Edit Linux Server wizard, click Apply.
4. In the pop-up dialogue window, click Yes to confirm that you trust this server.
5. Click Finish to close the wizard.

Audit Logs Location

Veeam Backup & Replication provides logging of performed activities, such as data protection and disaster recovery tasks: for example, the list of files restored during File-Level Restore sessions. The results of the audit of such activities are stored in form of .csv files that are called audit logs. For more information about log files, see Logging.

At Audit Logs Location field you can select folder where the audit logs will be stored. By default, log files are stored in the following folder: %ProgramData%\Veeam\Backup\Audit. You can also select a CIFS folder.
If you use a CIFS folder, the service account that is used for Veeam Backup Service on the machine with Veeam Backup & Replication must have access to that CIFS folder. By default, this is Local System account, so you will need to grant write access to VBR Server Active Directory computer account.

![Options dialog box](image)

### Options Dialog Box

**Backup server**

- Certificate: Self-signed
  - CN=Veeam Backup Server Certificate

**Linux hosts authentication**

- Trusted hosts: 0
- Trusted hosts list:
  - Add all discovered hosts to the list automatically
  - Add only unknown hosts to the list manually (more secure)

**Cloud Connect**

- Accept remote console connection requests originating from the Internet

**Audit logs location**

- Folder: C:\ProgramData\Veeam\Backup\Audit
  - Compress older audit logs automatically (saves disk space)
  - Consider disabling this option when using a WORM storage for audit logs.
Specifying Email Notification Settings

You can receive email notifications with results on jobs performed on the backup server.

To receive email notifications, you must perform the following tasks:

- Configure global email notification settings in Veeam Backup & Replication
- Configure job notification settings

**TIP:**
To receive email notification about all jobs performed on the backup server in one email, configure email notification settings in Veeam Backup Enterprise Manager.

### Configuring Global Email Notification Settings

To configure global email notification settings:

1. From the main menu, select **General Options**.
2. Open the **E-mail Settings** tab.
3. Select the **Enable e-mail notifications** check box.
4. In the **SMTP server** field, enter a full DNS name or IP address of the SMTP server that will be used for sending email notifications.
5. Click the **Advanced** button to specify user credentials and connection options:
   a. Specify the port number and connection timeout for the SMTP server.
   b. To use a secure connection for email operations, select the **Connect using SSL** check box.
   c. If you need to connect to the SMTP server using a specific account, select the **This SMTP server requires authentication** check box and select the necessary credentials from the **Log on as** list. If you have not set up credentials beforehand, click the **Manage accounts** link or click **Add** on the right to add credentials. For more information, see [Managing Credentials](#).
6. In the **From** field, specify an email from which email notifications must be sent.
7. In the **To** field, specify the recipient addresses. Use a semicolon to separate multiple addresses. Recipients specified in this field will receive notification about every job managed by the backup server. You can leave the field empty if required.

   For every particular job, you can specify additional recipients. For more information, see [Configuring Job Notification Settings](#).
NOTE:
If you specify the same email recipient in both job notification and global notification settings, Veeam Backup & Replication will send two separate notifications to this recipient in the following cases:

- If a subject for the email message specified in job notification and global notification settings is different.
- If a list of email recipients specified in job notification and global notification settings is different.

8. In the **Subject** field, specify a subject for the sent message. You can use the following variables in the subject:

   a. **%Time%** — completion time
   b. **%JobName%**
   c. **%JobResult%**
   d. **%ObjectCount%** — number of VMs in the job
   e. **%Issues%** — number of VMs in the job that have been processed with the **Warning** or **Failed** status

9. In the **Send daily reports at** field, specify at what time Veeam Backup & Replication will send daily email reports.

   Daily reports are generated for different purposes throughout Veeam Backup & Replication:
   
   - Reports about processing results of scale-out repository data.
     For more information, see [Receiving Scale-Out Backup Repository Reports](#).
   - Reports about processing results of backup copy jobs.
     For more information, see [Notification Settings](#) in [Creating Backup Copy Jobs for VMs and Physical Machines](#).
   - Reports about processing results of backup copy jobs for transaction log backups.
     For more information about transaction log backups, see [Microsoft SQL Server Logs Backup](#).
   - Reports about backups of virtual and physical machines created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux in the Managed by Agent mode.
   - Reports with statistics for rescan job sessions performed for protection groups of virtual and physical machines created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux.
   - Reports about processing results of backup copy jobs for backups of Oracle RMAN and SAP HANA databases created with Veeam Plug-ins for Enterprise Applications.

NOTE:
Settings configured for a certain report override global notification settings.

10. In the **Notify on** group, select the **Success**, **Warning** and/or **Failure** check boxes to receive email notification if a job is run successfully, not successfully or with a warning.

11. Select the **Suppress notifications until the last retry** check box to receive a notification about the final job status. If you do not enable this option, Veeam Backup & Replication will send one notification per every job retry.
12. Veeam Backup & Replication allows sending a test email to check if all settings have been configured correctly. To send a test email, click **Test Message**.

### Configuring Job Notification Settings

To configure job notification settings:

1. Open advanced settings of the job.
2. On the **Notifications** tab, select the **Send email notifications to the following recipients** check box.
3. In the field below, enter an email address to which a notification must be sent. You can enter several email addresses separated with a semicolon.

**NOTE:**

If you specify the same email recipient in both job notification and global notification settings, Veeam Backup & Replication will send two separate notifications to this recipient in the following cases:

- If a subject for the email message specified in job notification and global notification settings is different.
- If a list of email recipients specified in job notification and global notification settings is different.

4. You can choose to use global notification settings for the job or specify custom notification settings.

   - To receive a typical notification for the job, select **Use global notification settings**. In this case, Veeam Backup & Replication will apply to the job global email notification settings specified for the backup server. For more information, see [Configuring Global Email Notification Settings](#).
To configure a custom notification for the job, select **Use custom notification settings** and specify notification settings as required.
Specifying SNMP Settings

You can receive SNMP traps with results on jobs performed on the backup server. You can use SNMP traps to feed data to other monitoring systems such as CA Unicenter, BMC Patrol, IBM Tivoli or HPE OpenView. SNMP traps can be sent to 5 different destinations.

Veeam Backup & Replication supports SNMP versions 1 and 2.

To receive SNMP traps, you must perform the following tasks:

- Configure global SNMP settings
- Configure SNMP service properties
- Configure SNMP settings for jobs

Configuring Global SNMP Settings

To configure global SNMP settings:

1. From the main menu, select General Options.
2. Click the SNMP Settings tab.
3. In the Receiver field, specify an IP address of the SNMP recipient.
4. In the field on the right, enter the port number to be used.
5. In the Community String field, enter the community identifier.
Configuring SNMP Service Properties

To configure SNMP service properties on recipient computers:

1. Install a standard Microsoft SNMP agent from the Microsoft Windows distribution on the computer.
2. From the Start menu, select Control Panel > Administrative Tools > Services.
3. Double-click SNMP Service to open the SNMP Service Properties window.
4. Click the Traps tab.
5. Add the public string to the Community name list and name of the necessary host to the Trap destinations list.
6. Click the Security tab.
7. Make sure the Send authentication trap check box is selected.
8. Add the public string to the Accepted community names list.
9. Select the Accept SNMP packets from any host check box.
10. Click **OK** to save changes.

**Configuring SNMP Settings for Jobs**

To receive SNMP traps with results of a specific job:

1. Open advanced settings of the job.
2. On the **Notifications** tab, select the **Send SNMP notifications for this job** check box.
Specifying Other Notification Settings

You can configure Veeam Backup & Replication to automatically notify you about the following events:

- Low disk space
- Support contract expiration
- New product versions, available updates and patches

Low Disk Space Notification

When you run a job, Veeam Backup & Replication checks disk space in the target backup repository and production storage. If the disk space is below a specific value, Veeam Backup & Replication will display a warning message in the job session details.

To specify the disk space threshold:

1. From the main menu, select General Options.
2. Click the Notifications tab.
3. In the Backup storage and Production datastores sections, select the Warn me when free disk space is below <N> % options and specify a desired disk space threshold.
4. In the Production datastores section, select the Skip VMs when free disk is below <N> % option and specify a desired disk space threshold. When the threshold is reached, Veeam Backup & Replication will terminate backup and replication jobs working with production volumes before volume snapshots/VM checkpoints are taken. Such behaviour helps ensure that production volumes do not run out of space.

Veeam Backup & Replication also terminates jobs if the amount of free space on the volume is below 2 GB. You can change this threshold limit with registry keys. For more information, contact Veeam Customer Support.
Support Contract Expiration Notification

By default, Veeam Backup & Replication informs email recipients specified in global notification settings about the support expiration date in every email notification. Veeam Backup & Replication starts sending such notifications 14 days before the expiration date. Expiration information is also shown on the splash screen and on the License Information window (to display the License Information window, select Help > License from the main menu).

To stop receiving notifications about support contract expiration:

1. From the main menu, select General Options.
2. Click the Notifications tab.
3. Clear the Enable notifications about support contract expiration check box.

New Product Versions and Hypervisor Update Notification

Veeam Backup & Replication automatically checks and notifies you about new product versions and patches available on the Veeam website and released hypervisor updates. For more information, see Update Notification.

You can disable update notifications. However, it is recommended that you leave the update notifications enabled not to miss critical updates and patches.

To stop receiving the notifications:

1. From the main menu, select General Options.
2. Click the Notifications tab.
3. Clear the Check for product and hypervisor updates periodically check box.
IMPORTANT!

Make sure that the backup server is connected to the Internet. In the opposite case, you will not be able to receive the notifications about updates and patches.
Specifying Session History Settings

You can specify session history settings for jobs performed on the backup server.

1. From the main menu, select **General Options**.
2. Click the **History** tab.
3. In the **Sessions** section, configure how many sessions you want to display in the **Sessions** list of the **History** view:
   - Select **Show all sessions** if you want to show all sessions.
   - Select **Show only last sessions** if you want to show a limited number of sessions. In the field, also specify the total number of sessions that you want to display.
4. In the **Session history retention** section, configure for how long you want to keep session information in the database:
   - Select **Keep all sessions** if you do not want to delete sessions.
   - Select **Keep only last weeks** if you want to keep sessions for a limited period of time. In the field, also specify this period in weeks.
Roles and Users

You can assign one of the following roles to users or groups of users who plan to work with Veeam Backup & Replication:

- Veeam Restore Operator
- Veeam Backup Viewer
- Veeam Backup Operator
- Veeam Backup Administrator
- Veeam Tape Operator

A role assigned to the user defines the user activity scope: what operations in Veeam Backup & Replication the user can perform. Role security settings affect the following operations:

- Starting and stopping jobs
- Performing restore operations

Users having different roles can perform a different set of operations:

<table>
<thead>
<tr>
<th>Role</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veeam Restore Operator</td>
<td>Can perform restore operations using existing backups and replicas. Mind that during restore, Veeam Restore Operator can overwrite existing instances: VMs during VM restore, disks during disk restore and files during file-level restore.</td>
</tr>
<tr>
<td>Veeam Backup Viewer</td>
<td>Has the “read-only” access to Veeam Backup &amp; Replication. Can view existing jobs and review the job session details.</td>
</tr>
<tr>
<td>Veeam Backup Operator</td>
<td>Can start and stop existing jobs, export backups and create VeeamZip backups.</td>
</tr>
<tr>
<td>Veeam Backup Administrator</td>
<td>Can perform all administrative activities in Veeam Backup &amp; Replication.</td>
</tr>
<tr>
<td>Veeam Tape Operator</td>
<td>Can manage tapes and perform the following operations: tape inventory, tape export, tape eject, tape catalog, inventory library, catalog library, rescan library, import tapes, eject tape from drive.</td>
</tr>
</tbody>
</table>

You can assign several roles to the same user. For example, if the user must be able to start jobs and perform restore operations, you can assign the Veeam Backup Operator and Veeam Restore Operator roles to this user.

Mind the following:

- The user account under which the Veeam Backup Service runs must have the Veeam Backup Administrator role. By default, during installation the Veeam Backup Administrator role is assigned to users in the Administrators group. If you change the default settings, make sure that you assign the Veeam Backup Administrator role to the necessary user account. It is recommended to assign the Veeam Backup Administrator role to the user account explicitly rather than the group to which the user belongs.
• Built-in administrator accounts (Domain\Administrator and Machine\Administrator) always have full access in Veeam Backup & Replication, even if you exclude them from all Veeam Backup & Replication roles.

To assign a role to the user or user group:

1. From the main menu, select **Users and Roles**.
2. Click **Add**.
3. In the **User or group** field, enter a name of a user or user group in the **DOMAIN\USERNAME** format.
4. From the **Role** list, select the necessary role to be assigned.
Update Notification

Veeam Backup & Replication automatically notifies you about updates that must or can be installed to enhance your work experience with the product. Update notifications eliminate the risk of using out-of-date components in the backup infrastructure or missing critical updates that can have a negative impact on data protection and disaster recovery tasks.

Veeam Backup & Replication notifies about the following types of updates:

- Veeam Backup & Replication updates: new patches and product versions.
- Microsoft Hyper-V updates: Microsoft Hyper-V fixes and patches required for correct work of Veeam Backup & Replication with Microsoft Hyper-V.

The update notifications are enabled by default. If you do not want to get notified about available updates, you can disable them. For more information, see Specifying Other Notification Settings.

However, it is recommended that you leave update notifications enabled not to miss critical updates and patches.

How Update Notification Works

To check for updates, Veeam Backup & Replication uses a special XML file on the Veeam Update Notification Server (dev.veeam.com). The XML file contains information about the most up-to-date product version and patches.

Veeam Backup & Replication downloads an XML file from the Veeam Update Notification Server once a week. It also collects information about the installed product and updates installed on Hyper-V hosts. The collected information is compared with the information in the downloaded file. If new product versions, patches and updates are available, Veeam Backup & Replication informs you about them.
NOTE:
Make sure that the backup server is connected to the Internet and update notification is enabled in Veeam Backup & Replication options. In the opposite case, update notification will not function.
Installing Updates

Veeam Backup & Replication uses update notifications to inform you about new versions of Veeam Backup & Replication, new product patches and Microsoft Hyper-V hypervisor updates.

New Product Versions and Patches

When a new version of Veeam Backup & Replication or a new product patch becomes available on the website, Veeam Backup & Replication displays an icon in the system tray. An icon is displayed once a week.

To install a product update, double-click the Veeam Backup & Replication icon in the system tray. Veeam Backup & Replication will open a KB webpage with the update description and links to the installation archive of the new product version or new patch.

Microsoft Hyper-V Updates

Veeam Backup & Replication notifies about hypervisor updates that should be installed on Microsoft Hyper-V hosts and off-host backup proxies.
If a Microsoft Hyper-V host or off-host backup proxy added to the backup infrastructure misses important hypervisor fixes and patches that can potentially affect work of Veeam Backup & Replication, Veeam Backup & Replication displays a warning icon over the host or off-host proxy in the inventory pane.

To install updates:

1. In the **Backup Infrastructure** view, select a host or off-host backup proxy and click **Missing Updates** on the ribbon.

2. Use the **Missing Updates** window to manage updates:
   - To install an update, click the update link. Veeam Backup & Replication will open a webpage with the update description and download link.
   - To ignore the update, select it in the list and click **Dismiss**. Veeam Backup & Replication will remove the update from the list and will not inform you about it anymore. To ignore all updates, click **Dismiss All**.
   - To bring the list of updates to its initial state, click **Re-Check**. Veeam Backup & Replication will display all updates, including those that have been dismissed.
   - To copy update list details, click **Copy to Clipboard**.
TIP:
Beside hypervisor updates, in the **Missing Updates** list Veeam Backup & Replication displays information about new Veeam Backup & Replication versions and patches. Click the corresponding link in the list, and Veeam Backup & Replication will open a webpage with the product update description and links to the installation archive.
Server Components Upgrade

Every time you launch the Veeam Backup & Replication console, Veeam Backup & Replication automatically checks if Veeam Backup & Replication components installed on managed servers are up to date. If a later version of components is available, Veeam Backup & Replication displays the Components Update window and prompts you to upgrade components on managed servers. Components upgrade may be necessary, for example, after you have upgraded Veeam Backup & Replication.

You can manually check if components upgrade is required. To do this, select Upgrade from the main menu. If components on all managed servers are up to date, the menu item will be disabled.

To upgrade components on managed servers:

1. In the Components Update window, select a server and click Details. Veeam Backup & Replication will display the current and latest available versions for installed components.

2. In the Components Update window, select check boxes next to servers for which you want to upgrade components and click Next.

You can update components on every managed server separately. If components installed on the server require upgrade, Veeam Backup & Replication displays a warning icon next to the server.

To update components for a managed server:

1. Open the Backup Infrastructure view.

2. In the inventory pane, click Managed servers.
3. In the working area, select the server and click **Upgrade** on the ribbon.

Alternatively, you can open the **Infrastructure** view, in the inventory pane select **Managed servers**, in the working area right-click the server and select **Upgrade**.
Logging

Veeam Backup & Replication provides detailed logging of performed activities data protection and disaster recovery tasks.

On the backup server, log files are stored in the following folder: %ProgramData%\Veeam\Backup. Veeam Backup & Replication keeps a separate log file for each of its components: Veeam Shell, Veeam Backup Service, Veeam Guest Catalog Service, Veeam vPower NFS Service, Veeam Installer, Veeam Data Mover and performed jobs.

In addition to logs stored on the backup server, log files are also stored on all servers added to the backup infrastructure:

- On Linux servers, logs are stored in the following directory: /var/log/VeeamBackup/ or /tmp/VeeamBackup
- On Microsoft Windows servers and Hyper-V hosts, logs are stored in the following directory: %ProgramData%\Veeam\Backup

You can collect log files from the backup server and servers managed by Veeam Backup & Replication using the Export Logs wizard.

**TIP:**
You can change default log files settings. For more information, see this Veeam KB article.
Exporting Logs

You can use log files to submit a support ticket. It is recommended that you send all log files when submitting a support ticket to ensure that overall and comprehensive information is provided to Veeam Support Team.

To aggregate all log files in the same location, use the **Export Logs** wizard. To launch the wizard, from the main menu select **Help > Support Information**.
Step 1. Select Virtual Infrastructure Scope

At the **Scope** step of the wizard, define the scope for logs export. You can export logs for the following objects:

- Specific jobs on the backup server
- Specific VMs in the virtual environment
- Specific components in the backup infrastructure

**NOTE:**

If you export logs from the Veeam Backup & Replication console, the exported logs will be copied to the machine where the console is installed. The log archive will also contain logs from the console machine.

![Export Logs](image)

<table>
<thead>
<tr>
<th>Managed servers:</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>svw08.tech.local</td>
<td>Installer, Mount Server, Transport, vPower N..</td>
</tr>
<tr>
<td>172.17.52.13</td>
<td>Installer, Transport</td>
</tr>
<tr>
<td>fileserver01.tech.local</td>
<td>Installer, Mount Server, Transport, vPower N..</td>
</tr>
<tr>
<td>fileserver02.tech.local</td>
<td>Installer, Mount Server, Transport, vPower N..</td>
</tr>
<tr>
<td>svw07.tech.local</td>
<td>Installer, Transport, WAN Accelerator</td>
</tr>
</tbody>
</table>

---

[Image of Export Logs dialog box]
Step 2. Specify Time Interval

At the **Date Range** step of the wizard, define the time interval for which logs must be collected. You can select one of the following options:

- Collect logs for the last N days
- Collect logs for a specific period of time
- Collect all available logs
Step 3. Specify Destination Folder

At the **Location** step of the wizard, specify the destination folder to which the logs will be exported.

In the **Path to folder** field, specify a path to an archive with log files that will be created. By default, the archive is placed to the `C:\temp\logs` folder on the backup server.
Step 4. Review Results

At the Export step of the wizard, Veeam Backup & Replication will collect specified logs and create a log archive. Wait for the export process to complete, review the results and click the Open folder link to browse to exported log files and log package.
Configuration Backup and Restore

You can back up and restore the configuration database that Veeam Backup & Replication uses.

During configuration backup, Veeam Backup & Replication exports data from the configuration database and saves it to a backup file in the backup repository. If the backup server fails for some reason, you can re-install the backup server and quickly restore its configuration from the configuration backup. You can also use configuration backups to apply the configuration of one backup server to another backup server in the backup infrastructure.

It is recommended that you regularly perform configuration backup for every backup server in the backup infrastructure. Periodic configuration backups reduce the risk of data loss and minimize the administrative overhead if any problem with backup servers occurs.

It is not recommended to back up the backup server configuration using backup jobs in Veeam Backup & Replication. For backup, Veeam Backup & Replication uses VM snapshots. During snapshot creation and commit, the VM freezes for some time, which can potentially lead to the following consequences:

- Disconnection from the configuration database. For more information, see the Veeam KB1681 article.
- Disconnection from remote Veeam Backup & Replication agents.
- Disconnection from network storage (for example, storage presented via iSCSI) and so on.

For this reason, you must always use the configuration backup functionality to back up and restore configuration of the backup server.
Configuration Backup

By default, Veeam Backup & Replication is configured to create a configuration backup daily. You can change the schedule or run the backup manually.

See the following topics:

- Scheduling Configuration Backups
- Configuring Notification Settings for Configuration Backups
- Running Configuration Backups Manually
- Creating Encrypted Configuration Backups

Configuration Backup Files

When you perform configuration backup, Veeam Backup & Replication retrieves data for the backup server from the configuration database, writes this data into a set of XML files and archives these XML files to a backup file of the BCO format.

Veeam Backup & Replication exports information about the following objects:

- **Backup infrastructure components and objects**: hosts, servers, backup proxies, repositories, WAN accelerators and jobs, global settings configured on the backup server and so on.
- **Backups**: backups, replicas and backup copies created on the backup server.
- **Sessions**: job sessions performed on the backup server.
- **Tapes**: tape libraries connected to the backup server.

Configuration backup is job-driven. You can schedule it to run regularly or start it manually. You can choose the backup repository in which the configuration backup must be stored and specify the necessary retention settings.

**NOTE:**

The configuration backup job creates a snapshot of the configuration database and retrieves data required for successful restore from it. If the database size is large, the job may produce significant load on the Microsoft SQL Server. Make sure that you schedule the configuration backup job for a period of low operation intensity on the backup server.

Backup Repository Target

The resulting configuration backup file is stored in the \VeeamConfigBackup\%BackupServer% folder on the default backup repository. However, for security’s sake, it is recommended that you do not store configuration backups on the default backup repository or in any other folder on the backup server. In this case, if the backup server fails, its configuration data will remain, and you will be able to recover the failed backup server.

When you configure a new backup repository, Veeam Backup & Replication offers you to change the configuration backup file location from the default backup repository to the new backup repository. Click **Yes**, and Veeam Backup & Replication will automatically change the backup target in the configuration backup job settings and will use this target in future.
Configuration backups that were created before the target change will remain in the default backup repository. You can manually copy them to the new backup repository to have all restore points of the configuration backup in one place.

**IMPORTANT!**
You cannot store configuration backups in scale-out backup repositories.

### Scheduling Configuration Backups

You can instruct Veeam Backup & Replication to perform configuration backup automatically by schedule.

**IMPORTANT!**
If you plan to migrate configuration data to the database used by another backup server, stop all running jobs and disable scheduled jobs before creating the configuration backup. In the opposite case, job sessions may be failing after configuration restore. For more information, see [Migrating Configuration Database](#).

To schedule a configuration backup:

1. From the main menu, select **Configuration Backup**.
2. Make sure that the **Enable configuration backup to the following repository** check box is selected.
3. From the **Backup repository** list, choose a backup repository on which the configuration backup must be stored.
4. In the **Restore points to keep** field, specify the number of restore points that you want to maintain in the backup repository.
5. Click **Schedule** next to the **Perform backup on** field and specify the time schedule according to which the configuration backup must be created.
6. To create an encrypted backup, select the **Enable backup file encryption** check box. From the **Password** field, select a password you want to use for encryption. If you have not created a password beforehand, click **Add** or use the **Manage passwords** link to specify a new password. For more information, see **Creating Encrypted Configuration Backups**.

---

**Configuration Backup Settings**

**Backup**
- Enable configuration backup to the following repository:
  - Backup Volume 01 (Windows-based repository)
  - 86.6 GB free of 119 GB
- Restore points to keep: 10
- Perform backup on: Daily at 10:00 AM
- Last successful backup: 4/2/2019 10:31 AM

**Enable backup file encryption**
- **Password**: Veeam encryption (Last edited: less than a day ago)
- **Add...**
- **Manage passwords**

**Restore**
- Restore the configuration backup to this server

---

**Configuring Notification Settings for Configuration Backups**

You can configure notifications for the configuration backup:

1. From the main menu, select **Configuration Backup**.
2. Click **Notifications**.
3. Select the **Send SNMP notifications for this job** check box if you want to receive SNMP traps when the job completes successfully.
   - SNMP traps will be sent if you specify global SNMP settings in Veeam Backup & Replication and configure software on recipient’s machine to receive SNMP traps. For more information, see **Specifying SNMP Settings**.
4. Select the **Send email notifications to the following recipients** check box if you want to receive notifications about the job completion status by email. In the field below, specify recipient’s email address. You can enter several addresses separated by a semicolon.
   - Email notifications will be sent if you configure global email notification settings in Veeam Backup & Replication. For more information, see **Configuring Global Email Notification Settings**.
5. You can choose to use global notification settings or specify custom notification settings.
   - To receive a typical notification for the job, select **Use global notification settings**. In this case, Veeam Backup & Replication will apply to the job global email notification settings specified for the backup server. For more information, see **Configuring Global Email Notification Settings**.
   - To configure a custom notification for the job, select **Use custom notification settings specified below** check box. You can specify the following notification settings:
i. In the **Subject** field, specify a notification subject. You can use the following variables in the subject: %JobResult%, %JobName%, %Time% (completion time).

ii. Select the **Notify on success**, **Notify on warning** and/or **Notify on error** check boxes to receive email notification if the job completes successfully, fails or completes with a warning.

---

### Running Configuration Backups Manually

You can create a configuration backup manually when you need it, for example, if you want to capture a state of the configuration database at a specific point in time.

**IMPORTANT!**

If you plan to migrate configuration data to the database used by another backup server, stop all running jobs and disable scheduled jobs before creating the configuration backup. In the opposite case, job sessions may be failing after configuration restore. For more information, see [Migrating Configuration Database](#).

To create a configuration backup manually:

1. From the main menu, select **Configuration Backup**.
2. Make sure that the **Enable configuration backup to the following repository** check box is selected.
3. From the **Backup repository** list, choose a backup repository on which the configuration backup must be stored.
4. In the **Restore points to keep** field, specify the number of restore points that you want to maintain in the backup repository.
5. To create an encrypted backup, select the **Encrypt configuration backup** check box. From the **Password** field, select a password you want to use for encryption. If you have not created a password beforehand, click **Add** or use the **Manage passwords** link to specify a new password. For more information, see [Creating Encrypted Configuration Backups](#).
6. Click **Backup now**.
Veeam Backup & Replication will back up the configuration database and store a new restore point to the selected backup repository.

Creating Encrypted Configuration Backups

Veeam Backup & Replication requires that you encrypt the configuration backup if you have created at least one password in the Password Manager on the backup server.

When you encrypt jobs or tapes with passwords, Veeam Backup & Replication creates a set of keys that are employed in the encryption process. Some encryption keys, for example, storage keys and metakeys, are stored in the configuration database. If a configuration backup was non-encrypted, data from it could be freely restored on any backup server. Encryption keys saved to the configuration database and the content of encrypted files might become accessible for unintended audience.
If the Password Manager contains at least one password, and you do not enable encryption for the configuration backup, Veeam Backup & Replication disables configuration backup. To enable the configuration backup, you must enable encryption in the configuration backup job settings.

After you enable the encryption option, Veeam Backup & Replication will create encrypted configuration backups. Beside encryption keys, the created backups capture credential records specified in the Credentials Manager. When you restore data from such backup, you will not have to enter passwords for credentials records again (unless the passwords for credentials records have changed by the time of restore).

To encrypt the configuration backup:

1. From the main menu, select **Configuration Backup**.
2. Select the **Encrypt configuration backup** check box.
3. From the **Password** field, select a password you want to use for encryption. If you have not created a password beforehand, click **Add** or use the **Manage passwords** link to specify a new password. For more information, see Managing Passwords for Data Encryption.
Restoring Configuration Database

Restore of the configuration database is helpful in the following situations:

- The configuration database got corrupted and you want to recover data from the configuration backup.
- The Microsoft SQL Server on which the configuration database resides got corrupted, and you want to deploy the configuration database on a new Microsoft SQL Server, and restore data from the configuration backup to it.
- You want to roll back the configuration database to a specific point in time.
- You want to restore data to a new configuration database on the same Microsoft SQL server, for example, for testing purposes.

You can restore a configuration backup on the same backup server where the backup was created or on another backup server.

Before you start the restore process, check prerequisites. Then use the Veeam Backup & Replication Configuration Restore wizard to restore the configuration database.

Before You Begin

Before you start the restore process, check the following prerequisites:

- Stop all jobs that are currently running. During restore of configuration, Veeam Backup & Replication temporary stops the Veeam Backup Service and jobs.
- Save registry keys that you changed or created on the backup server. After restore, you will need to recreate or change the keys manually because the configuration database does not store them.
- Check the version of the backup server. On the backup server running Veeam Backup & Replication 10, you can restore configuration backups created with the following product versions: 9.5 Update 4 and 9.5 Update 3.
- Make sure that the certificate chain restored from a configuration backup will successfully pass validation on the target backup server. This precaution is required if the following conditions are met:
  a. You want to restore configuration database of a backup server used in the Veeam Agent management scenario.
  b. The backup server whose configuration database you want to restore uses a custom certificate issued by a Certificate Authority instead of the default self-signed certificate to ensure a secure connection in the Veeam Agent management infrastructure.
- If you plan to restore configuration data to the database on another Microsoft SQL Server, make sure the account for using Veeam Backup & Replication has sufficient permissions. For more information, see Required Permissions.
- [for Veeam Backup for Nutanix AHV users] After you restore the configuration database of Veeam Backup & Replication, you must remove existing AHV backup proxies from Veeam Backup & Replication infrastructure and connect to them again. Otherwise, these AHV backup proxies will not be able to perform backup and restore due to missing authentication certificates. For instructions on how to connect to an existing AHV backup proxy, see the Adding Nutanix AHV Backup Proxy section in the Veeam Backup for Nutanix AHV User Guide.
IMPORTANT!

You can start configuration restore only from the Veeam Backup & Replication console installed locally on the backup server. You cannot start configuration restore from the console installed on a remote machine.
Step 1. Launch Configuration Database Restore Wizard

To launch the Veeam Backup and Replication Configuration Restore wizard, do either one of the following:

- From the main menu of the Veeam Backup & Replication console, select Configuration Backup. In the Restore section, click Restore.
- In the Start menu of the backup server, click Configuration Restore.
- Use the Veeam.Backup.Configuration.Restore.exe file located in the installation folder on the backup server. By default, the path to the folder is the following: %PROGRAMFILES%\Veeam\Backup and Replication\Backup.
- [If the configuration backup is stored on the backup server] In Microsoft Windows Explorer, open the folder where configuration backups are stored (by default, Backup\VeeamConfigBackup\<BackupServerName> on the volume with most disk space on the backup server) and double-click the necessary configuration backup file.
Step 2. Select Restore Mode

At the **Restore Mode** step of the wizard, choose a restore mode that you want to use.

- **Select Restore** if you want to restore data from the configuration backup to the database used by the initial backup server.

  In the Restore mode, Veeam Backup & Replication retrieves configuration data from the backup and stores it to the target database. After that, Veeam Backup & Replication performs additional rescan of VM replicas, backup repositories and tape libraries connected to the backup server. Rescan helps synchronize potential changes between the backup infrastructure and restored database that took place from the moment when the configuration backup was created till the present time. As a result, the target configuration database will contain information about restore points that were created after the configuration backup was taken, and this information is displayed in the Veeam Backup & Replication console.

- **Select Migrate** if you want to restore data from the configuration backup to the database used by another backup server.

  In the Migrate mode, Veeam Backup & Replication retrieves configuration data from the backup and stores it to the target database. No rescan operation is performed.
Step 3. Select Configuration Backup

At the **Configuration Backup** step of the wizard, select a configuration backup from which you want to restore data.

1. From the **Backup repository** list, select a server or backup repository on which the configuration backup file is located.

2. Click **Browse** next to the **Backup file** field and select the backup file.

If you select to restore configuration data from a backup in a remote backup repository, during restore Veeam Backup & Replication will first copy the backup file to a temporary folder on the backup server. After you finish the restore process and close the wizard, Veeam Backup & Replication will automatically delete the configuration file from the temporary folder.

![Configuration Backup Wizard](image)

- **Browse** button: Select the location of the backup file.
- **Configuration Backup** tab: Configure the backup settings.
- **Backup repository** drop-down menu: Select the backup repository.
- **Backup file** field: Enter the path to the backup file.
- **Configuration backup file located in remote backup repositories will be copied locally into a temporary folder. This may take some time.**
Step 4. Review Configuration Backup Parameters

At the **Backup Contents** step of the wizard, Veeam Backup & Replication will analyze the content of the selected backup file and display the following settings:

- **Backup file settings**: settings of the configuration backup file itself.
- **Product settings**: version of Veeam Backup & Replication installed on the initial backup server and configuration database version.
- **List of catalogs**: catalogs storing backup configuration data.

Review the displayed settings and click **Next**.
Step 5. Specify Password

The **Password** step of the wizard is available if you have enabled the encryption option in the configuration backup properties.

Enter the password to decrypt configuration backup data:

1. Check the password hint to recall the password.
2. In the **Password** field, enter the password to decrypt the configuration backup file.

If you have forgotten or lost the password, click the **I forgot the password** link. For more information, see Decrypting Data Without Password.

**NOTE:**

If the backup server is not connected to Veeam Backup Enterprise Manager and does not have the Enterprise or Enterprise Plus license installed, you will not see the **I forgot the password** link and will not be able to restore configuration data without a password.
Step 6. Specify Target Database

At the **Target Database** step of the wizard, specify a target Microsoft SQL server and database to which configuration data must be restored.

1. In the **Database name** field, specify a name of the database to which configuration data must be restored. By default, Veeam Backup & Replication uses the name of the initial database.

   If you specify a name of the database that does not exist, Veeam Backup & Replication will create it on the Microsoft SQL Server.

2. From the **Server name** list, select a Microsoft SQL server on which the database is deployed or must be deployed. In the list of Microsoft SQL Servers Veeam Backup & Replication displays all servers from the network where the backup server resides. To update the list of servers, click **Refresh** on the right.

3. In the **Authentication** section, select the authentication mode to connect to the Microsoft SQL Server instance: **Windows Authentication** or **SQL Server Authentication**. If you select the Microsoft SQL Server authentication mode, specify the user name and password of the account that you want to use. To view the entered password, click and hold the eye icon on the right of the field.

When you restore configuration to an existing database, the configuration restore process will delete the current state of the database contents and replace it with the restored data. Veeam Backup & Replication will display a warning. If you want to replace the contents, click **Yes** to confirm.
If you do not want to lose the current data, restore the configuration to a new database. To do this, click **No** to the warning and specify a non-existing database name in the **Database name** field.
Step 7. Specify Restore Options

At the **Restore Options** step of the wizard, specify additional restore options.

1. In the **Restore** section, select what data you want to restore from the configuration backup.
   Veeam Backup & Replication always restores configuration data for backup infrastructure components, jobs and global settings specified at the level of the backup server. You can additionally restore the following data:
   - **Backup and replica catalog**: data about all backups and replicas registered on the backup server and information about tapes to which backups were written and location of these tapes.
   - **Session history**: data about all sessions performed on the backup server.

2. If you plan to use PowerShell on the restored backup server, select the **Enable required PowerShell policy for SCVMM** check box. During restore, Veeam Backup & Replication will enable the PowerShell execution policy and you will not have to enable it manually afterwards. Enabling this option is identical to running the `Set-ExecutionPolicy RemoteSigned` command on the backup server.

3. If you are restoring configuration data to the same database, select the **Backup existing database before configuration restore** check box. This option will help you protect the current database from accidental errors during the restore process. During restore, Veeam Backup & Replication will first back up the current database using the native tools of Microsoft SQL Server. After that, Veeam Backup & Replication will purge the current database and import data from the configuration backup to it. In such scenario, if an error occurs during the restore process, you will be able to restore the current database from the Microsoft SQL backup using Microsoft SQL Management Studio or SQL scripts.
   
   The created Microsoft SQL database backup is named by the following pattern: `VeeamBackup<DatabaseName><date>.bak` and stored to the default Microsoft SQL backups location, for example: `%ProgramFiles%\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL\Backup\`.

4. Click **Restore**. Veeam Backup & Replication will stop currently running jobs and Veeam Backup & Replication services and will restore the database to the specified location.
Step 8. Review Restore Settings

At the **Restore** step of the wizard, Veeam Backup & Replication will display the progress on the restore process. Wait for the restore process to complete and click **Next**.

If you have chosen to restore data in the Migrate mode and the configuration backup file does not meet the Migrate mode requirements, Veeam Backup & Replication will display a warning and offer you to switch to the Restore mode. The Restore mode requires more time but guarantees that information about all new restore points will be available in the restored database.

- To switch to the **Restore** mode, in the warning window click **Yes**.
- To carry on data restore in the **Migrate** mode, in the warning window click **No**.
- To stop the restore process, in the warning window click **Cancel**.

For more information, see **Migrating Configuration Database**.
Step 9. Finalize Restore Process

After the restore process has finished, you may need to perform the following actions to finalize the configuration database restore:

1. Specify credentials for backup infrastructure objects.
2. Specifying credentials for cloud services.
3. Perform components upgrade.

Specifying Credentials

At the Credentials step of the wizard, Veeam Backup & Replication displays a list of credentials records that existed on the backup server at the time when the configuration backup was created. If by the time of restore passwords for credentials records have changed, you can specify new values for these records.

**IMPORTANT!**

If you have not enabled encryption for configuration backups, Veeam Backup & Replication will not restore passwords for credentials records. You need to re-enter passwords for all credentials records to make sure that backup infrastructure components and jobs work in a proper way after you complete configuration restore.

To edit credentials records:

1. Select a record in the list and click **Edit**.
2. Edit settings of the record as required.
3. Repeat the procedure for all records in the list.
Specifying Cloud Credentials

At the **Cloud Credentials** step of the wizard, Veeam Backup & Replication displays a list of cloud credentials records that existed on the backup server at the time when the configuration backup was created. If by the time of restore passwords for cloud credentials records have changed, you can specify new values for these records.

**IMPORTANT!**

Consider the following:

- If you have not enabled encryption for configuration backups, Veeam Backup & Replication will not restore passwords for cloud credentials records. You need to re-enter passwords for all cloud credentials records to make sure that cloud services and jobs work in a proper way after you complete configuration restore.
- You cannot edit credentials of Microsoft Azure compute accounts in the configuration restore wizard. You can edit Microsoft Azure compute account credentials only after configuration restore in Cloud Credentials Manager. For details, see [Editing and Deleting Credentials Records](#).

To edit cloud credentials records:

1. Select a record in the list and click **Edit**.
2. Edit settings of the record as required.
3. Repeat the procedure for all records in the list.

![Cloud Credentials](image)

Performing Components Upgrade

After the restore process is complete, Veeam Backup & Replication will check if services on backup infrastructure components must be upgraded and display a list of outdated components.
To upgrade backup infrastructure components, select check boxes next to the necessary components and click **Next**. If some component fails to upgrade, you can get back to a previous step of the wizard and repeat the procedure or close the wizard and upgrade the components manually. For more information, see [Server Components Upgrade](#).
Step 10. Synchronize Backups and Tape Libraries

After the configuration database is restored, Veeam Backup & Replication can perform a synchronization operation for backups and replicas created on the backup server and tape libraries connected to the backup server.

- The synchronization operation for backups and replicas is performed if you are restoring a database from a backup created with Veeam Backup & Replication 9.0 in the Restore mode and you have selected to restore data from the backup and replica catalog.

- The synchronization operation for tape libraries is performed if you are restoring a database from a backup created with Veeam Backup & Replication 9.0 in the Restore mode and you have selected to restore data from the backup and replica catalog.

Wait for the synchronization operation to complete.
Step 11. Finish Working with Wizard

At the Summary step of the wizard, finalize the process of configuration data restore.

1. Review the restore process results.

2. If you want to start Veeam Backup & Replication after you finish working with the wizard, select the Launch the Backup & Replication user interface check box.

3. Click Finish to exit the wizard.

NOTE:

Mind the following:

- If you created custom registry keys or changed the existing ones on the backup server, you must recreate or change the registry keys again.

- If you restore data from the configuration backup in the Restore mode, all jobs on the backup server will be disabled after the restore process is complete. You need to enable them manually.
Migrating Configuration Database

Migration of the configuration database is helpful if you need to move the backup server and configuration database to another location, for example, offsite. In this case, you can configure a backup server, deploy a Microsoft SQL Server in the target location and then restore data from the configuration backup to a database on this server. As a result, you will get a “replica” of the backup server without additional adjustments and fine-tuning.

NOTE:
It is recommended that you use Veeam Backup & Replication tools to create configuration backups and migrate the configuration database. If you use native Microsoft SQL Server tools or others, after migration, some information, such as secure configuration data, may not be accessible.

Before You Begin

Before you start the migration process, perform the following tasks:

- Prepare the target backup server.
  Install Veeam Backup & Replication on the machine on which you plan to move your source backup server.

- Stop all running jobs and disable all scheduled jobs on the source backup server before you create the configuration backup.
  Do not start or enable any jobs. If you start a job before migration is completed, Veeam Backup & Replication will produce a new restore point in the chain and update the chain metadata. The created configuration backup will not contain information about this new restore point. When you migrate data from the configuration backup to the database and start the job again, Veeam Backup & Replication will fail to synchronize the chain metadata with data in the database. As a result, the job will fail.

- Save registry keys that you changed or created on the backup server. After the migration, you will need to recreate or change the keys manually because the configuration database does not store them.

Before migrating the configuration backup, Veeam Backup & Replication performs an additional check. If the configuration backup does not meet the requirements, Veeam Backup & Replication will offer you to switch to the Restore mode.

In the Restore mode, Veeam Backup & Replication will rescan VM replicas, backup repositories and tape libraries connected to the backup server. The database will be updated to include information about new restore points, and subsequent job sessions will work in a proper way.

Performing Migration

1. On the target backup server, from the main menu, select Configuration Backup.
2. In the **Restore** section, click **Restore** to launch the **Configuration Database Restore** wizard.

3. At the **Restore Mode** step of the wizard, select **Migrate**.

4. Complete the wizard as described in the **Restoring Configuration Database** section.

5. If you created custom registry keys or changed the existing ones on the previous backup server, you must recreate or change the registry keys again manually on the target backup server.
NOTE:
If you have local repositories, after migration to another VM they may be displayed as empty. In this case, add them again and remap the jobs.
Backup

Veeam Backup & Replication produces image-level backups of VMs. It treats VMs as objects, not as a set of files. When you back up VMs, Veeam Backup & Replication copies a VM image as a whole, at a block level. Image-level backups can be used for different types of restore, including Instant VM Recovery, entire VM restore, VM file recovery, file-level recovery and so on.

The backup technology is typically used for VMs with lower RTOs. When the primary VM fails, you need some time to restore VM data from a compressed and deduplicated backup file.
About Backup

Veeam Backup & Replication is built for virtual environments. It operates at the virtualization layer and uses an image-based approach for VM backup.

Veeam Backup & Replication does not install agent software inside the VM guest OS to retrieve VM data. To back up VMs, Veeam Backup & Replication leverages Microsoft VSS snapshot and checkpoint capabilities. When you back up a VM, Veeam Backup & Replication instructs Microsoft Hyper-V to create a cohesive point-in-time copy of a VM. Veeam Backup & Replication uses this point-in-time copy as a source of data for backup.

Veeam Backup & Replication copies VM data from the source volume at a block level. It retrieves VM data, compresses and deduplicates it, and stores in backup files in the backup repository in Veeam proprietary format.

In Veeam Backup & Replication, backup is a job-driven process. To perform backup, you need to configure backup jobs. A backup job is a configuration unit of the backup activity. The backup job defines when, what, how and where to back up. One backup job can be used to process one or several VMs. You can instruct Veeam Backup & Replication to run jobs automatically by schedule or start them manually.

The first backup job session always produces a full backup of the VM image. Subsequent backup job sessions are incremental — Veeam Backup & Replication copies only those data blocks that have changed since the last backup job session. To keep track of changed data blocks, Veeam Backup & Replication uses different approaches. For more information, see Changed Block Tracking.
How Backup Works

Veeam Backup & Replication performs VM backup in the following way:

1. When a new backup job session starts, Veeam Backup & Replication starts the Veeam Backup Manager process on the backup server. Veeam Backup Manager reads job settings from the configuration database and creates a list of VM tasks to process. For every disk of VMs added to the job, Veeam Backup & Replication creates a new task.

2. Veeam Backup Manager connects to the Veeam Backup Service. The Veeam Backup Service includes a resource scheduling component that manages all tasks and resources in the backup infrastructure. The resource scheduler checks what backup infrastructure resources are available, and assigns backup proxies and backup repositories to process job tasks.

3. Veeam Backup Manager connects to Veeam Transport Services on the target repository and backup proxy (on-host or off-host). The Veeam Transport Services, in their turn, start Veeam Data Movers. A new instance of Veeam Data Mover is started for every task that the backup proxy is processing.

4. Veeam Backup Manager establishes a connection with Veeam Data Movers on the backup repository and backup proxy, and sets a number of rules for data transfer, such as network traffic throttling rules and so on.

5. Veeam Data Movers on the backup proxy and backup repository establish a connection with each other for data transfer.

6. Veeam Backup Manager queries information about VMs and virtualization hosts from Microsoft Hyper-V.

7. If application-aware image processing is enabled for the job, Veeam Backup & Replication connects to VM guest OSes, deploys runtime processes on VM guest OSes and performs in-guest processing tasks.

8. Veeam Backup & Replication requests Microsoft Hyper-V VSS to create a cohesive point-in-time copy of a VM. Microsoft Hyper-V VSS creates a volume snapshot or VM checkpoint, depending on the hypervisor version.

9. The source Veeam Data Mover reads the VM data from the volume snapshot or VM checkpoint and transfers the data to the backup repository in one of transport modes. During incremental job sessions, the source Veeam Data Mover uses CBT to retrieve only those data blocks that have changed since the previous job session. If CBT is not available, the source Veeam Data Mover interacts with the target Veeam Data Mover on the backup repository to obtain backup metadata, and uses this metadata to detect blocks that have changed since the previous job session.

While transporting VM data, the source Veeam Data Mover performs additional processing. It filters out zero data blocks, blocks of swap files and blocks of excluded VM guest OS files. The source Veeam Data Mover compresses VM data and transports it to the target Veeam Data Mover.
10. After the backup proxy finishes reading VM data, Veeam Backup & Replication requests Microsoft Hyper-V VSS to perform cleanup operations.
Backup Architecture

Veeam Backup & Replication uses the following components for the backup process:

- One or more source hosts with associated volumes
- [Optional] Off-host backup proxy
- Backup repository
- [Optional] One or more guest interaction proxies
- [For shared folder backup repository] Gateway server

All backup infrastructure components engaged in the job make up a data pipe. The source host and backup repository produce two terminal points for the data flow. Veeam Backup & Replication processes VM data in multiple cycles, moving VM data over the data pipe block by block.

Veeam Backup & Replication collects VM data, transforms and transports it to target with the help of Veeam Data Movers. Veeam Backup & Replication uses two-service architecture – one Veeam Data Mover controls interaction with the source host, and the other one controls interaction with the backup repository. The Veeam Data Movers communicate with each other and maintain a stable connection.

When a new backup session starts, Veeam Backup & Replication performs the following actions:

1. Veeam Backup & Replication deploys runtime processes on VM guest OSes via the guest interaction proxy (for Microsoft Windows VMs) or backup server (for VMs with other OSes).
2. The target-side Veeam Data Mover obtains job instructions and communicates with the source-side Veeam Data Mover to begin data collection.
3. The source-side Veeam Data Mover copies VM data from the volume shadow copy or VM checkpoint. During incremental job runs, the source-side Veeam Data Mover retrieves only those data blocks that have changed since the previous job session.
   
   While copying, the source-side Veeam Data Mover performs additional data processing. It filters out zero data blocks, blocks of swap files and blocks of excluded VM guest OS files, compresses and deduplicates VM data blocks and moves them to the target-side Data Mover Service.
4. The target-side Veeam Data Mover deduplicates similar blocks of data on the target side and writes the result to the backup file in the backup repository.
Onsite Backup

When you back up to a Microsoft Windows or Linux backup repository in the local site, Veeam Backup & Replication starts the target-side Veeam Data Mover on the Microsoft Windows or Linux repository. The source-side Veeam Data Mover can be hosted on the source host or on a dedicated off-host backup proxy, depending on the backup mode you use (on-host or off-host). VM data is sent from the source host to the backup repository over the LAN.

To back up to a shared folder backup repository in the local site, you need to deploy a gateway server that has access to the shared folder backup repository. You can assign the role of a gateway server to the backup server itself or any Microsoft Windows machine added to the backup infrastructure. In this scenario, Veeam Backup & Replication starts the target-side Veeam Data Mover on the gateway server. The source-side Veeam Data Mover can be hosted on the source host or on a dedicated off-host backup proxy, depending on the backup mode you use (on-host or off-host).
If you choose to back up VMs to a shared folder backup repository and do not specify a gateway server explicitly, Veeam Backup & Replication starts the source-side and target-side Veeam Data Movers on the backup proxy. In the on-host backup scenario, Veeam Data Movers are started on the source Microsoft Hyper-V host. In the off-host backup scenario, Veeam Data Movers are started on the off-host backup proxy.

Offsite Backup

The common requirement for offsite backup is that one Veeam Data Mover runs in the production site, closer to the source volume, and the other Veeam Data Mover runs in the remote target site, closer to the backup repository. During backup, Veeam Data Movers maintain a stable connection, which allows for uninterrupted operation over WAN or slow links.

If you choose to back up to a Microsoft Windows or Linux repository in the remote site, Veeam Backup & Replication starts the target-side Veeam Data Mover on the Microsoft Windows or Linux repository. The source-side Veeam Data Mover can be hosted on the source host or on a dedicated off-host backup proxy, depending on the backup mode you use (on-host or off-host). VM data is sent from the source to the backup repository over the WAN.
If you choose to back up to a shared folder backup repository in the on-host mode, you must deploy a gateway server in the remote site and point the shared folder backup repository at this gateway server. In this scenario, Veeam Backup & Replication starts the target-side Veeam Data Mover on the gateway server. The source-side Veeam Data Mover can be hosted on the source host or on a dedicated off-host backup proxy in the source site, depending on the backup mode you use (on-host or off-host).
Backup of VMs on Local Storage and CSV

For backup of VMs on local storage and CSV, Veeam Backup & Replication leverages the Microsoft VSS framework and Microsoft Hyper-V VSS components. Veeam Backup & Replication acts as a Microsoft VSS requestor and communicates with the Microsoft VSS framework. It obtains information about available Microsoft VSS components from Microsoft VSS, prescribes what components Microsoft VSS must use, identifies volumes where VM files are located, and triggers the Microsoft VSS coordinator to create volume snapshots.

Before a snapshot of a volume is created, VMs on the volume must be quiesced: there must remain no incomplete transactions, open files and so on. Veeam Backup & Replication uses three methods to prepare Microsoft Hyper-V VMs for backup:

- **Online backup** (also known as Child VM Snapshot method) — native Microsoft Hyper-V mechanism that allows you to create an application-consistent image of running VMs without any downtime.
- **Offline backup** (also known as Saved State method) — native Microsoft Hyper-V mechanism that requires some VM downtime. To quiesce guest OS operations for a VM, Microsoft Hyper-V brings the VM to the save state (hibernates it).
  
  Offline backup is not applicable to VMs registered on Microsoft Hyper-V Server 2016.
- **Crash-consistent backup** — Veeam's proprietary mechanism that allows you to create a crash-consistent VM backup. During crash-consistent backup, VMs are not brought to the saved state.

Whenever possible, Veeam Backup & Replication uses online backup to quiesce VMs. If online backup cannot be performed, Veeam Backup & Replication employs one of the other two methods to prepare a VM for backup.

- If online backup is cannot be performed, Veeam Backup & Replication fails over to the crash-consistent backup.
- If you do not want to produce a crash-consistent backup, you can instruct Veeam Backup & Replication to use the offline backup method.

**NOTE:**

Veeam Backup & Replication does not fail over to the crash-consistent backup mode if you enable application-aware processing for a job and enable the **Require successful processing** option. In such situation, if application-aware processing fails, Veeam Backup & Replication will terminate the job with the **Error** status.

**Online Backup**

Online backup is the recommended backup method for Microsoft Hyper-V VMs. This type of backup requires no downtime. VMs remain running for the whole period of backup, and users can access them without any interruption.

Online backup can be performed if Microsoft Hyper-V VMs meets a number of requirements. For more information, see **Microsoft Hyper-V documentation**.

The procedure of online backup depends on the Microsoft Hyper-V Server version:

- **Microsoft Hyper-V Server 2008 R2 and 2012**
- **Microsoft Hyper-V Server 2012 R2**
- **Microsoft Hyper-V Server 2016 and later**
Microsoft Hyper-V Server 2008 R2 and 2012

For online backup of VMs on Microsoft Hyper-V Server 2008 R2 and 2012, Veeam Backup & Replication uses a native Microsoft Hyper-V approach. To quiesce VM data, Microsoft Hyper-V employs two Microsoft VSS frameworks that work at two different levels and communicate with each other:

- Microsoft VSS framework inside the VM guest OS. This framework is responsible for quiescing data of Microsoft VSS-aware applications inside the VM and creating a snapshot inside the VM guest OS. This snapshot is known as internal snapshot.

- Microsoft VSS framework at the Microsoft Hyper-V host level. This framework is responsible for creating a snapshot of a volume on which VM disks are located. This snapshot is known as external snapshot.

Online backup for VMs on Microsoft Hyper-V Server 2008 R2 and 2012 is performed in the following way:

1. Veeam Backup & Replication interacts with the Microsoft Hyper-V host VSS Service and requests backup of a specific VM.
2. The Microsoft VSS Writer on the Microsoft Hyper-V host passes the request to the Microsoft Hyper-V Integration Components (HV-IC) installed inside the VM guest OS.
3. The HV-IC acts as a VSS Requestor for the framework inside the VM. It communicates with this framework and requests backup of Microsoft VSS-aware applications running on the VM.
4. VSS Writers for Microsoft VSS-aware applications on the VM are instructed to quiesce application data.
5. After the applications are quiesced, the framework inside the VM takes an internal snapshot using a Microsoft VSS software provider in the VM guest OS.
6. The VM returns from the read-only state to the read-write state, and operations inside the VM are resumed. The created snapshot is passed to the HV-IC.
7. The HV-IC notifies the hypervisor that the VM is ready for backup.
8. The Microsoft Hyper-V host VSS provider takes a snapshot of a volume on which VM disks are located (external snapshot). After that, Microsoft VSS triggers the auto-recovery process. For more information, see Auto-Recovery.
9. The volume snapshot is presented to Veeam Backup & Replication. Veeam Backup & Replication reads VM data from the volume snapshot in one of two backup modes — on-host backup or off-host backup.
10. After the backup is complete, the volume snapshot is deleted.

Auto-Recovery

Internal and external snapshots are taken one after another, with a little time difference. During this time interval, the VM on the volume is not frozen — its applications and OS are working as usual. For this reason, when the external snapshot is created, there may remain unfinished application transactions inside the VM, and this data can be lost during backup.

To make sure the VM data is consistent at the moment of backup, Microsoft Hyper-V VSS Writer performs additional processing inside the created external snapshot. This process is also known as auto-recovery.

Auto-recovery is performed after a volume snapshot is taken. The auto-recovery process is performed in the following way:

1. Right after the snapshot of a volume is taken, Microsoft Hyper-V host VSS allows the Microsoft Hyper-V host VSS Writer time to update data inside the external snapshot, before it is permanently put to the read-only state.

2. The volume snapshot is temporarily mounted to the Microsoft Hyper-V host as a new volume with the read-write access.

3. The Microsoft Hyper-V host VSS Writer rolls back a VM on the external snapshot to the state of the internal snapshot. All changes that took place after the internal snapshot was taken are discarded. This way, VM data inside the external snapshot is brought to a completely consistent state.

   At the same time, the internal snapshot inside the VM guest OS is deleted.

As a result, you have a VM on the production volume, and a consistent volume snapshot that Veeam Backup & Replication can use for backup.

**NOTE:**

Auto-recovery may take up to several minutes.
Microsoft Hyper-V Server 2012 R2

For backup of VMs on Microsoft Hyper-V Server 2012 R2, Microsoft VSS uses backup and auto-recovery checkpoints.

To quiesce VM data, Veeam Backup & Replication leverages two Microsoft VSS frameworks that work at two different levels and communicate with each other:

- Microsoft VSS framework inside the VM guest OS. This framework is responsible for quiescing data of Microsoft VSS-aware applications inside the VM and creating a snapshot inside the VM guest OS.
- Microsoft VSS framework at the Microsoft Hyper-V host level. This framework is responsible for creating a snapshot of a volume on which VM disks are located.

Online backup for VMs on Microsoft Hyper-V 2012 R2 is performed in the following way:

1. Veeam Backup & Replication interacts with the Microsoft Hyper-V host VSS Service and requests backup of a specific VM.
2. The Microsoft VSS Writer on the Microsoft Hyper-V host passes the request to the Microsoft Hyper-V Integration Components (HV-IC) installed inside the VM guest OS.
3. The HV-IC acts as a VSS Requestor for the framework inside the VM. It communicates with this framework and requests backup of Microsoft VSS-aware applications running on the VM.
4. VSS Writers for Microsoft VSS-aware applications on the VM are instructed to quiesce application data.
5. After the applications are quiesced, Microsoft Hyper-V VSS takes a backup checkpoint of the VM. Every virtual disk of a VM receives a temporary file named as `vm_disk_name_GUID.avhdx`. For example, the name of the received file can be: `disk_1_A1C3FDA5-5DFE-4001-A6D7-EBE18195A85C.avhdx`. All new writes that occur to the VM until the volume snapshot is taken are redirected to this file.
6. Right after taking the backup checkpoint, Microsoft Hyper-V VSS takes another auxiliary checkpoint — auto-recovery checkpoint. Every virtual disk of a VM receives a temporary file named as `vm_disk_name-AutoRecovery.avhdx`. For example, the name of the received file can be: `disk_1-AutoRecovery.avhdx`. The auto-recovery checkpoint helps make sure that VM data is consistent during backup.
   
   The auto-recovery checkpoint does not depend on the backup checkpoint — it is taken independently in a new checkpoint chain.
7. The framework inside the VM takes an internal snapshot using a Microsoft Hyper-V Integration Services Shadow Copy provider in the VM guest OS.
8. The created internal snapshot is passed to the HV-IC.
9. The HV-IC notifies the hypervisor that the VM is ready for backup.
10. Microsoft Hyper-V VSS performs auto-recovery — it mounts the auto-recovery checkpoint to the VM, rolls back data on the VM to the consistent state.
11. The Microsoft Hyper-V host VSS provider takes a snapshot of a volume on which VM disks are located (external snapshot).
12. The auto-recovery checkpoint is merged with the original VM.
13. The volume snapshot is presented to Veeam Backup & Replication. Veeam Backup & Replication reads VM data from the volume snapshot in one of two backup modes — on-host backup or off-host backup.
14. After the backup is complete, the volume snapshot is deleted, and the backup checkpoint is merged with the original VM.
Microsoft Hyper-V Server 2016 and later

Online backup of VMs on Microsoft Hyper-V 2016 relies on production checkpoints.

Production checkpoints are point-in-time images of VMs. When producing production checkpoints, Microsoft Hyper-V does not put VMs to the saved state. Instead, it quiesces data on VMs with the help of the Microsoft VSS technology (for Microsoft Windows VMs) or file system freeze (for Linux VMs). The resulting checkpoints are application-consistent, so you can recover VMs without any data loss.

Veeam Backup & Replication performs online backup with the help of production checkpoints only if the following conditions are met:

- VM configuration version is upgraded to 8.x.
- VMs are deployed on Microsoft Hyper-V Server 2016
- [For Microsoft Hyper-V clusters] All hosts in the cluster are upgraded to Microsoft Hyper-V Server 2016 and the cluster functional level is upgraded.

Online backup is performed in the following way:

1. Veeam Backup & Replication requests a production checkpoint of a specific VM.
2. Microsoft Hyper-V Virtual Machine Management Service (for Microsoft Windows VMs) or file system freeze (for Linux VMs) brings data on the VM guest OS to a consistent state.
3. Microsoft Hyper-V Virtual Machine Management Service creates a production checkpoint for the VM. Every virtual disk of a VM receives a temporary AVHDX file. All new writes are redirected to temporary AVHDX files.
4. Further activities depend on the backup mode:
   - In the onhost backup mode, Veeam Backup & Replication reads data from VM disks in the read-only state. After the VM processing completes, the production checkpoint is merged with the original VM.
In the offhost backup mode, the Microsoft Hyper-V host VSS provider takes a snapshot of a volume on which VM disks are located. The volume snapshot is mounted to the offhost backup proxy and presented to Veeam Backup & Replication. Veeam Backup & Replication reads VM data from the volume snapshot. After the VM processing completes, the production checkpoint is merged with the original VM. When all VMs in the group for which the volume snapshot is created are processed, Veeam Backup & Replication triggers volume snapshot deletion.

Offline Backup

Offline backup (or saved state backup) is a native Microsoft Hyper-V approach to quiesce VMs before taking a volume snapshot. This type of backup requires some downtime of a VM. When a VM is backed up, the Microsoft Hyper-V VSS Writer forces the VM into the saved state (hibernates it) to create a stable system image.

**NOTE:**
Offline backup is not applicable to VMs registered on Microsoft Hyper-V Server 2016.

Offline backup is performed in the following way:

1. Veeam Backup & Replication interacts with the Microsoft Hyper-V host VSS Services and requests backup of a specific VM.
2. The Microsoft Hyper-V host VSS Writer forces a VM into the saved state for several seconds. The VM OS hibernates, and the content of the system memory and CPU is written to a dump file.
3. The Hyper-V host VSS provider takes a snapshot of a volume on which VM disks are located. The VM returns to the normal state.
4. The volume snapshot is presented to Veeam Backup & Replication. Veeam Backup & Replication reads VM data from the volume snapshot in one of two backup modes — on-host backup or off-host backup. After the backup is complete, the volume snapshot is deleted.
In the production environment, offline backup may be inappropriate. It implies VM downtime and does not produce transactionally consistent backups and replicas as data on the VM is not quiesced before a volume snapshot is taken. As an alternative to offline backup, Veeam Backup & Replication offers the crash-consistent backup method for those cases when online backup cannot be used, and offline backup is inappropriate.

### Crash-Consistent Backup

Crash-consistent backup is Veeam’s proprietary method of creating crash-consistent VM images. A crash-consistent image can be compared to the state of a VM that has been manually reset. Unlike offline backup, crash-consistent backup does not require any downtime of a VM.

**IMPORTANT!**

Crash-consistent backup does not preserve data integrity of open files of transactional applications on the VM guest OS and may result in data loss.

The procedure of crash-consistent backup depends on the Microsoft Hyper-V Server version:

- **Microsoft Hyper-V Server 2012 R2 and earlier**
- **Microsoft Hyper-V Server 2016 and later**

### Microsoft Hyper-V Server 2012 R2 and Earlier

Crash-consistent backup is performed in the following way:

1. Veeam Backup & Replication interacts with the Hyper-V host VSS Services and requests backup of a specific VM.
2. The Hyper-V host VSS Writer notifies the VSS provider that volume snapshots can be taken.
3. The Hyper-V host VSS provider creates a snapshot of the requested volume.
4. The volume snapshot is presented to Veeam Backup & Replication. Veeam Backup & Replication reads VM files from the volume snapshot using one of two backup modes — on-host backup or off-host backup. After the backup is completed, the snapshot is deleted.

**Microsoft Hyper-V Server 2016 and Later**

Crash-consistent backup of VMs on Microsoft Hyper-V 2016 and later versions relies on standard checkpoints. Crash-consistent backup is performed in the following way:

1. Veeam Backup & Replication requests a standard checkpoint of a specific VM.
2. Further activities depend on the backup mode:
   - In the onhost backup mode, Veeam Backup & Replication reads data from VM disks in the read-only state. After the VM processing completes, the standard checkpoint is merged with the original VM.
- In the offhost backup mode, the Microsoft Hyper-V host VSS provider takes a snapshot of a volume on which VM disks are located.

The volume snapshot is mounted to the offhost backup proxy and presented to Veeam Backup & Replication. Veeam Backup & Replication reads VM data from the volume snapshot. After the backup job completes, the volume snapshot and checkpoint are deleted.

Backup Modes

Veeam Backup & Replication offers two modes for processing VM data — on-host backup and off-host backup. The difference between the two modes lies in the location where VM data is processed.

On-Host Backup

During on-host backup, VM data is processed on the source Microsoft Hyper-V host where VMs that you want to back up or replicate reside. All processing operations are performed directly on the source host that performs the role of the backup proxy. For this reason, on-host backup may result in high CPU usage and network overhead on the host system.

NOTE:

The procedure below describes the backup process for Microsoft Hyper-V Server 2012 R2 and earlier. For more information about backup of VMs registered on Microsoft Hyper-V 2016 and later versions, see Online Backup and Crash-Consistent Backup.

The on-host backup process is performed in the following way:

1. Veeam Backup & Replication triggers a snapshot of the necessary volume.
2. The Veeam Data Mover on the host uses the created volume snapshot to retrieve VM data; it processes the VM data and copies it to the destination.
3. After the backup process is complete, the volume snapshot is deleted.

Assigning Role of On-Host Backup Proxy in CSV

The role of the backup proxy is assigned to a Microsoft Hyper-V host in CSV by the following rules:

- If you back up or replicate VMs whose disks are located on a CSV in Microsoft Hyper-V Server 2012 or 2012 R2, and Microsoft CSV Software Shadow Copy Provider is used for snapshot creating, Veeam Backup & Replication assigns the role of an on-host backup proxy to the host owning the CSV. If VM disks are located on different CSV’s, Veeam Backup & Replication may use several on-host backup proxies, which are the corresponding hosts owning CSV’s.

- In case you perform backup or replication of VMs whose disks are located on a CSV in Microsoft Hyper-V 2008 R2, and a VSS software or hardware provider is used for snapshot creation, Veeam Backup & Replication assigns the role of an on-host backup proxy to the host on which the processed VM is registered.

Off-Host Backup

In the off-host backup mode, backup processing is shifted from the source Microsoft Hyper-V host to a dedicated machine — an off-host backup proxy.

The off-host backup proxy acts as a “data mover”. The Veeam Data Mover running on the off-host backup proxy retrieves VM data from the source volume, processes it and transfers data to the destination. This type of backup does not impose load on the source host. As resource intensive data processing operations are performed on the off-host backup proxy, production hosts remain unaffected.

To perform off-host backup, Veeam Backup & Replication uses transportable shadow copies. The transportable shadow copy technology lets the backup application create a snapshot of a data volume on which VM disks are located, and import, or mount, this snapshot onto another server in the same subsystem (SAN) for backup and other purposes. The transport process is accomplished in a few minutes, regardless of the amount of the data. The process is performed at the SAN storage layer so it does not impact host CPU usage or network performance. For more information about transportable shadow copies, see Microsoft Docs.

To perform off-host backup, the backup infrastructure must meet the following requirements:

- You must configure an off-host backup proxy. For more information, see Off-Host Backup Proxy.
• In the properties of a backup or replication job, you must select the off-host backup method and off-host backup proxy that you want to use. If necessary, you can point the job to a specific off-host backup proxy. For more information, see Configuring Advanced Options for Off-Host Backup Proxies.

The off-host backup process is performed in the following way:

1. Veeam Backup & Replication triggers a snapshot of the necessary volume on the Microsoft Hyper-V host.
2. The created snapshot is detached from the host and mounted to the off-host backup proxy.
3. The Veeam Data Mover running on the off-host backup proxy uses the mounted volume snapshot as a data source. It retrieves VM data from the volume snapshot, processes it and transports data to the destination.
4. After the backup process is complete, the snapshot is dismounted from the off-host backup proxy and deleted on the storage system.

**IMPORTANT!**

If you plan to perform off-host backup for a Microsoft Hyper-V cluster with CSV, make sure you deploy an off-host backup proxy on a host that is NOT a part of a Hyper-V cluster.

When a volume snapshot is created, this snapshot has the same LUN signature as the original volume. Microsoft Cluster Services do not support LUNs with duplicate signatures and partition layout. For this reason, volume snapshots must be transported to an off-host backup proxy outside the cluster. If the off-host backup proxy is deployed on a node of a Microsoft Hyper-V cluster, a duplicate LUN signature will be generated, and the cluster will fail during backup or replication.

**Helpful Resources**


- Links to resources and documentation from some of storage vendors:
  - HPE Support Center: [https://support.hpe.com/support/home](https://support.hpe.com/support/home).
Choosing VSS Provider (Microsoft Hyper-V Server 2012 R2 and Earlier)

Before you configure backup jobs, it is recommended that you decide what VSS provider will be used to create and maintain volume shadow copies.

By default, Veeam Backup & Replication automatically selects a VSS provider on every volume. Every 4 hours it rescans all Microsoft Hyper-V hosts added to the backup infrastructure and updates information about connected volumes. Veeam Backup & Replication also collects information about software and hardware VSS providers available on every volume.

If hardware providers are available, Veeam Backup & Replication selects a hardware provider to create volume shadow copies on a volume. If no hardware providers are installed, Veeam Backup & Replication selects the VSS system software provider. If necessary, however, you can assign a VSS provider on every volume manually.

If both software and hardware providers are available for a volume, it is recommended that you select a hardware provider. Although software providers are generally applicable to a wider range of storage platforms, they have a number of limitations:

- Software providers do not support transportable volume shadow copies and cannot be used for off-host backup.
- By default, jobs working with the same volume can take up to 4 snapshots of a volume simultaneously. If necessary, the number of snapshots can be increased.
- Hardware providers operate at the storage system controller level. Software providers operate at the software level, between the file system and the volume manager, and can cause a significant performance overhead on the source host.
- [For Microsoft Windows Server 2008 R2] Hardware providers can work with several snapshots simultaneously. That is, if you have several jobs that work with the same volume, you can run them in parallel. If you use a software provider, Veeam Backup & Replication serializes VM processing. You will not be able to start several jobs working with the same volume simultaneously. The volume on which VM disks reside remains locked by one job for the whole period of data processing. After the job completes, the volume becomes accessible for other jobs.
  - If a hardware provider is used to take a snapshot in such case, the CSV stays in the redirected mode while the snapshot is taken. After a volume shadow copy is created, the CSV resumes direct I/O.
- [For Microsoft Windows Server 2008 R2] Software providers are not suitable for backup on CSVs — a significant backup window is required to back up VMs that reside on the same volume but are registered on different hosts. When a cluster node initiates a snapshot on a CSV, the CSV is switched to the Backup in Progress, Redirected Access mode.
  - If a software provider is used to take a snapshot, the CSV stays in the redirected mode until the backup process completes. If large virtual disks are processed, backup time can be significant.

To get detailed information, contact your storage vendor.
Backup of VMs on Microsoft SMB3

Microsoft Hyper-V provides the ability to store VM files on SMB3 file shares. Veeam Backup & Replication works with both standalone and clustered SMB3 servers. It supports VMs whose VM disks are located on SMB3 shares and lets you perform backup, replication and file copy operations for such VMs without taking VMs offline.

The procedure of backup depends on the Microsoft Hyper-V Server version:

- Microsoft Hyper-V Server 2012 R2 and earlier
- Microsoft Hyper-V Server 2016

Microsoft Hyper-V Server 2012 R2 and Earlier

In general, VM quiescence and backup or replication of VMs on SMB3 shares is similar to backup or replication of VMs hosted on local storage and CSV. However, SMB3 brings in some specifics.

If you want to work with SMB3 shares in Veeam Backup & Replication, the backup infrastructure must meet the following requirements:

- SMB3 shares must be properly configured. For a full list of requirements for SMB3 shares, see the Requirements and supported configurations section at Microsoft Docs.
- An SMB3 server or SMB3 cluster hosting the necessary file shares must be added to the backup infrastructure. Otherwise Veeam Backup & Replication will not be able to use changed block tracking for VMs residing on SMB3 shares.
- VMs must not be located on hidden shares or default shares like C$ or D$. When rescanning SMB v3 file shares, Veeam Backup & Replication skips these types of shares.

Microsoft Hyper-V Server 2016 and Later

For backup of VMs registered on Microsoft Hyper-V Server 2016 and later versions, Veeam Backup & Replication uses a new mechanism based on production checkpoints. For more information, see Backup of VMs on Microsoft Hyper-V Server 2016.

If you plan to process VMs whose disks reside on SMB3 shared folders registered on Microsoft Hyper-V Server 2016 or later, it is not obligatory to add the SMB3 server to the backup infrastructure. However, if you do not add the SMB3 server, you will not be able to specify the Max snapshots and latency control settings for SMB3 shared folders.

The mentioned above applies for SMB3 shares running on Microsoft Windows or any other non-Windows based SMB3 source.

For more information, see Adding Microsoft SMB3 Servers.

Backup Process (Microsoft Hyper-V 2012 R2 and Earlier)

For backup and replication of VMs that reside on SMB3 shares, Veeam Backup & Replication uses a native Hyper-V approach utilizing the Microsoft VSS framework. Veeam Backup & Replication acts as a VSS requestor: it communicates with the VSS framework and triggers a shadow copy of the necessary file share. The Microsoft VSS components create a file share shadow copy and present it to Veeam Backup & Replication that uses this shadow copy as a source for backup.
To properly quiesce VMs on SMB3 shares, Microsoft Hyper-V uses three VSS frameworks. These frameworks work at the level of the Hyper-V host and at the level of the SMB3 file server and communicate with each other:

- **VSS framework on the Microsoft Hyper-V host** (Hyper-V Host VSS). When Veeam Backup & Replication starts the backup or replication process, it communicates directly with the VSS framework on the Microsoft Hyper-V host where VMs are registered. The Hyper-V host VSS Service initiates creation of the file share shadow copy, freezes VM application writes, and passes the request for shadow copy to the VSS for SMB File Shares framework. After the shadow copy is created, the Microsoft Hyper-V host VSS Service returns a path to the shadow copy to Veeam Backup & Replication.

- **VSS for SMB File Shares**. This framework is Microsoft's extension to its VSS framework. VSS for SMB File Shares provides application-consistent shadow copies of VMs on SMB3 network shares. To work with shadow copies of file shares, VSS for SMB File Shares uses two components:
  - File Share Shadow Copy Provider is a VSS provider for SMB3. The File Share Shadow Copy Provider is invoked on the Microsoft Hyper-V host where VMs are registered. The provider uses VSS APIs to interact with the VSS requestor, File Share Shadow Copy Agent and request creation of file shares shadow copies.
  - File Share Shadow Copy Agent is a VSS requestor for SMB3. The File Share Shadow Copy Agent is invoked on the SMB3 file server. The agent interacts with the local VSS framework on the SMB3 file server to create a shadow copy of the requested file share.

- **Local VSS framework on the SMB3 file server**. This framework is responsible for creating a shadow copy of the volume on which the file share is located, and exposing the shadow copy as a file share on the SMB3 server.

Backup of VMs on SMB3 shares is performed in the following way:

1. Veeam Backup & Replication interacts with the Microsoft Hyper-V host VSS Service and requests a shadow copy of the necessary file share.
2. The Hyper-V host VSS Service sends a request to create a shadow copy to the Microsoft Hyper-V host VSS Writer. The Microsoft Hyper-V host VSS Writer flushes buffers and holds application writes on VMs.
3. The Microsoft Hyper-V host VSS Service sends a request for shadow copy creation to the File Share Shadow Copy Provider invoked on the Hyper-V host.
4. The File Share Shadow Copy Provider relays the request to the File Share Shadow Copy Agent invoked on the SMB3 file server hosting the necessary file share.
5. The File Share Shadow Copy Agent triggers a request for shadow copy creation to the local VSS on the SMB3 file server.
6. The local VSS on the SMB3 file server uses the necessary shadow copy provider to create a shadow copy of the volume on which the necessary file share is located. The shadow copy is exposed as a file share on the SMB3 server. After that, application writes on VMs located on the original file share are resumed.
7. The File Share Shadow Copy Agent returns a path to the shadow copy to the File Share Shadow Copy Provider.

8. The File Share Shadow Copy Provider communicates this information to the Microsoft Hyper-V host VSS Service.

9. Veeam Backup & Replication retrieves information about the shadow copy properties from the Microsoft Hyper-V host VSS Service.

10. Veeam Backup & Replication uses the created shadow copy as a source for backup. After backup is complete, the file share shadow copy is deleted.

For more information, see Microsoft Docs.

**Backup Modes (Microsoft Hyper-V 2012 R2 and Earlier)**

Veeam Backup & Replication offers two modes for processing VMs on SMB3 shares: on-host backup and off-host backup.

**On-Host Backup**

On-host backup of VMs on SMB3 shares is similar to on-host backup of VMs on local storage and CSV. During on-host backup, Microsoft VSS components, File Share Shadow Copy Provider and Veeam Data Mover are invoked on the source host. The File Share Shadow Copy Agent is invoked on the SMB3 server. As a result, all data processing is accomplished directly on the source Microsoft Hyper-V host and on the SMB3 server.

The on-host backup process includes the following steps:

1. Veeam Backup & Replication triggers a shadow copy of the necessary file share. Microsoft VSS components invoked on the source host and SMB3 server create a shadow copy of the volume on which the requested file share is located, and expose the shadow copy as a file share on the SMB3 server.

2. The Veeam Data Mover on the source host accesses the shadow copy file share exposed on the SMB3 server. Veeam Backup & Replication retrieves VM data from the shadow copy, processes it and copies data to the destination.
3. After the backup process is complete, the shadow copy is deleted.

Off-Host Backup

In general, off-host backup for VMs on SMB3 shares is similar to off-host backup of VMs on local storage or CSV. During off-host backup, Microsoft VSS processing operations are shifted from the source host to a dedicated machine — off-host backup proxy. The Veeam Data Mover is deployed on the off-host backup proxy, instead of the source host.

If you want to perform off-host backup, the backup infrastructure must meet the following requirements:

- You must configure an off-host backup proxy. For more information, see Off-Host Backup Proxy.
- In the properties of a backup or replication job, you must select the off-host backup method and off-host backup proxy that you want to use. If necessary, you can point the job to a specific off-host backup proxy. For more information, see Configuring Advanced Options for Off-Host Backup Proxies.
- The LocalSystem account of the off-host backup proxy must have read access permissions on the SMB3 file share.
- The off-host backup proxy must be located in the same domain where the SMB3 server resides. Alternatively, the domain where the SMB3 server resides must be trusted by the domain in which the off-host backup proxy is located.

The off-host backup process is performed in the following way:

1. Veeam Backup & Replication triggers a shadow copy of the necessary file share. Microsoft VSS components invoked on the source host and SMB3 server create a shadow copy of the volume on which the requested file share is located, and expose the shadow copy as a file share on the SMB3 server.
2. The Veeam Data Mover on the off-host backup proxy accesses the shadow copy on the SMB3 server. It retrieves VM data from the shadow copy, processes it and copies data to the destination.
3. After the backup process is complete, the shadow copy is deleted.
Backup of VMs on Microsoft Hyper-V 2016 or Later

Veeam Backup & Replication has the following limitations for work with Microsoft Hyper-V 2016 or later:

- Veeam Backup & Replication does not support processing of VMs with shared VHDX disks that are registered on Microsoft Hyper-V 2016 or later. You must change the disk format to VHD Set (VHDS).

- If Microsoft Hyper-V Server 2016 or later and hosts of lower versions are added to the same cluster, Veeam Backup & Replication will not use new mechanisms to work for VMs in this cluster (for example, online backup with checkpoints and RCT for change block tracking). The new mechanisms will be used only after you perform the following actions:
  - Upgrade all nodes in the cluster to Microsoft Hyper-V Server 2016 or later
  - Upgrade the cluster functional level
  - Upgrade VM configuration version to 8.x

- For Hyper-V Server 1709 or later: backup of VMs with VMPmemController is not supported.

Shielded VMs

Veeam Backup & Replication has the following limitations on processing of shielded VMs:

- Veeam Backup & Replication cannot interact with the guest OS of a shielded VM and get information about its OS, IP address and so on. For this reason, the following operations are not supported for shielded VMs:
  - Application-aware image processing
  - Restore of VM guest OS files to the original location
  - Restore of application items to the original location

- Shielded VMs can run only on trusted hosts guarded with the Host Guardian Service. Bear it in mind when selecting a target host for VM replication or VM restore. If the target host is not guarded with the same Host Guardian Service as the source host, you will not be able to power on the replicated or restored VM.

- If VM guest disks are encrypted with Bitlocker, Veeam Backup & Replication will not be able to restore VM guest OS files and application items from such disks.

The second and third items in the list with limitations for shielded VMs also apply to Generation 1 of Microsoft Hyper-V VMs that use Key Storage Drive. For more information about Key Storage Drive, see [Microsoft Docs](https://microsoft.com).
Backup Chain

Veeam Backup & Replication creates and maintains the following types of backup files:

- **VBK** — full backup files that store copies of full VM images.
- **VIB or VRB** — incremental backup files that store incremental changes of VM images.
- **VBM** — backup metadata files that store information about the backup job, VMs processed by the backup job, number and structure of backup files, restore points, and so on. Metadata files facilitate import of backups, backup mapping and other operations.

In addition to these file types, Veeam Backup & Replication can create the following files in the backup repository:

- **VSB** — virtual synthetic backup files used for generation of virtual full backups on tapes. For more information, see [Virtual Full Backup](#).
- **VLB, VSM and VLM** — files that store Microsoft SQL Server transaction log data. For more information, see [Microsoft SQL Server Logs Backup](#).
- **VLB, VOM and VLM** — files that store Oracle archived log data. For more information, see [Oracle Logs Backup](#).

All backup files created by the backup job reside in a dedicated job folder in the backup repository. For example, if you create a backup job with the **DC Backup** name, Veeam Backup & Replication will create the **DC Backup** folder on the target backup repository and store all backup files produced with this job in this folder.

Backup files make up a backup chain. The backup chain consists of first full backup file, incremental backup files and, additionally, backup metadata file. The number of backup files and how Veeam Backup & Replication orders them in the chain depend on the chosen backup method. For details, see [Backup Methods](#).

Full and incremental backup files correspond to restore points of backed-up VMs. You can think of restore points as of "snapshots" of VM data at specific points in time. Restore points let you roll back VMs to the necessary state.

To roll back a VM to a specific point in time, you need a chain of backup files: a full backup file plus a set of incremental backup files dependent on this full backup file. If some file in the backup chain is missing, you will not be able to roll back to the necessary state. For this reason, you must not delete separate backup files from the backup repository manually. Instead, you must specify retention policy settings that will let you maintain the desired number of backup files in the backup repository.

By default, during every backup job session Veeam Backup & Replication writes data of all VMs to the same backup file. If necessary, you can instruct Veeam Backup & Replication to create per-VM backup chains — that is, produce a separate backup chain for every VM added to the backup job. For details, see [Per-VM Backup Files](#).

Backup Methods

Veeam Backup & Replication provides three methods for creating backup chains:

- **Forever forward incremental backup**
- **Forward incremental backup**
- **Reverse incremental backup**
Forever Forward Incremental Backup

The forever forward incremental backup method produces a backup chain that consists of the first full backup file (VBK) and a set of forward incremental backup files (VIB) following it.

Veeam Backup & Replication creates a forever forward incremental backup chain in the following way:

1. During the first session of a backup job, Veeam Backup & Replication creates a full backup file in the backup repository.

2. During subsequent backup job sessions, Veeam Backup & Replication copies only VM data blocks that have changed since the last backup job session (full or incremental) and saves these blocks as an incremental backup file in the backup chain.

3. After adding a new restore point to the backup chain, Veeam Backup & Replication checks the retention policy for the job. If Veeam Backup & Replication detects an outdated restore point, it transforms the backup chain to make room for the most recent restore point. For more information, see Forever Forward Incremental Backup Retention Policy.

To use the forever forward incremental backup method, you must select the following options in the backup job settings:

1. Select the **Incremental** backup mode.
2. Do not enable synthetic full backups and/or active full backups. If you enable synthetic and/or active full backups, Veeam Backup & Replication will produce a forward incremental backup chain.

### Forward Incremental Backup

The forward incremental backup method produces a backup chain that consists of the first full backup file (VBK) and a set of forward incremental backup files (VIB) following it. Additionally, the forward incremental backup chain contains synthetic full and/or active full backup files that "split" the backup chain into shorter series.

**Veeam Backup & Replication** creates a forward incremental backup chain in the following way:

1. During the first backup job session, Veeam Backup & Replication creates a full backup file in the backup repository.
2. During subsequent backup job sessions, Veeam Backup & Replication copies only VM data blocks that have changed since the last backup job session (full or incremental) and saves these blocks as an incremental backup file in the backup chain.
3. On a day when the synthetic full or active full backup is scheduled, Veeam Backup & Replication creates a full backup file and adds it to the backup chain. Incremental restore points produced after this full backup file use it as a new starting point.
4. After adding a new restore point to the backup chain, Veeam Backup & Replication checks the retention policy set for the job. If Veeam Backup & Replication detects an outdated restore point, it attempts to remove this point from the backup chain. For more information, see Retention for Forward Incremental Backup.

The forward incremental backup with synthetic full backup enabled is a default method for backup chain creation. To use the forward incremental backup method, you can leave the default settings or select the following options in the backup job settings:

1. Select the **Incremental** backup mode.
2. Enable synthetic full backups and/or active full backups. If the synthetic full backup and/or active full backups are not enabled, Veeam Backup & Replication will produce a **forever forward incremental backup chain**.

Reverse Incremental Backup

The reverse incremental backup method produces a backup chain that consists of the last full backup file (VBK) and a set of reverse incremental backup files (VRB) preceding it.
Veeam Backup & Replication creates a reverse incremental backup chain in the following way:

1. During the first backup job session, Veeam Backup & Replication creates a full backup file in the backup repository.

2. During subsequent backup job sessions, Veeam Backup & Replication copies only VM data blocks that have changed since the last backup job session. Veeam Backup & Replication “injects” copied data blocks into the full backup file to rebuild it to the most recent state of the VM. Additionally, Veeam Backup & Replication creates a reverse incremental backup file containing data blocks that are replaced when the full backup file is rebuilt, and adds this reverse incremental backup file before the full backup file in the backup chain.

3. After adding a new restore point to the backup chain, Veeam Backup & Replication checks the retention policy set for the job. If Veeam Backup & Replication detects an outdated restore point, it removes this point from the backup chain. For more information, see Retention for Reverse Incremental Backup.

As a result, the most recent restore point in the backup chain is always a full backup, and it gets updated after every successful backup job session.

The reverse incremental backup method lets you immediately restore a VM to the most recent state without extra processing because the most recent restore point is a full backup file. If you need to restore a VM to a particular point in time, Veeam Backup & Replication applies the required VRB files to the VBK file to get to the required restore point.
To use the reverse incremental backup method, you must select the **Reverse incremental** option in the backup job settings.

### Switching Between Backup Methods

You can easily switch between backup methods. Veeam Backup & Replication does not transform the previously created chain. Instead, it creates a new backup chain next to the existing one in the following manner:

- **If you switch from the reverse incremental method to the forever forward incremental or forward incremental method,** Veeam Backup & Replication creates a set of incremental backup files next to the reverse incremental chain. The full backup file in the reverse incremental chain is used as a starting point for incremental backup files.

- **If you switch from the forever forward incremental or forward incremental method to the reverse incremental method,** Veeam Backup & Replication first creates a full backup file next to incremental backup files. During every new job session, Veeam Backup & Replication transforms this full backup file and adds reverse incremental backup files to the backup chain.

- **If you switch from the forever forward incremental method to the forward incremental method,** Veeam Backup & Replication creates synthetic full backups according to the specified schedule. Old backup chain is deleted when the number of restore points in the new chain reach the retention limit.

- **If you switch from the forward incremental method to the forever forward incremental method,** synthetic full backups are no longer created. When the number of restore points created since the last full backup reach the retention limit, the old backup chain is deleted. Thereafter, with each restore point creation the earliest increment file will merge with the full backup file.
Active Full Backup

In some cases, you need to regularly create a full backup. For example, your corporate backup policy may require that you create a full backup on weekend and run incremental backup on work days. To let you conform to these requirements, Veeam Backup & Replication lets you create active full backups.

The active full backup produces a full backup of a VM, just as if you run the backup job for the first time. Veeam Backup & Replication retrieves data for the whole VM from the source, compresses and deduplicates it and stores it to the full backup file — VBK.

The active full backup resets a backup chain. All incremental backup files use the latest active full backup file as a new starting point. A previously used full backup file remains on disk until it is automatically deleted according to the retention policy.

You can create active full backups manually or schedule a backup job to create active full backups periodically.

- To create an active full backup manually, use the **Active Full** command from the shortcut menu of a corresponding backup job.
To schedule active full backups, specify scheduling settings in the Advanced section of a corresponding backup job. You can schedule active full backups to run weekly, for example, every Saturday, or monthly, for example, every fourth Sunday of a month.

Active Full Backup Schedule

Veeam Backup & Replication automatically triggers a backup job to create an active full backup, even if a regular backup job session is not scheduled on this day. The job session is started at the same time when the parent backup job is scheduled. For example, if you schedule the parent backup job at 12:00 AM Sunday through Friday, and schedule active full backup on Saturday, Veeam Backup & Replication will start a backup job session that will produce an active full backup at 12:00 AM on Saturday.

If the parent backup job is not scheduled to run automatically or disabled, Veeam Backup & Replication will not perform active full backup.

If a regular backup job is scheduled together with active full backup, Veeam Backup & Replication will produce only one backup file — an active full backup that will contain the latest state of the source VM. An incremental backup file that should have been created by the backup job schedule will not be added to the backup chain.

Veeam Backup & Replication creates an active full backup only once a day on which active full backup is scheduled (unless you create a full backup manually). If you run the backup job again on the same day, Veeam Backup & Replication will perform incremental backup in a regular manner.

Synthetic Full Backup

In some situations, running active full backups periodically may not be an option. Active full backups are resource-intensive and consume considerable amount of network bandwidth. As an alternative, you can create synthetic full backups.
In terms of data, the synthetic full backup is identical to a regular full backup. Synthetic full backup produces a VBK file that contains data of the whole VM. The difference between active and synthetic full backup lies in the way how VM data is retrieved:

- When you perform active full backup, Veeam Backup & Replication retrieves VM data from the source volume where the VM resides, compresses and deduplicates it and writes it to the VBK file in the backup repository.

- When you perform synthetic full backup, Veeam Backup & Replication does not retrieve VM data from the source volume. Instead, it synthesizes a full backup from data you already have in the backup repository. Veeam Backup & Replication accesses the previous full backup file and a chain of subsequent incremental backup files on the backup repository, consolidates VM data from these files and writes consolidated data into a new full backup file. As a result, the created synthetic full backup file contains the same data you would have if you created an active full backup.

The synthetic full backup has a number of advantages:

- The synthetic full backup does not use network resources: it is created from backup files you already have on disk.

- The synthetic full backup produces less load on the production environment: it is synthesized right on the backup repository.

Veeam Backup & Replication treats synthetic full backups as regular full backups. As well as any other full backup file, the synthetic full backup file resets the backup chain. All subsequent incremental backup files use the synthetic full backup file as a new starting point. A previously used full backup file remains on disk until it is automatically deleted according to the retention policy.

**NOTE:**

If you enable both synthetic and active full backups and schedule their creation on the same day, the synthetic full backup is not created.
To create synthetic full backups, you must enable the **Create synthetic full backups periodically** option and schedule creation of synthetic full backups on specific days in the backup job settings.

### How Synthetic Full Backup Works

To create a synthetic full backup, Veeam Backup & Replication performs the following steps:

1. On a day when synthetic full backup is scheduled, Veeam Backup & Replication triggers a new backup job session. During this session, Veeam Backup & Replication first performs incremental backup in a regular manner and adds a new incremental backup file to the backup chain.

Veeam Backup & Replication retrieves VM data for this incremental backup file from the production storage. Incremental backup helps Veeam Backup & Replication ensure that the synthetic full backup includes the latest changes of the source VM in the production environment.
2. At the end of the backup job session, the Veeam Data Mover on the backup repository builds a new synthetic full backup using backup files that are already available in the backup chain, including the newly created incremental backup file.

3. When the synthetic full backup is created, the Veeam Data Mover on the backup repository deletes the incremental backup file created at the beginning of the job session. As a result, you have a backup chain that consists of a full backup file, set of incremental backup files and synthetic full backup file.

4. Every next job session creates a new incremental restore point starting from the synthetic full backup until the day on which synthetic full backup is scheduled. On this day, Veeam Backup & Replication creates a new synthetic full backup.

**Synthetic Full Backup Schedule**

Veeam Backup & Replication automatically triggers a backup job session to create a synthetic full backup, even if a regular backup job session is not scheduled on this day. The job session is started at the same time when the parent backup job is scheduled. For example, if you schedule the parent backup job at 12:00 AM Sunday through Friday, and schedule synthetic full backup on Saturday, Veeam Backup & Replication will start a backup job session that will produce a synthetic full backup at 12:00 AM on Saturday.

If a regular backup job is scheduled together with a synthetic full backup, Veeam Backup & Replication will produce only one backup file — a synthetic full backup that will contain the latest state of the source VM. An incremental backup file that should have been created by the backup job schedule will not be added to the backup chain.

If an active full backup is scheduled together with a synthetic full backup, Veeam Backup & Replication will create only the active full backup.

Veeam Backup & Replication creates a synthetic full backup only once a day on which synthetic full backup is scheduled. If you run the backup job again on the same day, Veeam Backup & Replication will perform incremental backup in a regular manner.

**Backup Chain Transformation**

Backup chain transformation helps reduce disk space required for storing backups in a backup repository. This is functionality additional to the synthetic full backups.
With backup chain transformation enabled, Veeam Backup & Replication transforms the active backup chain (the latest full backup file and subsequent incremental backup files, VBK and VIBs) into reverse incremental backup files, VRBs. As the result of the transformation process, you will have only one synthetic full backup file instead of two full backup files — a regular full backup and synthetic full backup.

Veeam Backup & Replication applies short-term retention policy to the transformed chains without delays — Veeam Backup & Replication just deletes a VRB backup file. However, the transformation process takes more time than creating a periodic synthetic full backup. The transformation process produces heavy load on the backup repository. Make sure you properly plan the use of backup repository resources when you schedule backup jobs.

**NOTE:**
Veeam Backup & Replication transforms only the active backup chain. All backup files that precede the active backup chain stay intact.

### How Backup Chain Transformation Works

For example, you have configured a backup job to perform daily forward incremental backups and scheduled synthetic full backups on Thursday. Additionally, you have selected to transform the incremental backup chain into the reverse incremental backup chain. The backup job starts on Sunday. In this case, Veeam Backup & Replication performs backup in the following way:

1. On Sunday, Veeam Backup & Replication creates a full backup file.
2. Monday through Wednesday, Veeam Backup & Replication creates increments and adds them to the backup chain.
3. On Thursday, Veeam Backup & Replication creates a new increment and then transforms the backup chain in the following way:
   a. Veeam Backup & Replication injects the Monday increment into the Sunday full backup. Modified blocks are pulled out and saved as a reverse incremental file. As a result, you have Monday full backup and Sunday reverse increment.
   b. Veeam Backup & Replication repeats the process for Tuesday, Wednesday and Thursday increments. As a result, you have the synthetic full backup created on Thursday and a set of reverse increments for Sunday through Wednesday.
4. When you run the backup job next time, Veeam Backup & Replication adds a new increment to the backup chain. The synthetic full backup will be used as a starting point.
Retention Policy for Mixed Backup Chains

To maintain the necessary number of restore points in mixed backup chains (backup chains that contain reverse incremental and forward incremental backup files), Veeam Backup & Replication deletes an outdated reverse incremental backup file when the job adds a new forward incremental backup file to the chain.

Short-Term Retention Policy

Every successful backup job session creates a new restore point that lets you roll back VM data to an earlier point in time. To control the number of restore points in the backup chain, you must specify retention policy settings. The retention policy defines how many restore points you want to retain on disk and thus how ‘far’ you are able to roll back. After the allowed number of restore points is exceeded, Veeam Backup & Replication automatically removes the earliest restore point from the backup chain.

To define the retention policy for a backup job, you must specify the necessary number of restore points or days in the Retention policy field in the backup job settings. By default, Veeam Backup & Replication keeps 14 restore points. In the Storage step of the New Backup Job wizard you can select the following units of retention policy.

- **Restore points**: Veeam Backup & Replication keeps the last $N$ restore points, where $N$ is the specified number of restore points.

- **Days**: Veeam Backup & Replication keeps restore points created during the last $N$ days, where $N$ is the specified number of days.

The daily retention policy can be helpful if you periodically create off-schedule backups. For example, you create a daily backup job and you want to store retention points for 14 calendar days. If you select 14 restore points and manually create off-schedule backups, there will be several restore points in one day. So, you will have retention points for less than 14 days. In this case, you can use the days option.

Mind the following for the daily retention policy:

- The minimum number of retained restore points is 3. This number does not depend on the number of days set in the retention policy. For example, the retention policy is set to 5 days. You launch the job after it was stopped for 10 days. Normally, Veeam Backup & Replication would delete all previous restore points. However, due to the minimum number of retained restore points, you will still have at least 3 restore points.

  You can change the minimum number of retained restore points with a registry key. For more information, contact Veeam Customer Support.

- If the backup job starts at the end of the day and finishes the next day, Veeam Backup & Replication assumes that the restore point is created at the moment when the backup job started. However, Veeam Backup & Replication starts counting retention policy days only after the backup job finishes processing VMs.

- For the daily retention policy, Veeam Backup & Replication does not count restore points created on the day the retention policy is run. For example, if you create a backup job on Monday, set daily retention to 3 days, and create full backups daily. On Thursday, Veeam Backup & Replication will keep restore points created during 4 days (Monday, Tuesday, Wednesday, and Thursday). Restore points created on Thursday will not be counted. On Friday, Veeam Backup & Replication will delete backup files created on Monday, and keep restore points created during 4 days (Tuesday, Wednesday, Thursday, and Friday). Note that the retention period may be longer depending on the specified backup method.
When the specified number is exceeded, the earliest restore points will be removed from the backup chain or merged with the next closest restore point. Veeam Backup & Replication handles restore points in different ways for forever forward incremental, forward incremental and reverse incremental backup chains:

- **Forever Forward Incremental Backup Retention Policy**
- **Retention for Forward Incremental Backup**
- **Retention for Reverse Incremental Backup**

**NOTE:**

When the allowed number of restore points in the backup chain is exceeded, Veeam Backup & Replication deletes the whole backup file, not separate VMs from it. For more information, see Removal of Restore Points.

**Forever Forward Incremental Backup Retention Policy**

If the number of restore points in forever forward incremental backup chains exceeds retention policy settings, Veeam Backup & Replication transforms the backup chain to make room for the most recent restore point. The transformation process is performed in the following way:

1. Veeam Backup & Replication adds a new incremental backup file to the backup chain and detects that the number of allowed restore points is exceeded.

2. Veeam Backup & Replication reuses empty data blocks in the full backup file to include changes of the incremental backup file that follows the full backup. To do that, Veeam Backup & Replication injects data blocks from the first incremental backup file in the chain into the full backup file. As a result, the full backup file ‘moves’ one step forward in the backup chain.
NOTE:
If the forever forward incremental backup chain resides on a deduplicating storage appliance, Veeam Backup & Replication does not reuse empty data blocks of the full backup file. Instead, Veeam Backup & Replication appends data from the first incremental backup file in the chain to the full backup file. As a result, the backup chain may consume more disk space on the appliance.

3. The first incremental backup file is removed from the backup chain as redundant. Its data has already been injected into the full backup file, and the full backup file contains the same data as this incremental backup file.

For example, you want to keep 7 restore points in the backup chain. The backup job starts on Sunday and runs daily. In this case, Veeam Backup & Replication will create the backup chain in the following way:

1. During the first backup job session on Sunday, Veeam Backup & Replication creates the first restore point—a full backup file.
2. Monday through Saturday Veeam Backup & Replication adds six incremental backup files to the backup chain.
3. The next Sunday, Veeam Backup & Replication adds a new incremental backup file to the backup chain.
4. Veeam Backup & Replication detects that the number of allowed restore points is exceeded, and starts the transformation process:

a. Veeam Backup & Replication merges data blocks from the incremental backup file created on Monday into the full backup file created on Sunday. This way, the full backup file ‘moves’ one step forward — from Sunday to Monday.

b. The incremental backup created on Monday becomes redundant and is removed from the backup chain.

As a result, you have a chain of a full backup file as of Monday and six incremental backup files Tuesday through Sunday.

Forward Incremental Backup Retention Policy

To be able to restore from a forward incremental backup, you need to have a full backup file and a chain of subsequent incremental backup files on disk. If you delete a full backup file, the whole chain of incremental backup files will become useless. In a similar manner, if you delete any incremental backup file before the point to which you want to roll back, you won’t be able to restore VM data (since later incremental backup files depend on earlier incremental backup files).

For this reason, if you select forward incremental backup method, in some days there will be more restore points on disk than specified by retention policy settings. Veeam Backup & Replication will remove the full backup chain only after the last incremental backup file in the chain becomes outdated.

For example, the retention policy is set to 3 restore points. The first full backup file is created on Sunday, incremental backup files are created Monday through Saturday, and the second full backup is created on Thursday. Although the retention policy is already breached on Wednesday, the first full backup is not deleted. Without the full backup, backup chain would be useless, leaving you without any restore point at all. Veeam Backup & Replication will wait for the second full backup file and 2 incremental backup files to be created, and only then will delete the whole previous chain, which will happen on Saturday.
Reverse Incremental Backup Retention Policy

In case of reverse incremental backup, Veeam Backup & Replication immediately deletes the earliest reverse incremental backup file as soon as it becomes outdated.

For example, you configure a backup job in the following way:

- The backup job starts on Sunday.
- The backup method is reverse incremental.
- Retention policy is set to 6 restore points.

Veeam Backup & Replication will start the backup job on Sunday. Monday through Friday, it will add new restore points to the backup chain and rebuild the full backup file. On Saturday, Veeam Backup & Replication will add a new restore point and remove the earliest reverse incremental backup file (VRB) from the backup chain.

Retention Policy for Deleted Items

In some situations, after you configure and run backup jobs in Veeam Backup & Replication, you may want to change something in the virtual infrastructure or in the backup strategy. For example, you may remove some machines from the virtual infrastructure or move them to another location. You may also exclude some machines from jobs that have already run for some time.

Retention policy for deleted items functions differently depending on the per-VM backup file option. For details, see Per-VM Backup Files.

- [If per-VM is enabled] When you enable retention policy for deleted items, Veeam Backup & Replication will remove data for machines that are no longer processed by the backup job from the backup repository.
- [If per-VM is disabled] When you enable retention policy for deleted items, Veeam Backup & Replication will remove the data about deleted items from the backup job and Veeam Backup & Replication database. The stored blocks of deleted machines will remain in the repository. The stored blocks of deleted machines will be removed only when the restore point retention limit is reached or by the compact full backup file option.

Retention policy for deleted items data is set at the level of the backup job. You must enable the Remove deleted items data after option in backup job settings and specify the period of time for which data for deleted items must be retained in the backup repository.

Mind the following:

- You must use retention policy for deleted items data carefully. It is strongly recommended that you set the retention policy to 3 days or more to prevent unwanted data loss.
• The **Remove deleted items data after** option lets you control data of deleted or excluded items. In addition to it, Veeam Backup & Replication applies general retention policy rules to maintain the necessary number of restore points in the backup chain. For more information, see [Retention Policy](#).

## How Retention Policy for Deleted Items Works

If you enable retention policy for deleted items data in backup job settings, Veeam Backup & Replication performs the following actions:

1. If all machines in the job are processed with the *Success* status, at the end of the backup job session Veeam Backup & Replication gets a list of machines in the backup.

2. For every machine in the backup, Veeam Backup & Replication checks the configuration database and gets the date of the latest backup job session completed with the *Success* status.

3. Veeam Backup & Replication checks if any machine in the backup meets the following conditions:
   - There are no successful backups for the machine for the last N days.
   - There are no corrupted backups for the machine for the last N days.

   Where N is the number of days specified in the **Remove deleted items data after N days** setting.

4. If both conditions are true for some machine, Veeam Backup & Replication removes data for this machine from the backup. Note that if per-VM is disabled, it does not free up space in the backup repository. It marks the space as available to be overwritten, and this space is removed during subsequent job sessions or the full backup file compact operation.

**Example 1**
You create a backup job for 2 VMs and set the retention policy for deleted items to 5 days. The backup job runs once a day for 7 times and processes VMs in the following way:

- **VM 1** is successfully processed during all job sessions.
- **VM 2** is successfully processed during the 1st and 2nd backup job sessions. Before the 3rd job session, **VM 2** is excluded from the job and is not processed by subsequent job sessions.

During the 8th job session, Veeam Backup & Replication will remove data for **VM 2** from backups in the backup repository since there are no successful and corrupted backups for **VM 2** for the last 5 days.

---

**Example 2**

You create a backup job for 2 machines and set the retention policy for deleted machines to 5 days. The backup job runs once a day for 7 times and processes machines in the following way:

- **VM 1** is successfully processed during all job sessions.
- **VM 2** is successfully processed during the 1st and 2nd backup job sessions. Starting from the 3rd job session, **VM 2** fails to be processed, for example, due power loss while machine data is transported.

During the 8th job session, Veeam Backup & Replication will not remove data for **VM 2** from backups in the backup repository. Even though there are no successfully created backups for **VM 2** for the last 5 days, Veeam Backup & Replication will detect that the configuration database contains information about corrupted backups for **VM 2** for the last 5 days.

---

**Limitations for Retention Policy for Deleted Items**

- [Per-VM is disabled] Retention policy for deleted items does not function if you enable synthetic full backups and/or active full backup.
- [Per-VM is enabled] Retention policy for deleted items functions without limitations.

---

**Removal of Restore Points**

To keep up with the retention policy, Veeam Backup & Replication deletes the whole backup file from the backup chain, not data for separate VMs from the backup file. In some situations a certain VM may have fewer restore points than it is specified in retention policy settings. This can happen if a backup job processes a number of VMs or VM containers, and some VMs or VM containers fail to be processed during some job sessions.
Removal of Restore Points from Forward Incremental Chains

In case of a forward incremental backup chain, Veeam Backup & Replication does not remove a restore point immediately. Instead, Veeam Backup & Replication waits for a new full backup (synthetic or active) to be created and a new backup chain to be started. As soon as the last incremental restore point in the "old" backup chain is marked as redundant, Veeam Backup & Replication removes the whole "old" backup chain from the backup repository. For more information, see Retention for Incremental Backup.

For example, a backup job processes 2 VMs: VM1 and VM2. According to the retention policy settings, the backup chain must contain 3 restore points. The backup job has already had 5 job sessions and VMs have been processed in the following way:

- VM1 has been successfully backed up 3 times and has 3 restore points
- VM2 has failed to be processed in 2 job sessions and has 1 valid restore point

When Veeam Backup & Replication adds a new restore point to the backup chain, it will not remove the earliest restore point. Veeam Backup & Replication will wait until a new full backup file and 2 incremental backup files are added to the backup chain. After that, it will remove the whole outdated backup chain from the backup repository. Restore points in the new backup chain, at the same time, may contain data for both VMs or for one VM only: Veeam Backup & Replication regards backup files as restore points, not separate VMs in these files.

Removal of Restore Points from Reverse Incremental Chains

In case of a reverse incremental backup chain, Veeam Backup & Replication immediately deletes a redundant restore point when the allowed number of restore points is exceeded. For more information, see Retention for Reverse Incremental Backup.

For example, a backup job processes two VMs: VM1 and VM2. According to the retention policy settings, the backup chain must contain 5 restore points. The backup job has already had 5 job sessions and VMs have been processed in the following way:

- VM1 has been successfully backed up 5 times and has 5 valid restore points
- VM2 has failed to be processed in 2 job sessions and has 3 valid restore points

After that, Veeam Backup & Replication runs a new backup job session in which VM1 and VM2 are successfully processed. When a new restore point is added to the chain, Veeam Backup & Replication removes the earliest restore point because the number of restore points in the backup chain has exceeded 5. As a result, you will have 5 restore points for VM1 and 3 restore points for VM2.
Long-Term Retention Policy (GFS)

The long-term or Grandfather-Father-Son (GFS) retention policy allows you to store backup files for long periods of time — for weeks, months and even years. For this purpose, Veeam Backup & Replication does not create any special new backup files — it uses backup files created while backup job runs and marks these backups with specific GFS flags.

To mark a backup file for long-term retention, Veeam Backup & Replication can assign to the file the following types of GFS flags: weekly (W), monthly (M) and yearly (Y). The types of GFS flags that Veeam Backup & Replication assigns depend on the configured GFS retention policy settings.

**IMPORTANT!**

GFS flags can be assigned only to full backup files created during the time period specified in GFS policy settings.

As soon as Veeam Backup & Replication assigns a GFS flag to a full backup file, this backup file can no longer be deleted or modified. Also, Veeam Backup & Replication does not apply short-term retention policy settings to the full backup file — that is, Veeam Backup & Replication ignores the backup file when determining whether the number of allowed backup files is exceeded.

When the specified retention period ends, Veeam Backup & Replication unassigns the GFS flag from the full backup file. If the backup file does not have any other GFS flags assigned, it can be modified and deleted according to the short-term retention policy.

Limitations

When planning to use GFS retention policy, mind the following limitations:

- GFS retention policy does not apply to reverse incremental backup chains.
- GFS retention policy applies to forever forward incremental backup chain only if you periodically create full backups manually or using scheduled scripts. For more information on cmdlets that you can use in scripts, see the Veeam PowerShell Reference.
- As Veeam Backup & Replication does not create new full backup files while applying the GFS retention policy, you must configure your backup jobs in a way you do not lose any essential data due to an insufficient number of full backup files. For example, if you configure monthly GFS retention, you need at least one full backup file per month.
- If a GFS flag is assigned to a full backup file in an active backup chain, the following applies:
  - Veeam Backup & Replication cannot transform the backup chain.
  - Veeam Backup & Replication is not able to merge data from incremental backup files into the full backup file. For forever forward incremental backup chain, this means, that the short-term retention policy does not apply.
• Veeam Backup & Replication assigns GFS flags only after you save GFS retention policy settings. This means that GFS flags are assigned only to those backup files created after the configuration, while backup files created earlier are not affected and previously assigned flags are not modified.

• You cannot store full backups to which GFS flags are assigned in backup repositories with rotated drives.

• Retention policy for deleted items does not apply to full backup files to which GFS flags are assigned.

Assignment of GFS Flags

When configuring GFS retention policy settings, you can choose a number of GFS flag types that Veeam Backup & Replication will use to mark backup files for long-term retention. Depending on this number, Veeam Backup & Replication will apply slightly different algorithms when assigning GFS flags:

• Algorithm for One Flag Type

• Algorithm for Multiple Flag Types

IMPORTANT!

If you reconfigure GFS retention policy and save it, the described algorithms start to work as for the first time. This means that the previously assigned GFS flags are not considered when determining whether new GFS flags must be assigned. The previously assigned flags are not modified and are deleted according to the previous GFS retention policy.

Algorithm for One Flag Type

If you select only one type of GFS flags when configuring retention policy settings for a backup job, Veeam Backup & Replication performs the following steps as soon as the job finishes:

• If the job finishes within the period when a new GFS flag must be assigned, Veeam Backup & Replication checks whether the backup job has created a full backup file.
  o Yes: If the GFS flag has already been assigned to another backup file during the scheduled period, Veeam Backup & Replication does not assign another GFS flag to the backup file. If the GFS flag has not been assigned, Veeam Backup & Replication assigns it.
  o No: Veeam Backup & Replication waits for a full backup file to be created.

• If the job finishes outside the scheduled period, Veeam Backup & Replication checks whether the GFS flag has already been assigned during the previous period.
  o Yes: Veeam Backup & Replication does not assign a new GFS flag.
  o No: Veeam Backup & Replication checks whether the backup job has created a full backup file.
    ▪ Yes: Veeam Backup & Replication assigns the GFS flag.
No: Veeam Backup & Replication does not assign a new GFS flag.

Consider the following example. On Monday, you configure GFS policy settings of a backup job in a way weekly GFS flags must be assigned every Wednesday. In this example, Veeam Backup & Replication will take the following steps.
Example Description

1. Until Wednesday, Veeam Backup & Replication will not assign any GFS flags because the scheduled period has not started yet.

2. On Wednesday, the backup job will produce an incremental backup file. Veeam Backup & Replication will start waiting for a full backup file to be created since the scheduled period is now started.

3. On Thursday, the backup job will produce another incremental backup file, while Veeam Backup & Replication will still be waiting for a full backup file.

4. On Friday, the backup job will produce a full backup file, and Veeam Backup & Replication will immediately assign the weekly GFS flag to the backup file.

Algorithm for Multiple Flag Types

If you select multiple types of GFS flags when configuring retention policy settings for a backup job, GFS flags depend on each other. Yearly flags (high level) depend on monthly flags, monthly flags depend on weekly flags, weekly flags (low level) do not depend on any flags. This means that Veeam Backup & Replication can only assign GFS flags of a higher level to backup files with GFS flags of a lower level — this mechanism helps you save space in the backup repository.
IMPORTANT!
The described mechanism does not apply to a situation where you select only two types of GFS flags, yearly and weekly. If you select these two types and do not select the monthly type, Veeam Backup & Replication treats the case as if you select only one flag type. This means that flags of each type are assigned according to the algorithm for one flag type.

Veeam Backup & Replication performs the following steps as soon as the job finishes. Note that GFS flags of lower levels are processed before flags of higher levels.

- If the job finishes within the period when a new GFS flag must be assigned, Veeam Backup & Replication checks whether the flag of a lower level must be assigned.
  - Yes: If the GFS flag of a lower level has already been assigned to the backup file created by the job, Veeam Backup & Replication assigns the GFS flag of the current level. If the GFS flag of a lower level has not been assigned, Veeam Backup & Replication waits for the flag to be assigned.
  - No: Veeam Backup & Replication checks whether the backup job has created a full backup file.
    - Yes: If the GFS flag of current level has already been assigned to another backup file during the scheduled period, Veeam Backup & Replication does not assign the GFS flag of the current level to the backup file. If the GFS flag has not been assigned, assigns it.
    - No: Veeam Backup & Replication waits for a full backup file to be created.

- If the job finishes outside the scheduled period, Veeam Backup & Replication checks whether the GFS flag of current level has already been assigned during the previous period.
  - Yes: Veeam Backup & Replication does not assign any GFS flags.
  - No: Veeam Backup & Replication checks whether the backup job has created a full backup file.
    - Yes: Veeam Backup & Replication assigns the flag of the current level.
    - No: Veeam Backup & Replication does not assign any GFS flags.

Consider the following example. On Monday, you configure GFS policy settings of a backup job in a way weekly GFS flags must be assigned every Wednesday and monthly GFS flags must be assigned every first week of a month. In this example, Veeam Backup & Replication will take the following steps.
## Example Description

1. On Monday, the backup job will produce an incremental backup file. Veeam Backup & Replication will start waiting for a full backup file since the monthly scheduled period is now started.

2. On Tuesday, the backup job will produce a full backup file. Although Veeam Backup & Replication will still be waiting for a full backup file, the full backup file with weekly GFS flag is required.

3. On Wednesday, the backup job will produce an incremental backup file.

4. On Thursday, the backup job will produce an incremental backup file. Veeam Backup & Replication will start waiting for a full backup file to assign the weekly GFS flag to it since the weekly scheduled period is now started.

5. On Friday, the backup job will produce a full backup file. Veeam Backup & Replication will immediately assign the weekly GFS flag to the backup file. As the weekly GFS flag will have been assigned, Veeam Backup & Replication will also assign the monthly GFS flag to the backup file.
Removal of GFS Flags

When configuring GFS retention policy settings, you can specify the retention period for each type of GFS flags. After the specified retention period exceeds, Veeam Backup & Replication removes GFS flags.

The date when Veeam Backup & Replication can remove GFS flags is calculated by the following formulas:

- **Weekly**: \( \text{date of GFS flag assignment} + N \times 7 \text{ days} \)
- **Monthly**: \( \text{date of GFS flag assignment} + N \times \text{months} + \text{1 day} \)

When calculating the date of GFS flag assignment + N months, Veeam Backup & Replication increases the month ordinal number by \( N \). If the calculated date does not exist, Veeam Backup & Replication uses the last date of the calculated month.

- **Yearly**: \( \text{date of GFS flag assignment} + N \times \text{years} + \text{1 day} \)

Where, \( N \) is the value specified in the **Keep weekly/monthly/yearly full backups for** field.

**NOTE:**

Veeam Backup & Replication removes GFS flags only during running backup job sessions. This means that if the backup job does not run on the calculated date, Veeam Backup & Replication will remove the GFS flag later during the next job session.

Consider the following example. At the beginning of January, you create a backup job whose GFS retention policy settings are configured to assign monthly GFS flags. You want to keep backup files with monthly flags for 1 month and set the value of the **Keep monthly full backups for** field to 1. Veeam Backup & Replication will perform the following steps to assign and remove the flags.

1. Veeam Backup & Replication will assign the monthly GFS flag on 1/31/2019.
2. To calculate the date when the monthly flag must be removed, the following formula is used: \( \text{date of GFS flag assignment} + 1 \times \text{month} \). This means that the flag must be removed on 2/31/2019. However, this date does not exist since the last date of February is 2/28/2019. That is why Veeam Backup & Replication will remove the GFS flag on 3/1/2019 (which is 2/28/2019 + 1 day).

Per-VM Backup Files

By default, backup jobs write VM data to the backup repository in one write stream, and store data of all VMs to the same backup file. Such behavior can be non-optimal if the target storage device is able to write data in multiple streams simultaneously. In this situation, the backup repository may become the bottleneck for the data transfer, even though its resources will not be fully utilized.
You can instruct Veeam Backup & Replication to create per-VM backup files in the backup repository. In this case, the backup job will use a separate write stream for every VM in the job, and store data of every VM to a separate backup file. Resources of the storage device will be used more efficiently, and the job performance may increase.

To create per-VM backup files, you must enable the **Use per-VM backup files** option at the level of the backup repository. It is recommended that you enable this option for deduplicating storage appliances that support multiple write streams. The option is also enabled for scale-out backup repositories by default.

It is recommended that you balance the number of tasks on backup proxies and backup repository to avoid the situation where some backup infrastructure resources remain idle while others are overloaded.
NOTE:
It is not recommended that you disable the Limit maximum concurrent tasks to N option for backup repositories with per-VM backup chains. In case of per-VM backup chains, synthetic operations (synthetic full backup, backup files merge and transformation) work in parallel for every VM in the backup. The number of parallel operations is limited by the number of concurrent tasks that can be performed on the backup repository. If you disable the Limit maximum concurrent tasks to N option (which results in using an unlimited number of slots), the load on the backup repository may be high.

Limitations for Per-VM Backup Files

- The Use per-VM backup files option cannot be enabled for backup repositories with rotated drives.
- If you enable the Use per-VM backup files option, data deduplication between VMs will not work. For more information, see Data Compression and Deduplication.
- The Per-VM backup chains functionality is available in Veeam Backup & Replication Enterprise edition and higher. If you configure backup repositories to produce per-VM backup chains and then install a license that does not support this functionality, you must manually disable the Use per-VM backup files option for backup repositories. Otherwise backup jobs targeted at these backup repositories will be failing.

Per-VM Backup Files Option for Existing Backup Repositories

You can enable or disable the Use per-VM backup files option for existing backup repositories at which backup jobs are already targeted. The new setting will not have any effect on previously created backup files in the backup repository. It will affect new backup files created after the setting is changed.
Veeam Backup & Replication applies the new setting starting from the next active full backup. You can create an active full backup manually or wait for Veeam Backup & Replication to automatically create active full backup (if active full backups are scheduled). Synthetic full backups do not affect the **Use per-VM backup files** setting.

**Retention for Per-VM Backup Files**

If you enable the **Use per-VM backup files** option for the backup repository, Veeam Backup & Replication creates a separate backup chain for every VM added to the job. Backup files are stored together in the folder of the backup job in the backup repository. The job produces one metadata file. This file stores information about all created backup files and backup chains.

Veeam Backup & Replication regards all backup files that are created during one backup job run as one restore point. When Veeam Backup & Replication needs to remove earlier restore points by retention policy, it removes backup files for all VMs that were created during one job run.

For example, you have added 3 VMs to the job, set the retention setting to 5 restore points and run the job 5 times. The job will produce 15 backup files, 5 per each VM in the job. On the 6th job run, the job will remove from the backup chain 3 backup files — the earliest restore points for every VM.

If the job backs up some VMs during the job run and does not manage to back up others, Veeam Backup & Replication will still regard that the restore point is valid. When the earliest restore point gets outdated, Veeam Backup & Replication will remove backup files for all VMs at once, even though backup chains for some VMs may contain fewer backup files than you expect.

The rules of restore points deletion for regular backup chains also apply to per-VM backup chains. For more information, see [Removing Restore Points from the Backup Chain](#).

For example, you have added 3 VMs to the job and set retention policy to 5. The backup job worked in the following way:

1. During the first two job runs, Veeam Backup & Replication backed up all VMs.
2. During the 3rd and 4th job runs, VM 1 and VM 2 were successfully backed up, and VM 3 failed.

During the 6th job run, Veeam Backup & Replication will delete the earliest restore point for all VMs. As a result, the VM 1 and VM 2 will have 5 restore points and VM 3 will have 3 restore points.

---

<table>
<thead>
<tr>
<th>Run 1</th>
<th>Run 2</th>
<th>Run 3</th>
<th>Run 4</th>
<th>Run 5</th>
<th>Run 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>VM 1</td>
<td>VM 1</td>
<td>VM 1</td>
<td>VM 1</td>
<td>VM 1</td>
<td>VM 1</td>
</tr>
<tr>
<td>VM 2</td>
<td>VM 2</td>
<td>VM 2</td>
<td>VM 2</td>
<td>VM 2</td>
<td>VM 2</td>
</tr>
<tr>
<td>VM 3</td>
<td>X</td>
<td>X</td>
<td>VM 3</td>
<td>VM 3</td>
<td>VM 3</td>
</tr>
</tbody>
</table>

Sun MonTueWedThuFri
Changed Block Tracking

When Veeam Backup & Replication performs incremental backup, it needs to know what data blocks have changed since the previous job session. To get the list of changed data blocks, Veeam Backup & Replication uses the changed block tracking mechanism, or CBT. CBT increases the speed and efficiency of incremental backups.

Veeam Backup & Replication uses CBT for the following operations:

- Backup
- Replication
- Entire VM restore

Veeam Backup & Replication enables CBT. You can disable it either at the host level or at the job level for troubleshooting purposes. Note that if you choose to run incremental jobs with CBT disabled, the backup window may increase dramatically, as Veeam Backup & Replication will read all VM data to detect what blocks have changed since the last job session.

To keep track of changed data blocks, Veeam Backup & Replication uses the following mechanisms:

- [For VMs on Microsoft Hyper-V Servers 2012 R2 and earlier] Veeam proprietary changed block tracking mechanism (CBT)
- [For VMs on Microsoft Hyper-V Server 2016 and later] Resilient Changed Tracking

Veeam CBT

The CBT mechanism is implemented as a file system filter driver — Veeam CBT driver. The driver is installed on every Microsoft Hyper-V host added to the backup infrastructure. The driver is activated when the host is first addressed by a job for which CBT is enabled.
The Veeam CBT driver keeps track of changed data blocks in virtual disks. Information about changed data blocks is registered in special CTP files. When a job runs, Veeam Backup & Replication uses CTP files to find out what data blocks have changed since the last run of the job, and copies only changed data blocks from the disk image.

CTP files are stored in the `C:\ProgramData\Veeam\CtpStore` folder on standalone Microsoft Hyper-V hosts or on every node of the Microsoft Hyper-V cluster. The CtpStore folder contains a set of subfolders — one for every processed VM, in which the following files are stored:

- **CTP files.** These files are used by the Veeam CBT driver to keep track of changed data blocks. For every VHD/VHDX or AVHD/AVHDX file of a VM, there is a separate CTP file.
- **notes.txt file.** This file contains basic information about the VM such as VM name and ID, and describes for which VHD/VHDX files changed block tracking is enabled.

If a Microsoft Hyper-V VM is registered as a cluster resource, the Veeam CBT driver operates on all cluster nodes that have access to VM disks on the CSV. When a job runs, Veeam Backup & Replication copies CTP files to the temporary folder on the backup proxy used by the backup job.

- If backup or replication is performed in the on-host backup mode, CTP files are copied to the Microsoft Hyper-V host performing the role of the on-host backup proxy. For more information, see On-Host Backup.
- If backup is performed in the off-host backup mode, CTP files are copied to the off-host backup proxy. For more information, see Off-Host Backup.

**IMPORTANT!**

If you process VMs on a Microsoft Hyper-V cluster, make sure that all cluster nodes are online. If cluster nodes are in the maintenance mode, have the cluster service stopped, are powered off or not accessible, CBT will not work. For more information about other requirements for VMs on clusters and SMB3 storage, see this Veeam KB article.

### Resilient Changed Tracking

For VMs running on Microsoft Hyper-V Server 2016 or later, Veeam Backup & Replication uses Resilient Change Tracking, or RCT. RCT is a native Microsoft Hyper-V mechanism for changed block tracking in virtual hard disks of VMs.

The RCT mechanism is used only if the Microsoft Hyper-V environment meets the following requirements:

- VMs run on Microsoft Hyper-V Server 2016 or later.
- [For Microsoft Hyper-V clusters] All hosts in the cluster are upgraded to Microsoft Hyper-V Server 2016 or later, and the cluster functional level is upgraded to 2016. If at least one node in a cluster is not upgraded to Microsoft Hyper-V Server 2016 or later, Veeam Backup & Replication does not use changed block tracking.
- VM configuration version is upgraded to 8.x.
For backup and replication with RCT, Veeam Backup & Replication uses the following mechanism:

1. Veeam Backup & Replication triggers Microsoft Hyper-V to create a checkpoint for a processed VM. The checkpoint is used as a data source for backup and replication.

2. At the end of VM processing, before a checkpoint is merged with the base VM disk, Microsoft Hyper-V converts the checkpoint to a reference point. The reference point can be thought of as a point-in-time representation of the VM disk state.

3. When Veeam Backup & Replication performs incremental backup or replication, it creates a new checkpoint for the VM that is used as a data source. Veeam Backup & Replication queries Microsoft Hyper-V to get incremental changes between the reference point created during the previous job session and checkpoint created during the current job session.

4. Veeam Backup & Replication copies only changed data blocks from the created checkpoint and saves them in an incremental backup file.

To guarantee persistence of CBT data, Microsoft RCT maintains 3 bitmaps with CBT data:

- In-memory bitmap contains the most granular CBT data.
- RCT file contains less granular CBT data than the in-memory bitmap. The RCT file is used if the CBT data in the in-memory bitmap is not available during normal operational situations, for example, a VM is moved to another host.
- MRT file has the coarsest granularity level. The RCT file is used if the CBT data in the in-memory bitmap is not available during abnormal operational situations, for example, power loss or host crash.

RCT and MRT files are created for every VM disk and stored at the VM disk level.

**CBT Reset (Microsoft Hyper-V Server 2012 R2 and Earlier)**

In some cases, CBT data may get corrupted — as a result, Veeam Backup & Replication will fail to process VMs with changed block tracking. To reset CBT data for individual VMs or specific VHD/VHDX files, you can use the `Reset-HvVmChangeTracking` PowerShell cmdlet. For more information, see the Veeam PowerShell Reference.

Keep in mind that CBT data is reset when you perform product upgrade. When you run a backup job for the first time after upgrade, Veeam Backup & Replication will not use changed block tracking. Instead, it will scan the VM image to learn what data blocks have changed.
Data Compression and Deduplication

Veeam Backup & Replication provides mechanisms of data compression and deduplication. Data compression and deduplication let you decrease traffic going over the network and disk space required for storing backup files and VM replicas.

Data Compression

Data compression decreases the size of created backups but affects duration of the backup procedure. Veeam Backup & Replication allows you to select one of the following compression levels:

- **None** compression level is recommended if you plan to store backup files and VM replica files on storage devices that support hardware compression and deduplication.
- **Dedupe-friendly** is an optimized compression level for very low CPU usage. You can select this compression level if you want to decrease the load on the backup proxy.
- **Optimal** is the recommended compression level. It provides the best ratio between size of the backup file and time of the backup procedure.
- **High** compression level provides additional 10% compression ratio over the **Optimal** level at the cost of about 10x higher CPU usage.
- **Extreme** compression provides the smallest size of the backup file but reduces the backup performance. We recommend that you run backup proxies on computers with modern multi-core CPUs (6 cores recommended) if you intend to use the extreme compression level.

**NOTE:**

Veeam Backup & Replication does not compress VM data if encryption is enabled for a job, and the **Decompress backup data blocks before storing** check box is selected in the settings of the target backup repository. Therefore, in the job statistics, you may observe a higher amount of transferred data (the **Transferred** counter) as compared to a job for which encryption is disabled. For details on job statistics, see Viewing Real-Time Statistics.

Changing Data Compression Settings

You can change data compression settings for existing backup jobs. New settings will not have any effect on previously created backup files in the backup chain. They will be applied to new backup files created after the settings were changed.

Compression settings are changed on the fly. You do not need to create a new full backup to use new settings — Veeam Backup & Replication will automatically apply the new compression level to newly created backup files.

However, if you use the reverse incremental backup method, the newly created backup files will contain a mixture of data blocks compressed at different levels. For example, you have a backup job that uses the reverse incremental backup method and the Optimal level of compression. After several job sessions, you change the compression level to High. In the reverse incremental backup chains, the full backup file is rebuilt with every job session to include new data blocks. As a result, the full backup file will contain a mixture of data blocks: data blocks compressed at the Optimal level and data blocks compressed at the High level. The same behaviour applies to synthetic full backups: synthetic full backups created after the compression level change will contain a mixture of data blocks compressed at different levels.
If you want the newly created backup file to contain data blocks compressed at one level, you can create an active full backup. Veeam Backup & Replication will retrieve data for the whole VM image from the production infrastructure and compress it at the new compression level. All subsequent backup files in the backup chain will also use the new compression level.

**Deduplication**

Data deduplication decreases the size of backup files. You can enable data deduplication if you add to backup or replication jobs several VMs that have a great amount of free space on their logical disks or VMs that have similar data blocks — for example, VMs that were created from the same template. With data deduplication enabled, Veeam Backup & Replication does not store to the resulting backup file identical data blocks and space that has been pre-allocated but not used.

Veeam Backup & Replication uses Veeam Data Movers to deduplicate VM data on the source and target side.

- The source-side Veeam Data Mover deduplicates VM data at the level of VM disks. Before the source Veeam Data Mover starts processing a VM disk, it obtains digests for the previous restore point in the backup chain from the target-side Veeam Data Mover. The source-side Veeam Data Mover consolidates this information with CBT information from the hypervisor and filters VM disk data based on it. If some data block exists in the previous restore point for this VM, the source-side Veeam Data Mover does not transport this data block to the target. In addition to it, in case of dynamically expanded disks the source-side Veeam Data Mover skips unallocated space.

- The target-side Veeam Data Mover deduplicates VM data at the level of the backup file. It processes data for all VM disks of all VMs in the job. The target-side Veeam Data Mover uses digests to detect identical data blocks in transported data, and stores only unique data blocks to the resulting backup file.

You can change the inline data deduplication settings for existing backup jobs. New changes will not have any effect on previously created backup files in the backup chain. They will be applied to new backup files created after the settings were changed.

Inline Data Deduplication setting can be changed on the fly. You do not need to create a new full backup to enable/disable this setting. Veeam Backup & Replication will automatically apply the change to newly created backup files.

**Storage Optimization**

Veeam Backup & Replication uses data blocks of different size to process VMs. Data block size depends on the type of storage you select as a backup target.

When you deduplicate a large backup file to small data blocks, Veeam Backup & Replication produces a very large deduplication metadata table, which can potentially overgrow memory and CPU resources of your backup repository. To optimize the job performance and data block size, you can choose one of the following options in accordance with the size of your backup files.

<table>
<thead>
<tr>
<th>Storage optimization option</th>
<th>Block size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local target (large blocks)</td>
<td>4096 KB</td>
<td>Recommended for backup files that are larger than 16 TB. This option will provide the lowest deduplication ratio and the largest size of incremental backup files.</td>
</tr>
</tbody>
</table>
### Storage Optimization Options

<table>
<thead>
<tr>
<th>Storage optimization option</th>
<th>Block size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local target</td>
<td>1024 KB</td>
<td>Recommended for backup to SAN, DAS or local storage. This option provides the fastest backup job performance but reduces the deduplication ratio, because with larger data blocks it is less likely to find identical blocks.</td>
</tr>
<tr>
<td>LAN target</td>
<td>512 KB</td>
<td>Recommended for backup to NAS and onsite backup. This option provides a better deduplication ratio and reduces the size of a backup file because of reduced data block sizes.</td>
</tr>
<tr>
<td>WAN target</td>
<td>256 KB</td>
<td>Recommended if you are planning to use WAN for offsite backup. This option provides the maximum deduplication ratio and the smallest size of backup files that allows you to reduce the amount of traffic over WAN.</td>
</tr>
</tbody>
</table>

### Changing Storage Optimization Settings

You can change storage optimization settings for existing backup jobs. New settings will not have any effect on previously created backup files in the backup chain. They will be applied to new backup files created after the settings were changed.

**Backup Jobs**

To apply new storage optimization settings in backup jobs, you must create an active full backup after you change storage optimization settings. Veeam Backup & Replication will use the new block size for the active full backup and subsequent backup files in the backup chain.

**Backup Copy Jobs**

To change data block size for a backup copy job, you must perform the following actions:

1. Change data block size in settings of the initial backup job.
2. Create an active full backup with the initial backup job.
3. Create an active full backup with the backup copy job.
Data Exclusion

When you configure a backup or replication job, you can define what data you want to back up and replicate and exclude data that you do not need. Data exclusion helps reduce the size of the VM backup or replica and decrease the load on the network.

You can exclude data at the VM level and at the VM guest OS level.

At the VM level:
- VMs added as part of the container
- VM disks

At the VM guest OS level:
- Swap files on the VM guest OS
- Deleted file blocks on the VM guest OS (BitLooker)
- Files and folders on the VM guest OS

VMs and VM Disks

When you configure a backup or replication job, you can exclude the following objects from processing:
- VMs added as a part of a VM container
- Individual VM disks

VMs as Part of Container

If you want to back up or replicate a VM container that holds several VMs but want to skip some VMs, you can exclude specific VMs from the job processing. This option will help you reduce the size of the resulting backup or replica and increase the job performance.
You can define which VMs you want to skip at the **Virtual Machines** step of the backup or replication job wizard.

### Individual VM Disks

You can choose what VM disks you want to back up or replicate:

- All VM disks
- 0:0 disks (which are commonly the VM system disks)
- Specific IDE, SCSI disks

For example, you may want to back up or replicate only the system disk instead of creating a backup or replica of a full VM. VM disks exclusion reduces the size of the backup or replica.
You can define which VM disks you want to back up or replicate at the **Virtual Machines** step of the backup or replication job wizard. You can specify disk processing settings granularly for every VM in the job or for the whole VM container. In the latter case, Veeam Backup & Replication will apply the configured rule to all VMs in this container.

### Deleted File Blocks (BitLooker)

By default, Veeam Backup & Replication does not copy "dirty" data blocks to the target location. Dirty data blocks are blocks marked as deleted after you remove them from the recycle bin. Omitting these blocks lets you reduce the size of the VM backup or replica and increase the job performance.

If you do not want to exclude deleted file blocks from backups or replicas, you can disable the **Exclude deleted file blocks** option in the backup or replication job settings.
NOTE:
If you enable or disable the Exclude deleted file blocks setting for the existing job, Veeam Backup & Replication will apply the new setting from the next job session.

With this option enabled, Veeam Backup & Replication performs the following operations during the job session:

1. Veeam Backup & Replication accesses the MFT file on the VM guest OS to identify deleted file blocks, and zeros out these blocks.

2. Veeam Backup & Replication processes and transports data blocks of the VM image in the following manner:
   - If a data block of the VM image contains only the deleted file blocks, Veeam Backup & Replication does not read this data block from the source volume.
   - If a data block of the VM image contains zeroed out blocks and other data, Veeam Backup & Replication copies this block to the target. Due to data compression, data blocks that are marked as deleted are compressed, and the size of the resulting backup or replica file reduces.
Limitations for Deleted File Blocks Exclusion

Veeam Backup & Replication can exclude deleted file blocks only on the VM guest OS with Microsoft NTFS.

Swap Files

You can instruct Veeam Backup & Replication to exclude pagefile.sys and hiberfil.sys files from backups or replicas of Microsoft Windows VMs.

- hiberfil.sys is a system file created by the OS for correct work of the hibernate mode.
- pagefile.sys is a swap file. Swap files are dynamic in nature and can change intensively between job sessions, even if a VM itself does not change much.

To exclude these files, you must enable the **Exclude swap file blocks** option in the job settings. Veeam Backup & Replication will identify data blocks of these files and exclude them from processing. As a result, the size of incremental backups and replicas will be smaller.

1. Veeam Backup & Replication accesses the MFT file on the VM guest OS to identify data blocks of pagefile.sys and hiberfil.sys files and zeros them out.

2. Veeam Backup & Replication processes and transports data blocks of the VM image in the following manner:
   - If a data block of the VM image contains only blocks of these files, Veeam Backup & Replication does not copy this data block to the target.
If a data block of the VM image contains blocks of these files and other data, Veeam Backup & Replication copies this block to the target.

Limitations for Swap Files Exclusion

Veeam Backup & Replication can exclude blocks of pagefile.sys and hiberfil.sys files only on the VM guest OS with Microsoft Windows NTFS.

VM Guest OS Files

If you do not want to back up or replicate some files and folders on the VM guest OS, you can exclude them from the backup or replica. Files exclusion reduces the size of the backup or replica but may affect the job performance.

You can specify file exclusion settings granularly for every VM in the job or for the whole VM container. In the latter case, Veeam Backup & Replication will apply the configured rule to all VMs in this container.

To define which VM guest OS files must and must not be processed, you can use the following options:

- Disable file exclusion.
  Veeam Backup & Replication will back up or replicate the whole content of the VM guest file system.
- Exclude specific files and folders from the backup or replica.
  Veeam Backup & Replication will back up or replicate all files and folders except the specified ones.
- Include only specific files and folders in the backup or replica.
  Veeam Backup & Replication will back up or replicate only the specified files and folders.

Defining File Exclusions and Inclusions

To define a list of exclusions or inclusions, you can use the following methods:

- Specify a full path to a folder on the VM guest OS, for example, \C:\Documents\.
- Specify a full path to a file on the VM guest OS, for example: \C:\Documents\MyReport.docx.

If a path is not full, Veeam Backup & Replication will expand it relatively the root directory on the computer volume and attempt to detect such files on all computer volumes. For example, you have C, D and E disks on the VM. In the list of exclusions, you specify Document.docx. Veeam Backup & Replication will scan the whole file system and exclude the following files (if any): \C:\Document.docx, \D:\Document.docx, \E:\Document.docx. If there is a \C:\MyDocuments\Document.docx file, it will not be excluded — this file is not located in the root directory.
- Use environmental variables, for example, `%TEMP%`, `%windir%`.

  Environment variables must be defined for the user account that you use to connect to the VM guest OS and under which the runtime process is started. For example, you connect to the VM guest OS under the `Administrator` account. If you want to use the `%windir%` variable in the list of exclusions or inclusions, you must make sure that the `%windir%` variable is added to the list of user variables for `Administrator` on the VM guest OS.

- Use file masks. You can use the following characters for masks:
  
  o (*) — a substitution for one or more characters in the file name or path. Can be used for any sequence of characters (including no characters). For example, `*.pdf`.
  
  o (?) — a substitution of one character in the file name or path. For example, `report?.pdf`.
  
  o (;) — mask separator, for example, `report.*;reports.*`.

  In the table below, mask stands for any sequence of characters.

<table>
<thead>
<tr>
<th>Mask format</th>
<th>Affects paths/files</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>mask</em></td>
<td>All paths that contain the given sequence.</td>
</tr>
<tr>
<td>mask*</td>
<td>If the asterisk character (<em>) is not specified at the beginning of the mask, the mask will be applied to all volumes on the VM guest OS, and Veeam Backup &amp; Replication will include/exclude files and folders in the root folder on the volume: A:\mask</em>, B:\mask*, ..., Z:\mask*.</td>
</tr>
<tr>
<td>&lt;drive_letter&gt;:*mask*</td>
<td>All paths on the specified volume that contain the given sequence.</td>
</tr>
<tr>
<td><em>mask1</em>;<em>mask2</em>;<em>mask3</em></td>
<td>All paths that contain at least one of the given character sequences: <em>mask1</em> or <em>mask2</em> or <em>mask3</em>.</td>
</tr>
</tbody>
</table>

**IMPORTANT!**

Be careful when using masks with double wildcard characters. If you specify masks of such type, Veeam Backup & Replication will exclude all files and paths that contain the given mask. For example, if you specify the `*.doc*` mask, Veeam Backup & Replication will exclude files like `MyReport.docx`, `Report.doc.txt` and so on.
Requirements and Limitations for VM Guest OS File Exclusion

VM guest OS files exclusion has the following limitations:

- File exclusion works only on Microsoft Windows NTFS.
- File exclusion is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.
- To exclude VM guest OS files, Veeam Backup & Replication must be able to deploy the runtime process inside the VM. For this reason, the VM must be running and accessible by an IP address, and credentials for application-aware processing must be valid.
- Veeam Backup & Replication supports both basic and dynamic disks. For the dynamic disks, simple and RAID-5 types of volumes are supported. Spanned, mirrored and striped volumes are not supported.
- It is not recommended that you use VM guest files exclusion in Microsoft Windows for volumes with enabled Data Deduplication. If you decide to use VM guest files exclusion for such volumes and set up a list of inclusions, you must add the System Volume Information folder to the list of inclusions.

Consider the following:

- If you use file masks for file exclusion, Veeam Backup & Replication will scan the VM guest file system, and thus the time of VM disk processing will increase.
- The number of entries in the list of exclusions or inclusions must not exceed a few hundreds. The number of entries in the list influences the job performance — the more files are included or excluded from the backup or replica, the more time Veeam Backup & Replication requires to process these files.
- It is recommended that you do not exclude system files without the necessity. Veeam Backup & Replication does not perform any checks to verify the VM image integrity.
Exclusion of small files (less than 2 KB in size) is ineffective and will not reduce the size of the backup or replica significantly.

Exclusion Rules for VMs with Several Volumes

The VM guest file exclusion and inclusion functionality works at the volume level. Consider the following situations:

Data exclusion

A VM has several volumes: C:\, D:\ and E:\. You want to exclude from the backup the Archive folder that is present on all volumes of the VM. If you add the C:\Archive folder to the list of exclusions, Veeam Backup & Replication will back up the following data:

- Whole content of the C: \ volume except the Archive folder
- Whole content of D: \ and E: \ volumes

To exclude the Archive folder from all volumes of the VM, you must add a relative path to the Archive folder the list of exclusions: ..\Archive\. 

Data inclusion

A VM has several volumes: C:\, D:\ and E:\. You want to include to the backup only the D:\Documents folder. If you add the D:\Documents folder to the list of inclusions, Veeam Backup & Replication will back up the following data:

- D:\Documents folder
- Whole content of C: \ and E: \ volumes

To include only the D:\Documents folder to the backup, you must add the D:\Documents folder to the list of inclusions and, additionally, exclude unnecessary disks (that contain C:\ and E: \ volumes) at the Virtual Machines step of the wizard. For more information, see Exclude Objects from Backup Job.

How VM Guest OS File Exclusion Works

When you exclude VM guest OS files from the backup or replica, Veeam Backup & Replication performs the following operations:

1. Veeam Backup & Replication checks the job settings to identify what VM guest OS files must be excluded.
2. Veeam Backup & Replication opens the MFT file from the VM guest file system in the memory cache on the backup proxy, and marks data blocks of excluded files as deleted.
3. When Veeam Backup & Replication copies VM data to the target, it reads data both from the VM snapshot and memory cache on the backup proxy. On the target, Veeam Backup & Replication creates a “merged” version of VM disks that do not contain excluded VM guest OS files. Due to data compression, data blocks that are marked as deleted are compressed, and the size of the resulting backup or replica file reduces.

During the job session with file exclude, Veeam Backup & Replication makes changes to processed VM disks at the NTFS level using the cache on the backup proxy. However, these changes are not visible to the CBT mechanism. For this reason, Veeam Backup & Replication saves information about excluded data blocks in the backup file and replica metadata. During the next job session with use of CBT, Veeam Backup & Replication retrieves a list of data blocks that were excluded during the previous job session from the backup file or replica metadata and analyzes what data needs to be processed during the current job session. To do this, Veeam Backup & Replication regards the following data:

- Data blocks that are marked as new with CBT
- Data blocks that were excluded during the previous job session
- Data blocks that must be excluded during the current job session
Microsoft Hyper-V Guest Quiescence

When you back up or replicate a running VM, you need to quiesce or 'freeze' the VM to bring its file system and application data to a consistent state. Data quiescence is crucial for highly-transactional applications. It helps create transactionally consistent backups or replicas and guarantee safety of application data.

To create transactionally consistent backups and replicas for VMs that do not support Microsoft VSS (for example, Linux VMs), you must enable Microsoft Hyper-V guest quiescence for the job. In this case, Veeam Backup & Replication will use a native Microsoft Hyper-V approach to quiesce the VM. Microsoft Hyper-V guest quiescence helps freeze the file system and application data on the VM and create a stable shadow copy of the volume where VM data resides.

NOTE:
To create consistent backups for such VMs, applications should be prepared using special pre-freeze and post-thaw scripts that you should create and store on the backup server beforehand. When the job starts, Veeam Backup & Replication will upload these scripts to the appropriate folders on VM guest. For more information, see Pre-Freeze and Post-Thaw Scripts.

To quiesce the VM, Veeam Backup & Replication can use the following methods:

- Online backup (Microsoft Hyper-V method)
- Offline backup (Microsoft Hyper-V method)
- Crash-consistent backup (Veeam method)

The quiescence method is selected in the following way:

- If a VM meets all requirements for online backup, Veeam Backup & Replication will use the online backup method.
- If a VM does not meet requirements for online backup, Veeam Backup & Replication will use the offline backup method. During offline backup a VM is suspended for a short period of time.
  
  If you do not want to suspend the VM, you can instruct Veeam Backup & Replication to create a crash-consistent backup instead of creating a transactionally consistent backup with the offline backup method.

Microsoft Hyper-V guest quiescence is enabled at the job level for all VMs added to the job. By default, this option is disabled.
**NOTE:**
Offline backup is not applicable to VMs registered on Microsoft Hyper-V Server 2016.

**Combined Approach**

It is recommended to enable Microsoft Hyper-V guest quiescence and application-aware processing when you add Microsoft Windows and Linux VMs to the same job. In this case, all VMs will be processed in a transactionally consistent manner — either with application-aware processing or Microsoft Hyper-V guest quiescence.

In such a scenario, Veeam Backup & Replication processes VMs in the job in the following way:

1. Veeam Backup & Replication first attempts to use application-aware processing to prepare VMs for backup or replication. If Veeam Backup & Replication manages to quiesce all VMs in the job with application-aware processing, it does not use Microsoft Hyper-V guest quiescence.

2. If some VMs cannot be quiesced with application-aware processing or application-aware processing is disabled for some VMs in the job (the Disable application processing is set for VMs in the job settings), Veeam Backup & Replication uses Microsoft Hyper-V guest quiescence to prepare these VMs for backup or replication.

To enable both technologies:

1. At the **Storage** step of the wizard (for backup) or **Job Settings** step of the wizard (for replication), click **Advanced**.
2. On the **Hyper-V** tab of the Advanced Settings window, select **Enable Hyper-V guest quiescence**.

3. At the **Guest Processing** step of the wizard, select the **Enable application-aware processing** check box.
4. When you configure advanced option for individual VMs, select **Try application processing, but ignore failures**. You can also select the **Disable application processing** option for VMs that you want to process with Microsoft Hyper-V guest quiescence.

**NOTE:**

If you enable application-aware processing and Microsoft Hyper-V guest quiescence but do not select the **Ignore application processing failures** option, Veeam Backup & Replication uses only application-aware processing for the job.
Guest Processing

If you back up or replicate running VMs, you can enable guest processing options. Guest processing options are advanced tasks that require Veeam Backup & Replication to communicate with the VM guest OS.

Veeam Backup & Replication offers the following guest processing options:

- **Application-aware processing.** You can create transactionally consistent backups and replicas of VMs that run Microsoft Active Directory, Microsoft Exchange, Microsoft SharePoint, Microsoft SQL Server or Oracle. The transactionally consistent backup guarantees proper recovery of these applications without data loss. For information on system requirements for the applications, see System Requirements.

- **Pre-freeze and post-thaw scripts.** You can use pre-freeze and post-thaw scripts to quiesce VMs running applications that do not support Microsoft VSS.

- **Transaction log truncation.** You can set the backup or replication job to truncate transaction logs on the VM guest OS after the VM is successfully processed.

- **Transaction logs backup for Microsoft SQL Server and Oracle.** You can set up the backup job to back up transaction logs from Microsoft SQL Server and Oracle VMs.

- **VM guest file system indexing.** You can set up the backup job to create a catalog of files and folders on the VM guest OS. The catalog lets you search for VM guest OS files and 1-click restore in Veeam Backup Enterprise Manager.

  VM guest file system indexing is optional. If you do not enable this option in the backup job settings, you will still be able to perform 1-click restore from the backup created with such backup job. For more information, see the Preparing for File Browsing and Searching section in the Enterprise Manager User Guide.

- **VM guest OS files exclusion.** You can exclude/include individual files and folders from/to backup or replica.

Runtime Coordination Process

To perform guest processing tasks, Veeam Backup & Replication does not deploy persistent agents inside VMs. Instead, it uses a runtime coordination process. The runtime process is non-persistent — it is deployed on every VM added to the job when the job starts and removed as soon as the job finishes. Use of the runtime process helps avoid agent-related drawbacks such as pre-installing, troubleshooting and updating.

Veeam Backup & Replication can deploy the runtime process on VMs in two ways:

- For VMs running Microsoft Windows, the runtime process is deployed via guest interaction proxies. For more information, see Guest Interaction Proxy.

- For VMs running OSes other than Microsoft Windows, for example, Linux, the runtime process is deployed from the backup server.

**NOTE:**

If there are no guest interaction proxies or guest interaction proxies fail for some reason, Veeam Backup & Replication will deploy the runtime process on Microsoft Windows VMs from the backup server.

When you start a job with guest processing tasks enabled, Veeam Backup & Replication performs the following operations:

1. Veeam Backup & Replication defines the machines that will perform the guest interaction proxy role.
2. Veeam Backup & Replication obtains IP addresses from Hyper-V Integration Services installed on VMs. If Veeam Backup & Replication fails to connect to the VM guest OS over the network, it obtains IP addresses over PowerShell Direct. PowerShell Direct is used for VMs that reside on Microsoft Hyper-V Server 2016 or later and run Microsoft Windows 10 or Microsoft Windows Server 2016 or later. Veeam Backup & Replication requires Microsoft PowerShell 2.0 or later to work over PowerShell Direct.

Veeam Backup & Replication deploys the runtime process on VMs:

- [For Microsoft Windows VMs] The guest interaction proxy connects to VMs and deploys the runtime process on them.
- [For VMs running other OSes] The backup server connects to VMs and deploys the runtime process on them.

3. The job session proceeds as usual.

4. When the job session completes, Veeam Backup & Replication deletes the runtime process on VMs.

If a network connection breaks during the job session, Veeam Backup & Replication makes attempts to re-establish the connection:

- If a network connection between the backup server/guest interaction proxy and VM guest OS breaks, Veeam Backup & Replication makes one attempt to reconnect.
- If a network connection between the backup server and guest interaction proxy breaks, Veeam Backup & Replication makes 10 attempts to reconnect.

If attempts are unsuccessful, guest processing tasks fail. The job proceeds with the scenario defined in the job settings. For example, if you have instructed a backup job to try application processing but ignore failures, Veeam Backup & Replication will not perform guest processing tasks but will proceed with the VM backup.

## Application-Aware Processing

To create transactionally consistent backups or replicas of VMs that run Microsoft Active Directory, Microsoft SQL Server, Microsoft SharePoint, Microsoft Exchange or Oracle, you must enable application-aware processing in job settings.

Application-aware processing is the Veeam technology based on Microsoft VSS. Microsoft VSS is responsible for quiescing applications on the VM and creating a consistent view of application data on the VM guest OS. Use of Microsoft VSS ensures that there are no unfinished database transactions or incomplete application files when Veeam Backup & Replication triggers the VM checkpoint and starts copying VM data to the target. For more information about Microsoft VSS, see Microsoft Docs.

Application-aware processing for Microsoft Windows Server versions is supported by corresponding versions of Microsoft Hyper-V (see Microsoft Docs). To use application-aware processing, you must have Hyper-V Integration Services and the latest updates installed on the VM guest OS.
IMPORTANT!

If a VM runs an application that does not support Microsoft VSS (there is no VSS writer for this particular type of application, for example, MySQL), Veeam Backup & Replication will not be able to utilize Microsoft VSS and application-aware processing for this VM. To process such VMs, you can use Microsoft Hyper-V guest quiescence with pre-freeze and post-thaw scripts. For more information, see Microsoft Hyper-V Guest Quiescence and Pre-Freeze and Post-Thaw Scripts.

How Application-Aware Processing Works

If you enable application-aware processing in job settings, Veeam Backup & Replication performs the following operations as a part of the backup or replication process:

1. Veeam Backup & Replication deploys the runtime process on the VM and detects if the VM runs any of the supported applications.
2. Veeam Backup & Replication collects information about applications installed on VMs — this information is required for VSS-aware restore. VSS-aware restore is performed when the VM is started after you restore it from the backup or fail over to a VM replica.
3. Veeam Backup & Replication prepares applications for VSS-aware restore.
4. Microsoft VSS communicates with applications and quiesces I/O activities at a specific point in time.
5. Microsoft Hyper-V VSS requestor triggers a VM VSS snapshot.
6. Microsoft VSS resumes quiesced I/O activities on the VM guest OS.
7. Veeam Backup & Replication triggers a snapshot for the volume on which the VM is located.
8. The job session proceeds as usual.
9. If you have instructed Veeam Backup & Replication to truncate transaction logs, Veeam Backup & Replication truncates transaction logs on the VM guest OS after the backup or replica are successfully created.
Pre-Freeze and Post-Thaw Scripts

If you back up or replicate VMs running applications that do not support Microsoft VSS, you can instruct Veeam Backup & Replication to run custom scripts for VMs. For example, the pre-freeze script may quiesce the file system and application data on the VM guest OS to bring the VM to a consistent state before Veeam Backup & Replication triggers a VM checkpoint. After the VM checkpoint is created, the post-thaw script may bring the VM and applications to their initial state.

You can use pre-freeze and post-thaw scripts for the following types of jobs:

- Backup job
- Replication job

Scripts must be created beforehand. You must specify paths to them in the job settings. Script execution settings can be configured per VM or per container, depending on the objects included in the job.

When the job starts, Veeam Backup & Replication uploads scripts to the VM guest OS and executes them under the account specified in the Guest OS credentials section of the job settings.

- Scripts for Microsoft Windows VMs are uploaded to \<vmname>\admin$ over the network. Scripts are executed from the C:\Windows directory.
- Scripts for Linux VMs are uploaded over SSH or PowerShell Direct if the SSH connection fails. Scripts are executed from the /home/<username> directory of a user that you have specified in Guest OS credentials.

PowerShell Direct is used for VMs that reside on Microsoft Hyper-V Server 2016 or later and run Microsoft Windows 10 or Microsoft Windows Server 2016 or later. Veeam Backup & Replication requires Microsoft PowerShell 2.0 or later to work over PowerShell Direct.

The script is considered to be executed successfully if "0" is returned.
The default time period for script execution is 10 minutes. If the script fails to execute before the timeout expires, Veeam Backup & Replication displays an error message in the job session and error or warning messages issued during script execution.

The default time period for script execution is 10 minutes. If the script fails to execute before the timeout expires, Veeam Backup & Replication displays an error message in the job session and error or warning messages issued during script execution.

Supported Script Formats

Pre-freeze and post-thaw scripts can be used for Microsoft Windows and Linux VMs.

- For Microsoft Windows VMs, Veeam Backup & Replication supports scripts in the EXE, BAT, CMD, WSF, JS, VBS and PS1 file format.
- For Linux VMs, Veeam Backup & Replication supports scripts in the SH file format.

Limitations for Pre-Freeze and Post-Thaw Scripts

Veeam Backup & Replication has the following limitations for pre-freeze and post-thaw scripts:

- You cannot stop a job when the pre-freeze or post-thaw script is executed. If the script hangs up, Veeam Backup & Replication waits for 10 minutes and terminates the job.
- If you want to run several scripts that depend on each other, you must upload them to the VM guest OS manually. For example, you have script1.bat that sequentially starts script2.bat, script3.bat and script4.bat. In this case, you must specify a path to script1.bat in the job properties and upload script2.bat, script3.bat and script4.bat to the VM guest OS.
- It is not recommended to use the standard error (STDERR) stream for error output in Linux scripts. Veeam Backup & Replication will fail to execute scripts with STDERR.
Transaction Log Truncation

If you back up or replicate virtualized database systems that use transaction logs, for example, Microsoft Exchange or Microsoft SQL Server, you can instruct Veeam Backup & Replication to truncate transaction logs so that logs do not overflow the storage space on the VM. Veeam Backup & Replication provides the following options of transaction logs handling:

- **Truncate logs**
- **Do not truncate logs**
- **Back up logs periodically**

### Truncate Logs

You can instruct Veeam Backup & Replication to truncate logs after a backup or VM replica is successfully created. With this option selected, Veeam Backup & Replication behaves in the following way:

- If the job completes successfully, Veeam Backup & Replication produces a backup file or VM replica and truncates transaction logs on the original VM. As a result, you have the backup file or replica that contains a VM image at a specific point in time.
  
  In this scenario, you can recover a database to the point in time when the backup file or replica was created. As transaction logs on the VM are truncated, you cannot use them to get the restored database to some point in time between job sessions.

- If the backup or replication job fails, Veeam Backup & Replication does not truncate transaction logs on the VM. In this scenario, you can restore a VM from the most recent backup or replica restore point and use database system tools to apply transaction logs and get the database system to the necessary point in time after the restore point.
Do not Truncate Logs

You can choose not to truncate transaction logs on the VM. This option is recommended if together with Veeam Backup & Replication you use another backup tool.

For example, you can use Veeam Backup & Replication to create a VM image backup and instruct the native Microsoft SQL Server log backup job to back up transaction logs. If you truncate transaction logs with Veeam Backup & Replication, the chain of transaction logs will be broken, and the Microsoft SQL Server log backup job will not be able to produce a consistent log backup.

With this option selected, Veeam Backup & Replication produces a backup file or VM replica and does not trigger transaction log truncation. As a result, you have a backup file or VM replica that contains a VM image captured at a specific point in time, and transaction logs on the VM. You can use transaction logs to restore the VM to any point in time between job sessions. To do this, you must recover the VM from the backup file or perform replica failover and use database system tools to apply transaction logs and get the database system to the necessary point in time.

Back Up Logs Periodically

This option can be used if you back up Microsoft SQL Server VMs and Oracle VMs.

You can choose to back up logs with Veeam Backup & Replication. For more information, see Microsoft SQL Server Logs Backup and Oracle Logs Backup.

Support for Database Availability Groups (DAG)

Veeam Backup & Replication supports any configuration of DAGs, in particular, with all databases active on one node, or with active databases on every node. Transaction logs will be truncated on all DAG members, no matter whether Veeam Backup & Replication backs up an active or passive database.

For more information and recommendations on Microsoft Exchange Server backup, you can also refer to the following:

- Veeam Knowledge Base article

Copy-Only Backup

Some organizations prefer to back up Microsoft SQL Server databases and transaction logs with native Microsoft SQL Server tools or 3rd party backup tools. To restore database systems in a proper way, database administrators must be sure that they have database backups and a sequence of transaction log backups associated with these backups at hand.

If you use native Microsoft SQL Server tools or 3rd party backup tools and also want to back up Microsoft SQL Server VMs with Veeam Backup & Replication, you must enable the Perform copy only option in the job settings.

The Perform copy only option indicates that a chain of database backups is created with native Microsoft SQL Server means or by a 3rd party tool, and instructs Veeam to preserve this chain (backup history). Veeam Backup & Replication backs up the Microsoft SQL Server VM using the VSS_BS_COPY method for snapshot creation. The VSS_BT_COPY method produces a copy-only backup — the backup that is independent of the existing chain of database backups and does not contain transaction logs data. As a result, the copy-only backup does not change the log sequence number and transaction log backup time.
**IMPORTANT!**

Veeam Backup & Replication does not truncate transaction logs after copy-only backup. For this reason, if you instruct the backup job to perform copy-only backup, you cannot specify transaction log handing settings for this job.

---

**VM Guest OS File Indexing**

You can instruct Veeam Backup & Replication to create an index of files and folders on the VM guest OS during backup. VM guest OS file indexing allows you to search for VM guest OS files inside VM backups and perform 1-click restore in Veeam Backup Enterprise Manager.

VM guest OS file indexing is enabled at the job level. You can specify granular indexing settings for every VM in the job.
NOTE:
VM guest OS file indexing is optional. If you do not enable this option in the backup job settings, you will still be able to perform 1-click restore from the backup created with such backup job. For more information, see the Preparing for File Browsing and Searching section in the Enterprise Manager User Guide.

Mind, however, that if you do not enable indexing in the backup job, during 1-click restore from Linux and other OS backups, Veeam Backup Enterprise Manager will not display symlinks to folders in the file system browser.

Requirements for VM Guest OS File Indexing

Consider the following requirements for VM guest OS file indexing:

- Veeam Backup & Replication supports file indexing for VMs running Microsoft Windows and Linux OS.
- Linux VMs must have the following tools installed: openssl, mlocate, gzip and tar.
Veeam Backup Catalog

For VM guest OS file indexing, Veeam Backup & Replication uses the Veeam Guest Catalog Service. In the backup infrastructure, the Veeam Guest Catalog Service is installed on the Veeam backup server and Veeam Backup Enterprise Manager server.

- The Veeam Guest Catalog Service on the Veeam backup server works as a local catalog service. It collects indexing data for backup jobs and stores this data in the Veeam Backup Catalog folder.
  
  By default, the indexing data is stored in the VBRCatalog folder on the backup server. Veeam Backup & Replication creates the folder on a volume with the maximum amount of free space, for example, C:\VBRCatalog.

- The Veeam Guest Catalog Service on Veeam Backup Enterprise Manager works as a global, federal catalog service. It communicates with Veeam Guest Catalog Services on backup servers connected to Veeam Backup Enterprise Manager and performs the following tasks:
  
  o Replicates indexing data from backup servers to create a global catalog for the whole backup infrastructure.
    
    On the Veeam Backup Enterprise Manager server, the default folder for storing indexing data (the VBRCatalog folder) is located on a volume with the maximum amount of free space.
  
  o Maintains indexing data retention.
  
  o Allows you to search for VM guest OS files in current and archived backup files.

How VM Guest OS File Indexing Works

When you run a backup job with the file indexing option enabled, Veeam Backup & Replication performs the following operations:

1. When the backup job starts, Veeam Backup & Replication connects to the VM whose file system must be indexed and deploys a runtime process inside this VM. The runtime process is responsible for coordinating indexing activities inside the VM.

2. The runtime process starts indexing the VM file system. The indexing procedure is carried out in parallel with the backup procedure. If indexing takes long, Veeam Backup & Replication will not wait for the indexing procedure to complete. It will start copying VM data and continue file indexing inside the VM.

3. When file indexing is complete, the runtime process collects indexing data and writes it to the GuestIndexData.zip file. The GuestIndexData.zip file is stored to a temporary folder on the backup server.

4. When the backup job completes, Veeam Backup & Replication notifies the local Veeam Guest Catalog Service, and the service saves indexing data in the Veeam Catalog folder on the backup server.
5. During the next catalog replication session, the global Veeam Guest Catalog Service replicates data from the backup server to the Veeam Catalog folder on the Veeam Backup Enterprise Manager server.
Microsoft SQL Server Log Backup

To protect Microsoft SQL Server VMs, you can instruct the backup job to create image-level VM backups and periodically back up database transaction logs. If Microsoft SQL Server fails, you can restore the Microsoft SQL Server VM from the necessary restore point of the image-level backup. After that, you can use Veeam Explorer for Microsoft SQL Server to apply transaction logs and get databases on the Microsoft SQL Server to the necessary state between backups.

Transaction Log Backup Jobs

To back up transaction logs, you must create a backup job, add Microsoft SQL Server VMs to it and specify advanced settings for transaction logs backup in the job settings. The resulting job will comprise two jobs:

- **Parent backup job** — the backup job that creates an image-level backup of the Microsoft SQL Server VM. The parent backup job is named `<job_name>`, for example, `DB Backup`. You can configure the parent job in the Veeam Backup & Replication console just like any other backup job.

- **Child job** — a transaction log backup job. To form a name of the child job, Veeam Backup & Replication adds a suffix to the name of the parent backup job: `<parent_job_name>` + `SQL Server Transaction Log Backup`, for example, `DB Backup SQL Server Transaction Log Backup`. Veeam Backup & Replication automatically creates the child job if it detects a backup job that is scheduled to back up at least one Microsoft SQL Server VM, and transaction log backup is enabled for this job. Session data of the transaction log backup job is stored in the configuration database and displayed in the Veeam Backup & Replication console.

The parent job runs in a regular manner — it starts by schedule or is started manually by the user. The transaction log backup job is triggered by the parent backup job. This sequence ensures that the VM (and the database) restore point is present when it comes to transaction log replay.

Sessions of Transaction Log Backup Jobs

The transaction log backup job runs permanently in the background, shipping transaction logs to the backup repository at a specific time interval (by default, every 15 minutes). A sequence of time intervals between sessions of the parent backup job makes up a session of the transaction log backup job.

The transaction log backup session starts and stops in the following way:

- The initial session starts when the parent backup job schedule is enabled. After that, the session starts with every new session of the parent backup job.

- The session ends before the next session of the parent backup job or when this parent backup job is disabled.

- When the session ends, Veeam Backup & Replication stops the runtime process and uninstalls it from the VM guest OS. When a new session starts, the runtime process is deployed again.

How Microsoft SQL Server Log Backup Works

To perform transaction log backup, Veeam Backup & Replication installs the *Veeam Guest SQL Log Shipper* runtime component on the VM guest OS.
The component works during the transaction log backup job session. It collects information about databases that require transaction log backup. It also detects whether it is possible to ship logs directly to the backup repository or Veeam Backup & Replication must use the log shipping server. When the transaction log backup job session ends, the component is stopped and removed from the VM guest OS. When a new session starts, the component is installed on the VM guest OS again.

The transaction log backup is performed in the following way:

1. Veeam Backup & Replication launches the parent backup job by schedule.

2. The parent backup job creates an image-level backup of a Microsoft SQL Server VM and stores it in backup repository.

3. A new session of the transaction log backup starts. Veeam Backup & Replication accesses the VM (directly or via the guest interaction proxy) and installs the runtime components for guest processing, database information collection and transaction log handing on the VM guest OS.

4. Veeam Backup & Replication detects what databases currently exist on the Microsoft SQL Server and maps this data with the information kept in the configuration database. This periodic mapping reveals the databases for which Veeam Backup & Replication must process transaction logs during this time interval. The runtime component backs up transaction log files and stores them as a *.bak file to a temporary folder on the VM guest file system.

5. Veeam Backup & Replication transports transaction log backup copies from the temporary folder on the Microsoft SQL Server VM to the backup repository, either directly or via the log shipping server, and saves them as VLB files. As soon as copies of transaction log backups are saved to the backup repository, transaction log backups in the temporary folder on the Microsoft SQL Server VM are removed.

The session of the transaction log backup job remains working until the next start of the parent backup job. When a new session of the parent job starts, the transaction log backup job stops the current session and then starts a new session, performing steps 1-5.

Transaction logs that for some reason were not processed during the log backup interval remain in the temporary folder and are processed during the next log backup interval. To detect these remaining logs, Veeam Backup & Replication enumerates log files in the temporary folder.

**NOTE:**

If a new session of the transaction log backup starts and the parent backup job has not created a new restore point yet, the transaction log backup job will remain in the idle state, waiting for a new restore point to be created.
Retention for Transaction Log Backups

Transaction log backups are stored in files of the proprietary Veeam format — VLB. Veeam Backup & Replication keeps transaction log backups together with the VM image-level backup. The target location of VLB files depend on the type of the backup repository:

- If you store the VM image-level backup in a backup repository, Veeam Backup & Replication writes transaction log backups to the same folder where files of the image-level backup reside.

- If you store the VM image-level backup in a scale-out backup repository, Veeam Backup & Replication writes transaction log backups to the extent where the latest incremental backup file of the VM image-level backup is stored.

Veeam Backup & Replication removes transaction log backups by retention. You can choose one of the following retention methods:

- Retain logs according to the image-level backup
- Retain logs for the specified number of days

Retain Logs with Image-Level Backup

By default, Veeam Backup & Replication retains transaction log backups together with the corresponding image-level backup of the Microsoft SQL Server VM. When Veeam Backup & Replication removes a restore point of the image-level backup from the backup chain, it also removes a chain of transaction logs relating to this image-level backup.

This method allows you to have both the image-level backup and necessary transaction log backups at hand. If you need to recover a database to some state, you can restore the Microsoft SQL Database from the necessary restore point and perform transaction log replay to bring the database to the desired state.

Retain Logs for a Number of Days

You can instruct Veeam Backup & Replication to keep transaction logs only for a specific period of time. This retention setting can be used, for example, if you want to save on storage space and plan to retain transaction log backups for the last few days. In this case, you will be able to restore the database only to one of the most recent states.
If you select this retention method, you must make sure that retention policies for the image-level backup and transaction log backup are consistent. The restore point of the image-level backup must always be preserved. If a backup of the database itself is missing, you will not be able to perform transaction log replay.

Log Shipping Servers

For every Microsoft SQL Server VM whose transaction logs you want to back up, Veeam Backup & Replication defines how to ship logs to the backup repository. Transaction logs can be shipped in the following ways:

- If it is possible to establish a direct connection between the VM guest OS and backup repository, log files will be shipped directly from the VM guest OS to the backup repository. This is the optimal method, as it does not involve additional resources and puts less load on the VM guest OS.

- Otherwise, files will be shipped via log shipping servers. You can instruct Veeam Backup & Replication to choose a log shipping server automatically from the list of available ones, or to use a specific server.

  Note that if direct connection is possible, files will be always transferred from VM guest to repository directly (regardless of the configured log shipping server, as this server will not be involved). This approach helps to optimize performance at file transfer.

A log shipping server is a Microsoft Windows server added to the backup infrastructure. You can explicitly define what servers you want to use for log shipping or instruct Veeam Backup & Replication to automatically choose an optimal log shipping server. Veeam Backup & Replication chooses the log shipping server based on two criteria: possible data transfer methods and location of the Microsoft SQL Server VMs and log shipping server.

Data Transfer Methods

Log shipping servers can transport data in two ways:

- Over the network. In this scenario, Veeam Backup & Replication obtains files from the VM guest OS and transfers them over the network.

  To offload the VM guest OS, logs are created one by one (not simultaneously). One log creation request is issued for every DB.

- Over PowerShell Direct. In this scenario, Veeam Backup & Replication obtains transaction logs from the VM guest OS over PowerShell Direct, bypassing the network. PowerShell Direct is used for VMs that reside on Microsoft Hyper-V Server 2016 or later and run Microsoft Windows 10 or Microsoft Windows Server 2016 or later. Veeam Backup & Replication requires Microsoft PowerShell 2.0 or later to work over PowerShell Direct.

  The default method is log shipping over the network.
Location of Log Shipping Server and VMs

When choosing a log shipping server for the job, Veeam Backup & Replication considers the location of the Microsoft SQL Server VM and log shipping server. Veeam Backup & Replication uses the following priority rules to select the log shipping server:

1. Log shipping server is located on the source Microsoft Hyper-V host performing the role of the on-host backup proxy.
2. Log shipping server and Microsoft SQL Server VM are located in the same network.
3. Log shipping server and Microsoft SQL Server VM are located in different networks (the production infrastructure is isolated from the backup infrastructure).

That is, when choosing a log shipping server, Veeam Backup & Replication will give the top priority to a Microsoft Windows VM that is located on the source Microsoft Hyper-V host.

Log shipping servers are assigned per job session. When a new job session starts, Veeam Backup & Replication detects log shipping servers anew. Veeam Backup & Replication can also re-detect available servers during the job session. If a log shipping server becomes unavailable for some reason, Veeam Backup & Replication will fail over to another log shipping server.

**IMPORTANT!**

If you do not want to use some servers for transaction logs transport, you can manually define what server Veeam Backup & Replication must use as a log shipping server in the job settings. It is recommended that you assign the log shipping server role to a number of servers for availability purposes.
Transaction Log Backup Statistics

You can view the statistics of the transaction log backup job in the History view or in the Home view in Veeam Backup & Replication.

In the statistics window, you can examine the overall statistics for the transaction log backup job, as well as view per-VM information.

### Last period (all VMs)

<table>
<thead>
<tr>
<th>Database</th>
<th>RPD</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protected: 26</td>
<td>100%</td>
<td>Success: 1</td>
</tr>
<tr>
<td>Unprotected: 0</td>
<td>0</td>
<td>Warning: 0</td>
</tr>
<tr>
<td>Excluded: 12</td>
<td>00:00</td>
<td>Errors: 0</td>
</tr>
</tbody>
</table>

### Throughput (last 5 min)

<table>
<thead>
<tr>
<th>Name: cmr_db</th>
<th>Status: Pending</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration: 02:15</td>
<td>Read: 16.3 MB</td>
</tr>
<tr>
<td>Log size: 16.3 MB</td>
<td></td>
</tr>
</tbody>
</table>

### Latest session

- **SLA:** 100%
- **Misses:** 0
- **Max delay:** 00:00
- **Success:** 1
- **Warning:** 0
- **Errors:** 0

### Databases

- **Protected:** number of databases that were backed up at least once during the last session
- **Unprotected:** number of databases that failed to be backed up during the last session

In the upper part of the statistics window, Veeam Backup & Replication displays information about the transaction log backup job for all VMs included in the parent backup job.

The **Last period (all VMs)** section contains statistics data for the selected session of the backup job.

In the **Databases** column, you can view the following information:

- **Protected**
- **Unprotected**
• **Excluded** – databases excluded from processing. Databases may be excluded for the following reasons:
  o The database status is **Offline**.
  o The database recovery model is set to **Simple**.
  o The database is read-only.
  o The database was deleted after the latest full backup.
  o The AutoClose property is enabled for the database.
  o The database was excluded from application-aware processing. For details, see this Veeam KB article.
  o The database was excluded from SQL log backup processing. For details, see this Veeam KB article.
  o The database belongs to vCenter Server. For details, see this Veeam KB article.

**NOTE:**
Unprotected databases do not comprise **Excluded** databases, as they have different reasons for being non-processed.

In the **RPO** column, you can view the following information:

- **SLA value** – how many log backup intervals completed in time with successful log backup (calculated as percentage of total number of intervals).
- **Misses** – how many intervals were missed (number of intervals).
- **Max delay** – difference between the configured log backup interval and time actually required for log backup. If exceeded, a warning is issued.

In the **Status** column, the following information is displayed (per job): number of VMs processed successfully, with warnings or with errors.

The **Latest session** section displays the following information for the latest log processing interval for the selected VM:

- **Duration** – duration of log shipment from the VM guest OS to the backup repository since the current log processing interval has started
- **Bottleneck** – operation with the greatest duration in the last completed interval. The operation may have the following bottlenecks:

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Slowing-down Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log backup</td>
<td>Saving BAK files to a temporary location on VM guest OS</td>
</tr>
<tr>
<td>Network</td>
<td>Uploading log files to the log shipping server</td>
</tr>
<tr>
<td>Target</td>
<td>Saving files to the target repository</td>
</tr>
</tbody>
</table>

- **Read** – amount of data read from the temporary folder on VM guest OS
- **Transferred** – amount of data transferred to the target repository
The **Last period** section displays the following statistics of log backups per VM for the latest session of the transaction log backup job:

- **The RPO** column displays statistics on log processing interval (calculated as described above)
- **The Sessions** column includes statistics of log backups per VM, calculated as follows:
  - *Success* — number of intervals when all database logs were backed up successfully
  - *Warning* — number of sequential intervals with failed log processing (if not more than 4 intervals in a sequence)
  - *Errors* — number of sequential intervals with failed log processing (more than 4 intervals in a sequence)
- **The Duration** column includes the following information:
  - *Average* — average duration of log data transfer (through all intervals in the session)
  - *Max* — maximal duration of log data transfer (through all intervals in the session)
  - *Sync interval* — duration of periodic intervals specified for log backup in the parent job settings (default is 15 min)
- **The Log size** column displays the following information:
  - *Average* — average amount of data read from the VM guest OS through all intervals
  - *Max* — maximal amount of data read from the VM guest OS over all 15-min intervals
  - *Total* — total amount of data written to the backup repository

**NOTE:**
- Statistics on transaction log processing is updated periodically, simultaneously for the parent backup job and transaction log backup job.
- For Always On Availability groups, Veeam Backup & Replication collects logs only from one node. Thus, in reports, the status of database replicas will be the same for all nodes (Protected or Excluded).

**Log Files**

At each start of the SQL Server backup job (parent), a new .VLB is created to store log backups in the repository:

- If the **Use per-VM backup files** option is selected for the repository, then Veeam Backup & Replication will create a separate .VLB for each server processed by the job.
- If this option is cleared, then a single .VLB will be created for all servers processed by the job.

For example, if a job processes only one SQL Server, the repository will contain a number of .VLB files for it (a so-called chain).
As described in the section above, during database log backup (child) job session, transaction log backup is performed by native means of the SQL Server and stored as .BAK file to a temporary folder in the SQL Server VM guest file system. Then Veeam Backup & Replication copies .BAK file to the current .VLB in the repository. When the new parent job session starts, another .VLB is created, and the .BAK files that appear after that will be stored there during the child job session. The resulting chain of .VLBs will look like shown below, depicted for a single SQL Server VM1:

![Backup chain for VM1]

Total number of all LOG<N>.BAK files stored at the moment in all VLBs is reported as a number of restore points for the child job that backs up database logs. So, in the example above, the log backup job for SQL Server VM1 has created 8 restore points by the moment.

In the Veeam Backup & Replication console this number of restore points for the log backup job can be seen in the Restore Points column of the preview pane.

Support for AlwaysOn Availability Groups

AlwaysOn Availability Groups allow you to increase fault tolerance between active and hot-standby databases without involving shared physical disks, which is quite important for virtualization of Microsoft SQL Servers. Veeam Backup & Replication supports AlwaysOn Availability Groups for virtualized Microsoft SQL Server 2012 or later.

Image-level Backup of Microsoft SQL Server VMs

During image-level backup of a Microsoft SQL Server VM, Veeam Backup & Replication requests and analyzes information about databases that are included in the AlwaysOn Availability Groups. Depending on the retrieved information, Veeam Backup & Replication creates a VSS snapshot with or without COPY_ONLY flag. The VSS_BS_COPY flag for VSS snapshot is triggered if the VM represents a secondary node for at least one AlwaysOn Availability Group.

Veeam Backup & Replication also detects to what cluster the database belongs. If the backup job does not include all VMs from the cluster, an information message will be issued.

Retrieved information is saved for further log identification.

Transaction Log Backup

Transaction log backup can be performed only for those databases that were successfully backed up, either on the primary or on the secondary node of AlwaysOn Availability Group.

The transaction logs processing interval may be the same or may differ through VMs included in AlwaysOn Availability Group. If the interval is different, Veeam Backup & Replication will use minimal value (by default, 15 minutes).
At each log processing interval, Veeam Backup & Replication chooses the AlwaysOn Availability Group node for which transaction logs will be backed up.

Logs are backed up from one node of the AlwaysOn Availability Group. To become a subject for log backup, the node must meet the following criteria:

- Required Veeam Backup & Replication components can be installed on this node (the VM must be running).
- If there are any logs remaining in the temporary folder on the node of AlwaysOn Availability Group, this means these logs were not backed up to the backup repository during the previous session of the transaction log backup job, so this AlwaysOn Availability Group node must be processed first.
- Databases in the AlwaysOn Availability Groups for this node were successfully backed up for the last two processing intervals.
- Veeam Backup & Replication can establish a network connection to the node or PowerShell Direct connection, if a connection over the network cannot be established. PowerShell Direct is used for VMs that reside on Microsoft Hyper-V Server 2016 or later and run Microsoft Windows 10 or Microsoft Windows Server 2016 or later. Veeam Backup & Replication requires Microsoft PowerShell 2.0 or later to work over PowerShell Direct.
- The VM is in the list of preferred nodes for backup retrieved from the Microsoft SQL Server. If there are no preferred nodes, any node can be chosen.

**NOTE:**

When you configure a backup job to process Distributed Availability Groups transaction logs, select either primary or secondary distributed availability group. Otherwise, the log chain of the distributed group databases might become inconsistent.

When you configure a backup job to back up transaction logs for other Distributed Availability Groups, use the Perform copy only mode. See Application-Aware Processing to learn more about the copy only mode. You can also use the exclude feature to prevent Guest-OS database from being processed. See Exclude Objects from Backup Job to learn more on excluding objects. To read about distributed availability group limitations, see Configure distributed availability group.
Oracle Log Backup

Veeam Backup & Replication supports backup of Oracle database archived logs and restore of Oracle databases.

Database archived logs are created by the Oracle system. The Oracle database can run in one of the following logging modes:

- ARCHIVELOG turned on — logs are saved and can be used for recovery purposes.
- ARCHIVELOG turned off — no logs are saved. This mode is not recommended as it does not provide for proper disaster recovery.

With ARCHIVELOG turned on, the Oracle system stores database archived logs to a certain location on the VM guest OS, as specified by the database administrator. Veeam Backup & Replication allows you to set up the following ways of log handling:

- Instruct the backup job to collect log files from the Oracle VM and ship them to the backup repository where they are stored next to image-level backups of the Oracle VM.
- Skip log processing — log files remain untouched on the Oracle VM and are preserved within the image-level backup.

If you enable application-aware processing for an Oracle VM, during the job session Veeam Backup & Replication installs a runtime process on this VM to collect information about the database and process archived logs according to job settings. Application-specific settings are configured at the Guest Processing step of the backup job wizard — you can specify how logs should be backed up and/or deleted for Oracle databases.

Requirements for Archived Log Backup

- Veeam Backup & Replication supports archived log backup and restore for Oracle database version 11 and later. The Oracle database may run on a Microsoft Windows VM or Linux VM.
- Automatic Storage Management (ASM) is supported for Oracle 11 and later.
- Oracle Express Databases are supported if running on Microsoft Windows machines only.
- The database must run in the ARCHIVELOG mode.

Archived Log Backup Jobs

To back up archived logs, you must create a backup job, add Oracle VMs to it and specify advanced settings for archived logs backup in the job settings. The resulting job will comprise two jobs:

- Parent backup job — the backup job that creates an image-level backup of the Oracle VM. The parent backup job is named <job_name>, for example, Daily Job. You can configure the parent job in the Veeam Backup & Replication console just like any other backup job.
- Child job — an archived log backup job. To form a name of the child job, Veeam Backup & Replication adds a suffix to the name of the parent backup job: <parent_job_name> + Oracle Backup, for example, Daily Job Oracle Backup. Veeam Backup & Replication automatically creates the child job if it detects a backup job that is scheduled to back up at least one Oracle VM, and archived log backup is enabled for this job. Session data of the archived log backup job is stored in the configuration database and displayed in the Veeam Backup & Replication console.

The parent job runs in a regular manner — it starts by schedule or is started manually by the user. The archived log backup job is triggered by the parent backup job. This sequence ensures that the VM (and the database) restore point is present when you need to use archived logs to restore the database.
Sessions of Archived Log Backup Jobs

The archived log backup job runs permanently in the background, shipping archived logs to the backup repository at a specific time interval (by default, every 15 minutes). A sequence of time intervals between sessions of the parent backup job makes up a session of the archived log backup job.

The archived log backup session starts and stops in the following way:

- The initial session starts when the parent backup job schedule is enabled. After that, the session starts with every new session of the parent backup job.
- The session ends before the next session of the parent backup job or when this parent backup job is disabled.
- When the session ends, Veeam Backup & Replication stops the runtime process and uninstalls it from the VM guest OS. When a new session starts, the runtime process is deployed again.

How Oracle Archived Log Backup Works

The archived log backup for Oracle VMs is performed in the following way:

1. Veeam Backup & Replication launches the parent backup job by schedule.
2. The parent backup job creates an image-level backup of the Oracle VM and stores this backup to the backup repository.
3. A new session of the archived log backup starts. Veeam Backup & Replication accesses the VM guest OS to perform guest processing, collect database information and handle archived log.
   
   If Oracle runs on a Microsoft Windows server, Veeam Backup & Replication accesses the VM guest OS over a guest interaction proxy. You can instruct Veeam Backup & Replication to select the guest interaction proxy automatically or assign it explicitly.

   By default, Veeam Backup & Replication accesses the VM guest OS over the network:
   
   o For Linux VM guest OS — using SSH.
   o For Microsoft Windows VM guest OS — using RPC.

   If a network connection cannot be established, Veeam Backup & Replication accesses the VM guest OS over PowerShell Direct. PowerShell Direct is used for VMs that reside on Microsoft Hyper-V Server 2016 or later and run Microsoft Windows 10 or Microsoft Windows Server 2016 or later. Veeam Backup & Replication requires Microsoft PowerShell 2.0 or later to work over PowerShell Direct.

4. Veeam Backup & Replication deploys the runtime process in the VM guest OS. The runtime process scans the Oracle system and collects information about databases whose logs must be processed, including:
   
   o List of all databases
   o Database state — a database is on or off, in which logging mode it runs
   o Paths to all database files (configuration logs and so on) and other data required for backup

   Veeam Backup & Replication also detects whether it is possible to store logs to the backup repository through a direct access or a log shipping server is required.

   The runtime process copies archived log files from the log archive destination (set by the Oracle administrator) to a temporary folder on the VM guest file system.
5. Veeam Backup & Replication maps information about the Oracle system collected at step 4 with information kept in the configuration database. This periodic mapping helps reveal databases for which Veeam Backup & Replication must ship archived logs to the backup repository during this time interval.

6. Archived log backup files are transferred from the temporary location on the Oracle VM to the backup repository, either directly or via the log shipping server. The source-side Veeam Data Mover compresses log data to be transferred according to its built-in settings. On the backup repository side, data is compressed according to the parent backup job settings.

Archived logs that for some reason were not processed during the log backup interval remain in the temporary folder and are processed during the next log backup interval. To detect these remaining logs, Veeam Backup & Replication enumerates log files in the temporary folder.

**NOTE:**

If a new session of the archived log backup starts and the parent backup job has not created a new restore point yet, the archived log backup job will remain in the idle state, waiting for a new restore point to be created.

**IMPORTANT!**

Before backup, Veeam Backup & Replication shuts down databases in the NOARCHIVELOG mode. For details, see the Backing Up a Database in NOARCHIVELOG Mode section in the Oracle Database Backup and Recovery User Guide.

**Retention for Archived Log Backup**

Archived log backups are stored in files of the proprietary Veeam format — VLB. Veeam Backup & Replication keeps archived log backups together with the VM image-level backup. The target location of VLB files depend on the type of the backup repository:

- If you store the VM image-level backup in a backup repository, Veeam Backup & Replication writes archived log backups to the same folder where files of the image-level backup reside.

- If you store the VM image-level backup in a scale-out backup repository, Veeam Backup & Replication writes archived log backups to the extent where the latest incremental backup file of the VM image-level backup is stored.
Veeam Backup & Replication removes archived log backups by retention. You can choose one of the following retention methods:

- Retain logs according to the image-level backup
- Retain logs for the specified number of days

**Retain Logs with Image-Level Backup**

By default, Veeam Backup & Replication retains archived log backups together with the corresponding image-level backup of the Oracle VM. When Veeam Backup & Replication removes a restore point of the image-level backup from the backup chain, it also removes a chain of archived logs relating to this image-level backup.

This method allows you to have both the image-level backup and necessary archived log backups at hand. If you need to recover a database to some state, you can restore the Oracle VM from the necessary restore point and use archived logs to bring the database to the desired state.

**Retain Logs for a Number of Days**

You can instruct Veeam Backup & Replication to keep archived logs only for a specific period of time. This retention setting can be used, for example, if you want to save on storage space and plan to retain archived log backups for the last few days. In this case, you will be able to restore the database only to one of the most recent states.

If you select this retention method, you must make sure that retention policies for the image-level backup and archived log backup are consistent. The restore point of the image-level backup must always be preserved. If a backup of the database itself is missing, you will not be able to use archived logs.

**Log Shipping Servers**

For every Oracle VM whose archived logs you want to back up, Veeam Backup & Replication defines how to ship logs to the backup repository. Archived logs can be transported in the following ways:

- Directly from the VM guest OS to the backup repository. This method is recommended — it does not involve additional resources and puts less load on the VM guest OS.
Via log shipping servers. If it is not possible to establish a direct connection between the VM guest OS and backup repository, you can configure Veeam Backup & Replication to use a log shipping server.

A log shipping server is a Microsoft Windows or Linux server added to the backup infrastructure. You can explicitly define what servers you want to use for log shipping or instruct Veeam Backup & Replication to automatically choose an optimal log shipping server. Veeam Backup & Replication chooses the log shipping server based on two criteria: possible data transfer methods and location of the Oracle VM and log shipping server.

**Data Transfer Methods**

Log shipping servers can transport data in two ways:

- **Over the network.** In this scenario, Veeam Backup & Replication obtains files from the VM guest OS and transfers them over the network.

- **Over PowerShell Direct.** In this scenario, Veeam Backup & Replication obtains archived logs from the VM guest OS over PowerShell Direct, bypassing the network. PowerShell Direct is used for VMs that reside on Microsoft Hyper-V Server 2016 or later and run Microsoft Windows 10 or Microsoft Windows Server 2016 or later. Veeam Backup & Replication requires Microsoft PowerShell 2.0 or later to work over PowerShell Direct.

The default method is log shipping over the network.

**Location of Log Shipping Server and VMs**

When choosing a log shipping server for the job, Veeam Backup & Replication considers the location of the Oracle VM and log shipping server. Veeam Backup & Replication uses the following priority rules to select the log shipping server:

1. Log shipping server is located on the source Microsoft Hyper-V host performing the role of the on-host backup proxy.

2. Log shipping server and Oracle VM are located in the same network.

3. Log shipping server and Oracle VM are located in different networks (the production infrastructure is isolated from the backup infrastructure).

That is, when choosing a log shipping server, Veeam Backup & Replication will give the top priority to a VM that is located on the source Microsoft Hyper-V host.

Log shipping servers are assigned per job session. When a new job session starts, Veeam Backup & Replication detects log shipping servers anew. Veeam Backup & Replication can also re-detect available servers during the job session. If a log shipping server becomes unavailable for some reason, Veeam Backup & Replication will fail over to another log shipping server.
IMPORTANT!

If you do not want to use some servers for archived logs transport, you can manually define what server Veeam Backup & Replication must use as a log shipping server in the job settings. It is recommended that you assign the log shipping server role to a number of servers for availability purposes.

Archived Log Backup Statistics

You can view the statistics of the archived log backup job in the History view or in the Home view in Veeam Backup & Replication.
In the statistics window, you can examine the overall statistics for the archived log backup job, as well as view per-VM information.

### Databases (all VMs)

The **Last period** (all VMs) section contains statistics data for the selected session of the backup job.

In the **Databases** column, you can view the following information:

- **Protected** – number of databases that were backed up at least once during the last session
- **Unprotected** – number of databases that failed to be backed up during the last session
- **Excluded** – databases excluded from processing. Databases may be excluded for the following reasons: ARCHIVELOG mode is turned off for the database (the database is in NOARCHIVELOG mode), database was deleted after the latest full backup, or database was added to the list of exclusions.

---

*632 | Veeam Backup & Replication | User Guide for Microsoft Hyper-V*
NOTE:
Unprotected databases do not comprise Excluded databases, as they have different reasons for being non-
processed. See also this Veeam KB article for information on processing databases in NOARCHIVE mode.

In the RPO column, you can view the following information:

- **SLA** — how many log backup intervals completed in time with successful log backup (calculated as percentage of total number of intervals).
- **Misses** — how many intervals failed to complete in time with successful log backup (number of intervals).
- **Max delay** — difference between the configured log backup interval and time actually required for log backup. If exceeded, a warning is issued.

In the Status column, the following information is displayed (per job): number of VMs processed successfully, with warnings or with errors.

The Latest session section displays the following information for the latest log processing interval for the selected VM:

- **Duration** — duration of log shipment from the VM guest OS to the backup repository since the current log processing interval has started
- **Bottleneck** — operation with the greatest duration in the last completed interval. The operation may have the following bottlenecks:

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Slowing-down Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log backup</td>
<td>Saving archived log files to a temporary location on VM guest OS (to work around, see the Veeam KB article: this Veeam KB article)</td>
</tr>
<tr>
<td>Network</td>
<td>Uploading log files to the log shipping server</td>
</tr>
<tr>
<td>Target</td>
<td>Saving files to the target repository</td>
</tr>
</tbody>
</table>

- **Read** — amount of data read from the temporary folder on VM guest OS
- **Transferred** — amount of data transferred to the target repository

The Last period section displays the following statistics of log backups per VM for the latest session of the log backup job:

- The RPO column displays statistics on log processing interval (calculated as described above)
- The Sessions column includes statistics of log backups per VM, calculated as follows:
  - **Success** — number of intervals when all database logs were backed up successfully
  - **Warning** — number of sequential intervals with failed log processing (if not more than 4 intervals in a sequence)
  - **Errors** — number of sequential intervals with failed log processing (more than 4 intervals in a sequence)
• The **Duration** column includes the following information:
  - *Average* — average duration of log data transfer (through all intervals in the session)
  - *Maximum* — maximal duration of log data transfer (through all intervals in the session)
  - *Sync interval* — duration of periodic intervals specified for log backup in the parent job settings (default is 15 min)

• The **Log size** column displays the following information:
  - *Average* — average amount of data read from the VM guest OS through all intervals
  - *Maximum* — maximal amount of data read from the VM guest OS over all 15-min intervals
  - *Total* — total amount of data written to the backup repository

The pane below shows all actions performed during the job run. To filter out actions with the certain status, use the **Errors**, **Warnings** and **Success** buttons.

**NOTE:**
Statistics on archived log processing is updated periodically, simultaneously for the VM backup job (parent) and archived log backup job (child job).

**Log Files**

At each start of the Oracle backup job (‘parent’), a new .VLB is created to store log backups in the repository:

- If the **Use per-VM backup files** option is selected for the repository, then Veeam will create a separate .VLB for each server processed by the job.
- If this option is cleared, then a single .VLB will be created for all servers processed by the job.

For example, if a job processes only one Oracle server, the repository will contain a number of .VLB files for it (a so-called chain).

As described in the section above, during database log backup (‘child’) job session, log archiving is performed by native means of the Oracle server. Archived logs are stored to a temporary folder on the Oracle VM guest file system. Then Veeam copies archived log to the current .VLB in the repository. When the new ‘parent’ job session starts, another .VLB is created, and the archived log files that appear after that will be stored there during the ‘child’ job session. The resulting chain of .VLBs will look like shown below, depicted for a single Oracle VM1:

![Backup Chain Diagram](image)

Total number of all archived logs files stored at the moment in all VLBs is reported as a **number of restore points for the 'child' job** that backs up database logs. So, in the example above, the log backup job for Oracle VM1 has created 8 restore points by the moment.
Backup Job Scheduling

You can start backup jobs manually or schedule them to start automatically at specific time. Veeam Backup & Replication lets you configure the following settings for the job:

- Scheduling settings
- Job retry settings
- Backup window settings

Automatic Startup Schedule

To run a job periodically without user intervention, you can schedule the job to start automatically. The Veeam Backup Service running on the backup server continuously checks configuration settings of all jobs configured on the backup server, and starts them according to their schedule.

Veeam Backup & Replication lets you configure the following scheduling settings for jobs:

- You can schedule jobs to run at specific time every day or on selected days
- You can schedule jobs to run periodically at specific time intervals
- You can schedule jobs to run continuously
- You can chain jobs

Jobs Started at Specific Time

You can schedule jobs to start at specific time daily, on specific week days or monthly on selected days.

This type of schedule requires that you define the exact time when the job must be started. For example, you can configure the job to start daily at 10:00 PM or every first Sunday of the month at 12:00 AM.

Jobs Started at Specific Time Intervals

You can schedule jobs to start periodically throughout a day at a specific time interval. The time interval between job sessions can be defined in minutes or hours. For example, you can configure a job to start every 30 minutes or every 2 hours.

For periodically run jobs, reference time is midnight (12:00 AM). Veeam Backup & Replication always starts counting defined intervals from 12:00 AM, and the first job session will start at 12:00 AM. For example, if you configure a job to run with a 4-hour interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 PM and so on.
If necessary, you can specify an offset for periodically run jobs. The offset is an exact time within an hour when the job must start. For example, you can configure the job to start with a 4-hour interval and specify offset equal to 15 minutes. In this case, the job will start at 12:15 AM, 4:15 AM, 8:15 AM, 12:15 PM, 4:15 PM and so on.

If a session of a periodically run job does not fit into the specified time interval and overlaps the next planned job session, Veeam Backup & Replication starts the next backup job session at the nearest scheduled interval. For example, you set up a job to run with a 4-hour interval. The first job session starts at 12:00 AM, takes 5 hours and completes at 5:00 AM. In this case, Veeam Backup & Replication will start a new job session at 8:00 AM.

**Jobs Run Continuously**

You can schedule the job to run continuously — that is, in a non-stop manner. A new session of a continuously running job starts as soon as the previous job session completes. Continuously run jobs can help you implement near-continuous data protection (near-CDP) for the most critical applications installed on VMs.

**Chained Jobs**

In the common practice, data protection jobs configured in the virtual environment start one after another: when job $A$ finishes, job $B$ starts and so on. You can create a chain of jobs using scheduling settings. To do this, you must define the start time for the first job in the chain. For other jobs in the chain, you must select the **After this job** option and choose the preceding job from the list.

Job chaining is not limited to jobs of specific type only. You can create a chain of jobs of different types. For example, you can:

1. Set a backup job as the first job in the chain.
2. Configure a SureBackup job and chain with the backup job. In this case, Veeam Backup & Replication will automatically verify a backup file created with the backup job after the backup job completes.

**NOTE:**

If you start the initial job manually, Veeam Backup & Replication will offer you to start jobs chained to it as well. Click **Yes** to start the whole job chain or **No** to start only the first job in the chain.

If you start the initial job manually and chain another job to it while the initial job is running, the chained job will not start when the initial job completes.
Recommendations on Job Chaining

You should use job chaining wisely. Job chaining removes guesswork from job scheduling but has a number of drawbacks:

- You cannot predict precisely how much time the initial job will require and when jobs chained to it will start. Depending on the situation, the job schedule may shift, and some operations may even not be performed as planned.

  For example, you configure 2 jobs:
  
  - Job 1 is scheduled to start at 10:00 PM daily and typically takes 1 hour.
  - Job 2 is scheduled to start after Job 1 daily. Synthetic full backup is scheduled on Saturday.

  Imagine that Job 1 starts on Saturday and runs for 2.5 hours instead of 1 hour. Job 2 will then start after midnight on Sunday, and the synthetic full backup planned on Saturday will not be created.

- Errors in job sessions may cause the job schedule to shift. For example, if the initial job in the chain fails, Veeam Backup & Replication will attempt to retry it, and the schedule for chained jobs will shift.

- Load on backup infrastructure resources may be not balanced. Some slots on backup proxies and backup repositories may be available but will not be used since jobs are queued to run one by one. And if you use a backup repository that supports multiple I/O streams, its resources will not be used efficiently.

Instead of job chaining, you can balance the load on backup infrastructure components. To do this, you must limit the number of concurrent tasks on backup proxies and backup repositories. For more information, see Limiting the Number of Concurrent Tasks.

Job Retry

You can instruct Veeam Backup & Replication to retry a job several times if the initial job pass fails. By default, Veeam Backup & Replication automatically retries a failed job for 3 times within one job session. If necessary, however, you can define a custom number of retries in the job settings.

Veeam Backup & Replication retries a job only if the previous job session has failed, and one or several VMs in the job have not been processed. Veeam Backup & Replication does not perform a retry if a job session has finished with the Success or Warning status. During the job retry, Veeam Backup & Replication processes only those VMs that have failed.

**IMPORTANT!**

Veeam Backup & Replication does not perform automatic retry for jobs that were started or stopped manually.

Veeam Backup & Replication always creates one backup file within one job session. If a job processes several VMs and some of them fail to be processed during the first job pass, Veeam Backup & Replication will create a backup file containing data for those VMs that have been successfully processed. During a job retry, Veeam Backup & Replication will attempt to process failed VMs. In case of success, Veeam Backup & Replication will write data of processed VMs to the backup file that was created at the initial job pass.

In some situations, Veeam Backup & Replication may fail to process VMs during all job retries. In this case, failed VMs will be processed during the next job session. Their data will be written to the backup file created within the current job session.

For example, you have configured a job for 2 VMs: VM 1 and VM 2. The job uses the forward incremental method.
During the first job session, Veeam Backup & Replication successfully processed VM 1 and created a full backup file for it. VM 2 has failed to be processed during all 3 job retries. In this case, Veeam Backup & Replication will attempt to process the failed VM 2 within the next job session. Data for VM 2 will be written to the backup file created within this job session, which will be an incremental backup. As a result, at the end of the second backup job session, you will have 2 files:

- Full backup file containing a full restore point for VM 1
- Incremental backup file containing a full restore point for VM 2 and an incremental restore point for VM 1

### Backup Window

If necessary, you can specify a backup window for jobs. The backup window is a period of time on week days when jobs are permitted to run. If the job exceeds the allowed window, Veeam Backup & Replication will automatically terminate it.

The backup window can be helpful if you do not want data protection jobs to produce unwanted overhead for the production environment or do not want jobs to overlap production hours. In this case, you can define the time interval during which the job must not run.

**IMPORTANT!**

The backup window affects only the data transport process and health check operations. Other transformation processes can be performed in the target repository outside the backup window.
Backup Window for Periodically Run Jobs

If you define the backup window for a job that runs periodically at specific time intervals, Veeam Backup & Replication will immediately start the job after the denied window is over. All subsequent backup job sessions will be performed according to specified scheduling settings.

For example, you have configured a job to run with a 4-hour interval with an offset of 15 minutes. The allowed backup window for the job is 7:00 PM to 8:00 AM. Veeam Backup & Replication will run this job in the following way:

1. The first job session will start at 12:15 AM (since midnight is a reference time for periodically run jobs).
2. The next job session will start at 4:15 AM.
3. The job session at 8:15 AM will not be performed as it falls into the denied period of the backup window.
4. The next job session will start immediately after the denied period is over: at 7:15 PM.
5. After that, Veeam Backup & Replication will run the job by the defined schedule: at 8:15 PM, 12:15 AM and so on.

Manual Start of Backup Jobs

You can start jobs manually if you need to capture VM data at a specific point in time and do not want to re-configure job scheduling settings. For example, you can start a job to create a VM backup before you install new software on a VM or enable a new feature.

When you start the job manually, Veeam Backup & Replication runs a regular job session that produces a new restore point in the backup chain in the backup repository.
To start and stop jobs configured on the backup server, you can use the **Start** and **Stop** buttons on the ribbon or corresponding commands in the shortcut menu.

**Manual Stop of Backup Jobs**

You can stop job execution at any moment of time. For example, you can stop a job if the job processes several VMs but the workload appears to be greater than you expected. Or you can stop the job if there is not enough time to finish the job session.

You can stop a job in 2 ways:

- **You can stop the job immediately.** In this scenario, Veeam Backup & Replication terminates the job session and does not create a new restore point for VMs that are currently processed.
- **You can stop the job gracefully.** In this scenario, Veeam Backup & Replication creates a restore point for the VMs that are currently processed and then terminates the job session.

**Immediate Stop of Jobs**

Immediate job stop terminates the job session instantly. The job finishes with the following results:

- VMs that Veeam Backup & Replication has succeeded to process by the time you stop the job will have new restore points.
- VMs that Veeam Backup & Replication is currently processing and VMs that Veeam Backup & Replication has not started to process will not have new restore points.

When you stop a job session immediately, Veeam Backup & Replication performs the following operations:

1. If a checkpoint for a VM has already been created, Veeam Backup & Replication instructs Microsoft Hyper-V to remove the checkpoint.
2. Veeam Backup & Replication terminates all job processes and tasks. The job is finished with the *Failed* error.

All restore points created with the previous job sessions remain untouched. You can use them for restore operations.

<table>
<thead>
<tr>
<th>VMs</th>
<th>VM 1</th>
<th>VM 2</th>
<th>VM 3</th>
<th>VM 4</th>
<th>VM 5</th>
<th>VM 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore points</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>

**Graceful Stop of Jobs**

Graceful job stop instructs Veeam Backup & Replication that it must create restore points for VMs that are currently being processed, and then terminate the job. The job finishes with the following results:

- VMs that Veeam Backup & Replication has succeeded to process and VMs that are being processed will have new restore points.
- VMs that Veeam Backup & Replication has not started to process will not have new restore points.

You can use graceful job stop for the following types of jobs:

- Backup jobs
- Replication jobs

You cannot use graceful job stop for the following types of jobs:

- File copy jobs
- Backup copy jobs
- Restore operations

VMs added to the job are processed in the order defined in job settings. Information about VMs that have already been processed and VMs that are being processed is displayed in job details.

If you stop the job gracefully before Veeam Backup & Replication starts processing the first VM in the job, the job will be finished with the *Failed* error. You will see the message *Operation was canceled by user* in job details.

<table>
<thead>
<tr>
<th>VMs</th>
<th>VM 1</th>
<th>VM 2</th>
<th>VM 3</th>
<th>VM 4</th>
<th>VM 5</th>
<th>VM 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore points</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>
Health Check for Backup Files

You can instruct Veeam Backup & Replication to periodically perform a health check for the latest restore point in the backup chain. During the health check, Veeam Backup & Replication performs a CRC check for metadata and a hash check for VM data blocks in the backup file to verify their integrity. The health check helps make sure that the restore point is consistent, and you will be able to restore data from this restore point.

The health check can be performed for all types of backup chains:

- Forever forward incremental
- Forward incremental
- Reverse incremental backup chains

To run the health check periodically, you must enable the **Perform backup files health check** option in the backup job settings and define the health check schedule. By default, the health check is performed on the last Friday of every month. You can change the schedule and run the health check weekly or monthly on specific days.

**NOTE:**

Veeam Backup & Replication performs the health check during the first job session on the day when the health check is scheduled. If another job session runs on the same day, Veeam Backup & Replication will not perform the health check during this job session. For example, if the job is scheduled to run several times on Saturday, and the health check is scheduled on Saturday, the health check will only be performed during the first backup job session on Saturday.
Verification Content

The health check always verifies only the latest restore point in the backup chain. In case of forever forward incremental and forward incremental backup chains, if the latest restore point is incomplete, the health check verifies the restore point preceding the latest one.

Bear in mind that the health check procedure verifies not the latest backup file in the backup chain, but the latest restore point for a VM. The latest restore point corresponds to the state of the VM at the date and time when the latest backup file for this VM was created. Data blocks that are required to "compose" the VM latest state are typically spread out across several backup files in the backup chain. Therefore, to verify the latest state of the VM, Veeam Backup & Replication must open several backup files in the backup chain and read data blocks from these backup files. For this reason, the health check procedure may take long.

The health check verifies only those virtual disks of a VM that are available in the latest restore point. For example, you added a VM with 3 virtual disks to a backup job. The VM was backed up Sunday through Tuesday. On Wednesday, you removed 1 virtual disk, and Veeam Backup & Replication run the health check for the VM. During the health check, Veeam Backup & Replication will verify only the 2 remaining virtual disks.

The health check verifies only those VMs that are available in the latest restore point. For example, you added 2 VMs to a backup job and run the job for some time. The health check verified 2 VMs. If you remove 1 VM from the backup job, the next scheduled health check run will verify the latest unverified restore point for the removed VM, and the latest restore point for the remaining VM. In future, the health check will verify only the restore point for the remaining VM in the job.

Limitations for Health Check

- The health check is not performed during an active full backup job session started manually or automatically by schedule.
- The health check is not performed for offloaded restore points. For more information, see Capacity Tier.
- [For per-VM backup chains] If you add a new VM to an existing backup job that has been run for some time, Veeam Backup & Replication will perform the health check for it during the next incremental backup job session for the added VM.

How Health Check Works

When Veeam Backup & Replication saves a new restore point to the backup repository, it calculates CRC values for backup metadata and hash values for data blocks of VM disk in the backup file, and saves these values in the metadata of the backup file, together with VM data. During the health check session, Veeam Backup & Replication uses these values to make sure that a verified restore point is consistent.
NOTE:
If you perform health check for encrypted backup files, Veeam Backup & Replication will pass encryption keys to the regular backup repository or cloud repository. For more information on encryption, see Data Encryption.

Veeam Backup & Replication uses different mechanisms of health check for different types of backup chains:

- **Forever forward incremental and forward incremental backup chains**
- **Reverse incremental backup chains**
- **Mixed backup chains (chains containing forward incremental and reverse incremental restore points)**

**Forever Forward Incremental and Forward Incremental Backup Chains**

The health check for forward incremental backup chains is performed in the following way:

1. At the end of the backup job session, Veeam Backup & Replication performs the health check. It calculates CRC values for backup metadata and hash values for VM disks data blocks in the backup file and compares them with the CRC and hash values that are already stored in the backup file.

   During the health check, Veeam Backup & Replication verifies the latest restore point in the backup chain (restore point created with the current backup job session — the session during which the health check is performed). If the latest restore point in the backup chain is incomplete, Veeam Backup & Replication checks the restore point preceding the latest one.

2. If the health check does not detect data corruption, the backup job session completes in a regular way.

   If the health check detects corrupted data, Veeam Backup & Replication completes the backup job with the **Error** status and starts the health check retry process. The health check retry starts as a separate backup job session.

   Depending on the revealed data corruption, Veeam Backup & Replication performs the following actions:

   - If the health check has detected corrupted backup metadata in the full backup file, Veeam Backup & Replication marks the backup chain starting from this full restore point as corrupted in the configuration database. During the health check retry, Veeam Backup & Replication transports data blocks of the whole VM image from the source volume, creates a new full backup file in the backup repository and saves transported data blocks to it.

   - If the health check has detected corrupted backup metadata in the incremental backup file, Veeam Backup & Replication removes information about this incremental restore point and subsequent incremental restore points from the configuration database. During the health check retry, Veeam Backup & Replication transports incremental data relatively the latest valid restore point in the backup chain from the source volume, creates a new incremental backup file in the backup repository and saves transported data blocks to it.
If the health check has detected corrupted VM disk blocks in the full or incremental backup file, Veeam Backup & Replication marks the restore point that includes the corrupted data blocks and subsequent incremental restore points as corrupted in the configuration database. During the health check, Veeam Backup & Replication transports data blocks from the source volume. In addition, Veeam Backup & Replication transports data blocks that have changed since the backup job session that has triggered the health check. Veeam Backup & Replication stores these data blocks to the latest restore point that has been created with the current backup job session (session that has triggered the health check retry).

Reverse Incremental Backup Chains

In case of reverse incremental backup chains, the health check always verifies only the latest restore point in the backup chain, which is always a full backup file.

The health check is performed in the following way:

1. At the end of the backup job session, Veeam Backup & Replication verifies the full backup file. Veeam Backup & Replication calculates CRC values for backup metadata and hash values for VM disks data blocks in the full backup file, and compares them with the CRC and hash values that are already stored in the full backup file.

2. If the health check does not detect data corruption, the backup job session completes in a regular way. If the health check detects corrupted data, Veeam Backup & Replication completes the backup job with the Error status and starts the health check retry process. The health check retry starts as a separate backup job session.

Depending on the revealed data corruption, Veeam Backup & Replication performs the following actions:

- If the health check has detected corrupted backup metadata in the full backup file, Veeam Backup & Replication marks the whole backup chain (full backup file and preceding reverse incremental backup files) as corrupted in the configuration database. During the health check retry, Veeam Backup & Replication transports data blocks of the whole VM image from the source datastore, creates a new full backup file in the backup repository and saves transported data blocks to it.
If the health check has detected corrupted VM disk blocks in the full backup file, Veeam Backup & Replication marks the full backup file and preceding reverse incremental backup files as corrupted in the configuration database. During the health check retry, Veeam Backup & Replication transports data blocks from the source datastore. In addition, Veeam Backup & Replication transports data blocks that have changed since the backup job session that has triggered the health check. Veeam Backup & Replication stores these data blocks to the existing full backup file in the backup repository. Corrupted data blocks that have been replaced with data blocks from the source datastore are stored to an existing reverse incremental backup file preceding the full backup file.

Mixed Backup Chains

If you enable the Transform previous backup chains into rollback option in the job settings, Veeam Backup & Replication creates a mixed backup chain that contains two types of incremental backup files – reverse incremental backup files (VRB) and forward incremental backup files (VIB). In case of mixed backup chains, Veeam Backup & Replication performs a health check only the forward incremental part of the backup chain. The reverse incremental part of the backup chain is not verified. However, if Veeam Backup & Replication detects corrupted data blocks metadata or VM disk data blocks in the full backup file, it marks preceding reverse incremental backup files as corrupted in the configuration database.

Health Check Retries

The health check itself is started during the backup job session or the job retry session if the backup job session has failed. If attempts are not successful, Veeam Backup & Replication performs the health check during the last job retry in any case.

If the health check detects corrupted data, Veeam Backup & Replication completes the backup job with the Error status and starts the health check retry process. The health check retry starts as a separate backup job session. During the health check retry, Veeam Backup & Replication attempts to transport data blocks for the corrupted restore point from the source datastore.

For scheduled jobs, the number of health check retries is equal to the number of job retries specified in the job settings. For jobs started manually, Veeam Backup & Replication performs 1 health check retry.
NOTE:

If Veeam Backup & Replication fails to fix the corrupted data during all health check retries, you must retry the job manually. In this case, Veeam Backup & Replication will transport the required data blocks from the source datastore to fix the latest restore point. If the latest restore point in the backup chain is incomplete, Veeam Backup & Replication will attempt to fix the restore point preceding the latest one.
Compact of Full Backup File

If you use a forever forward incremental or reverse incremental backup method, the backup job constantly transforms the full backup file in the backup chain to meet retention policy settings. The transformation process, however, has a side effect. In the long run, the full backup file grows large and gets fragmented. The file data occurs to be written to non-contiguous clusters on disk, and operations of reading and writing data from and to the backup file slow down.

To resolve the fragmentation problem, you can instruct Veeam Backup & Replication to compact the full backup file periodically. During the file compact operation, Veeam Backup & Replication creates a new empty file and copies to it data blocks from the full backup file. As a result, the full backup file gets defragmented and the speed of reading and writing from and to the file increases.

To compact the full backup file periodically, you must enable the **Defragment and compact full backup file** option in the backup job settings and define the compact operation schedule. By default, the compact operation is performed on the last Saturday of every month. You can change the compact operation schedule and instruct Veeam Backup & Replication to perform it weekly or monthly on specific days.

Limitations for Full Backup File Compact

The full backup file compact has the following limitations:

- **The Defragment and compact full backup file** option works for forever forward incremental or reverse incremental backup chains. For this reason, you must not schedule active or synthetic full backups.

Although you do not schedule active full backups for forever forward incremental or reverse incremental backup chains, full backups can be created. For example, you can create them manually or Veeam Backup & Replication can create them during the health check. On the day when active full backups are triggered, Veeam Backup & Replication does not create compact full backups. Veeam Backup & Replication will create them on another day during the backup job session.
• Veeam Backup & Replication does not compact full backup files that have been offloaded to cloud-based object storage. For more information, see Capacity Tier.

• The backup repository must have enough space to store a file of the full backup size. During the compact process, Veeam Backup & Replication creates auxiliary files that exist in the backup repository until the end of the compact operation.

• [For per-VM backup chains] If you add a new VM to an existing backup job that has been run for some time, Veeam Backup & Replication will perform the compact full operation for it during the next incremental backup job session for the added VM.

• If you change the block size in backup job settings, Veeam Backup & Replication does not change the block size in the compacted backup file till the next full backup. However, if you change compression settings in backup job settings, during the next compact file operation Veeam Backup & Replication changes the compression level for the compacted backup file.

Removal of Deleted VMs Data

During the compact operation, Veeam Backup & Replication does not copy all data blocks from the VBK file to the newly created file. It copies only data blocks of VMs whose information is stored in the configuration database. For example, if the VM is removed from the backup job, its data is not copied to the new full backup file. This approach helps reduce the size of the full backup file and remove unnecessary data from it.

VM Data Take Out

If the full backup file contains data for a VM that has only one restore point and this restore point is older than 7 days, during the compact operation Veeam Backup & Replication will extract data for this VM from the full backup file and write this data to a separate full backup file. Such backup will be displayed under the Backups > Disk (imported) node in the Home view.

The mechanism works if the following conditions are met:

• The Remove deleted VMs data option is not enabled in the backup job settings.

• The Use per-VM backup files option is not enabled in backup repository settings.
Resume on Disconnect

Veeam Backup & Replication can handle a situation of an unstable network during backup, backup copy and replication jobs. If a network connection drops for a short period of time during the data transport process, Veeam Backup & Replication automatically resumes the dropped network connection. The data transfer process starts from the point when the connection was lost. The resume on disconnect capability improves the reliability of remote data transfer, reduces the backup window and minimizes the network load.

Veeam Backup & Replication automatically re-establishes a connection between the following backup infrastructure components engaged in the data transfer process:

- Backup server
- Source and target Microsoft Hyper-V hosts
- Off-host backup proxy
- Backup repository

Resume on disconnect works only for dropped network connections. Veeam Backup & Replication attempts to resume the connection with an interval of 15 seconds during 30 minutes. If the problem has any other nature, Veeam Backup & Replication retries the job in a regular manner.

Veeam Backup & Replication does not create a new restore point on resume: VM data is written to the same restore point that was created for the current job session. When resuming the data transfer process, Veeam Backup & Replication regards VM disks, not the whole VM.

For example, a VM has two disks: disk A and disk B. Before the connection dropped, Veeam Backup & Replication managed to transfer 20 GB of disk A and did not start transferring disk B. After the connection is re-established, Veeam Backup & Replication will start transferring the data for disk A from the 20 GB point; data of the whole disk B will be transferred anew.
Creating Backup Jobs

To back up VMs, you must configure a backup job. The backup job defines how, where and when to back up VM data. One job can be used to process one or more VMs. Jobs can be started manually or scheduled to run automatically at a specific time.

Before you create a backup job, check prerequisites. Then use the New Backup Job wizard to configure the backup job.
Before You Begin

Before you create a backup job, check the following prerequisites:

- Backup infrastructure components that will take part in the backup process must be added to the backup infrastructure and properly configured. These include Microsoft Hyper-V hosts on which VMs are located and backup repository. If you want to perform backup in the off-host backup mode, the off-host backup proxy must also be added to the backup infrastructure and properly configured.

- The backup repository must have enough free space to store created backup files. To receive alerts about low space in the backup repository, configure global notification settings. For more information, see Specifying Other Notification Settings.

- For VM guest OS indexing on Linux-based VMs, a user account with root privileges on the VM is required. It is recommended that you create a separate user account for work with Veeam Backup & Replication on the Linux-based VM, grant root privileges to this account and specify settings of this account at the Guest Processing step of the New Backup Job wizard.

- If you plan to map a backup job to a backup file that already exists in the backup repository, you must perform the rescan operations for this backup repository. Otherwise, Veeam Backup & Replication will not be able to recognize backup files in the backup repository. For more information, see Rescanning Backup Repositories.

- If you plan to configure a secondary destination for the backup job, you can create a backup copy job or backup to tape job beforehand. The backup copy job or backup to tape job can have an empty source, that is, can be not linked to any backup job. For more information, see Creating Backup Copy Jobs and Creating Backup to Tape Jobs.

- If you plan to use pre-job and post-job scripts and/or pre-freeze and post-thaw scripts, you must create scripts before you configure the backup job.

- To back up Microsoft SQL transaction logs with Veeam Backup & Replication, you must make sure that the recovery model is set to Full or Bulk-logged recovery model for required databases on Microsoft SQL Server VMs. If the recovery model is set to Simple, Veeam Backup & Replication will not detect and process transaction logs on Microsoft SQL Server VMs.

- Veeam Backup & Replication excludes from application-aware processing Microsoft SQL databases that are mounted to the Microsoft SQL Server using a remote UNC path. If at least one file of the database is located on a network shared folder, this database will be backed up in the crash-consistent state. Other databases on this server will be backed up in the transactionally consistent state. For more information, see this Veeam KB article.

- By default, system databases (master, model, msdb) are skipped from transaction log processing and are not a part of the Veeam Explorer for Microsoft SQL Server restore workflow. To recover these databases, you can use file-level restore.

  If you want to exclude other databases from the transaction log processing workflow, refer to this Veeam Knowledge Base article: this Veeam KB article. (Consider that exclusion configured this way will be treated as a global setting.)

- To back up Oracle transaction logs with Veeam Backup & Replication, you must make sure that ARCHIVELOG is turned on for required databases on Oracle VMs. If ARCHIVELOG is turned off, Veeam Backup & Replication will not detect and process transaction logs on Oracle VMs.

Mind the following limitations:

- If you plan to periodically perform maintenance operations with backup files, mind the following limitations: Health Check for Backup Files, Retention Policy for Deleted VMs, Compact of Full Backup File.
• Due to Microsoft limitations, you cannot use Microsoft Azure Active Directory credentials to perform application-aware processing on VMs running Microsoft Windows 10.

• [For Dell EMC Data Domain backup repository] The length of forward incremental and forever forward incremental backup chains that contain one full backup and a set of subsequent incremental backups cannot be greater than 60 restore points. To overcome this limitation, schedule full backups (active or synthetic) to split the backup chain into shorter series. For example, to perform backups at 30-minute intervals, 24 hours a day, you must schedule synthetic fulls every day. In this scenario, intervals immediately after midnight may be skipped due to the duration of synthetic processing. For more information, see How Synthetic Full Backup Works.

• Veeam Backup & Replication supports backup of Microsoft Exchange, SharePoint and SQL Server databases existing in mount point volumes.

• Dynamic disks and FAT/FAT32 disks can be backed up only with disabled application-aware processing.
Step 1. Launch New Backup Job Wizard

To launch the New Backup Job wizard, do one of the following:

1. On the Home tab, click Backup Job > Virtual machine > Microsoft Hyper-V.
2. Open the Home view. In the inventory pane, right-click Jobs and select Backup > Virtual machine > Microsoft Hyper-V.

3. Open the Inventory view, in the working area select the VMs, click Add to Backup on the ribbon and select New job or right-click the VMs and select Add to Backup Job > New job. Veeam Backup & Replication will start the New Backup Job wizard and add the VMs to this job. You can add other VMs to the job later on, when you pass through the wizard steps.

4. You can quickly add the VMs to an already existing job. To do this, open the Inventory view, in the working area select the VMs and click Add to Backup > name of the job on the ribbon or right-click the VMs and select Add to Backup Job > name of the job.
Step 2. Specify Job Name and Description

At the **Name** step of the wizard, specify a name and description for the backup job.

1. In the **Name** field, enter a name for the backup job.
2. In the **Description** field, provide a description for future reference. The default description contains information about the user who created a job, date and time when the job was created.
Step 3. Select VMs to Back Up

At the Virtual Machines step of the wizard, select VMs and VM containers (Hyper-V hosts, clusters, SCVMM or volumes) that you want to back up.

Jobs with VM containers are dynamic in their nature. If a new VM is added to the container in the virtual infrastructure after the backup job is created, Veeam Backup & Replication will automatically update the job settings to include the added VM.

1. Click Add.

2. Use the toolbar at the top right corner of the window to switch between views: Hosts and Clusters, Hosts and Volumes, VMs and Tags, VM Groups.
   
   Mind that VMs can be arranged in VM groups only on Microsoft Hyper-V hosts version 2016 or later.

3. Select the VM or VM container in the list and click Add.

To quickly find the necessary object, you can use the search field at the bottom of the Add Objects window.

1. Click the button to the left of the search field and select the necessary type of object to search for: Everything, Folder, Host Group, SCVMM, Cluster, Host or Virtual machine.

2. Enter the object name or a part of it in the search field.

3. Click the Start search button on the right or press [Enter] on the keyboard.

The initial size of VMs and VM containers added to the backup job is displayed in the Size column in the list. The total size of objects is displayed in the Total size field. Use the Recalculate button to refresh the total size value after you add a new object to the job.
Step 4. Exclude Objects from Backup Job

After you have added VMs and VM containers to the job, you can specify which objects you want to exclude from the backup. You can exclude the following types of objects:

- **VMs from VM containers**
- **Specific VM disks**

To exclude VMs from a VM container:

1. At the **Virtual Machines** step of the wizard, click **Exclusions**.
2. Click the **VMs** tab.
3. Click **Add**.
4. Use the toolbar at the top right corner of the window to switch between views: **Hosts and Clusters**, **Hosts and Volumes**, **VMs and Tags**, **VM Groups**.
   
   Mind that VMs can be arranged in VM groups only on Microsoft Hyper-V hosts version 2016 or later.
5. In the displayed tree, select the object and click **Add**. Use the **Show full hierarchy** check box to display the hierarchy of all Microsoft Hyper-V Servers added to the backup infrastructure.
6. Click **OK**.

**NOTE:**

Volumes on the dynamic disks must not be split. Spanned, striped and other types of split volumes cannot be excluded.

To exclude VM disks:
1. At the **Virtual Machines** step of the wizard, click **Exclusions**.

2. Click the **Disks** tab.

3. Select the VM in the list and click **Edit**. If you want to exclude disks of a VM added as a part of the container, click **Add** to include the VM in the list as a standalone object.

4. Choose disks that you want to back up. You can choose to process all disks, 0:0 disks (typically, system disks) or add to the list custom IDE or SCSI disks.
Step 5. Define VM Backup Order

You can define the order in which the backup job must process VMs. Setting VM order can be helpful, for example, if you add some mission-critical VMs to the job and want the job to process them first. You can set these VMs first in list to ensure that their processing fits the backup window.

VMs inside a VM container are processed at random. To ensure that VMs are processed in the defined order, you must add them as standalone VMs, not as a part of the VM container.

To define VM backup order:

1. At the **Virtual Machines** step of the wizard, select a VM or VM container.
2. Use the **Up** and **Down** buttons on the right to move the VM or VM container up or down in the list.

**NOTE:**

VMs may be processed in a different order. For example, if backup infrastructure resources for a VM that is higher on the priority list are not available, and resources for a VM that is lower on the list are available, Veeam Backup & Replication will start processing the VM that is lower on the list first.

If you enable the **Allow processing of multiple VMs with a single volume snapshot** option in the **Advanced Backup settings**, VMs may also be processed in a different order. This option unites VMs added to the job in several groups, and the defined VM order may be broken.
Step 6. Specify Backup Storage Settings

At the Storage step of the wizard, select backup infrastructure components for the job — backup proxy and backup repository, and define backup storage settings.

1. Click Choose next to the Backup proxy field to select a backup proxy.
   - If you choose the On-host backup mode, the source Microsoft Hyper-V host will perform the roles of the source host and backup proxy. In this mode, the Veeam Data Mover runs directly on the source host, which helps streamline data retrieval operations but puts additional load on the host.
     
     If the job processes a VM whose disks are located on the CSV and Microsoft CSV Software Shadow Copy Provider is used for snapshot creating, the Microsoft Hyper-V host owning the CSV will be used as the on-host backup proxy.
   - If you choose the Off-host backup mode, the Veeam Data Mover will be started on a dedicated off-host backup proxy. In this mode, all backup processing operations are shifted to the off-host backup proxy from the source host.
     
     By default, if the off-host backup mode is selected for the job but no off-host backup proxies are available when the job starts, Veeam Backup & Replication will automatically fail over to the on-host backup mode. To disable failover, clear the Failover to on-host backup mode if no suitable off-host proxies available check box. If you disable this option, you must check off-host backup proxies before the job starts. The job will not be able to start if off-host backup proxies are not available or are not configured properly.
     
     To perform off-host backup, Veeam Backup & Replication analyzes the current load on off-host backup proxies and proxy settings (such as the number of allowed tasks, connectivity to the source volumes) to select an appropriate off-host backup proxy for the job. You can also explicitly point out what off-host backup proxies the job must use. To do this, select the Use the following backup proxy servers only check box and choose one or several off-host backup proxies from the list. It is recommended that you select at least two off-host backup proxies to ensure that the backup job starts if one of the backup proxies fails or loses its connectivity to the source volumes.

2. From the Backup repository list, select a backup repository where the created backup files must be stored. When you select a backup repository, Veeam Backup & Replication automatically checks how much free space is available in the backup repository.

3. You can map the job to a specific backup stored in the backup repository. Backup job mapping can be helpful if you have moved backup files to a new backup repository and want to point the job to existing backups in this new backup repository. You can also use backup job mapping if the configuration database got corrupted and you need to reconfigure backup jobs.
   
   To map the job to a backup, click the Map backup link and select the backup in the backup repository. Backups can be easily identified by job names. To find the backup, you can also use the search field at the bottom of the window.

4. In the Retention Policy field, specify retention policy settings for restore points:
   - If you want to keep the last N restore points, select restore points from the drop-down list. Then specify the number of restore points.
   - If you want to keep all restore points created during the last N days, select days from the drop-down list. Then specify the number of days.
     
     When the specified number is exceeded, the earliest restore points is removed from the backup chain or merged with the next closest restore point. For more information, see Short-Term Retention Policy.
5. If you want to ignore the retention policy for some full backups and store them for long-term archiving, select the **Keep some periodic full backups longer for archival purposes** check box. Then click the **Configure** button and specify the Grand-Father-Son (GFS) retention policy. For details, see [Specify GFS Retention Policy](#).

6. If you want to archive backup files created with the backup job to a secondary destination (backup repository or tape), select the **Configure secondary destination for this job** check box. With this option enabled, the **New Backup Job** wizard will include an additional step — **Secondary Target**. At the **Secondary Target** step of the wizard, you can link the backup job to the backup copy job or backup to tape backup job.

You can enable this option only if a backup copy job or backup to tape job is already configured on the backup server.
Step 7. Specify GFS Retention Policy

At the Storage step of the wizard, you can configure GFS retention policy settings for the backup job. For more information on GFS and its limitations, see Long-Term Retention Policy (GFS).

1. Click the Configure button.

2. In the Configure GFS window, do the following:
   
   o If you want to create weekly restore points, select the Keep weekly full backups for check box. Then specify the number of weeks during which you want to prevent restore points from being modified and deleted.
     
     In the If multiple full backups exist, use the one from list, select a week day when Veeam Backup & Replication must assign the weekly GFS flag to a full restore point.
   
   o If you want to create monthly restore points, select the Keep monthly full backups for check box. Then specify the number of months during which you want to prevent restore points from being modified and deleted.
     
     In the Use weekly full backup for the following week of a month list, select a week when Veeam Backup & Replication must assign the monthly GFS flag to a full restore point. A week equals 7 calendar days; for example, the first week of May is days 1–7, and the last week of May is days 25–31.
   
   o If you want to create yearly restore points, select the Keep yearly full backups for check box. Then specify the number of years during which you want to prevent restore points from being modified and deleted.
     
     In the Use monthly full backup for the following month list, select a month when Veeam Backup & Replication must assign the yearly GFS flag to a full restore point.
NOTE:
If you select to assign multiple types of GFS flags, the flags begin to depend on each other. For more information on this dependency, see Assignment of Multiple GFS Flags.

Advanced job settings include backup mode, compression and deduplication, block size, notification settings, automated post-job activity and other settings.
Step 8. Specify Advanced Backup Settings

At the Storage step of the wizard, you can specify the advanced settings for the backup job:

- Backup settings
- Maintenance settings
- Storage settings
- Notification settings
- Hyper-V settings
- Script settings

TIP:
After you specify necessary settings for the backup job, you can save them as default settings. To do this, click Save as Default at the bottom left corner of the Advanced Settings window. When you create a new backup job, Veeam Backup & Replication will automatically apply the default settings to the new job.

Backup Settings

To specify settings for a backup chain created with the backup job:

1. At the Storage step of the wizard, click Advanced.
2. On the Backup tab, select the backup method that you want to use to create the backup chain in the backup repository:
   - To create a reverse incremental backup chain, select Reverse Incremental.
     Dell EMC Data Domain and HPE StoreOnce do not support the reverse incremental backup method. Do not select this option for backup jobs targeted at these types of backup repositories.
   - To create an incremental backup chain, select Incremental and enable synthetic full and/or active full backups (see items 3-4).
   - To create a forever forward incremental backup chain, select Incremental and do not enable synthetic full and/or active full backups (see items 3-4).
   For more information, see Backup Methods.
3. If you choose the incremental backup method, you can select to periodically create synthetic full backups and/or active full backups.
   - To create a synthetic full backup, select the Create synthetic full backups periodically check box and click Days to schedule synthetic full backups on the necessary week days.
     You can additionally choose to transform the previous incremental backup chain into the reverse incremental backup chain. To do this, select the Transform previous backup chains into rollbacks check box.
To create full backups regularly, select the **Create active full backups periodically** check box. Use the **Monthly on** or **Weekly on selected days** options to define scheduling settings.

Before you schedule periodic full backups, you must make sure that you have enough free space in the backup repository. As an alternative, you can create active full backups manually when needed. For more information, see Active Full Backup.

**NOTE:**

If you schedule the active full backup and synthetic full backup with or without the transformation task on the same day, Veeam Backup & Replication will perform only active full backup. Synthetic full backup and transformation task will be skipped.

**Maintenance Settings**

You can instruct Veeam Backup & Replication to periodically perform maintenance operations — service actions that will help make sure that the backup chain remains valid and consistent.

To specify maintenance settings for the backup job:

1. At the **Storage** step of the wizard, click **Advanced**.
2. Click the **Maintenance** tab.
3. To periodically perform a health check for the latest restore point in the backup chain, in the **Storage-level corruption guard** section select the **Perform backup files health check** check box and specify the time schedule for the health check.

An automatic health check can help you avoid a situation where a restore point gets corrupted, making all dependent restore points corrupted, too. If during the health check Veeam Backup & Replication detects corrupted data blocks in the latest restore point in the backup chain (or, in case of forever forward incremental and forward incremental chains, the restore point before the latest one if the latest restore point is incomplete), it will start the health check retry and transport valid data blocks from the source volume to the backup repository. The transported data blocks are stored to a new backup file or the latest backup file in the backup chain, depending on the data corruption scenario. For more information, see **Health Check for Backup Files**.

4. Select the **Remove deleted items data after** check box and specify the number of days for which you want to keep backup data for deleted VMs. If a VM is no longer available (for example, it was deleted or excluded from the job), Veeam Backup & Replication will keep its data in the backup repository for the period that you have specified. When this period is over, data of the deleted VM will be removed from the backup repository.

   By default, the retention period for deleted VM data is 14 days. It is strongly recommended that you set the retention period to 3 days or more to prevent unwanted data loss. For more information, see **Retention Policy for Deleted VMs**.

5. To periodically compact a full backup, select the **Defragment and compact full backup file** check box and specify the schedule for the compact operation.

   During the compact operation, Veeam Backup & Replication creates a new empty file and copies to it data blocks from the full backup file. As a result, the full backup file gets defragmented and the speed of reading and writing from/to the backup file increases.

   If the full backup file contains data blocks for deleted VMs, Veeam Backup & Replication will remove these data blocks. If the full backup file contains data for a VM that has only one restore point, and this restore point is older than 7 days, Veeam Backup & Replication will perform the take out operation. For more information, see **Compact of Full Backup File**.
IMPORTANT!
If you schedule periodic full backups, the Remove deleted items data after and Defragment and compact full backup file check boxes do not apply.

Storage Settings

To specify storage settings for the backup job:

1. At the Storage step of the wizard, click Advanced.
2. Click the Storage tab.
3. By default, Veeam Backup & Replication deduplicates VM data before storing it in the backup repository. Data deduplication provides a smaller size of the backup file but may reduce the backup job performance. To disable data deduplication, clear the Enable inline data deduplication check box.

   If you disable this option, you also change the workflow of incremental backup. If Changed Block Tracking is enabled for the job, Veeam Backup & Replication will save all data blocks marked by CBT as new to the destination storage without performing an additional check or using Veeam’s filtering mechanism. This will result in faster incremental backup. For more information, see Changed Block Tracking.

4. By default, Veeam Backup & Replication checks the NTFS MFT file on VMs with Microsoft Windows OS to identify data blocks of the hiberfil.sys file (file used for the hibernate mode) and pagefile.sys file (swap file), and excludes these data blocks from processing. The swap file is dynamic in nature and changes intensively between backup job sessions, even if the VM itself does not change much. Processing of service files reduces the job performance and increases the size of incremental backup files.

   If you want to include data blocks of the hiberfil.sys file and pagefile.sys file to the backup, clear the Exclude swap file blocks check box. For more information, see Swap Files.
5. By default, Veeam Backup & Replication does not copy deleted file blocks ("dirty" blocks on the VM guest OS) to the target location. This option lets you reduce the size of backup files and increase the job performance. If you want to include dirty data blocks to the backup, clear the **Exclude deleted file blocks** check box. For more information, see [Deleted File Blocks](#).

6. From the **Compression level** list, select a compression level for the backup: *None, Dedupe-friendly, Optimal, High or Extreme.*

7. In the **Storage optimization** section, select what type of backup target you plan to use: *Local target (large blocks), Local target, LAN target or WAN target.* Depending on the chosen storage type, Veeam Backup & Replication will use data blocks of different size to optimize the size of backup files and job performance. For more information, see [Compression and Deduplication](#).

8. To encrypt the content of backup files, select the **Enable backup file encryption** check box. In the **Password** field, select a password that you want to use for encryption. If you have not created the password beforehand, click **Add** or use the **Manage passwords** link to specify a new password. For more information, see [Managing Passwords for Data Encryption](#).

   If the backup server is not connected to Veeam Backup Enterprise Manager, you will not be able to restore data from encrypted backups in case you lose the password. Veeam Backup & Replication will display a warning about it. For more information, see [Decrypting Data Without Password](#).
NOTE:

If you enable encryption for an existing backup job, during the next job session Veeam Backup & Replication will create a full backup file. The created full backup file and subsequent incremental backup files in the backup chain will be encrypted with the specified password.

Encryption is not retroactive. If you enable encryption for an existing job, Veeam Backup & Replication does not encrypt the previous backup chain created with this job. If you want to start a new chain so that the unencrypted previous chain can be separated from the encrypted new chain, follow this scenario: this Veeam KB article.

Notification Settings

To specify notification settings for the backup job:

1. At the Storage step of the wizard, click Advanced.
2. Click the Notifications tab.
3. Select the Send SNMP notifications for this job check box if you want to receive SNMP traps when the job completes successfully.

SNMP traps will be sent if you specify global SNMP settings in Veeam Backup & Replication and configure software on recipient’s machine to receive SNMP traps. For more information, see Specifying SNMP Settings.
4. Select the **Send email notifications to the following recipients** check box if you want to receive notifications about the job completion status by email. In the field below, specify recipient’s email address. You can enter several addresses separated by a semicolon.

Email notifications will be sent if you configure global email notification settings in Veeam Backup & Replication. For more information, see Configuring Global Email Notification Settings.

5. You can choose to use global notification settings or specify custom notification settings.

- To receive a typical notification for the job, select **Use global notification settings**. In this case, Veeam Backup & Replication will apply to the job global email notification settings specified for the backup server. For more information, see Configuring Global Email Notification Settings.

- To configure a custom notification for the job, select **Use custom notification settings specified below** check box. You can specify the following notification settings:
  
  i. In the Subject field, specify a notification subject. You can use the following variables in the subject: %Time% (completion time), %JobName%, %JobResult%, %VmCount% (number of VMs in the job) and %Issues% (number of VMs in the job that have been processed with the Warning or Failed status).

  ii. Select the **Notify on success**, **Notify on warning** and/or **Notify on error** check boxes to receive email notification if the job completes successfully, fails or completes with a warning.

  iii. Select the **Suppress notifications until the last retry** check box to receive a notification about the final job status. If you do not enable this option, Veeam Backup & Replication will send one notification per every job retry.
Hyper-V Settings

To specify Hyper-V settings for the backup job:

1. At the Storage step of the wizard, click Advanced.
2. Click the Hyper-V tab.
3. In the Guest quiescence section, specify which backup method must be used to prepare the VM guest OS for backup.

   Typically, it is recommended that you use Veeam's application-aware processing that leverages the Microsoft VSS framework to prepare the VM guest OS for backup. If application-aware processing cannot be used for some reason, select the Enable Hyper-V guest quiescence check box. Veeam Backup & Replication will select the backup method in the following way:

   o If a VM meets all requirements for online backup, Veeam Backup & Replication will use the online backup method.
   o If a VM does not meet requirements for online backup, Veeam Backup & Replication will use the offline backup method. Note that during offline backup a VM is suspended for a short period of time.

   The selected backup method applies to all VMs in the job. However, if you enable application-aware processing for VMs, the application-aware processing settings will have higher priority than the selected backup method.

   **NOTE:**

   For VMs on Microsoft Hyper-V Server 2016 and later, mind the following:
   - Offline backup cannot be used.
   - If you enable Hyper-V guest quiescence and leave application-aware processing disabled in the job, Veeam Backup & Replication performs backup using the VSS_BT_FULL method. This method backs up databases and transaction logs and then truncates the transaction logs. For more information on backup methods, see [this Microsoft Documentation](#). You can change the backup method to VSS_BT_COPY with a registry key. For more information, contact Veeam Customer Support.

4. If you do not want to suspend VMs in the job, select the Take crash consistent backup instead of suspending VM check box. In this case, Veeam Backup & Replication will create a crash-consistent backup of a VM.
5. In the Changed block tracking section, specify if CBT must be used for VM backup. By default, this option is enabled. CBT dramatically reduces load on the production environment and time required to perform incremental backups.
6. If you have added several VMs to the job, select the Allow processing of multiple VMs with a single volume snapshot check box. This option helps reduce snapshot workload in the Microsoft Hyper-V environment. When the job starts, Veeam Backup & Replication will group VMs and trigger Microsoft Hyper-V to create one volume snapshot for a group of VMs, instead of creating a volume snapshot per each processed VM.

   Veeam Backup & Replication can create a single volume snapshot for a group of VMs that meet the following requirements:
   - VMs must be located on the same host.
   - Volumes on which VM files reside must use the same VSS provider for snapshot creation.
The number of VMs in the group is limited: for a software VSS provider — 4 VMs, for a hardware VSS provider — 8 VMs.

Veeam Backup & Replication groups VMs based on the method of snapshot creation that is used for backup: transactionally consistent (VSS) or crash-consistent.

For example, you add to the job 2 VMs that are registered on the same host. VM1 resides on volume C:\ and VM2 resides on volume D:\. Both VMs use Microsoft Software Shadow Copy Provider. In this situation, Veeam Backup & Replication will create a single snapshot for these VMs.

**NOTE:**

The **Allow processing of multiple VMs with a single volume** snapshot option is not applicable to VMs registered on Microsoft Hyper-V Server 2016 and later that are processed in the onhost backup mode.

---

### Script Settings

To specify script settings for the backup job:

1. At the **Storage** step of the wizard, click **Advanced**.
2. Click the **Scripts** tab.
3. If you want to execute custom scripts before and/or after the backup job, select the **Run the following script before the job** and **Run the following script after the job** check boxes and click **Browse** to choose executable files from a local folder on the backup server. The scripts are executed on the backup server.

You can select to execute pre- and post-backup actions after a number of backup sessions or on specific week days.

- If you select the **Run scripts every <N> backup session** option, specify the number of the backup job sessions after which the scripts must be executed.
- If you select the **Run scripts on the selected days only** option, click **Days** and specify week days on which the scripts must be executed.

**NOTE**

Mind the following:

- Custom scripts that you define in the advanced job settings relate to the backup job itself, not the VM quiescence process. To add pre-freeze and post-thaw scripts for VM image quiescence, use the **Guest Processing** step of the wizard.
- If you select the **Run scripts on the selected days only** option, Veeam Backup & Replication executes scripts only once on each selected day — when the job runs for the first time. During subsequent job runs, scripts are not executed.
- To run the script, Veeam Backup & Replication uses the **Service Account** under which the Veeam Backup Service is running.
Step 9. Specify Secondary Target

The **Secondary Target** step of the wizard is available if you have enabled the **Configure secondary destination for this job** option at the **Storage** step of the wizard.

At the **Secondary Target** step of the wizard, you can link the backup job to a backup to tape or backup copy job. As a result, the backup job will be used as a source for the backup to tape or backup copy job. Backup files created with the backup job will be archived to tape or copied to the secondary backup repository according to the secondary jobs schedule. For more information, see *Linking Backup Jobs to Backup Copy Jobs* and *Linking Backup Jobs to Backup to Tape Jobs*.

The backup to tape job or backup copy job must be configured beforehand. You can create these jobs with an empty source. When you link the backup job to these jobs, Veeam Backup & Replication will automatically update the linked jobs to define the backup job as a source for these jobs.

To link jobs:

1. **Click Add**.
2. **From the jobs list, select a backup to tape or backup copy job that must be linked to the backup job.** You can link several jobs to the backup job, for example, one backup to tape job and one backup copy job. To quickly find the job, use the search field at the bottom of the wizard.
Step 10. Specify Guest Processing Settings

At the Guest Processing step of the wizard, you can enable the following settings for VM guest OS processing:

- Application-aware processing
- Transaction log handling for Microsoft SQL VMs
- Archived log handling for Oracle VM
- VM guest OS file exclusion
- Use of pre-freeze and post-thaw scripts
- VM guest OS file indexing

To coordinate guest processing activities, Veeam Backup & Replication deploys a runtime process on the VM guest OS. The process runs only during guest processing and is stopped immediately after the processing is finished (depending on the selected option, during the backup job session or after the backup job completes).

You must specify a user account that will be used to connect to the VM guest OS and deploy the runtime process:

1. From the Guest OS credentials list, select a user account that has enough permissions. For details, see Required Permissions for Guest Processing.
   - If you have not set up credentials beforehand, click the Manage accounts link or click Add on the right to add credentials.
   - By default, Veeam Backup & Replication uses the Log on as a batch job policy to connect to guest OS. If the connection fails, Veeam Backup & Replication switches to Interactive Logon.

2. By default, Veeam Backup & Replication uses the same credentials for all VMs in the job. If some VM requires a different user account, click Credentials and enter custom credentials for the VM.

3. If you have added Microsoft Windows VMs to the job, specify which guest interaction proxy Veeam Backup & Replication can use to deploy the runtime process on the VM guest OS. On the right of the Guest interaction proxy field, click Choose.
   - Leave Automatic selection to let Veeam Backup & Replication automatically select the guest interaction proxy.
   - Select Use the selected guest interaction proxy servers only to explicitly define which servers will perform the guest interaction proxy role. The list of servers contains Microsoft Windows servers added to the backup infrastructure.

To check if Veeam Backup & Replication can communicate with VMs added to the job and deploy the runtime process on their guest OSes, click Test Now. Veeam Backup & Replication will use the specified credentials to connect to all VMs in the list.
The guest interaction proxy functionality is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.

Application-Aware Processing

If you add to the backup job VMs running VSS-aware applications, you can enable application-aware processing to create a transactionally consistent backup. The transactionally consistent backup guarantees proper recovery of applications on VMs without data loss.

To enable application-aware processing:

1. At the **Guest Processing** step of the wizard, select the **Enable application-aware processing** check box.
2. Click **Applications**.
3. In the displayed list, select the VM and click **Edit**.

   To define custom settings for a VM added as a part of a VM container, you must include the VM to the list as a standalone object. To do this, click **Add** and choose the VM whose settings you want to customize. Then select the VM in the list and define the necessary settings.

4. On the **General** tab, in the **Applications** section specify the behavior scenario for application-aware processing:
   - Select **Require successful processing** if you want Veeam Backup & Replication to stop the backup process if any error occurs during application-aware processing.
   - Select **Try application processing, but ignore failures** if you want to continue the backup process even if an error occurs during application-aware processing. This option guarantees completion of the backup job. However, the resulting backup will not be transactionally consistent but crash consistent.
- Select **Disable application processing** if you do not want to enable application-aware processing for the VM.

5. **[For Microsoft Exchange, Microsoft SQL and Oracle VMs]** In the **Transaction logs** section, specify if Veeam Backup & Replication must process transaction logs or copy-only backups must be created.

   a. Select **Process transaction logs with this job** if you want Veeam Backup & Replication to process transaction logs.

      [For Microsoft Exchange VMs] With this option selected, the runtime process running on the VM guest OS will wait for backup to complete successfully and then trigger truncation of transaction logs. If the backup job fails, the logs will remain untouched on the VM guest OS until the next start of the runtime process.

      [For Microsoft SQL Server VMs and Oracle VMs] You will have to specify settings for transaction log handling on the SQL and Oracle tabs of the **VM Processing Settings** window. For more information, see [Transaction Log Settings: Microsoft SQL](#) and [Transaction Log Settings: Oracle](#).

   b. Select **Perform copy only** if you use another backup tool to perform VM guest level backup, and this tool maintains consistency of the database state. Veeam Backup & Replication will create a copy-only backup for the selected VM. The copy only backup preserves the chain of full/differential backup files and transaction logs on the VM. For more information, see [Microsoft Docs](#).

   **IMPORTANT!**

   If both Microsoft SQL Server and Oracle Server are installed on one VM, and this VM is processed by a job with log backup enabled for both applications, Veeam Backup & Replication will back up only Oracle transaction logs. Microsoft SQL Server transaction logs will not be processed.
Microsoft SQL Server Transaction Log Settings

If you back up a Microsoft SQL VM, you can specify how Veeam Backup & Replication must process transaction logs on this VM:

1. At the Guest Processing step of the wizard, select the Enable application-aware processing check box.
2. Click Applications.
3. In the displayed list, select the Microsoft SQL Server VM and click Edit.
4. In the Transaction logs section, select Process transaction logs with this job.
5. In the VM Processing Settings window, click the SQL tab.
6. Specify how transaction logs must be processed. You can select one of the following options:

   o Select **Truncate logs** to truncate transaction logs after successful backup. The runtime process running on the VM guest OS will wait for the backup to complete successfully and then truncate transaction logs. If the job does not manage to back up the Microsoft SQL Server VM, the logs will remain untouched on the VM guest OS until the next start of the runtime process.

   **NOTE:**
   If the account specified for application-aware processing does not have enough rights, Veeam Backup & Replication tries to truncate logs using the local SYSTEM account for Microsoft SQL Server 2008 and 2008 R2. If you have modified this account, make sure that it is permitted to truncate logs.
   For other Microsoft SQL Server versions, Veeam Backup & Replication uses NT AUTHORITY\SYSTEM account. Make sure that you assign the sysadmin role to this account. For more information, see this Veeam KB article.

   o Select **Do not truncate logs** to preserve transaction logs. When the backup job completes, Veeam Backup & Replication will not truncate transaction logs on the Microsoft SQL Server VM.
   It is recommended that you enable this option for databases that use the Simple recovery model. If you enable this option for databases that use the Full or Bulk-logged recovery model, transaction logs on the VM guest OS may grow large and consume all disk space. In this case, the database administrator must take care of transaction logs him-/herself.

   o Select **Backup logs periodically** to back up transaction logs with Veeam Backup & Replication. Veeam Backup & Replication will periodically copy transaction logs to the backup repository and store them together with the image-level backup of the Microsoft SQL Server VM. During the backup job session, transaction logs on the VM guest OS will be truncated.
   For more information, see [Microsoft SQL Server Log Backup](#).

If you have selected to back up transaction logs with Veeam Backup & Replication, you must specify settings for transaction log backup:

1. In the Backup logs every <N> minutes field, specify the frequency for transaction log backup. By default, transaction logs are backed up every 15 minutes. The maximum log backup interval is 480 minutes.
2. In the Retain log backups section, specify retention policy for transaction logs stored in the backup repository.
   o Select **Until the corresponding image-level backup is deleted** to apply the same retention policy for image-level backups and transaction log backups.
o Select **Keep only last <N> days of log backups** to keep transaction logs for a specific number of days. By default, transaction logs are kept for 15 days. If you select this option, you must make sure that retention for transaction logs is not greater than retention for the image-level backups. For more information, see [Retention for Transaction Log Backups](#).

3. In the **Log shipping servers** section, click **Choose** to select what log shipping server you want to use to transport transaction logs:

   o Select **Automatic selection** if you want Veeam Backup & Replication to choose an optimal log shipping server automatically. If the optimal shipping server is busy, Veeam Backup & Replication will direct the data flow to another shipping server not to lose data and to comply with RPO. The process of transaction logs shipment does not require a dedicated server — Veeam Backup & Replication can use any Microsoft Windows server added to the backup infrastructure.

   o To define a log shipping server explicitly, select **Use the specified servers only** and select check boxes next to servers that you want to use as log shipping servers. The server list includes all Microsoft Windows servers added to the backup infrastructure.

     Make sure that you select a server that is not engaged in other resource-consuming tasks. For example, you may want not to use a server that performs the WAN accelerator role as a log shipping server. For load balance and high availability purposes, it is recommended that you select at least 2 log shipping servers.
IMPORTANT!

Veeam Backup & Replication automatically excludes its configuration database from application-aware processing during backup if the database is hosted without using SQL Server AlwaysOn Availability Group. Transaction logs for the configuration database are not backed up.

If the Veeam Backup & Replication configuration database is hosted using SQL Server AlwaysOn Availability Group, you should manually exclude this database from application-aware processing during backup as described in this Veeam KB article. Otherwise, job processing will fail with the following error: Failed to freeze guest over network, wait timeout.

Oracle Archived Log Settings

If you back up an Oracle VM, you can specify how Veeam Backup & Replication must process archived logs on this VM:

1. At the Guest Processing step of the wizard, select the Enable application-aware processing check box.
2. Click Applications.
3. In the displayed list, select the Oracle VM and click Edit.
4. In the Transaction logs section, select Process transaction logs with this job.
5. In the VM Processing Settings window, click the Oracle tab.
6. In the **Specify Oracle account with SYSDBA privileges** section, specify a user account that Veeam Backup & Replication will use to connect to the Oracle database. The account must have SYSDBA rights on the Oracle database.

You can select **Use guest credentials** in the list of user accounts. In this case, Veeam Backup & Replication will use the account specified at the **Guest Processing** step of the wizard to access the VM guest OS and connect to the Oracle database.

7. In the ** Archived logs ** section, specify how Veeam Backup & Replication must process archived logs on the Oracle VM:

   - Select **Do not delete archived logs** if you want Veeam Backup & Replication to preserve archived logs on the VM guest OS. When the backup job completes, the runtime process will not delete archived logs.

     It is recommended that you select this option for databases for which the ARCHIVELOG mode is turned off. If the ARCHIVELOG mode is turned on, archived logs on the VM guest OS may grow large and consume all disk space. In this case, the database administrator must take care of archived logs himself.

   - Select **Delete logs older than <N> hours** or **Delete logs over <N> GB** if you want Veeam Backup & Replication to delete archived logs that are older than <N> hours or larger than <N> GB. The log size threshold refers to the total size of all logs for all databases, but to the log size of each database on the selected Oracle server.

     When the parent backup job (job creating an image-level backup) runs, Veeam Backup & Replication will wait for the backup to complete successfully, and then trigger archived logs deletion on the Oracle VM over Oracle Call Interface (OCI). If the primary job does not manage to back up the Oracle VM, the logs will remain untouched on the VM guest OS until the next start of the runtime process.

8. To back up Oracle archived logs with Veeam Backup & Replication, select the **Backup log every <N> minutes** check box and specify the frequency for archived log backup. By default, archived logs are backed up every 15 minutes. The maximum log backup interval is 480 minutes.

9. In the ** Retain log backups ** section, specify retention policy for archived logs stored in the backup repository:

   - Select **Until the corresponding image-level backup is deleted** to apply the same retention policy for image-level backups and archived log backups.

   - Select **Keep only last <n> days** to keep archived logs for a specific number of days. By default, archived logs are kept for 15 days. If you select this option, you must make sure that retention for archived logs is not greater than retention for the image-level backups. For more information, see **Retention for Archived Log Backups**.

10. In the ** Log shipping servers ** section, click **Choose** to select what log shipping server you want to use to transport archived logs:

    - Select **Automatic selection** if you want Veeam Backup & Replication to select an optimal log shipping server automatically. The process of archived logs shipment does not require a dedicated server — Veeam Backup & Replication can use any Microsoft Windows or Linux server added to the backup infrastructure.
Select **Use the specified servers only** to define a log shipping server explicitly. In the **Log Shipping Servers** window, select check boxes next to servers that you want to use as log shipping servers. The server list includes all Microsoft Windows servers added to the backup infrastructure.

Make sure that you select a server that is not engaged in other resource-consuming tasks. For example, you may want not to use a server that performs the WAN accelerator role as a log shipping server. For load balance and high availability purposes, it is recommended that you select at least 2 log shipping servers.

---

**VM Guest OS File Exclusion**

If you do not want to back up specific files and folders on the VM guest OS, you can exclude them from the backup. Note that this option is available only in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.

To define what files and folders must be excluded:

1. At the **Guest Processing** step of the wizard, select the **Enable application-aware processing** check box.
2. Click **Applications**.
3. In the displayed list, select the VM and click **Edit**.

   To define custom settings for a VM added as part of a VM container, you must include the VM in the list as a standalone object. To do this, click **Add** and choose a VM whose settings you want to customize. Then select the VM in the list and define the necessary settings.

4. Click the **Exclusions** tab and specify what files must be excluded from the backup:

   o **Select Exclude the following files and folders** to remove the individual files and folders from the backup.
- Select **Include only the following files and folders** to leave only the specified files and folders in the backup.

5. Click **Add** and specify what files and folders you want to include or exclude. To form the list of exclusions or inclusions, you can use full paths to files and folders, environmental variables and file masks with the asterisk (*) and question mark (?) characters. For more information, see **VM Guest OS Files**.

**NOTE:**
When you choose files to be included or excluded, mind requirements and limitations that are listed in the **Requirements and Limitations for VM Guest OS File Exclusion** section.

6. Click **OK**.

7. Repeat steps 5-6 for every file or folder that you want to exclude or include.

**NOTE:**
Volumes on the dynamic disks must not be split. Spanned, striped and other types of split volumes cannot be excluded.

---

### Pre-Freeze and Post-Thaw Scripts

If you plan to back up VMs running applications that do not support VSS, you can specify what scripts Veeam Backup & Replication must use to quiesce the VM. The pre-freeze script quiesces the VM file system and application data to bring the VM to a consistent state before Veeam Backup & Replication triggers a VM snapshot. After the VM snapshot is created, the post-thaw script brings the VM and applications to their initial state.
To specify pre-freeze and post-thaw scripts for the job:

1. At the **Guest Processing** step, click **Applications**.
2. In the displayed list, select the VM and click **Edit**.
3. Click the **Scripts** tab.
4. In the **Script processing mode** section, specify the scenario for scripts execution:
   - Select **Require successful script execution** if you want Veeam Backup & Replication to stop the backup process if the script fails.
   - Select **Ignore script execution failures** if you want to continue the backup process even if script errors occur.
   - Select **Disable script execution** if you do not want to run scripts for the VM.
5. In the **Windows scripts** section, specify paths to pre-freeze and post-thaw scripts for Microsoft Windows VMs. For the list of supported script formats, see *Pre-Freeze and Post-Thaw Scripts*.
6. In the **Linux scripts** section, specify paths to pre-freeze and/or post-thaw scripts for Linux VMs. For the list of supported script formats, see *Pre-Freeze and Post-Thaw Scripts*.

If you have added to the job a VM container with Microsoft Windows and Linux VMs, you can select to execute both Microsoft Windows and Linux scripts for the VM container. When the job starts, Veeam Backup & Replication will automatically determine what OS type is installed on the VM and use corresponding scripts to quiesce this VM.

**TIP:**
Beside pre-freeze and post-thaw scripts for VM quiescence, you can instruct Veeam Backup & Replication to run custom scripts before the job starts and after the job completes. For more information, see *Script Settings*. 
VM Guest OS File Indexing

To specify VM guest OS indexing options for a VM:

1. At the **Guest Processing** step of the wizard, click **Indexing**.
2. Select a VM in the list and click **Edit > Windows indexing** or **Linux indexing**.
3. Specify the indexing scope:
   - Select **Disable indexing** if you do not want to index guest OS files of the VM.
   - Select **Index everything** if you want to index all VM guest OS files.
   - Select **Index everything except** if you want to index all VM guest OS files except those defined in the list. By default, system folders are excluded from indexing. You can add or delete folders using the **Add** and **Remove** buttons on the right. You can also use system environment variables to form the list, for example: %windir%, %ProgramFiles% and %Temp%.

To reset the list of folders to its initial state, click **Default**.

   - Select **Index only following folders** to define folders that you want to index. You can add or delete folders to index using the **Add** and **Remove** buttons on the right. You can also use system environment variables to form the list, for example: %windir%, %ProgramFiles% and %Temp%.

**NOTE:**

[For Linux VMs] To perform guest OS file indexing, Veeam Backup & Replication requires several utilities to be installed on the Linux VM: openssh, mlocate, gzip and tar. If these utilities are not found, Veeam Backup & Replication will prompt you to deploy them on the VM guest OS.
Step 11. Define Job Schedule

At the Schedule step of the wizard, select to run the backup job manually or schedule the job to run on a regular basis.

To specify the job schedule:

1. Select the Run the job automatically check box. If this check box is not selected, you will have to start the job manually to create the VM backup.

2. Define scheduling settings for the job:
   - To run the job at specific time daily, on defined week days or with specific periodicity, select Daily at this time. Use the fields on the right to configure the necessary schedule.
   - To run the job once a month on specific days, select Monthly at this time. Use the fields on the right to configure the necessary schedule.

   **NOTE:**
   When you configure the job schedule, keep in mind possible date and time changes (for example, related to daylight saving time transition).

   - To run the job repeatedly throughout a day with a specific time interval, select Periodically every. In the field on the right, select the necessary time unit: Hours or Minutes. Click Schedule and use the time table to define the permitted time window for the job. In the Start time within an hour field, specify the exact time when the job must start.

   A repeatedly run job is started by the following rules:
   - Veeam Backup & Replication always starts counting defined intervals from 12:00 AM. For example, if you configure to run a job with a 4-hour interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 PM and so on.
   - If you define permitted hours for the job, after the denied interval is over, Veeam Backup & Replication will immediately start the job and then run the job by the defined schedule.

   For example, you have configured a job to run with a 2-hour interval and defined permitted hours from 9:00 AM to 5:00 PM. According to the rules above, the job will first run at 9:00 AM, when the denied period is over. After that, the job will run at 10:00 AM, 12:00 PM, 2:00 PM and 4:00 PM.

   - To run the job continuously, select the Periodically every option and choose Continuously from the list on the right. A new backup job session will start as soon as the previous backup job session finishes.

   - To chain jobs, use the After this job field. In the common practice, jobs start one after another: when job A finishes, job B starts and so on. If you want to create a chain of jobs, you must define the time schedule for the first job in the chain. For the rest of the jobs in the chain, select the After this job option and choose the preceding job from the list.

3. In the Automatic retry section, define whether Veeam Backup & Replication must attempt to run the backup job again if the job fails for some reason. During a job retry, Veeam Backup & Replication processes failed VMs only. Enter the number of attempts to run the job and define time intervals between them. If you select continuous backup, Veeam Backup & Replication will retry the job for the defined number of times without any time intervals between the job sessions.
4. In the **Backup window** section, define the time interval within which the backup job must complete. The backup window prevents the job from overlapping with production hours and ensures that the job does not provide unwanted overhead on the production environment. To set up a backup window for the job:

   a. Select the **Terminate job if it exceeds allowed backup window** check box and click **Window**.

   b. In the **Time Periods** section, define the allowed hours and prohibited hours for backup. If the job exceeds the allowed window, it will be automatically terminated.

**NOTE:**

The **After this job** function will only start a job if the first job in the chain is started automatically by schedule. If the first job is started manually, jobs chained to it will not be started.
Step 12. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of backup job configuration.

1. Review details of the backup job.
2. Select the **Run the job when I click Finish** check box if you want to start the job right after you finish working with the wizard.
3. Click **Finish** to close the wizard.

![Screenshot of the Summary step of the wizard](image)

**Summary**
The job's settings have been saved successfully. Click Finish to exit the wizard.

- **Name:** DB Backup
- **Type:** Hyper-V Backup
- **Enable application-aware processing:**
- **Enable guest file system indexing:**
- **Source items:**
  - sqlvms03 (Hyper-V03)
  - sqlvms04 (Hyper-V02)
- **Target repository:** Scale-out Backup Repository
- **Target repository home use backup proxy:**
- **Target repository path:**

**Command line to start the job on backup server:**

```
C:\Program Files\Veeam\Backup and Replication\Backup\VeeamBackupManager.exe" backup
4812dcd6-57d6-4597-8d68-9e0d838f7041\0
```
Performing Active Full Backup

You can create an ad-hoc full backup — active full backup, and add it to the backup chain in the backup repository. The active full backup resets the backup chain. All subsequent incremental backups use the active full backup as a starting point. The previously used full backup will remain in the backup repository until it is removed from the backup chain according to the retention policy.

To perform active full backup:

1. Open the **Home** view.
2. In the inventory pane, select **Jobs**.
3. In the working area, select the job and click **Active Full** on the ribbon or right-click the job and select **Active Full**.
Quick Backup

Quick backup lets you perform on-demand incremental backup for VMs. You can use quick backup if you want to produce an additional restore point for one or more VMs in a backup job and do not want to configure a new job or modify the existing one. Quick backup can be run for both incremental and reverse incremental backup chains.

Quick backup is an incremental backup task: Veeam Backup & Replication copies only changed data for selected VMs and saves this data to a new restore point in the backup chain. Similar to incremental backup, quick backup can only be run for VMs that have been successfully backed up at least once and has a full restore point. If there is no full restore point for a VM, quick backup cannot be performed.

To perform quick backup, Veeam Backup & Replication uses an existing backup job. When you start a quick backup task for a VM, Veeam Backup & Replication verifies that a backup job processing this VM exists on the backup server. If such job is detected, Veeam Backup & Replication triggers a job and creates an incremental restore point for the VM. If a backup job for the VM does not exist, quick backup is terminated.

You can run quick backup for one VM or more VMs at once. If you start quick backup for several VMs and these VMs are processed by different backup jobs, Veeam Backup & Replication triggers a set of backup jobs. Each triggered job creates a separate restore point and stores this restore point in a corresponding backup chain.

In some cases, a VM may be processed by several backup jobs on the backup server. In this case, Veeam Backup & Replication starts the job that has created the most recent restore point for the VM.

For example, VM01 is processed by 2 jobs:
- **Backup job 1** created the most recent restore point on Monday
- **Backup job 2** created the most recent restore point on Tuesday

When you start quick backup for VM01, Veeam Backup & Replication will trigger **Backup job 2** to create a new incremental restore point.

**NOTE:**

If the quick backup task overlaps the scheduled backup job, the backup job waits for the quick backup task to complete.
Retention Policy for Quick Backups

When you perform quick backup, Veeam Backup & Replication creates a single VM incremental restore point. Unlike a regular incremental restore point that contains data for all VMs in a job, a single VM incremental restore point contains data only for a specific VM.

A single VM restore point is not regarded as full-fledged restore point in the backup chain. From the retention policy perspective, a single VM restore point is grouped with a regular restore point following it. When Veeam Backup & Replication needs to delete a single VM restore point by retention, it waits for the next regular restore point to expire — that is, Veeam Backup & Replication increases the retention by one restore point for some time. After the next regular restore point expires, Veeam Backup & Replication deletes two restore points at once.

If the backup chain is stored in a repository with the Use per-VM backup files option enabled, the retention increases in a different way. As a rule, the retention increases by the number of VMs from this chain for which quick backup was performed. This applies to the reverse incremental and forward incremental backup chains.
Performing Quick Backup

You can create an ad-hoc incremental backup for one or more VMs — quick backup, and add it to the backup chain in the backup repository. Quick backup can be helpful if you want to produce an additional restore point for one or more VMs in the backup job and do not want to configure a new job or modify the existing one.

Quick backup can be performed for VMs that meet the following requirements:

1. A backup job processing the VM exists on the backup server.
2. A full backup file for the VM exists in the backup repository configured in the backup infrastructure.

To perform quick backup:

1. Open the Inventory view.
2. In the infrastructure tree, select a host or VM container in which the VMs that you want to back up reside.
3. In the working area, select the VMs and click Quick Backup on the ribbon. You can also right-click the VMs and select Quick Backup.

Veeam Backup & Replication will trigger a backup job to create a new incremental restore point for selected VMs. Details of a running quick backup task are displayed in the job session window.
Importing Backups Manually

You may need to import backups to Veeam Backup & Replication in the following situations:

- The backup server has failed and you have restored it in a new location. You want to restore VM data from backups created by the backup server that has failed.
- You want to restore VM data from backups created on another backup server.
- You want to restore VM data from backups in the backup repository that is not added to the backup infrastructure (for example, if you removed it earlier).
- You want to restore VM data from VeeamZIP files created on your backup server or another backup server.

The imported backup becomes available in the Veeam Backup & Replication console. You can use any restore operation to recover VM data from this backup.

Before you import a backup, check the following prerequisites:

- The server from which you plan to import backups must be added to the backup infrastructure. Otherwise you will not be able to access backup files.
- To be able to restore VM data from previous backup restore points, make sure that you have all required incremental backup files (forward or reverse) in the same folder where the full backup file resides.

To import a backup to the Veeam Backup & Replication console:

1. On the **Home** tab, click **Import Backup**.
2. From the **Computer** list, select the server on which the backup you want to import is stored.
3. Click **Browse** and select the necessary VBM or VBK file. If you select the VBM file, the import process will be notably faster. It is recommended that you select the VBK file only if the VBM file is not available.
4. By default, index data of the VM guest OS file system is not imported with the backup to speed up the import process. If you want to import index data, select the **Import guest file system index** check box.
5. Click **OK** to import the backup. The imported backup will be displayed in the **Home** view, under the **Backups > Imported** node in the inventory pane. Backups are imported using the original name of the backup job with the _imported suffix appended.
TIP:
If you need to import all backups stored on a server, assign a backup repository role to it and enable import at the Review step of the wizard. If the repository is already added to the backup infrastructure, you can rescan it. Veeam Backup & Replication will automatically import backups. For more information, see Rescanning Backup Repositories.
Importing Encrypted Backups

You can import backups that were encrypted on this backup server or on another backup server.

To import an encrypted backup file:

1. On the **Home** tab, click **Import Backup**.
2. From the **Computer** list, select the host on which the backup you want to import is stored.
3. Click **Browse** and select the VBM or VBK file.
4. Click **OK**. The encrypted backup will appear under the **Backups > Disk (encrypted)** node in the inventory pane.
5. In the working area, select the imported backup and click **Specify Password** on the ribbon or right-click the backup and select **Specify password**.
6. In the **Password** field, enter the password for the backup file.

   If you changed the password one or several times while the backup chain was created, you must enter passwords in the following manner:
   - If you select a VBM file for import, you must specify the latest password that was used to encrypt files in the backup chain.
   - If you select a VBK file for import, you must specify the whole set of passwords that were used to encrypt files in the backup chain.

If you enter correct passwords, Veeam Backup & Replication will decrypt the backup file. The backup will be moved under the **Backups > Disk (imported)** node in the inventory pane.

**NOTE:**

If you use Enterprise or Enterprise Plus edition of Veeam Backup & Replication and your backup servers are connected to Veeam Backup Enterprise Manager, you can recover data from encrypted backups even if the password is lost. For more information, see Decrypting Data Without Password.
Importing Transaction Logs

You cannot import transaction log backups without VM backups (as there will be no restore point to which the transaction logs can be applied).

To import a VM backup with transaction log backups, do either of the following:

- Import a backup metadata file (VBM). In this case, Veeam Backup & Replication will automatically import the database backup and log backups.
- Import a full backup file (VBK). In this case, Veeam Backup & Replication will browse to corresponding log backups and import them, too.
Importing Backup Files from Scale-Out Backup Repositories

You cannot import a backup directly from the scale-out backup repository. When you perform backup import, you cannot browse through all extent of the scale-out backup repository. Veeam Backup & Replication lets you browse only through individual extents.

To import a backup from the scale-out backup repository, you must place backup files from all extents to one staging folder. The staging folder can reside on any server added to the backup infrastructure. After that, you can import the backup as usual.

**TIP:**

If you need to import all backups stored in a scale-out backup repository, rescan the repository. In this case, you do not need to place files in one folder, Veeam Backup & Replication will import backups automatically. For more information, see Rescanning Backup Repositories.
Exporting Backups

Exporting backups allows you to synthesize a complete and independent full backup file out of selected restore points that are located in your backup repositories. That is, you can transform any incremental or reverse-incremental backup chain (i.e., all dependent .vbk, .vib or .vrb files) into a standalone .vbk file.

Export applies to Full, Incremental and Reverse-incremental restore points located in:

- Backup repositories.
- Object storage repositories.
- Backup repositories of cloud service providers and their tenants.

Consider the following:

- The restore point that is being exported as a new full backup file is saved to the same repository, wherein the source selected restore points reside.
- Once export is complete, the exported backup files will be attached under the **Backups > Disk (Imported)** node.
- If a restore point that is being exported resides on the tenant side, a new full backup file will also be exported to the same repository (on the tenant side) from which the source restore point is being taken.
- If a tenant initiates export of a restore point that resides in the `subtenant` directory, a new full backup file will be exported to the `tenant` directory.
- If you select a backup job consisting of multiple virtual machines, Veeam will synthesize a separate full backup file per each machine.
- When exporting VMs from vCloud Director (vCD) backups, all the VMs will be exported without vApps, that is, a new full backup file will be exported as a simple VMWare backup, not vCD backup. For more information about vCD backups, see **Backup of vCloud Director VMs**.
- Export session results are saved to the configuration database and available for viewing, as described in **Viewing Session Statistics**.
Performing Export

To export data, do the following:

1. Launch New Export Wizard
2. Select Restore Points to Export
3. Specify Export Reason
4. Finish Working with Wizard
Step 1. Launch New Export Wizard

To launch the New Export wizard, do either of the following:

- On the Home tab, click Export Backup.
- In the Home view, under the Backups > Disks node, select a VM you want to transform into a full backup file and click Export backup.
Step 2. Select Restore Points to Export

At the **Restore Point** step of the wizard, do the following:

1. **Click Add** to select a VM, the restore points of which you want to transform into full backup files.

   ![Export Backup](image)

   - **Click Add** to select a VM, the restore points of which you want to transform into full backup files.
   - **In the Backups Browser dialog**, select a backup job or virtual machine.
   - When selecting a backup job consisting of multiple machines, then each machine will be exported as an independent full backup file.

2. **In the Backups Browser dialog**, select a backup job or virtual machine.

   When selecting a backup job consisting of multiple machines, then each machine will be exported as an independent full backup file.
Use the search field at the bottom of the dialog to find particular VMs in the list.

3. Select a VM from the table and click **Point** to select a restore point that you want to transform into a full backup file.

By default, the latest available restore point is selected.
4. Select the **Delete exported backup file automatically** check box and set up the value in the drop-down list to apply a retention policy for files that are being exported.

All the exported backup files that fall under the retention policy will be removed automatically.

To remove a restore point from the list, select a machine and click **Remove**.
Step 3. Specify Export Reason

At the **Reason** step of the wizard, provide the reason of restore (optional).

If you do not want to see this step in future, select the **Do not show me this page again** check box at the bottom of the dialog.
Step 4. Finish Working with Wizard

At the **Summary** step of the wizard, review summary information, click **Finish** and wait until the restore session, which is described in **Viewing Session Statistics**, is complete.

<table>
<thead>
<tr>
<th>Restore Point</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Automatically delete exported backup files in 1 month</td>
</tr>
<tr>
<td></td>
<td>Backups to export:</td>
</tr>
<tr>
<td></td>
<td>MSSQLSERVER</td>
</tr>
<tr>
<td></td>
<td>BETA</td>
</tr>
</tbody>
</table>

Export Backup
Viewing Session Statistics

Once you invoke the export procedure, Veeam shows the Restore Session progress dialog that informs you of the current export status.

You can close the dialog by clicking the Close button in the lower-right corner and let Veeam perform export in the background.

As each export session saves its results to the configuration database, you can review them at any time.

To review the export session results, do the following:

1. In the inventory pane, go to the History view and select the Restore > Export node.
2. In the working area, double-click a machine for which you want to review the session results or right-click a machine and select Statistics.

The Restore Session dialog contains the following tabs:

- **Reason** tab — shows you the reason of export you may have provided at the Specify Export Reason step of the wizard.

- **Parameters** tab — shows you the date when the exported backup files will be removed due to the retention policy you may have configured at the Select Restore Points to Export step of the wizard. In this tab you can also find a backup name and Date/time of a restore point that was synthesized into a full backup file.

- **Log** tab — shows you the actual export progress.
Canceling Session

To cancel a session, open the **Restore Session** dialog, as described above, and click **Cancel restore task** in the upper-right corner of the dialog.
Managing Backups

You can perform the following operations with backups:

- View backup properties
- Remove a backup from configuration
- Delete a backup from disks
- Delete a backup from object storage repository
- Remove missing restore points
Viewing Properties

You can view summary information about created backups. The summary information provides the following data:

- Available restore points
- Date of restore points creation
- Compression and deduplication ratios
- Data size and backup size
- GFS retention policy applied to restore points (W — weekly; M — monthly; Y — yearly)

To view summary information for backups:

1. Open the **Home** view.
2. In the inventory pane, select **Backups**.
3. In the working area, right-click the backup and select **Properties**.
4. To see the list of available restore points, select the required object from the **Objects** list.
Removing from Configuration

If you want to remove records about backups from the Veeam Backup & Replication console and configuration database, you can use the **Remove from configuration** operation.

When you remove a backup from the configuration, backup files (VBK, VIB, VRB, VBM, VBLOB) remain in the backup repository. You can import the backup later and restore VM data/files and folders from it.

When you remove an encrypted backup from configuration, Veeam Backup & Replication removes encryption keys from the configuration database. If you import such backup on the same backup server or another backup server, you will have to specify the password or unlock the backup with Veeam Backup Enterprise Manager. For more information, see **Importing Encrypted Backups**.

To remove a backup from the configuration:

1. Open the **Home** view.
2. In the inventory pane, select **Backups** or **Replicas**.
3. In the working area, select the backup and click **Remove from Configuration** on the ribbon. You can also right-click the backup and select **Remove from configuration**.
Deleting Backups from Disk

If you want to delete records about backups from the Veeam Backup & Replication console and configuration database and, additionally, delete backup files from the backup repository, you can use the **Delete from disk** operation. When you delete backup files from a disk, Veeam Backup & Replication deletes the whole chain from the backup repository. Thus, on the next run of the backup job, Veeam Backup & Replication will create full backups for VMs included in the job.

Mind the following:

- Do not delete backup files from the backup repository manually. Use the **Delete from disk** option instead. If you delete backup files manually, subsequent backup or replication job sessions will fail.

- If the per-VM functionality is enabled, you can perform the **Delete from disk** operation for separate VMs in the backup. If you delete backup files for one VM, on the next run of the backup job Veeam Backup & Replication will create a full backup for VMs whose backup files are deleted. For all other VMs, Veeam Backup & Replication will create increments.

  To learn more about per-VM backup files, see [Per-VM Backup Files](#).

- If you use the scale-out backup repository, keep in mind that the **Delete from disk** operation will remove the backups not only from the Performance Tier, but also from the Capacity Tier. If you want to remove backups from the Performance Tier only, you should move those backups to the Capacity Tier instead. For details, see [Moving to Capacity Tier](#).

To delete backup files from the backup repository, do the following:

1. Open the **Home** view.
2. In the inventory pane, select **Backups** or **Replicas**.
3. In the working area, select the backup or separate VM in the backup and click **Remove from > Disk** on the ribbon. You can also right-click the backup and select **Delete from disk**.
4. To remove backups with GFS flags (weekly, monthly and yearly), select the **Remove GFS full backups** check box and click **Yes**.
Deleting Backups from Object Storage

This section explains how to delete offloaded backups from object storage repositories. For more information, see Removing Backups from Capacity Tier.

To delete offloaded backups, do the following:

1. Open the **Home** view.
2. In the inventory pane, select the **Backups > Object Storage** node.
3. In the working area, select a backup or VM and click **Delete from Disk** on the ribbon. Alternatively, you can right-click a backup and select **Delete from disk**.
Removing Missing Restore Points

In some cases, one or more restore points in the backup chain may be inaccessible. This can happen, for example, if the backup repository is put to the maintenance mode (for scale-out backup repositories), the backup repository is not available or some backup file is missing in the backup chain. Backup chains that contain missing restore points get corrupted — you cannot perform backup or restore VM data from the missing restore point, and restore points that depend on the missing restore point.

You can perform two operations with missing restore points:

- **Forget** — you can remove records about missing restore points from the configuration database. Veeam Backup & Replication will “forget” about missing restore points and will not display them in the console. The backup files themselves will remain on disk (if backup files are still available).

- **Remove** — you can remove records about missing restore points from the configuration database and delete backup files from disk (if backup files are still available).

**NOTE:**

Consider the following:

- The **Forget** and **Remove from disk** options are available only for restore points that are missing from the backup chain or points that depend on missing ones. If the restore point is available in the backup chain and does not depend on a missing restore point, you will not be able to use the **Forget** and **Remove from disk** options for it.

- You can manually update information about missing restore points. For this, disable a backup job and rescan the backup repository that is the target for the backup copy job. For more information, see **Disabling and Removing Jobs** and **Rescanning Backup Repositories**. Manual update can be required because Veeam Backup & Replication requires some time to update information in the configuration database for restore points that were removed from a backup chain or became inaccessible. That is why, such restore points may not be displayed in the console as missing restore points.

- Veeam Backup & Replication does not track missing restore points in backups that reside in the cloud repository.

To remove records about missing restore points from the configuration database:

1. Open the **Home** view.
2. In the inventory pane, select **Disk** under **Backups**.
3. In the working area, select the backup and click **Properties** on the ribbon or right-click the backup and select **Properties**.
4. In the **Backup Properties** window, right-click the missing restore point and select **Forget**.
   - To remove only the selected restore point and restore points that depend on it (that is, a part of the backup chain starting from this restore point), select **This and dependent backups**.
To remove all missing restore points, select **All unavailable backups**.

To remove missing restore points from the configuration database and disk:

1. Open the **Home** view.
2. In the inventory pane, click **Disk** under **Backups**.
3. In the working area, select the backup and click **Properties** on the ribbon or right-click the backup and select **Properties**.
4. In the **Backup Properties** window, right-click the missing restore point and select **Remove from disk**.
   - To remove only the selected restore point and restore points that depend on it (that is, a part of the backup chain starting from this restore point), select **This and dependent backups**.
- To remove all missing restore points, select **All unavailable backups**.
Managing Jobs

To view all jobs configured on the backup server, open the **Home** view and select the **Jobs** node in the inventory pane. The list of available jobs is displayed in the working area. You can edit job properties, start and stop jobs, restart failed jobs, clone jobs, view job statistics and delete unnecessary jobs.
Editing Job Settings

You can edit configured jobs at any moment. For example, you may want to change scheduling settings for the job or add some VMs to the job.

To edit job settings:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the job and click Edit on the ribbon or right-click the job and select Edit.

You will follow the same steps as you have followed when creating the job and can change job settings as required.
Cloning Jobs

You can create new jobs by means of job cloning. Job cloning allows you to create an exact copy of any job with the same job settings. Configuration information of the created job copy are written to the configuration database that stores information of the original job.

To create multiple jobs with similar settings, you can configure a set of jobs that will be used as 'job templates'. You can then clone these 'job templates' and edit settings of cloned jobs as required.

The name of the cloned job is formed by the following rule: <job_name_clone1>, where job_name is the name of the original job and clone1 is a suffix added to the original job name. If you clone the same job again, the number in the name will be incremented, for example, job_name_clone2, job_name_clone3 and so on.

When cloning job, Veeam Backup & Replication can change some job settings so that cloned jobs do not hinder original jobs.

- If the original job is scheduled to run automatically, Veeam Backup & Replication disables the cloned job. To enable the cloned job, select it in the job list and click Disable on the ribbon or right-click the job and select Disable.
- If the original job is configured to use a secondary target, the cloned job is created without the secondary target settings.

To clone a job:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the job and click Clone on the ribbon or right-click the job and select Clone.
4. After a job is cloned, you can edit all its settings, including the job name.
NOTE:
The job cloning functionality is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.
Disabling and Removing Jobs

You can temporary disable scheduled jobs. The disabled job is not deleted from Veeam Backup & Replication, it is paused for some period of time and is not run by the specified schedule. You can enable a disabled job at any time.

To disable a job:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the job and click Disable on the ribbon or right-click the job and select Disable.

To enable a disabled job, select it in the list and click Disable on the ribbon once again.

You can permanently remove a job from Veeam Backup & Replication and from the configuration database.

To remove a job:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the job and click Delete on the ribbon or right-click the job and select Delete.

NOTE:

If you want to permanently remove a backup copy job, you must first stop the synchronization process. To do this, disable the backup job. After the job is disabled, you can delete it.
Starting and Stopping Jobs

You can start job manually, for example, if you want to create an additional restore point for a VM backup or replica and do not want to change the job schedule. You can also stop a job, for example, if VM processing is about to take long, and you do not want the job to produce workload on the production environment during business hours.

Starting Jobs

To start a job:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the backup job and click Start on the ribbon or right-click the job and select Start.

Stopping Jobs

You can stop a job in one of the following ways:

- Stop job immediately. In this case, Veeam Backup & Replication will produce a new restore point only for those VMs that have already been processed by the time you stop the job.

- Stop job after current VM. In this case, Veeam Backup & Replication will produce a new restore point only for those VMs that have already been processed and for VMs that are being processed at the moment.

To stop a job:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the backup job and click Stop on the ribbon or right-click the job and select Stop. In the displayed window, click Immediately.

To stop the job after the current VM:

1. Open the Home view.
2. In the inventory pane, click Jobs.
3. In the working area, right-click the job and select **Stop**. In the displayed window, click **Gracefully**.
Starting and Stopping Transaction Log Backup Jobs

If you create a backup job and instruct it to ship transaction logs, the backup job comprises 2 jobs:

1. A parent backup job creating an image-level backup of the VM on which the database runs. This job is named as a regular backup job, for example: Daily Job.

2. A transaction log backup job responsible for shipping transaction logs to the backup repository. This job is named by the following pattern:
   - For MS SQL: `<job_name>` SQL Server Transaction Log Backup. For example, Daily Job SQL Server Transaction Log Backup.
   - For Oracle: `<job_name>` Oracle Redo Log Backup. For example, Daily Job Oracle Redo Log Backup.

The transaction log backup job is created automatically by Veeam Backup & Replication if it detects that you have added to the backup job at least one Microsoft SQL Server or Oracle VM, enabled application-aware processing and instructed Veeam Backup & Replication to back up transaction logs periodically.

Starting Transaction Log Backup Jobs

A parent backup job is started manually when you click Start on the toolbar, or automatically by schedule. The transaction log backup job is initially started when you enable schedule for the parent backup job. The transaction log backup works continuously in the background. A new session of the transaction log backup job starts every time the parent backup job is launched.

Stopping Transaction Log Backup Jobs

You can stop transaction log processing in one of the following ways:

- Disable transaction log shipping
- Disable the parent backup job

If you want the backup job to create image-level backups of the VM but do not want it to ship transaction logs anymore, you can disable transaction log backup in the backup job settings.

To disable transaction log shipping:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the backup job and click Edit on the ribbon or right-click the backup job and select Edit.
4. Pass to the Guest Processing step of the wizard and click Applications.
5. In the Application-Aware Processing Options window, select the VM and click Edit.
6. On the SQL or Oracle tab of the VM Processing Settings window, disable transaction log backup.
7. Click Finish to save the job settings.
If you do not want to create image-level backups of the VM and back up database transaction logs, you can disable scheduling for the parent backup job. Veeam Backup & Replication will instruct the transaction log backup job to complete log processing for all VMs added to the parent backup job, and will switch the parent backup job to the non-scheduled mode. The parent backup job will no longer be started automatically by schedule – you will have to run it manually.

To disable scheduling for the parent backup job:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the backup job and click Edit on the ribbon. Alternatively, you can right-click the backup job and select Edit.
4. Pass to the Schedule step of the wizard and clear the Run the job automatically check box.
5. Click Finish to save the job settings.

Alternatively, you can disable the parent backup job:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the backup job and click Disable on the ribbon or right-click the job and select Disable.

To re-activate transaction log processing for all VMs in the parent backup job, select the job in the list and click Disable on the ribbon once again.
Reconfiguring Jobs with Microsoft SQL Server VMs

In some situations, you may need to reconfigure a backup job that processes a Microsoft SQL Server VMs and ships transaction logs. For example, you may want to create a separate backup job to process the virtualized database, and delete the VM running the database from the previously created job.

When you configure a new job, mind the restriction on transaction logs shipping. By default, the new backup job that processes the VM will not ship transaction logs if transaction logs for this VM have been shipped for the last 7 days by another backup job on the same backup server.

You can overcome this restriction with registry keys. For more information, contact Veeam Customer Support.
Reporting

When you run a job, Veeam Backup & Replication saves the job statistics and operation data to the configuration database. You can view real-time statistics for any performed job and generate reports with statistics data for any job or separate job session.
Viewing Real-Time Statistics

To view real-time statistics for a job, do one of the following:

- Open the Home view, in the inventory pane select Jobs, Last 24 hours or Running. In the working area, double-click the job.
- Open the Home view, in the inventory pane select Jobs, Last 24 hours or Running. In the working area, right-click the job and select Statistics.

The real-time statistics provides detailed data on job sessions: job progress, duration, processing rate, performance bottlenecks, amount of processed data, read and transferred data and details of the session performance, for example, warnings and errors that have occurred in the process of operation.

In addition to overall job statistics, the real-time statistics provides information on each object processed with the job. To view the processing progress for a specific object, select it in the list on the left.

**TIP:**

Mind the following:

- To collapse and expand the real-time statistics window, use Hide Details and Show Details buttons at the bottom left corner of the window.
- To switch between the job sessions backward and forward, use left and right arrow keys on the keyboard.

### Statistics Counters

Veeam Backup & Replication displays jobs statistics for the following counters:

- The **Job progress** bar shows percentage of the job completion.
- The **Summary** box shows general information about the job:
  - **Duration** — time from the job start till the current moment or job end.
  - **Processing rate** — average speed of VM data processing. This counter is a ratio between the amount of data that has actually been read and job duration.
  - **Bottleneck** — bottleneck in the data transmission process. To learn about job bottlenecks, see Detecting Performance Bottlenecks.
- The **Data** box shows information about processed VM data:
  - **Processed** — total size of all VM disks processed by the job.
- **Read** — amount of data read from the volume by the source-side Data Mover Service prior to applying compression and deduplication. For incremental job runs, the value of this counter is typically lower than the value of the **Processed** counter. Veeam Backup & Replication reads only data blocks that have changed since the last job session, processes and copies these data blocks to the target.

- **Transferred** — amount of data transferred from the source-side Data Mover Service to the target-side Data Mover Service after applying compression and deduplication. This counter does not directly indicate the size of the resulting files. Depending on the backup infrastructure and job settings, Veeam Backup & Replication can perform additional activities with data: deduplicate data, decompress data prior to writing the file to disk and so on. The activities can impact the size of the resulting file.

- The **Status** box shows information about the job results. This box informs how many tasks have completed with the **Success**, **Warning** and **Error** statuses (1 task per 1 VM).

- The pane at the lower left corner shows a list of objects included in the job.

- The pane at the lower right corner shows a list of operations performed during the job. To see a list of operations for a specific object included in the job, click the object in the pane on the left. To see a list of operations for the whole job, click anywhere on the blank area in the left pane.

### Colored Graph

To visualize the data transfer process, Veeam Backup & Replication displays a colored graph in the real-time statistics window:

- The green area defines the amount of data read from source.
- The brown area defines the amount of data transported to target.
- The horizontal line defines the current data processing speed.

If the job session is still being performed, you can click the graph to view data rate for the last 5 minutes or the whole processing period. If the job session has already ended, the graph will display information for the whole processing period only.
The colored graph is displayed only for the currently running job session or the latest job session. If you open real-time statistics for past sessions other than the latest one, the colored graph will not be displayed.
Viewing Job Session Results

You can view detailed statistics on every job session.

To view statistics for a selected job session, do either of the following:

- Open the History view. In the inventory pane select Jobs. In the working area, double-click the necessary job session.

- Open the History view. In the inventory pane select Jobs. In the working area, right-click the necessary job session and select Statistics.

TIP:
To switch between past job sessions, use left and right arrow keys on the keyboard.
Viewing Job and Job Session Reports

You can generate reports with details about job and job session performance.

Job Report

The job report contains data on all sessions initiated for a specific job. To generate a job report:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the necessary job and click Report on the ribbon. You can also right-click the job and select Report.

The session report contains data on a single job session:

- Cumulative session statistics: session duration details, details of the session performance, amount of read, processed and transferred data, backup size, compression and deduplication ratios.
- Detailed statistics for every VM processed within the session: processing duration details, backup data size, amount of read and transferred data, list of warnings and errors (if any).

TIP:

Generated reports are stored at the C:\Users\<username>\AppData\Local\Temp folder.

Session Report

To generate a session report:

1. Open the History view.
2. In the inventory pane, select Jobs.
3. In the working area, select the necessary session and click Report on the ribbon. You can also right-click the necessary session and select Report.

<table>
<thead>
<tr>
<th>Backup Job: DBs Backup Daily Backup Job</th>
<th>Success 2 of 2 VMs processed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Monday, January 9, 2017 1:08:22 AM</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Success</strong> 2</td>
<td><strong>Start time</strong> 1:08:22 AM</td>
</tr>
<tr>
<td><strong>Warning</strong> 0</td>
<td><strong>End time</strong> 1:15:14 AM</td>
</tr>
<tr>
<td><strong>Error</strong> 0</td>
<td><strong>Duration</strong> 0:06:52</td>
</tr>
</tbody>
</table>

**Details**

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Start time</th>
<th>End time</th>
<th>Size</th>
<th>Read</th>
<th>Transferred</th>
<th>Duration</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>sqlog03</td>
<td>Success</td>
<td>1:09:36 AM</td>
<td>1:14:19 AM</td>
<td>527.0 GB</td>
<td>4.2 GB</td>
<td>1.2 GB</td>
<td>0:04:43</td>
<td></td>
</tr>
<tr>
<td>sqlog14</td>
<td>Success</td>
<td>1:09:35 AM</td>
<td>1:15:04 AM</td>
<td>608.0 GB</td>
<td>35.3 GB</td>
<td>3.8 GB</td>
<td>0:05:26</td>
<td></td>
</tr>
</tbody>
</table>
Replication

In addition to VM backups, you can create VM replicas with Veeam Backup & Replication. When you replicate a VM, Veeam Backup & Replication creates an exact copy of the VM in the native Microsoft Hyper-V format on a spare host, and maintains this copy in sync with the original VM.

Replication provides the best recovery time objective (RTO) values, as you actually have a copy of your VM in a ready-to-start state. That is why replication is commonly recommended for the most critical VMs that need minimum RTOs.
About Replication

Veeam Backup & Replication is built for virtual environments. It operates at the virtualization layer and uses an image-based approach for VM replication.

Veeam Backup & Replication does not install agent software inside the VM guest OS to retrieve VM data. To back up VMs, Veeam Backup & Replication leverages Microsoft VSS snapshot and checkpoint capabilities. When you replicate a VM, Veeam Backup & Replication instructs Microsoft Hyper-V to create a cohesive point-in-time copy of a VM. Veeam Backup & Replication uses this point-in-time copy as a source of data for backup.

In many respects, replication works similarly to forward incremental backup. During the first replication cycle, Veeam Backup & Replication copies data of the original VM running on the source host, and creates its full replica on the target host. Unlike backup files, replica virtual disks are stored decompressed in their native format. All subsequent replication cycles are incremental. Veeam Backup & Replication copies only those data blocks that have changed since the last replication job session. To keep track of changed data blocks, Veeam Backup & Replication uses different approaches. For more information, see Changed Block Tracking.

Veeam Backup & Replication lets you perform onsite replication for high availability (HA) scenarios and remote (offsite) replication for disaster recovery (DR) scenarios. To facilitate replication over the WAN or slow connections, Veeam Backup & Replication optimizes traffic transmission. It filters out unnecessary data blocks such as duplicate data blocks, zero data blocks, blocks of swap files and blocks of excluded VM guest OS files, and compresses replica traffic. Veeam Backup & Replication also allows you to use WAN accelerators and apply network throttling rules to prevent replication jobs from consuming the entire network bandwidth.

In Veeam Backup & Replication, replication is a job-driven process. To perform replication, you need to configure replication jobs. A replication job is a configuration unit of the replication activity. The replication job defines when, what, how and where to replicate. One replication job can be used to process one or several VMs. You can instruct Veeam Backup & Replication to run jobs automatically by schedule or start them manually.

Limitations for Replication

Replication has the following limitations:

- [For VMs with VHD disks] If you change the size of VM disks on the source VM, Veeam Backup & Replication will delete all available restore points on the VM replica during the next replication job session.
- You cannot replicate VMs with shared VHDX and VHDS disks.
- Due to Microsoft limitations, you cannot use Microsoft Azure Active Directory credentials to perform application-aware processing on VMs running Microsoft Windows 10.
- If a job is unable to complete within 21 days period, it will be stopped with the 'Failed' status.
How Replication Works

Veeam Backup & Replication performs VM replication in the following way:

1. When a new replication job session starts, Veeam Backup & Replication starts the Veeam Backup Manager process on the backup server. Veeam Backup Manager reads job settings from the configuration database and creates a list of VM tasks to process. For every disk of VMs added to the job, Veeam Backup & Replication creates a new task.

2. Veeam Backup Manager connects to the Veeam Backup Service. The Veeam Backup Service includes a resource scheduling component that manages all tasks and resources in the backup infrastructure. The resource scheduler checks what backup infrastructure resources are available, and assigns backup proxies and backup repositories to process job tasks.

3. Veeam Backup Manager connects to Veeam Transport Services on source and target backup proxies (on-host or off-host) and on the backup repository. The Veeam Transport Services, in their turn, start Veeam Data Movers. A new instance of Veeam Data Mover is started for every task that the backup proxy is processing.

4. Veeam Backup Manager establishes a connection with Veeam Data Movers on backup proxies and the backup repository, and sets a number of rules for data transfer, such as network traffic throttling rules and so on.

5. The source Veeam Data Mover establishes a connection with the target Veeam Data Mover, and Veeam Data Mover on the backup repository.

6. Veeam Backup Manager queries information about VMs and virtualization hosts from Microsoft Hyper-V.

7. If application-aware image processing is enabled for the job, Veeam Backup & Replication connects to VM guest OSes, deploys runtime processes on VM guest OSes and performs in-guest processing tasks.

8. Veeam Backup & Replication requests Microsoft Hyper-V VSS to create a cohesive point-in-time copy of a VM. Microsoft Hyper-V VSS creates a volume snapshot or VM checkpoint, depending on the hypervisor version.

9. The source Veeam Data Mover reads the VM data from the volume snapshot or VM checkpoint and copies it. During incremental job sessions, the source Veeam Data Mover uses CBT to retrieve only those data blocks that have changed since the previous job session. If CBT is not available, the source Veeam Data Mover interacts with the Veeam Data Mover on the backup repository to obtain replica metadata, and uses this metadata to detect blocks that have changed since the previous job session.

   While copying VM data, the source Veeam Data Mover performs additional processing. It filters out zero data blocks, blocks of swap files and blocks of excluded VM guest OS files. The source Veeam Data Mover compresses VM data and transports it to the target Veeam Data Mover.

10. The target Veeam Data Mover decompresses VM data and writes the result to the destination datastore.
11. After the backup proxy finishes reading VM data, Veeam Backup & Replication requests Microsoft Hyper-V VSS to delete the volume snapshot or VM checkpoint.
Replication Architecture

Veeam Backup & Replication uses the following components for the replication process:

- Backup server
- Source host and target host with associated volumes
- [Optional] Off-host backup proxy
- Backup repository (only for snapshot replica)
- [Optional] WAN accelerators

Backup Server

The backup server is the configuration, administration and management core of the replication infrastructure. You can use the backup server to set up all components required for the replication process and to configure replication jobs. During the replication process, the backup server coordinates replication tasks, controls resource allocation and replica job scheduling.

Source and Target Hosts

The source host and the target host produce two terminal points between which replicated VM data is moved. The role of a target can be assigned to a single Microsoft Hyper-V host or Microsoft Hyper-V cluster.

If you assign a Microsoft Hyper-V cluster as a target, the replication job is performed even if one of the cluster hosts fails. During the first session of the replication job, the VM replica is registered in the cluster. During every subsequent job session, Veeam Backup & Replication detects the VM in the cluster and transports incremental data to the target. Change of the cluster owner does not affect the replication job.

Off-Host Backup Proxies

To collect, transform and transport VM data during the VM replication process, Veeam Backup & Replication uses Veeam Data Movers. Data Mover Services communicate with each other and maintain a stable connection.

For every replication job, Veeam Backup & Replication requires 3 Veeam Data Movers:

- Source Veeam Data Mover runs on the source host or off-host backup proxy, depending on the replication scenario.
- Target Veeam Data Mover runs on the target host.
- Veeam Data Mover hosted on the backup repository (not required for legacy replica jobs)

During replication, the source Veeam Data Mover interacts with the source host, and the target Veeam Data Mover interacts with the target host. The Veeam Data Mover hosted on the backup repository works with replica metadata files.

Backup Repository

The backup repository stores VM replica metadata. The backup repository must be deployed in the source site, as close to the source host as possible. When you perform incremental replication, the source Veeam Data Mover communicates with the Veeam Data Mover on the backup repository to obtain replica metadata and quickly detect changed blocks of data between two replica states.
WAN Accelerators

WAN accelerators are optional components in the replication infrastructure. You can use WAN accelerators if you replicate VMs over a slow connection or over WAN.

In the replication process, WAN accelerators are responsible for global data caching and deduplication. To use WAN acceleration, you must deploy two WAN accelerators in the following manner:

- The source WAN accelerator must be deployed in the source side, close to the source host or off-host backup proxy running the source Veeam Data Mover.
- The target WAN accelerator must be deployed in the target side, close to the target host running the target Veeam Data Mover.

Replication Scenarios

Veeam Backup & Replication supports two replication scenarios:

- **On-host replication**
- **Off-host replication**

Both scenarios are applicable for onsite replication and replication to a remote disaster recovery (DR) site. In both scenarios, you can replicate VM data over a direct data path or over a pair of WAN accelerators.

On-Host Replication

On-host replication can be used when you replicate VMs over the LAN or WAN. This scenario requires the following backup infrastructure components:

- Source host. The source Veeam Data Mover runs on the source host.
- Target host. The target Veeam Data Mover runs on the target host.
- [For snapshot replica] Backup repository for storing replica metadata.
- [Optional] WAN accelerators.

No additional infrastructure components are required. Note, however, that the source Veeam Data Mover may cause additional overhead on the source host.
Off-Host Replication

Off-host replication can be used when you replicate VMs both over the LAN and WAN. In contrast to on-host replication, this scenario requires an additional replication infrastructure component – off-host backup proxy.

The off-host replication scenario requires the following replication infrastructure components:

- Source host.
- Off-host backup proxy. The off-host backup proxy must be deployed in the source site and must have access to the source host and the target host. The source Veeam Data Mover runs on the off-host backup proxy.
- Target host. The target Veeam Data Mover runs on the target host.
- [For snapshot replica] Backup repository for storing replica metadata.
- [Optional] WAN accelerators.

During off-host replication, all the necessary data transformations (such as data compression and block filtering) are performed on off-host backup proxy, which helps reduce unwanted overhead on the source host.

Replication Data Paths

VM replication can work over two data paths:

- Direct data path
- Over a pair of WAN accelerators

**NOTE:**

Replication over WAN accelerators is supported only for snapshot replicas.

Direct Data Path

Replication over a direct data path is recommended if you replicate VMs over the LAN or fast connections. In this case, Veeam Backup & Replication transports data directly from the source host or off-host backup proxy to the target host.
Replication over WAN Accelerators

If you have a weak WAN link, you can replicate VM data over a pair of WAN accelerators. WAN accelerators provide advanced technologies to optimize VM data transfer:

- Global data caching and deduplication
- Resume on disconnect for uninterrupted data transfer

WAN accelerators add a new layer in the backup infrastructure — a layer between the source Veeam Data Mover and target Veeam Data Mover. The data flow goes from the source host or off-host backup proxy over a pair of WAN accelerators to the target host.

To replicate VMs over WAN accelerators, you must deploy a WAN accelerator at each end of the WAN link:

- Source WAN accelerator must be deployed in the source site. The source WAN accelerator must have access to the backup server, source host or off-host backup proxy and target WAN accelerator.
- Target WAN accelerator must be deployed in the target site. The target WAN accelerator must have access to the backup server, source WAN accelerator and target host.
Replication Chain

For every VM replica, Veeam Backup & Replication creates and maintains a number of restore points. If the original VM fails for any reason, you can temporarily or permanently fail over to a VM replica and restore critical services with minimum downtime. If you cannot fail over to the latest VM replica state (for example, in case corrupted data was replicated from source to target), you can select a previous restore point and fail over to it.

Veeam Backup & Replication utilizes Microsoft Hyper-V checkpoint capabilities to create and manage replica restore points. During the first replication job session, Veeam Backup & Replication creates a copy of the source VM on the target host. During every subsequent replication job session, it adds a new checkpoint to the checkpoint chain for the VM replica. Blocks of data that have changed since the last job run are written to the checkpoint differencing disk, and the checkpoint differencing disk acts as a restore point.

VM replica restore points are stored in a native Microsoft Hyper-V format next to replica virtual disk files, which allows Veeam Backup & Replication to accelerate failover operations. To fail over to the necessary point of the VM replica, Veeam Backup & Replication does not need to apply rollback files. Instead, it uses a native Microsoft Hyper-V mechanism of applying the checkpoint.

You can specify retention policy settings for replication jobs — define how many retention points you want to keep for every VM replica. Veeam Backup & Replication will keep only the specified number of points and remove outdated checkpoints.
VM Replica Types

Veeam Backup & Replication supports two methods for creating VM replicas:

- **Snapshot replica**
- **Legacy replica**

Snapshot Replica

To create snapshot replicas, Veeam Backup & Replication uses Hyper-V VM snapshot capabilities.

Snapshot replica in many respects is similar to forward incremental backup. During the first run of a replication job, Veeam Backup & Replication copies the VM running on the source Hyper-V host and creates its full replica on the target host. The replica is stored decompressed, in a native Hyper-V format.

All subsequent replication jobs are incremental. Veeam Backup & Replication copies only those data blocks that have changed since the last replication cycle. To keep track of changed data blocks for Hyper-V VMs, Veeam Backup & Replication uses its proprietary changed block tracking mechanism (for VMs registered on Microsoft Hyper-V Server 2012 R2 and earlier) or RCT (for VMs registered on Microsoft Hyper-V Server 2016 and later). For more information, see Changed Block Tracking.

For each new incremental run of the replication job, Veeam Backup & Replication triggers a regular snapshot of the replica. Blocks of data that have changed since the last job run are written to AVHD(X) files. Thus, the created replica snapshot acts as a new restore point.

As a result, for every replicated VM, Veeam Backup & Replication produces a full replica and a chain of snapshots, or restore points. The latest snapshot in the chain mirrors the state of the original VM. If the original VM fails for any reason, you can temporary or permanently fail over to the latest restore point or to an earlier point in time.

Veeam Backup & Replication creates and maintains the following types of replica files:

- Full VM replica (a set of VM configuration files and virtual disks)
- Replica restore points (VM snapshot files)
- Replica metadata (VBK file) that store VM replica digests. Veeam Backup & Replication uses this file to quickly detect changed blocks of data between two replica states. For more information, see Changed Block Tracking.

The full VM replica along with its restore points is stored in a dedicated folder in the target datastore. Replica metadata files are stored in a backup repository.

**NOTE:**
Virtual disks of snapshot VM replicas are always dynamically expanding.

Legacy Replica

For legacy replicas, Veeam Backup & Replication uses an approach that is similar to reverse incremental backup. During the first run of a replication job, Veeam Backup & Replication copies the VM running on the source host and creates its full replica on the target host. The replica is stored decompressed, in a native Hyper-V format.
All subsequent replication jobs are incremental. Veeam Backup & Replication copies only those data blocks that have changed since the last replication cycle. To keep track of changed data blocks for Hyper-V VMs, Veeam Backup & Replication uses its proprietary changed block tracking mechanism.

At every incremental job run, Veeam Backup & Replication “injects” changes into the replica to rebuild it to the most recent state of the original VM. It also creates a rollback file to store data blocks that were replaced when the full replica was rebuilt.

As a result, for every replicated VM, Veeam Backup & Replication produces a full replica and a chain of rollback files. The replica mirrors the latest state of the original VM, while rollback files serve as restore points. If you need to restore a replica to a particular point in time, Veeam Backup & Replication will apply the required rollback files to get you to that point in time.

Veeam Backup & Replication creates and maintains the following types of replica files:

- Full VM replica (a set of VM configuration files and virtual disks)
- VRB — replica rollback files
- VBR — file that stores hash data describing the current state of a VM replica on the target host

All files of a legacy replica are stored in a dedicated folder on the target volume.

Limitations for Legacy Replicas

- Legacy replicas can use only the virtual infrastructure as a source of data. Replication from backup is not supported for legacy VM replicas.

- You cannot clone a legacy replication job that replicates a VM from the source Microsoft Hyper-V Server 2008 R2 host to the target Microsoft Hyper-V Server 2012 host or later using the Veeam Backup & Replication console or Veeam Backup Enterprise Manager web UI.

Supported Platforms for VM Replica Types

Veeam Backup & Replication automatically selects what type of VM replica must be created. You cannot explicitly choose to create a snapshot or legacy replica.

The type of VM replica depends on the following criteria:

- Version of the source Microsoft Hyper-V host
- Version of the target Microsoft Hyper-V host

New Replication Jobs

If you create replication jobs with Veeam Backup & Replication, the replication job will produce VM replicas of the following types:

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Target 2008 R2</th>
<th>Target 2012-2019</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Infrastructure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source 2008 R2</td>
<td>Legacy</td>
<td>Snapshot</td>
</tr>
</tbody>
</table>
### Source/Target

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Target 2008 R2</th>
<th>Target 2012-2019*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source 2012-2019</td>
<td>Not supported</td>
<td>Snapshot</td>
</tr>
<tr>
<td>From Backup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source 2008 R2</td>
<td>Not supported</td>
<td>Snapshot</td>
</tr>
<tr>
<td>Source 2012-2019</td>
<td>Not supported</td>
<td>Snapshot</td>
</tr>
</tbody>
</table>

*Target OS version must be equal or higher than Source OS version

For example:

- You configure a replication job with a Microsoft Hyper-V 2008 R2 host used as a source and a Microsoft Hyper-V 2008 R2 host used as a target. VM data is retrieved from the production infrastructure. In this case, the replication job will produce a legacy replica.

- You configure a replication job with a Microsoft Hyper-V 2012 R2 host used as a source and a Microsoft Hyper-V 2016 host used as a target. VM data is retrieved from the production infrastructure. In this case, the replication job will produce a snapshot replica.

## Existing Replication Jobs

After you upgrade Veeam Backup & Replication, legacy replication jobs remain as they are. They do not change their type to snapshot replication jobs.

After you upgrade to Veeam Backup & Replication, replication jobs work as usual. However, if you have legacy replication jobs that use Microsoft Hyper-V Server 2012 host and later as a target, and these jobs were created with Veeam Backup & Replication earlier than 9.0, you will not be able to edit these jobs.

Legacy replication jobs can use only the virtual infrastructure as a source of data. Replication from backup is not supported for legacy replication jobs.
Changed Block Tracking

To perform incremental replication, Veeam Backup & Replication needs to know what data blocks have changed since the previous job session. For this purpose, it uses Changed Block Tracking.
Advanced Replication Technologies

To minimize the workload on the production infrastructure and reduce data traffic, you can use the following advanced replication technologies:

- **Replica from backup** can help you minimize use of compute, storage and network resources of the production infrastructure.

- **Replica seeding** and **replica mapping** can help you minimize the amount of traffic going to the disaster recovery (DR) site over WAN or slow links.

Replica from Backup

Disaster recovery plans often require that you back up and replicate the same VM for disaster recovery (DR) and HA purposes. Normally, this doubles the workload on the virtual infrastructure. You need to create two VM snapshots, independently from one another, and transfer VM data from the production site twice.

You can reduce the workload on the production environment by using the replica from backup option. This option can be used for onsite and offsite replication scenarios.

When you perform replication from backup, Veeam Backup & Replication does not address hosts and storage in the production environment to read VM data. As a source of data, it uses a backup chain that already exists in the backup repository. As a result, you do not need to create a VM snapshot for replication and transport the same data twice. You retrieve VM data only during the backup job. The replication job re-uses retrieved data to build VM replica restore points.

Although replica from backup might resemble replica seeding, there is difference between these options:

- Replica seeding uses the backup file only during the first run of a replication job. To further build VM replica restore points, the replication job addresses the production environment and reads VM data from the source storage.

- Replica from backup uses a backup chain in the backup repository as the only source of data. When building a new VM replica restore point, Veeam Backup & Replication always reads data from the latest restore point in the backup chain, either full or incremental. The backup chain in the backup repository may be created with a backup job or a backup copy job.

Limitations for Replica from Backup

- You can perform replication only from backups of Microsoft Hyper-V virtual machines created with Veeam Backup & Replication.

- A backup that you plan to use for replication must be mapped to a backup job on the backup server where you configure the replication job.

If you want to use a backup created on another backup server, perform the following steps:

  a. Import the backup to the Veeam Backup & Replication console.

  b. Create a new backup job and map the imported backup to it.
c. Create a replication job, enable the **Get seed from the following backup repository** option and point to the backup repository where the imported backup resides.

Mind the following:

- The backup job to which you map the imported backup file on another backup server must run periodically and produce new restore points. You cannot create a job, map the imported backup to it and never run this job.
- No other job on any other backup server must use the imported backup.

**How Replica from Backup Works**

Replica from backup is performed with a regular replication job. When you set up a replication job, you define a backup repository with VM backups as a source of data. If the backups for this VM are available in different backup repositories, you can select several backup repositories as a source. In this case, Veeam Backup & Replication will look for the latest VM restore point across these backup repositories.

For example, you have configured two backup jobs that process the same VM, and targeted these jobs at two different backup repositories. The backup jobs have created the following backup files:

- **Backup job 1** has created 2 restore points in **Backup repository 1**: full backup file on Sunday and incremental backup file on Tuesday.
- **Backup Job 2** has created 1 restore point in **Backup repository 2**: full backup file on Monday.

The replication job is configured to retrieve VM data from backups and scheduled to run daily. In this case, the replication job will retrieve VM data from backups in the following way:

1. On Sunday, the replication job will retrieve VM data from the full backup file in **Backup repository 1**.
2. On Monday, the replication job will retrieve VM data from the full backup file in **Backup repository 2**.
3. On Tuesday, the replication job will retrieve VM data from the incremental backup file in **Backup repository 1**.
In some situations, a new restore point in the backup repository may not be created by the time a replication job starts. In this case, Veeam Backup & Replication displays a warning notifying that the latest restore point has already been replicated. The replication job session finishes with the *Warning* status.

**NOTE:**

When you replicate a VM over a production network, Veeam Backup & Replication retrieves VM data as of the latest VM state. When you replicate a VM from backup, Veeam Backup & Replication retrieves VM data as of the point in time when the backup was created. The VM replica restore point has the same timestamp as a corresponding VM backup restore point, not the time when the replica job session is run.

**Replica Seeding**

If you replicate a VM to a remote disaster recovery (DR) site, you can use replica seeding. Replica seeding helps significantly minimize the amount of traffic going from the production site to the DR site over WAN or slow LAN links.

With replica seeding, you do not have to transfer all of VM data from the source host to the target host across the sites when you perform initial replication. Instead, you can use a VM backup created with Veeam Backup & Replication as a replica “seed”. When the replication job starts, Veeam Backup & Replication will use the seed to build a VM replica.

Replica seeding includes the following steps:

1. As a preparatory step for replica seeding, you need to create a backup of a VM that you plan to replicate.
2. The created backup should then be copied from the backup repository in the production site to the backup repository in the DR site. After the backup is copied to the backup repository in the DR site, you will need to perform rescan of this repository as described in the *Rescanning Backup Repositories* section.
3. When you create a replication job, you should point it to the backup repository in the DR site. During the first run of a replication job, Veeam Backup & Replication accesses the backup repository where the replica seed is located, and restores the VM from the backup. The restored VM is registered on the replication target host in the DR site. Files of the restored VM are placed to the location you specify as the replica destination storage.
   
   Virtual disks of a replica are restored from the backup as dynamically expanding.

4. Veeam Backup & Replication synchronizes the restored VM with the latest state of the original VM. After successful synchronization, in the *Home* view of Veeam Backup & Replication, under *Replicas* node you will see a VM replica with two restore points. One point will contain the state of the VM from the backup file; the other point will contain the latest state of the original VM you want to replicate.
5. During all subsequent runs of the replication job, Veeam Backup & Replication transfers only incremental changes in a regular manner.

Replica seeding dramatically reduces traffic sent over WAN or slow connections because Veeam Backup & Replication does not send the full contents of the VM image. Instead, it transmits only differential data blocks.

**TIP:**

If you add new VMs to an already existing replication job, you can enable replica seeding settings for these VMs. In this case, the newly added VMs will be seeded from the selected backups at the next pass of the replication job. VMs that have already been processed by the job by the time you add new VMs will be processed in a regular manner.

**Replica Mapping**

If a replica for the VM that you plan to replicate already exists in the disaster recovery (DR) site, you can map the original VM in the production site to this VM. For example, you can map the original VM to a VM replica created with another replication job or restore a VM from the backup on the target host in the DR site and map the original VM to it. You can also use replica mapping if you need to reconfigure or recreate replication jobs, for example, split one replication job into several jobs.

Replication to a mapped VM is performed in the following way:

1. During the first run, the replication job calculates the differences between the original and mapped VM. Instead of copying and transferring all data of the original VM, the replication job transfers only incremental changes to synchronize the state of the mapped VM with the state of the original VM.

After successful synchronization, in the **Home** view of Veeam Backup & Replication, under **Replicas** node you will see a VM replica with 2 restore points:

   - One restore point will contain the latest state of the mapped VM.
   - The other restore point will contain the latest state of the original VM on the source host.
2. All subsequent runs of the replication job will be performed in a regular manner:
Veeam Backup & Replication will transfer only incremental changes to the target host.

Replica Mapping for VMs with Checkpoints

[For legacy replicas] The legacy VM replica to which you map the original VM must not have any checkpoints. Otherwise, replica mapping will not work.

[For snapshot replicas] If a snapshot replica to which you map the original VM has any checkpoints that were created by Veeam Backup & Replication, for example, with a replication job run on another backup server, Veeam Backup & Replication will identify these checkpoints as valid restore points for the VM replica and, additionally, will create one new restore point during the first run of the replication job. For example, if a VM replica on the target host has 3 checkpoints created with Veeam Backup & Replication, after the first run of the replication job, you will have a VM replica with 4 valid restore points.

If a snapshot replica to which you map the original VM has any checkpoints that were created outside Veeam Backup & Replication, for example, triggered manually by the user, Veeam Backup & Replication will not identify them as valid restore points. During the first run of the replication job, Veeam Backup & Replication will create 2 new restore points as described in the procedure above.

For example, if a VM replica has 2 checkpoints created in Hyper-V Manager, after the first run of the replication job, you will have a VM replica with 2 restore points. 2 checkpoints created in Hyper-V Manager will remain in the checkpoint chain. However, you will not be able to see these checkpoints in the Veeam Backup & Replication console and will not be able to use these checkpoints for failover and failback operations.
Network Mapping and Re-IP

If you use different network and IP schemes in production and disaster recovery (DR) sites, in the common case you would need to change the network configuration of a VM replica before you fail over to it. To eliminate the need for manual replica reconfiguration and ensure minimum failover downtime, Veeam Backup & Replication offers possibilities of network mapping and automatic IP address transformation.

Network Mapping

By default, a replicated VM uses the same network configuration as the original VM. If the network in the DR site does not match the production network, you can create a network mapping table for the replication job. The table maps source networks to target networks.

During every job run, Veeam Backup & Replication checks the network configuration of the original VM against the mapping table. If the original VM network matches a source network in the table, Veeam Backup & Replication updates the replica configuration file to replace the source network with the target one. The VM replica is then re-registered (for legacy VM replicas, not snapshot VM replicas). Thus, network settings of a VM replica are always kept up to date with the DR site requirements. In case you choose to fail over to the VM replica, it will be connected to the correct network.

**NOTE:**
If you use VLAN IDs for networking, you can specify VLAN IDs settings for source and target networks.

Re-IP Rules

For Microsoft VMs, Veeam Backup & Replication also automates reconfiguration of VM IP addresses. If the IP addressing scheme in the production site differs from the DR site scheme, you can create a number of Re-IP rules for the replication job.

When you fail over to the replica, Veeam Backup & Replication checks if any of the specified Re-IP rules apply to the replica. If a rule applies, Veeam Backup & Replication mounts VM disks of the replica to the backup server and changes its IP address configuration via the Microsoft Windows registry. The whole operation takes less than a second. If failover is undone for any reason or if you fail back to the original location, replica IP address is changed back to the pre-failover state.

**IMPORTANT!**
- Replica Re-IP works only if you perform replica failover using Veeam Backup & Replication. If you power on a VM replica in some other way, for example, manually using Hyper-V Manager, Re-IP rules will not be applied to it.
- The backup server OS must support mounting of the system disk of processed machine.
Creating Replication Jobs

To create VM replicas, you must configure a replication job. The replication job defines how, where and when to replicate VM data. One job can be used to process one VM or more VMs.

You can configure a job and start it immediately or save the job to start it later. Jobs can be started manually or scheduled to run automatically at specific time.

Before you create a replication job, check prerequisites. Then use the New Replication Job wizard to configure a replication job.
Before You Begin

Before you create a replication job, check the following prerequisites:

- Backup infrastructure components that will take part in the replication process must be added to the backup infrastructure and properly configured. These include source and target Microsoft Hyper-V hosts and backup repository for storing replica metadata. If you want to perform backup in the off-host backup mode, the off-host backup proxy must also be added and properly configured.

  The backup server must be able to resolve short names and connect to source and target virtualization hosts.

- The target volume must have enough free space to store disks of replicated VMs. To receive alerts about low space on the target volume, configure global notification settings. For more information, see Specify Other Notification Settings.

- If you plan to replicate VMs via WAN accelerators, source and target WAN accelerators must be added to the backup infrastructure and properly configured. For more information, see Adding WAN Accelerators.

- If you plan to replicate VMs via WAN accelerators, it is recommended that you pre-populate the global cache on the target WAN accelerator before you start the replication job. Global cache population helps reduce the amount of traffic transferred over WAN. For more information, see Populating Global Cache.

- If you plan to replicate VMs from the backup, the backup job that you plan to use as the source must be configured beforehand. For more information, see Replica from Backup.

- If you plan to use pre-job and post-job scripts and/or pre-freeze and post-thaw scripts, you must create scripts before you configure the replication job. Veeam Backup & Replication supports script files in the following formats: EXE, BAT, CMD, JS, VBS, WSF, PS1, SH.

- Host and target Microsoft Hyper-V hosts that you select for the replication process must be compatible. For more information, see Supported Platforms for VM Replica Types.

- You must check limitations for replication. For more information, see About Replication.
Step 1. Launch New Replication Job Wizard

To run the New Replication Job wizard, do one of the following:

- On the Home tab, click Replication Job > Virtual machine > Microsoft Hyper-V.

- Open the Home view, in the inventory pane right-click the Jobs node and select Replication > Virtual machine > Microsoft Hyper-V.

- Open the Inventory view. In the working area, select the VMs, click Add to Replication on the ribbon and select New job or right-click the VMs and select Add to replication job > New job. In this case, the selected VMs will be automatically added to the replication job. You can add other VMs to the job when passing through the wizard steps.

- You can quickly include the VMs to already existing jobs. To do this, open the Inventory view. In the working area, select the VMs and click Add to Replication > name of the job on the ribbon or right-click VMs and select Add to replication job > name of the job.
Step 2. Specify Job Name and Description

At the **Job** step of the wizard, specify a job name and description, and configure advanced settings for the replication job.

1. In the **Name** field, enter a name for the replication job you create.

2. In the **Description** field, provide a description for future reference. The default description contains information about the user who created a job, date and time when the job was created.

3. If you plan to replicate VMs to a disaster recovery (DR) site, you can use a number of advanced settings for the job:
   - Select the **Replica seeding (for low bandwidth DR sites)** check box to enable the **Seeding step** in the wizard. Replica seeding can be used if you plan to replicate VMs to a remote site and want to reduce the amount of traffic sent over the network during the first run of the replication job.
   - Select the **Network remapping (for DR sites with different virtual networks)** check box to enable the **Network step** in the wizard. If the network in the DR site does not match the production network, you can resolve this mismatch by creating a network mapping table.
   - Select the **Replica re-IP (for DR sites with different IP addressing scheme)** check box to enable the **Re-IP step** in the wizard. Re-IP possibilities can be used to automate reconfiguration of replica IP addresses for Microsoft Windows VMs if IP schemes in the DR and production sites do not match.
Step 3. Select VMs to Replicate

At the **Virtual Machines** step of the wizard, select VMs and VM containers (Hyper-V hosts, clusters, SCVMM and volumes) that you want to replicate.

Jobs with VM containers are dynamic in their nature. If a new VM is added to the container in the virtual infrastructure after the replication job is created, Veeam Backup & Replication will automatically update the job settings to include the added VM.

1. Click **Add**.
2. Use the toolbar at the top right corner of the window to switch between views: **Hosts and Clusters**, **Hosts and Volumes**, **VMs and Tags**, **VM Groups**.
   Mind that VMs can be arranged in VM groups only on Microsoft Hyper-V hosts version 2016 or later.
3. Select the object and click **Add**.

To quickly find the necessary object, you can use the search field at the bottom of the **Add Objects** window.

1. Click the button to the left of the search field and select the necessary type of object to search for: **Everything**, **Folder**, **Host Group**, **SCVMM**, **Cluster**, **Host** or **Virtual machine**.
2. Enter the object name or a part of it in the search field.
3. Click the **Start search** button on the right or press [Enter] on the keyboard.

The initial size of VMs and VM containers added to the replication job is displayed in the **Size** column in the list. The total size of objects is displayed in the **Total size** field. Use the **Recalculate** button to refresh the total size value after you add a new object to the job.
Step 4. Specify Data Source

You can select a data source from which VM data must be read.

1. At the **Virtual Machines** step of the wizard, click **Source** on the right of the VMs list.
2. In the displayed window, select one of the following options:
   - **From production storage**. In this case, Veeam Backup & Replication will retrieve VM data from volumes connected to the source Microsoft Hyper-V host.
   - **From backup files**. In this case, Veeam Backup & Replication will read VM data from a backup chain already existing in the backup repository. This option can be used in the replica from backup scenario. For more information, see **Replica from Backup**.
Step 5. Exclude Objects from Replication Job

After you have added VMs and VM containers to the job, you can specify which objects you want to exclude from replicas. You can exclude the following types of objects:

- VMs from VM containers
- Specific VM disks

To exclude VMs from a VM container:

1. At the Virtual Machines step of the wizard, click Exclusions.
2. Click the VMs tab.
3. Click Add.
4. Use the toolbar at the top right corner of the window to switch between views: Hosts and Clusters, Hosts and Volumes, VMs and Tags, VM Groups.
   
   Mind that VMs can be arranged in VM groups only on Microsoft Hyper-V hosts version 2016 or later.
5. Select the object and click Add. Use the Show full hierarchy check box to display the hierarchy of all Hyper-V Servers added to Veeam Backup & Replication.
6. Click OK.

To exclude VM disks:

1. At the Virtual Machines step of the wizard, click Exclusions.
2. Click the Disks tab.
3. Select the VM in the list and click **Edit**. If you want to exclude disks of a VM added as a part of the container, click **Add** to include the VM in the list as a standalone object.

4. Choose disks that you want to replicate. You can choose to process all disks, 0:0 disks (typically, the system disks) or add to the list custom IDE and SCSI disks.
Step 6. Define VM Replication Order

You can define the order in which the replication job must process VMs. Setting VM order can be helpful, for example, if you have added some mission-critical VMs to the job and want the job to process them first. You can set these VMs first in list to ensure that their processing fits the backup window.

VMs inside a VM container are processed at random. To ensure that VMs are processed in the defined order, you must add them as standalone VMs, not as a part of the VM container.

To define VM replication order:

1. At the Virtual Machines step of the wizard, select a VM or VM container.
2. Use the Up and Down buttons on the right to move the VM or VM container up or down in the list.

NOTE:

VMs may be processed in a different order. For example, if backup infrastructure resources for a VM that is higher on the priority list are not available, and resources for a VM that is lower on the list are available, Veeam Backup & Replication will start processing the VM that is lower on the list first.

If you enable the Allow processing of multiple VMs with a single volume snapshot option in the job settings, VMs may also be processed in a different order. This option unites VMs added to the job in several groups, and the defined VM order may be broken.
Step 7. Specify Replica Destination

At the Destination step of the wizard, select a destination for created replicas.

1. In the Host or cluster section, specify a target host or cluster where replicas will be registered. Click Choose and select a host or cluster in the virtual infrastructure hierarchy. Assigning a cluster as a target ensures more sustainable replication process. The replication job will be performed until there is at least one available host in the cluster.

   To facilitate selection, use the search field at the bottom of the window. Click the button on the left of the field to select the type of object that you want to search for (SCVMM, Cluster or Host), enter object’s name or a part of it and click the Start search button on the right or press [Enter] on the keyboard.

2. In the Path section, specify a path to the folder where VM replica files must be stored. By default, Veeam Backup & Replication stores VM replica files to the C:\Replicas folder (if you have selected a Microsoft Hyper-V host as a target) or on a CSV with the maximum amount of free space (if you have selected a Microsoft Hyper-V cluster as a target).

   If all or the majority of replicas will be stored in the same location, click Choose and point to the target folder. To create a dedicated folder for storing VM replicas, use the New folder button at the bottom of the window.

   If you want to place replicas to different folders:
   
   a. Click the Pick path for selected virtual disks link.

   b. Click Add VM on the right and select VMs that must be stored to different folders.

   c. In the Files location list, select the added VM and click Path at the bottom of the window. You can select an existing folder or create a new one in the list.

You can choose a Microsoft SMB3 shared folder as a destination for VM replicas. To do this:

   a. Click Choose next to the Path field.

   b. In the search field at the bottom of the Select Folder window, type a path to the Microsoft SMB3 shared folder. The path must be specified in the UNC format, for example: |\172.16.11.38\Share01.

   The host or cluster you specify in the Host or cluster field must have access to the Microsoft SMB3 shared folder. If you are using Microsoft SCVMM 2012 or Microsoft SCVMM 2012 R2, the server hosting the Microsoft SMB3 share must be registered in Microsoft SCVMM as a storage device. For more information, see Microsoft Docs.
You can choose to store replica configuration files and disk files in different locations. To do this, add a VM to the **Files location** list, expand it and select the required type of files. Click **Path** at the bottom of the window and choose the destination for the selected type of files.
Step 8. Create Network Map Table

The **Network** step of the wizard is available if you have selected the **Network remapping** option at the **Job step** of the wizard. You can use this step to configure network mapping settings for the VM replicas.

Network mapping can be helpful if you use different networks in the production site and disaster recovery (DR) site. In this situation, you can configure a table that maps production networks to networks in the DR site. During every replication job session, Veeam Backup & Replication will check the network mapping table and update VM replica configuration file to replace the production network with the specified network in the DR site. As a result, when you perform failover, the VM replica will be connected to the necessary networks in the DR site, and you will not have to re-configure network settings for the VM replica manually.

To configure a network mapping table:

1. Click **Add**.
2. Click **Browse** next to the **Source network** field and select the production network to which VMs added to the job are connected.
3. Click **Browse** next to the **Target network** field and select the network in the DR site to which VM replicas must be connected.
4. If you use VLAN IDs for networking, select the **VLAN ID** check box and specify VLAN IDs of the source and target networks.

**NOTE:**

When the **Enable VLAN** check box is selected:

- In the **Source network** section, VLAN ID is 0 refers to any VLAN including the disabled ones.
- In the **Target network** section, VLAN ID is 0 means VLAN is disabled.
5. Repeat steps 1-4 for all networks to which VM replicas must be connected.
Step 9. Configure Re-IP Rules

The Re-IP step of the wizard is available if you have selected the Replica re-IP option at the Job step of the wizard. You can use this step to configure Re-IP rules for Microsoft Windows VMs.

Re-IP rules can be helpful if the IP addressing scheme in the production site differs from the IP addressing scheme in the disaster recovery (DR) site. In this situation, you can configure a number of re-IP rules for the replication job. When you perform failover, Veeam Backup & Replication will check if configured Re-IP rules apply for the VM replica. If a Re-IP rule applies, the VM replica will get a new IP address according to the new network mask, and you will be able to reach this VM replica in the DR site.

To configure a Re-IP rule:

1. Click Add.
2. In the Source VM section, describe an IP numbering scheme adopted in source site. To facilitate configuration, Veeam Backup & Replication detects an IP address and subnet mask for the backup server and pre-populates values in the Source VM section.
3. In the Target VM section, describe an IP numbering scheme adopted in the DR site. Specify an IP address, subnet mask and default gateway that will be used for VM replicas. If necessary, define the DNS and WINS server addresses.
4. In the Description field, specify a brief outline of the rule or any related comments.
NOTE:
You can use the asterisk character (*) to specify a range of IP addresses, for example: 172.16.17.*. Do not use 0 to specify a range of IP addresses. In Veeam Backup & Replication, value 172.16.17.0 means a regular IP address 172.16.17.0, not an IP address range.
Step 10. Specify Replication Job Settings

At the **Job Settings** step of the wizard, define replication job settings.

1. From the **Repository for replica metadata** list, select a backup repository that is located in the source site. The backup repository stores metadata for VM replicas — checksums of read data blocks required to streamline incremental sessions of the replication job.

   This setting must be specified only for snapshot replicas. Legacy replicas do not use a backup repository for storing metadata. For more information, see [VM Replica Types](#).

2. In the **Replica name suffix** field, enter a suffix for the name of VM replicas. To register a VM replica on the target host, Veeam Backup & Replication appends the specified suffix to the name of the source VMs.

3. In the **Restore points to keep** field, specify the number of restore points that must be maintained by the replication job. If this number is exceeded, the earliest restore point will be removed.

   Due to Microsoft Hyper-V restrictions on the number of VM snapshots, the maximum number of restore points for snapshot replicas is limited to 47.

   When you specify the retention policy settings for the replication job, consider available space on the target volume. A great number of restore points (snapshots) may fill the target volume.

**IMPORTANT!**

- You cannot store VM replica metadata on deduplicating storage appliances. During replication jobs, Veeam Backup & Replication frequently reads and writes small portions of metadata from/to the backup repository. Frequent access to metadata causes low performance of deduplicating storage appliances, which may result in low performance of replication jobs.

- You cannot store replica metadata in a scale-out backup repository.
Step 11. Specify Advanced Replica Settings

At the **Job settings** step of the wizard, you can specify the following settings for the replication job:

- Traffic settings
- Notifications settings
- Hyper-V settings
- Script settings

**TIP:**
After you specify necessary settings for the replication job, you can save them as default settings. To do this, click **Save as Default** at the bottom left corner of the Advanced Settings window. When you create a new replication job, Veeam Backup & Replication will automatically apply the default settings to the new job.

**Traffic Settings**

To specify traffic settings for the replication job:

1. At the Job Settings step of the wizard, click **Advanced**.
2. Click the Traffic tab.
3. By default, Veeam Backup & Replication checks the NTFS MFT file on VMs with Microsoft Windows OS to identify data blocks of the hiberfil.sys file (file used for the hibernate mode) and pagefile.sys file (swap file), and excludes these data blocks from processing. The swap file is dynamic in nature and changes intensively between replication job sessions, even if the VM itself does not change much. Processing of service files reduces the job performance and increases the size of incremental data.
   
   If you want to include data blocks of the hiberfil.sys file and pagefile.sys file to the replica, clear the Exclude swap file blocks check box. For more information, see Swap Files.

4. By default, Veeam Backup & Replication does not copy deleted file blocks ("dirty" blocks on the VM guest OS) to the target location. This option lets you reduce the size of the VM replica and increase the job performance. If you want to include dirty data blocks to the VM replica, clear the Exclude deleted file blocks check box.
   
   For more information, see Deleted File Blocks.

5. From the Compression level list, select a compression level for the created VM replica: None, Dedupe-friendly, Optimal, High or Extreme.

6. In the Storage optimization section, select what type of backup target you plan to use: Local target (large blocks), Local target, LAN target or WAN target. Depending on the chosen storage type, Veeam Backup & Replication will use data blocks of different size to optimize the size of backup files and job performance.

   When selecting the data block size, consider the following aspects:

   - When reading the VM image, Veeam Backup & Replication "splits" the VM image into blocks of the selected size. The more data blocks there are, the more time is required to process the VM image.
Veeam Backup & Replication writes information about every data block to the VM replica metadata stored in the backup repository. The more data blocks there are, the more metadata is written to the backup repository.

During incremental job runs, Veeam Backup & Replication uses CBT to define changed data blocks in the VM. The larger is the size of the found changed data block, the greater amount of data needs to be transferred to the target site.

For more information, see Compression and Deduplication.

### Notification Settings

To specify notification settings for the replication job:

1. At the **Job Settings** step of the wizard, click **Advanced**.
2. Click the **Notifications** tab.
3. Select the **Send SNMP notifications for this job** check box if you want to receive SNMP traps when the job completes successfully. SNMP traps will be sent if you specify global SNMP settings in Veeam Backup & Replication and configure software on recipient's machine to receive SNMP traps. For more information, see Specifying SNMP Settings.
4. Select the **Send email notifications to the following recipients** check box if you want to receive notifications by email in case of job failure or success. In the field below, specify a recipient’s email address. You can enter several addresses separated by a semicolon.

Email notifications will be sent if you configure general email notification settings in Veeam Backup & Replication. For more information, see Specifying Email Notification Settings.
5. You can choose to use global notification settings or specify custom notification settings.
   
   o To receive a typical notification for the job, select **Use global notification settings**. In this case, Veeam Backup & Replication will apply to the job global email notification settings specified for the backup server. For more information, see Specifying Email Notification Settings.
   
   o To configure a custom notification for a job, select **Use custom notification settings specified below**. You can specify the following notification settings:
      
      i. In the **Subject** field, specify a notification subject. You can use the following variables in the subject: `%Time%` (completion time), `%JobName%`, `%JobResult%`, `%VmCount%` (number of VMs in the job) and `%Issues%` (number of VMs in the job that have been processed with the Warning or Failed status).
      
      ii. Select the **Notify on success**, **Notify on warning** and/or **Notify on error** check boxes to receive email notification if the job completes successfully, fails or completes with a warning.
      
      iii. Select the **Suppress notifications until the last retry** check box to receive a notification about the final job status. If you do not select this option, Veeam Backup & Replication will send one notification per every job retry.

Hyper-V Settings

To specify Hyper-V settings for the replication job:

1. At the **Job Settings** step of the wizard, click **Advanced**.
2. Click the **Hyper-V** tab.
3. In the **Guest quiescence** section, specify which backup method must be used to prepare the VM guest OS for replication.
Typically, it is recommended that you use Veeam’s application-aware processing that leverages the Microsoft VSS framework to prepare the VM guest OS for replication. If application-aware processing cannot be used for some reason, select the **Enable Hyper-V guest quiescence** check box. Veeam Backup & Replication will select the backup method in the following way:

- If a VM meets all requirements for online backup, Veeam Backup & Replication will use the online backup method.
- If a VM does not meet requirements for online backup, Veeam Backup & Replication will use the offline backup method. Note that during offline backup a VM is suspended for a short period of time.

The selected replication method applies to all VMs in the job. However, if you enable application-aware processing for VMs, the application-aware processing settings will have higher priority than the selected replication method.

**NOTE:**
Offline backup is not applicable to VMs registered on Microsoft Hyper-V Server 2016 and later.

4. If you do not want to suspend a VM, select the **Take crash consistent backup instead of suspending VM** check box. In this case, Veeam Backup & Replication will create a crash-consistent VM replica.

5. In the **Changed block tracking** section, specify if CBT must be used for VM replication. By default, this option is enabled. CBT dramatically reduces load on the production environment and time required to perform incremental replication.

6. If you have added several VMs to the job, select the **Allow processing of multiple VMs with a single volume snapshot** check box. This option helps reduce snapshot workload in the Microsoft Hyper-V environment. When the job starts, Veeam Backup & Replication will group VMs and trigger Microsoft Hyper-V to create one volume snapshot for a group of VMs, instead of creating a volume snapshot per each processed VM.

Veeam Backup & Replication can create a single volume snapshot for a group of VMs that meet the following requirements:

- VMs must be located on the same host.
- Volumes on which VM files reside must use the same VSS provider for snapshot creation.
- The number of VMs in the group is limited: for VSS software provider — 4 VMs, for VSS hardware provider — 8 VMs.
- Veeam Backup & Replication groups VMs based on the method of snapshot creation that is used for replication: transactionally consistent (VSS) or crash-consistent.

For example, you add to the job two VMs that are registered on the same host. \( VM1 \) resides on volume \( C:\ \) and \( VM2 \) resides on volume \( D:\ \). Both VMs use Microsoft Software Shadow Copy Provider. In this situation, Veeam Backup & Replication will create a single snapshot for these VMs.
NOTE:
The **Allow processing of multiple VMs with a single volume** snapshot option is not applicable to VMs registered on Microsoft Hyper-V Server 2016 and later that are processed in the onhost backup mode.

Script Settings
To specify script settings for the replication job:

1. At the **Job Settings** step of the wizard, click **Advanced**.
2. Click the **Scripts** tab.
3. If you want to execute custom scripts before and/or after the replication job, select the **Run the following script before the job** and **Run the following script after the job** check boxes and click **Browse** to choose executable files from a local folder on the backup server. The scripts are executed on the backup server.

You can select to execute pre- and post-replication actions after a number of job sessions or on specific week days.

   o If you select the **Run scripts every... backup session** option, specify the number of the replication job sessions after which scripts must be executed.

   o If you select the **Run scripts on selected days only** option, click **Days** and specify week days on which scripts must be executed.
NOTE

Mind the following:

- Custom scripts that you define in the advanced job settings relate to the backup job itself, not the VM quiescence process. To add pre-freeze and post-thaw scripts for VM image quiescence, use the Guest Processing step of the wizard.
- If you select the Run scripts on the selected days only option, Veeam Backup & Replication executes scripts only once on each selected day — when the job runs for the first time. During subsequent job runs, scripts are not executed.
- To run the script, Veeam Backup & Replication uses the Service Account under which the Veeam Backup Service is running.
Step 12. Specify Data Transfer Settings

At the **Data Transfer** step of the wizard, select backup infrastructure components that must be used for the replication process and choose a path for VM data transfer.

1. From the **Source proxy** list, select the backup proxy that must be used to transfer VM data from source to target. Click **Choose** to select the mode and backup proxies for the replication job.
   
   - If you choose the **On-host backup** mode, during replication the source Microsoft Hyper-V host will perform the roles of the source host and backup proxy. In this mode, the Veeam Data Mover runs directly on the source host, which helps streamline data retrieval operations but puts additional load on the host.
     
     In case the job processes a VM whose disks are located on the CSV and Microsoft CSV Software Shadow Copy Provider is used for snapshot creating, the Microsoft Hyper-V host owning the CSV will be used as the on-host backup proxy.
   
   - If you choose the **Off-host backup** mode, the Veeam Data Mover will be started on a dedicated off-host backup proxy. In this mode, all data processing operations are moved to the off-host backup proxy from the source host.
     
     By default, if the off-host backup mode is selected for the job but there are no off-host backup proxies available when the job starts, Veeam Backup & Replication will automatically fail over to the on-host backup mode. To disable failover, clear the **Failover to on-host backup mode if no suitable off-host proxies available** check box. If you disable this option, you must check off-host backup proxies in the backup infrastructure before the job starts. The job will not be able to start if off-host backup proxies are not available or not configured properly.
     
     To perform off-host backup, Veeam Backup & Replication analyzes the current load on off-host backup proxies and proxy settings (such as the number of allowed tasks, connectivity to the source volumes) to select the most appropriate off-host backup proxy for the job automatically. You can also explicitly point out what off-host backup proxies the job must use. To do this, select the **Use the following backup proxy servers only** check box and choose one or more off-host backup proxies from the list. It is recommended that you select at least two off-host backup proxies to ensure that the replication job starts if one of the proxies fails or loses its connectivity to the source volumes.

2. Select a path for VM data transfer:
   
   - To transport VM data directly from the on-host/off-host backup proxy to the target volume, select **Direct**.
   
   - To transport VM data via WAN accelerators, select **Through built-in WAN accelerators**. From the **Source WAN accelerator** list, select the WAN accelerator configured in the source site. From the **Target WAN accelerator** list, select the WAN accelerator configured in the target site.

   For more information, see [Replication Data Paths](#).

   You should not assign one source WAN accelerator to several replication jobs that you plan to run simultaneously. The source WAN accelerator requires a lot of CPU and RAM resources, and does not process multiple replication tasks in parallel. As an alternative, you can create one replication job for all VMs you plan to process over one source WAN accelerator.
The target WAN accelerator, however, can be assigned to several replication jobs. For more information, see Adding WAN Accelerators.
Step 13. Define Seeding and Mapping Settings

The Seeding step is available if you have selected the Replica seeding option at the Job step of the wizard. You can use this step to configure replica seeding and mapping for the replication job.

Configuring Replica Seeding

If you plan to replicate to a remote disaster recovery (DR) site over WAN or low-bandwidth network, you can use replica seeding. Replica seeding helps reduce the amount of VM data transferred over the network.

Replica seeding can be used if you have a backup for the replicated VM in the backup repository located in the DR site. In this case, you can point the replication copy job to the backup repository where the backup file resides. During the first session of the replication job, Veeam Backup & Replication will use this backup file as a "seed". Veeam Backup & Replication will restore the VM image from the backup file and register the VM replica on the target host. After that, Veeam Backup & Replication will synchronize the VM replica with the source VM. All subsequent incremental replication runs will be performed in the regular course.

Before you start a replication job that uses replica seeding, you must perform a number of preparatory tasks:

1. Create a backup (seed) of the VM you plan to replicate. To do this, configure a backup job that points to an onsite backup repository. Run the job to perform a full backup.
   
   If you have previously created a backup containing all necessary VMs, there is no need to configure and run a new backup job.
   
   For seeding, you can use any existing backup created with Veeam Backup & Replication. The backup must include VBK and VBM files. If you have a full backup and a chain of forward increments, you can use VIB files together with the VBK and VBM files. In this case, Veeam Backup & Replication will restore VMs from the seed to the latest available restore point.

2. Copy the backup from the backup repository in the production site to a backup repository in the DR site. If you do not have a backup repository in the DR site, you will need to create one.
   
   You can move the backup using a file copy job or any other appropriate method, for example, copy the backup to a removable storage device, ship the device to the DR site and copy backups to the backup repository in the DR site.

3. After the backup is copied to the backup repository in the DR site, perform rescan of this backup repository. Otherwise, Veeam Backup & Replication will not be able to detect the copied backup.

When the preliminary steps are completed, you can configure replica seeding settings for the job.

1. In the Initial seeding section, select the Get seed from the following backup repository check box.

2. From the list of repositories, select the backup repository in the DR site to which the seed (the full backup) has been copied.

When you start the replication job, Veeam Backup & Replication will attempt to restore all VMs included in the job from the seed that you have specified. If a VM is not found in the seed, the VM will be skipped from replication.
**IMPORTANT!**

You cannot use a backup located in the scale-out backup repository as a seed for a replication job.

---

**Configuring Replica Mapping**

If a replica for the VM you plan to replicate already exists on the target host in the DR site, you can use replica mapping. Replica mapping helps reduce the amount of VM data transferred over the network.

To use replica mapping, you must point the replication job to a VM replica in the DR site. During the first session of the replication job, Veeam Backup & Replication will calculate the difference between the source VM and VM replica and copy necessary data blocks to synchronize the VM replica to the latest state of the source VM. All subsequent incremental replication runs will be performed in the regular course.

**TIP:**

If there is no existing VM replica in the DR site, you can restore a VM from the backup and map it to the original VM.

To set up replica mapping:

1. Select the **Map replicas to existing VMs** check box.

2. Click **Detect**. Veeam Backup & Replication will scan the destination location to detect existing VM replicas. If any matches are found, Veeam Backup & Replication will populate the mapping table.

   If Veeam Backup & Replication does not find a match, you can map a VM to its VM replica manually. To do this, select a production VM from the list, click **Edit** and choose an existing VM replica. To facilitate selection, use the search field at the bottom of the window.

To break a mapping association, select the VM in the list and click **Remove**.
IMPORANT!

The mapping list does not display VMs added to the list of exclusions. For more information, see Step 5. Exclude Objects from Replication Job.

Configuring Replica Seeding and Replica Mapping

You configure both replica seeding and replica mapping within the same replication job. For example, if a job includes 2 VMs, you can use seeding for one VM and map the other VM to an existing VM replica.

If replica seeding is enabled in the job settings, all VMs in the job must be covered with seeding or mapping. If a VM is neither available in the seed, nor mapped to an existing VM replica, it will be skipped from processing. And, on the contrary, if the same VM is available in the seed and mapped to an existing replica, replication will be performed using replica mapping as mapping has precedence over seeding.
Step 14. Specify Guest Processing Settings

At the Guest Processing step of the wizard, you can enable the following settings for VM guest OS processing:

- Application-aware processing
- Transaction log handling for Microsoft SQL Server
- Transaction log handling for Oracle
- VM guest OS file exclusion
- Use of pre-freeze and post-thaw scripts

To coordinate guest processing activities, Veeam Backup & Replication deploys a runtime process on the VM guest OS. The process runs only during guest processing and is stopped immediately after the processing is finished (depending on the selected option, during the replication job session or after the replication job completes).

You must specify a user account that will be used to connect to the VM guest OS and deploy the runtime process:

1. From the Guest OS credentials list, select a user account with local Administrator privileges on the VM guest OS. If you have not set up credentials beforehand, click the Manage accounts link or click Add on the right to add credentials. For more information, see Guest Processing.

2. By default, Veeam Backup & Replication uses the same credentials for all VMs in the job. If some VM requires a different user account, click Credentials and enter custom credentials for the VM.

3. If you have added Microsoft Windows VMs to the job, specify which guest interaction proxy Veeam Backup & Replication can use to deploy the runtime process on the VM guest OS. On the right of the Guest interaction proxy field, click Choose.
   - Leave Automatic selection to let Veeam Backup & Replication automatically select the guest interaction proxy.
   - Select Use the selected guest interaction proxy servers only to explicitly define which servers will perform the guest interaction proxy role. The list of servers contains Microsoft Windows servers added to the backup infrastructure.

To check if Veeam Backup & Replication can communicate with VMs added to the job and deploy the runtime process on their guest OSes, click Test Now. Veeam Backup & Replication will use the specified credentials to connect to all VMs in the list.
NOTE:
The guest interaction proxy functionality is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.

Application-Aware Processing
If you add to the replication job VMs running VSS-aware applications, you can enable application-aware processing to create transactionally consistent replicas. The transactionally consistent replica guarantees proper recovery of applications on VMs without data loss.

To enable application-aware processing:

1. Select the **Enable application-aware processing** check box.
2. Click **Applications**.
3. In the displayed list, select the VM and click **Edit**.
   
   To define custom settings for a VM added as a part of the VM container, you must include the VM in the list as a standalone object. To do this, click Add and choose a VM whose settings you want to customize. Then select the VM in the list and define the necessary settings.
4. On the **General** tab, in the **Applications** section specify the VSS behavior scenario:
   
   - Select **Require successful processing** if you want Veeam Backup & Replication to stop the replication process if any VSS errors occur.
   - Select **Try application processing, but ignore failures** if you want to continue the replication process even if VSS errors occur. This option is recommended to guarantee completion of the job. The created VM replica image will not be transactionally consistent but crash consistent.
5. [For Microsoft Exchange, Microsoft SQL and Oracle VMs] In the Transaction logs section, specify if Veeam Backup & Replication must process transaction logs or copy-only VM replicas must be created.
   a. Select **Process transaction logs with this job** if you want Veeam Backup & Replication to process transaction logs.

   [For Microsoft Exchange VMs] With this option selected, the runtime process running on the VM guest OS will wait for replication to complete successfully and then trigger truncation of transaction logs. If the replication job fails, the logs will remain untouched on the VM guest OS until the next start of the runtime process.

   [For Microsoft SQL Server VMs and Oracle VMs] You will have to specify settings for transaction log handling on the SQL and Oracle tabs of the VM Processing Settings window. For more information, see Transaction Log Settings: Microsoft SQL and Transaction Log Settings: Oracle.

   b. Select **Perform copy only** if you use another backup tool to perform VM guest level backup or replication, and this tool maintains consistency of the database state. Veeam Backup & Replication will create a copy-only replica for the selected VM. The copy only replica preserves the chain of full/differential backup files and transaction logs on the VM. For more information, see Microsoft Docs.

Transaction Log Handling: Microsoft SQL Server

If you replicate a Microsoft SQL VM, you can specify how Veeam Backup & Replication must process transaction logs:

1. At the **Guest Processing** step of the wizard, select the **Enable application-aware processing** check box.
2. Click **Applications**.
3. In the displayed list, select the Microsoft SQL Server VM and click **Edit**.
4. In the **Transaction logs** section, select **Process transaction logs with this job**.

5. In the **VM Processing Settings** window, click the **SQL** tab.

6. Specify how transaction logs must be processed:
   - Select **Truncate logs** if you want Veeam Backup & Replication to trigger truncation of transaction logs only after the job completes successfully. In this case, the runtime process will wait for VM replication to complete and then trigger truncation of transaction logs. If the replication job fails, the logs will remain untouched on the VM guest OS until the next start of the runtime process.
   - Select **Do not truncate logs** if you do not want Veeam Backup & Replication to truncate logs at all. This option is recommended if you are using another backup tool to perform VM guest-level backup or replication, and this tool maintains consistency of the database state. In such scenario, Veeam Backup & Replication will not trigger transaction log truncation. After you fail over to the necessary restore point of the VM replica, you will be able to apply transaction logs to get the database system to the necessary point in time between replication job sessions.

## Transaction Log Handling: Oracle

If you replicate an Oracle VM, you can specify how Veeam Backup & Replication must process transaction logs:

1. At the **Guest Processing** step of the wizard, select the **Enable application-aware processing** check box.
2. Click **Applications**.
3. In the displayed list, select the Oracle VM and click **Edit**.
4. In the **Transaction logs** section, select **Process transaction logs with this job**.
5. In the **VM Processing Settings** window, click the **Oracle** tab.
6. In the Specify Oracle account with SYSDBA privileges section, specify a user account that Veeam Backup & Replication will use to connect to the Oracle database. The account must have SYSDBA rights on the Oracle database.

You can select Use guest credentials in the list of user accounts. In this case, Veeam Backup & Replication will use the account specified at the Guest Processing step of the wizard to access the VM guest OS and connect to the Oracle database.

7. In the Archived logs section, specify if Veeam Backup & Replication must truncate transaction logs on the Oracle VM:

   - Select Do not truncate archived logs if you want Veeam Backup & Replication to preserve archived logs on the VM guest OS. When the replication job completes, the runtime process will not truncate transaction logs. It is recommended that you select this option for databases for which the ARCHIVELOG mode is turned off. If the ARCHIVELOG mode is turned on, transaction logs on the VM guest OS may grow large and consume all disk space. In this case, the database administrator must take care of transaction logs himself.

   - Select Truncate logs older than <N> hours or Truncate logs over <N> GB if you want Veeam Backup & Replication to truncate archived logs that are older than <N> hours or larger than <N> GB. The runtime process running on the VM guest OS will wait for the replication job to complete successfully and then trigger transaction logs truncation via Oracle Call Interface (OCI). If the job does not manage to replicate the Oracle VM, the logs will remain untouched on the VM guest OS until the next start of the runtime process.

VM Guest OS File Exclusion

If you do not want to replicate specific files and folders on the VM guest OS Windows, you can exclude them from the VM replica.
To define what files and folders must be excluded:

1. At the Guest Processing step of the wizard, select the Enable application-aware processing check box.
2. Click Applications.
3. In the displayed list, select the VM and click Edit.

To define custom settings for a VM added as part of a VM container, you must include the VM in the list as a standalone object. To do this, click Add and choose a VM whose settings you want to customize. Then select the VM in the list and define the necessary settings.
4. Click the Exclusions tab and specify what files must be excluded from the VM replica:
   - Select Exclude the following files and folders to remove the individual files and folders from the VM replica.
   - Select Include only the following files and folders to leave only the specified files and folders in the VM replica.
5. Click Add and specify what files and folders you want to include or exclude. To form the list of exclusions or inclusions, you can use full paths to files and folders, environmental variables and file masks with the asterisk (*) and question mark (?) characters. For more information, see VM Guest OS Files.
6. Click OK.
7. Repeat steps 5-6 for every object that you want to exclude or include.
Pre-Freeze and Post-Thaw Scripts

If you plan to replicate VMs running applications that do not support VSS, you can instruct Veeam Backup & Replication to run custom pre-freeze and post-thaw scripts for these VMs. The pre-freeze script quiesces the VM file system and application data to bring the VM to a consistent state before Veeam Backup & Replication triggers a VM snapshot. After the VM snapshot is created, the post-thaw script brings the VM and applications to their initial state.

To specify pre-freeze and post-thaw scripts for the job:

1. At the Guest Processing step, click Applications.
2. In the displayed list, select the VM and click Edit.
3. Click the Scripts tab.
4. In the Script processing mode section, specify the scenario for scripts execution:
   - Select Require successful script execution if you want Veeam Backup & Replication to stop the replication process if the script fails.
   - Select Ignore script execution failures if you want to continue the replication process even if script errors occur.
   - Select Disable script execution if you do not want to run scripts for the VM.
5. In the Windows scripts section, specify paths to pre-freeze and post-thaw scripts for Microsoft Windows VMs. For the list of supported script formats, see Pre-Freeze and Post-Thaw Scripts.
6. In the Linux scripts section, specify paths to pre-freeze and/or post-thaw scripts for Linux VMs. For the list of supported script formats, see Pre-Freeze and Post-Thaw Scripts.

If you have added to the job a VM container with Microsoft Windows and Linux VMs, you can select to execute both Microsoft Windows and Linux scripts for the VM container. When the job starts, Veeam Backup & Replication will automatically determine what OS type is installed on the VM and apply corresponding scripts to quiesce this VM.
TIP:
Beside pre-freeze and post-thaw scripts for VM quiescence, you can instruct Veeam Backup & Replication to run custom scripts before the job starts and after the job completes. For more information, see Advanced Settings.
Step 15. Define Job Schedule

At the **Schedule** step of the wizard, select to run the replication job manually or schedule the job to run on a regular basis.

To define a job schedule:

1. Select the **Run the job automatically** check box. If this check box is not selected, you will have to start the job manually to perform VM replication.

2. Define scheduling settings for the job:
   - To run the job at specific time daily, on defined week days or with specific periodicity, select **Daily at this time**. Use the fields on the right to configure the necessary schedule.
   - To run the job once a month on specific days, select **Monthly at this time**. Use the fields on the right to configure the necessary schedule.

   **NOTE:**
   When you configure the job schedule, keep in mind possible date and time changes (for example, related to daylight saving time transition).

   - To run the job repeatedly throughout a day with a set time interval, select **Periodically every**. In the field on the right, select the necessary time unit: **Hours** or **Minutes**. Click **Schedule** and use the time table to define the permitted time window for the job. In the **Start time within an hour** field, specify the exact time when the job must start.

   A repeatedly run job is started by the following rules:
   - Veeam Backup & Replication always starts counting defined intervals from 12:00 AM. For example, if you configure to run a job with a 4-hour interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 PM and so on.
   - If you define permitted hours for the job, after the denied interval is over, Veeam Backup & Replication will immediately start the job and then run the job by the defined schedule.

   For example, you have configured a job to run with a 2-hour interval and defined permitted hours from 9:00 AM to 5:00 PM. According to the rules above, the job will first run at 9:00 AM, when the denied period is over. After that, the job will run at 10:00 AM, 12:00 PM, 2:00 PM and 4:00 PM.

   - To run the job continuously, select the **Periodically every** option and choose **Continuously** from the list on the right.

   - To chain jobs, use the **After this job** field. In the common practice, jobs start one after another: when job A finishes, job B starts and so on. If you want to create a chain of jobs, you must define the time schedule for the first job in the chain. For the rest of the jobs in the chain, select the **After this job option** and choose the preceding job from the list.

3. In the **Automatic retry** section, define whether Veeam Backup & Replication should attempt to run the job again if the job fails for some reason. During a job retry, Veeam Backup & Replication processes failed VMs only. Enter the number of attempts to run the job and define time spans between them. If you select continuous schedule for the job, Veeam Backup & Replication will retry the job for the defined number of times without any time intervals between the job sessions.
4. In the **Backup window** section, determine a time interval within which the job must be completed. The backup window prevents the job from overlapping with production hours and ensures it does not provide unwanted overhead on your production environment. To set up a backup window for the job:

   a. Select the **Terminate job if it exceeds allowed backup window** check box and click **Window**.

   b. In the **Time Periods** section, define the allowed hours and prohibited hours for VM replication. If the job exceeds the allowed window, it will be automatically terminated.

**NOTE:**

The **After this job** function will only start a job if the first job in the chain is started automatically by schedule. If the first job is started manually, jobs chained to it will not be started.
Step 16. Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of replication job configuration.

1. Review details of the replication job.
2. Select the **Run the job when I click Finish** check box if you want to start the job right after you finish working with the wizard.
3. Click **Finish** to close the wizard.
Managing Replicas

You can perform the following operations with replicas:

- View replica properties
- Rescanning Replicas
- Remove a replica from configuration
- Delete a replica from disks
Viewing Replica Properties

You can view summary information about created replicas. The summary information provides the following data:

- Available restore points
- Date of restore points creation
- Data size and replica status

To view summary information for replicas:

1. Open the Home view.
2. In the inventory pane, select Replicas.
3. In the working area, right-click the replica and select Properties.

![Replication Properties Oracle Replication](image)

<table>
<thead>
<tr>
<th>Replica</th>
<th>Date</th>
<th>Data Size</th>
<th>Restore Point Size</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>oracle02</td>
<td>1/9/2017 10:00 PM</td>
<td>4.0 MB</td>
<td>4.0 MB</td>
<td>OK</td>
</tr>
<tr>
<td>oracle02</td>
<td>1/9/2017 6:47 AM</td>
<td>4.0 MB</td>
<td>4.0 MB</td>
<td>OK</td>
</tr>
<tr>
<td>oracle02</td>
<td>12/30/2016 10:00 PM</td>
<td>0.1 GB</td>
<td>0.1 GB</td>
<td>OK</td>
</tr>
</tbody>
</table>
Rescanning Replicas

You may need to perform replica rescan in the following cases:

- After you delete restore points for one or more replicas.
- After you restore the configuration database, and the session results show that some hosts used to register replicas were unavailable during the session.

To check whether any errors occurred during the database restore session, open the Home view and select System in the inventory pane. In the working area, right-click the Configuration Database Resynchronize job and select Statistics.

During the rescan process, Veeam Backup & Replication gathers information on replicas that are currently available in backup repositories and updates the list of replicas in the configuration database.

To rescan replicas, do the following:

1. Open the Home view.
2. In the inventory pane, right-click the Replicas node and select Rescan Replicas.
Removing from Configuration

If you want to remove records about replicas from the Veeam Backup & Replication console and configuration database, you can use the Remove from configuration operation.

Replicated VMs remain on target hosts. If necessary, you can start them manually after the Remove from configuration operation is performed.

Mind the following:

- The Remove from configuration operation can be performed only for VM replicas in the Ready state. If the VM replica is in the Failover or Failback state, this option is disabled.

- When you perform the Remove from configuration operation for a VM that is replicated as a standalone object, Veeam Backup & Replication removes this VM from the initial replication job. When you perform the Remove from configuration operation for a VM that is replicated as part of a VM container, Veeam Backup & Replication adds this VM to the list of exclusions in the initial replication job. For more information, see Step 5. Exclude Objects from Replication Job.

To remove records about VM replicas from the Veeam Backup & Replication console and configuration database:

1. Open the Home view.
2. In the inventory pane, select Replicas.
3. In the working area, select the replica and click Remove from > Configuration on the ribbon. You can also right-click the replica and select Remove from configuration.
Deleting from Disk

If you want to delete records about replicas from the Veeam Backup & Replication console and configuration database and, additionally, delete replica files from the destination storage, you can use the **Delete from disk** operation.

Mind the following:

- Do not delete replica files from the destination storage manually. Use the **Delete from disk** option instead. If you delete replica files manually, subsequent replication job sessions will fail.

- The **Delete from disk** operation can be performed only for VM replicas in the *Ready* state. If the VM replica is in the *Failover* or *Failback* state, this option is disabled.

To delete replica files from disk:

1. Open the **Home** view.
2. In the inventory pane, select **Replicas**.
3. In the working area, select the VM replica and click **Remove from > Disk** on the ribbon. You can also right-click the VM replica and select **Delete from disk**.
Replica Failover and Failback

In case of software or hardware malfunction, you can quickly recover a corrupted VM by failing over to its replica. When you perform failover, a replicated VM takes over the role of the original VM. You can fail over to the latest state of a replica or to any of its good known restore points.

In Veeam Backup & Replication, failover is a temporary intermediate step that should be further finalized. Veeam Backup & Replication offers the following options for different disaster recovery scenarios:

- You can perform permanent failover to leave the workload on the target host and let the replica VM act as the original VM. Permanent failover is suitable if the source and target hosts are nearly equal in terms of resources and are located on the same HA site.

- You can perform failback to recover the original VM on the source host or in a new location. Failback is used in case you failed over to a disaster recovery (DR) site that is not intended for continuous operations and would like to move the operations back to the production site when the consequences of a disaster are eliminated.

Veeam Backup & Replication supports failover and failback operations for one VM and for several VMs. In case one or several hosts fail, you can use batch processing to restore operations with minimum downtime.
Replica Failover

Failover is a process of switching from the original VM on the source host to its VM replica on the target host.

During failover, Veeam Backup & Replication recovers a fully functional VM to the required restore point on the target host. As a result, you have a VM up and running within a couple of seconds, and your users can access services and applications they need with minimum disruption.

When you perform failover, the state of the original VM on the source host is not affected in any way. If you need to test the VM replica and its restore points for recoverability, you can perform failover while the original VM is running. After all necessary tests, you can undo failover and get back to the normal mode of operation.

**NOTE:**

If the original VM and VM replica are located in the same network and you plan to perform replica failover while the original VM is running, consider temporary disconnecting the original VM from the network to avoid IP addresses and/or machine names conflicts.

It is recommended that you always use Veeam Backup & Replication to perform failover operations. Avoid powering on a replica manually — this may disrupt further replication operations or cause loss of important data.

Veeam Backup & Replication performs the failover process for snapshot VM replicas and legacy VM replicas in different ways.

**Snapshot VM Replicas**

The failover operation for snapshot VM replicas is performed in the following way:

1. Veeam Backup & Replication rolls back the VM replica to the required restore point. To do this, Veeam Backup & Replication applies the necessary snapshot from the replica chain to the VM replica.

2. Veeam Backup & Replication powers on the VM replica. The state of the VM replica is changed from **Normal** to **Failover**. If you perform failover for testing or DR simulation purposes, and the original VM still exists and is running, the original VM remains powered on.

   Note that any replication activities for the original VM will fail until the VM replica is returned to the **Normal** state.

3. All changes made to the VM replica while it is running in the **Failover** state are written to the differencing disk (AVHD/AVHDX) of the snapshot, or restore point, to which you have selected to roll back.
Legacy VM Replicas

The failover operation for legacy VM replicas is performed in the following way:

1. To protect the VM replica from altering, Veeam Backup & Replication takes a protective snapshot for the VM replica.
2. Veeam Backup & Replication rolls back the VM replica to the required restore point.
3. Veeam Backup & Replication powers on the VM replica. The state of the VM replica is changed from Normal to Failover.
   
   Note that any replication activities for the original VM will fail until the VM replica is returned to the Normal state.
4. All changes made to the VM replica while it is running in the Failover state are written to the differencing disk of the created protective snapshot.

In Veeam Backup & Replication, the actual failover is considered a temporary stage that should be further finalized. While the replica is in the Failover state, you can undo failover, perform failback or perform permanent failover. In a disaster recovery scenario, after you test the VM replica and make sure the VM runs stable, you should take another step to perform permanent failover.

Performing Failover

If a VM becomes unavailable or fails in case of a disaster, you can fail over to a VM replica and quickly restore services in the production environment. When you perform failover, the VM replica takes over the role of the original VM. As a result, you have your VM up and running within a couple of minutes, and your users can access services and applications they need with minimal disruption.

Before you perform failover, check prerequisites. Then use the Hyper-V Failover wizard to fail over the VM replica.

Before You Begin

Before you fail over to a VM replica, check the following prerequisites:

- The failover operation can be performed for VMs that have been successfully replicated at least once.
- VM replicas must be in the Ready state.
Step 1. Launch Failover Wizard

To launch the **Failover** wizard, do one of the following:

- On the **Home** tab, click **Restore > Microsoft Hyper-V > Restore from replica > Entire replica > Failover to a replica**.
- Open the **Home** view, in the inventory pane select **Replicas**. In the working area, select the necessary replica and click **Failover Now** on the ribbon.
- Open the **Home** view, in the inventory pane select **Replicas**. In the working area, right-click the necessary replica and select **Failover Now**.

---

**Entire replica**  
Performs failover or failback operation on replica VMs.

**Failover to a replica**  
Performs failover to a replica. Use this option for disaster recovery when the original machine is no longer available.

**Planned failover a replica**  
Performs planned failover to a replica, preventing any data loss. This option requires that the original machine is still available, as is particularly useful for datacenter migrations.

**Undo failover**  
Performs undo operation on the previously performed replica failover discarding any changes to the replica VM.

**Failback to production**  
Performs failback of a replica to the original location by transferring actual replica state to the source machine.

**Commit failback**  
Commits replica failback operation. Perform this operation after ensuring that the VM is functioning normally.
Step 2. Select VMs

At the **Virtual Machines** step of the wizard, select VMs for which you want to perform failover. You can perform failover for separate VMs and whole VM containers.

To select VMs and VM containers:

1. Click **Add VM**.
2. Select where to browse for VMs and VM containers:
   - **From infrastructure** — browse the virtual environment and select VMs or VM containers. If you choose a VM container, Veeam Backup & Replication will expand it to a plain VM list.
   - **From replicas** — browse existing replicas and select VMs or VM containers under replication jobs.

To quickly find VMs or VM containers, you can use the search field at the top of the wizard.

1. Enter a VM or VM container name or a part of it in the search field. Veeam Backup & Replication will display possible matches.
2. If the VM or VM container is not in the list, click the **Show more** link to browse the virtual infrastructure.

**NOTE:**

Make sure that VMs you select from the virtual environment have been successfully replicated at least once.
Step 3. Select Restore Point

By default, Veeam Backup & Replication uses the latest valid restore point of the VM replica. However, you can fail over to an earlier state of the VM. If you have chosen to perform failover for several VMs, you can select the necessary restore point for every VM in the list.

To select a restore point for a VM:

1. In the **Virtual machines to failover** list, select a VM.
2. Click **Point** on the right.
3. In the **Restore Points** window, select a restore point that you want to use.
Step 4. Specify Failover Reason

At the **Reason** step of the wizard, enter a reason for failing over to VM replicas. The information you provide will be saved in the session history and you can reference it later.

**TIP:**
If you do not want to display the **Reason** step of the wizard in future, select the **Do not show me this page again** check box.
Step 5. Review Summary and Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of failover.

1. Review details of the failover task.
2. Click **Finish** to start the failover process.

When the failover process is complete, VM replicas will be started on the target hosts.
Permanent Failover

To finalize the failover process, you can permanently fail over to the VM replica.

When you perform permanent failover, you “commit” failover. You can perform this operation if you want to permanently switch from the original VM to a VM replica and use this replica as the original VM. As a result of permanent failover, the VM replica ceases to exist as a replica and takes on the role of the original VM.

The permanent failover scenario is acceptable if the original VM and VM replica are located in the same site and are nearly equal in terms of resources. In this case, users will not experience any latency in ongoing operations.

The permanent failover operation is performed in the following way:

1. Veeam Backup & Replication removes snapshots (restore points) of the VM replica from the snapshot chain and deletes associated files from the volume. Changes that were written to the snapshot differencing disk are committed to the VM replica disk files to bring the VM replica to the most recent state.

2. Veeam Backup & Replication removes the VM replica from the list of replicas in the Veeam Backup & Replication console.

3. To protect the VM replica from corruption after permanent failover is complete, Veeam Backup & Replication reconfigures the replication job and adds the original VM to the list of exclusions. When the replication job starts, the original VM is skipped from processing. As a result, no data is written to the working VM replica.

Performing Permanent Failover

With permanent failover, you can finalize failover to a VM replica. As a result of permanent failover, the VM replica on the target host ceases to exist as a replica and takes on the role of the original VM.

To perform permanent failover, do either of the following:

- Open the Home view, in the inventory pane select Replicas. In the working area, select the necessary replica and click Permanent Failover on the ribbon.

- Open the Home view, in the inventory pane select Replicas. In the working area, right-click the necessary replica and select Permanent Failover.

In the displayed window, click Yes to confirm the operation.
To protect the VM replica from corruption after performing a permanent failover, Veeam Backup & Replication removes the VM replica from the Replicas list. Additionally, Veeam Backup & Replication reconfigures the replication job and adds the original VM to the list of exclusions. When the replication job that processes the original VM starts, the VM will be skipped from processing, and no data will be written to the working VM replica.
**Failover Plan**

If you have a number of VMs running interdependent applications, you need to failover them one by one, as a group. To do this automatically, you can prepare a failover plan.

In a failover plan, you set the order in which VMs must be processed and time delays for VMs. The time delay is an interval of time for which Veeam Backup & Replication must wait before starting the failover operation for the next VM in the list. It helps to ensure that some VMs, such as a DNS server, are already running at the time the dependent VMs start. The time delay is set for every VM in the failover plan except the last VM in the list.

The failover plan must be created in advance. In case the primary VM group goes offline, you can start the corresponding failover plan manually. When you start the procedure, you can choose to fail over to the latest state or select the point in time to which VM replicas must be started. Veeam Backup & Replication will look for the closest restore points to this point in time and use them to start VM replicas. The source VMs will not be powered off.

The failover process is performed in the following way:

1. For each VM, Veeam Backup & Replication detects its replica. The VMs whose replicas are already in Failover or Failback state are skipped from processing.
2. The replica VMs are started in the order they appear in the failover plan within the set time intervals.

![Diagram of failover process]

**Limitations for Failover Plans**

The maximum number of VMs that can be started simultaneously when you run a failover plan is 10. If you have added more VMs to the failover plan and scheduled them to start simultaneously, Veeam Backup & Replication will wait for the first VMs in the list to fail over and then start the failover operation for subsequent VMs. This limitation helps reduce the workload on the production infrastructure and backup server.

For example, if you have added 14 VMs to the failover plan and scheduled them to start at the same time, Veeam Backup & Replication will start the failover operation for the first 10 VMs in the list. After the 1st VM is processed, Veeam Backup & Replication will start the failover operation for the 11th VM in the list, then for the 12th VM and so on.

**Finalizing Failover Plans**

Failover is a temporary intermediate step that needs to be finalized. The finalizing options for a group failover are similar to a regular failover: undoing failover, permanent failover or failback.
When you failback or perform permanent failover, you need to process every VM individually. However, when you undo failover, you can process the whole group. For this, use the undo failover plan option.

Undoing the failover switches the replica back to the primary VM discarding all changes that were made to the replica while it was running. When you undo group failover, Veeam Backup & Replication uses the list of VMs that were failed over during the last failover plan session and switches them back to the primary VMs. If some of the VMs were already failed back, for example manually by the user, they are skipped from processing.

Veeam Backup & Replication starts the undo failover operation for a group of 5 VMs at the same time. The time interval between the operation starts is 10 seconds. For example, if you have added 10 VMs to the failover plan, Veeam Backup & Replication will undo failover for the first 5 VMs in the list, then will wait for 10 seconds and undo failover for the remaining 5 VMs in the list. Time intervals between the operation starts help Veeam Backup & Replication reduce the workload on the production environment and backup server.

Creating Failover Plans

If you have a number of VMs running dependent applications, you need to failover them one by one, as a group. To do this automatically, you can prepare a failover plan.

Before you create a failover plan, check prerequisites. Then use the New Failover Plan wizard to create a failover plan.

Before You Begin

Before you create a failover plan, check the following prerequisites:

- VMs that you plan to include in the failover plan must be successfully replicated at least once.
- VM replicas must be in the Ready state.
- If you plan to use pre-failover and/or post-failover scripts for the failover plan, you must create scripts before you configure the failover plan.
Step 1. Launch New Failover Plan Wizard

To launch the **New Failover Plan** wizard, do one of the following:

- **On the Home tab**, click **Failover Plan** and select **Microsoft Hyper-V**.

- **Open the Home view**, in the inventory pane select **Replicas**. In the working area select one or more VMs, click **Add to Failover Plan > New Failover Plan** on the ribbon or right-click one or more VMs and select **Add to failover plan > New Failover Plan**.

  In this case, the VMs will be automatically added to the failover plan. You can add other VMs to the failover plan when passing through the wizard steps.

- **Open the Inventory view**, in the working area select one or more VMs, click **Add to Failover Plan > New Failover Plan** on the ribbon or right-click one or more VMs and select **Add to failover plan > New Failover Plan**.

  In this case, the selected VMs will be automatically added to the failover plan. You can add other VMs to the failover plan when passing through the wizard steps.
Step 2. Specify Failover Plan Name and Description

At the **General** step of the wizard, specify a name and description for the failover plan and define script settings for the plan if necessary.

1. In the **Name** field, enter a name for the failover plan.
2. In the **Description** field, provide a description for future reference. The default description contains information about the user who created the failover plan, date and time when the plan was created.
3. If you want to execute custom scripts before and/or after the failover plan, select the **Pre-failover script** and **Post-failover script** check boxes and click **Browse** to choose executable files. Veeam Backup & Replication supports script files in the following formats: BAT, CMD, EXE and PS1. For example, you may want to stop some applications on production VMs before the failover plan starts or send an email to backup administrators after the failover plan finishes.
Step 3. Select VMs

At the **Virtual Machines** step of the wizard, select VMs that you want to add to the failover plan. You can add separate VMs and whole VM containers.

To add VMs and VM containers:

1. Click **Add VM**.
2. Select where to browse for VMs and VM containers:
   - **From infrastructure** — browse the virtual environment and select VMs or VM containers. If you choose a VM container, Veeam Backup & Replication will expand it to a plain VM list.
   
   To quickly find VMs or VM containers, you can use the search field at the bottom of the **Add Object** window. Enter a VM or VM container name or a part of it in the search field and click **Start search** or press [Enter] on the keyboard.

   - **From replicas** — browse existing replication jobs and select all VMs or specific VMs from replication jobs.

   To quickly find VMs, you can use the search field at the bottom of the **Select Replica** window. Enter a VM name or a part of it in the search field and click **Start search** or press [Enter] on the keyboard.

Make sure that VMs you select from the virtual environment have been successfully replicated at least once.

**IMPORTANT!**

A source from which you add a VM to a failover plan does not matter. When you run the failover plan, Veeam Backup & Replication always fails over to the latest restore point of VM replicas. To fail over to a specific restore point of VM replicas, use the **Start to** command. For more information, see **Running Failover Plans**.

![New Failover Plan](image)
Step 4. Define VM Failover Order

The VM replicas in the failover plan are started in the order they appear in the VM list. If some VMs provide environment for other dependent VMs, make sure that they are started first.

To set VM start order:

1. Select the VM in the list
2. Move the VM up or down the list using the Up and Down buttons on the right.
Step 5. Set Time Delay

After you have set the order for VMs in the failover plan, you need to set a time delay for VMs. The delay time defines for how long Veeam Backup & Replication must wait before starting the failover operation for the next VM in the list. You can use time delays to make sure that some VMs are already running at the moment dependent VMs start.

Time delays can be specified for all VMs in the list except the last one. If you do not specify time delays, VMs will be started simultaneously.

For example, you have added 2 VMs to the failover plan and set a time delay to 60 seconds for the first VM in the list. Veeam Backup & Replication will perform failover in the following manner: Veeam Backup & Replication will start the failover operation for the first VM in the list, then wait for 60 seconds and start the failover operation for the second VM in the list.

To set the time delay for a VM:

1. Select it and click Set Delay on the right or double-click the VM in the list.
2. Enter the time interval that you consider sufficient for this VM to boot.
Step 6. Review Summary and Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of the failover plan configuration.

1. Review details for the configured failover plan.
2. Click **Finish** to create the failover plan.

### Running Failover Plans

You have the following options to run the failover plan:

- You can fail over to latest restore point of VM replicas. To use this option, you must run the failover plan with the **Start** command.

  Veeam Backup & Replication searches for the latest restore point of VM replicas across all replication jobs configured on the backup server. For example, you have 2 jobs that replicate the same VM: Job 1 has created the most recent point at 2:00 AM and Job 2 has created the most recent restore point at 3:00 AM. When you run the failover plan using the **Start** command, Veeam Backup & Replication will pick the restore point created at 3:00 AM with Job 2.

- You can fail over to a specific restore point of VM replicas. To use this option, you must run the failover plan with the **Start to** command and select the necessary date when restore points for VM replicas were created.

To fail over to the latest restore point of VM replicas:

1. Open the **Home** view.
2. Expand the **Replicas** node.
3. Select **Failover Plans**.
4. In the working area, right-click the failover plan and select **Start**.

To fail over to a specific restore point of VM replicas:

1. Open the **Home** view.
2. Expand the **Replicas** node.
3. Select **Failover Plans**.
4. In the working area, right-click the failover plan and select **Start to**.
5. In the displayed window, select the backup date and time. Veeam Backup & Replication will find the closest restore point prior to the entered value for each VM and fail over to it.

---

**Undoing Failover by Failover Plans**

You can undo failover for all VMs added to the failover plan at once. When you undo failover, you switch the workload back to original VMs and discard all changes that were made to VM replicas during failover.

To undo failover by a failover plan:

1. Open the **Home** view.
2. Expand the **Replicas** node.
3. Select **Failover Plans**.
4. In the working area, right-click the failover plan and select **Undo**.
5. In the displayed dialog box, click **Yes** to confirm the operation.
Planned Failover

If you know that your primary VMs are about to go offline, you can proactively switch the workload to their replicas. A planned failover is smooth manual switching from a primary VM to its replica with minimum interrupting in operation. You can use the planned failover, for example, if you plan to perform datacenter migration, maintenance or software upgrade of the primary VMs. You can also perform planned failover if you have an advance notice of a disaster approaching that will require taking the primary servers offline.

When you start the planned failover, Veeam Backup & Replication performs the following steps:

1. The failover process triggers the replication job to perform an incremental replication run and copy the un-replicated changes to the replica.
2. The VM is powered off.
3. The failover process triggers the replication job to perform another incremental replication run and copy the portion of last-minute changes to the replica. The replica becomes fully synchronized with the source VM.
4. The VM is failed over to its replica.
5. The VM replica is powered on.

As the procedure is designed to transfer the current workload to the replica, it does not suggest selecting a restore point to switch.

During the planned failover, Veeam Backup & Replication creates 2 helper restore points that are not deleted afterwards. These restore points will appear in the list of restore points for this VM; you can use them later to roll back to the necessary VM replica state.

When your primary host is online again, you can switch back to it. The finalizing options for a planned failover are similar to those of an unplanned failover: undoing failover, permanent failover or failback.

NOTE:

During planned failover, Veeam Backup & Replication always retrieves VM data from the production infrastructure, even if the replication job uses the backup as a data source. This approach helps Veeam Backup & Replication synchronize the VM replica to the latest state of the production VM.
Limitations for Planned Failover

Planned failover has the following limitations:

- If you start planned failover for several VMs that are replicated with one replication job, these VMs will be processed one by one, not in parallel.

- Each planned failover task for each VM is processed as a separate replica job session. If a backup proxy is not available and the session has to wait for resources, job sessions for other VMs in the same task cannot be started before the current session is finished.

- The user account under which you launch the planned failover operation must have the *Veeam Backup Administrator* role or *Veeam Backup Operator* and *Veeam Restore Operator* roles in Veeam Backup & Replication. For more information, see [Roles and Users](#).

Performing Planned Failover

Planned failover is the operation of switching from a running VM to its replica. Planned failover is performed to transfer the workload to the replica in advance in case the original VM is scheduled to go offline for some time.

Before you perform planned failover, check prerequisites. Then use the Planned Failover wizard to perform planned failover.

**Before You Begin**

Before you perform planned failover, check the following prerequisites:

- VMs for which you plan to perform planned failover must be successfully replicated at least once.

- VM replicas must be in the *Ready* state.
Step 1. Launch Planned Failover Wizard

To launch the Planned Failover wizard, do one of the following:

- On the Home tab, click Restore and select Microsoft Hyper-V > Restore from replica > Entire replica > Planned failover a replica.

- Open the Home view, expand the Replicas node. In the working area, select one or more VMs and click Planned Failover on the ribbon. You can also right-click one or more VMs and select Planned Failover.

- Open the Inventory view, in the working right-click one or more VMs area and select Restore > Planned Failover.

In this case, the selected VMs will be automatically included into the planned failover task. You can add other VMs to the task when passing through the wizard steps.
Step 2. Select VMs

At the Virtual Machines step of the wizard, select one or more VMs for which you want to perform failover. You can perform failover for separate VMs and whole VM containers.

To select VMs and VM containers:

1. Click Add VM.
2. Select where to browse for VMs and VM containers:
   - From infrastructure — browse the virtual environment and select VMs or VM containers. If you choose a VM container, Veeam Backup & Replication will expand it to a plain VM list.
     To quickly find VMs or VM containers, you can use the search field at the bottom of the Add Object window. Enter a VM or VM container name or a part of it in the search field and click Start search or press [Enter] on the keyboard.
   - From replicas — browse existing replication jobs and select all VMs or specific VMs from replication jobs.
     To quickly find VMs, you can use the search field at the bottom of the Backup Browser window. Enter a VM name or a part of it in the search field and click Start search or press [Enter] on the keyboard.

You can also use the search field at the top of the wizard:

1. Enter a VM name or a part of it in the search field. Veeam Backup & Replication will display possible matches.
2. If the VM is not in the list, click the Show more link to browse existing VM replicas. Veeam Backup & Replication will open the Backup Browser window, and you can select the necessary VM replica there.

Make sure that VMs you select from the virtual environment have been successfully replicated at least once.
Step 3. Specify Failover Reason

At the Reason step of the wizard, enter a reason for failing over to VM replicas. The information you provide will be saved in the session history and you can reference it later.

TIP:
If you do not want to display the Reason step of the wizard in future, select the Do not show me this page again check box.
Step 4. Review Summary and Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of planned failover.

1. Review details of the failover task.
2. Click **Finish** to start the failover process.

Once planned failover is complete, VM replicas will be started on the target hosts.
Undo Failover

To revert a VM replica to its pre-failover state, you can undo failover.

When you undo failover, you switch back from the VM replica to the original VM. Veeam Backup & Replication discards all changes made to the VM replica while it was in the Failover state. You can use the undo failover scenario if you have failed over to the VM replica for testing and troubleshooting purposes and want to get back to the normal operation mode.

The undo failover operation is performed in the following way:

1. Veeam Backup & Replication reverts the VM replica to its pre-failover state. To do this, Veeam Backup & Replication powers off the VM replica and gets it back to the state of the latest snapshot in the snapshot chain. Changes that were written to the snapshot differencing disk while the VM replica was in the Failover state are discarded.

2. The state of the VM replica gets back to Normal, and Veeam Backup & Replication resumes replication activities for the original VM on the source host.

Undoing Failover

With the undo failover operation, you can power off running VM replicas on target hosts and roll back to initial state of VM replicas.

To undo failover:

1. Open the Home view.
2. In the inventory pane, select Replicas.
3. In the working area, select the necessary replica and click Undo Failover on the ribbon. You can also right-click the necessary replica and select Undo Failover.
4. In the displayed window, click **Yes** to confirm the operation.

---

**Forcing Undo Failover**

In some cases, Veeam Backup & Replication may fail to perform the undo failover operation. This can happen, for example, if the host on which the VM replica resides is unavailable. To overcome this situation, you can force undo failover.

When you force failover, Veeam Backup & Replication attempts to perform the undo failover operation in a regular way. If the host is unavailable, Veeam Backup & Replication changes the VM replica state to **Ready** in the configuration database and console.

To force undo failover:

1. Open the **Home** view.
2. In the inventory pane, select **Replicas**.
3. In the working area, select the necessary replica and click **Undo Failover** on the ribbon. You can also right-click the necessary replica and select **Undo Failover**.
4. In the displayed window, select the **Force undo failover** check box and click **Yes**.
Replica Failback

If you want to resume operation of a production VM, you can fail back to it from a VM replica. When you perform failback, you get back from the VM replica to the original VM, shift your I/O and processes from the target host to the production host and return to the normal operation mode.

If you managed to restore operation of the source host, you can switch from the VM replica to the original VM on the source host. If the source host is not available, you can restore the original VM to a new location and switch back to it. Veeam Backup & Replication offers three failback options:

- You can fail back to a VM in the original location on the source host.
- You can fail back to a VM that has been restored up-front from the backup in a new location.
- You can fail back to an entirely new location by transferring all VM replica files to the selected destination.

The first two options help you decrease recovery time and use of the network traffic: Veeam Backup & Replication needs to transfer only differences between the original VM and VM replica. The third option can be used if there is no way to use the original VM or restore the VM from the backup before performing failback.

How Failback Works

If you fail back to an existing original VM, Veeam Backup & Replication performs the following operations:

1. If the original VM is running, Veeam Backup & Replication powers it off.
2. Veeam Backup & Replication calculates the difference between disks of the original VM and disks of the VM replica in the Failover state. Difference calculation helps Veeam Backup & Replication understand what data needs to be transported to the original VM to synchronize it with the VM replica.
3. Veeam Backup & Replication transports changed data to the original VM.
4. Veeam Backup & Replication powers off the VM replica. The VM replica remains powered off until you commit failback or undo failback.
5. Veeam Backup & Replication creates a failback protective snapshot for the VM replica. The snapshot acts as a new restore point and saves the pre-failback state of the VM replica. You can use this snapshot to return to the pre-failback state of the VM replica afterwards.
6. Veeam Backup & Replication calculates the difference between the VM replica and the original VM once again and transports changed data to the original VM. A new synchronization cycle lets Veeam Backup & Replication copy a portion of last-minute changes made on the VM replica while the failback process was being performed.
7. The state of the VM replica is changed from Failover to Failback. Veeam Backup & Replication temporarily puts replication activities for the original VM on hold.
8. If you failback to the original VM restored in a new location, Veeam Backup & Replication updates the ID of the original VM in the Veeam Backup & Replication configuration database. The ID of the original VM is replaced with the ID of the restored VM.
9. If you have selected to power on the original VM after failback, Veeam Backup & Replication powers on the restored original VM on the target host.

If you fail back to an entirely new location, Veeam Backup & Replication performs the following operations:

1. Veeam Backup & Replication transports all VM replica files and stores them on the target volume.
2. Veeam Backup & Replication registers a new VM on the target host.
3. If you have selected to power on the original VM after failback, Veeam Backup & Replication powers on the restored original VM on the target host.

In Veeam Backup & Replication, failback is considered a temporary stage that should be further finalized. After you test the recovered original VM and make sure it is working without problems, you should commit failback. You can also undo failback and return the VM replica back to the Failover state.

**Supported Platforms for Replica Failback**

**Failback to Original Location**

You can fail back to an existing VM in original location from the target host of any version: 2008 R2-2019.

**Failback to New Location**

If you fail back to an entirely new location or to a new VM in original location, the version of the target host must be equal to or later than the version of the source host:

<table>
<thead>
<tr>
<th>Source/Target</th>
<th>Target 2008 R2</th>
<th>Target 2012-2019 (the Target OS version must be higher than Source OS version)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source 2008 R2</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Source 2012-2019</td>
<td>✗</td>
<td>✓</td>
</tr>
</tbody>
</table>
IMPORTANT!
Mind the following exception: you can fail back from the source 2016 host to the target 2012 R2 host only if a VM replica configuration is lower than 8.0.

Quick Rollback

If you fail back from a VM replica to the VM in the original location, you can instruct Veeam Backup & Replication to perform quick rollback. Quick rollback significantly reduces the failback time and has little impact on the production environment.

During failback with the quick rollback option enabled, Veeam Backup & Replication does not calculate digests for entire VM replica disks to get the difference between the original VM and VM replica. Instead, it queries CBT to get information about disk sectors that have changed, and calculates digests only for these disk sectors. As a result, digest calculation is performed much faster. After that, Veeam Backup & Replication performs failback in a regular way: transport changed blocks to the original VM, powers off the VM replica and synchronizes the original VM with the VM replica once again.

It is recommended that you use quick rollback if you fail back to the original VM after a problem that has occurred at the level of the guest OS of the VM replica — for example, there has been an application error or a user has accidentally deleted a file on the VM replica guest OS. Do not use quick rollback if the problem has occurred at the VM hardware level, storage level or due to a power loss.

Requirements for Quick Rollback

To perform quick rollback, make sure that the following requirements are met:

- You must perform failback to the VM in the original location.
- The VM replica must be created with the Use changed block tracking data option enabled.
Limitations for Quick Rollback

- After you fail back to the original VM with quick rollback, the CBT on the original VM is reset. During the subsequent replication job session, Veeam Backup & Replication will read data of the entire original VM.
- Quick rollback is not supported for VM replicas created with legacy replication jobs.

Performing Failback

With the **Failback** option, you can switch from a VM replica back to the original VM or restore a VM from a VM replica in a new location.

Before you start failback, check prerequisites. Then use the **Failback** wizard to switch back to the original VM.

Before You Begin

Before you perform failback, check the following prerequisites:

- VMs for which you plan to perform failback must be successfully replicated at least once.
- VM replicas must be in the **Failover** state.
- On non-Microsoft Windows SMB3 storage, for example, Tintri, Veeam Backup & Replication may display the "Failed to disable integrity bit on disk N" warning during VM restore. You can ignore this warning for non-Microsoft Windows SMB3 storage.
- You must check the platform compatibility matrix. For more information, see **Supported Platforms for Replica Failback**.
Step 1. Launch Failback Wizard

To launch the Failback wizard, do one of the following:

- On the Home tab, click Restore > Microsoft Hyper-V > Restore from replica > Entire replica > Failback to production.
- Open the Home view, in the inventory pane select Replicas. In the working area, select the necessary replica and click Failback to Production on the ribbon.
- Open the Home view, in the inventory pane select Replicas. In the working area, right-click the necessary replica and select Failback to production.

**Entire replica**
Performs failover or failback operation on replica VMs.

- **Failover to a replica**
  Performs failover to a replica. Use this option for disaster recovery when the original machine is no longer available.

- **Planned failover a replica**
  Performs planned failover to a replica, preventing any data loss. This option requires that the original machine is still available, as it is particularly useful for datacenter migrations.

- **Undo failover**
  Performs undo operation on the previously performed replica failover discarding any changes to the replica VM.

- **Failback to production**
  Performs failback of a replica to the original location by transferring actual replica state to the source machine.

- **Commit failback**
  Commits replica failback operation. Perform this operation after ensuring that the VM is functioning normally.
Step 2. Select VM Replicas to Fail Back

At the **Replica** step of the wizard, select one or more VM replicas from which you want to fail back.

1. Click **Populate** to display all existing replicas in the **Failover** state.
2. Leave check boxes selected only for those VM replicas from which you want to fail back.
Step 3. Select Failback Destination

At the Destination step of the wizard, select failback destination.

Veeam Backup & Replication supports three possible failback destination variants. Note that the Failback wizard displays a different set of steps for every failback variant.

- Select **Failback to the original VM** if you want to fail back to the original VM residing on the source host. In this case, Veeam Backup & Replication will restore the original VM to the current state of its replica.
  
  If this option is selected, you will pass to the **Summary step** of the wizard.

- Select **Failback to the original VM restored in a different location** if you have recovered the original VM from a backup in a new location, and you want to switch to it from the replica. In this case, Veeam Backup & Replication will restore the recovered VM to the current state of the replica.
  
  If this option is selected, you will pass directly to **Target VM step** of the wizard.

- Select **Failback to the specified location (advanced)** if you want to restore the original VM from a replica in a new location and/or with different settings (such as VM location, network settings, the format of restored virtual disks and so on).

If you fail back to the original VM or to the original VM restored in a new location, only differences between the existing virtual disks and their state will be transferred over to the original VM. Veeam Backup & Replication will not transfer replica configuration changes, such as a different IP address or network settings (if replica Re-IP and network mapping were applied), new hardware or virtual disks added while the replica was in the Failover state.

If you choose to perform advanced failback, the entire VM replica, including its configuration and virtual disks content, will be restored in the selected location.
Step 4. Select Target Host

The Host step of the wizard is only available if you have chosen to perform advanced failback.

To specify a target host:

1. Select one or more VMs in the list and click Host.

2. Choose a standalone or clustered host where the selected VMs should be registered. To facilitate selection, you can use the search field at the bottom of the window. Click the button on the left of the field to select the necessary type of object that should be searched for: SCVMM, Cluster or Host. Enter an object’s name or a part of it and click the Start search button on the right or press [Enter] on the keyboard.

3. If you choose to register a restored VM on a host that is a part of a Microsoft Hyper-V failover cluster, you can register it as a cluster resource. Select a VM in the list and click Resource. In the Cluster Resource Settings section, choose Register VM as a cluster resource. In this case, if the target host is brought offline or fails for any reason, the VM will fail over to another node in the cluster.
Step 5. Select Target Datastore

The **Datastore** step of the wizard is only available if you have chosen to perform advanced failback.

When restoring a VM from a replica, you can place an entire VM to a particular location or choose to store configuration files and disk files of a restored VM in different locations.

To specify a destination location:

1. Select one or more VMs in the list and click **Path**.

2. If configuration and disk files of a VM should be placed to different locations, expand the VM in the list, select the necessary file type, click **Path** and point to the necessary folder. To create a dedicated folder for storing files of the restored VM, use the **Make New folder** button at the bottom of the window.

You can choose a Microsoft SMB3 shared folder as a destination for the VM.

1. Select the VM in the list and click **Path** at the bottom of the window.

2. Type a path to the Microsoft SMB3 shared folder in the search field at the bottom of the **Select Folder** window. The path must be specified in the UNC format, for example: `\172.16.11.38\Share01`.

The host or cluster where you register the VM must have access to the Microsoft SMB3 shared folder. If you are using SCVMM 2012 or later, the server hosting the Microsoft SMB3 share must be registered in SCVMM as a storage device. For more information, see [Microsoft Docs](https://docs.microsoft.com).

![Datastore Step](image-url)
Step 6. Select Target Network

The **Network** step of the wizard is only available if you have chosen to perform advanced failback.

If you plan to fail back to VMs to a new location (for example, another site with a different set of networks), you can map disaster recovery site networks to production site networks. Veeam Backup & Replication will use the network mapping table to update configuration files of VMs on the fly, during the restore process.

To change networks to which restored VMs will be connected:

1. Select one or more VMs in the list and click **Network**.
2. If a VM is connected to multiple networks, expand the VM, select the network to map and click **Network**.
3. The **Select Network** section displays all networks to which the target host or cluster is connected. From the list of available networks, choose a network to which the original VMs should have access upon failback. To facilitate selection, use the search field at the bottom of the window: enter a network name or a part of it and click the **Start search** button on the right or press [Enter] on the keyboard.

To prevent the original VM from accessing networks upon failback, select the VM or its network connections in the list and click **Disconnected**.
Step 7. Specify VM Name and VM UUID Handling

The **Name** step of the wizard is only available if you have chosen to perform advanced failback.

When restoring VMs from replicas, Veeam Backup & Replication uses original VM names. You can change names of restored VMs, for example, if you restore a VM to its original location, you may need to change its name to avoid confusion.

To change VM names:

1. Select one or more VMs in the list and click **Name**.
2. In the **Change Name** section, you can enter a new name explicitly or specify a change name rule by adding a prefix and/or suffix to the regular VM name. You can change VM names directly in the list: select a VM, click the **New Name** field and enter the name to be assigned to the restored VM.

Additionally, you can specify how Veeam Backup & Replication should handle unique identifiers of restored VMs. By default, a new VM ID will be generated for the recovered VM. If necessary, you can choose to preserve the existing VM ID.

To view or change VM identification settings:

1. Select one or more VMs in the list and click **VM ID**.
2. In the **Unique VM ID** section, choose one of the following options:

   - Select **Preserve existing VM ID** if the original VM was decommissioned, so the restored VM will be used in place of the original one.
   - Select **Generate new VM ID** if you perform VM recovery to clone the original VM. Use this option to avoid VM ID conflicts in cases when the original VM and its duplicate will operate in parallel in the same location.
Step 8. Map the Replica to Restored VM

The **Target VM** step of the wizard is only available if you have chosen to fail back to the original VM restored in a different location.

You can define how VM replicas map to VMs restored from backup.

To create a mapping association:

1. Select a replica in the list and click **Edit**.
2. Select the restored VM from the virtual environment. To facilitate selection, use the search field at the bottom of the *Select Objects* window: click the button to the left of the field and select the necessary type of object to search for: *Everything, Folder, Host Group, SCVMM, Cluster, Host* or VM, enter an object's name or a part of it and click the **Start search** button on the right or press [Enter] on the keyboard.
Step 9. Review Summary and Finish Working with Wizard

At the **Summary** step of the wizard, specify additional settings for failback:

1. If you want to start the VM on the target host after failback is complete, select the **Power on VM after restoring** check box.

2. Check the specified settings and click **Finish**. Veeam Backup & Replication will restore the original VMs to the state of corresponding VM replicas.
Commit Failback

To confirm failback and finalize recovery of the original VM, you need to commit failback.

When you commit failback, you confirm that you want to get back to the original VM. Veeam Backup & Replication gets back to the normal operation mode and resumes replication activities for the original VM to which you failed back.

The commit failback operation is performed in the following way:

1. Veeam Backup & Replication changes the state of the replica from Failback to Normal.
2. Further operations depend on the location to which the VM is failed back:
   - If the VM replica is failed back to a new location, Veeam Backup & Replication additionally reconfigures the replication job and adds the former original VM to the list of exclusions. The VM restored in the new location takes the role of the original VM and is included into the replication job instead of the excluded VM. When the replication job starts, Veeam Backup & Replication will process the newly restored VM instead of the former original VM.
   - If the VM replica is failed back to the original location, the replication job is not reconfigured. When the replication job starts, Veeam Backup & Replication will process the original VM in the normal operation mode.

During failback commit, the failback protective snapshot that saves the pre-failback state of a VM replica is not deleted. Veeam Backup & Replication uses this snapshot as an additional restore point for VM replica. With the pre-failback snapshot, Veeam Backup & Replication needs to transfer fewer changes and therefore puts less load on the network when replication activities are resumed.

Committing Failback

The Commit failback operation finalizes failback from the VM replica to the original VM.

To commit failback, do one of the following:

- Open the Home view, in the inventory pane select Replicas. In the working area, select the necessary replica and click Commit Failback on the ribbon. In the displayed window, click Yes to confirm the operation.
- Open the Home view, in the inventory pane select Replicas. In the working area, right-click the necessary replica and select Commit Failback. In the displayed window, click Yes to confirm the operation.
Depending on the location to which the VM is failed back, Veeam Backup & Replication performs the following finalizing operations after failback is committed:

- If the VM replica is failed back to a new location, Veeam Backup & Replication additionally reconfigures the replication job and adds the former original VM to the list of exclusions. The VM restored in the new location takes the role of the original VM, and is included into the replication job instead of the excluded VM. When the replication job starts, Veeam Backup & Replication will exclude the former original VM from processing, and will replicate the newly restored VM instead.

- If the VM replica is failed back to the original location, the replication job is not reconfigured. When the replication job starts, Veeam Backup & Replication will process the original VM in the normal mode.
Undo Failback

If the original VM is not working as expected after the failback operation, you can undo failback and get back to the VM replica.

The undo failback operation is performed in the following way:

1. Veeam Backup & Replication deletes the protective failback snapshot on the VM replica.
2. Veeam Backup & Replication powers on the VM replica and changes the VM replica state from Failback to Failover.

Undoing Failback

The undo failback option allows you to switch from the original VM back to the VM replica and roll back the replica to the failover state.

To undo failback, do one of the following:

- Open the Home view and select the Replicas node. In the working area, select the necessary replica and click Undo Failback on the ribbon.
- Open the Home view and select the Replicas node. In the working area, right-click the necessary replica and select Undo Failback.
In the displayed dialog box, click **Yes** to confirm the operation.
With Veeam Backup & Replication, you can quickly perform backup of one or several VMs with VeeamZIP.

VeeamZIP is similar to a full VM backup. The VeeamZIP job always produces a full backup file (VBK) that acts as an independent restore point. You can store the backup file to a backup repository, to a local folder on the backup server or to a network share.

When you perform backup with VeeamZIP, you do not have to configure a backup job and schedule it. Instead, you can start the backup process for selected VMs immediately. This type of backup requires minimum settings — you should only select the backup destination, choose the necessary compression level and enable or disable encryption and application-aware processing if necessary.

Backup files produced with VeeamZIP jobs are displayed in the Home view, under the Backups > Disk (VeeamZIP) node. To restore VM data from VeeamZIP backups, you can right-click it in the Home view and select the necessary restore option. You can also double-click the necessary VeeamZIP backup file on the machine where Veeam Backup & Replication is installed.

To view the progress or results of the VeeamZIP job session, you can use the History view. For more information, see Viewing Real-Time Statistics.

**IMPORTANT!**

Consider the following:

- Veeam Backup & Replication does not enforce backup repository throttling rules during VeeamZIP jobs.
- You cannot use a Veeam Cloud Connect repository as a target for VeeamZIP jobs.
Creating VeeamZIP Backups

You can quickly back up running and powered off VMs with VeeamZIP. VeeamZIP can be helpful if you want to create an ad-hoc backup for VMs, archive VMs before decommissioning and so on. You can create VeeamZIP backups for one or more VMs.

To create VeeamZIP backups:

1. Open the **Inventory** view.
2. In the infrastructure tree, select a host or VM container in which the VMs that you want to back up reside.
3. In the working area, select the VMs and click **VeeamZIP > VeeamZIP** on the ribbon or right-click the VMs and select **VeeamZIP**.
   
   To quickly find the necessary VMs, type the VM name or a part of it in the search field at the top of the working area and click the **Start search** button on the right or press [Enter] on the keyboard.
4. In the **Destination** section of the **VeeamZIP <N> VM** window, specify a location in which you want to store VeeamZIP backups.
   
   - To store VeeamZIP backups in a backup repository, select **Backup repository** and choose the necessary backup repository from the list.
   
   - To store VeeamZIP backups in a local folder on the backup server, select **Local or shared folder**, click **Browse** on the right and select a folder in which VeeamZIP backups must be stored.
   
   - To store VeeamZIP backups in a shared folder, select **Local or shared folder** and type in the UNC name of the shared folder in the field below. Keep in mind that the UNC name always starts with two back slashes (\\).
     
     If the shared folder requires authentication, select the necessary credentials from the **Credentials** list. If you have not set up credentials beforehand, click the **Manage accounts** link or click **Add** on the right to add necessary credentials. For more information, see **Managing Credentials**.
5. If you want to specify retention settings for the created VeeamZIP backups, select the **Delete this backup automatically** check box. From the drop-down list, select the retention period. If you do not want to delete VeeamZIP backups, leave the **Delete this backup automatically** check box unselected.
6. To encrypt VeeamZIP backups, select the **Enable backup file encryption** check box. From the **Password** list, select a password that you want to use for encryption. If you have not created a password beforehand, click **Add** or use the **Manage passwords** link to specify a new password. For more information, see **Managing Passwords for Data Encryption**.
7. From the **Compression level** list, select a compression level for created backups.
8. By default, Veeam Backup & Replication uses native Microsoft Hyper-V quiescing mechanisms to create a transactionally consistent image of VMs. You can disable VM quiescence. To do this, select the **Disable guest quiescence** check box. In this case, Veeam Backup & Replication will create a crash-consistent VM backup.
9. Click **OK**. The VeeamZIP task will start immediately. Veeam Backup & Replication will create a full backup file (VBK) and store it in the specified location. The VM name, date and time of the file creation are appended to the file name so you can easily find the necessary backups afterwards.
10. As the job runs, you can track the job performance in the real-time mode. To see the job results once it completes, open the **History** view, expand the **Jobs** node and click **Backup**. Then double-click the job session in the list.
TIP:
Veeam Backup & Replication keeps settings of the latest VeeamZIP task. To quickly create VeeamZIP backups with the same settings and store backups in the same location, right-click the necessary VM and select VeeamZIP to.
Backup Copy

The main backup purpose is to protect your data against disasters and virtual or physical machine failures. However, having just one backup does not provide the necessary level of safety. The primary backup may get destroyed together with production data, and you will have no backups from which you can restore data.

To build a successful data protection and disaster recovery plan, it is recommended that you follow the 3-2-1 rule:

- **3**: You must have at least three copies of your data: the original production data and two backups.
- **2**: You must use at least two different types of media to store the copies of your data, for example, local disk and cloud.
- **1**: You must keep at least one backup offsite, for example, in the cloud or in a remote site.

Thus, you must have at least two backups and they must be in different locations. If a disaster takes out your production data and local backup, you can still recover from your offsite backup.

To help you adopt the 3-2-1 rule, Veeam Backup & Replication offers backup copy capabilities. Backup copy allows you to create several instances of the same backup data in different locations, whether onsite or offsite. Backup copies have the same format as those created by backup jobs and you can recover your data from them when you need it.

Backup copy is a job-driven process. Veeam Backup & Replication fully automates the backup copy process and lets you specify retention settings to maintain the desired number of restore points, as well as full backups for archival purposes.
About Backup Copy

With backup copy, you can create several instances of the same backup file and copy them to secondary (target) backup repositories for long-term storage. Target backup repositories can be located in the same site as the source backup repository or can be deployed offsite. The backup copy file has the same format as the primary backup, so you can restore necessary data directly from it in case of a disaster.

Veeam Backup & Replication supports backup copy for the following types of backups:

- Backups of VMware vSphere or vCloud Director virtual machines created with Veeam Backup & Replication
- Backups of Microsoft Hyper-V virtual machines created with Veeam Backup & Replication
- Backups of virtual and physical machines created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux
- Backups of virtual and physical machines created with Veeam Agent for Oracle Solaris
- Backups of Nutanix AHV virtual machines created with Veeam Backup for Nutanix AHV
- Backups of Oracle and SAP HANA databases created with Veeam Plug-ins for Enterprise Applications
- Backups stored in an HPE StoreOnce backup repository
- File share backups created with Veeam Backup & Replication
- Backups of Amazon EC2 instances created with Veeam Backup for AWS
- Backups of Microsoft Azure virtual machines created with Veeam Backup for Microsoft Azure

IMPORTANT!

You can copy backups created with Veeam Backup for AWS or Veeam Backup for Microsoft Azure only if you have Enterprise Plus edition of Veeam Backup & Replication. You can copy these backups from external repositories but not to them.

When the backup copying process starts, Veeam Backup & Replication accesses backup files in the source backup repository, retrieves data blocks for a specific machine from the backup file, copies them to the target backup repository, and composes copied blocks into a backup file in the target backup repository. The backup copying process does not affect virtual and physical infrastructure resources, does not require creation of additional VM checkpoints or VSS snapshots and does not produce load on machines whose backups are copied.

In Veeam Backup & Replication, backup copy is a job-driven process. To copy backups, you need to configure backup copy jobs. The backup copy job defines when, what, how and where to copy. Note that to copy file share backups, you need to configure a file share backup job, not the backup copy job. For more information, see Creating File Share Backup Jobs.

One backup copy job can be used to process one or multiple VMs. VMs included in the job are processed in parallel. If a VM included in the backup copy job has multiple disks, disks are processed sequentially, one after another.

In the target backup repository, the backup copy job creates a forever forward incremental backup chain. The target backup repository always contains only one active incremental backup chain. Restore points in the chain are managed according to the retention policy. For more information, see Retention Policy for Backup Copy Jobs.
How Backup Copy Works

Veeam Backup & Replication performs backup copy in the following way:

1. [For VM backup copy jobs only] Veeam Backup & Replication connects to Microsoft Hyper-V hosts to gather information about VMs whose restore points you want to copy.

2. For backup copying process, Veeam Backup & Replication starts two Veeam Data Movers — source Veeam Data Mover and target Veeam Data Mover. Veeam Data Movers location depends on the backup repository type and data transport path. For more information, see Backup Copy Architecture.

3. The first backup copy run always produces a full backup file. Veeam Backup & Replication copies data blocks that are necessary to build a full backup of a machine as of the most recent state.

   Veeam Backup & Replication can copy data blocks from one or more backup files in the backup chain in the source backup repository.

   - If the backup chain is created in the reverse incremental backup method, Veeam Backup & Replication copies data blocks of the latest full backup.

   - If the backup chain is created in the forward or forever forward incremental backup method, Veeam Backup & Replication copies data blocks from the first full backup and a set of incremental backups.

   To minimize the amount of traffic going over the network, Veeam Backup & Replication uses the data compression and deduplication technologies.

4. Veeam Backup & Replication transfers copied data to the target backup repository and writes all copied data blocks to the full backup file.

   - If you do not enable the Use per-VM backup files option for the target backup repository, Veeam Backup & Replication creates one backup file in the target backup repository and stores it data for all machines processed by the job.

   - If you enable the Use per-VM backup files option, data of every machine in the job is stored to separate backup files in the target backup repository.
5. During every next backup copy runs, when a new restore point appears in the source backup repository, Veeam Backup & Replication copies incremental changes from this most recent restore point and transfers them to the target backup repository. Veeam Backup & Replication writes the copied data blocks to the incremental backup file in the target backup repository.

In some cases, the source backup job and backup copy job may overlap. This situation can occur if the source backup job needs to transform the source backup chain.

If a specific task in the backup copy job locks the source backup chain to read data from it, and the source backup job that needs to write data to this backup chain starts at this moment (for example, for reverse incremental backup), the task in the backup copy job is put on hold. The backup copy job can continue processing other tasks that use other sources (for example, backup files created by other backup jobs). After the source backup job releases the backup chain, the backup copy job resumes processing machines in this backup chain.
Backup Copy Architecture

To transport data from the source backup repository to the target backup repository, the backup copy job uses one of the following paths:

- Direct transport path
- Transport path over WAN accelerators

Direct Transport Path

Veeam Backup & Replication transports data directly from the source backup repository to the target backup repository. This type of data transport is recommended for copying backups to onsite backup repositories or offsite backup repositories over fast connections.

When Veeam Backup & Replication transports data over the direct data path, it uses Veeam Data Movers on the following backup infrastructure components:

- **Microsoft Windows and Linux repositories.** Veeam Backup & Replication uses the source Veeam Data Mover on the source backup repository and target Veeam Data Mover on the target backup repository.

- **Shared folder backup repository.** If you have instructed Veeam Backup & Replication to automatically select the gateway server, Veeam Backup & Replication will use Veeam Data Movers deployed on mount servers associated with backup repositories. In case mount servers cannot be used for some reason, Veeam Backup & Replication will fail over to the backup server.

  If you have explicitly defined the gateway server, Veeam Backup & Replication will use the source Veeam Data Mover on the gateway server in the source site and target Veeam Data Mover on the gateway server on the target site.
Transport Path over WAN Accelerators

Veeam Backup & Replication transports data through a pair of WAN accelerators: one deployed on the source side and the other one deployed on the target side. WAN accelerators remove redundant blocks before transferring data and thus significantly reduce the amount of traffic going over the network. This type of data transport is recommended for copying backups offsite over slow connections or WAN.

**IMPORTANT!**

The WAN acceleration technology is available in the Enterprise Plus edition of Veeam Backup & Replication. For more information, see [WAN Acceleration](#).

When Veeam Backup & Replication transports data via WAN accelerators, it uses Veeam Data Movers on the following backup infrastructure components:

- **Microsoft Windows and Linux repositories.** Veeam Backup & Replication uses the source Veeam Data Mover on the source backup repository and target Veeam Data Mover on the target backup repository.

- **Shared folder backup repository.** If you have instructed Veeam Backup & Replication to automatically select the gateway server, Veeam Backup & Replication will use the Data Mover Services deployed on the source and/or target WAN accelerator. If you have explicitly defined the gateway server, Veeam Backup & Replication will use the source Veeam Data Mover on the gateway server in the source site and target Veeam Data Mover on the gateway server on the target site.
Backup Copy Modes

Veeam Backup & Replication offers two backup copy modes:

- **Immediate copy**
  
  In the immediate copy mode, Veeam Backup & Replication copies restore points as soon as they appear in a source backup repository. Veeam Backup & Replication copies only restore points created by source backup jobs (backup jobs that you select when configuring a backup copy job). Veeam Backup & Replication can also copy transaction log backups if you enable this capability in job settings.
  
  The immediate copy mode is supported for the following backup types:
  
  - Backups created with Veeam Backup & Replication
  - Backups created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux operating in the managed mode
    
    Only backups created by backup jobs managed by the backup server are supported.
  - Backups created with Veeam Plug-ins for Enterprise Applications

- **Periodic copy**
  
  In the periodic copy mode, Veeam Backup & Replication copies restore points once an interval specified in backup copy job settings. This interval is also known as backup copy interval. For more information, see [Backup Copy Intervals](#).
  
  Veeam Backup & Replication can copy restore points created by backup jobs or restore points of individual machines. If you select backup jobs when configuring copy job settings, Veeam Backup & Replication copies only restore points that selected backup jobs create. If you select machines, Veeam Backup & Replication copies all restore points of the selected machines — even restore points created by different backup jobs.
  
  The periodic copy mode is supported for the following backup types:
  
  - Backups created with Veeam Backup & Replication
  - Backups created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux operating in the standalone or managed mode
    
    For the managed mode, backups created by both backup jobs managed by the backup server and jobs managed by Veeam Agent are supported.
  - Backups created with Veeam Agent for Oracle Solaris
  - Backups created with Veeam Backup for Nutanix AHV
  - Backups created with Veeam Backup for AWS
  - Backups created with Veeam Backup for Microsoft Azure

**NOTE:**

Veeam Backup & Replication does not allow you to change the selected backup copy mode because the operating logic and created data are very different in these modes. If you want to change the mode, you need to create a new backup copy job in the required mode and create a seed for it. Note that the seed must also be created in the same mode as the new backup copy job. For more information, see [Creating Seed for Backup Copy Job](#).
Backup Copy Intervals

A backup copy interval is a time span in which a backup copy job must copy a restore point from the source backup repository to the target backup repository.

**NOTE:**
Veeam Backup & Replication uses backup copy intervals only in the periodic copy mode.

The backup copy interval affects the restore point selection process. For more information, see Restore Point Selection.

At the beginning of a new interval, Veeam Backup & Replication checks if a new restore point is available in the source backup repository:

- If a new restore point is found, the backup copy job starts the synchronization process and copies the latest restore point to the target backup repository.
- If a new restore point is not found or is locked by the source backup job, the backup copy job enters the idle state.

By default, the backup copy interval is set to 1 day. You can change this interval when configuring a backup copy job and set the interval in minutes or hours. Note that if you specify a too short backup copy interval or change the interval, some issues can occur. For details, see Issues with Backup Copy Intervals.

Minutely and Hourly Backup Copy Intervals

The first minutely and hourly intervals start when the backup copy job runs for the first time. Each subsequent backup copy interval starts after the period that you specified in the backup copy job settings.

For example, if you set the backup copy interval to 4 hours and start the backup copy job at 12:00 AM, Veeam Backup & Replication will start new backup copy intervals at 12:00 AM, 4:00 AM, 8:00 AM and so on.

### Daily Backup Copy Intervals

The daily backup intervals start every day at the time specified in the backup copy job settings.

For example, if you set the backup copy interval to 1 day and instruct Veeam Backup & Replication to start new intervals at 12:00 PM, Veeam Backup & Replication will start new backup copy intervals at 12:00 PM daily.

In some cases, the start time of the backup copy job and backup copy interval may differ.

For example, when configuring a backup copy job, you set the start time of the backup copy interval to 12:00 PM and launch the backup copy job at 12:00 AM. In this case, the first backup copy interval will start immediately after you launch the backup copy job and will run for a shorter period of time. In the example above, for 12 hours instead of one day. All subsequent backup copy intervals will start as defined by backup copy job schedule.
Issues with Backup Copy Intervals

Being a scheduled activity, the backup copy job may fail to run as expected. Veeam Backup & Replication automatically handles some issues that can occur with the backup copy job.

Short Backup Copy Intervals

In some cases, Veeam Backup & Replication may fail to transport the restore point within the backup copy interval of the backup copy job. This can happen, for example, if the backup copy interval is too short and is not sufficient for the amount of data to be copied.

Veeam Backup & Replication handles this situation differently for the first and subsequent backup copy intervals.

- The first backup copy interval always produces a full backup file — the starting point in the backup chain. If Veeam Backup & Replication fails to copy data for the full backup file during the first backup copy interval, it marks the job session as finished with the Warning status. During the next backup copy interval, Veeam Backup & Replication attempts to copy data for the full backup file in the following manner:
  
a. When a new backup copy interval begins, the restore point that was previously copied no longer corresponds to the restore point selection rules. That is, the time of the restore point creation falls out of the search scope. For this reason, Veeam Backup & Replication waits for a new restore point to appear in the source backup repository.

b. When a new restore point appears in the source backup repository, Veeam Backup & Replication detects what data blocks still need to be copied to make up a full backup file in the target backup repository, and copies these data blocks.

This process continues until there is a full backup file in the target backup repository.

- At subsequent backup copy intervals, Veeam Backup & Replication copies incremental restore points. If Veeam Backup & Replication fails to transport an incremental restore point, it marks the synchronization task as failed. Veeam Backup & Replication waits for the expiration of the backup copy interval; after that, Veeam Backup & Replication marks the job session as finished with the Error status.

Veeam Backup & Replication does not mark the backup copy job session with the Error status if the source backup job has not started during the backup copy interval of the backup copy job (that is, the backup copy job has nothing to copy to the target backup repository).

Change of the Backup Copy Interval Start Time

If you have selected to run a backup copy job with a daily backup copy interval, you must define the start time of the backup copy interval. However, you may want to change the start time afterwards. After the start time change, Veeam Backup & Replication behaves in the following manner:

1. Veeam Backup & Replication finishes the current backup copy interval running according to the 'old' start time value as usual.

2. After the current backup copy interval is over, Veeam Backup & Replication immediately starts the backup copy interval, not waiting for the 'new' start time point to come. At that, Veeam Backup & Replication "stretches" the started interval: the interval lasts for the time remaining till the new start time plus the time of the backup copy interval itself.

3. All subsequent backup copy intervals are created and started in a regular manner by the new schedule.
For example, when you first created a backup copy job, you set a daily backup copy interval with the start time at 8 AM. After that, you changed the start time to 10 AM. In this case, Veeam Backup & Replication will first finish the backup copy interval that is currently running — that is, the backup copy interval that was started at 8 AM — as usual. After that, it will immediately start a new backup copy interval. This interval will run for 26 hours — from 8 AM of the current day until 10 AM of the next day. All subsequent backup copy intervals will be started at 10 AM every day.

The first backup copy interval that is run after the start time change is typically longer than a regular one. This happens because of the backup copy interval "stretch" mentioned above. To start the synchronization process right away, you can use the Sync Now option after you change the start time value. In this case, Veeam Backup & Replication will behave in the following manner:

1. When you start the synchronization process manually, Veeam Backup & Replication forcibly finishes the current backup copy interval and begins a new backup copy interval according to the new start time value. This backup copy interval lasts until a new backup copy interval by the new schedule must be started.
2. All subsequent backup copy intervals are created and started in a regular manner.

As a result, the first backup copy interval after the start time change will begin immediately.

For example, when you first created a backup copy job, you set a daily backup copy interval with the start time at 8 AM. After that, you changed the start time to 10 AM. On the start time change, you started the manual synchronization process at 1 PM. In this case, Veeam Backup & Replication will finish the current backup copy interval — that is, the backup copy interval that was started at 8 AM — immediately at 1 PM. After that, it will start a new backup copy interval. This interval will run for 21 hours — from 1 PM of the current day until 10 AM of the next day. All subsequent backup copy intervals will be started at 10 AM every day.
Restore Point Selection

Veeam Backup & Replication always copies the most recent restore points, even if a backup copy job runs for the first time and source backup repositories already contain chains of restore points.

In the immediate copy mode, the most recent restore point is the latest complete restore point created by a source backup job.

In the periodic copy mode, Veeam Backup & Replication uses the backup copy interval to identify a restore point as the most recent one — the time of restore point creation must be greater or equal to the difference between the current time and the backup copy interval.

\[\text{Time of restore point creation} \geq \text{current time} - \text{backup copy interval}\]

Consider the following example. You create a backup copy job and set the backup copy interval to 24 hours. The source backup job will create a restore point on 6/30/2020 at 1:00 PM. The backup copy job will start on 7/1/2020, 12:00 PM. According to the rule, Veeam Backup & Replication will copy the created restore point:

\[6/30/2020, 1:00 \text{ PM} \geq 7/1/2020, 12:00 \text{ PM} - 24 \text{ hours}\]

If there are no restore points considered as recent, Veeam Backup & Replication does not copy data from source backup repositories. Instead, it waits for new restore points to appear. Only after that, Veeam Backup & Replication copies the most recent data blocks to the target repository.

In the periodic copy mode, you can also specify the search scope for restore points. For more information, see Select Machines to Process.

Limitations for Restore Points Selection

The following limitations apply when Veeam Backup & Replication selects restore points that must be copied to the target repository:

- Veeam Backup & Replication does not copy restore points from imported backups.
- Veeam Backup & Replication does not copy restore points that have already been copied by the same backup copy job to the target backup repository.
- Veeam Backup & Replication does not copy incomplete restore points.
- Veeam Backup & Replication does not copy restore points that are locked by the backup transformation process (merge, transform).
- A backup copy job does not copy a restore point if its data block size differs from the data block size of restore points that the job has already copied to the target backup repository. To copy restore points with the changed block size, you need to create active full backups. For details, see Change Storage Optimization Settings for Backup Copy Job.

For example, if you have changed the block size for restore points in the source backup job (the Storage optimization option in the Storage Settings), Veeam Backup & Replication will not copy newly created restore points and will display the Restore point is located in backup file with different block size message.
Transformation Processes

Veeam Backup & Replication can perform additional transformationations in the target backup repository after the backup copying task or at the end of the backup copy interval. Transformation processes are the following:

- **Backup chain transformation**
  When a new restore point is copied to the target backup repository, Veeam Backup & Replication checks the retention policy settings for the backup copy job. If the limit in restore points is exceeded, Veeam Backup & Replication transforms the backup chain to make room for a new restore point. For more information, see [Retention Policy for Backup Copy Jobs](#).

  After the transformation process, Veeam Backup & Replication can perform additional operations: remove data for deleted machines from the backup chain and compact a full backup file.

- **Removal of deleted items**
  In the backup copy job settings, you can select to maintain retention policy for deleted machines. In this case, Veeam Backup & Replication will check the list of machines included in the job and remove data for deleted machines from the backup chain in the target backup repository. For more information, see [Specifying Advanced Settings](#).

- **Full backup file compact**
  In the backup copy job settings, you can select to periodically compact a full backup file to reduce its size and increase the speed of read and write operations. For more information, see [Compact of Full Backup File](#).
Backup Copy Window

A backup copy window is a period of time when a backup copy job is allowed to transport data between source and target repositories.

By default, the backup copy window is configured to allow data transfer at any time. If you do not want the backup copy job to overlap the production hours, you can reduce the backup copy window and specify "prohibited" hours.

During the prohibited hours Veeam Backup & Replication cannot transfer data between source and target repositories. Other aspects of how Veeam Backup & Replication behaves during the prohibited hours and backup copy window depend on the selected backup copy mode. For more information, see Backup Copy Window and Prohibited Hours in Immediate Copy Mode and Backup Copy Window and Prohibited Hours in Periodic Copy Mode.

NOTE:
During the prohibited hours, Veeam Backup & Replication stops only data transferring operations. Transformation processes in the target repository are still performed. For more information, see Transformation Processes.

Backup Copy Window and Prohibited Hours in Immediate Copy Mode

When the prohibited hours start, Veeam Backup & Replication stops backup copy job sessions during which data transfer was not finished and assigns Failed to the session statuses. During the prohibited hours, Veeam Backup & Replication does not start new backup copy job sessions.

When the backup copy window starts, Veeam Backup & Replication transfers all restore points that were not transferred and creates as many incremental backup files as were omitted.

Backup Copy Window and Prohibited Hours in Periodic Copy Mode

How Veeam Backup & Replication behaves during the prohibited hours and backup copy window depend on the length of the backup copy interval:

- If the backup copy interval is longer than the duration of the prohibited hours, Veeam Backup & Replication puts backup copy job sessions to the Idle state and postpones data transfer operations. When the backup copy window starts, Veeam Backup & Replication renews data transfer.
If the backup copy interval is shorter than the duration of the prohibited hours, Veeam Backup & Replication finishes all backup copy job sessions and assigns *Failed* to the session statuses. During the first backup copy interval on the backup copy window, Veeam Backup & Replication aggregates all data changes between the latest restore point on the target backup repository and latest restore point in the source backup repository. Then, Veeam Backup & Replication transfers these changes to the target repository and writes them into one restore point.
Retention Policy for Backup Copy Jobs

The retention policy of a backup copy job does not depend on retention policy settings of the source backup job. The backup copy job has its own retention policy settings. The retention policy of a backup copy job defines for how long Veeam Backup & Replication must retain copied restore points in the target backup repository.

Veeam Backup & Replication offers two retention policy schemes for backup copy jobs:

- **Simple Retention Policy**
- **GFS Retention Policy**

**Simple Retention Policy**

A simple retention policy scheme is intended for short-time archiving. When you specify retention policy settings for a simple scheme, you define how many restore points you want to retain in the target backup repository.

With the simple retention policy scheme, Veeam Backup & Replication creates a forever forward incremental chain. In this chain, restore points subsequently follow one another. The first restore point in the chain is always a full backup (also known as a recent full backup). All other restore points in the chain are incremental backups.

By default, Veeam Backup & Replication keeps 7 restore points in the target backup repository.

**NOTE:**

The minimum number of restore points that you can keep with the simple retention policy scheme is 2.

To maintain the desired number of restore points in the backup chain, Veeam Backup & Replication uses the forever forward incremental scheme. For details on how the forever forward incremental retention policy works, see [Forever Forward Incremental Backup Retention Policy](#).

**GFS Retention Policy**

In most cases, simple backup retention policy is not enough. You cannot store an unlimited number of restore points in the target backup repository forever — it is not rational and is resource consuming. If you want to retain copied data for longer periods of time, you can enable the GFS retention policy scheme for backup copy jobs.

The GFS, or Grandfather-Father-Son retention policy is a backup rotation scheme intended for long-term archiving. It lets you keep backups of machines for an entire year and requires minimum amount of storage space. GFS backups are always full backup files that contain data of the whole machine image as of specific date.
GFS is a tiered retention policy scheme. It uses a number of cycles to retain backups for different periods of time:

- Regular backup cycle
- Weekly backup cycle
- Monthly backup cycle
- Quarterly backup cycle
- Yearly backup cycle

In the GFS retention policy scheme, weekly backups are known as ‘sons’, monthly backups are known as ‘fathers’ and yearly backup are known as ‘grandfathers’. Additionally, Veeam Backup & Replication maintains quarterly backups. Weekly, monthly, quarterly and yearly backups are also called archive backups.

**IMPORTANT!**

You cannot enable GFS retention settings if you use a backup repository with rotated drives as the target backup repository.

Methods for Archive Backups Creation

You can instruct Veeam Backup & Replication to create archive full backups with the following methods:

- **Synthetic full method** — Veeam Backup & Replication synthesizes archive full backups using restore points in the target backup repository.
- **Active full method** — Veeam Backup & Replication copies data for archive full backups from the source backup repository. This method is available only for the periodic copy mode.

Synthetic Full Method for Archive Backups

The synthetic full backup is the default method to create archive full backups. Veeam Backup & Replication does not copy data for archive full backups from the source backup repository. It synthesizes archive full backups from backup files that are already stored in the target backup repository. This approach helps reduce load on the network and production environment.
NOTE:
The synthetic full method is not recommended if you use a deduplication storage appliance as a target backup repository. Performing a synthetic full backup in such repositories requires additional time and resources to download and decompress backup data blocks.

This recommendation does not apply to HPE StoreOnce, Dell EMC Data Domain and ExaGrid:

- HPE StoreOnce and Dell EMC Data Domain use virtual synthetics. Veeam Backup & Replication creates archive full backups by virtually synthesizing data blocks from existing backup files.
- ExaGrid uses adaptive deduplication. Veeam Backup & Replication creates archive full backups from existing backup files that are stored in complete form in ExaGrid high-speed cache.

Active Full Method for Archive Backups

You can instruct Veeam Backup & Replication to create archive full backups (backups retained by the GFS scheme) with the active full backup method. The active full backup method is recommended if you use a deduplicating storage appliance as the target backup repository. Active full backup helps improve the backup copy job performance and reduce the load on the target backup repository.

By default, Veeam Backup & Replication uses the synthetic backup method to create archive full backups. However, synthesizing archive full backups can cause problems with storage performance on deduplicating storage appliances. Deduplicating storage appliances are optimized for sequential data access. The synthetic backup creation, however, takes random I/O operations — Veeam Backup & Replication reads data from existing backup files and writes data to the synthesized archive full backup file. As a result, the storage performance can degrade.

In addition, backups reside in the target backup repository in the deduplicated and compressed state. Before creating synthetic full backups, Veeam Backup & Replication needs to download and decompress data blocks of backups, which requires additional time and resources.
NOTE:

Mind the following:

- The active full backup method does not always copy the most recent restore point from the source backup repository. If the recent restore point is not created by the time the GFS task must start, Veeam Backup & Replication copies the latest available restore point from the source backup repository.

- If Veeam Backup & Replication does not manage to transfer the restore point during the backup interval, the interval is extended to finalize the transfer.

Retention Policy for Active Full Archive Backups

If you enable the Read the entire restore point from source instead of synthesizing it from increments option, Veeam Backup & Replication stops transforming the backup chain with every backup copy interval, and no longer uses the forever forward incremental backup method to maintain the desired number of restore points in the backup chain. Instead, it applies to the backup chain retention rules similar to the forward incremental backup method. For more information, see Forward Incremental Backup Retention Policy.

Veeam Backup & Replication waits until the number of restore points in the new backup chain equals the number of restore points specified in the retention policy settings, and then removes restore points from the previous backup chain. Archive full backups remain on disk because Veeam Backup & Replication applies a separate retention policy scheme to archive full backups.

NOTE

Veeam Backup & Replication ignores archive full backups when determining whether the number of restore points specified in the retention policy settings is reached.
For example, you have configured a backup copy job in the following way:

- The backup copy job starts on Sunday; the backup copy interval is equal to 1 day and starts at 12:00 AM.
- Simple retention policy is set to 4.
- Weekly full backups are enabled, Thursday is selected in the full backup schedule settings.
- The Read the entire restore point from source instead of synthesizing it from increments option is enabled.

Veeam Backup & Replication will run the backup copy job in the following way:

1. During the first 4 backup copy intervals, Sunday through Wednesday, Veeam Backup & Replication will create a full backup and 3 incremental backups.
2. On Thursday, Veeam Backup & Replication will add a weekly full backup to the backup chain.
   
   **IMPORTANT!**
   If the daily interval start time is different from 12:00 AM, Veeam Backup & Replication will create a weekly full backup 1 day prior to the day selected in the full backup schedule settings. For more information, see Active Weekly Full Backups.

3. Friday through Monday, Veeam Backup & Replication will add incremental backups to the new backup chain. On Monday, Veeam Backup & Replication will remove the whole previous backup chain.

4. Veeam Backup & Replication will keep on adding incremental backups to the backup chain until the next Thursday. On Thursday, Veeam Backup & Replication will create a new weekly full backup.

5. Friday through Sunday, Veeam Backup & Replication will add incremental backups to the new backup chain.

6. On Monday, Veeam Backup & Replication will add a new incremental backup to the new backup chain, and remove incremental backups from the previous backup chain. The weekly full backup will remain on disk.

**Switching Between Synthetic and Active Full Modes**

In some cases, you may want to change the algorithm of archive full backup creation. You can perform the following operations:

- Switch from the synthetic to the active full mode
- Switch from the active full to the synthetic mode
Switching from Synthetic to Active Full Method

After you switch from the synthetic to the active full method of archive backup creation, Veeam Backup & Replication does not perform synthetic transformation processes for some time. Veeam Backup & Replication works in the following way:

1. Veeam Backup & Replication will add new incremental restore points to the backup chain and keeps existing restore points until a new active full backup is created.

2. Veeam Backup & Replication will add a new active full backup to the backup chain.

3. Veeam Backup & Replication will keep adding new incremental restore points to the backup chain. When the number of restore points in the new backup chain is equal to the number allowed by retention, Veeam Backup & Replication will remove incremental restore points that precede the new active full backup.

After this, Veeam Backup & Replication will use the new method to create the backup chain in a regular manner.

Switching from Active Full to Synthetic Method

Scenario 1. The backup chain does not contain archive full backup files

In this case, Veeam Backup & Replication will work by the standard archive full backup scheme. For more information, see Weekly Backup Cycle.

Scenario 2. The backup chain contains full backups (recent or archive)
After you switch from the active full to the synthetic method of archive backup creation, Veeam Backup & Replication works in the following way:

1. During the first backup copy interval after the switch, Veeam Backup & Replication will add a new incremental restore point to the recent backup chain.

2. Veeam Backup & Replication will keep adding new incremental restore points to the recent backup chain. When the number of restore points in the recent backup chain is equal to the number allowed by retention, Veeam Backup & Replication will build a recent full backup out of the latest archive full and the first incremental restore point in the new backup chain.

   After that, Veeam Backup & Replication will remove all incremental restore points from preceding backup chains. If there are any outdated archive full backups, Veeam Backup & Replication will remove them, too.

Subsequent backup copy intervals work according to the standard retention scheme for the synthetic full method of archive backups. For more information, see Weekly Backup Cycle.

**NOTE:**

Veeam Backup & Replication normally creates one archive full backup per GFS cycle. However, when you switch from active to synthetic backup method or change scheduling settings for synthetic full backups, Veeam Backup & Replication will create and keep in the backup chain two archive full backups marked with the same flag. For details, see Archive Full Backups per GFS Cycle.

### GFS Cycles

Veeam Backup & Replication uses a number of cycles to retain backups for different periods of time according to the GFS retention scheme:

- Regular backup cycle
- Weekly backup cycle
- Monthly backup cycle
- Quarterly backup cycle
Yearly backup cycle

IMPORTANT!
The full backup can be marked as weekly, monthly, quarterly and/or yearly. When transforming weekly, monthly, quarterly and yearly backup chains, Veeam Backup & Replication checks flags set for the full backup file. If the full backup file belongs to some other retention policy tier and must be retained in the target backup repository, such backup file will not be removed.

Regular Backup Cycle

The regular backup cycle is based on the simple retention policy scheme. When you specify retention policy settings, you define how many restore points you want to retain in the backup chain in the target backup repository.

Veeam Backup & Replication runs the regular backup cycle in the following way:

1. During the first backup copy session, Veeam Backup & Replication creates the first restore point — a full backup.
2. The next backup copy sessions add incremental backups to the backup chain.

As a result, the regular backup cycle produces a chain of a full backup and set of incremental backups in the target backup repository.

For example, you have selected to retain 7 restore points. The backup copy runs once a day and starts on Sunday. Veeam Backup & Replication will create a full backup on Sunday and add 6 incremental backups Monday through Saturday.

Weekly Backup Cycle

In the GFS scheme, the weekly backup is created during the weekly backup cycle.

Weekly backup cycles always produce full backup files that contain data of the whole machine image as of specific date. When you define retention policy settings for the weekly backup cycle, you specify how many weekly backups you want to retain and define the week day on which the weekly full backup must be created.

Veeam Backup & Replication creates weekly full backups for synthetic and active full backup methods in different ways:

- Synthetic weekly full backups
- Active weekly full backups
Synthetic Weekly Full Backups

Veeam Backup & Replication does not use a separate task to create weekly full backups. Veeam Backup & Replication re-uses a full backup created in the regular backup cycle and propagates this full backup to the weekly tier.

Veeam Backup & Replication creates a weekly full backup in the following way:

1. Veeam Backup & Replication creates a chain of backups in the regular backup cycle. The chain consists of a full backup and set of subsequent incremental backups.

   For example, you have selected to keep 7 restore points. The backup copy runs once a day and starts on Sunday. During the week, Veeam Backup & Replication creates a backup chain in the target backup repository. The backup chain consists of a full backup copied on Sunday and a set of incremental backups copied Monday through Saturday.

2. With every new backup copy run, Veeam Backup & Replication transforms the backup chain and moves the full backup forward. This procedure repeats until the full backup file reaches the day when the weekly backup is scheduled.

3. During the backup copy session on this day, Veeam Backup & Replication transforms the backup chain and creates a weekly full backup at the same time. This process is performed in the following way:
   a. Veeam Backup & Replication adds a new restore point to the backup chain.
   b. As the allowed number of restore points is exceeded, Veeam Backup & Replication transforms the backup chain. The transformation process slightly differs from a regular one. Veeam Backup & Replication does not inject data from the incremental backup to the full backup. Instead, it copies data from full and incremental backups and stores them to a new full backup file, next to the primary backup file.

4. The incremental backup from which data was copied is removed as obsolete.

5. The primary full backup file remains in the target backup repository. Veeam Backup & Replication sets it aside and marks it as a weekly full backup. The weekly backup is no longer used in the backup chain.
6. The newly created full backup file remains in the backup chain and is used as a starting point for incremental backups created by the regular backup cycle.

For example, weekly backup is scheduled on Monday. Veeam Backup & Replication will keep transforming the backup chain until the full backup file reaches Monday. During the next backup copy sessions, Veeam Backup & Replication will transform the backup chain. To do that, it will copy data from the Monday full backup and Tuesday incremental backup to a new full backup file and store it next to the primary full backup file.

As a result, in the target backup repository you will have a full backup created on Monday and a backup chain that includes a full backup as of Tuesday and a chain of increments Wednesday through Monday. The full backup as of Monday will be marked as a weekly backup and set aside. The full backup as of Tuesday will be used as a new starting point in the backup chain.

NOTE:
Veeam Backup & Replication normally creates one archive full backup per GFS cycle. However, when you switch from active to synthetic backup method or change scheduling settings for synthetic full backups, Veeam Backup & Replication will create and keep in the backup chain two archive full backups marked with the same flag. For details, see Archive Full Backups per GFS Cycle.

Active Weekly Full Backups

Veeam Backup & Replication copies data from the source backup repository and saves it to the full backup file in the target backup repository. The created full backup file is marked as a weekly full backup.

Weekly Full Backup Creation

To let Veeam Backup & Replication create active weekly full backups, you must configure the full backup schedule settings for the backup copy job. For more information, see Define Backup Copy Target.

When you select the day in the full backup schedule settings, Veeam Backup & Replication understands 12:00 AM on this day as a reference point for creating full backups. For example, you selected Thursday. The reference point for Thursday is "Thursday, 12:00 AM".

For backup copy jobs with backup copy intervals of 1 day, Veeam Backup & Replication creates weekly full backups by the following rules:

- If the backup copy interval start time is different from 12:00 AM, the full backup is created 1 day prior to the selected day.
- If the backup copy interval start time is 12:00 AM, the full backup is created on the selected day.

Scenario A

You have configured the backup copy job schedule settings in the following way:

- The backup copy job starts on Sunday; the backup copy interval is equal to 1 day and starts at 8:00 AM.
You selected Thursday as the day when weekly full backups must be created. Veeam Backup & Replication will perform the backup copy job in the following way:

1. The backup copy job will create a full backup on its first run.
2. Veeam Backup & Replication will check if "Thursday, 12:00 AM" reference point lies within the backup copy interval:
   a. Backup copy intervals that start on Monday and Tuesday do not include the reference point. Veeam Backup & Replication adds incremental backups to the backup chain on these days.
   b. Veeam Backup & Replication extends the interval from "Wednesday 08:00 AM - Thursday 08:00 AM" to "Wednesday 00:00 AM - Thursday 08:00 AM".
      Veeam Backup & Replication detects that "Thursday, 00:00 AM" reference point lies within the backup copy interval "Wednesday 00:00 AM - Thursday 08:00 AM" and creates a weekly full backup on Wednesday.
   c. On Thursday Veeam Backup & Replication adds an incremental backup.

Scenario B

You have configured the backup copy job schedule settings in the following way:

- The backup copy job starts on Sunday; the backup copy interval is equal to 1 day and starts at 12:00 AM.
- You selected Thursday as the day when weekly full backups must be created.

Veeam Backup & Replication will perform the backup copy job in the following way:

1. The backup copy job will create a full backup on its first run.
2. Veeam Backup & Replication will check if "Thursday, 12:00 AM" reference point lies within the backup copy interval:
   a. Backup copy intervals that start on Monday, Tuesday and Wednesday do not include the reference point.
      Veeam Backup & Replication adds incremental backups to the backup chain on these days.
Veeam Backup & Replication detects that "Thursday, 12:00 AM" reference point is the same as the "Thursday 00:00 AM - Friday 00:00 AM" interval start time and creates a weekly full backup on Thursday.

Veeam Backup & Replication repeats the weekly backup cycle until the number of weekly backups allowed by the retention policy is exceeded. After that, Veeam Backup & Replication removes the earliest active weekly full backup from the target backup repository to make room for the most recent active weekly full backup.

Veeam Backup & Replication treats active weekly full backups as regular full backups, and applies regular retention policy rules to maintain the necessary number of restore points in the backup chain. For more information, see Retention Policy for Active Full Archive Backups.

Related Topics
- Backup Copy Intervals
- Retention Policy for Active Full Archive Backups

Restore Point Selection for Weekly Backup (Synthetic Method)

Typically, when a weekly full backup is created, Veeam Backup & Replication takes a full backup as of this day and marks it as a weekly backup. In some cases, however, Veeam Backup & Replication may fail to find a full backup on the day when the weekly backup is scheduled. In this situation, Veeam Backup & Replication will use the nearest full backup file created within the next backup copy session.

For example, your backup copy job runs once a week and starts on Sunday. As a result, a new restore point is created every Sunday. When Veeam Backup & Replication transforms the backup chain, the full backup moves from the previous Sunday to the next Sunday.
Imagine the weekly backup is scheduled on Wednesday. As all backups are created on Sunday, Veeam Backup & Replication will not find a full backup as of Wednesday. For this reason, it will use the full backup from the next backup copy session — a full backup as of Sunday.

### Monthly, Quarterly and Yearly Backup Cycles

Monthly, quarterly and yearly backup cycles use the same algorithms as the weekly backup cycle. When you define retention policy settings for these backup cycles, you specify how many backups you want to retain and define the weekday on which the monthly, quarterly or yearly backup must be created.

Veeam Backup & Replication repeats the monthly, quarterly or yearly backup cycle until the number of backups allowed by the retention policy is exceeded. After that, Veeam Backup & Replication removes the earliest full backup from the target backup repository to make room for the most recent monthly, quarterly or yearly backup.

### Concurrent Archive Full Schedule

If you schedule a monthly, quarterly or yearly full backup on the same day when the weekly full backup is scheduled, Veeam Backup & Replication will create only one archive full backup — the weekly backup. The created weekly backup will be marked at the same time as monthly, quarterly or yearly GFS backup. In the Veeam Backup & Replication console, you will see all GFS flags assigned to the backup. In the file system, however, the file will be visible as having only one GFS flag — the flag of the highest GFS tier. For example, if you schedule weekly and yearly backup on the same day, the backup file will be marked as yearly in the file system.

### Minutely and Hourly Backup Copy Intervals

The following information is actual for the active full method.

If the backup copy interval is less than 1 day, Veeam Backup & Replication creates the archive full backup during the backup copy interval when the weekly full backup is scheduled. In the Veeam Backup & Replication console, the created archive backup is marked with all necessary GFS flags.

For example, you have scheduled both weekly and monthly full backups on Sunday. The backup copy interval is set to 3 hours and starts at 5:00 PM on Saturday. That is, backup copy intervals take place on Saturday at 5:00 PM, 8:00 PM, 11:00 PM, on Sunday at 2:00 AM, 5:00 AM and so on.

Before creating an archive full backup, Veeam Backup & Replication checks if the "Sunday, 12:00 AM" point in time lies within a current backup copy interval. If so, Veeam Backup & Replication creates an archive full backup. In this example, Veeam Backup & Replication will create an archive full backup during the backup copy interval "Saturday, 11:00 PM – Sunday, 2:00 AM". The created archive full backup will be marked with weekly and monthly flags.
Expected GFS Schedule for Active Full Method

If you use the active full method, mind that archive backups may not be created as you expect. For example, you configure the GFS schedule for a backup copy job in the following way:

- Weekly backups are created regularly, for example, on Sundays.
- Yearly backups are not created.

After some time passes, you change the GFS schedule and enable yearly backups for the backup copy job. You may expect that Veeam Backup & Replication marks a weekly backup, that has already been created, as a yearly one. That is, the existing archive backup will have weekly and yearly GFS flags.

However, with the active full method, Veeam Backup & Replication never marks full backups, that have already been set aside as archive backups, with additional GFS flags. In the described situation, Veeam Backup & Replication will not mark an existing archive backup as yearly. Veeam Backup & Replication will create a yearly backup only during the next yearly cycle — in the next year.

To overcome this behavior and create a yearly backup during the current yearly cycle, you must schedule a yearly backup so that it coincides with the active backup copy chain (backup chain created during a regular backup copy cycle). In this case, Veeam Backup & Replication will assign the yearly flag when it sets a full backup aside as a yearly one. After a full backup is marked as yearly and set aside, you can change the yearly GFS schedule as required.

The described behavior is specific only for archived backups created with the active full method, and is applicable to all GFS cycles — monthly, quarterly and yearly.

NOTE:

Veeam Backup & Replication normally creates one archive full backup per GFS cycle. However, when you switch from active to synthetic backup method or change scheduling settings for synthetic full backups, Veeam Backup & Replication will create and keep in the backup chain two archive full backups marked with the same flag. For details, see Archive Full Backups per GFS Cycle.
Archive Full Backups per GFS Cycle

Veeam Backup & Replication normally creates one archive full backup per GFS cycle. However, Veeam Backup & Replication will create and keep in the backup chain two archive full backups marked with the same flag in the following cases:

- If you switch from active to synthetic backup method
- If you change scheduling settings for synthetic full backups

Two archive full backups will be created only for one GFS cycle — the GFS cycle when you switched the backup method or changed scheduling settings. In terms of retention policy, these backups are regarded as one. When the allowed number of archive full backups is exceeded, Veeam Backup & Replication removes both backups at the same time from the backup chain.

For example, you instruct a backup copy job to create weekly full backups on Monday. After a weekly full backup is created, you change scheduling settings for weekly full backups to Thursday. In this case, Veeam Backup & Replication will create a new weekly full backup on Thursday. During subsequent weeks, the backup copy job will produce weekly full backups only on Thursday. When the allowed number of weekly full backups is exceeded, Veeam Backup & Replication will remove two weekly full backups created for the week when you changed scheduling settings.

The described behavior is applicable to all GFS cycles — weekly, monthly, quarterly and yearly.

Deleted Items Retention

After you configure a backup copy job, you may want to change something in the virtual infrastructure. For example, you may decommission some virtual or physical machines or move VMs to another location. You may also exclude VMs from the backup copy job that has already run for some time.
By default, when you remove a machine protected by Veeam Backup & Replication from the virtual infrastructure, exclude a machine from the backup copy job or stop protecting a machine with Veeam Agent, the copied data still remains in backup files in the target backup repository. To avoid keeping redundant data on disk, you can enable the **Remove deleted items data after** option in the backup copy job settings. With this option enabled, at the end of every synchronization cycle Veeam Backup & Replication will remove data for deleted machines from backup files in the target backup repository.

Veeam Backup & Replication removes data for deleted machine only if two conditions are met:

1. Veeam Backup & Replication has not created a valid restore points for the deleted machine for the number of days specified in the **Remove deleted items data after** field.

2. The backup chain in the target backup repository does not contain any successful incremental restore points for the deleted machine.

This approach helps ensure that data for deleted machines can be saved by the GFS retention.

For example:

- The retention for the backup copy job is set to 7.
- The retention period for deleted machine is set to 3 days.

The backup copy job has created 3 successful restore points — a full backup and two incremental backups. During the next 4 days, no successful restore points were created. At the next synchronization cycle, Veeam Backup & Replication will not remove data for the deleted machine from the target backup repository as the backup chain contains successful incremental restore points for this machine.
IMPORTANT!

Mind the following:

- The deleted items retention applies only to regular backup chains. Veeam Backup & Replication does not remove data for deleted machines from weekly, monthly, quarterly and yearly backups.
- When Veeam Backup & Replication removes data for deleted machines from regular backup chains, it does not free up space in the backup repository. It marks the space as available to be overwritten, and this space is overwritten during subsequent job sessions or the backup file compact operation.
- When Veeam Backup & Replication removes data for deleted machines from per-VM backup chains, it does not mark the space as available but deletes backup files since they contain data for 1 machine only.

Veeam Backup & Replication does not analyze the reason for which the machine has not been processed during the backup copy session. For example, a VM may be regarded as deleted if Veeam Backup & Replication has failed to obtain data for the VM from the virtual infrastructure, the VM has failed to be processed in time during the backup copy session and so on.

For this reason, you must be careful when specifying the retention period for deleted machines. If the retention period is too short, Veeam Backup & Replication may remove from the backup chain restore points that you still require.

For example, a backup copy job is configured to process 2 VMs and has the following settings:

- The backup copy starts once a day.
- The retention for the backup copy job is set to 2.
- The retention period for deleted VMs is set to 1 day.

The backup copy job runs in the following way:

1. On Sunday, the backup copy job creates a full backup for 2 VMs – VM1 and VM2.
2. On Monday, the backup copy job creates an incremental backup for VM1. The backup copy job does not manage to process VM2 in time.
3. On Tuesday, the backup copy job creates an incremental backup for VM1. The backup copy job does not manage to process VM2 in time.
4. At the end of the backup copy job session on Tuesday, Veeam Backup & Replication transforms the backup chain and detects deleted VMs. Veeam Backup & Replication regards VM2 as a deleted VM – the deleted VMs retention is set to 1 day, and after transformation, there are no valid restore points for this VM in the backup chain.

As a result, after the backup copy session on Tuesday backup files in the target backup repository will not contain data for VM2.

![Diagram showing the backup process and deleted VMs retention](image-url)
Health Check for Backup Files

You can instruct Veeam Backup & Replication to periodically perform a health check for the latest restore point or backup file in the backup chain. The health check helps Veeam Backup & Replication make sure that further restore will be possible.

The health check starts as soon as a backup copy job starts. The health check verifies restore points (full backup files or related full and incremental backup files). Only the latest restore points are verified. On the day when the health check is scheduled, Veeam Backup & Replication performs the health check only once, even if the backup copy job runs several times.

Note that the health check process differs for backup files stored in the HPE StoreOnce repository. For details, see Health Check for Backup Files Stored on HPE StoreOnce.

NOTE:
If you perform the health check for the encrypted backup files, Veeam Backup & Replication will pass encryption keys to the regular backup repository or cloud repository. For more information on encryption, see Data Encryption.

How Health Check Works

Veeam Backup & Replication performs the health check in the following way:

1. As soon as a restore point is saved to the backup repository, Veeam Backup & Replication calculates CRC values for backup metadata and hash values for data blocks of a disk in the backup file and saves these values in the metadata of the backup file, together with copied data.

2. On the day when the health check is scheduled, Veeam Backup & Replication performs the following actions:
   a. At the beginning of the backup copy session, Veeam Backup & Replication performs the health check for the latest restore point in the backup chain. If the latest restore point in the backup chain is incomplete, Veeam Backup & Replication checks the restore point preceding the latest one.

      Veeam Backup & Replication calculates CRC values for backup metadata and hash values for disks data blocks in the backup file and compares them with the CRC and hash values that are already stored in the backup file.

   b. If the health check detects corrupted data blocks, together with data blocks for the new restore point, Veeam Backup & Replication transports valid data blocks for the corrupted restore point. The valid data blocks are stored to the new incremental restore point created with this backup copy session. As a result, the backup chain gets “fixed”, and you get a possibility to restore data from restore points following the corrupted restore point.
NOTE:
If the backup copy job uses WAN accelerators, Veeam Backup & Replication attempts to find data blocks in the global cache not to transfer data over the network. For more information, see WAN Acceleration.

Health Check for Backup Files Stored on HPE StoreOnce

The health check starts as soon as a backup copy job transfers backup files to the target repository. The health check verifies backup files, not restore points, and only those backup files transferred during the current job session.

How Health Check Works

Veeam Backup & Replication performs the health check in the following way:

1. As soon as a backup file is transferred to the target repository, Veeam Backup & Replication calls the HPE StoreOnce internal method that calculates checksums for data blocks of this backup file.
   
   The checksum calculation requires the rehydration of the verified data. This may lower the performance on the target repository especially during the first backup copy session. During this session, the health check verifies all backup files in source backup chains.

2. Veeam Backup & Replication compares the calculated checksums and the checksums already stored in the backup file.

3. If the health check detects corrupted data blocks, Veeam Backup & Replication deletes the backup file from the target repository. On the next backup copy job session, Veeam Backup & Replication transfers and performs the health check for this file again.
Compact of Full Backup File

The backup copy job constantly transforms the full backup file in the backup chain to meet retention policy settings. The transformation process, however, has a side effect. In the long run, the full backup file grows large and gets fragmented. The file data occurs to be written to non-contiguous clusters on disk, and operations of reading and writing data from and to the backup file slow down.

To resolve the fragmentation problem, you can instruct Veeam Backup & Replication to compact the full backup file periodically. During the file compact operation, Veeam Backup & Replication creates a new full backup file in the target repository: it copies existing data blocks from the old backup file, rearranges and stores them close to each other. As a result, the full backup file gets defragmented, its size reduces and the speed of reading and writing from and to the file increases.

To compact the full backup file periodically, you must enable the Defragment and compact full backup file option in the backup copy job settings and define the compact operation schedule. By default, the compact operation is performed on the last Sunday of every month. You can change the compact operation schedule and instruct Veeam Backup & Replication to perform it weekly or monthly on specific days.
Backup Copy Job Mapping

Backup copy job mapping helps you reduce the amount of data transferred over network and decrease the load on WAN accelerators or slow connections.

If you use the target backup repository also as a target for other backup copy or backup jobs, you can already have a backup of machines that you want to copy. In this case, you can map the backup copy job to this backup.

A backup copy job mapped to a backup is performed in the following way:

1. Veeam Backup & Replication accesses a backup to which you map the backup copy job. The backup may have any number of restore points in the chain. This backup chain will be used as a seed for the further backup copying process.

2. During subsequent backup copy sessions, Veeam Backup & Replication copies restore points in a regular manner. It copies only incremental changes and stores them as new restore points next to the seed backup chain.

A mapped backup copy job does not store copied restore points in a dedicated folder in the target backup repository. Instead, it stores restore points to the same folder where the "seed" backup chain resides.

Creating Seed for Backup Copy Job

Backup copy jobs have limitations for backups that can be used as seeds. The limitations are listed in the Map Backup File section.

To overcome these limitations, you can create a seed using a secondary backup copy job. To create a seed for the primary backup copy job, do the following:

1. Create a backup copy job. Add machines or backups whose restore points you want to copy to this backup copy job. Target the backup copy job to some backup repository on the source side. This backup repository will be used as an intermediate one.

2. Run the backup copy job to create a full backup file (VBK) in the intermediate backup repository.

3. Transfer the created VBK file and VBM file from the intermediate backup repository to the target backup repository.

4. Perform repository rescan to populate the target backup repository.

If the initial backup file was encrypted, you must enter a password to unlock the full backup file. Otherwise, Veeam Backup & Replication will not display the full backup file in the list of backups in the backup repository. For more information, see Importing Encrypted Backups.
5. Remap the backup copy job to the full backup file that you have created and transferred to the target backup repository.

6. Click **Sync Now** to start the backup copy.

As a result, Veeam Backup & Replication will use the full backup file as a seed. When a new restore point for the machine is available in the source backup repository, Veeam Backup & Replication will copy the restore point to the target backup repository and store it next to the full backup seed.

### Specifying Backup Copy Interval for Periodic Copy Mode

When you configure a backup copy job, make sure that its backup copy interval covers the whole chain of restore points in the backup repository from which you plan to copy backups. The length of the backup copy interval has an impact on the algorithm of restore point selection. Veeam Backup & Replication copies only restore points that match the following criterion:

\[
\text{Time of restore point creation} \geq \text{current time} - \text{backup copy interval}
\]

That is, if you have a backup chain whose earliest restore point is 1 week old, you need to set the backup copy interval to 1 week. If you set the backup copy interval to a smaller time interval, for example, 1 day, all restore points that are older than 1 day will fall out of the search scope, and Veeam Backup & Replication will not transfer such restore points. For more information, see **Restore Point Selection**.
Active Full Backup Copies

You can manually create an ad-hoc full backup for the backup copy job — active full backup copy, and add it to the backup chain in the target backup repository. To do this, you can use the Active Full button on the ribbon or the Active Full command from the shortcut menu.

Active full backup copy can be helpful if you want to change backup copy job settings, for example, enable or disable encryption. Veeam Backup & Replication will apply new settings starting from this full backup.

Veeam Backup & Replication treats archive full backups created with the active full backup method as regular backups and applies regular retention policy rules to maintain the necessary number of restore points.

Retention Policy for Active Full Backups

If you create active full backups for backup copy jobs, Veeam Backup & Replication applies to the backup chain retention rules of the forward incremental backup method. Veeam Backup & Replication waits until the number of restore points in the new backup chain is equal to the retention policy setting, and then removes the previous backup chain on the whole. For more information, see Retention for Forward Incremental Backup.

If you additionally use the GFS retention scheme for the backup copy job, Veeam Backup & Replication behaves in a different way. After the number of restore points in the new backup chain is equal to the retention policy setting, Veeam Backup & Replication merges restore points in the previous backup chain to the restore point that must be marked as an archive backup. When the archive restore point is set aside, Veeam Backup & Replication uses the standard scheme described above.
Automatic Job Retries

Veeam Backup & Replication automatically retries several operations that are performed within a backup copy job session.

Job Tasks Retry

By default, Veeam Backup & Replication automatically retries a failed backup copy task 5 times within one backup copy job session. A new task is started immediately after the previous one, without any interval.

The backup copy task is retried only if the previous task has failed and a restore point has not been copied to the target backup repository. Veeam Backup & Replication does not perform a retry if a task has finished with the Success or the Warning status.

The backup copy task is retried during the same backup copy session only. If a restore point fails to be copied during all retries in the current backup copy session, Veeam Backup & Replication marks the current task as failed. In case of the periodic copy mode, Veeam Backup & Replication also waits for the expiration of the backup copy interval. After that, Veeam Backup & Replication performs the necessary transformation processes and starts a new backup copy session.

A backup copy job can process several machines. If only some machines are successfully processed by the backup copy task, Veeam Backup & Replication creates a restore point holding data for these machines in the target backup repository. Veeam Backup & Replication will attempt to process restore points for all machines during the next backup copy session.

NOTE:

Some errors from WAN accelerators can block backup copy job retries. For example, if there is no space in the global cache on the target WAN accelerator, Veeam Backup & Replication puts backup copy operations on hold and waits for the expiration of the backup copy session.

Transformation Retry

After the backup copying task, Veeam Backup & Replication may perform a number of additional transformation processes in the target backup repository. These processes include the backup chain transformation, removing of deleted machines from restore points and compacting a full backup file. For more information, see Transformation Processes.

Veeam Backup & Replication may fail to perform transformation: for example, if the backup file in the target backup repository is locked by the file-level restore session. By default, Veeam Backup & Replication automatically retries transformation processes for 5 times. The first interval between retries is 1 minute; the interval doubles with every new attempt. If all retries of transformation processes fail, Veeam Backup & Replication does the following:

- [For the immediate copy mode] Stops the job with the Fail status and waits for the new job session.
- [For the periodic copy mode] Puts the job to the idle state and waits for the new backup copy interval to begin.

Virtual Infrastructure Access Retry

At the beginning of every backup copy session, Veeam Backup & Replication accesses the virtual infrastructure to make up a list of machines processed by the job.
Veeam Backup & Replication may fail to access the virtual infrastructure for some reason: for example, in case the Hyper-V host is not responding. By default, Veeam Backup & Replication automatically retries access operations for 5 times with a 5 minute interval.
Creating Backup Copy Jobs for VMs and Physical Machines

To copy backups to a secondary location, you must configure a backup copy job. The backup copy job defines how, where and when to copy backups. One job can be used to process backups of one or more workloads.

**NOTE:**

If you want to copy backups between HPE StoreOnce repositories, follow the instructions listed in *Creating Backup Copy Jobs for HPE StoreOnce Repositories.*

If you want to copy file share backups, follow the instructions listed in *Creating File Share Backup Jobs.*

Before you create a job, check prerequisites. Then use the **New Backup Copy Job** wizard to configure the backup copy job.
Before You Begin

Before you create a backup copy job, check the following prerequisites:

- Backup infrastructure components that will take part in the backup copy process must be added to the backup infrastructure. This includes the target backup repository to which backups must be copied. For more information on adding components, see Backup Infrastructure Components.

- If you plan to use pre-job and/or post-job scripts, you must create scripts before you configure the backup copy job.

- If you plan to use WAN accelerators, check that you use the Enterprise Plus edition of Veeam Backup & Replication and that target and source WAN accelerators are added to the backup infrastructure. For more information, see Adding WAN Accelerators.
Step 1. Launch New Backup Copy Job Wizard

To run the New Backup Copy Job wizard, do one of the following:

- On the Home tab, click Backup Copy and select a platform:
  - Virtual Machine > Microsoft Hyper-V backup
  - Windows computer backup
  - Linux computer backup
  - Solaris x86 backup
  - Solaris SPARC backup
  - AWS EC2 backup
  - Azure IaaS backup
  - Nutanix backup

- Open the Home view, in the inventory pane right-click Jobs or right-click anywhere in the working area, and select the necessary option:
  - Backup copy > Virtual machine > Microsoft Hyper-V backup — if you want to create a copy of a VM backup.
  - Backup copy > Windows computer backup — if you want to create a copy of a Veeam Agent backup created for Microsoft Windows machines.
  - Backup copy > Linux computer backup — if you want to create a copy of a Veeam Agent backup created for Linux machines.
  - Backup copy > Solaris x86 backup — if you want to create a copy of a Veeam Agent backup created for Oracle Solaris machines based on Intel x86 architecture.
  - Backup copy > Solaris SPARC backup — if you want to create a copy of a Veeam Agent backup created for Oracle Solaris machines based on SPARC architecture.
  - Backup copy > AWS EC2 backup — if you want to create a copy of an EC2 instance backup created with Veeam Backup for AWS.
  - Backup copy > Azure IaaS backup — if you want to create a copy of an Microsoft Azure VMs created with Veeam Backup for Microsoft Azure.
- **Backup copy > Nutanix backup** – if you want to create a copy of a backup created with Veeam Backup for Nutanix AHV.
Step 2. Specify Job Name and Copy Mode

At the Job step of the wizard, specify basic settings for a backup copy job:

1. In the Name field, enter a name for the job.

2. In the Description field, enter a description for the job. The default description contains information on a user who created the job, date and time when the job was created.

3. Select a backup copy mode. Note that after you finish configuring the backup copy job, you will not be able to change the selected mode. For more information on copy modes and backup types supported in each mode, see Backup Copy Modes.
   - Select Immediate copy to copy new restore points and, if required, log backups as soon as they appear.
   - Select Periodic copy to copy the most recent restore points once within a backup copy interval.
     - In the Copy every field, specify the backup copy interval. For more information on how to choose backup copy interval duration, see Backup Copy Intervals.
     - If you have selected a daily backup copy interval, specify the start time for the interval. By default, the daily backup copy interval starts at 12:00 AM.
Step 3. Select Workloads to Process

At the **Objects** step of the wizard, select the workloads whose restore points you want to copy to a target backup repository.

1. Click the **Add** button.
2. Add the workloads that you want to copy:
   - [For the immediate copy mode] Select a source backup job. Veeam Backup & Replication copies restore points of all workloads that the selected backup jobs process.
     - If you have configured processing of transaction log backups in the source backup jobs and want to copy these backups to the target repository, select the **Include database transaction log backups** check box.
   - [For the periodic copy mode] You can select workloads from the following sources:
     - **From infrastructure.** You can browse the virtual infrastructure to add VMs or VM containers to the job. When the backup copy job runs, Veeam Backup & Replication searches for restore points of selected VMs in all backup repositories in the backup infrastructure. You can limit the search scope by selecting only specific backup repositories for the backup copy job. For more information, see **Select Source Backup Repositories**.
       - This source is available only for backup copy jobs that process VMware or Hyper-V VMs.
     - **From backups.** You can select workloads from backups. When the backup copy job runs, Veeam Backup & Replication searches for restore points of selected workloads in all backups created in the backup server. You can limit the search scope by selecting only specific backup repositories for the backup copy job. For more information, see **Select Source Backup Repositories**.
       - This source is the only available one for backup copy jobs that process backups of Amazon EC2 instances and Microsoft Azure VMs. You can select instances/VMs only from backups that are stored in external repositories.
     - **From jobs.** You can select workloads from backup jobs. When the backup copy job runs, Veeam Backup & Replication searches for restore points of selected workloads in backups created by the selected jobs.

As an alternative, you can create a backup copy job with an empty source — that is, do not add any workloads at this step of the wizard. In this case, you need to configure a secondary destination for the source backup job and link it to the created backup copy job. For more information, see **Linking Backup Jobs to Backup Copy Jobs**.

Limitations for Workload Selection

When selecting workloads, consider the following limitations:

- Within one backup copy job, Veeam Backup & Replication processes workloads of one platform only. For example, within one backup copy job, you cannot process backups of VMware vSphere and Microsoft Hyper-V VMs or backups of VMs and physical machines.
The following applies to the periodic copy mode:

- If a workload that you want to add to a backup copy job is processed by multiple source backup jobs that use different block sizes, add this workload **From jobs**.

  When you add a workload From infrastructure or From backups, Veeam Backup & Replication picks the most recent backup as a data source. If Veeam Backup & Replication picks source backups with different block sizes during different backup copy intervals, the backup copy job will fail.

- If Use per-VM backup files option is disabled in a repository that you are planning to use as the target, you can select only workloads that have the same data block size — that is, restore points of all workloads that you select to process must have the same data block size. If the Use per-VM backup files option is enabled, you can select workloads that have different block sizes.

- [For backup copy jobs processing Veeam Agent backups] The following limitation applies to backup copy jobs only if you have upgraded to Veeam Backup & Replication 10 from Veeam Backup & Replication 9.5 Update 4 or earlier versions.

  If a Microsoft Windows machine that you want to add to a backup copy job is processed by multiple source Veeam Agent backup jobs configured in Veeam Backup & Replication, add this machine **From jobs**. If you add a machine From backups, the backup copy job will fail with the following message: **Unable to determine source backup: multiple backup files with the same instance ID exist in the source backup repository. Please reconfigure this Backup Copy job to use the specific backup job as the source.**
Step 4. Exclude Objects from Backup Copy Job

This functionality is available only for virtual machines.

If you have added VM containers to the list of processed machines, you can specify which objects you want to exclude from the backup copy job.

1. At the **Objects** step of the wizard, select a VM container added to the job and click **Exclusions**.
2. In the **Exclusions** window, click **Add**.
3. In the **Add Objects** window, select objects that you want to exclude and click **Add**.
   
   To display the hierarchy of all hosts added to Veeam Backup & Replication, use the **Show full hierarchy** check box.
4. Click **OK**.
Step 5. Select Source Backup Repositories

This functionality is available if you have selected **Periodic copy** at the Specify Job Name and Description step.

You can select specific backup repositories on which Veeam Backup & Replication must search for restore points.

1. At the **Objects** step of the wizard, click **Source**.
2. Click the **Selected backup repositories only** option and select backup repositories.

**IMPORTANT!**

The **Selected backup repositories only** option does not apply if you have added workloads **From jobs**. In this case, Veeam Backup & Replication copies data from the backup repositories where backups created by source backup jobs reside.
Step 6. Define Processing Order

This functionality is available if you have selected Periodic copy at the Specify Job Name and Description step.

You can define the order in which the backup copy job must process workloads. Configuring workload order can be helpful, if you want the backup copy job to process mission-critical workloads first. For this, put these workloads higher in the list to ensure that their processing fits the backup window.

Workloads inside a container are processed at random. To ensure that workloads are processed in the defined order, you must add them as standalone workloads, not as part of the container.

To define workload processing order:

1. At the Objects step of the wizard, select a workload whose order you want to change.
2. Use the Up and Down buttons on the right to move the workload up or down in the list.
Step 7. Define Backup Copy Target

At the **Target** step of the wizard, define a target backup repository and retention policy settings:

1. From the **Backup repository** list, select a backup repository where copied backups must be stored.

2. In the **Restore points to keep** field, specify the number of restore points that must be retained in the target backup repository. The maximum number of restore points is 999.

   When the specified number is exceeded, Veeam Backup & Replication removes the earliest restore point from the backup chain. For more information on how Veeam Backup & Replication retains the desired number of restore points, see **Forever Forward Incremental Backup Retention Policy**.

3. To use the GFS (Grandfather-Father-Son) retention policy, select the **Keep the following restore points as full backups for archival purposes** check box. For more information, see **GFS Retention Policy**.
   a. In the fields below, specify the number of daily, weekly, monthly, quarterly and yearly full intervals for which backups must be retained.
   b. Click the **Schedule** button to define the schedule for creating GFS full backups.
   c. [For the periodic copy mode] You can also define a way to create archive full backups (backups that GFS policy retains). To copy data for archive full backups from the source backup repository and write this data to the archive full backup file, select the **Read the entire restore point from source instead of synthesizing it from increments** option. This way of creating archive full backups is known as active full. For more information on the method and its limitations, see **Active Full Method**.

   To synthesize archive full backups from restore points that already exist in the target backup repository, leave the option unselected. This way of creating archive full backups is known as synthetic full. For more information on the method and its limitations, see **Synthetic Full Method**.
**IMPORTANT!**

You cannot enable GFS retention settings if you use a repository with rotated drives as a target backup repository.

---

**Backup repository:**
- Select:
  - Scale-out Backup Repository (Extendable Backup Repository)
- Size: 537 GB free of 7.24 TB

**Restore points to keep:**
- Keep the following restore points as full backups for archival purposes:
  - Weekly backup: 4th Sunday
  - Monthly backup: 1st Sunday of the month
  - Quarterly backup: 1st Sunday of the quarter
  - Yearly backup: 1st Sunday of the year

**Advanced settings:** Include health check and compact schedule, notifications settings, and automated post-job activity options.
Step 8. Map Backup File

If the target backup repository already stores a backup of workloads that you want to copy, you can map the backup copy job to this backup. The backup can be created by a backup job or another backup copy job.

The backup copy job will use the backup as a seed. As a result, Veeam Backup & Replication will transfer less data over network. For more information, see Mapping Backup Copy Jobs.

To map the backup copy job to a backup:

1. At the Target step of the wizard, click the Map backup link.
2. In the Select Backup window, select a backup that contains restore points of workloads that you want to copy.

Limitations for Mapping

When mapping a backup copy job, mind the following limitations:

- If a backup that you plan to use as a seed is encrypted, you must enable encryption for the backup copy job. The password that you use for the backup copy job can differ from the password used for the initial job.

- The following limitations apply to a backup that can be used as a seed:
  - If you map the backup copy job to a backup created by another backup copy job, the backup must be created with the same copy mode.
  - [For the immediate copy mode] You can map the backup copy job only to a backup created by another backup copy job.
  - [For the periodic copy mode] If you map the backup copy job to a backup created by a backup job. The backup must be created with the incremental backup method only, that is, forever forward or forward incremental.

NOTE:

To overcome the listed limitations, you can use a workaround scenario. For more information, see Creating Seed for Backup Copy Job.

- [For the periodic copy mode] You can map a Veeam Agent backup copy job only to a backup created by the following types of jobs:
  - Backup copy job that processes backups created by Veeam Agent operating in the standalone mode.
- Backup job created in Veeam Agent operating in the standalone mode.
Step 9. Specify Advanced Settings

At the Target step of the wizard, you can specify the following settings for the backup copy job:

- Maintenance settings
- Storage settings
- RPO Monitor settings
- Notification settings
- Script settings

TIP:
After you specify advanced settings for the backup copy job, you can save them as default settings. For this, click Save as Default at the bottom left corner of the Advanced Settings window. When you create a new backup copy job, Veeam Backup & Replication will automatically apply the default settings to the new job.

Maintenance Settings

To specify settings for backup files stored in the target backup repository:

1. At the Target step of the wizard, click Advanced.

2. If you want to periodically perform a health check of the most recent restore point in the backup chain, select the Perform backup files health check check box and specify the schedule for the health check.

   By default, the health check is performed on the last Saturday of every month. For more information on the health check, see Health Check.

3. Select the Remove deleted items data after check box and specify the retention policy settings for deleted workloads.

   By default, the deleted item retention period is 30 days. It is recommended that you set the retention period to 3 days or more to prevent unwanted data loss. For more information on the retention policy and its limitations, see Deleted Items Retention.

4. To periodically compact a full backup, select the Defragment and compact full backup file check box and specify the schedule for the compacting operation.

   By default, the compact operation is disabled. For more information on compact of full backup files, see Compact of Full Backup File.
IMPORTANT!

When enabling the **Defragment and compact full backup file** option, mind the following:

- The **Defragment and compact full backup file** option can be enabled only if GFS retention policy is disabled.
- The target backup repository must have enough space to store a file of the full backup size. During the compact process, Veeam Backup & Replication creates an auxiliary VBK file that exists in the backup repository until the end of the compact operation.
- If you do not want to copy data for workloads that have only one restore point in the full backup file and this restore point is older than 7 days, check that the following conditions are met: **Remove deleted items data** is disabled; **Use per-VM backup files** is disabled in the settings of the target backup repository.

Veeam Backup & Replication will extract data for such workloads from the full backup file and write this data to a separate backup file. The file will be displayed under the **Backups > Disk (imported)** node in the **Home** view.

**Storage Settings**

To specify compression, deduplication and encryption settings for backup files stored in the target backup repository, do the following:

1. At the **Target** step of the wizard, click **Advanced**.
2. Click the **Storage** tab.
3. In the **Data reduction** section, specify data compression and deduplication settings:
   
   o By default, Veeam Backup & Replication performs deduplication before storing copied data in the target backup repository. To disable data deduplication, clear the **Enable inline data deduplication** check box.
     
     For more information on deduplication, see [Deduplication](#).
   
   o From the **Compression level** list, select a compression level.
     
     The recommended level of compression is **Auto**. In this case, Veeam Backup & Replication uses compression settings of the copied backup files. For more information on other compression levels, see [Data Compression](#).

5. In the **Encryption** section, specify encryption settings:
   
   o To encrypt the backup file created with the backup copy job, select the **Enable backup file encryption** check box.
     
   o From the **Password** field, select a password that you want to use to encrypt the backup file. If you have not created a password beforehand, click **Add** or use the [Manage passwords](#) link to specify a new password. For more information, see [Managing Passwords for Data Encryption](#).
NOTE:
When specifying encryption settings, consider the following:

• If you enable encryption for an existing backup copy job, Veeam Backup & Replication applies new settings only starting from the next active full backup (created manually or by the GFS schedule). The active full backup file and subsequent incremental backup files in the backup chain will be encrypted with the specified password.

Note that if you disable the Read the entire restore point from source backup instead of synthesizing it from increments option in the backup copy job, you will have synthetic full backups, not active full backups. For details, see Defining Backup Copy Target.

• Encryption is not retroactive. If you enable encryption for an existing job, Veeam Backup & Replication does not encrypt the previous backup chain created with this job. If you want to start a new chain so that the unencrypted previous chain can be separated from the encrypted new chain, follow the scenario described in this Veeam KB article.

RPO Monitor Settings

This capability is available if you have selected Immediate copy at the Specify Job Name and Description step.

You can instruct a backup copy job to display a warning if a newly created restore point or transaction log is not copied within the desired recovery point objective (RPO). The RPO is counted down from the moment when the source backup job finishes and is ready to be copied.

To mark a job with the Warning status when the RPO is exceeded, do the following:

1. At the Target step of the wizard, click Advanced.
2. Click the RPO Monitor tab.
3. Select the **Alert me if newly created backup is not copied within** check box.

4. In the fields on the right, specify the desired RPO in minutes, hours or days.

5. If you have enabled copying of log backups, select the **Alert me if newly created log backup is not copied within** check box.

6. In the fields on the right, specify the desired RPO in minutes, hours or days.

---

### Notification Settings

To specify notification settings for the backup copy job:

1. At the **Target** step of the wizard, click **Advanced**.

2. Click the **Notifications** tab.

3. Select the **Send SNMP notifications for this job** check box if you want to receive SNMP traps when the job completes successfully. In the periodic copy mode, you will receive notifications when the entire backup copy job finishes. In the immediate copy mode — when copying of each source backup job finishes.

   SNMP traps will be sent if you specify global SNMP settings in Veeam Backup & Replication and configure software on the recipient workload to receive SNMP traps. For more information, see [Specifying SNMP Settings](#).
4. Select the **Send email notifications to the following recipients** check box if you want to receive notifications by email in case of job failure or success. In the field below, specify the recipient email address. You can enter several addresses separated by a semicolon.

   Email notifications will be sent if you configure global email notification settings in Veeam Backup & Replication.

   - [For the immediate copy mode] Veeam Backup & Replication sends notifications when copying of each source backup job finishes. For example, if your backup copy job contains two source backup jobs, you will receive two emails.

   - [For the periodic copy mode] Veeam Backup & Replication sends a consolidated email notification once for the specified backup copy interval. Even if the synchronization process is started several times within the interval, for example, due to job retries, only one email notification will be sent.

   For more information on how to configure global notification settings, see **Configuring Global Email Notification Settings**.

5. [For the immediate copy mode] In the **Send at** field, specify when you want to send notifications about backup copy jobs that process log backups. Veeam Backup & Replication sends a consolidated report once a day at the specified time.

6. You can choose to use global notification settings or specify custom notification settings.

   - To receive a typical notification for the job, select **Use global notification settings**. In this case, Veeam Backup & Replication will apply to the job global email notification settings specified for the backup server. For more information, see **Configuring Global Email Notification Settings**.

   - To configure a custom notification for a job, select **Use custom notification settings specified below**. You can specify the following notification settings:

     i. In the **Subject** field, specify a notification subject. You can use the following variables in the subject: %Time% (completion time), %JobName%, %JobResult%, %ObjectCount% (number of workloads in the job) and %Issues% (number of workloads in the job that have been processed with the Warning or Failed status).
ii. Select the **Notify on success**, **Notify on warning** and/or **Notify on error** check boxes to receive email notification if data processing completes successfully, completes with a warning or fails.

### Scripts Settings

To specify script settings for the backup copy job:

1. At the **Target** step of the wizard, click **Advanced**.
2. Click the **Scripts** tab.
3. Select the **Run the following script before the job** and **Run the following script after the job** check boxes to execute custom scripts before and/or after the backup copy job. Note that in the immediate copy mode, scripts are executed for every source backup job.

   Then click **Browse** and select executable files from a local folder on the backup server. The scripts will be executed on the backup server after the transformation processes are completed on the target repository.

4. You can change how often the scripts must be executed:
   
   - To run the scripts after a specific number of backup copy sessions, select **Run scripts every... backup session** option and specify the number of sessions.
   - To run the scripts on specific days, select the **Run scripts on selected days only** option and click the **Days** button to specify week days.
NOTE:
If you select the **Run scripts on the selected days only** option, Veeam Backup & Replication executes scripts only once on each selected day — when the job runs for the first time. During subsequent job runs, scripts are not executed.
Step 10. Specify Data Path Settings

The **Data Transfer** step of the wizard is available only if you copy backups of virtual or physical machines created with Veeam Backup & Replication or Veeam Agents.

At this step of the wizard, you can select how Veeam Backup & Replication will transport backed up data — directly or through WAN accelerators. By default, during the backup copy job Veeam Backup & Replication transports data directly from the source backup repository to target backup repository. This type of transport is recommended if you plan to copy backup files over high-speed connections.

If you plan to copy backup files over WAN or slow connections, it is recommended that you configure source and target WAN accelerators in the backup infrastructure and copy backups through these WAN accelerators. For more information, see [WAN Acceleration](#).

To use WAN acceleration for the backup copy job:

1. At the **Data Transfer** step of the wizard, select the **Through built-in WAN accelerators** option.
2. From the **Source WAN accelerator** list, select a WAN accelerator configured in the source site.
3. From the **Target WAN accelerator** list, select a WAN accelerator configured in the target site.

Requirements and Limitations for WAN Accelerators

- You must not assign one source WAN accelerator to several backup copy jobs that you plan to run simultaneously.
  
  The source WAN accelerator requires a lot of CPU and RAM resources and does not process multiple backup copy tasks in parallel. As an alternative, you can create one backup copy job for all workloads you plan to process over one source WAN accelerator. The target WAN accelerator, however, can be assigned to several backup copy jobs.

- [For WAN accelerators with the high bandwidth mode disabled] It is recommended that you pre-populate the global cache on the target WAN accelerator before you start the backup copy job. Global cache population helps reduce the amount of traffic transferred over WAN. For more information, see [Populating Global Cache](#).
- You cannot use WAN accelerators for backup copy jobs that copy backups of Amazon EC2 instances.
Step 11. Define Backup Copy Window

At the **Schedule** step of the wizard, you can define a time span in which the backup copy job must not transport data between source and target backup repositories. For more information, see [Backup Copy Window](#).

To define a backup window for the backup copy job:

1. Select the **During the following time periods only** option.
2. In the schedule box, select the desired time area.
3. Use the **Enable** and **Disable** options to mark the selected time segments as allowed or prohibited for the backup copy job.
Step 12. Finish Working with Wizard

At the Summary step of the wizard, complete the procedure of backup copy job configuration.

1. Review details of the backup copy job.
2. Select the Enable the job when I click Finish check box if you want to start the job right after you finish working with the wizard.
3. Click Finish to close the wizard.
Creating Backup Copy Jobs for HPE StoreOnce Repositories

To copy backup files between HPE StoreOnce backup repositories, you must configure a backup copy job.

Unlike other backup copy jobs, the backup copy job for HPE StoreOnce mirrors data from the source repository. This backup copy job copies backup files as they are stored in the source repository, without any transformation. To copy the backup files, Veeam Backup & Replication uses the HPE StoreOnce Catalyst Copy technology.

The backup copy job copies only backup files created by backup jobs. The backup files must be of the following types:

- VM backup files created by Veeam Backup & Replication. Log backup files are not copied.
- Physical machine backup files created by Veeam Agent backup jobs managed by the backup server.

**IMPORTANT!**

Mind the following limitations:

- The backup copy job copies only backup files created by backup jobs. The backup jobs must be configured on the same backup server where you configure the backup copy job. Backups created by jobs configured on other backup servers are not copied.
- The backup copy does not copy imported backups.

When the backup copy job for HPE StoreOnce runs for the first time, it copies all existing backup files. Then the backup copy job starts each time a new backup file appears in the source repository. In case of a removed backup file, the backup copy job waits 21 days since the backup file creation and removes the backup file from the target repository. If 21 days have already passed at the moment of removal, the backup copy job removes the backup file immediately. You can change this day limit using registry keys. For more information, contact Veeam Customer Support.

Before you create a job, check prerequisites and limitations. Then use the New Backup Copy Job wizard to configure the backup copy job.
Before You Begin

Before you create a backup copy job for HPE StoreOnce backup repository, check the following requirements:

- The minimum supported software versions of HPE StoreOnce are the following:
  - For the third generation, the minimum version is 3.18.7.
  - For the fourth generation, the minimum version is 4.2.0.

- Make sure that all backup infrastructure components that take part in the backup copy process are added to the backup infrastructure. These components include the source and target repositories between which data is copied. For more information on how to add a backup repository, see Adding Backup Repositories.

- Check that repositories between which you plan to copy data have a direct connection to each other. This is required because Veeam Backup & Replication uses the HPE StoreOnce Catalyst Copy technology to copy backup files.
  
  This direct connection must be of the same type as the connection that you select when adding the target HPE StoreOnce. For example, if you connected the target HPE StoreOnce repository over Fibre Channel, you must connect the source HPE StoreOnce to the target HPE StoreOnce over Fibre Channel.

- If you plan to use pre-job and/or post-job scripts, you must create scripts before you configure the backup copy job.
Step 1. Launch New Backup Copy Job Wizard

To run the **New Backup Copy Job** wizard, do one of the following:

- On the **Home** tab, click **Backup Copy** and select **HPE StoreOnce repository**.
- Open the **Home** view. In the inventory pane, right-click **Jobs** and select **Backup copy > HPE StoreOnce repository**.
Step 2. Specify Job Name and Description

At the Job step of the wizard, specify name and description for the backup copy job:

1. In the **Name** field, enter a name for the job.
2. In the **Description** field, enter a description for the job. The default description contains information about the user who created the job, date and time when the job was created.
Step 3. Select Source and Target Repositories

At the **Storage Mapping** step of the wizard, select a source repository from which you want to copy backups and a target repository where you want to store the copies.

1. Click **Add** to open the **Add Repository** window.

2. From the **Source backup repository** list, select a backup repository from which you want to copy backup files. The unsupported backup repositories are not shown in the list.

3. From the **Target backup repository** list, select a backup repository where you want to store the copies. The unsupported backup repositories are not shown in the list.

**IMPORTANT!**

Veeam Backup & Replication does not copy all types of backups. For the list of supported backup types, see [Creating Backup Copy Jobs for HPE StoreOnce Repositories](#).

Requirements and Limitations for Source and Target Repositories

When you create backup copy jobs, check the following prerequisites and limitations for the source and target repositories:

- The source and target backup repositories must be HPE StoreOnce backup repositories or scale-out backup repositories that consist of HPE StoreOnce repositories only.

- [For scale-out backup repositories] The file placement policy must be Data locality. For more information, see [Data locality](#).

- Within one backup copy job, you can use each repository as a source only once.

- You must not create the same pairs of source and target repositories, even in different backup copy jobs.
Requirements for Data Flow

When you create backup copy jobs, check that you do not create loops in data flow across all backup copy jobs. This means that data copied from one repository must not be copied to it again. The following image shows backup copy jobs configured correctly (without loops) and incorrectly (with loops).
Step 4. Specify Advanced Settings

At the **Storage Mapping** step of the wizard, you can specify the following settings for the backup copy job:

- Maintenance Settings
- Notification Settings
- Script Settings

**TIP:**

After you specify necessary settings for the backup copy job, you can save them as default settings. To do this, click **Save as Default** at the bottom left corner of the **Advanced Settings** window. When you create a new backup copy job, Veeam Backup & Replication will automatically apply the default settings to the new job.

### Maintenance Settings

In the maintenance settings, you can configure whether to perform a health check. Note that the health check may lower the performance of the target repository. For details, see [Health Check for Backup Files](#).

By default, the health check is enabled. To disable it, do the following:

1. At the **Storage Mapping** step of the wizard, click **Advanced**.
2. Clear the **Perform backup files health check** check box.
IMPORTANT!

Veeam Backup & Replication does not perform the health check for encrypted and compressed backup files.

Notification Settings

To specify notification settings for the backup copy job:

1. At the **Storage Mapping** step of the wizard, click **Advanced**.
2. Click the **Notifications** tab.
3. Select the **Send SNMP notifications for this job** check box if you want to receive SNMP traps when data from each source repository is copied.
   
   SNMP traps will be sent if you specify global SNMP settings in Veeam Backup & Replication and configure software on the recipient machine to receive SNMP traps. For more information, see **Specifying SNMP Settings**.

4. Select the **Send email notifications to the following recipients** check box if you want to receive email notifications when copying data of each source repository finishes with **Success**, **Warning** or **Failed** status.
   
   Email notifications will be sent if you configure global email notification settings in Veeam Backup & Replication. For more information, see **Configuring Global Email Notification Settings**.

5. You can choose whether to use global notification settings or specify custom notification settings.
   
   - To receive typical notifications for the job, select **Use global notification settings**. In this case, Veeam Backup & Replication will apply to the job global email notification settings specified for the backup server.
To configure custom notifications, select **Use custom notification settings specified below**. You can specify the following notification settings:

i. In the **Subject** field, specify a notification subject. You can use the following variables in the subject: %Time% (completion time), %JobName%, %JobResult%, %VmCount% (number of machines in the job) and %Issues% (number of machines in the job that have been processed with the Warning or Failed status).

ii. Select the **Notify on success**, **Notify on warning** and/or **Notify on error** check boxes to receive email notifications if data processing completes successfully, fails or completes with a warning.

---

**Script Settings**

To specify script settings for the backup copy job:

1. At the **Storage Mapping** step of the wizard, click **Advanced**.
2. Click the **Scripts** tab.
3. Select the **Run the following script before the job** and **Run the following script after the job** check boxes to execute custom scripts before and/or after copying data of each source repository finishes.

Then click **Browse** and select executable files from a local folder on the backup server. The scripts are executed on the backup server after the transformation processes are completed on the target repository.

4. You can change how often the scripts must be executed:
   - To run scripts after a specific number of backup copy sessions, select **Run scripts every... backup session** option and specify the number of sessions.
To run scripts on specific days, select the **Run scripts on selected days only** option and click the **Days** button to specify week days.

**NOTE:**
If you select the **Run scripts on the selected days only** option, Veeam Backup & Replication executes scripts only once on each selected day — when the job runs for the first time. During subsequent job runs, scripts are not executed.
Step 5. Define Backup Copy Window

At the **Schedule** step of the wizard, define the time span in which the backup copy job must not transport data between source and target backup repositories. For more information, see *Backup Copy Window*.

To define a 'prohibited' period for the backup copy job:

1. Select the **During the following time periods only** option.
2. In the schedule box, select the desired time area.
3. Use the **Enable** and **Disable** options to mark the selected time segments as allowed or prohibited for the backup copy job.

![New Backup Copy Job](image)

**Schedule**

Specify when this job is allowed to transfer data over the network. Backup copy jobs run continuously, starting data transfers according to copy interval and/or as new object restore points appear.

- **This job can transfer data:**
  - Any time (continuously)
  - During the following time periods only

- **Enable** and **Disable** options to mark the selected time segments as allowed or prohibited for the backup copy job.

Monday through Friday from 6:00 AM to 8:59 PM
Step 6. Finish Working with Wizard

At the Summary step of the wizard, complete the procedure of backup copy job configuration:

1. Review details of the backup copy job.
2. Select the Enable the job when I click Finish check box if you want to start the job right after you finish working with the wizard.
3. Click Finish to close the wizard.
Creating Backup Copy Jobs for Oracle and SAP HANA Databases

To create copies of Veeam Plug-in backups of Oracle and SAP HANA databases, you must configure a backup copy job. For more details, see the Creating Backup Copy Job section in the Veeam Plug-ins for Enterprise Applications Guide.
Linking Backup Jobs to Backup Copy Jobs

You can link backup jobs to backup copy jobs. This option lets you create a secondary target for the backup job and store backups created with the backup job in the secondary backup repository.

When you link a backup job to the backup copy job, Veeam Backup & Replication automatically updates properties of the backup copy job and adds it to the backup job as a source of data. During every backup copy session, the backup copy job checks the source backup repository for new restore points. As soon as a backup job session is finished and a new restore point appears in the source backup repository, the backup copy job automatically copies this restore point to the target backup repository.

You can link a backup job to an existing backup copy job using the **Backup Job** wizard. To link jobs:

1. Open the backup job settings for editing. For more information, see **Editing Job Settings**.
2. Navigate to the **Storage** step.
3. Select the **Configure secondary destination for this job** check box.
4. At the **Secondary Target** step of the wizard, click **Add** and choose a backup copy job to which the backup job must be linked. The backup copy job must be already configured on the backup server.
Managing Backups

To view all backups created by backup copy jobs, open the **Home** view and select the **Backups > Disk (Copy)** node in the inventory pane. The list of available backups is displayed in the working area. You can view backup properties, remove unnecessary backups and remove missing restore points.
Viewing Backup Properties

You can view summary information about backups created by backup copy jobs. The summary information provides the following data: available restore points, date of restore points creation, compression and deduplication ratios, data size and backup size.

To view summary information for a backup copy:

1. Open the Home view.
2. In the inventory pane, select Backups > Disk (copy).
3. In the working area, right-click the backup copy and select Properties.

In the summary information, Veeam Backup & Replication displays data about restore points created by the simple retention scheme and archive restore points created by the GFS retention scheme (if GFS retention is enabled). Archive restore points are marked with the following letters:

- R — full backups created with the simple retention scheme or active full backups
- W — weekly backups
- M — monthly backups
- Q — quarterly backups
- Y — yearly backups
Removing Backups from Target Repositories

You can remove backups created by backup copy jobs from Veeam Backup & Replication configuration or permanently delete backup chains from the target backup repository.

Removing from Configuration

When you use the Remove from configuration option, you delete records about backup copies from the Veeam Backup & Replication console and configuration database. The backup copy job remains in the list of jobs and all backup files remain in the target backup repository. You can easily import backups to the Veeam Backup & Replication console for restore operations at any moment.

To remove from backups:

1. Open the Home view.
2. In the inventory pane, select Backups.
3. In the working area, right-click the backup copy and select Remove from configuration.
4. To remove all weekly, monthly, quarterly and yearly backups created by the job, select the Include archived full backups check box and click Yes.

Deleting from Disk

When you use the Delete from disk option, you delete records about backup copies from the Veeam Backup & Replication console and configuration database, and delete backup files from the target backup repository. This option can be used for the whole backup copy or for some workloads in the backup copy.

To permanently remove backup copies from the target backup repository:

1. Open the Home view.
2. In the inventory pane, select **Backups**.

3. In the working area, right-click the backup copy or a workload in the backup copy and select **Delete from disk**.

4. To remove all weekly, monthly, quarterly and yearly backups from disk, select the **Include archived full backups** check box and click **Yes**.
Removing Missing Restore Points

In some cases, one or more restore points in the backup chain may be inaccessible. This can happen, for example, if the backup repository is put to the maintenance mode (for scale-out backup repositories), the backup repository is not available or some backup file is missing in the backup chain. Backup chains that contain missing restore points get corrupted — you cannot perform backup copy or restore data from the missing restore point, and restore points that depend on the missing restore point.

You can perform the following with missing restore points:

- **Forget** — you can remove records about missing restore points from the configuration database. Veeam Backup & Replication will ignore the missing restore points and will not display them in the console. The backup files will remain on disk (if backup files are still available).

- **Remove** — you can remove records about missing restore points from the Veeam Backup & Replication console and configuration database, and delete backup files from disk (if backup files are still available).

**NOTE:**
Consider the following:

- The **Forget** and **Remove from disk** options are available only for restore points that are missing from the backup chain or that depend on missing ones.

- You can manually update information about missing restore points. For this, disable a backup copy job and rescan the backup repository that is the target for the backup copy job. For more information, see Disabling and Removing Jobs and Rescanning Backup Repositories.

  Manual update can be required because Veeam Backup & Replication requires some time to update information in the configuration database for restore points that were removed from a backup chain or became inaccessible. That is why, such restore points may not be displayed in the console as missing restore points.

To remove records about missing restore points from the configuration database:

1. Open the **Home** view.
2. In the inventory pane, select **Disk (copy)** under **Backups**.
3. In the working area, select the backup and click **Properties** on the ribbon or right-click the backup and select **Properties**.
4. In the **Backup Properties** window, right-click the missing restore point and select **Forget**.
   - To remove only the selected restore point and restore points that depend on it (that is, a part of the backup chain starting from this restore point), select **This and dependent backups**.
To remove all missing restore points, select **All unavailable backups**.

1. Open the **Home** view.
2. In the inventory pane, click **Disk (copy)** under **Backups**.
3. In the working area, select the backup and click **Properties** on the ribbon or right-click the backup and select **Properties**.
4. In the **Backup Properties** window, right-click the missing restore point and select **Remove from disk**.
   - To remove only the selected restore point and restore points that depend on it (that is, a part of the backup chain starting from this restore point), select **This and dependent backups**.
To remove all missing restore points, select **All unavailable backups**.
You can view real-time statistics for any performed job and generate reports with statistics data for any job or separate job session. The procedures of viewing statistics and generating reports practically do no differ from the same procedures for backup jobs. For more information, see Reporting.
Managing Jobs

To view all configured jobs, open the Home view and select the Jobs > Backup Copy node in the inventory pane. The list of available jobs is displayed in the working area. You can edit job properties, start and stop jobs, and delete unnecessary jobs.
Editing Backup Copy Jobs

You can edit backup copy job settings after you create it. For example, you may want to change scheduling settings for the job or add some machines to the job.

To edit job settings:

1. Open the Home view.
2. In the inventory pane, select Jobs > Backup Copy.
3. In the working area, select the job and click Edit on the ribbon or right-click the job and select Edit.

You will follow the same steps as you have followed when creating the job and can change job settings as required.

Related Topics

- Creating Backup Copy Jobs for VMs and Physical Machines
- Creating Backup Copy Jobs for HPE StoreOnce Repositories
- Creating Backup Copy Jobs for Oracle and SAP HANA Databases

Disabling GFS Scheme

If you disable the Keep the following restore points as full backups for archival purposes option, and you already have archive full backups in the target backup repository, Veeam Backup & Replication will offer you to remove existing archive full backups.

- Click Yes to remove archive full backups from the target backup repository. Archive full backups will be removed during the next retention cycle (next backup copy session). The backup copy job will not create archive full backups.
- Click No to keep archive full backups in the target backup repository. Archive full backups will be displayed under the Backups > Disk (imported) node in the Veeam Backup & Replication console. The backup copy job will not create archive full backups.
If you disable the Keep the following restore points as full backups for archival purposes option and enable it again later, archive full backups that remained on disk will not be linked to the backup copy job. They will still be displayed under the Backups > Disk (imported) node in the Veeam Backup & Replication console.
Starting Backup Copy Jobs Manually

You can manually start a backup copy job. This procedure differs for the periodic and immediate copy modes. You can find details in the following sections:

- **Starting Jobs in Immediate Copy Mode**
- **Starting Jobs in Periodic Copy Mode**

Starting Jobs in Immediate Copy Mode

Manual start can be helpful if the backup copy job was disabled for some time and restore points were not copied to the target repository.

To start the backup copy job manually:

1. Open the **Home** view.
2. In the inventory pane, select the **Backup Copy** node.
3. In the working area, select the backup copy job and click **Sync now** on the ribbon or right-click the backup copy job and select **Sync now**.
4. In the opened window, do the following:
   - If you want to copy all restore points created by the source jobs but that were not copied since the last backup copy job session, click **All**.
   - If you want to copy only the latest restore point for each source job, click **Latest**.

Starting Jobs in Periodic Copy Mode

Manual start of the backup copy job can be helpful if a new restore point has already appeared in the source backup repository but the previous backup copy interval has not finished yet.
When you manually start the synchronization process, Veeam Backup & Replication creates a new backup copy interval.

- In case of backup copy jobs with minutely and hourly intervals, the backup copy interval is equal to those that are created automatically by the schedule. As a result, the start time of backup copy processing shifts forward.

- In case of backup copy jobs with intervals equal to one or several days, the day of the next backup copy interval shifts forward for the number of days equal to the interval. The start time of the backup copy interval, however, remains the same.

For example, you configure a backup copy job to copy data every 30 days. The backup copy interval starts at 2:00 AM. The manual backup copy interval starts on May 1 at 1:00 PM. The manual backup copy interval will work from 1:00 PM on May 1 till 2:00 AM on May 31. On May 31 at 2:00 AM Veeam Backup & Replication will automatically start a new 30-day backup copy interval.

To start the backup copy job manually:

1. Open the Home view.
2. In the inventory pane, select the Backup Copy node under Jobs.
3. In the working area, select the backup copy job and click Sync now on the ribbon or right-click the backup copy job and select Sync now.
Creating Active Full Backups

You can manually create an ad-hoc full backup — active full backup, and add it to the backup chain in the target backup repository. Active full backup can be helpful if you want to change backup copy job settings, for example, enable or disable encryption. Veeam Backup & Replication will apply new settings starting from this full backup.

To create an active full backup manually:

1. Open the Home view.
2. In the inventory pane, select the Backup Copy node under Jobs.
3. In the working area, select the backup copy job and click Active full on the ribbon or right-click the backup copy job and select Active full. Veeam Backup & Replication will start a new backup copy session, copy data from the source backup repository and save it in a full backup file in the target backup repository.
Disabling and Removing Jobs

You can temporarily disable backup copy jobs. The disabled job is not deleted from Veeam Backup & Replication, the job is paused for some period of time and is not run by the specified schedule. You can enable a disabled job at any time.

To disable a job:

1. Open the Home view.
2. In the inventory pane, select Jobs > Backup Copy.
3. In the working area, select the job and click Disable on the ribbon or right-click the job and select Disable.

To enable a disabled job, select the job in the list and click Disable once again.

You can permanently remove a job from Veeam Backup & Replication and from the configuration database.

To remove a job:

1. Open the Home view.
2. In the inventory pane, select Jobs > Backup Copy.
3. In the working area, select the job, click Delete on the ribbon or right-click the job and select Delete.
File Copy

You can copy and move files and folders between servers and hosts added to the backup infrastructure. For file copying operations, Veeam Backup & Replication offers a Windows Explorer-like user interface familiar to a Microsoft Windows user. You can copy files manually or schedule file copy jobs to run automatically by the defined schedule.

The file copy functionality is not intended for creating backups of VM guest OS files. Use backup jobs to create VM image-level backups instead.
Creating File Copy Jobs

To schedule a copying process for files and folders, you must configure a file copy job. You can run the file copy job immediately after its creation, schedule or save the job.

File copy jobs let you copy files between the following backup infrastructure objects:

- Virtualization hosts
- Microsoft Windows servers
- Linux servers
- ExaGrid storage appliances used as backup repositories

Before you configure a file copy job, check prerequisites. Then use the New File Copy Job wizard to create a job.
Before You Begin

Before you configure a file copy job, check the following prerequisites:

Backup infrastructure components that will take part in the file copying process must be added to the backup infrastructure and properly configured. These include a source and target host or server between which files and folders will be copied.

Mind the following limitations:

- File copy is not supported for Unix systems, for example, Solaris, FreeBSD and AIX.
- Veeam Backup & Replication does not preserve the Access Control List (ACL) settings for copied guest OS folders. The ACL settings are preserved for files only.

TIP:

You can restore the ACL settings for recovered guest OS files and folders using Instant File-Level Restore.
Step 1. Launch New File Copy Job Wizard

To launch the New File Copy Job wizard, do either of the following:

- On the Home tab, click Copy Job > File.

- Open the Files view, in the working area right-click the necessary files and folders and select Add to File Copy Job > New job. Veeam Backup & Replication will start the New File Copy Job wizard and add selected files and folders to this job. You can add other files and folders to the job later on, when you pass through the wizard steps.

You can add files and folders to already existing jobs. To do this, open the Files view, in the working area right-click necessary objects and select Add to file copy job > name of the job.
Step 2. Specify Job Name and Description

At the **Name** step of the wizard, enter a name and description of the created job.

1. **Name** field: Enter a name for the file copy job.
2. **Description** field: Provide a description for future reference. The default description contains information about the user who created a job, date and time when the job was created.

![Image of New File Copy Job window](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO File Copy</td>
<td>Weekly File Copy Job</td>
</tr>
</tbody>
</table>
Step 3. Select Files and Folders to Be Copied

At the **Source** step of the wizard, select files and folders that you want to copy.

You can use the following sources for the file copy job:

- Virtualization hosts
- Microsoft Windows servers
- Linux servers
- ExaGrid storage appliances used as backup repositories

To select files and folders that you want to copy:

1. From the **Host** list, choose a host or server on which files or folders that you want to copy reside.
2. Click **Add** and select files or folders that must be copied. The selected items will be added to the list.

**IMPORTANT!**

If the list contains files/folders with the same names and extensions, Veeam Backup & Replication copies only one instance of a file/folder. This limitation applies even if you add files/folders from different hosts or servers. To avoid this limitation, you can rename files/folders on the source or add parent folders to the list.

To remove a file or folder from the list, select it and click **Remove**.
Step 4. Select Destination for Copying

At the Destination step of the wizard, select a destination to which files or folders must be copied.

1. From the Server list, select the target host or server.
2. Click Details on the right of the Server field to view or edit server properties.
3. Click Browse next to the Path to folder field and select a folder where copied items must be stored. To create a dedicated folder for copied files or folders, use the New Folder button at the bottom of the Select Folder window.

IMPORTANT!

If the target folder already contains files/folders with the same names and extensions as the files/folder that must be copied, Veeam Backup & Replication will replace files/folders in the target folder with new files/folders.
Step 5. Define Job Schedule

At the **Schedule** step of the wizard, you can select to run the file copy job manually or schedule the job to run on a regular basis.

To specify the job schedule:

1. Select the **Run the job automatically** check box. If this check box is not selected, you will have to start the job manually to copy files or folders.

2. Define scheduling settings for the job:
   - To run the job at specific time daily, on defined week days or with specific periodicity, select **Daily at this time**. Use the fields on the right to configure the necessary schedule.
   - To run the job once a month on specific days, select **Monthly at this time**. Use the fields on the right to configure the necessary schedule.

**NOTE:**

When you configure the job schedule, keep in mind possible date and time changes (for example, related to daylight saving time transition).

- To run the job repeatedly throughout a day with a set time interval, select **Periodically every**. In the field on the right, select the necessary time unit: **Hours** or **Minutes**. Click **Schedule** and use the time table to define the permitted time window for the job. In the **Start time within an hour** field, specify the exact time when the job must start.

   A repeatedly run job is started by the following rules:
   - Veeam Backup & Replication always starts counting defined intervals from 12:00 AM. For example, if you configure to run a job with a 4-hour interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 PM and so on.
   - If you define permitted hours for the job, after the denied interval is over, Veeam Backup & Replication will immediately start the job and then run the job by the defined schedule.

   For example, you have configured a job to run with a 2-hour interval and defined permitted hours from 9:00 AM to 5:00 PM. According to the rules above, the job will first run at 9:00 AM, when the denied period is over. After that, the job will run at 10:00 AM, 12:00 PM, 2:00 PM and 4:00 PM.

- To run the job continuously, select the **Periodically every** option and choose **Continuously** from the list on the right.
To chain jobs, use the **After this job** field. In the common practice, jobs start one after another: when job A finishes, job B starts and so on. If you want to create a chain of jobs, you should define the time schedule for the first job in the chain. For the rest of the jobs in the chain, at the **Schedule** step of the wizard, select the **After this job option** and choose the preceding job from the list.

![New File Copy Job window](image)

- **Name**
- **Source**
- **Destination**
- **Schedule**
- **Summary**
Step 6. Finish Working with Wizard

At the Summary step of the wizard, complete the procedure of file copy job configuration.

1. Review details for the created file copy job.
2. Select the Run the job when I click Finish check box if you want to start the job right after you finish working with the wizard.
3. Click Finish to close the wizard.
Copying Files and Folders Manually

You can manually copy and move files and folders between servers and hosts added to the backup infrastructure.

Veeam Backup & Replication lets you copy files manually between the following backup infrastructure objects:

- Virtualization hosts
- Microsoft Windows servers
- Linux servers
- Deduplicating storage appliances used as backup repositories

**IMPORTANT!**

You cannot copy backup files (VBK, VIB and VRB) to HPE StoreOnce storage appliances used as backup repositories. To copy such files, use backup copy jobs.

To copy files and folders:

1. Open the Files view.
2. In the inventory pane, expand the file tree of the source server or host.
3. Right-click files and folders that you want to copy and select Copy.
4. In the inventory pane, expand the file tree of the target server or host.
5. Right-click a destination folder and select Paste.

You can also use a drag-n-drop operation to copy files and folders between the source and target hosts or servers.
Managing Folders

You can create, rename and delete folders in the Files view of Veeam Backup & Replication.

To create a folder:
1. Open the Files view.
2. In the inventory pane, expand the file tree of the necessary server or host.
3. In the working area, right-click anywhere on the blank area and select New Folder.

To rename a folder:
1. Open the Files view.
2. In the inventory pane, expand the file tree of the necessary server or host.
3. In the working area, select the folder and click Rename on the ribbon or right-click the folder and select Rename.
4. Enter a new name for the folder and press [Enter] on the keyboard.

To remove a folder:
1. Open the Files view.
2. In the inventory pane, expand the file tree of the necessary server or host.
3. In the working area, select the folder and click Delete on the ribbon or right-click the folder and select Delete.
Editing and Deleting Files

You can edit files and delete them in the Files view of Veeam Backup & Replication. For example, you may want to delete from the storage files of unused VMs.

To edit a file:

1. Open the Files view.
2. In the inventory pane, expand the file tree of the necessary server or host.
3. In the working area, select the file and click Edit on the ribbon or right-click the folder and select Edit.
4. Veeam Backup & Replication will open the selected file in the editor. Edit the file as required and click Save on the file editor toolbar or press [Ctrl+S] on the keyboard.

To delete a file:

1. Open the Files view.
2. In the inventory pane, expand the file tree of the necessary server or host.
3. In the working area, select the file and click Delete on the ribbon or right-click the folder and select Delete.
Recovery Verification

Veeam Backup & Replication offers the SureBackup technology that lets you verify recoverability of VM backups and scan them for malware.
SureBackup

SureBackup is the Veeam technology that lets you test VM backups and check if you can recover data from them. You can verify any restore point of a backed-up VM.

During a SureBackup job, Veeam Backup & Replication performs “live” verification: scans the backed-up data for malware, boots the VM from the backup in the isolated environment, runs tests for the VM, powers the VM off and creates a report on recovery verification results.

**IMPORTANT!**

The recovery verification functionality is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication. If you use the Standard edition, you can manually verify VM backups with Instant VM Recovery. For more information, see Manual Recovery Verification.
How SureBackup Works

For SureBackup, Veeam Backup & Replication uses a regular image-based backup. During recovery verification, Veeam Backup & Replication performs the following actions:

1. If the SureBackup job is configured to perform malware scan, Veeam Backup & Replication scans data of VMs from the application group and the verified VM with antivirus software.

2. Veeam Backup & Replication publishes VMs from the application group and the verified VM in the isolated environment — virtual lab. VMs are started directly from compressed and deduplicated backup files that reside in the backup repository. To achieve this, Veeam Backup & Replication utilizes Instant VM Recovery.

3. Veeam Backup & Replication performs a number of tests against VMs in the application group and verified VM: heartbeat test, ping test and application test.

4. If the SureBackup job is configured to validate backup files, Veeam Backup & Replication performs a CRC check for the backup file from which the verified VM is started and, optionally, for backup files from which VMs in the application group are started. The backup file validation is performed after all verification tests are complete.

5. When the recovery verification process is over, Veeam Backup & Replication unpublishes VMs and creates a report on their state. The report is sent to the backup administrator by email.

During verification, a backed-up VM image remains in read-only state. All changes that take place when the VM is running are written to the differencing disk (AVHD/AVHDX file) created for the recovered VM. When the recovery verification process is complete, the changes are discarded.

To perform recovery verification, you need to create the following objects:

1. **Application group.** During recovery verification, the verified VM may need to be started with a group of VMs on which it is dependent. The application group enables full functionality of applications running inside the VM and lets you run these applications just like in the production environment.

2. **Virtual lab.** The virtual lab is the isolated virtual environment in which the verified VM and VMs from the application group are started and tested.

3. **SureBackup job.** The SureBackup job is a task to perform recovery verification. You can run the SureBackup job manually or schedule it to run automatically by schedule.
Backup Recovery Verification Tests

To verify VMs with a SureBackup job, you can instruct Veeam Backup & Replication to run predefined tests for VMs or use custom verification scripts.

- Predefined tests
  - Microsoft SQL Server Checker script
  - Backup file validation

Predefined Tests

Veeam Backup & Replication can verify VMs with the following predefined tests:

- **Heartbeat test.** When the VM starts, Veeam Backup & Replication performs a heartbeat test. It waits for a heartbeat signal from Hyper-V Integration Services installed inside the VM to determine that the VM guest OS is running. If the signal comes regularly at specific time intervals, the test is passed.

- **Ping test.** Veeam Backup & Replication sends ping requests to the VM from the backup server and checks if the VM can respond to them. If the VM responds to ping requests, the test is passed.

  Veeam Backup & Replication uses two algorithms for detecting the IP addresses of a Hyper-V VM:
  
  - For DNS servers, domain controllers, Global Catalog servers, mail servers and web servers, Veeam Backup & Replication uses a script that probes an application-specific port. For example, to verify a domain controller, Veeam Backup & Replication probes port 389 for a response. If the response is received, the test is passed.
  
  - For Microsoft SQL Server, Veeam Backup & Replication uses a script that attempts to connect to instances and databases on the Microsoft SQL Server. For more information, see Microsoft SQL Server Checker Script.

- **Application test.** Veeam Backup & Replication waits for applications inside the VM to start and runs a script against these applications. Veeam Backup & Replication uses two types of predefined scripts:

  - For DNS servers, domain controllers, Global Catalog servers, mail servers and web servers, Veeam Backup & Replication uses a script that probes an application-specific port. For example, to verify a domain controller, Veeam Backup & Replication probes port 389 for a response. If the response is received, the test is passed.

- **NOTE:**

  To run the heartbeat test, you must have Hyper-V Integration Services installed inside the VM. If Hyper-V Integration Services are not installed, this test will be skipped.
You can run verification tests for VMs added to the application group or processed with a linked SureBackup job. Settings for verification tests can be specified and customized in the application group or SureBackup job settings.

Microsoft SQL Server Checker Script

If you need to verify a virtualized Microsoft SQL Server, you can instruct Veeam Backup & Replication to run the Microsoft SQL Server Checker script against it during the SureBackup job. The script sequentially performs the following operations:

1. Connects to Microsoft SQL Server instances.
2. Enumerates databases on these instances.
3. Employs the USE SQL statement to connect to databases and check their availability.

The script is located on the backup server in the Veeam Backup & Replication product folder, by default, C:\Program Files\Veeam\Backup and Replication\Backup\Veeam.Backup.SqlChecker.vbs.

The script runs on the backup server side, not from inside of a Microsoft SQL Server VM. For this reason, Named Pipes or TCP/IP connections must be enabled for the Microsoft SQL Server running in the virtual lab. For more information, see Microsoft Docs.

Credentials for Script Execution

To execute the script, Veeam Backup & Replication connects to Microsoft SQL Server. By default, Veeam Backup & Replication uses the account under which the Veeam Backup Service is running. If you need to run the script under another account, you can specify credentials for this account. The script supports Microsoft Windows and SQL Server authentication methods.

- For the Microsoft Windows authentication mode, you can specify credentials for the account on the Credentials tab in the application group or SureBackup job settings.
For the SQL Server authentication mode, you must pass credentials of the account as arguments to the script. You can do it via the UI or command line interface.

To pass credentials via the UI, in the application group or SureBackup job settings, select to use a custom script, specify a path to the Microsoft SQL Server Checker script (by default, C:\Program Files\Veeam\Backup and Replication\Backup\Veeam.Backup.SqlChecker.vbs) and specify the user name and password in the Arguments field.

To pass credentials via the command line, run the script from the command line in with the following parameters:


**IMPORTANT!**

Even if you use the Microsoft SQL Server authentication mode, in some cases, you may need to specify credentials of the account to connect to the machine on which Microsoft SQL Server is installed. To do this, use the Credentials tab in the application group or SureBackup job settings.

**Database Exclusion**

By default, Veeam Backup & Replication verifies all databases on all instances of Microsoft SQL Server. However, you can exclude specific databases from verification — for example, vCenter Server database. To exclude an instance or a database, you must open the script in the text editor and edit the Settings section in the following way:

- To exclude specific databases, uncomment the 'gDBsToExclude.Push "dbname"' line in the script and specify names of databases that you want to exclude. To exclude several databases, use a comma.

- To exclude specific instances, uncomment the 'gInstancesToExclude.Push "instancename"' line in the script and specify names of instances that you want to exclude. To exclude several instances, use a comma.
To exclude the default instance, uncomment the "gInstancesToExclude.Push "MSSQLSERVER" line.

**IMPORTANT!**
Instance and database names are case sensitive.

**Logging**

To define whether the script has completed successfully or not, Veeam Backup & Replication publishes the following return codes in the SureBackup job session statistics:

- 0 — test is passed successfully.
- 1 — you use a wrong syntax for the script command.
- 2 — Veeam Backup & Replication is unable to connect to Microsoft SQL Server.
- 3 — all instances are excluded from the check.
- 4 — error occurred while Veeam Backup & Replication was getting the list of databases.
- 5 — unknown error
- 6 — one or more databases are not accessible.

Results of script execution are written to the log file located by the following path: %programdata%\Veeam\Backup\<name of the job>\<VM name>_SQLChecker.log. If necessary, you can change the log file location. To do this, you must pass a new path to the log file in the %log_path% argument in the application group or SureBackup job settings.
Backup File Validation

In addition to recovery verification tests, Veeam Backup & Replication allows you to perform backup file validation. For backup file validation, Veeam Backup & Replication performs a CRC check for backup files of VMs verified by the SureBackup job. You can also validate backup files for VMs from the application group with this test.

To validate the backup file, Veeam Backup & Replication uses the checksum algorithm. When Veeam Backup & Replication creates a backup file for a VM, it calculates a checksum for every data block in the backup file and stores this data in the backup file, together with VM data. During the backup file validation test, Veeam Backup & Replication de-compresses the backup file, re-calculates checksums for data blocks in the decompressed backup file and compares them with initial checksum values. If the results match, the test is passed.

The backup file validation test is started after recovery verification tests. As soon as Veeam Backup & Replication completes all "live" verification for all VMs in the SureBackup job, it unpublishes VMs and starts the backup file validation test.

The result of the backup file validation test impacts the state of the SureBackup job session. If the verification tests are completed successfully but the backup validation is not passed, Veeam Backup & Replication marks the SureBackup job session with the *Failed* status.
Application Group

In most cases, a VM works not alone but in cooperation with other services and components. To verify such VM, you first need to start all services and components on which this VM is dependent. To this aim, Veeam Backup & Replication uses the application group.

The application group creates the “surroundings” for the verified VM. The application group contains one or several VMs on which the verified VM is dependent. These VMs run applications and services that must be started to enable fully functional work of the verified VM. Typically, the application group contains at least a domain controller, DNS server and DHCP server.

When you set up an application group, you specify a role of every VM, its boot priority and boot delay. Additionally, you can specify what tests must be performed to verify VMs in the application group.

When a SureBackup job is launched, Veeam Backup & Replication first starts in the virtual lab VMs from the application group in the required order and performs necessary tests against them. This way, Veeam Backup & Replication creates the necessary environment for the verified VM. Only after all VMs from the application group are started and tested, Veeam Backup & Replication starts the verified VM in the virtual lab.

For example, if you want to verify a Microsoft Exchange Server, you need to test its functionality in cooperation with the domain controller and DNS server. Subsequently, you must add to the application group a virtualized domain controller and DNS server. When Veeam Backup & Replication runs a SureBackup job, it will first start and verify the domain controller and DNS server in the virtual lab to make verification of the Microsoft Exchange Server possible.

**NOTE:**

All VMs added to the application group must belong to the same platform — VMware or Hyper-V. Mixed application groups are not supported.

Creating Application Group

Before you create an application group, check prerequisites. Then use the **New Application Group** wizard to create an application group.

**Before You Begin**

Before you create and start a recovery verification job, check the following prerequisites:

- A valid license for Enterprise edition of Veeam Backup & Replication must be installed on the backup server.
- All applications and services on which verified VMs are dependent must be virtualized in your environment.
- If you plan to scan VM data for malware, check requirements and limitations.
- If you plan to verify VMs with a ping test, the firewall on tested VMs must allow ping requests.
- If you plan to verify VMs with a heartbeat test, Hyper-V Integration Services must be installed in tested VMs.
- To open a console of a verified VM, you must have the RDP client version 7.0 and later installed on the backup server. The RDP client is pre-installed on Microsoft Windows 7 OS and later.
Mind that you cannot add to application groups VMs from backups created with backup copy jobs and backups stored in cloud backup repositories.
Step 1. Launch New Application Group Wizard

To launch the New Application Group wizard, do one of the following:

- Open the Backup Infrastructure view, in the inventory pane select SureBackup. In the working area, click Add Application Group > Hyper-V.
- Open the Backup Infrastructure view, in the inventory pane select Application Groups under SureBackup and click Add Group > Hyper-V on the ribbon.
- Open the Backup Infrastructure view, in the inventory pane right-click Application Groups under SureBackup and select Add App Group > Hyper-V.
Step 2. Specify Application Group Name and Description

At the Name step of the wizard, specify a name and description for the application group.

1. In the **Name** field, enter a name for the application group.

2. In the **Description** field, provide a description for future reference. The default description contains information about the user who created the group, date and time when the group was created.
Step 3. Add VMs to Application Group

At the **Virtual Machines** step of the wizard, add VMs to the created application group.

An application group must contain VMs running on one virtualization platform only: VMware vSphere or Microsoft Hyper-V. Mixed application groups are not supported.

To add VMs to the application group:

1. Click **Add VM**.
2. In the displayed window, expand the backup job, select the VM and click **Add**.
3. VMs in the list are specified in the order of their boot priority. To move a VM up and down in the list, select it and click **Move Up** or **Move Down**.

To remove a VM from the list, select it and click **Remove**.
Step 4. Specify Recovery Verification Options and Tests

You must specify verification options for every VM in the application group:

- Select a role that a VM performs
- Configure startup settings
- Select tests that must be performed for the VM
- Specify credentials for running the verification script

To specify recovery verification options and tests for a VM:

1. At the Virtual Machines step of the wizard, select a VM in the list.
2. Click Edit on the right.
3. Use the Verification Options window to specify the VM role, startup and test settings for the verified VM.

Role Settings

On the Role tab, select the role that the VM performs. Veeam Backup & Replication offers the following predefined roles for VMs:

- DNS Server
- Domain Controller (Authoritative Restore). In the Authoritative Restore mode, Veeam Backup & Replication starts a domain controller in the virtual lab and marks it as being authoritative to its replication partners. When other domain controllers (replication partners) are started in the virtual lab, they replicate data from the domain controller started in the Authoritative Restore mode.
- Domain Controller (Non-Authoritative Restore). In the Non-Authoritative Restore mode, Veeam Backup & Replication restores a domain controller in the virtual lab and marks it as being non-authoritative to its replication partners. Non-authoritative domain controllers then replicate data from a domain controller started in the Authoritative Restore mode.
- Global Catalog
- Mail Server
- SQL Server
- Veeam Backup for Microsoft Office 365 (machine on which Veeam Backup for Microsoft Office 365 is installed)
- Web Server

VM roles are described in XML files stored in the %ProgramFiles%\Veeam\Backup and Replication\Backup\SbRoles folder on the backup server. You can add your own roles. To do this, you need to create a new XML file and specify role and test scripts settings in it. For more information, see Creating XML files with VM Roles Description.

After you select a role for the VM, Veeam Backup & Replication will automatically configure startup options and assign predefined test scripts for the chosen role. You can use these settings or specify custom settings on the Startup Options and Test Scripts tabs.

To verify VMs that perform roles other than those specified in the list, you will have to manually configure startup options and specify test scripts that must be run for these VMs.
IMPORTANT!

If you want to add several domain controllers to the application group, you must assign the Domain Controller (Authoritative Restore) role to the first domain controller started in the virtual lab. Other domain controllers must have the Domain Controller (Non-Authoritative Restore) role.

Startup Settings

To specify VM startup settings:

1. Click the Startup Options tab.

2. In the Memory section, specify the amount of memory that you want to pre-allocate to the VM on the system boot. The amount of pre-allocated memory is defined in percent. The percentage rate is calculated based on the system memory level available for the production VM. For example, if 1024 MB of RAM is allocated to the VM in the production and you specify 80% as a memory rate, 820 Mb of RAM will be allocated to the verified VM on startup.

   Veeam Backup & Replication does not allow you to change VM CPU manually, it does this automatically. If the VM has more CPU than the host can provide, Veeam Backup & Replication scales down the CPU of the VM.

3. In the Startup time section, specify the allowed boot time for the VM and timeout to initialize applications on the VM.

   Be careful when specifying the Maximum allowed boot time value. Typically, a VM started by a SureBackup job requires more time to boot than a VM started in the production environment. If an application is not initialized within the specified interval of time, the recovery verification process fails with the timeout error. If such error occurs, you need to increase the Maximum allowed boot time value and start the job again.
4. In the **Boot verification** section, specify when the VM must be considered to have been booted successfully:

   - **VM heartbeat is present.** If you select this option, Veeam Backup & Replication will perform a heartbeat test for the verified VM.

   - **VM responds to ping on any network interface.** If you select this option, Veeam Backup & Replication will perform a ping test for the verified VM.

   If you enable both options, Veeam Backup & Replication will require that both tests are completed successfully: heartbeat test and ping test.

**IMPORTANT!**

To be able to perform the heartbeat test, Veeam Backup & Replication requires Hyper-V Integration Services to be installed in verified VM. If Hyper-V Integration Services are not installed, the VM will be started but the test will not be performed.

---

**Test Script Settings**

When you select a VM role, Veeam Backup & Replication automatically assigns a predefined script that must be run to verify applications inside the VM. If you want to verify a VM that has some other role not listed on the **Role** tab, do the following:

1. Click the **Test Scripts** tab.
2. Click **Add**.
3. In the **Test Scripts** window, select **Use the following test script**.
4. In the **Name** field, specify a name for the script.
5. In the **Path** field, define a path to an executable script file that should be run to verify the VM.
   - If you have your own custom script, define a path to it in the **Path** field.
   - If you do not have a custom script, you can use a standard utility by Veeam, `Veeam.Backup.ConnectionTester.exe`, that probes application communication ports. The utility is located in the installation folder of Veeam Backup & Replication: `%ProgramFiles%\Veeam\Backup and Replication\Backup\Veeam.Backup.ConnectionTester.exe`. Specify this path in the **Path** field.

6. In the **Arguments** field, specify an IP address of the verified VM and the port that you want to probe (if the selected test probes the port). You can use the `%vm_ip%` variable to define the VM IP address or the `%vm fqdn%` variable to define the VM fully qualified domain name.

   For Microsoft SQL Server, you can also specify a path to the log file in the `%log_path%` argument. For more information, see Backup Recovery Verification Tests.

7. Click **OK** to add the configured test.

To edit test settings, select the test in the list and click **Edit**. To delete a test, select it in the list and click **Remove**.

**NOTE:**

If a VM performs several roles and runs a number of applications, you can verify their work by adding several verification scripts. It is recommended that you specify the maximum startup timeout value and allocate the greatest amount of memory for such VMs.
Credentials Settings

By default, to run the verification script Veeam Backup & Replication uses the account under which the Veeam Backup Service is running. If you need to run the script under some other account, you can specify credentials for this account in the application group settings.

1. Click the Credentials tab.

2. From the Credentials list, select credentials for the account under which you want to run the script.

   If you have not set up credentials beforehand, click the Manage accounts link or click Add on the right to add the credentials. For more information, see Managing Credentials.
Step 5. Review the Application Group Settings and Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of application group configuration.

1. Review details of the application group.
2. Click **Finish** to save the application group settings and close the wizard.
Virtual Lab

The virtual lab is an isolated virtual environment in which Veeam Backup & Replication verifies VMs. In the virtual lab, Veeam Backup & Replication starts VMs from the application group and the verified VM. The virtual lab is used not only for the SureBackup verification procedure, but also for U-AIR, On-Demand Sandbox and staged restore.

The virtual lab itself does not require that you provision extra resources for it. However, VMs running in the virtual lab consume CPU and memory resources of the Hyper-V host where the virtual lab is deployed. All VM changes that take place during recovery verification are written to the differencing disk (AVHD/AVHDX file) which Veeam Backup & Replication creates for the recovered VM. When the recovery verification process is complete, the changes are discarded.

The virtual lab is fully fenced off from the production environment. The network configuration of the virtual lab mirrors the network configuration of the production environment. For example, if verified VMs and VMs from the application group are located in two logical networks in the production environment, the virtual lab will also have two networks. The networks in the virtual lab will be mapped to corresponding production networks.

VMs in isolated networks have the same IP addresses as in the production network. This lets VMs in the virtual lab function just as if they function in the production environment.

Proxy Appliance

To enable communication between the production environment and isolated networks in the virtual lab, Veeam Backup & Replication uses a proxy appliance. The proxy appliance is an auxiliary Linux-based VM that is deployed on the Hyper-V host where the virtual lab is created. The proxy appliance VM is assigned an IP address from the production network and placed to the dedicated virtual lab folder on the Hyper-V host.

The proxy appliance is connected to the production network and to the isolated network and so has visibility of the production environment and virtual lab. In essence, the proxy appliance acts as a gateway between the two networks — it routes requests from the production environment to VMs in the virtual lab.

To connect to isolated networks, the proxy appliance uses network adapters. Veeam Backup & Replication adds to the proxy appliance one network adapter per every isolated network. For example, if there are two networks in the virtual lab, Veeam Backup & Replication will add two network adapters to the proxy appliance. The network adapter gets an IP address from the isolated network. Typically, this IP address is the same as the IP address of the default gateway in the corresponding production network.
The proxy appliance is an optional component for recovery verification. Technically, you can create a virtual lab without the proxy appliance. However, in this case, you will not be able to perform automatic recovery verification of VMs. VMs will be started from backups in the virtual lab; you will have to access them using the VM console and perform necessary tests manually.

**IP Masquerading**

To let the traffic into the virtual lab, Veeam Backup & Replication uses masquerade IP addressing.

Every VM in the virtual lab has a masquerade IP address, along with the IP address from the production network. The masquerade IP address resembles the IP address in the production network. For example, if the IP address of a VM is 172.16.1.13, the masquerade IP address may be 172.18.1.13.

The masquerade IP address is an "entry point" to the VM in the virtual lab from the production environment. When you want to access a specific VM in the virtual lab, Veeam Backup & Replication addresses it by its masquerade IP address.

The rules that route requests to VMs in the virtual lab are specified in the routing table on the server from which you want to access VMs in the virtual lab. The routing table can be updated on the following servers:

- **Backup server.** Veeam Backup & Replication automatically creates the necessary static routes in the routing table on the backup server at the moment you launch a SureBackup job and Veeam Backup & Replication starts the virtual lab.
• **Client machine.** If you want to provide your users with access to VMs in the virtual lab, you need to manually update routing tables on their machines and add new static routes. For more information, see [Static IP Mapping](#).

The added static route destines the masquerade network traffic to the proxy appliance. The proxy appliance acts as a NAT device: it resolves the masquerade IP address, replaces it with “real” IP address of the VM from the production network and then directs the request to the necessary VM in the virtual lab. The static route is non-persistent: when you power off the virtual lab, the route is removed from the routing table on the backup server or client machine.

For example, when trying to access a VM with IP address 172.16.10.10 in the isolated network, Veeam Backup & Replication sends a request to the masquerade IP address 172.18.10.10. According to the routing rule added to the IP routing table, all requests are first sent to the next hop — the proxy appliance. The proxy appliance performs address translation, substitutes the masquerade IP address with the IP address in the isolated network, and forwards the request to the necessary VM in the isolated network — in this example, to 172.16.10.10.

### Static IP Mapping

Sometimes it is necessary to provide many clients with access to a restored VM, which is especially the case for user-directed application item-level recovery. For example, you may want to provide users with access to the Microsoft Exchange Server started in the virtual lab via web-based access (like Outlook Web Access).

Technically, you may update the routing table on every client machine; however, this will demand a lot of administrative effort.

For such situations, Veeam Backup & Replication lets you get access to a VM in the virtual lab directly from the production environment. To access to a VM in the virtual lab, you must reserve a static IP address in the pool of production IP addresses and map this IP address to the IP address of a VM in the virtual lab.
The static IP address is assigned to the proxy appliance network adapter connected to the production network. IP traffic directed to the specified static IP address is routed by the proxy appliance to the VM in the isolated network.

For example, for a VM with IP address 192.168.1.20 in the isolated network, you can reserve IP address 192.168.1.99 (a free IP address from the production network). As a result, you will be able to use IP address 192.168.1.99 to access the VM in the virtual lab from the production side.

You can also register an alias record in the production DNS server for the reserved IP address. For example, you can register backup.exchange.local as an alias for the IP address 192.168.1.99, and users will be able to access Microsoft Exchange Server by this alias.

**Virtual Lab Configuration**

For SureBackup recovery verification, Veeam Backup & Replication offers two types of the virtual lab configuration:

- Basic single-host virtual lab
- Advanced single-host virtual lab

**Basic Single-Host Virtual Labs**

The basic single-host virtual lab can be used if all VMs that you want to verify, VMs from the application group and the backup server are connected to the same network.

For the basic single-host virtual lab, Veeam Backup & Replication creates one virtual network that is mapped to the corresponding production network. Veeam Backup & Replication adds a new virtual switch for the virtual lab. The added virtual switch is only used by VMs started in the virtual lab. There is no routing outside the virtual lab to other networks.
Veeam Backup & Replication automatically configures all settings for the basic single-host virtual lab. The proxy appliance is also created and configured automatically on the Hyper-V host where the virtual lab is created.

Advanced Single-Host Virtual Labs

The advanced single-host virtual lab can be used if VMs that you want to verify and/or VMs from the application group are connected to different networks.

In the advanced single-host virtual lab, Veeam Backup & Replication creates several virtual networks for the virtual lab. The number of virtual networks corresponds to the number of production networks to which verified VMs are connected. Networks in the virtual lab are mapped to production networks.

Veeam Backup & Replication adds a new virtual switch for every network in the virtual lab. For example, if you have two networks in the production environment, Veeam Backup & Replication will create two networks in the virtual lab and add two virtual switches for every network on the Hyper-V host. The added virtual switches are only used by the VMs started in the virtual lab. There is no routing outside the virtual lab to other networks.

When you create an advanced single-host virtual lab, Veeam Backup & Replication configures basic settings for networks that are created in the virtual lab. You need to review these settings and manually adjust them.

Creating Virtual Lab

Before you create a new virtual lab, check prerequisites. Then use the New Virtual Lab wizard to create a virtual lab.
Before You Begin

Before you create a virtual lab, check the following prerequisites:

- A valid license for Enterprise edition of Veeam Backup & Replication must be installed on the backup server.

- You can configure a virtual lab on the following types of hosts:
  - Microsoft Hyper-V Server 2016
  - Microsoft Windows Server 2012 R2 with the Hyper-V role enabled
  - Microsoft Hyper-V Server 2012 R2
  - Microsoft Windows Server 2012 with the Hyper-V role enabled
  - Microsoft Hyper-V Server 2012

- You can verify backups of VMs running on the following platforms:
  - Microsoft Hyper-V Server 2016
  - Microsoft Windows Server 2012 R2 with the Hyper-V role enabled
  - Microsoft Hyper-V Server 2012 R2
  - Microsoft Windows Server 2012 with the Hyper-V role enabled
  - Microsoft Hyper-V Server 2012
  - Microsoft Windows Server 2008 R2 with the Hyper-V role enabled
  - Microsoft Hyper-V Server 2008 R2
Step 1. Launch New Virtual Lab Wizard

To launch the New Virtual Lab wizard, do one of the following:

- Open the Backup Infrastructure view, in the inventory pane select SureBackup. In the working area, click Add Virtual Lab > Hyper-V.

- Open the Backup Infrastructure view, in the inventory pane select Virtual Labs under SureBackup and click Add Virtual Lab > Hyper-V on the ribbon.

- Open the Backup Infrastructure view, in the inventory pane right-click Virtual Labs under SureBackup and select Add Virtual Lab > Hyper-V.
Step 2. Specify Virtual Lab Name and Description

At the **Name** step of the wizard, specify a name and description for the virtual lab.

1. In the **Name** field, enter a name for the virtual lab.
2. In the **Description** field, provide a description for future reference. The default description contains information about the user who created the virtual lab, date and time when the lab was created.
Step 3. Select Host

At the **Destination** step of the wizard, select a Microsoft Hyper-V host on which the virtual lab must be created.

1. Click **Choose** next to the **Host** field to select a Microsoft Hyper-V host. You can select a standalone Hyper-V host or host being a part of the Hyper-V cluster.

2. For every new virtual lab, Veeam Backup & Replication creates a dedicated folder on the host, by default, \C:\VeeamVirtualLabs\. To specify another folder, click **Choose** next to the **Path** field and select the necessary folder.

To the virtual lab folder, Veeam Backup & Replication copies files of the proxy appliance. The folder is also used as a mount point for VMs started in the virtual lab. In this folder, Veeam Backup & Replication “publishes” virtual disk and configuration files of verified VMs and VMs from the application group. These files are visible to the user as having the size of original VM files.

Veeam Backup & Replication emulates the presence of VM files in the virtual lab folder. The virtual disks themselves are still located in the backup file in the backup repository. All VM changes that take place during recovery verification are written to the differencing disk (AVHD/AVHDX file) which Veeam Backup & Replication creates for the recovered VM. When the recovery verification process is complete, the changes are discarded. For more information, see [How SureBackup Works](#).
Step 4. Set Up Proxy Appliance

At the **Proxy** step of the wizard, configure the proxy appliance settings.

1. Select the **Use proxy appliance in this virtual lab** check box to enable automatic recovery verification of VMs. The proxy appliance acts as a gateway that provides access from the backup server to VMs in the virtual lab. If you do not select this check box, during recovery verification Veeam Backup & Replication will only start VMs in the virtual lab and perform the heartbeat test for VMs. You will have to manually test VMs or perform manual item-level restore via the VM console.

2. By default, the proxy appliance uses the virtual lab name that you have specified at the **Name** step of the wizard. If you want to change a name of the proxy appliance, click **Edit** and specify the necessary name.

3. Click **Configure** and select a production network in which the proxy appliance will be created. Specify an IP address for the proxy appliance in the production network and settings of the DNS server to be used. You can choose to automatically obtain an IP address and DNS server settings or set them manually.

**IMPORTANT!**

If you assign to the proxy appliance an IP address from the same network where the backup server is located, Veeam Backup & Replication will automatically add a new route to the routing table on the backup server. If you assign to the proxy appliance an IP address from a different network, you will have to manually add a new route to the routing table on the router in the production network. If you do not add a new route, tests and application scripts will fail and you will not be able to access VMs in isolated networks.

When Veeam Backup & Replication starts a virtual lab, it verifies if the proxy appliance is available by sending a ping request to it. If the corresponding route is not added to the routing table, the SureBackup job will fail.

4. If you want to let VMs in the virtual lab access the Internet, select the **Allow proxy appliance to act as internet proxy for virtual machines in this lab** check box. In the **Port** field, specify a port for HTTP traffic. By default, port 8080 is used. In the **Production proxy** field, you can optionally specify an IP address or a fully qualified domain name of an Internet-facing proxy server that VMs must use to access the Internet.

5. Adjust proxy settings in the Internet options on every VM that you plan to start in the virtual lab. To do this, on the VM open **Internet Options > Connections > LAN Settings > Proxy server** and specify the IP address of the proxy appliance on the isolated network and port number.
NOTE:
When you allow the proxy appliance to act as an Internet proxy, you enable the HTTP(S) Internet access for VMs in the virtual lab. The proxy appliance does not proxy other protocols (such as ICMP protocol used for ping tests) for VMs in the virtual lab.
Step 5. Select Networking Mode

At the Networking step of the wizard, select the type of network settings configuration. Veeam Backup & Replication offers two networking modes for the virtual lab:

- **Basic single-host.** This networking mode is recommended if all VMs that you plan to verify, VMs from the application group and the backup server are located in the same production network. In this case, Veeam Backup & Replication will automatically define all networking settings for the virtual lab.

- **Advanced single-host.** This networking mode is recommended if VMs that you plan to verify and/or VMs from the application group are located in different networks. In this case, you will have to manually define settings for isolated networks in the virtual lab.

If this option is selected, the New Virtual Lab wizard will include additional steps for customizing network settings.
Step 6. Select Isolated Networks

The Isolated Networks step of the wizard is available if you have selected the advanced networking option at the Networking step of the wizard.

At the Isolated Networks step of the wizard, you must create isolated networks to which verified VMs and VMs from the application group will be connected and map these networks to production networks where original VMs are located.

You can configure two types of mapping rules:

- Mapping rules for networks without VLANs
- Mapping rules for networks with VLANs

Mapping Rules for Networks Without VLANs

To add a network:

1. Click Add.
2. From the Production network list, select a production network in which VMs from the application group and/or verified VMs reside.
3. In the Isolated network field, specify a name for an isolated network that must be mapped to this production network.
4. In the VLAN ID field, enter an ID for the created isolated network.
NOTE:

You can map several production networks to the same isolated network. The production networks that you plan to map must have the same network masks and pools of IP addresses.

### Mapping Rules for Networks with VLANs

If you use VLANs in your production network, you can create several isolated networks and map them to different VLANs. As a result, the networking scheme in the virtual lab will resemble the networking scheme in your production environment.

To create mapping rules for a network with several VLANs:

1. Click **Add**.
2. From the **Production network** list, select a production network in which the VLAN you want to map is created.
3. In the **VLAN ID** field below, specify an ID of the VLAN in the production network.
4. In the **Isolated network** field, specify a name for an isolated network that you want to map to the VLAN.
5. In the **VLAN ID** field, enter an ID for this isolated network.
6. Repeat steps 1-5 for every VLAN in your production network.

For example, you have 3 VLANs in your production networks: VLAN 100, VLAN 200 and VLAN 300. In this case, you can create 3 isolated networks and map them to VLANs in the following way:

- Isolated network 1 is mapped to VLAN 100
- Isolated network 2 is mapped to VLAN 200
- Isolated network 3 is mapped to VLAN 300

In the virtual lab, Veeam Backup & Replication will create 3 isolated networks and 3 virtual switches for these networks and connect VMs to corresponding virtual switches. VMs in the virtual lab will function as they function in the production environment.
Step 7. Specify Network Settings

The **Network Settings** step of the wizard is available if you have selected the advanced networking option at the **Networking** step of the wizard.

At the **Network Settings** step of the wizard, you must specify settings for every created isolated network and define how production networks map to isolated networks in the virtual lab.

Communication between production networks and isolated networks is carried out through network adapters that are added to the proxy appliance. A new network adapter must be added for every isolated network.

To add a network adapter for an isolated network:

1. At the **Network Settings** step of the wizard, click **Add**.

2. Select a network to which the network adapter must be connected. Specify an IP address that the proxy appliance must have in the isolated network and subnet mask of this isolated network. Typically, the IP address for the proxy appliance coincides with the IP address of the gateway in the corresponding production network.

3. After you specify the IP address, Veeam Backup & Replication will automatically configure a masquerade IP address for accessing VMs in the virtual lab from the production network. You can change the masquerade network IP address if necessary.

4. Select the **Enable DHCP service on this interface** check box if you need to dynamically assign IP addresses for machines. The assigned IP addresses belong to the current isolated network.

5. Click the **DNS Servers** button and specify settings of a virtualized DNS server if necessary.

6. Click **OK**.

7. To enable communication between isolated networks, select the **Route network traffic between vNICs** check box. Make sure that the IP address of the proxy appliance in the isolated network matches the IP address of the gateway in the production network.
IMPORTANT!

You cannot assign more than one virtual NIC to a single isolated network.
Step 8. Specify Static IP Mapping Rules

The **Static Mapping** step of the wizard is available if you have selected the advanced networking option at the **Networking** step of the wizard.

At the **Static Mapping** step of the wizard, you can specify static IP address mapping rules to make VMs in the virtual lab accessible from any machine in the production network.

To add a new rule:

1. Select the **Define static IP address mapping** check box.
2. Click **Add**.
3. In the **IP Address Mapping** window, specify settings of a new rule:
   a. In the **Isolated IP** field, specify an IP address of the VM in the production network.
   b. In the **Access IP** field, specify an IP address in the production network that you want to use to access the VM in the virtual lab. You must use an IP address that is not allocated to any machine yet.

**NOTE:**

It is recommended that you assign an access IP from the same subnet where the proxy appliance resides. In the opposite case, you will have to configure routing rules for the access IP manually.

For example, the DNS server you plan to start in the virtual lab has IP address 172.17.53.2 in the production network. To set static mapping for the DNS server:

1. In the **Isolated IP** field, you need to define its production IP address — 172.17.53.2.
2. In the **Access IP** field, you need to define any unallocated IP address from the production network, for example, 172.17.53.162.
After a virtual lab is created and VMs are started in the virtual lab, you will be able to access the DNS server in the virtual lab from the production environment using IP address 172.17.53.162.
Step 9. Apply Parameters

At the Ready to Apply step of the wizard, complete the procedure of virtual lab configuration.

1. Review details of the virtual lab.
2. Click Apply to create the virtual lab.
3. At the last step of the wizard, click Finish to exit the wizard.

Connecting to Existing Virtual Lab

You can connect an existing virtual lab and use this virtual lab for recovery verification. For example, you can connect to a virtual lab that has been created on another backup server.

To connect to a virtual lab:

1. Open the Backup Infrastructure view.
2. In the inventory pane, select Virtual Labs under SureBackup and click Connect Virtual Lab > Hyper-V on the ribbon or right-click Virtual Labs and select Connect Virtual Lab > Hyper-V.
3. Select the virtual lab and click **Connect**. To quickly find a virtual lab, use the search field at the bottom of the **Select Virtual Lab** window: enter a virtual lab name or a part of it in the field below and press [Enter] on the keyboard.

---

### Editing and Deleting Virtual Labs

You can edit settings of a virtual lab or delete the virtual lab.

Always use Veeam Backup & Replication to modify or delete a virtual lab. If you change lab settings or delete any of its components from outside, for example, in Hyper-V Manager, the lab will be corrupted and its component such as the created virtual switch will remain in the virtual infrastructure.

To edit settings of a virtual lab:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select **Virtual Labs** under **SureBackup**.
3. In the working area, select a virtual lab and click **Edit Virtual Lab** on the ribbon or right-click the virtual lab and select **Properties**.
4. Edit virtual lab settings as required.

To remove a virtual lab:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select **Virtual Labs** under **SureBackup**.
3. In the working area, select a virtual lab and click **Remove Virtual Lab** on the ribbon or right-click the virtual lab and select **Delete**.
4. If you want to remove virtual lab objects from the virtual environment, in the displayed window select the **Remove virtual lab objects from host** check box. If you do not select this option, Veeam Backup & Replication will disconnect the virtual lab from the backup server. You will be able to connect to this virtual lab later.
SureBackup Job

A SureBackup job is a task for recovery verification. The SureBackup job aggregates all settings and policies of the recovery verification task, such as application group and virtual lab to be used, VM backups that must be verified in the virtual lab and so on. You can run the SureBackup job manually or schedule it to run automatically.

When a SureBackup job runs, Veeam Backup & Replication first creates an environment for recovery verification:

1. Veeam Backup & Replication starts the virtual lab.

2. In the virtual lab, Veeam Backup & Replication starts VMs from the application group in the required order. VMs from the application group remain running until the verified VMs (VMs from the linked job) are booted from backups and tested.
   
   If Veeam Backup & Replication does not find a valid restore point for any of VMs from the application group, the SureBackup job fails.

3. When the virtual lab is ready, Veeam Backup & Replication starts verified VMs (VMs from the linked job) to the necessary restore point and, depending on the job settings, verifies them one by one or creates several streams and verifies a number of VMs simultaneously.
   
   If Veeam Backup & Replication does not find a valid restore point for any of verified VMs, verification of this VM fails, but the job continues to run.

By default, you can start and test up to three VMs at the same time. You can also increase the number of VMs to be started and tested simultaneously. Keep in mind that if these VMs are resource demanding, performance of the SureBackup job as well as performance of the Hyper-V host on which the virtual lab resides may decrease.

Once the verification process is complete, VMs from the application group are powered off. Optionally, you can leave the VMs from the application group running to perform manual testing or enable user-directed application item-level recovery.

In some cases, the SureBackup job schedule may overlap the schedule of the backup job linked to it. The backup file may be locked by the backup job and the SureBackup job will be unable to verify such backup. In this situation, Veeam Backup & Replication will not start the SureBackup job until the corresponding backup job is over.

To overcome the situation of job overlapping, you may chain the backup and SureBackup jobs or define the timeout period for the SureBackup job. For more information, see Specifying Job Schedule.

**NOTE:**

VMs from the application group and verified VMs must belong to the same platform — VMware or Hyper-V. Mixed scenarios are not supported.

SureBackup Job Processing

The recovery verification process includes the following steps:

1. **Getting virtual lab configuration.** Veeam Backup & Replication gets information about configuration of the virtual lab where verified VMs must be started.

2. **Starting proxy appliance VM.** Veeam Backup & Replication starts the proxy appliance. The proxy appliance is used as a gateway that provides access to the virtual lab.

3. **Configuring network routes.** Veeam Backup & Replication adds to the routing table on the backup server new routes for the networks created in the virtual lab.
4. **Performing malware scan.** If the recovery verification process includes malware scan, Veeam Backup & Replication scans VM data with antivirus software.

After the malware scan is complete, Veeam Backup & Replication registers the VM on the selected ESXi host and runs recovery verification tests for this VM.

Veeam Backup & Replication verifies VMs sequentially — one after another. For example, when the malware scan and recovery verification tests for VM A complete, Veeam Backup & Replication verifies VM B, and so on.

5. **Preparing application group.** In the virtual lab, Veeam Backup & Replication starts VMs from the application group in the specified order and performs necessary tests for them.

6. **Performing verification tasks.** In the virtual lab, Veeam Backup & Replication starts verified VMs and performs necessary tests for them.

7. **Performing heartbeat test.** Veeam Backup & Replication checks whether the Hyper-V Integration Services heartbeat signal is coming from the VM or not. If the VM has no Hyper-V Integration Services, the test is not performed and a notification is written to the job session details.

8. **Running ping tests.** Veeam Backup & Replication checks if the VM responds to the ping requests or not. If the VM has no network adapters or mapped networks for them, the ping test is not performed and a notification is written to the job session details.

9. **Application initialization.** Veeam Backup & Replication waits for the applications installed in the VM, for example, Microsoft SQL Server, to start. The application initialization period is defined in settings of the SureBackup job and by default is equal to 120 sec.

   Depending on the software installed in a VM, the application initialization process may require more time than specified in the job settings. If applications installed in a VM are not initialized within the specified period of time, test scripts can be completed with errors. If such error situation occurs, you will need to increase the Application initialization timeout value and start the job once again.

10. **Running test scripts.** Veeam Backup & Replication runs scripts to test whether the application installed in the VM is working correctly or not. If there are no network adapters on the VM or mapped networks for them, Veeam Backup & Replication skips tests that use the %vm_ip% and %vmfqdn% variables as the IP address and fully qualified domain name of the VM cannot be determined.

    Test results are written to the job session details. To define whether the script has been completed successfully or not, Veeam Backup & Replication uses return codes. If the return code is equal to 0, the script is considered to complete successfully. Other values in the return code mean that the script has failed.

11. **Powering off.** After all tests have been performed, Veeam Backup & Replication powers off the verified VM and unregisters it on the Hyper-V host.

12. **Running backup validation test.** After a VM has been verified and powered off, Veeam Backup & Replication runs a CRC check to verify the VM backup at the file level and make sure that this file is not corrupted.

13. **Stopping virtual lab engine.** Veeam Backup & Replication powers off the proxy appliance in the virtual lab.

14. **Deleting network routes.** Veeam Backup & Replication deletes added network routes from the routing table on the backup server.
Stabilization Algorithm

To be able to perform tests for a verified VM without errors, Veeam Backup & Replication needs to know that the VM is ready for testing. To determine this, Veeam Backup & Replication waits for the VM to reach a stabilization point — the moment when the VM boots and reports it is ready for tests. After the stabilization point has been reached, Veeam Backup & Replication can start heartbeat tests, ping tests and test scripts against the VM.

Veeam Backup & Replication establishes a stabilization point with the help of parameters that it gets from the VM. Depending on the VM configuration, it uses one of the four algorithms:

- **Stabilization by IP.** This algorithm is used if the VM has network adapters and there are mapped networks for these network adapters. In this case, Veeam Backup & Replication waits for an IP address of the VM for mapped networks that is sent by Hyper-V Integration Services running in the VM or by the Hyper-V host via the proxy appliance. The sent IP address must be valid and must not change for a specific period of time. For more information, see Recovery Verification Tests.

- **Stabilization by heartbeat.** This algorithm is used if the VM has Hyper-V Integration Services installed but there are no network adapters and mapped networks for them. In this case, Veeam Backup & Replication waits for a heartbeat signal from Hyper-V Integration Services installed inside the VM.

- **Hybrid heartbeat/IP algorithm.** Veeam Backup & Replication uses both the heartbeat signal (if available) and an IP of the VM to stabilize the VM boot process.

- **Stabilization by Maximum allowed boot time.** This algorithm is used if the VM has neither Hyper-V Integration Services installed, nor network adapters and mapped networks for them. In this case, Veeam Backup & Replication waits for the time specified in the Maximum allowed boot time field, which is considered to be a stabilization period for the VM. Once this time interval is exceeded, Veeam Backup & Replication considers that the VM is successfully booted and is ready for testing.

When the stabilization point has been established, Veeam Backup & Replication runs ping, heartbeat tests and performs test scripts against the verified VM.

The stabilization process cannot exceed the time interval specified in the Maximum allowed boot time field. For this reason, you should be careful when specifying this value. Typically, a VM started by a SureBackup job requires more time to boot than a VM started in the production environment. If the stabilization point cannot be determined within the Maximum allowed boot time, the recovery verification process is finished with the timeout error. When such an error occurs, you need to increase the Maximum allowed boot time value and start the job again.

Creating SureBackup Job

To create a new SureBackup job, use the New SureBackup Job wizard.

Before You Begin

Before you create and start a recovery verification job, check the following prerequisites:

- A valid license for Enterprise edition of Veeam Backup & Replication must be installed on the backup server.

- All applications and services on which verified VMs are dependent must be virtualized in your environment.

- You must create or connect a virtual lab. For more information, see sections Creating Virtual Lab and Connecting to Existing Virtual Lab.
• If you plan to scan VM data for malware, check requirements and limitations.

• If you plan to verify VMs with a ping test, the firewall on tested VMs must allow ping requests.

• If you plan to verify VMs with a heartbeat test, Hyper-V Integration Services must be installed in tested VMs.

• To open a console of a verified VM, you must have the RDP client version 7.0 and later installed on the backup server. The RDP client is pre-installed on Microsoft Windows 7 OS and later.

Mind the following limitations:

• You cannot link to SureBackup jobs VMs from backups created with backup copy jobs and backups stored in cloud backup repositories.

• The source backup job has a higher priority than the SureBackup job. If the source backup job starts when the SureBackup job is running, and this job is about to modify the restore point from which the VM is started, Veeam Backup & Replication automatically powers off VMs in the virtual lab and completes the SureBackup job.
Step 1. Launch New SureBackup Job Wizard

To launch the **New SureBackup Job** wizard, do either of the following:

- Open the **Home** view. On the **Home** tab, click **SureBackup Job > Hyper-V** on the ribbon.
- Open the **Home** view. In the inventory pane, right-click **SureBackup** under **Jobs** and select **SureBackup > Hyper-V**.

You can use this method if you already have at least one SureBackup job. If there are no SureBackup jobs, the **SureBackup** node will not be displayed in the inventory pane. In this case, you can right-click **Jobs** in the inventory pane and select **SureBackup > Hyper-V**.

**NOTE:**

SureBackup UI elements become available in the Veeam Backup & Replication console only after you create or connect a virtual lab. For more information, see sections **Creating Virtual Lab** and **Connecting to Existing Virtual Lab**.
Step 2. Specify Job Name and Description

At the **Name** step of the wizard, specify a name and description for the SureBackup job.

1. In the **Name** field, enter a name for the SureBackup job.

2. In the **Description** field, provide a description for future reference. The default description contains information about the user who created the job, date and time when the job was created.

![New SureBackup Job dialog box](image)

- **Name**
  - Type in a name and description for this SureBackup job.

- **Name:**
  - Exchange SureBackup Job

- **Description:**
  - Daily Verification Job
Step 3. Select Virtual Lab

At the **Virtual Lab** step of the wizard, select a virtual lab that you want to use for recovery verification.

1. From the **Virtual Lab** list, select a virtual lab. The list contains all virtual labs that are created or connected to the backup server.

2. In the **Virtual lab info** section, review information about the selected virtual lab.

![New SureBackup Job](image)
Step 4. Select Application Group

At the Application Group step of the wizard, select an application group that you want to use for recovery verification.

You can select an application group or skip this step. If the application group is not selected, you must link at least one backup or replication job to the SureBackup job at the Linked Jobs step of the wizard. In this case, when the SureBackup job starts, Veeam Backup & Replication will only run VMs from the linked job in the virtual lab and verify these VMs.

To select an application group:

1. From the Application group list, select an application group. The list contains all application groups that are created on the backup server.

2. In the Application group info list, refer to the Source Status column to make sure that backups and replicas for VMs in the application group are created.

3. To leave VMs from the application group running after the SureBackup job finishes, select the Keep the application group running after the job completes check box. With this option enabled, the lab will not be powered off when the SureBackup job completes, and you will be able to perform application item-level restore (U-AIR) and manually test VMs started in the virtual lab.
Step 5. Link Backup Job

At the **Linked Jobs** step of the wizard, select backup jobs with VMs that you want to verify with the created SureBackup job.

You can link a backup job to the SureBackup job or skip this step. If you do not link a backup job, Veeam Backup & Replication will only start VMs from the application group in the virtual lab and verify them. You have an option not to link a backup job to the SureBackup job only if you have selected an application group at the **Application Group** step of the wizard.

To link a backup job to the SureBackup job:

1. Select the **Link jobs** check box.
2. Click **Add**.
3. In the **Select Jobs** window, select backup jobs.
4. In the **Process simultaneously up to ... VMs** field, specify the maximum number of VMs that can be started at the same time. For example, if you select to start 3 VMs at the same time, Veeam Backup & Replication will create 3 streams: 1 stream per every verified VM. When the VM has been tested and powered off, the next VM will be started in the available stream. After all VMs are verified, VMs from the application group will be powered off or will be left running if the **Keep the application group running after the job completes** option has been enabled at the **Application Group** step of the wizard.

To remove a backup job from the list, select it and click **Remove**.
Step 6. Specify Recovery Verification Options and Tests

You must specify verification options for every VM from the jobs linked to the SureBackup job:

- Select a role that a VM performs
- Configure VM startup settings
- Select tests that must be performed for the VM
- Specify credentials for running the verification script

If all VMs in the linked job perform the same role, you can specify startup options and test settings for the whole job in bulk. If VMs have different roles, you can granularly specify startup options and test settings for each VM in the job.

- To specify startup options and select tests for the whole job, select the job in the list and click **Edit** on the right.
- To specify startup options and select tests for every VM in the job separately, select the job in the list and click **Advanced** on the right. Click **Add** and select the necessary VM in the **Add Objects** window. Select the added VM in the list, click **Edit** and specify settings as described below.

**IMPORTANT!**

If you specify startup options and tests individually for a VM, Veeam Backup & Replication will apply these options and tests only. Options and tests specified at the level of the SureBackup job will be ignored for this VM.

Role Settings

On the **Role** tab, select the role that the VM performs. Veeam Backup & Replication offers the following predefined roles for VMs:

- DNS Server
- Domain Controller (Authoritative Restore). In the Authoritative Restore mode, Veeam Backup & Replication starts a domain controller in the virtual lab and marks it as being authoritative to its replication partners. When other domain controllers (replication partners) are started in the virtual lab, they replicate data from the domain controller started in the Authoritative Restore mode.
- Domain Controller (Non-Authoritative Restore). In the Non-Authoritative Restore mode, Veeam Backup & Replication restores a domain controller in the virtual lab and marks it as being non-authoritative to its replication partners. Non-authoritative domain controllers then replicate data from a domain controller started in the Authoritative Restore mode.
- Global Catalog
- Mail Server
- SQL Server
- Veeam Backup for Microsoft Office 365 (machine on which Veeam Backup for Microsoft Office 365 is installed)
- Web Server
VM roles are described in XML files stored in the `%ProgramFiles%\Veeam\Backup and Replication\Backup\SbRoles` folder on the backup server. You can add your own roles. To do this, you need to create a new XML file and specify role and test scripts settings in it. For more information, see Creating XML files with VM Roles Description.

After you select the necessary role, Veeam Backup & Replication will automatically configure startup options and provide predefined test scripts applicable for the chosen role. You can use these settings or specify custom ones on the Startup Options and Test Scripts tabs.

To verify VMs that perform roles other than those specified in the list, you will have to manually configure startup options and specify test scripts to be run against these VMs.

VM Startup Settings

To specify VM startup settings:

1. Click the Startup Options tab.

2. In the Memory section, specify the amount of memory that you want to pre-allocate to the VM on the system boot. The amount of pre-allocated memory is defined in percent. The percentage rate is calculated based on the system memory level available for the production VM. For example, if 1024 MB of RAM is allocated to the VM in the production and you specify 80% as a memory rate, 820 MB of RAM will be allocated to the verified VM on startup.

   Veeam Backup & Replication does not allow you to change VM CPU manually, it does this automatically. If the VM has more CPU than the host can provide, Veeam Backup & Replication scales down the CPU of the VM.
3. In the **Startup time** section, specify the allowed boot time for the VM and timeout to initialize applications on the VM.

   Be careful when specifying the **Maximum allowed boot time** value. Typically, a VM started by a SureBackup job requires more time to boot than a VM started in the production environment. If an application is not initialized within the specified interval of time, the recovery verification process fails with the timeout error. If such error occurs, you need to increase the **Maximum allowed boot time** value and start the job again.

4. In the **Boot verification** section, specify when the VM must be considered to have been booted successfully:

   - **VM heartbeat is present.** If you select this option, Veeam Backup & Replication will perform a heartbeat test for the verified VM.
   - **VM responds to ping on any network interface.** If you select this option, Veeam Backup & Replication will perform a ping test for the verified VM.

   If you enable both options, Veeam Backup & Replication will require that both tests are completed successfully: heartbeat test and ping test.

**NOTE:**

Veeam Backup & Replication performs a heartbeat test for VMs that have Hyper-V Integration Services installed. If Hyper-V Integration Services are not installed, the VM will be started but tests will not be performed.
Test Script Settings

When you select a VM role, Veeam Backup & Replication automatically assigns a predefined script that must be run to verify applications inside the VM. If you want to verify a VM that has some other role not listed in the Role tab, do the following:

1. Click the Test Scripts tab.
2. Click Add.
3. In the Test Scripts window, select Use the following test script.
4. In the Name field, specify a name for the script.
5. In the Path field, define a path to an executable script file that should be run to verify the VM.
   - If you have your own custom script, define a path to it in the Path field.
   - If you do not have a custom script, you can use Veeam's standard utility, Veeam.Backup.ConnectionTester.exe, that probes application communication ports. The utility is located in the installation folder of Veeam Backup & Replication: %ProgramFiles%\Veeam\Backup and Replication\Backup\Veeam.Backup.ConnectionTester.exe. Specify this path in the Path field.
6. In the Arguments field, specify an IP address of the verified VM and the port that you want to probe (if the selected test probes the port). You can use the %vm_ip% variable to define the VM IP address or the %vm_fqdn% variable to define the VM fully qualified domain name.
   For Microsoft SQL Server, you can also specify a path to the log file in the %log_path% argument. For more information, see Backup Recovery Verification Tests.
7. Click OK to add the configured test.

To edit test settings, select the test in the list and click Edit. To delete a test, select it in the list and click Remove.
NOTE:

If a VM performs several roles and runs a number of applications, you can verify their work by adding several verification scripts. It is recommended that you specify the maximum startup timeout value and allocate the greatest amount of memory for such VMs.

Credentials Settings

In the Credentials tab, specify credentials to authenticate in the VM where you need to run the script.

1. Click the Credentials tab.
2. From the **Credentials** list, select credentials for the account under which you want to run the script.

   If you have not set up credentials beforehand, click the **Manage accounts** link or click **Add** on the right to add the credentials. For more information, see **Managing Credentials**.
Step 7. Specify Additional Job Settings

On the Settings step of the wizard, specify additional settings for the SureBackup job:

1. If you want to validate the backup file with a CRC check and make sure that the file is not corrupted, select the Validate entire virtual disk contents check box. You can optionally exclude VMs being a part of the application group from this test. To do this, select the Skip validation for application group VMs check box. For more information, see Recovery Verification Tests.

2. If you want Veeam Backup & Replication to scan VM data with antivirus software, select the Scan the selected restore point for malware check box. For more information, see Secure Restore.
   - if you want the antivirus software to continue scanning VM data after the first malware is found, select the Scan the entire image check box. For information on how to view results of the malware scan, see Viewing Recovery Verification Job Statistics.
   - if you do not want to scan VMs from the application group, select the Skip application group machines from malware scan check box. In this case, the antivirus will only scan VMs from linked jobs.

Veeam Backup & Replication scans VM data with antivirus before running verification tests. Mind that the SureBackup job may take considerable time to complete if you are verifying backups of large sized VMs.

3. If you want to receive SNMP traps, select the Send SNMP trap check box.
   
   SNMP traps will be sent only if you configure global SNMP settings in Veeam Backup & Replication and on recipient's computer. For more information, see Specifying SNMP Settings.

4. If you want to receive notifications by email, select the Send email notifications to the following recipients check box. In the field below, specify recipient's email address. You can enter several addresses separated by a semicolon.
   
   Email notifications will be sent only if you configure global email notification settings in Veeam Backup & Replication. For more information, see Specifying Email Notification Settings.
NOTE:
If you enable the **Keep the application group running after the job completes** option at the **Application Group** step of the wizard, the **Skip validation for application group VMs** option will be automatically enabled.
Step 8. Specify Job Schedule

At the Schedule step of the wizard, select to manually run the SureBackup job or schedule the job at specific time, for example, after the corresponding backup job completes.

1. To define a job schedule, select the Run the job automatically check box. If this check box is not selected, you will have to manually start the job to perform recovery verification.

2. Choose the necessary schedule option for the job:
   - Daily at to start the job at specific time every day, on week days or on specific days.
   - Monthly at to start the job once a month on the specified day.

   **NOTE:**
   When you configure the job schedule, keep in mind possible date and time changes (for example, related to daylight saving time transition).

   - After this job to chain the job. Typically, a SureBackup job should run after the linked backup job completes. In this case, the SureBackup job will verify the VM backup created by the corresponding job.

     To create a chain of jobs, you must define the time schedule for the first job in the chain. For the rest of the jobs in the chain, at the Schedule step of the wizard, select the After this job option and choose the preceding job from the list.

3. In some cases, the linked backup job may not complete until the SureBackup job starts. If Veeam Backup & Replication finds out that the linked job is still running, the SureBackup job will fail to start. To overcome this situation, select the If some linked backup jobs are still running, wait up to check box and specify the necessary time period in the field on the right. If the linked job is still running, Veeam Backup & Replication will wait for the defined period of time and check the linked job after this period elapses.

   - If the linked job is finished within the specified period, the SureBackup job will start.
   - If the linked job is still running, the SureBackup job will not start.
NOTE:
The *After this job* function will only start a job if the first job in the chain is started automatically by schedule. If the first job is started manually, jobs chained to it will not be started.

<table>
<thead>
<tr>
<th>Schedule</th>
<th>Run the job automatically</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Virtual Lab</td>
<td></td>
</tr>
<tr>
<td>Application Group</td>
<td></td>
</tr>
<tr>
<td>Linked Jobs</td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td></td>
</tr>
</tbody>
</table>

- **Run the job automatically**
  - Daily at this time: 10:00 PM Everyday
  - Monthly at this time: 10:00 PM Fourth Saturday
  - After this job: Exchange Backup (Daily Backup Job)

- **Wait for backup jobs**
  - If some linked backup jobs are still running, wait for up to: 180 minutes
Step 9. Review Job Summary and Finish Working with Wizard

At the **Summary** step of the wizard, complete the procedure of SureBackup job configuration.

1. Review details of the SureBackup job.
2. If you want to start the job right after you finish working with the wizard, select the **Run the job when I click Finish** check box.
3. Click **Finish** to save the SureBackup job settings and close the wizard.

---

**Starting and Stopping SureBackup Job**

You can instruct the SureBackup job to verify the latest restore point of a VM backup or select a specific restore point to which the VM from the backup must be started.

**To start a VM from the latest restore point:**

1. Open the **Home** view.
2. In the inventory pane, click **SureBackup** under **Jobs**.
3. In the working area, select the SureBackup job and click **Start** on the ribbon. You can also right-click the SureBackup job and select **Start**. Veeam Backup & Replication will start VMs in the application group and verified VMs from the latest restore point and perform necessary tests for them.

**To start VMs from a specific point in time:**

1. Open the **Home** view.
2. In the inventory pane, select **SureBackup** under **Jobs**.
3. In the working area, select the SureBackup job and click **Start** on the ribbon. You can also right-click the SureBackup job and select **Start**.

4. In the **Restore Point** window, select an approximate date of the restore point creation. Veeam Backup & Replication will pick the most recent restore point prior to the selected day and start VMs from the application group and verified VMs from this restore point.

To stop a running SureBackup job session:

1. Open the **Home** view.
2. In the inventory pane, select **SureBackup** under **Jobs**.
3. In the working area, select the SureBackup job and click **Stop** on the ribbon. You can also right-click the SureBackup job and select **Stop**.

**Viewing Recovery Verification Job Statistics**

You can monitor how tests for verified VMs are performed while a recovery verification job is running.

To see the status of VM tests:

1. Open the **Home** view.
2. In the inventory pane, select **SureBackup** under **Jobs**.
3. In the working area, right-click a recovery verification job and select **Statistics**. You can also double-click the job in the list.

The job session window displays statistics for all VMs that are started during the SureBackup job: VMs from the application group in the specified order and VMs from linked jobs. For your convenience, these VMs are marked with different icons.

After the verified VM is powered on, its name is displayed as a hyperlink. You can click the link to open the VM console to see what is happening inside the VM or perform manual testing.

If some VM fails to be verified automatically, you can start it manually when this VM is powered off. To start a VM, right-click the VM in the list and select **Start**. If the application group has already been powered off by that time, it will be started again. After that, you can open the VM console and perform verification and testing manually.
If you enabled malware scan at the Settings step of the SureBackup job wizard, you can view the detailed logging of the scan process. To view logs, click the Scan Log button that will appear at the bottom of the job session window after the scan is complete.

Creating SureBackup Session Reports

You can generate HTML reports with statistics on the SureBackup job. A report contains detailed data on job sessions: job status, start and end time, details of the session performance, status of verified VMs and test results. You can generate a report for the whole SureBackup job or a specific job session/sessions.

The SureBackup job report contains data on all sessions initiated for a specific job. To generate a SureBackup job report:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select the SureBackup job and click Report on the ribbon. You can also right-click the SureBackup job and select Report.

The session report contains data on a single job session. To generate a session report:

1. Open the History view.
2. In the inventory pane, select Jobs.
3. In the working area, select the session and click **Report** on the ribbon. You can also right-click the session and select **Report**.

---

### SureBackup: Exchange SureBackup Job

<table>
<thead>
<tr>
<th>Session Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Success</td>
</tr>
<tr>
<td>Start time</td>
<td>12/29/2019 2:03:30 PM</td>
</tr>
<tr>
<td>End Time</td>
<td>12/29/2019 2:03:30 PM</td>
</tr>
<tr>
<td>Total tasks</td>
<td>4</td>
</tr>
<tr>
<td>Processed tasks</td>
<td>4</td>
</tr>
<tr>
<td>Duration</td>
<td>1:17:34</td>
</tr>
<tr>
<td>Failed tasks</td>
<td>0</td>
</tr>
<tr>
<td>Skipped tasks</td>
<td>0</td>
</tr>
</tbody>
</table>

**Virtual Machines Status**

<table>
<thead>
<tr>
<th>VM Name</th>
<th>Status</th>
<th>Start time</th>
<th>End time</th>
<th>Heartbeat Test</th>
<th>Ping Test</th>
<th>Custom script test</th>
<th>Validation test</th>
<th>Malware scan test</th>
</tr>
</thead>
</table>
XML Files with VM Roles Description

VM roles that you can assign to verified VMs and VMs from the application group are described in XML files. These XML files are stored in the `%ProgramFiles%\Veeam\Backup and Replication\Backup\SbRoles` folder on the backup server.

To add a new role, you must create a new XML file and save it to the SbRoles subfolder on the backup server. Do not save the XML file on the machine where the Veeam Backup & Replication console is installed — this will not affect the list of roles in Veeam Backup & Replication.

XML files describing VM roles have the following structure:

```xml
<SbRoleOptions>
  <Role>
    <Id>4CDC7CC4-A906-4de2-979B-E5F74C44832F</Id>
    <Name>Web Server</Name>
  </Role>
  <Options>
    <SbVerificationOptions>
      <ActualMemoryPercent>100</ActualMemoryPercent>
      <MaxBootTimeoutSec>300</MaxBootTimeoutSec>
      <AppInitDelaySec>120</AppInitDelaySec>
      <TestScripts>
        <TestScript>
          <Name>Web Server</Name>
          <Type>Predefined</Type>
          <TestScriptFilePath>Veeam.Backup.ConnectionTester.exe</TestScriptFilePath>
          <Arguments>%vm_ip% 80</Arguments>
        </TestScript>
      </TestScripts>
    </SbVerificationOptions>
    <HeartbeatEnabled>True</HeartbeatEnabled>
    <PingEnabled>True</PingEnabled>
  </Options>
</SbRoleOptions>
```

The XML file with the role description contains the following tags and parameters:

<table>
<thead>
<tr>
<th>Tag</th>
<th>Required/Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;SbRoleOptions&gt;</code></td>
<td>Required</td>
<td>Encapsulates the VM role file.</td>
</tr>
<tr>
<td><code>&lt;Role&gt;</code></td>
<td>Required</td>
<td>Parent tag for a role assigned to a VM. <code>&lt;SbRole&gt;</code>, <code>&lt;Id&gt;</code>, and <code>&lt;Name&gt;</code> are children of this tag.</td>
</tr>
<tr>
<td><code>&lt;SbRole&gt;</code></td>
<td>Required</td>
<td>Encapsulates basic information for a VM role: ID and name.</td>
</tr>
<tr>
<td><code>&lt;Id&gt;</code></td>
<td>Required</td>
<td>Unique identifier of a VM role.</td>
</tr>
<tr>
<td><code>&lt;Name&gt;</code></td>
<td>Required</td>
<td>Name of a VM role. The VM role name is displayed in the roles list on the Role tab.</td>
</tr>
<tr>
<td>Tag</td>
<td>Required/Optional</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&lt;Options&gt;</td>
<td>Required</td>
<td>Parent tag for startup and test script options to be used for the defined role.  &lt;SbVerificationOptions&gt;, &lt;ActualMemoryPercent&gt;, &lt;MaxBootTimeoutSec&gt;, &lt;AppInitDelaySec&gt;, &lt;TestScripts&gt;, &lt;Name&gt;, &lt;Type&gt;, &lt;TestScriptFilePath&gt;, &lt;Arguments&gt;, &lt;HeartbeatEnabled&gt;, &lt;PingEnabled&gt; are children of this tag.</td>
</tr>
<tr>
<td>&lt;SbVerificationOptions&gt;</td>
<td>Required</td>
<td>Encapsulates options data for a VM role.</td>
</tr>
<tr>
<td>&lt;ActualMemoryPercent&gt;</td>
<td>Optional</td>
<td>Percent of the original memory level that must be pre-allocated to a verified VM on the system boot.</td>
</tr>
<tr>
<td>&lt;MaxBootTimeoutSec&gt;</td>
<td>Optional</td>
<td>Maximum allowed time to boot a VM.</td>
</tr>
<tr>
<td>&lt;AppInitDelaySec&gt;</td>
<td>Optional</td>
<td>Duration of time for which Veeam Backup &amp; Replication must wait after the VM is successfully booted in the virtual lab. After this time elapses, Veeam Backup &amp; Replication will run test scripts. Time is specified in seconds.</td>
</tr>
<tr>
<td>&lt;TestScripts&gt;</td>
<td>Optional</td>
<td>Encapsulates test script data for a VM role.</td>
</tr>
<tr>
<td>&lt;Name&gt;</td>
<td>Optional</td>
<td>Name of a VM role. The VM role name is displayed on the Test Scripts tab.</td>
</tr>
<tr>
<td>&lt;Type&gt;</td>
<td>Optional</td>
<td>Type of the test script: Predefined or Custom.</td>
</tr>
<tr>
<td>&lt;TestScriptFilePath&gt;</td>
<td>Optional</td>
<td>Path to an executable file of the test script to be performed. The path can be absolute or relative.</td>
</tr>
<tr>
<td>&lt;Arguments&gt;</td>
<td>Optional</td>
<td>Arguments to be passed to the script. You can use the following variables: &lt;br&gt; • %vm_ip% – IP address of a verified VM. &lt;br&gt; or &lt;br&gt; • %vm_fqdn% – a fully qualified domain name of a verified VM. &lt;br&gt; • %log_path% – path to a log file to which verification results are stored.</td>
</tr>
<tr>
<td>&lt;HeartbeatEnabled&gt;</td>
<td>Required</td>
<td>Must a heartbeat test be enabled for this VM role: True or False.</td>
</tr>
<tr>
<td>Tag</td>
<td>Required/ Optional</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><code>&lt;PingEnabled&gt;</code></td>
<td>Required</td>
<td>Must a ping test be enabled for this VM role: True or False.</td>
</tr>
</tbody>
</table>
Manual Recovery Verification

Beside automatic recovery verification, you can perform manual verification of VM backups. Manual verification can be performed with all editions of Veeam Backup & Replication.

Boot Test

To perform a VM boot test, perform Instant VM Recovery for the verified VM. Power on the VM but do not connect the VM to the production network to avoid conflicts with the original VM.

Application Test

To perform an application test:

1. Create an isolated network.
2. Perform Instant VM Recovery to restore the verified VM. At the **Network** step of the wizard, select to connect the VM to the created isolated network.

The same procedure must be performed for all VMs that run applications on which the verified VM is dependent such as domain controller and DNS. All VMs must be connected to the same isolated network and started in the correct order: for example, DNS > domain controller > verified VM.
On-Demand Sandbox

If you need to perform tests for production VMs, you can use an On-Demand Sandbox™. The On-Demand Sandbox is an isolated virtual environment where you can start one or more VMs from backups. You can use the On-Demand Sandbox to perform the following tasks:

- Troubleshoot problems with VMs
- Test software patches and upgrades
- Install new software and so on

The On-Demand Sandbox uses a virtual lab — an isolated environment that is fully fenced off from the production environment. To start a VM in the virtual lab, Veeam Backup & Replication uses Instant VM Recovery. When you finish working with the On-Demand Sandbox, Veeam Backup & Replication unpublishes the VM and powers off the virtual lab.

To create the On-Demand Sandbox, you must configure the following objects:

- Virtual lab in which VMs will be started. For more information, see Virtual Lab.
- Application group. The application group must include all VMs that you want to start in the On-Demand Sandbox. This can be one VM or a group of VMs that work together. For more information, see Application Group.
- SureBackup job. The virtual lab and application group must be linked to this job. For more information, see SureBackup Job.
Configuring On-Demand Sandbox

To configure the On-Demand Sandbox, perform the following steps:

1. Configure a virtual lab in which you plan to start VMs. For more information, see Creating Virtual Lab.

2. Configure an application group. The application group must contain all VMs that you plan to start in the On-Demand Sandbox and all VMs on which these VMs are dependent. For more information, see Creating Application Group.

3. Configure a SureBackup job:
   a. Launch the New SureBackup Job wizard.
   b. At the Virtual Lab step of the wizard, select the configured virtual lab.
   c. At the Application Group step of the wizard, select the configured application group.
   d. Select the Keep the application group running after the job completes check box.
   e. Configure other job settings as required and save the job settings.

To start VMs in the On-Demand Sandbox, run the SureBackup job:

1. Open the Home view.
2. In the inventory pane, select SureBackup.
3. In the working area, right-click the configured SureBackup job and select Start or Start to.
Veeam Backup & Replication will start the virtual lab and power on VMs from the application group in the virtual lab. You will be able to connect to VMs and perform tests for them.
Data Recovery

Veeam Backup & Replication offers a number of recovery options for various disaster recovery scenarios:

- **Instant VM Recovery** enables you to instantly start a VM directly from a backup file.
- **Entire VM recovery** enables you to recover a VM from a backup file to its original or another location.
- **VM files restore** enables you to recover separate VM files (virtual disks, configuration files and so on).
- **Guest OS File Recovery** enables you to recover individual guest OS files from Windows, Linux, Mac and other guest OS file systems.

Veeam Backup & Replication uses the same image-level backup for all data recovery operations. You can restore VMs, VM files and individual guest OS files to the most recent state or to any available restore point.

To view and recover Microsoft Active Directory, Microsoft SQL Server, Microsoft SharePoint, Microsoft Exchange or Oracle application items, you can use the capabilities of Veeam Backup Explorers. For more information, see [Veeam Backup Explorers User Guide](#).

**NOTE:**

Veeam Backup & Replication provides backward compatibility: backups created with previous product versions can be restored with later product versions.

Keep in mind that if a job is unable to complete within 21 days period, it will be stopped with the 'Failed' status.
Instant VM Recovery

With Instant VM Recovery, you can immediately restore different workloads as VMs to your production environment by running them directly from the compressed and deduplicated backup files. The supported types of backup files are listed in the Performing Instant VM Recovery of Workloads to Hyper-V VMs and Performing Instant VM Recovery of Workloads to VMware vSphere VMs sections.

Instant VM Recovery helps improve recovery time objectives, minimize disruption and downtime of production workloads.

Instant VM Recovery is performed in the following way:

1. Veeam Backup & Replication reads the workload configuration from the backup file in the backup repository and creates a dummy VM with empty disks on the target host. The created VM has the same settings as the workload in the backup file. Note that Veeam Backup & Replication pre-allocates disk space required for the restored VM at the beginning of the Instant VM Recovery process.

2. Veeam Backup & Replication initiates creation of a protective snapshot for the dummy VM and the VM is started. If the Instant VM Recovery process fails for some reason, the protective snapshot guarantees that no data is lost.

3. On the backup repository and on the target host, Veeam Backup & Replication starts a pair of Veeam Data Movers that are used to mount the VM disks from the backup file to the dummy VM.

4. On the target host, Veeam Backup & Replication starts a proprietary Veeam driver. The driver redirects requests to the file system of the recovered VM (for example, when a user accesses some application) and reads necessary data from the backup file in the backup repository via the pair of Veeam Data Movers that maintain the disk mount.

To finalize VM recovery, you can migrate the VM to the production storage. When you begin the migration process, Veeam Backup & Replication starts another pair of Veeam Data Movers on the backup repository and on the target host. The second pair of Veeam Data Movers copies data of the recovered VM from the backup repository to the target host in the background, and populates disks of the VM started on the target host.

The driver on the target host knows which data has already been restored permanently and does not redirect requests to such data, reading it directly from the disks of the restored VM. Thus, performance of the instantly recovered VM will increase as more of the data is copied. When the VM is restored completely, all Veeam Data Movers are stopped.

If you do not perform VM migration, all operations on the file system of the recovered VM will be carried out via the disk mount connection. This can be helpful if you will only need the instantly recovered VM for a short period of time, to perform one or two tasks (for example, look up some information stored on the backed-up VM).
Instant VM Recovery supports bulk processing so you can immediately restore multiple workloads at once. If you perform Instant VM Recovery for several workloads, Veeam Backup & Replication uses the resource scheduling mechanism to allocate and use optimal resources required for Instant VM Recovery. For details, see Resource Scheduling.

**IMPORTANT!**

Before you start the Instant VM Recovery, make sure that the **Disable changed block tracking for this host** option is not selected for a host to which you plan to restore a workload. If this option is selected for the host, the driver required for work of Instant VM Recovery will be disabled. For more information, see Configuring Connected Volumes.
Performing Instant VM Recovery of Workloads to Hyper-V VMs

To recover workloads as Hyper-V VMs, you can use the following backups:

- Backups of Microsoft Hyper-V virtual machines created with Veeam Backup & Replication
- Backups of virtual and physical machines created with Veeam Agent for Microsoft Windows
- Backups of Nutanix AHV virtual machines created with Veeam Backup for Nutanix AHV
  Support of instant recovery of AHV VMs to Hyper-V environment is "experimental". For details, see the Veeam Experimental Support Statement.
- Backups of Amazon EC2 instances created with Veeam Backup for AWS*
- Backups of Microsoft Azure virtual machines created with Veeam Backup for Microsoft Azure*

* After backups are copied from external repositories using backup copy jobs.

Before you start Instant VM Recovery, check prerequisites. Then use the Instant VM Recovery to Hyper-V wizard to recover workloads as VMs.

Before You Begin

Before you perform Instant VM Recovery, consider the following:

- Make sure that the Disable changed block tracking for this host option is not selected for a host to which you plan to restore a workload. If this option is selected for the host, the driver required for work of Instant VM Recovery will be disabled. For more information, see Configuring Connected Volumes.
- You can restore a workload from a backup that has at least one successfully created restore point.
- If you restore a workload to the production network, make sure that the original workload is powered off to avoid conflicts.
- If you want to scan recovered VM data for viruses, check the secure restore requirements and limitations.
- On non-Microsoft Windows SMB3 storage, for example, Tintri, Veeam Backup & Replication may display the "Failed to disable integrity bit on disk N" warning during the restore process. You can ignore this warning for non-Microsoft Windows SMB3 storage.
- The restored VM will have the same MAC address as the original workload. Therefore, if you restore the workload to the same Hyper-V host where the original workload is running, a MAC address conflict may occur. To overcome this situation, power off the original workload before you start the restore process.
- [For Nutanix AHV VMs] The restored VM will not be connected to a network. You must connect to the network manually.
- [For Nutanix AHV VMs] Instantly restored VM will have default virtual hardware settings: 2 CPU cores, 4GB RAM and one network adapter. If you want to change the default settings, turn off the VM and set the required virtual resources. Note that you must not switch off the instant recovery session before turning off the VM.
Step 1. Launch Instant VM Recovery Wizard

To launch the **Instant VM Recovery to Hyper-V** wizard, do one of the following:

- On the **Home** tab, click **Restore** and select one of the following:
  - **Microsoft Hyper-V > Restore from backup > Entire VM restore > Instant VM recovery** — if you want to restore VMs from a VM backup created with Veeam Backup & Replication.
  - **Agent > Entire machine restore > Instant recovery to Microsoft Hyper-V** — if you want to restore physical machines from a backup created with Veeam Agent for Microsoft Windows.

- Open the **Home** view. In the inventory pane, select **Backups**. In the working area, expand a backup and do one of the following:
  - Select workloads that you want to restore and click **Instant Recovery > Hyper-V** on the ribbon.
  - Select workloads that you want to restore, right-click them and select **Instant VM recovery > Hyper-V**.

---

**Restore from Backup**

Select the type of restore you want to perform:

- **Instant VM recovery**
  - Instantly recovers a virtual machine by running it directly from backup. Remember to finalize the restore by moving the VM to your production storage.

- **Instant VM recovery to VMware vSphere**
  - Instantly recovers any image-level backup as a vSphere VM by running it directly from a repository. Remember to finalize the restore by moving the VM to your production storage.

- **Entire VM restore**
  - Restores entire VM to the original or a new location, and registers it with the Hyper-V infrastructure.

- **VM files restore (VSV, BIN, XML)**
  - Restores individual VM files to the specified location.

- **Restore to Amazon EC2**
  - Restores any backup to the Amazon EC2 virtual machine, contains options for on-prem and cloud restores.

- **Restore to Microsoft Azure**
  - Restores any backup to the Microsoft Azure infrastructure as a service (IaaS) virtual machine, contains options for on-prem and cloud restores.

---

1027 | Veeam Backup & Replication | User Guide for Microsoft Hyper-V
Step 2. Select Workloads

At the **Machines** step of the wizard, select one or more workloads that you want to recover.

To select workloads:

1. Click **Add**.

2. Select where to browse for workloads:
   - **From infrastructure** — browse the virtual environment and select workloads or workload containers to restore. If you choose a workload container, Veeam Backup & Replication will expand it to a plain workload list.
     
     When you add a workload to the list, Veeam Backup & Replication displays information about the most recent restore point in the **Restore point** column. If no restore point is available for the added workload, Veeam Backup & Replication will display a warning next to this workload.
   - **From backup** — browse existing backups and select workloads under backup jobs.

3. Click **Add**.

To quickly find workloads within the created backups, you can use the search field at the **Machines** step of the wizard:

1. Enter a workload name or a part of it in the search field. Veeam Backup & Replication will display matches.

2. If the workload is not in the list, click the **Show more** link to browse the backups.
Step 3. Select Restore Point

By default, Veeam Backup & Replication uses the latest valid restore points to recover the workloads. You can recover a workload to an earlier state, if necessary. If you have chosen to recover multiple workloads, you can select a restore point for each workload in the list.

To select a restore point:

1. In the **Machines to restore** list, select a workload.
2. Click **Point** on the right.
3. In the **Restore Points** window, select a restore point from which you want to recover the workload.

   In the **Location** column, you can view a name of a backup repository or object storage repository where a restore point resides.
Step 4. Select Recovery Mode

This step is available only if you restore Hyper-V VMs.

At the **Recovery Mode** step of the wizard, choose the necessary restore mode:

- Select **Restore to the original location** if you want to restore VMs with initial settings and to original location. If this option is selected, you will pass directly to the **Reason step** of the wizard.

- Select **Restore to a new location, or with different settings** if you want to restore VMs to a different location and/or with different settings (such as VM location, network settings and so on). If this option is selected, the **Instant VM Recovery to Hyper-V** wizard will include additional steps for customizing machine settings.

**IMPORTANT!**

If you recover a VM to the original location, consider the following:

- If the original VM still exists in the virtual infrastructure, its disks will be removed. Make sure that other VMs in the virtual environment do not use these disks.
- The VM settings contain the ID of the VM group to which the machine belongs. To restore the VM to the original VM group, you must not delete the original VM group or change the hierarchy of its parent VM groups.
Step 5. Select Target Host

The Host step of the wizard is available if you have chosen to change the location and settings for the recovered VMs.

At the Host step of the wizard, specify a target host for the recovered VMs:

1. In the VM location list, select one or more VMs and click Host.
2. From the virtual environment, select a standalone or clustered host where the selected VMs must be registered.

To quickly find the necessary object, use the search field at the bottom of the Select Host window:

1. Click the button on the left of the field to select the necessary type of object that should be searched for: SCVMM, Cluster or Host.
2. Enter an object name or a part of it in the search field.
3. Click the Start search button on the right or press [Enter].

IMPORTANT!

You cannot restore workloads to a Microsoft Hyper-V 2008 R2 Cluster due to Microsoft's limitations. You can restore workloads to Microsoft Hyper-V 2012 Failover Cluster or Microsoft Hyper-V 2012 R2 Failover Cluster.

If you need to restore a workload to a Microsoft Hyper-V 2008 R2 Cluster, you can use the following workaround:

1. Restore the workload to any node of the cluster.
2. Configure the restored VM as highly available. For more information, see Microsoft Docs.
Step 6. Select Target Datastore

The **Datastore** step of the wizard is available if you have chosen to change the location and settings for the recovered VMs.

You can place entire VMs to a particular location or choose to store configuration files and disk files of recovered VMs in different locations.

To specify a destination location:

1. Select one or more VMs in the list and click **Path**.
2. Point to a folder where VM files must be stored.

If configuration and disk files of a VM must be placed to different locations:

1. Expand a VM in the list.
2. Select the necessary file type.
3. Click **Path** and point to a folder where VM files must be stored. To create a dedicated folder for storing files of the recovered VM, click **New Folder** at the bottom of the window.

You can choose a Microsoft SMB3 shared folder as a destination for a recovered VM.

1. Select a VM in the list and click **Path** at the bottom of the window.
2. Type a path to the SMB3 shared folder in the search field at the bottom of the **Select Folder** window. The path must be specified in the UNC format, for example: `\172.16.11.38\Share01`.

The host or cluster on which you register the VM must have access to the specified SMB3 shared folder. If you are using SCVMM 2012 or later, the server hosting the Microsoft SMB3 shared folder must be registered in SCVMM as a storage device. For more information, see [Microsoft Docs](https://docs.microsoft.com).
Step 7. Specify Network Mapping

The **Network** step of the wizard is available if you have chosen to change the location and settings for the recovered VMs.

If you plan to restore workloads to new locations, for example, other sites with different sets of networks, you can map source site networks to target site networks. Veeam Backup & Replication will use the network mapping table to update configuration files of restored VMs on the fly, during the Instant VM Recovery process.

To change networks to which the restored VMs will be connected:

1. In the **Network** connections list, select one or more workloads and click **Network**.
   
   If a workload is connected to multiple networks, expand the workload, select a network to map and click **Network**.

2. The **Select Network** section displays all networks to which the target host or cluster is connected. In the list of available networks, select a network to which the selected workload must be connected after restore.
   
   To quickly find a network, enter a name or a part of it in the search field. Then, click the **Start search** button or press [Enter].

If you do not want to connect the restored VM to any virtual network, select the original workload in the list and click **Disconnect**.

---

![Network Mapping Table](image-url)
Step 8. Change VM Name and UUID

The Name step of the wizard is available if you have chosen to change the location and settings for restored VMs.

You can change a name of each restored VM and select whether you want to preserve their UUIDs or change them. It is recommended that you specify a new name and generate a new UUID for a VM to prevent conflicts if the original workload still resides in the production environment. The name and ID change is not required if the original workload no longer exists, for example, it was permanently deleted.

To change a VM name:

1. In the Virtual machines list, select one or more VMs and click Name.
2. In the Change Name section, enter a new name explicitly or specify a change name rule by adding a prefix and/or suffix to the original VM name.

You can also change VM names directly in the list:

1. Select a VM in the list.
2. Click the New Name field and enter the name to be assigned to the recovered VM.

You can specify how Veeam Backup & Replication must handle unique identifiers of the recovered VM. By default, the recovered VM is identified with the same UUIDs as the original workload. If necessary, you can assign a new UUID to the recovered VM.

To view or change VM identification settings:

1. Select one or more VMs in the list and click VM UUID.
2. Select to preserve the UUID or generate a new UUID.
Step 9. Specify Secure Restore Settings

This step is available if you restore Microsoft Windows VMs and restore them to a new location or with different settings.

You can instruct Veeam Backup & Replication to perform secure restore — scan VM data with antivirus software before restoring the VM to the production environment. For more information on secure restore, see Secure Restore.

To specify secure restore settings:

1. Select the **Scan the restored machine for malware prior to performing the recovery** check box.
2. Select which action Veeam Backup & Replication will take if an antivirus software finds a virus threat:
   - **Proceed with recovery but disable network adapters.** Select this action if you want to restore the VM with disabled network adapters (NICs).
   - **Abort VM recovery.** Select this action if you want to cancel the restore session.
3. Select the **Scan the entire image** check box if you want the antivirus software to continue the VM data scan after the first malware is found. For information on how to view results of the malware scan, see Viewing Malware Scan Results.
Step 10. Specify Restore Reason

At the **Reason** step of the wizard, enter a reason for performing Instant VM Recovery of the workloads. The information you provide will be saved in the session history and you can reference it later.

**TIP:**
If you do not want to display the **Reason** step of the wizard in future, select the **Do not show me this page again** check box.
Step 11. Verify Instant VM Recovery Settings

At the Summary step of the wizard, specify additional settings for Instant VM Recovery:

1. If you want to start the recovered VMs on the target host, select the Power on target VM after restoring check box.

2. Check settings of Instant VM Recovery and click Finish. Veeam Backup & Replication will recover selected workloads in the specified destination.
Step 12. Finalize Instant VM Recovery

After the VMs have been successfully recovered, you must finalize the process. For this, test the recovered VMs and decide whether to migrate them to production environment or stop publishing.

- Testing recovered VMs
- Migrating recovered VMs
- Stop publishing recovered VMs

Testing Recovered VMs

Before you migrate the recovered VMs to production, you can open VM consoles in Veeam Backup & Replication or in the Hyper-V client.

To open a VM console in Veeam Backup & Replication:

1. Open the Home view.
2. In the inventory pane, select the Instant Recovery node.
3. In the working area, right-click a VM and select Open VM console.

If the test fails, you can stop publishing the recovered VMs. For details, see Stop Publishing Recovered VMs.

Migrating Recovered VMs

When Veeam Backup & Replication migrates VMs, it transfers VM disks data to the production storage that you have selected as a destination for the recovered VMs.

To migrate a recovered VM to production:

1. Open the Home view.
2. In the inventory pane, select the **Instant Recovery** node.

3. In the working area, right-click a VM and select **Migrate to production**.

![Image of Veeam Backup & Replication interface]

**NOTE:**

The following information applies if you recover Hyper-V VMs.

After the migration is finished, and if the selected destination differs from the original location, the original VMs still exist. If you do not need them, you must manually remove them in the Hyper-V client.

**Stop Publishing Recovered VMs**

If your tests have failed, you can stop publishing the recovered VMs. This will remove the recovered VMs from the storage that you selected as the destination for recovery.

**IMPORTANT!**

If the destination is the original location, both the original and recovered VMs are removed.

To remove a recovered VM:

1. Open the **Home** view.
2. In the inventory pane, select the **Instant Recovery** node.
3. In the working area, right-click a VM and select **Stop publishing**.
Performing Instant VM Recovery of Workloads to VMware vSphere VMs

To restore workloads as VMware vSphere VMs, you can use the following backups:

- Backups of Microsoft Hyper-V virtual machines created with Veeam Backup & Replication
- Backups of virtual and physical machines created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux
- Backups of Nutanix AHV virtual machines created with Veeam Backup for Nutanix AHV
- Backups of Amazon EC2 instances created with Veeam Backup for AWS
- Backups of Microsoft Azure virtual machines created with Veeam Backup for Microsoft Azure

If you need to recover workloads as Hyper-V VMs, see the Performing Instant VM Recovery of Workloads to Hyper-V VMs section.

Before you start Instant VM Recovery, check prerequisites. Then use the Instant Recovery to VMware wizard to recover workloads.

Before You Begin

Before you perform Instant VM Recovery, consider the following:

- You can restore a workload from a backup that has at least one successfully created restore point.
- If you restore a workload to the production network, make sure that the original workload is powered off.
- If you want to scan restored VM data for viruses, check the secure restore requirements and limitations.
- You must provide enough free disk space in vPower NFS datastore. The minimum amount of free space must equal the RAM capacity of the recovered VM plus 200MB. For example, if the restored VM has 32 GB of virtual RAM, 32.2 GB of free space is required.

By default, vPower NFS datastore locates in the IRCache folder on a volume with the maximum amount of free space, for example, C:\ProgramData\Veeam\Backup\IRCache. The vPower NFS datastore is not used when you select to redirect virtual disk updates to a VMware vSphere datastore when configuring the job.

- [For Veeam Quick Migration with Smart Switch] In addition to the disk space mentioned above, you need to provide more disk space in vPower NFS datastore. The minimum amount of free space must equal the RAM capacity of the recovered VM.
- [For Nutanix AHV VMs] Instantly restored VM will have default virtual hardware settings: 2 CPU cores, 4GB RAM and one network adapter. If you want to change the default settings, turn off the VM and set the required virtual resources. Note that you must not switch off the instant recovery session before turning off the VM.
Step 1. Launch Instant VM Recovery Wizard

To launch the **Instant Recovery to VMware** wizard, do one of the following:

- **On the Home tab**, click **Restore** and select one of the following:
  - **Microsoft Hyper-V** > **Restore from backup** > **Entire VM restore** > **Instant VM recovery to VMware vsphere** — if you want to restore VMs from a VM backup created with Veeam Backup & Replication.
  - **Agent** > **Entire machine restore** > **Instant recovery to VMware vsphere** — if you want to restore physical machines from a backup created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux.
  - **Amazon EC2** > **Entire machine restore** > **Instant VM recovery to VMware vsphere** — if you want to restore Amazon EC2 instances from a backup backup created with Veeam Backup for AWS.
  - **Azure IaaS** > **Entire machine restore** > **Instant VM recovery to VMware vsphere** — if you want to restore Azure VMs from a backup backup created with Veeam Backup for Microsoft Azure.

- **Open the Home view**. In the inventory pane, select **Backups**. In the working area, expand a backup and do one of the following:
  - Select workloads that you want to restore and click **Instant Recovery > VMware** on the ribbon.
  - Select workloads that you want to restore, right-click them and select **Instant VM recovery > VMware**.

### Restore from Backup

Select the type of restore you want to perform.

- **Instant VM recovery** — instantly recover a virtual machine by running it directly from backup. Remember to finalize the restore by moving the VM to your production storage.
- **Instant VM recovery to VMware vsphere** — instantly recover any image-level backup as a vSphere VM by running it directly from a repository. Remember to finalize the restore by moving the VM to your production storage.
- **Entire VM restore** — restores entire VM to the original or a new location, and registers it with the Hyper-V infrastructure.
- **VM files restore (VSV, BIN, XML)** — restores individual VM files to the specified location.
- **Restore to Amazon EC2** — restores any backup to the Amazon EC2 virtual machine, contains options for on-prem and cloud restores.
- **Restore to Microsoft Azure** — restores any backup to the Microsoft Azure infrastructure as a service (IaaS) virtual machine, contains options for on-prem and cloud restores.
Step 2. Select Workloads

At the **Machines** step of the wizard, select one or more workloads that you want to recover.

To select workloads:

1. Click **Add**.
2. In the list of backup jobs, expand a job and select workloads.

To quickly find workloads within the created backups, you can use the search field:

1. Enter a workload name or a part of it in the search field. Veeam Backup & Replication will display matches.
2. If the workload is not in the list, click the **Show more** link to browse the backups.
Step 3. Select Restore Point

By default, Veeam Backup & Replication uses the latest valid restore point to recover workloads. You can recover a workload to an earlier state, if necessary.

To select a restore point for a workload:

1. In the Machines to restore list, select a workload.
2. Click the Point button on the right.
3. In the Restore Points window, select a restore point from which you want to recover the workload.
Step 4. Specify Destination for Restored VMs

Specify a destination for the restored VMs. Destination settings differ depending on the number of workloads that you restore:

- Specifying Destination for One VM
- Specifying Destination for Multiple VMs

Specifying Destination for One VM

The Destination step of the wizard is available if you restore one workload.

Specify the following settings for the restored VM:

1. In the Restored VM name field, specify a name for the restored VM.
2. In the Host field, specify a host on which the VM must run.
3. In the VM folder field, specify a folder to which the restored VM files must be placed.
4. In the Resource pool field, select a resource pool to which the VM must be placed.
5. In the Networks section, you can see all networks to which the original workload is connected. Select a network which you want to map and click Choose.

The Select Network window displays all networks to which the target host or cluster is connected. In the list of networks, select a network to which the restored VM must be connected.
6. Click the **Advanced** button and choose whether to preserve the workload BIOS UUID or generate a new one.

   It is recommended that you select to generate a new BIOS UUID to prevent conflicts if the original workload still resides in the production environment. The BIOS UUID change is not required if the original workload no longer exists, for example, it was deleted.

---

### Specifying Destination for Multiple VMs

The following steps are available if you restore multiple workloads.

If you restore multiple workloads, specify the following settings for the destination:

1. **At the Host step of the wizard, select a target host.**
2. **At the Folder step of the wizard, specify VM settings.**
3. **At the Network step of the wizard, specify network settings.**

### Selecting Host

At the **Host** step of the wizard, specify a target host and resource pool for the restored VMs:

1. In the list, select one or more VMs and click the **Host** button.
2. From the virtual environment, select a standalone or clustered host where the selected VMs must be registered.
3. Select one or more VMs and click the **Pool** button.
4. In the list, select a resource pool where the VMs must be stored.
To quickly find the necessary object, use the search field at the bottom of the Select Host and Select Resource Pool windows:

1. Click the button on the left of the search field to select the type of objects to search for.
2. Enter an object name or a part of it in the search field.
3. Click the Start search button on the right or press [Enter].

Specifying VM Settings

For each restored VM, you can change a VM name, BIOS UUID and folder where VM files must be stored. It is recommended that you specify a new name and generate a new BIOS UUID to prevent conflicts if the original workload still resides in the production environment. The name and BIOS UUID change is not required if the original workload no longer exists, for example, it was permanently deleted.

To specify a folder:

1. In the VM settings list, select one or more VMs.
2. Click the Folder button.
3. Select a folder where VM files must be stored.

To change a restored VM name and BIOS UUID:

1. In the VM settings list, select one VM.
2. Click the Customize button.
3. In the VM Settings window, do the following:
   o In the Set name to field, specify a new VM name.
To add a prefix and suffix to the name specified in the `Set name to` field, select `Add prefix` and `Add suffix` check boxes.

In the `BIOS UUID` section, specify whether to preserve or generate a new BIOS UUID.

### Specifying Network Settings

Veeam Backup & Replication uses the network mapping table to update configuration files of VMs on the fly, during the Instant VM Recovery process.

To change networks to which the restored VMs must be connected:

1. In the list, select one or more workloads and click the **Network** button.
   
   If a workload is connected to multiple networks, you can select a network to map and click **Network**.

2. The **Select Network** window displays all networks to which the target host or cluster is connected. In the list, select a network to which the restored VM must be connected after restore.

   To quickly find a network, enter a name or a part of it in the search field. Then, click the **Start search** button or press [Enter].
If you do not want to connect a restored VM to any virtual network, select the original workload and click **Disconnected**.

![Instant Recovery to VMware window](image)

### Network

Select how virtual networks map to each other between original and new VM location.

<table>
<thead>
<tr>
<th>Network</th>
<th>Source</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>winrv21</td>
<td>Intel(R) 1000 Gigabit Network Connected</td>
<td>VM Network</td>
</tr>
<tr>
<td>winrv22</td>
<td>Intel(R) 1000 Gigabit Network Connected</td>
<td>Not connected</td>
</tr>
</tbody>
</table>

Select multiple VMs to apply settings change in bulk. 

- **Network...**
- **Disconnected**

- **Previous**
- **Next**  
- **Finish**  
- **Cancel**
Step 5. Select Destination for Virtual Disk Updates

At the **Datastore** step of the wizard, you can select where to store redo logs when a VM is running from a backup. Redo logs are auxiliary files used to keep changes that take place while the restored VM runs.

By default, redo logs are stored on the vPower NFS server. You can store redo logs on any datastore in the virtual environment, if necessary. Redirecting redo logs improves recovery performance but makes Storage vMotion not possible for ESXi 5.5. When the recovery job finishes, Veeam Backup & Replication deletes redo logs.

To redirect redo logs:

1. Select the **Redirect write cache** check box.
2. Click **Choose** and select a datastore in the list.

**IMPORTANT!**

Consider the following:

- If you migrate workloads to the same datastore cluster that is used as the destination for redirecting virtual disk updates, you must enable the **Force Veeam transport usage** check box at the **Transfer** step of the **Quick Migration** wizard. Otherwise, your migrated workload may be deleted.

- If you restore workloads to the same datastore that is used as the destination for redirecting virtual disk updates, Veeam Backup & Replication uses Veeam Quick Migration instead of Storage vMotion. Such behavior prevents data loss due to a bug in VMware Storage vMotion. For more information on migration, see the **Quick Migration** section in the User Guide for VMware vSphere.

- If the size of restored VM disks is greater than 2 TB, you must not place redo logs on a VSAN datastore. Otherwise, Veeam Backup & Replication will fail to create a snapshot for the restored VM. For more information, see **VMware Docs**.
**Step 6. Configure Helper Appliance**

This step is available if you restore Linux VMs or physical machines.

Veeam Backup & Replication restores Linux machines to a standalone host over a helper appliance. The helper appliance is an auxiliary Linux-based VM registered by Veeam Backup & Replication. The appliance is quite small — around 50 MB. It requires 1024 MB RAM and takes around 10 seconds to boot.

To configure the helper appliance:

1. [For multiple machines] In the **Network** list, expand a host and select one machine.
2. Click the **Configure** button.
3. In the **Network Settings** window, select a network for the helper appliance.
   a. Click the **Browse** button near the **Production network** field.
   b. In the **Select Network** window, Veeam Backup & Replication shows the list of networks to which the target host is connected. In this list, select a network to which the helper appliance must be connected.
      
      Mind that the backup server and mount server must have access to the helper appliance over the network.
4. Specify IP address settings for the helper appliance:
   o If you use a DHCP server in the network and want to obtain IP address for the helper appliance automatically, make sure that the **Obtain an IP address automatically** option is selected.
   o To manually specify the IP address of the helper appliance, select the **Use the following IP address** option and enter the IP address, subnet mask and default gateway address in the corresponding fields.
5. Specify DNS server settings:
   o If you use a DHCP server in the network and the IP address for the DNS server is obtained automatically, make sure that the **Obtain DNS server address automatically** option is selected.
To manually specify the IP address of the DNS server, select the **Use the following DNS server address** option and enter the IP addresses of the preferred and alternate DNS servers in the corresponding fields.
Step 7. Specify Secure Restore Settings

This step is available if you restore Microsoft Windows workloads.

You can instruct Veeam Backup & Replication to perform secure restore — scan restored VM data with antivirus software before restoring VMs to the production environment. For more information on secure restore, see Secure Restore.

To specify secure restore settings:

1. Select the **Scan machine for virus threats prior performing recovery** check box.
2. Select which action Veeam Backup & Replication will take if an antivirus software finds a virus threat:
   - **Proceed to recovery but disable VM network adapters.** Select this action if you want to restore VMs with disabled network adapters (NICs).
   - **Abort VM recovery.** Select this action if you want to cancel the restore session.
3. Select the **Scan entire VM for virus threats** check box if you want the antivirus software to continue scanning VM data after the first malware is found. For information on how to view results of the malware scan, see Viewing Malware Scan Results.
Step 8. Specify Restore Reason

At the **Reason** step of the wizard, enter a reason for performing Instant VM Recovery. The information you provide will be saved in the session history and you can reference it later.

If you do not want to display the **Reason** step of the wizard in future, select the **Do not show me this page again** check box.
Step 9. Verify Instant VM Recovery Settings

At the **Summary** step of the wizard, specify additional settings for Instant VM Recovery:

1. If you recover production workloads that have failed and you want to restore them with initial network settings, select the **Connect VMs to network** check box.

   If you recover workloads for testing disaster recovery while the original workloads are still running, leave this check box unselected. Before you power on the recovered VMs, you must disconnect them from the production network and connect to a non-production network to avoid conflicts.

2. To start the VMs right after restore, select the **Power on target VMs after restoring** check box. If you recover the workloads to the production network, make sure that the original workloads are powered off.

3. Check settings that you have specified for Instant VM Recovery and click **Finish**.
4. Check that the publishing process has started and click **Close**.
Step 10. Finalize Instant VM Recovery

After the VMs have been successfully recovered, you must finalize the process. For this, test the recovered VMs and decide whether to migrate them to production environment or stop publishing.

- Testing recovered VMs
- Migrating recovered VMs
- Stop publishing recovered VMs

Testing Recovered VMs

Before migrating recovered VMs to production, you can open VM consoles in Veeam Backup & Replication or in the VMware vSphere client.

To open a VM console in Veeam Backup & Replication:

1. Open the **Home** view.
2. In the inventory pane, select the **Instant Recovery** node.
3. In the working area, right-click a VM and select **Open VM console**.

Migrating Recovered VMs

If the VMs were recovered successfully, you can migrate them to the production environment.

To migrate a recovered VM to the production environment:

1. Open the **Home** view.
2. In the inventory pane, select the **Instant Recovery** node.
3. In the working area, right-click a VM and select **Migrate to production**. Veeam Backup & Replication will launch the Quick Migration wizard. For more information, see the Quick Migration section in the Veeam Backup & Replication User Guide.

During migration, Veeam Backup & Replication will restore the VM from the backup file and additionally move all changes that were made while the VM was running from the backup in the Instant Recovery mode.

Stop Publishing Recovered VMs

If your tests have failed, you can stop publishing the recovered VMs. This will remove the recovered VMs from the host that you selected as the destination for recovery. Note that all changes made in the recovered VMs will be lost.

To stop publishing a recovered VM:

1. Open the **Home** view.
2. In the inventory pane, select the **Instant Recovery** node.
3. In the working area, right-click a VM and select **Stop publishing**.
Entire VM Restore

With Veeam Backup & Replication, you can restore an entire VM from a backup file to the latest state or to a previous point in time if the original VM fails.

Entire VM restore requires you to fully extract the VM image to the production storage. Veeam Backup & Replication copies the VM data from the backup repository to the selected storage, registers the VM on the chosen Hyper-V host and, if necessary, powers it on.

A VM can be restored to its original location or to a new location. When you restore a VM to its original location, Veeam Backup & Replication powers off the original VM and deletes it before the restore. This type of restore ensures the quickest recovery and minimizes the number of mistakes which can be potentially caused by changes in VM settings.

When you restore a VM to a new location, you can specify new VM settings such as the new VM name, the host and volume where the VM will reside and network properties. Veeam Backup & Replication will change the VM configuration file and store the VM data to the location of your choice.

**NOTE:**
If a VM has several VM disks, Veeam Backup & Replication restores VM disks in parallel.
Quick Rollback

When you restore a full VM to the original location, you can instruct Veeam Backup & Replication to perform quick rollback — incremental data restore. Instead of restoring an entire VM from a backup file, Veeam Backup & Replication will recover only those data blocks that are necessary to revert the VM to an earlier point in time. Quick rollback significantly reduces the recovery time and has little impact on the production environment.

For quick rollback, Veeam Backup & Replication uses the changed block tracking technology. Veeam Backup & Replication gets information about the current VM state and compares it with the CBT information in the backup file. This way, Veeam Backup & Replication detects what data blocks must be transported back to the production volume to rebuild the VM to the necessary point in time.

It is recommended that you use quick rollback if you restore a VM after a problem that has occurred at the level of the VM guest OS — for example, there has been an application error or a user has accidentally deleted a file on the VM guest OS. Do not use quick rollback if the problem has occurred at the VM hardware level, storage level or due to a power loss.

Requirements for Quick Rollback

To perform quick rollback, make sure that the following requirements are met:

- VM must be restored to its original location.
- The backup file from which you plan to restore a VM must be created with the **Use changed block tracking data** option enabled.
Limitations for Quick Rollback

- [For Microsoft Hyper-V 2016 and later] You cannot run two restore sessions with quick rollback subsequently. After you restore a VM with quick rollback, the CBT on the original VM is reset. You must run at least one incremental backup job session to be able to perform quick rollback again.

- Use quick rollback and VM guest OS file exclusion wisely. If you exclude specific files and folders from the VM guest OS during backup and use quick rollback to restore the VM or VM disk from such backup, Veeam Backup & Replication will restore only the content of the backup file. The excluded data will not be restored. For example, if you exclude C:\Folder from the backup, data in this folder will not be backed up and will not be available in the resulting backup file. After some time, data in C:\Folder may change but the folder will still not be backed up (since the job excludes this folder). For this reason, when you perform quick rollback, Veeam Backup & Replication will restore all data that have changed except the excluded C:\Folder.
Restoring Entire VM

If a VM has failed, you can recover it from the backup with entire VM restore. You can restore one or more VMs at once, to the original location or new location.

The entire VM restore operation recovers an entire VM from the backup file and registers the VM on the target host. Full VM recovery takes more time than Instant VM Recovery as you have to extract the VM image from the backup to the production storage. However, you do not need to take any additional steps to finalize entire VM restore: entire VM restore actually recovers a failed VM on the production storage and provides full disk I/O performance.

Before you restore a VM from the backup, check prerequisites. Then use the Full VM Restore wizard to restore the necessary VM.

Before You Begin

Before you restore a VM from a backup, consider the following:

- You can restore a VM from a backup that has at least one successfully created restore point.
- If you restore a VM to its original location and the original VM is still running, Veeam Backup & Replication powers off the original VM and deletes it before the restore.
- If you want to scan VM data for viruses, check the secure restore requirements and limitations.
- If you want to run an executable script for a VM, check the staged restore requirements and limitations.
- On non-Microsoft Windows SMB3 storage, for example, Tintri, Veeam Backup & Replication may display the "Failed to disable integrity bit on disk N" warning during VM restore. You can ignore this warning for non-Microsoft Windows SMB3 storage.
- The restored VM will have the same MAC address as the original VM. Therefore, if you restore the VM to the same Hyper-V host where the original VM is running, a MAC address conflict may occur. To overcome this situation, power off the original VM before you start the restore process.
- The version of the target host on which the VM is restored must be the same or later than the version of the source host where the original VM was registered.

For example, you can restore a VM from the host that runs Microsoft Windows Server 2016 to the target host that runs the following versions of Microsoft Windows:

- Microsoft Windows Server 2016 (including version 1809)
- Microsoft Windows Server 2019

The Hyper-V role must be enabled on both source and target hosts.
Step 1. Launch Full VM Restore Wizard

To launch the **Full VM Restore** wizard, do one of the following:

- On the **Home** tab, click **Restore > Microsoft Hyper-V > Restore from backup > Entire VM restore > Entire VM restore**.
- Open the **Home** view. In the inventory pane, select **Backups**. In the working area, expand the necessary backup and do one of the following:
  - Select the machine that you want to restore and click **Entire VM** on the ribbon.
  - Right-click the machine that you want to restore and select **Restore entire VM**.
- Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the displayed window, select the VM and click **Restore > Entire VM**.

You can use this option if you perform restore on the backup server. You cannot use this option if you perform restore remotely over the Veeam Backup & Replication console.
Step 2. Select VMs

At the **Virtual Machines** step of the wizard, select one or several VMs that you want to restore.

To select VMs:

1. Click **Add VM**.

2. Select where to browse for VMs:
   - **From infrastructure** — browse the virtual environment and select VMs or VM containers to restore. If you choose a VM container, Veeam Backup & Replication will expand it to a plain VM list.
     - When you add a VM to the list, Veeam Backup & Replication displays information about the most recent restore point in the **Restore point** column. If no restore point is available for the added VM, Veeam Backup & Replication will display a warning next to this VM.
   - **From backup** — browse existing backups and select VMs under backup jobs.

To quickly find VMs, you can use the search field at the top of the wizard.

1. Enter a VM name or a part of it in the search field. Veeam Backup & Replication will display possible matches.

2. If the VM is not in the list, click the **Show more** link to browse the virtual infrastructure.
Step 3. Select Restore Point

You can select the necessary restore point for the VMs that you want to restore.

By default, Veeam Backup & Replication uses the latest valid restore point. However, you can restore the VM to an earlier state. If you have chosen to restore several VMs, you can select the necessary restore point for every VM in the list.

To select a restore point for a VM:

1. In the Virtual machines to restore list, select the VM.
2. Click Point on the right.
3. In the Restore Points window, select a restore point from which you want to restore the VM.

In the Location column, you can view a name of a backup repository or object storage repository where a restore point resides.

![Restore Points Window](image-url)
Step 4. Select Restore Mode

At the **Restore Mode** step of the wizard, choose the necessary restore mode:

1. Choose a restore mode:
   
   o **Select Restore to original location** if you want to restore VMs with their initial settings and to their original location. If this option is selected, you will immediately pass to the **Reason step** of the wizard.
   
   o **Select Restore to a new location, or with different settings** if you want to restore VMs to a different location and/or with different settings (such as VM location, network settings and so on). If this option is selected, the **Full VM Restore** wizard will include additional steps for customizing VMs settings.
   
   o **Select Staged restore** if you want to run an executable script for VMs before recovering them to the production environment. If this option is selected, the **Full VM Restore** wizard will include an additional step for customizing staged restore settings.

**IMPORTANT!**

If you recover a machine to the original location, consider that the VM settings contain the ID of the VM group to which the machine belongs. To restore the machine to the original VM group, you must not delete the original VM group or change the hierarchy of its parent VM groups.
2. [For VM restore to the original location] Select the **Quick rollback** check box if you want to perform incremental restore for the VM. Veeam Backup & Replication will use CBT to get data blocks that are necessary to revert the VM to an earlier point in time, and will restore only these data blocks from the backup. Quick restore significantly reduces the restore time and has little impact on the production environment.

It is recommended that you enable this option if you restore a VM after a problem that occurred at the level of the VM guest OS: for example, there has been an application error or a user has accidentally deleted a file on the VM guest OS. Do not enable this option if the problem has occurred at the VM hardware level, storage level or due to a power loss.
Step 5. Select Target Host

The **Host** step of the wizard is available if you have chosen to change the location and settings for the restored VM.

To specify a target host:

1. Select a VM in the list and click **Host**. To apply changes in bulk, select several VMs in the list and click **Host**.
2. Choose a standalone or clustered host where the selected VM must be registered.

To facilitate selection, you can use the search field at the bottom of the window:

1. Click the button on the left of the field to select the necessary type of object that should be searched for: **SCVMM, Cluster or Host**.
2. Enter an object's name or a part of it and click the **Start search** button on the right or press [Enter] on the keyboard.

If you choose to register the restored VM on a host being a part of a Hyper-V failover cluster, you can specify additional failover settings.

1. Select a VM in the list and click **Resource**.
2. Select the **Register VM as a cluster resource** option if the restored VM must be configured as a cluster resource. In this case, if the target host is brought offline or fails for any reason, the VM will fail over to another node in the cluster.
Step 6. Select Target Datastore

The **Datastore** step of the wizard is available if you have chosen to change the location and settings for recovered VMs.

You can place an entire VM to a particular location or choose to store configuration files and disk files of a restored VM in different locations.

To specify a destination location:

1. Select a VM in the list and click **Path**. To apply changes in bulk, select several VMs in the list and click **Path**.
2. Point to a folder where VM files must be stored.

If configuration and disk files of a VM must be placed to different locations:

1. Expand the VM in the list.
2. Select the necessary file type.
3. Click **Path** and point to a folder where VM files must be stored. To create a dedicated folder for storing files of the recovered VM, click **Make New Folder** at the bottom of the window.

You can choose a Microsoft SMB3 shared folder as a destination for the restored VM.

1. Select the VM in the list and click **Path** at the bottom of the window.
2. Type a path to the Microsoft SMB3 shared folder in the search field at the bottom of the **Select Folder** window. The path must be specified in the UNC format, for example: `\\172.16.11.38\Share01`.

The host or cluster on which you register the VM must have access to the Microsoft SMB3 shared folder. If you are using SCVMM 2012 or later, the server hosting the SMB3 share must be registered in SCVMM as a storage device. For more information, see **Microsoft Docs**.
Step 7. Specify Network Mapping

The **Network** step of the wizard is available if you have chosen to change the location and settings for recovered VMs.

If you plan to restore a VM to a new location, for example, another site with a different set of networks, you can map source site networks to target site networks. Veeam Backup & Replication will use the network mapping table to update configuration files of VMs on the fly, during the restore process.

To change networks to which restored VMs will be connected:

1. Select a VM in the list and click **Network**. To apply changes in bulk, select several VMs in the list and click **Network**.
   
   If a VM is connected to multiple networks, expand the VM, select the network to map and click **Network**.

2. The **Select Network** section displays all networks to which the target host or cluster is connected. From the list of available networks, choose a network to which the selected VM must have access upon restore. To facilitate selection, use the search field at the bottom of the window: enter a network name or a part of it and click the **Start search** button on the right or press [Enter] on the keyboard.

If you do not want to connect the restored VM to any virtual network, select the VM in the list and click **Disconnected**.
Step 8. Change VM Name and UUID

The Name step of the wizard is available if you have chosen to change the location and settings for recovered VMs.

You can change a name of each restored VM and select whether you want to preserve its UUID or change it. It is recommended that you specify a new name and generate a new UUID for a VM to prevent conflicts if the original VM still resides in the production environment. The name and ID change is not required if the original VM no longer exists, for example, it was permanently deleted.

To change a VM name:

1. Select a VM in the list and click Name. To apply changes in bulk, select several VMs and click Name.
2. In the Change Name window, enter a new name explicitly or specify a change name rule by adding a prefix and/or suffix to the VM name.
3. You can also change VM names directly in the list: select a VM, click the New Name field and enter the name to be assigned to the recovered VM.

You can specify how Veeam Backup & Replication must handle unique identifiers of the restored VM. By default, a recovered VM is identified with the same UUIDs as the original VM. If necessary, however, you can choose to assign a new UUID to the restored VM.

To view or change VM identification settings:

1. Select one or more VMs in the list and click VM UUID.
2. Select to preserve the VM ID or generate a new VM ID:
   - Select Preserve virtual machine UUID if the original VM was decommissioned and the restored VM will be used in place of the original one.
- Select **Generate new virtual machine UUID** if you perform VM restore to clone the original VM. This option will help you avoid UUID conflicts if the original VM and its duplicate will operate in parallel in the same location.
Step 9. Specify Secure Restore Settings

This step is available if you restore Microsoft Windows VMs.

You can instruct Veeam Backup & Replication to perform secure restore — scan machine data with antivirus software before restoring the machine to the production environment. For more information on secure restore, see Secure Restore.

To specify secure restore settings:

1. At the Secure Restore step of the wizard, select the Scan the restored machine for malware prior to performing the recovery check box.

2. Select which action Veeam Backup & Replication will take if the antivirus software finds a virus threat:
   - Proceed with recovery but disable network adapters. Select this action if you want to restore the machine with disabled network adapters (NICS).
   - Abort VM recovery. Select this action if you want to cancel the restore session.

3. Select the Scan the entire image check box if you want the antivirus software to continue the machine data scan after the first malware is found. For information on how to view results of the malware scan, see Viewing Malware Scan Results.

---

**Secure Restore**

Scan the selected backup for malware, such as computer viruses or ransomware, prior to performing the restore. This requires a compatible antivirus installed on the mount server specified for the corresponding backup repository.

- **Virtual Machines**
- **Restore Mode**
- **Host**
- **Dataset**
- **Network**
- **Name**

**Secure Restore**

- **Staged Restore**
- **Reason**
- **Summary**

- **Full VM Restore**

- Scan the restored machine for malware prior to performing the recovery.
  - The machine you are about to restore will be scanned by antivirus software installed on the mount server to prevent a risk of bringing malware into your environment.
  - If malware is found:
    - Proceed with recovery but disable network adapters
    - Abort VM recovery
  - Scan the entire image
    - Continue scanning remaining files after the first malware has been found.
Step 10. Specify Staged Restore Settings

The **Staged Restore** step of the wizard is available if you have chosen to run an executable script for VMs before recovering them to the production environment. For more information on staged restore, see [Staged Restore](#).

To specify staged restore settings:

1. From the **Virtual lab** list, select a virtual lab that will be used to start VMs. The list contains all virtual labs that are created or connected to the backup server.

2. From the **Application group** list, select an application group if script execution requires other VMs to be powered on. In the virtual lab during staged restore, Veeam Backup & Replication will start VMs from the selected application group in the required order. The **Application group** list contains all application groups that are created on the backup server. For more information, see [Application Group](#).

3. On the right of the **Script** field, click **Browse** to choose the script from a local folder on the backup server.

4. From the **Credentials** list, select credentials for the account that has administrator privileges on VMs for which you want to run the script. If you have not set up credentials beforehand, click the **Manage accounts** link or click **Add** on the right of the **Credentials** field to add the credentials. For more information, see [Managing Credentials](#).

---

### VM Startup Settings

If you want to start VMs after recovery, perform the following steps:

1. Click **Advanced**.
2. In the Memory section, specify the amount of memory that you want to pre-allocate to a VM when it starts. The amount of pre-allocated memory is defined in percent. The percentage rate is calculated based on the system memory level available for the production VM. For example, if 4096 MB of RAM is allocated to the VM in the production environment and you specify 50% as a memory rate, 2048 MB of RAM will be allocated to the VM on startup.

3. In the Startup time section, specify the allowed boot time for the VM and timeout to initialize applications on the VM.

   Be careful when specifying the Maximum allowed boot time value. Typically, a VM started in a virtual lab requires more time to boot than a VM started in the production environment. If an application fails to be initialized within the specified interval of time, the recovery process fails with the timeout error. If such error occurs, you need to increase the Maximum allowed boot time value and perform VM restore again.
### Step 11. Specify Restore Reason

At the **Reason** step of the wizard, enter a reason for restoring the selected VMs. The information you provide will be saved in the session history and you can reference it later.

**TIP:**
If you do not want to display the **Reason** step of the wizard in future, select the **Do not show me this page again** check box.

<table>
<thead>
<tr>
<th>Virtual Machine</th>
<th>Restore reason:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Mode</td>
<td>Restoring a corrupted DB</td>
</tr>
</tbody>
</table>

[Image of user interface showing the Reason step of the wizard with an example of a restored database.]
Step 12. Verify Recovery Settings

At the Summary step of the wizard, specify additional settings for VM restore:

1. If you want to start the restored VM on the target host, select the Power on VM after restoring check box.
2. Check the specified settings and click Finish. Veeam Backup & Replication will restore selected VMs in the specified destination.
VM Files Restore

Veeam Backup & Replication can help you to restore specific VM files (.vhd/.vhdx, .xml and others) if any of these files are deleted or the volume is corrupted. This option provides a great alternative to entire VM restore, for example, when your VM configuration file is missing and you need to restore it. Instead of restoring the whole VM image to the production storage, you can restore the specific VM file only.

When you perform VM file restore, VM files are restored from regular image-level backups. Veeam Data Movers deployed on the backup repository and the Hyper-V host or the off-host backup proxy retrieve VM data from the backup file and send it to the original VM location, or to a new location specified by the user.
Restoring VM Files

You can restore specific VM files from the backup: VHD, VHDX, XML and others. VM file restore can be helpful, for example, if one or several VM files have been deleted or corrupted and you need to replace them on the production storage. Veeam Backup & Replication lets you restore the necessary VM file directly from the image-level backup, without prior de-staging of the VM image from the backup file.

Before you restore VM files from the backup, check prerequisites. Then use the Hyper-V Restore wizard to restore VM files.

Before You Begin

Before you restore VM files, check the following prerequisites:

- You can restore VM files from a backup that has at least one successfully created restore point.
- The server on which you plan to save restored VM files must be added to the backup infrastructure.
Step 1. Launch Hyper-V Restore Wizard

To launch the **Restore** wizard, do one of the following:

- On the **Home** tab, click **Restore > Microsoft Hyper-V > Restore from backup > Entire VM restore > VM files restore (VSV, BIN, XML)**.

- Open the **Home** view. In the inventory pane, select **Backups**. In the working area, expand the necessary backup and do one of the following:
  - Click the VM whose files you want to restore and click **VM Files** on the ribbon.
  - Right-click the VM whose files you want to restore and select **Restore VM files**.

  In this case, you will pass to the **Restore Point** step of the wizard.

- Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the displayed window, select the VM and click **Restore > VM files**. In this case, you will pass to the **Restore Point** step of the wizard.

You can use this option if you perform restore on the backup server. You cannot use this option if you perform restore remotely over the Veeam Backup & Replication console.
Step 2. Select VM

At the **Virtual Machine** step of the wizard, select the VM whose files you want to restore:

1. In the **Virtual machine** list, expand the necessary backup.
2. Select the VM.

To quickly find a VM, you can use the search field at the bottom of the window.

1. Enter a VM name or a part of it in the search field.
2. Click the **Start search** button on the right or press [Enter] on the keyboard.
Step 3. Select Restore Point

At the **Restore Point** step of the wizard, select the restore point from which you want to restore the VM files.

In the **Location** column, you can view a name of a backup repository or object storage repository where a restore point resides.
Step 4. Select VM Files and Destination

At the **Restore Destination** step of the wizard, select the VM files you want to restore and destination where the restored files must be stored.

1. From the **Server** list, select where to store VM files: to a Microsoft Hyper-V host, on the backup server or on a Microsoft Windows server added to the backup infrastructure. Use the **Details** button to view or change connection settings of the target host or server.

2. In the **Path to folder** section, specify a path to the folder on the selected host where files must be restored.
   
   To create a dedicated folder for restored files, click **Browse**. In the **Select Folder** window, select the target location for VM files and click **Make New Folder** at the bottom of the window.

3. In the **VM files to restore** section, select check boxes next to files that you want to restore. By default, all VM files are selected.
Step 5. Specify Restore Reason

At the **Restore Reason** step of the wizard, enter a reason for restoring VM files. The information you provide will be saved in the session history and you can reference it later.
Step 6. Finish Working with Wizard

At the Summary step of the wizard, complete the procedure of VM files restore.

1. Review details for the restore task.
2. Click Finish to start VM files restore.
EC2 Instance and Azure VM Disk Export

Veeam Backup & Replication allows you to export disks of Amazon EC2 instances and Microsoft Azure VMs in the VMDK, VHD or VHDX formats.

You can export disks from the following backups:

- Backups of EC2 instances created by Veeam Backup for AWS
- Backups of Azure VMs created with Veeam Backup for Microsoft Azure

During disk export, Veeam Backup & Replication creates standard virtual disks that can be used by VMware vSphere and Microsoft Hyper-V VMs.

**NOTE:**

When you export a disk in the VMDK format, Veeam Backup & Replication creates a pair of files that make up the VM virtual disk: a descriptor file and file with the virtual disk content.

You can export the converted disks to any server added to the backup infrastructure or place disks on a datastore connected to an ESXi host (for VMDK disk format only). VMDK disks can be exported as thin provision and thick disks. VHD/VHDX disks are always exported as dynamically expanding.

Veeam Backup & Replication supports batch disk export. For example, if you choose to export 2 instance disks, Veeam Backup & Replication will convert them to 2 virtual disks and store these disks in the specified location.
Exporting Disks

To export disks of Amazon EC2 instances or Azure VMs and convert disks to the VMDK, VHD or VHDX format, use the Export Disk wizard.
Step 1. Launch Export Disk Wizard

To launch the Export Disk wizard, do one of the following:

- Open the Home tab. Click Restore > AWS EC2 backup > Entire machine restore > Export disk to launch the wizard for Amazon EC2 instances. Click Restore > Azure IaaS backup > Entire machine restore > Export disk to launch the wizard for Microsoft Azure VMs.

- Open the Home view. In the inventory pane, click Backups > External Repository. In the working area, expand the backup of the workload whose disks you want to export. Right-click the workload and select Export Disk.
Step 2. Select Backup

At the **Backup** step of the wizard, expand a backup and select the workload whose disks you want to export.

To quickly find a workload, you can use the search field at the bottom of the window:

1. Enter a workload name or a part of it in the search field.
2. Click the **Start search** button on the right or press [Enter] on the keyboard.
Step 3. Select Restore Point

At the Restore Point step of the wizard, select the restore point from which you want to export data.

By default, Veeam Backup & Replication uses the latest restore point. However, you can select any valid restore point to recover volumes to a specific point in time.
Step 4. Select Disks

At the **Disks** step of the wizard, select check boxes next to the disks that you want to export.
Step 5. Select Destination and Disk Format

At the **Target** step of the wizard, select the destination for disk export and format in which you want to save the resulting virtual disks:

1. From the **Server** list, select a server on which the resulting virtual disks must be saved. If you plan to save the disks in the VMDK format on a datastore, select an ESXi host to which this datastore is connected.

   **NOTE:**
   If you export VMDK disks to a datastore, disks are saved in the thin provisioned format. If you export VMDK disks to a server, disks are saved in the thick format.
   VHD/VHDX disks are always saved as dynamically expanding.

2. In the **Path to folder** field, specify a datastore or folder on the server where the virtual disks must be placed.

3. Select the export format for the disks:
   - **VMDK** — select this option if you want to save the resulting virtual disk in the VMware VMDK format. This is the only available option if you export disks to a datastore.
   - **VHD** — select this option if you want to save resulting virtual disk in the Microsoft Hyper-V VHD format.
   - **VHDX** — select this option if you want to save resulting virtual disk in the Microsoft Hyper-V VHDX format (supported by Microsoft Windows Server 2012 or later).

4. [For VMDK disks exported to a datastore] Click the **Pick proxy to use** link to select backup proxies over which disk data must be transported to the target datastore. You can assign backup proxies explicitly or instruct Veeam Backup & Replication to automatically select backup proxies.
Step 6. Specify Secure Restore Settings

This step is available if you export disks of Microsoft Windows workloads.

At the Secure Restore step of the wizard, you can instruct Veeam Backup & Replication to perform secure restore — scan exported disk data with antivirus software before restoring the disk. For more information on secure restore, see Secure Restore.

To specify secure restore settings:

1. Select the Scan the restored disk for malware prior performing the recovery check box.
2. Select which action Veeam Backup & Replication will take if an antivirus software finds a virus threat:
   - Proceed with recovery. Select this action if you want to export the infected disk.
   - Abort disk recovery. Select this action if you want to cancel the export session.
3. Select the Scan the entire image check box if you want the antivirus software to continue scanning the disk data after the first malware is found. For information on how to view results of the malware scan, see Viewing Malware Scan Results.

![Secure Restore settings](image-url)
### Step 7. Specify Export Reason

At the **Reason** step of the wizard, enter a reason for disk export.

If you do not want to display the **Reason** step of the wizard in future, select the **Do not show me this page again** check box.

<table>
<thead>
<tr>
<th>Export Disk</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reason</strong></td>
<td>Type in the reason for performing this restore operation. This information will be logged in the restore sessions history for later reference.</td>
</tr>
<tr>
<td>Backup</td>
<td></td>
</tr>
<tr>
<td>Restore Point</td>
<td></td>
</tr>
<tr>
<td>Disks</td>
<td></td>
</tr>
<tr>
<td>Target</td>
<td></td>
</tr>
<tr>
<td>Secure Restore</td>
<td></td>
</tr>
<tr>
<td><strong>Reason</strong></td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td></td>
</tr>
</tbody>
</table>

- **Restore reason:** Converting to virtual disk

- **Do not show me this page again**
Step 8. Complete Export Process

At the **Summary** step of the wizard, review disk details and click the **Finish** button.

<table>
<thead>
<tr>
<th>Backup</th>
<th>Summary:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Computer: sv01</td>
</tr>
<tr>
<td></td>
<td>Restore point: 9 days ago (10:15 AM Wednesday 11/28/2018)</td>
</tr>
<tr>
<td></td>
<td>Target host: as02abc.local</td>
</tr>
<tr>
<td></td>
<td>Target path: \d1\</td>
</tr>
<tr>
<td></td>
<td>Disks to export:</td>
</tr>
<tr>
<td></td>
<td>Disk 1, volume(s):</td>
</tr>
<tr>
<td></td>
<td>Export format: VMDK</td>
</tr>
</tbody>
</table>

![Summary dialog box](image-url)
Guest OS File Recovery

With guest OS file recovery, you can recover individual guest OS files and folders from backups (Microsoft Windows and other file systems), replicas (Microsoft Windows file systems) and Nutanix AHV snapshots. When restoring files or folders, you do not need to extract the VM image to a staging location or start the VM prior to restore. You can restore files and folders directly from a regular image-level backup or replica to the necessary point in time.

Using the following methods, you can restore files from different guest OS file systems:

- **Restore from FAT, NTFS or ReFS** — method that helps you restore files Microsoft Windows VMs with NTFS, FAT and ReFS file systems.

- **Restore from Linux, Unix and Other File Systems** (multi-OS file-level restore) — method that helps you restore files from Linux, Solaris, BSD, Unix, Mac and other file systems.
  
  Note that this method supports recovery of files and folders only. Recovery of other file system objects such as pipes is not supported.

- **Restore from Other File Systems** — method that helps you restore files from file systems that other methods from the list do not support.
Restore from FAT, NTFS or ReFS

To restore individual files and folders from FAT, NTFS and ReFS file systems, you can use the **File-Level Restore** wizard.

When you perform file-level restore, Veeam Backup & Replication performs the following operations:

1. Veeam Backup & Replication mounts VM disks from the backup or replica to the mount server under the C:\VeeamFLR\<vmname> folder. For more information on the mount server, see **Mount Server**.

   For accessing VM disks content, Veeam Backup & Replication uses its proprietary driver. VM disks are not physically extracted from the backup file or VM replica. Veeam Backup & Replication emulates their presence on the backup server or Veeam Backup & Replication console. The backup file or VM replica itself remains in the read-only state.

2. Veeam Backup & Replication launches the Veeam Backup browser where mounted VM disks are displayed. You can browse the VM guest file system in the Veeam Backup browser and restore files or folders to the original or new location.

3. When you restore files or folders, the mount server connects to the VM over network or PowerShell Direct, if a connection over the network cannot be established.

   PowerShell Direct is used for VMs that reside on Microsoft Hyper-V Server 2016 or later and run Microsoft Windows 10 or Microsoft Windows Server 2016 or later. Veeam Backup & Replication requires Microsoft PowerShell 2.0 or later to work over PowerShell Direct.

4. If you need to browse files in Microsoft Windows explorer, Veeam Backup & Replication creates an additional mount point on Veeam Backup & Replication console.

   Veeam Backup & Replication creates this mount point only if you instruct Veeam Backup & Replication to mount VM disks there. For more information, see **Open Files in Microsoft Windows Explorer**.

5. When the restore process is finished or the Veeam Backup browser is closed by timeout, Veeam Backup & Replication removes mount points from the backup server or machine on which the Veeam Backup & Replication console is installed and from the mount server (if the second mount was used).

Depending on the restore scenario, Veeam Backup & Replication may create mount points on different backup infrastructure components. For more information, see **File-Level Restore Scenarios**.
File-Level Restore Scenarios

You can use different scenarios for file-level restore:

- Restore files from backups
- Restore files from replicas
- Restore files for work with Veeam Explorers
- Restore files from Veeam Backup Enterprise Manager
- Restore files from Nutanix AHV snapshots
- Restoring Files from Amazon EC2 Instances

In different restore scenarios, Veeam Backup & Replication uses different servers as mount points.

Restoring Files from Backups

When you restore files from backups that reside in the backup repository, Veeam Backup & Replication uses the following mount points:

1. Mount server associated with the backup repository on which the backup file resides. Veeam Backup & Replication uses this mount point when the restore process starts and allows you to browse the VM file system and restore files.

2. Veeam Backup & Replication console (backup server if not changed). Veeam Backup & Replication uses this mount point only if you instruct Veeam Backup & Replication to mount VM disks there. For more information, see Open Files in Microsoft Windows Explorer.

NOTE:
Backup files on HPE StoreOnce are locked exclusively by a restore task. For this reason, Veeam Backup & Replication uses only one mount point on the backup server or Veeam Backup & Replication console machine for backups on HPE StoreOnce.

Restoring Files from Replicas

When you restore files from a VM replica, Veeam Backup & Replication uses the following mount points:

1. Backup server. Veeam Backup & Replication uses this mount point when the restore process starts and allows you to browse the VM file system and restore files.
2. Veeam Backup & Replication console (backup server if not changed). Veeam Backup & Replication uses this mount point only if you instruct Veeam Backup & Replication to mount VM disks there. For more information, see Open Files in Microsoft Windows Explorer.

Restoring Files for Veeam Explorers

Veeam Backup & Replication can perform file-level restore as a preparatory step for application items restore. However, the database files may be huge and require a lot of network resources. For this reason, if you restore application items from Microsoft SQL and Oracle VMs, Veeam Backup & Replication can mount the content of the backup file directly to the original VM.

For restore from backups of Microsoft SQL Server VMs or Oracle VMs, Veeam Backup & Replication creates an additional mount point on the original VM. In some cases, Veeam Backup & Replication may create an additional mount point on a staging Microsoft SQL Server or Oracle server. This may be required if Veeam Backup & Replication does not have information about databases (for example, if you initiate restore from storage snapshots) or you restore Microsoft SQL Server or Oracle databases or Microsoft SQL Server database schema objects and table data up to a specific transaction.

- To create a mount point on Microsoft Windows machines, Veeam Backup & Replication uses the iSCSI protocol. The remote machine or staging server acts as an iSCSI initiator. The machine on which the Veeam Explorer runs acts as an iSCSI target. The iSCSI mount point is non-persistent — it is created only for duration of the restore process.

- To create a mount point on Linux VMs (for Oracle running on Linux), Veeam Backup & Replication uses fuse.
Restoring Files from Veeam Backup Enterprise Manager

When you restore files from the backup file that was created without VM guest OS file indexing, Veeam Backup & Replication uses the following mount points:

1. Veeam Backup & Replication mounts disks of the VM from the backup file to the backup server.

2. If you restore files to the original location, Veeam Backup & Replication creates an additional mount point on the mount server associated with the backup repository on which the backup file resides. The second mount lets you keep the VM traffic in one site and reduce load on the network.

If you select to download files, Veeam Backup & Replication does not create the second mount point. It copies files to the destination from the backup server.

Restoring Files from Nutanix AHV Snapshots

To learn how Veeam Backup & Replication performs guest OS file restore from backup snapshots, user snapshots and PD snapshots created by AHV Backup Proxy, see the Restoring Guest OS Files section of the Veeam Backup for Nutanix AHV User Guide.

Restoring Files from Amazon EC2 Instances

To perform a file-level restore of EC2 instances, Veeam Backup & Replication utilizes the functionality of AWS Plug-in for Veeam Backup & Replication. To learn more about a file-level restore of EC2 instances, see the File-Level Restore section of the Veeam Backup for AWS User Guide.

Restoring VM Guest OS Files (FAT, NTFS or ReFS)

You can restore individual Microsoft Windows guest OS files from the backup of a Microsoft Windows VM.

Before you restore VM guest OS files, check prerequisites. Then use the File Level Restore wizard to restore the necessary VM guest OS files and folders.
Before You Begin

Requirements

- Your file system must be one of the file systems listed in the Platform Support section.
- You can restore VM guest OS files from a backup that has at least one successfully created restore point.
- [For restore to the original location] VM guest OS must be accessible from the backup server over the network, or over PowerShell Direct (for VMs that reside on Microsoft Hyper-V Server 2016 or later).
- [For restore to the original location] Hyper-V Integration Services must be installed on the target VM.

ReFS

If you plan to restore files from a VM running Microsoft Windows ReFS, consider the following for the Veeam Backup & Replication components involved in the restore process:

- [For VM file system browsing and restore to a new location] The Veeam Backup & Replication console must be installed on a machine running Microsoft Windows Server 2012 or later.
- [For restore to the original location] The Veeam Backup & Replication console and the mount server associated with the backup repository must be installed on a machine running Microsoft Windows Server 2012 or later.
- [ReFS 3.x] If you plan to restore files from a VM running Microsoft Windows ReFS 3.x, the Veeam Backup & Replication console and mount server must be installed on machines running Microsoft Windows Server 2016 or later and the ReFS version must be supported on them.
- The version of Microsoft Windows Server on the mount server and Veeam Backup & Replication console must be the same or newer than the version of the VM guest OS.

Data Deduplication

If you plan to restore files from a VM running Microsoft Windows Server 2012 or later and Data Deduplication is enabled for some VM volumes, consider the following for the Veeam Backup & Replication components involved in the restore process:

- [For restore to the original location] The Veeam Backup & Replication console and mount server associated with the backup repository must be installed on a machine running Microsoft Windows Server 2012 or later. Data Deduplication must be enabled on the mount server.
- [For restore to a new location] The Veeam Backup & Replication console must be installed on a machine running Microsoft Windows Server 2012 or later. Data Deduplication must be enabled on this machine.
- The version of Microsoft Windows Server on the mount server and Veeam Backup & Replication console must be the same or newer than the version of the VM guest OS.

Limitations

- Processing of reparse points is supported only for NTFS.
- You cannot restore files from a backup created in the reverse incremental mode if the backup job is being performed. If the backup is created in the incremental backup mode and the backup job is being performed, you can restore files from any available restore point.
Step 1. Launch File Level Restore Wizard

To launch the **File Level Restore** wizard, do one of the following:

- On the **Home** tab, click **Restore > Microsoft Hyper-V > Restore from backup** or **Restore from replica > Guest files restore > Microsoft Windows**.

- Open the **Home** view. In the inventory pane, select **Backups** or **Replicas**. In the working area, expand the necessary backup and do one of the following:
  - Click the VM whose files you want to restore and click **Guest files > Microsoft Windows** on the ribbon.
  - Right-click the VM whose files you want to restore and select **Restore guest files > Microsoft Windows**.

- Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the displayed window, select the VM and click **Restore > Guest files (Microsoft Windows)**.

You can use this option if you perform restore on the backup server. You cannot use this option if you perform restore remotely over the Veeam Backup & Replication console.
Step 2. Select VM

At the **Machine** step of the wizard, select the VM whose guest OS files you want to restore:

1. In the **Machine** list, expand the necessary backup.
2. Select the VM.

To quickly find a VM, you can use the search field at the bottom of the window.

1. Enter a VM name or a part of it in the search field.
2. Click the **Start search** button on the right or press [Enter] on the keyboard.
Step 3. Select Restore Point

At the **Restore Point** step of the wizard, select the restore point from which you want to restore the VM guest OS files.

In the **Location** column, you can view a name of a regular backup repository or cloud repository where a restore point resides.
Step 4. Specify Restore Reason

At the **Reason** step of the wizard, enter a reason for restoring VM guest OS files. The information you provide will be saved in the session history and you can reference it later.

**TIP:**
If you do not want to display the **Reason** step of the wizard in future, select the **Do not show me this page again** check box.

<table>
<thead>
<tr>
<th>Machine</th>
<th>Restore Point</th>
<th>Reason</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**File Level Restore**

Reason

Type in the reason for performing this restore operation. This information will be logged in the restore session history for later reference.

- **Restore reason:**
  - Restoring deleted files

- **Do not show me this page again**

[Image of File Level Restore dialog box]

- [Previous]  
- [Next]  
- [Finish]  
- [Cancel]
Step 5. Verify Restore Settings

At the **Summary** step of the wizard, do the following:

1. Review details of the restore task.
2. Click **Finish** to close the wizard and open Veeam Backup browser.

![File Level Restore](image)
Step 6. Finalize Restore

After the wizard is closed, Veeam Backup & Replication opens the Veeam Backup browser displaying the file system tree of the restored VM. Note that names of the restored VM hard disks may differ from the original ones.

You can perform the following operations in the Veeam Backup browser:

- Restore files and folders to the original location
- Save files and folders to a folder on the backup server or network shared folder
- Launch Veeam Explorers for application item restore
- Open files in Microsoft Windows File Explorer

After you finish restoring files, close the Veeam Backup browser.

Restoring Files to Original Location

To restore a file or folder to its original location, in the Veeam Backup browser right–click the necessary file or folder in the file system tree or in the details pane on the right and select one of the following commands:

- To overwrite the original file on the VM guest OS with the file restored from the backup, select Restore > Overwrite.
- To save the file restored from the backup next to the original file, select Restore > Keep.

Veeam Backup & Replication will add the RESTORED- prefix to the original file name and store the restored file in the same folder where the original file resides.

If the file with the RESTORED- prefix already exists in the original location, Veeam Backup & Replication will name the restored file in the following format: RESTORED-<filename>__YYYYMMDD_HHMMSS.
NOTE:
If you have excluded the system disk from the VM backup, you will not be able to restore VM guest OS files to the original location.

Saving Files to New Location

To save restored files or folders on the local machine or in a network shared folder:

1. Right-click the necessary file or folder in the file system tree or in the details pane on the right and select Copy To.

2. Choose to preserve their original NTFS permissions or not:
   
   - Select the **Preserve permissions and ownership** check box to keep the original ownership and security permissions for restored objects. Veeam Backup & Replication will copy selected files and folders along with associated Access Control Lists, preserving granular access settings.
   
   - Leave the **Preserve permissions and ownership** check box not selected if you do not want to preserve the original ownership and access settings for restored objects. Veeam Backup & Replication will change security settings: the user who launched the Veeam Backup & Replication console will be set as the owner of the restored object, while access permissions will be inherited from the folder to which the restored object is copied.
3. If prompted, in the **Credentials** window specify settings of the user account to access the destination location.

### Launching Veeam Explorers

If you are restoring VM guest OS files of the virtualized Microsoft Active Directory Server, Microsoft Exchange Server, Microsoft SharePoint Server or Microsoft SQL Server or Oracle, you can launch a Veeam Explorer for the necessary application directly from the Veeam Backup browser.

To launch a Veeam Explorer, do the following:

1. **On the Home tab**, click **Application Items**.
2. **Select the required application:**
   - Microsoft Active Directory
   - Microsoft Exchange
   - Microsoft SharePoint
   - Microsoft SQL Server
   - Oracle
3. In the opened Veeam Explorer, perform the necessary operations. For more information on Veeam Explorers, see the Veeam Explorers User Guide.

Working with Microsoft Windows File Explorer

You can use Microsoft Windows File Explorer to work with restored files and folders. To use Microsoft Windows File Explorer, do the following:

1. On the ribbon of the Veeam Backup browser, click Mount to Console to mount the VM disks to the Veeam Backup & Replication console.

   The VM disks are mounted to the C:\VeeamFLR\<vmname>\<volume n> folder.

2. To open Microsoft Windows File Explorer, do the following:

   o Click Open in Explorer on the Veeam Backup browser ribbon or right-click the necessary folder and select Explorer.

   o Click File Explorer in the Start menu of the machine where Veeam Backup & Replication console is installed. Browse to the folder where the VM disks are mounted and find the necessary files.

It is recommended that you use Microsoft Windows File Explorer only to view file content, not to restore files. For the file-level restore, use Veeam Backup browser. This browser has the following advantages:

1. You can browse the VM guest OS file system ignoring the file system ACL settings.

2. You can preserve permissions and ownership during file-level restore.

If you open the VM file system in the Microsoft Windows Explorer, these capabilities will not be available. For more information, see Microsoft Docs.
Closing Veeam Backup Browser

You can browse to VM guest OS files only while the Veeam Backup browser is open. After the Veeam Backup browser is closed, Veeam Backup & Replication unmounts VM disks from the machine where the Veeam Backup & Replication console is installed and mount server (if you have restored VM guest OS files to the original location).

It is recommended that you close the Veeam Backup browser after you have finished restoring VM guest OS files. When the Veeam Backup browser is open, the backup file whose VM guest OS file system is displayed in the browser is locked in the backup repository. As a result, some scheduled operations that use this backup file may fail.

Veeam Backup & Replication checks if there is any activity in the Veeam Backup browser with an interval of 5 minutes. If the user or Veeam Backup & Replication components and services do not perform any actions for 30 minutes, Veeam Backup & Replication displays a warning that the Veeam Backup browser is to be closed in 5 minutes.

After the warning is displayed, you can perform one of the following actions:

- You can close the Veeam Backup browser manually.
- You can click Cancel to postpone the close operation. In this case, the Veeam Backup browser will remain open for 5 minutes. After this period expires, Veeam Backup & Replication will display the warning again.
- You can perform no action at all. In this case, the Veeam Backup browser will be automatically closed in 5 minutes.
Restore from Linux, Unix and Other File Systems

To restore files from VM guest OS other than Microsoft Windows, Veeam Backup & Replication uses a helper appliance. The helper appliance is a helper VM running a stripped down Linux kernel that has a minimal set of components. The appliance is quite small — around 50 MB. It requires 1024 MB RAM and takes around 10 seconds to boot.

When you perform file-level restore, Veeam Backup & Replication performs the following operations:

1. Veeam Backup & Replication deploys the helper appliance on the Microsoft Hyper-V host in the virtual infrastructure.
2. Veeam Backup & Replication mounts disks of a VM from the backup to the helper appliance. The backup file itself remains in the read-only state in the backup repository or volume.
3. Veeam Backup & Replication launches the Veeam Backup browser where mounted VM disks are displayed. You can browse the VM guest file system in the Veeam Backup browser and restore files or folders to the original VM or to another location. Alternatively, you can enable an FTP server on the virtual appliance and allow VM owners to restore files themselves.
4. When you close the Veeam Backup browser or it is closed by timeout, Veeam Backup & Replication unmounts the content of the backup file from the helper appliance and unregisters the helper appliance on the Microsoft Hyper-V host.

Restoring VM Guest OS Files (Multi-OS)

You can restore VM guest OS files from file systems supported by Linux-based and Unix-based OSes.

Before you restore VM guest OS files, check prerequisites. Then use the Guest File Restore wizard to restore the necessary VM guest OS files and folders.

Before You Begin

Before you restore VM guest OS files, mind the following prerequisites and limitations:

- Check the supported file systems. For details, see the File-Level Restore section.
- If you plan to restore VM guest OS files to their original location, Hyper-V Integration Services must be installed on the target VM.
- You cannot restore VM guest OS files from a backup that does not have any successfully created restore points.
• You cannot restore files from a backup created in the reverse incremental mode if the backup job is being performed. If the backup is created in the incremental backup mode and the backup job is being performed, you can restore files from any available restore point.

• Veeam Backup & Replication must have access to the guest OS of the target VM to deploy a coordination process. The coordination process performs a number of administrative actions on the target VM guest OS, for example, collects information about mount points.

• For Linux target VM, mind the following:
  o Veeam Backup & Replication uses the SSH protocol to communicate with the target Linux VM and requires the SCP utility on the target VM. Make sure that the SSH daemon is properly configured and SCP utility is available on the target VM.
  o SELinux must be disabled on the target VM.
  o A range of ports that are used for data transfer must be open on the target VM.
    For more information on configuring connection settings for Linux servers, see the SSH Connection step of the New Linux Server wizard.
  o Veeam Backup & Replication can restore ACL for recovered VM guest OS files. To let Veeam Backup & Replication detect the target Linux system architecture and kernel version, the following utilities must be present in the minimal configuration of the system: arch and uname.

• You cannot restore files directly to the original location from backups of BSD, Mac and Solaris VMs. Use the Copy to option instead.

• The multi-OS file-level restore wizard does not support restore of deduplicated volumes (for example, Microsoft Windows volumes with Data Deduplication enabled).
Step 1. Launch Guest File Restore Wizard

To launch the Guest File Restore wizard, do one of the following:

- On the Home tab, click Restore > Microsoft Hyper-V > Restore from backup > Guest files restore > Linux and other.
- Open the Home view. In the inventory pane, select Backups. In the working area, expand the necessary backup and do one of the following:
  - Click the VM whose files you want to restore and click Guest files > Linux and other on the ribbon.
  - Right-click the VM whose files you want to restore and select Restore guest files > Linux and other.
- Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the displayed window, select the VM and click Restore > Guest files (Linux and other).

You can use this option if you perform restore on the backup server. You cannot use this option if you perform restore remotely over the Veeam Backup & Replication console.

**Guest Files**

Select the operating system of the machine you're restoring from.

- **Microsoft Windows**
  - Restores guest files from an image-level backup of a Microsoft Windows-based machine.

- **Linux and other**
  - Restores guest files from an image-level backup of a Microsoft Windows, Linux, Novell, Solaris, Unix, BSD or MacOS-based machine.
Step 2. Select VM

At the **Virtual Machine** step of the wizard, select the VM whose guest OS files you want to restore:

1. In the **Virtual machine** list, expand the necessary backup.
2. Select the VM.

To quickly find a VM, you can use the search field at the bottom of the window:

1. Enter a VM name or a part of it in the search field.
2. Click the **Start search** button on the right or press [Enter] on the keyboard.
Step 3. Select Restore Point

At the **Restore Point** step of the wizard, select the restore point from which you want to restore the VM guest OS files.

In the **Location** column, you can view a name of a regular backup repository or cloud repository where a restore point resides.
Step 4. Specify Restore Reason

At the **Reason** step of the wizard, enter a reason for restoring VM guest OS files. The information you provide will be saved in the session history and you can reference it later.

**TIP:**

If you do not want to display the **Reason** step of the wizard in future, select the **Do not show me this page again** check box.
Step 5. Specify Location for Helper Appliance

At the Helper Appliance step of the wizard, select a Microsoft Hyper-V host for placing a helper appliance (or file-level restore appliance).

To locate the helper appliance:

1. At the bottom of the window, click Customize.
2. In the Host field, select the Microsoft Hyper-V host on which the helper appliance will be registered.
3. Select a network for the helper appliance:
   a. On the right of the Network field, click Choose.
      In the Select Network window, Veeam Backup & Replication will display a list of networks to which the specified host is connected.
   b. From the Networks list, select a network to which the helper appliance must be connected and click OK.
      Mind that the backup server and the mount server must have access to the helper appliance over the network.
4. If you use VLAN IDs, in the VLAN ID field specify the correct VLAN ID of the network where the helper appliance must reside.
5. Specify IP addressing settings for the helper appliance:
   a. If you use a DHCP server in the network, leave the Obtain an IP address automatically option selected.
   b. To manually assign the specific IP address to the helper appliance, select the Use the following IP address option and specify the IP address, subnet mask and default gateway address.
5. To enable FTP access to the restored file system, select the Enable FTP server on appliance (advanced) check box. As a result, users will be able to access the helper appliance over FTP, browse the file system of the restored VM and download necessary files on their own.
6. Click OK.
7. Click **Finish** to close the wizard and open the Veeam Backup browser.

It may take about 10-40 seconds to boot the file-level restore (FLR) appliance and open the browser.
Step 6. Finalize Restore

After the wizard is closed, Veeam Backup & Replication opens the Veeam Backup browser displaying the file system tree of the restored VM.

You can perform the following operations in the Veeam Backup browser:

- Restore files to the original location
- Restore files to a new location
- Access files over FTP
- Access FLR appliance logs

NOTE:
You can browse the VM guest OS files and access restored files on the FTP only while the Veeam Backup browser with the restored files is open. After the Veeam Backup browser is closed, the VM disks will be unmounted from the helper appliance, and the helper appliance will be deleted from the Hyper-V host.

Restoring Files to Original Location

To restore files and folders to the original location, right-click the necessary file or folder in the file system tree or in the details pane on the right and select one of the following commands:

- To overwrite the original file on the VM guest OS with the file restored from the backup, select **Restore > Overwrite**.
- To save the file restored from the backup next to the original file, select **Restore > Keep**.

Veeam Backup & Replication will add the `.RESTORED-YYYYMMDDHHMMSS` suffix to the original file name and store the restored file in the same folder where the original file resides.
If you restore files from disks that were not mounted to the file system, Veeam Backup & Replication asks for a target directory where to restore the selected files. In this case, file restore to the original location is not possible.

To restore files to the original location, Veeam Backup & Replication uses the account for VM guest OS access specified in the backup job settings. If this account does not have sufficient rights to access the target VM, you will be prompted to enter credentials. In the **Credentials window**, specify a user account to access the destination location (server or shared folder).

In some cases, you may remove the original VM and restore it from the backup by the time of file-level restore. If you then attempt to restore VM guest OS files to the original location, Veeam Backup & Replication will not be able to find the original VM by its reference ID, and display a warning. Click **OK** and browse to the target VM in the virtual infrastructure to which you want to restore VM guest OS files.

### Saving Files to New Location

To save files and folders to a new location:

1. Right-click the necessary file or folder and select **Copy to**.

2. In the **Select Destination** window, select the destination server (local or remote) from the list or provide a path to the shared folder.

   - If you are recovering files to a Linux server, you can select the destination server from the list or add a destination server ad-hoc. To do this, scroll down the list of servers and choose **Specify a different host** at the end of the list. Follow the steps of the wizard to add a Linux server that will be used as a target host.

     The server you add ad-hoc will not appear in the list of managed hosts in Veeam Backup & Replication: its purpose is to host the files that you recover. It will only remain visible in the Veeam Backup browser until all currently active file-level restore sessions are completed.

   - If you are recovering files to a shared folder, specify a path to the destination folder.

3. If you want to preserve original permissions and ownership for recovered files, select the **Preserve permissions and ownership** check box.

4. If prompted, in the **Credentials** window specify settings of the user account to access the destination location.
IMPORTANT!

To restore original permissions and ownership settings, the account you have specified should have privileges to change the owner on the selected server or shared folder.

Accessing Files over FTP

If you have chosen to enable FTP server on the FLR appliance, the restored file system will also be available over FTP at `ftp://<FLR_appliance_IP_address>`. Other users in the same network can access the FLR appliance to restore the files they need.

Accessing the appliance over FTP requires credentials. Use the Guest OS helper appliance credentials specified in managed credentials. If the password has not been updated, refer to the following knowledge base article: [this Veeam KB article](#).
Accessing FLR Appliance Logs

If you need to access logs of the FLR appliance, click Support Logs on the Veeam Backup browser ribbon. Veeam Backup & Replication will show the Log node under the file system tree. To hide this node, click Support Logs once again.
Restore from Other File Systems

You can restore file systems other than those listed in the File-Level Restore section. For this purpose, use the Instant VM Recovery technology.

To restore files and folders, do the following:

1. Use Instant VM Recovery to publish the VM from the backup file on the Microsoft Hyper-V host in the virtual infrastructure. Do not start the recovered VM.

2. Mount the disks of the restored VM to any VM that can read the file system of the original VM.

3. Restore files or folders using native file management tools.

Alternatively, you can mount the VM disks to a Microsoft Windows VM and use file management tools such as Portlock Explorer.
Viewing File Restore Session Statistics

You can view statistics about performed guest OS file restore sessions.

To view the restore session statistics, do one of the following:

- Open the **Home** view, in the inventory pane select **Last 24 hours**. In the working area, double-click the necessary restore session. Alternatively, you can select the session and click **Statistics** on the ribbon or right-click the session and select **Statistics**.

- Open the **History** view, in the inventory pane select **Restore**. In the working area, double-click the necessary restore session. Alternatively, you can select the session and click **Statistics** on the ribbon or right-click the session and select **Statistics**.

The file restore statistics provides detailed data on file restore sessions:

- At the top of the **Restore Session** window, Veeam Backup & Replication shows general session statistics: a name of the machine whose guest OS files are restored during the session, a user name of the account under which the session was started, session status and duration details.

- The **Statistics** tab shows detailed information about the files restored during the session.

- The **Reason** tab shows the reason for the guest OS file restore that was specified at the **Reason** step of the **File Level Restore** wizard.

- The **Parameters** tab shows information about the restore point selected for the guest OS file restore at the **Restore Point** step of the **File Level Restore** wizard.

- The **Log** tab shows a list of operations performed during the session.
Application Items Restore

You can use Veeam Explorers to restore application items directly from VM backups and replicas.
Using Veeam Explorer for Microsoft Active Directory

You can use Veeam Explorer for Microsoft Active Directory to restore Microsoft Active Directory objects from any successfully created backup or replica of a virtualized Microsoft Active Directory Server. The backup or replica must be created with application-aware processing enabled and the corresponding options turned on.

To launch Veeam Explorer for Microsoft Active Directory from Veeam Backup & Replication:

1. Open the Home view.
2. In the inventory pane, select the Backups or Replicas node.
3. In the working area, select the necessary machine in the backup or VM replica and click Application Items > Microsoft Active Directory on the ribbon.
   You can also right-click the machine or VM replica and select Restore application items > Microsoft Active Directory objects.
4. Veeam Backup & Replication will open the Microsoft Active Directory Object Restore wizard. You can use this wizard to automatically extract the Microsoft Active Directory database from the backup or replica and open it in Veeam Explorer for Microsoft Active Directory.

Detailed information about preparing your applications for item-level recovery and using with Veeam Explorer for Microsoft Active Directory is provided in the Veeam Backup Explorers User Guide. To view the guide, do one of the following:

- Select Help > Online Help from the main menu of Veeam Explorer for Microsoft Active Directory.
See Veeam Explorers User Guide.
Using Veeam Explorer for Microsoft Exchange

You can use Veeam Explorer for Microsoft Exchange to restore Microsoft Exchange items from any successfully created backup or replica of a virtualized Microsoft Exchange Server. The backup or replica must be created with application-aware processing enabled and the corresponding options turned on.

To launch Veeam Explorer for Microsoft Exchange from Veeam Backup & Replication:

1. Open the Home view.
2. In the inventory pane, select the Backups or Replicas node.
3. In the working area, select the necessary machine in the backup or VM replica and click Application Items > Microsoft Exchange on the ribbon.
   
   You can also right-click the machine or VM replica and select Restore application items > Microsoft Exchange mailbox items.
4. Veeam Backup & Replication will open the Microsoft Exchange Item Level Restore wizard. You can use this wizard to automatically extract the Microsoft Exchange database from the backup or replica and open it in Veeam Explorer for Microsoft Exchange.

Detailed information about preparing your applications for item-level recovery and using with Veeam Explorer for Microsoft Exchange is provided in the Veeam Backup Explorers User Guide. To view the guide, do one of the following:

- Select Help > Online Help from the main menu of Veeam Explorer for Microsoft Exchange.
See Veeam Explorers User Guide.
Using Veeam Explorer for Microsoft SharePoint

You can use Veeam Explorer for Microsoft SharePoint to restore Microsoft SharePoint items from any successfully created backup or replica of a virtualized Microsoft SharePoint Server. The backup or replica must be created with application-aware processing enabled and the corresponding options turned on.

To launch Veeam Explorer for Microsoft SharePoint from Veeam Backup & Replication:

1. Open the Home view.
2. In the inventory pane, select the Backups or Replicas node.
3. In the working area, select the necessary machine in the backup or VM replica and click Application Items > Microsoft SharePoint on the ribbon.
   You can also right-click the machine or VM replica and select Restore application items > Microsoft SharePoint content.
4. Veeam Backup & Replication will open the Microsoft SharePoint Item Restore wizard. You can use this wizard to automatically extract the Microsoft SharePoint content database from the backup or replica and open it in Veeam Explorer for Microsoft SharePoint.

Detailed information about preparing your applications for item-level recovery and using with Veeam Explorer for Microsoft SharePoint is provided in the Veeam Backup Explorers User Guide. To view the guide, do one of the following:

- Open Veeam Explorer for Microsoft SharePoint and press [F1] on the keyboard.
- Select Help > Online Help from the main menu of Veeam Explorer for Microsoft SharePoint.
- See Veeam Explorers User Guide.
Using Veeam Explorer for Microsoft OneDrive for Business

You can use Veeam Explorer for Microsoft OneDrive for Business to restore Microsoft OneDrive for Business data from any successfully created backup or replica of a Veeam Backup for Microsoft Office 365 server. The backup or replica must be created with application-aware processing enabled.

To launch Veeam Explorer for Microsoft OneDrive for Business from Veeam Backup & Replication:

1. Open the Home view.
2. In the inventory pane, select the Backups or Replicas node.
3. In the working area, select the necessary machine in the backup or VM replica and click Application Items > Microsoft OneDrive for Business on the ribbon.
   
   You can also right-click the machine or VM replica and select Restore application items > Microsoft OneDrive for Business files.
4. Veeam Backup & Replication will open the Microsoft OneDrive for Business Files wizard. You can use this wizard to extract Microsoft OneDrive for Business data from the backup or replica and open it in Veeam Explorer for Microsoft OneDrive for Business.

Detailed information about preparing your applications for item-level recovery and using with Veeam Explorer for Microsoft OneDrive for Business is provided in the Veeam Backup Explorers User Guide. To view the guide, do one of the following:

- Open Veeam Explorer for Microsoft OneDrive for Business and press [F1] on the keyboard.
- Select Help > Online Help from the main menu of Veeam Explorer for Microsoft OneDrive for Business.
• See Veeam Explorers User Guide.
Using Veeam Explorer for Microsoft SQL Server

You can use Veeam Explorer for Microsoft SQL to restore databases from any successfully created backup or replica of a virtualized Microsoft SQL Server. The backup or replica must be created with application-aware processing enabled and the corresponding options turned on.

To launch Veeam Explorer for Microsoft SQL from Veeam Backup & Replication:

1. Open the Home view.
2. In the inventory pane, select the Backups or Replicas node.
3. In the working area, select the necessary machine in the backup or VM replica and click Application Items > Microsoft SQL Server on the ribbon.
   You can also right-click the machine or VM replica and select Restore application items > Microsoft SQL Server databases.
4. Veeam Backup & Replication will open the Microsoft SQL Server Database Restore wizard. You can use this wizard to automatically extract the Microsoft SQL database from the backup or replica and open it in Veeam Explorer for Microsoft SQL.

Detailed information about preparing your applications for item-level recovery and using with Veeam Explorer for Microsoft SQL is provided in the Veeam Backup Explorers User Guide. To view the guide, do one of the following:

- Open Veeam Explorer for Microsoft SQL Server and press [F1] on the keyboard.
- Select Help > Online Help from the main menu of Veeam Explorer for Microsoft SQL.
See Veeam Explorers User Guide.
Using Veeam Explorer for Oracle

You can use Veeam Explorer for Oracle to restore databases from any successfully created backup or replica of a virtualized Oracle system. The backup or replica must be created with application-aware processing enabled and the corresponding options turned on.

To launch Veeam Explorer for Oracle from Veeam Backup & Replication:

1. Open the Home view.
2. In the inventory pane, select the Backups or Replicas node.
3. In the working area, select the necessary machine in the backup or VM replica and click Application Items > Oracle on the ribbon.

You can also right-click the machine or VM replica and select Restore application items > Oracle databases.

4. Veeam Backup & Replication will open the Oracle Database Restore wizard. You can use this wizard to automatically extract the Oracle database from the backup or replica and open it in Veeam Explorer for Oracle.

Detailed information about preparing your applications for item-level recovery and using with Veeam Explorer for Oracle is provided in the Veeam Backup Explorers User Guide. To view the guide, do one of the following:

- Open Veeam Explorer for Oracle and press [F1] on the keyboard.
- Select Help > Online Help from the main menu of Veeam Explorer for Oracle.
- See Veeam Explorers User Guide.
Veeam Backup & Replication allows you to restore machines from Veeam backups to Microsoft Azure. You can use Veeam Backup & Replication to complete the following tasks:

- Restore machines from Veeam backups to Microsoft Azure.
- Migrate machines from the on-premises infrastructure to the cloud.
- Create a test environment in the cloud for troubleshooting, testing patches and updates and so on.

You can restore machines from the following types of backups:

- Backups of Microsoft Windows and Linux VMs created with Veeam Backup & Replication.
- Backups of Microsoft Windows machines created with Veeam Agent for Microsoft Windows. Backups must be created at the entire machine level or volume level.
  
  **IMPORTANT!**
  Machines from a backup that contains a failover cluster are restored as separate VMs, not as a cluster. Shared cluster disks of these VMs are restored as regular disks.

- Backups of Linux machines created with Veeam Agent for Linux. Backups must be created at the entire machine level or volume level.
- Backups of Amazon EC2 instances created with Veeam Backup for AWS.
- Backups of Microsoft Azure virtual machines created with Veeam Backup for Microsoft Azure.
- Backups of Nutanix AHV VMs created with Veeam Backup for Nutanix AHV.

You can restore a machine to the latest restore point or any previous restore point in the backup chain. A backup chain from which you plan to restore a machine must reside in a backup repository added to the backup infrastructure.

You can also import a backup to the Veeam Backup & Replication console. For more information, see Importing Backups.

For restore to Microsoft Azure, Veeam Backup & Replication can employ the Microsoft Azure Resource Manager or Classic deployment model. Veeam Backup & Replication supports batch restore — you can launch the restore process for several VMs at a time.
IMPORTANT!

Starting from Veeam Backup & Replication version 9.5 Update 4, the Classic deployment model is deprecated. Thus, you cannot add Classic Azure accounts. You can restore VMs in the Classic model only if you have added the Classic Azure account before upgrading to Veeam Backup & Replication 9.5 Update 4.
How Restore to Microsoft Azure Works

Veeam Backup & Replication lets you restore physical and virtual machines from VeeamZIP files and backups residing in the on-premises environment to Microsoft Azure. The restore process differs for Microsoft Windows and Linux machines.

- Restore of Microsoft Windows machines
- Restore of Linux machines

Restore of Microsoft Windows Machines

To restore a Microsoft Windows machine, Veeam Backup & Replication performs the following steps:

1. If you use an Azure proxy for restore, Veeam Backup & Replication powers on the Azure proxy. For more information about the Azure proxy, see Configuring Azure Proxies.
2. Veeam Backup & Replication converts disks of a backed-up machine to the VHD format and uploads converted disks to blob storage in Microsoft Azure.
3. Veeam Backup & Replication mounts uploaded disks to the backup server.
4. Veeam Backup & Replication prepares disks for VM restore. As part of this process, it enables Remote Desktop rules, configures firewall rules, prepares disks for Microsoft Azure agent installation and so on.
5. Veeam Backup & Replication unmounts prepared disks from the backup server.
6. If you use an Azure proxy for restore, Veeam Backup & Replication powers off the Azure proxy after a timeout.
7. Veeam Backup & Replication registers a Microsoft Azure VM with the prepared machine disks. After the registration process is complete, the Microsoft Azure VM is powered on immediately, and the Microsoft Azure agent is installed on the machine.
Restore of Linux Machines

For restore of Linux machines, Veeam Backup & Replication uses a helper appliance. The helper appliance is a small auxiliary Linux-based VM in Microsoft Azure registered by Veeam Backup & Replication. During the restore process, Veeam Backup & Replication mounts disks of a backed-up machine to the helper appliance to prepare disks for restore.

You can set up a helper appliance when you configure initial settings for restore to Microsoft Azure. If you plan to restore Linux machines to different locations, you must set up several appliances — one appliance in every location.

The helper appliance is persistent. After you set up the appliance, it remains in Microsoft Azure in the powered off state. Veeam Backup & Replication starts the helper appliance for a short period of time during the restore process and powers the appliance off when the restore process is complete.

To restore a Linux machine, Veeam Backup & Replication performs the following steps:

1. If you use an Azure proxy for restore, Veeam Backup & Replication powers on the Azure proxy. For more information about the Azure proxy, see Configuring Azure Proxies.
2. Veeam Backup & Replication converts disks of a backed-up machine to the VHD format and uploads converted disks to blob storage in Microsoft Azure.
3. Veeam Backup & Replication mounts uploaded disks to the helper appliance that resides in the location to which you restore the Linux machine.
4. Veeam Backup & Replication starts the helper appliance with mounted disks.
5. Veeam Backup & Replication prepares disks for VM restore. As part of this process, it enables remote connection rules, configures firewall rules and so on.
6. Veeam Backup & Replication unmounts prepared disks from the helper appliance and powers off the helper appliance.
7. If you use an Azure proxy for restore, Veeam Backup & Replication powers off the Azure proxy after a timeout.
8. Veeam Backup & Replication registers a Microsoft Azure VM with the prepared machine disks. After the registration process is complete, the VM is powered on immediately.
Restore Workflow

To restore a machine from backup or VeeamZIP file to Microsoft Azure, you must perform the following steps:

1. **Configure initial settings for restore to Microsoft Azure.**
   You must add information about Microsoft Azure accounts to Veeam Backup & Replication, configure helper appliances and Azure proxies.

2. **Create a backup file.**
   You must create a backup of a machine that you want to restore to Microsoft Azure.

3. **Restore a machine from the backup.**
   You must restore a machine from the backup to Microsoft Azure.
Configuring Initial Settings

Before you restore machines from backups, you must configure initial settings for Microsoft Azure in Veeam Backup & Replication. As part of this process, you must perform the following tasks:

- Add an Azure account or add an Azure Stack account.
- [For restore of Linux machines] Configure helper appliances in Microsoft Azure.
- [For restore process speed-up] Configure an Azure proxy.
Adding Microsoft Azure Accounts

To restore machines to Microsoft Azure, you must add a Microsoft Azure account to Veeam Backup & Replication. When you add a Microsoft Azure account, Veeam Backup & Replication imports information about subscriptions and resources associated with the Microsoft Azure account. During the restore process, Veeam Backup & Replication accesses these resources and uses them to register new VMs in Microsoft Azure.

If necessary, you can add different user accounts to Veeam Backup & Replication. In this case, Veeam Backup & Replication will import information about all subscriptions and resources associated with provided accounts, and you will be able to use these resources for restore.

Information about subscriptions and resources is saved to the Veeam Backup & Replication configuration database. You can re-import this information at any time.

Before You Begin

Before you add a Microsoft Azure account to Veeam Backup & Replication, check the following prerequisites:

- Make sure that you have a user account in Microsoft Azure. You will not be able to create a new user account when passing through the Initial Configuration wizard.

- [For Microsoft Server OS] The Protected Mode must be switched off in the Internet Explorer settings. Otherwise, you will not be able to log on to Microsoft Azure when passing through the Initial Configuration wizard.

If you do not want to switch off the Protected Mode for security reasons, you can add the following sites to the list of trusted hosts in Internet Options > Secure settings in Internet Explorer or in Control Panel > Network and Internet:

- https://login.live.com
- https://login.microsoftonline.com
- https://secure.aadcdn.microsoftonline-p.com
- https://auth.gfx.ms
- about:security_veeam.backup.shell.exe

You may need to additionally disable the Internet Explorer Enhanced Security Configuration in Server Manager.

- On the backup server, you must set the correct time according to the timezone where the backup server is located. Otherwise, you may not be able to add a Microsoft Azure user account to Veeam Backup & Replication.

- We recommend having Microsoft Azure PowerShell version 5.1.1 installed on the machine running the Veeam Backup & Replication console. If the version is different from 5.1.1 you may not be able to add a Microsoft Azure account to Veeam Backup & Replication.

If you do not have Microsoft Azure PowerShell on the machine, Veeam Backup & Replication will prompt you to install it. For more information, see the Deployment Type step of the Initial Configuration wizard.

- When the Internet access is possible only through HTTP/HTTPS proxy, you must configure the proxy settings for the Local System account or account under which the Veeam Backup Service is running. For more information, see this Microsoft article.
NOTE:
When you add a Microsoft Azure account to Veeam Backup & Replication, Veeam Backup & Replication creates an Azure AD application in the added account. For more information, see Microsoft Azure documentation.

Procedure

To add a Microsoft Azure account using the Resource Manager deployment model, do the following:

1. From the main menu, select Manage Cloud Credentials.
2. In the Manage Cloud Credentials window, click Add and select Microsoft Azure compute account.
3. At the **Initial Configuration** step of the wizard, click **Next**.

![Initial Configuration screen](image)

Registering your Microsoft Azure account enables you to leverage Veeam Disaster Recovery in Microsoft Azure solution, which includes Direct Restore to Microsoft Azure and Veeam PN for Microsoft Azure.

Direct Restore to Microsoft Azure is an additional restore option that lets you restore backups of Windows and Linux virtual machines, physical servers and workstations directly to the Microsoft cloud for disaster recovery or migration purposes.

Veeam PN for Microsoft Azure is a lightweight software-defined networking solution that allows you to easily and securely establish network connectivity to the restored computers from your datacenter. [Learn more](#)

4. At the **Deployment Type** step of the wizard, select **Microsoft Azure**.

From the **Region** list, select a Microsoft Azure region: **Global, Germany, China** or **Government**, and click **Next**.

![Deployment Type screen](image)

- **Microsoft Azure**
  - Register an account for the public cloud computing service hosted in a global network of Microsoft-managed data centers.
  - **Regions:**
    - **Global**

- **Microsoft Azure Stack**
  - Register an account for a hybrid cloud computing service delivering Microsoft Azure services from a private or service provider's data center.
5. At the **Subscription** step of the wizard, select the method of importing your Azure Resource Manager subscription. You have two options:

   - **Use the existing account**: Select this option, if you want to use Azure Active Directory Account. The Azure account must have the *Owner* role privileges for the required subscription. If the *Owner* role cannot be used, you can create a custom role with minimal permissions. To learn how to create a custom role, see [Creating Custom Role for Azure Account](#).

     Note the following:
     - Only subscriptions that belong to selected account’s directory will be added.
     - In this scenario, you cannot add an account with enabled MFA. You must disable MFA for the required account. App passwords are not supported.

   - **Create a new account**: If you select this option, Veeam Backup & Replication will register a special application on Azure. Veeam Backup & Replication will use this application to communicate with Azure. Mind the following prerequisites:

     - A Microsoft Azure account that you plan to add to Veeam Backup & Replication must have the *Owner* role privileges for the subscription that will be used for restore to Microsoft Azure. Owner role privileges are required to provide access to subscription for the created application. For details, see [Microsoft Azure documentation](#).

     - The user must have privileges to register applications: Global Administrator privileges or the enabled **Users can register applications** option in Azure portal. For details, see [Microsoft Azure documentation](#).

     To create a new account, do the following:

     i. Click the **Configure account** link.

        Veeam Backup & Replication will check if Microsoft Azure PowerShell is installed on the machine that runs the Veeam Backup & Replication console. If Microsoft Azure PowerShell is not installed, Veeam Backup & Replication will display a warning.

     ii. In the warning window, click [this link](#). Veeam Backup & Replication will launch the Microsoft Azure Powershell installation wizard. Follow steps of the installation wizard to set up the Microsoft Azure PowerShell 5.1.1 on the machine.

     iii. After the installation process is complete, close the Veeam Backup & Replication console. In some cases, Microsoft PowerShell Azure requires you to restart the machine.

     iv. Open the Veeam Backup & Replication console and pass through the **Initial Configuration** wizard once again.
v. Click the **Configure account** link. You will be prompted to log in to the Microsoft Azure portal. Enter credentials of an existing Microsoft Azure account in the browser window. Veeam Backup & Replication will retrieve information about subscriptions and resources associated with this account.

6. If you plan to restore Linux machines to Microsoft Azure, select the **Enable restore of Linux-based computers** check box. Veeam Backup & Replication will deploy a helper appliance in Microsoft Azure and use it for restore of Linux machines. For more information about helper appliance setup, see [Configuring Helper Appliances](#).
7. At the **Summary** step of the wizard, review details of configured settings and click **Finish** to close the wizard.

The summary window is shown with the following details:

**Initial Configuration**
- Summary:
  - Initial configuration has been completed successfully. Click Finish to exit the wizard.

**Deployment Type**
- Subscription:
  - Visual Studio Premium with MSDN
Adding Microsoft Azure Stack Accounts

To restore machines to Microsoft Azure Stack, you must add an Azure Stack account to Veeam Backup & Replication. When you add an Azure Stack account, Veeam Backup & Replication imports information about subscriptions and resources associated with the Azure Stack account. During the restore process, Veeam Backup & Replication accesses these resources and uses them to register new VMs in Azure Stack.

**IMPORTANT!**
For restore to Microsoft Azure Stack version 1808 and later, you need to configure the backup server. For more information, see this Veeam KB article.

If necessary, you can add different user accounts to Veeam Backup & Replication. In this case, Veeam Backup & Replication will import information about all subscriptions and resources associated with provided accounts, and you will be able to use these resources for restore.

Information about subscriptions and resources is saved to the Veeam Backup & Replication configuration database. You can re-import this information at any time.

To add a Microsoft Azure Stack account, do the following.

1. From the main menu, select **Manage Cloud Credentials**.
2. In the **Manage Cloud Credentials** window, click **Add** and select **Microsoft Azure compute account**.

![Adding Microsoft Azure Stack Accounts](image-url)
3. At the **Initial Configuration** screen of the wizard, click **Next**.

4. At the **Deployment Type** step of the wizard, select **Microsoft Azure Stack** and click **Next**.
5. At the **Name** step of the wizard, do the following:

a. In the **Azure Stack resource manager endpoint** field, specify the virtual IP address of Azure Resource Manager in the following format: `management.<region>.<FQDN>`.

   To learn about Azure Stack virtual IP addresses, see [Microsoft Docs](#).

b. If you have added the Azure Stack tenant user account beforehand, select the Azure Stack tenant user account from the list.

   If you have not set up credentials beforehand, click the **Manage accounts** link or click **Add** on the right to add an Azure Stack tenant user credentials.

   **NOTE**

   Azure Stack tenant user account must have the Owner role privileges for the required subscription. If the Owner role cannot be used, you can create a custom role with minimal permissions. To learn how to create a custom role, see [Creating Custom Role for Azure Account](#).

   Keep in mind that:

   - Only subscriptions that belong to the directory of the selected account will be added.
   - In this scenario, you cannot add an account with enabled MFA. You must disable MFA for the required account. App passwords are not supported.

6. If you want to restore Linux-based computers, select the **Enable restore of Linux-based computers** check box. Veeam Backup & Replication will deploy a helper appliance in Microsoft Azure. The helper appliance will be used to restore Linux machines. For more information about helper appliance setup, see [Configuring Helper Appliances](#).
7. At the **Summary** step of the wizard, review details of configured settings and click **Finish** to close the wizard.
Creating Custom Role for Azure Account

If you do not want to use built-in Azure roles, you can create a custom role with minimal permissions.

To create a custom role, do the following:

1. Run the following script in Azure PowerShell:

```powershell
Import-Module AzureRM.Resources
$role.Name = 'Veeam Restore Operator'
$role.Description = 'Permissions for Veeam Direct Restore to Microsoft Azure'
$role.IsCustom = $true
$permissions = @(
  'Microsoft.Storage/storageAccounts/listkeys/action',
  'Microsoft.Storage/storageAccounts/read',
  'Microsoft.Network/locations/checkDnsNameAvailability/read',
  'Microsoft.Network/virtualNetworks/read',
  'Microsoft.Network/virtualNetworks/subnets/join/action',
  'Microsoft.Network/publicIPAddresses/read',
  'Microsoft.Network/publicIPAddresses/write',
  'Microsoft.Network/publicIPAddresses/delete',
  'Microsoft.Network/publicIPAddresses/join/action',
  'Microsoft.Network/networkInterfaces/read',
  'Microsoft.Network/networkInterfaces/write',
  'Microsoft.Network/networkInterfaces/delete',
  'Microsoft.Network/networkInterfaces/join/action',
  'Microsoft.Network/networkSecurityGroups/read',
  'Microsoft.Network/networkSecurityGroups/write',
  'Microsoft.Network/networkSecurityGroups/delete',
  'Microsoft.Network/networkSecurityGroups/join/action',
  'Microsoft.Compute/locations/vmSizes/read',
  'Microsoft.Compute/locations/usages/read',
  'Microsoft.Compute/virtualMachines/read',
  'Microsoft.Compute/virtualMachines/write',
  'Microsoft.Compute/virtualMachines/delete',
  'Microsoft.Compute/virtualMachines/start/action',
  'Microsoft.Compute/virtualMachines/deallocate/action',
  'Microsoft.Compute/virtualMachines/instanceView/read',
  'Microsoft.Compute/virtualMachines/extensions/read',
  'Microsoft.Compute/virtualMachines/extensions/write',
  'Microsoft.Compute/disks/read',
  'Microsoft.Compute/disks/write',
  'Microsoft.Resources/checkResourceName/action',
  'Microsoft.Resources/subscriptions/resourceGroups/read',
  'Microsoft.Resources/subscriptions/resourceGroups/write',
  'Microsoft.Resources/subscriptions/locations/read'
)
$role.Actions = $permissions
$role.NotActions = (Get-AzureRmRoleDefinition -Name 'Virtual Machine Contributor').NotActions
$subs = '/subscriptions/00000000-0000-0000-0000-000000000000' # use your subscription ID
$role.AssignableScopes = $subs
New-AzureRmRoleDefinition -Role $role
```
2. Assign the created role to the required Azure User. For details, see the Manage access to Azure resources using RBAC and the Azure portal section in the RBAC for Azure resources documentation.

3. In the Subscription step of the Initial Configuration wizard, select Use existing account and select the Azure user with the assigned role. For details, see Adding Microsoft Azure Account.

NOTE:
- You must use Connect-AzureRmAccount and Get-AzureRmSubscription to input the subscription ID within the script.
- The script is provided for Microsoft Azure PowerShell version 5.1.1. The naming of commands may vary for other versions of Microsoft Azure PowerShell.

Reference

Create Custom Roles Using Azure PowerShell
Configuring Helper Appliances

Veeam Backup & Replication requires a helper appliance to restore Linux machines to Microsoft Azure. The helper appliance is a small auxiliary VM in Microsoft Azure registered by Veeam Backup & Replication. During the restore process, Veeam Backup & Replication mounts disks of the restored machine to the helper appliance to prepare these disks for restore.

You must configure a helper appliance in the location to which you plan to restore Linux machines. If you plan to restore Linux machines to different locations, you must configure several appliances — one appliance in every location.

Mind the following:

- Helper appliances are persistent. After you set up appliances, they remain in Microsoft Azure in the powered off state until you start the restore process. Microsoft Azure will bill you for storing helper appliances disks in the storage account.

- Veeam Backup & Replication uses a built-in credentials record to work with all helper appliances. For security reasons, it is recommended that you change a password for this account before you set up the helper appliances. For more information, see Changing Credentials for Helper Appliances.

To configure a helper appliance:

1. From the main menu, select Manage Cloud Credentials.

2. In the Manage Cloud Credentials window, click Add. If you edit an existing account, select it in the list and click Edit.
3. **At the Deployment Model** step of the wizard, select the necessary deployment model.

4. **At the Subscription step of the wizard, select the Enable restore of Linux-based computers check box.**

5. **At the Helper Appliance step of the wizard, configure settings of the helper appliance.**
   a. On the right of the Helper appliances list, click Add.
b. From the **Subscription** list, select a subscription whose resources you want to use to configure the helper appliance. The subscription list contains all subscriptions that are associated with the Microsoft Azure user account.

c. From the **Location** list, select a location in which you want to configure the helper appliance. Make sure that you select a geographic region with which at least one storage account of the subscription is associated.

d. From the **Storage account** list, select a storage account whose resources you want to use to store disks of the helper appliance.

e. [Optional] Click **Choose** if you don't want Veeam Backup & Replication to create a new resource group.

f. From the **Virtual network** list, select a network to which the helper appliance must be connected.

g. From the **Subnet** list, select a subnet for the helper appliance.

h. At the **SSH port** field, specify a port over which Veeam Backup & Replication will communicate with the helper appliance. By default, port 22 is used.

i. Click **OK**.

6. Repeat steps from a to i for all locations to which you plan to restore Linux machines and click **Next**.
7. At the **Deploy** step of the wizard, wait until Veeam Backup & Replication configures the helper appliance in Microsoft Azure. The appliance will remain powered off until you start restoring Linux machines to the necessary location in Microsoft Azure.

![Deployment Progress](image1.png)

8. At the **Summary** step of the wizard, review summary information and click **Finish** to close the wizard.

![Summary Confirmation](image2.png)
Changing Credentials for Helper Appliances

By default, Veeam Backup & Replication uses built-in credentials record to work with all helper appliances in Microsoft Azure and Azure Stack. For security reasons, it is recommended that you change a password for this credentials record before you set up helper appliances.

**IMPORTANT!**

When you change a password in the built-in credentials record, you must re-deploy existing helper appliances in Microsoft Azure and Azure Stack.

To change the password in a credentials record for helper appliances:

1. From the main menu, select **Manage Credentials**.
2. In the **Manage Credentials** window, click the Azure helper appliance credentials record.
3. Click **Edit**.
4. In the **Password** field, specify a new password.
5. Click **OK** to save changes.

![manage_credentials.png](attachment://manage_credentials.png)

### Removing Helper Appliances

You can remove helper appliances from Microsoft Azure and Azure Stack, for example, if you no longer need to restore Linux machines to Azure or Azure Stack.

To remove a helper appliance, do the following:

1. From the main menu, select **Manage Cloud Credentials**.
2. In the accounts list, select the Azure account and click **Edit**.
3. Pass to the **Helper Appliance** step of the **Initial Configuration** wizard.
4. In the Help **appliance**s list, select the helper appliance and click **Remove**.

**IMPORTANT!**

Do not clear the **Enable restore of Linux-based computers** check box at the **Subscription** step of the wizard to remove helper appliances. In this case, the **Initial Configuration** wizard will not display the **Helper Appliance** step. Helper appliances themselves will remain in Microsoft Azure.
Configuring Azure Proxies

In some cases, upload of machine disks to Microsoft Azure may take a long time. This can happen if you restore machines to a distant location and the network connection is slow. To speed up the restore process, it is recommended that you deploy an Azure proxy in the backup infrastructure.

The Azure proxy is a small auxiliary machine in Microsoft Azure over which Veeam Backup & Replication transports VM disk data to blob storage. Veeam components installed on the Azure proxy compress and deduplicate disk data, which helps reduce network traffic and increase the speed of the restore process.

To configure an Azure proxy, you must pass through the Azure Proxy wizard. Veeam Backup & Replication will deploy a Microsoft Windows Server 2012 R2 machine in Microsoft Azure and assign the role of the Azure proxy to this machine. You can then instruct Veeam Backup & Replication to use the Azure proxy for restore tasks.

It is strongly recommended that you configure Azure proxies in the backup infrastructure. Azure proxies do not require a lot of resources and can speed up the restore process significantly. You should configure an Azure proxy in a location to which you plan to restore machines, or close to this location. If you plan to restore machines to different locations, you should configure at least one Azure proxy in each location.

The process of Azure proxy deployment takes some time. It is recommended that you configure the Azure proxy in advance, before you start the restore process.

Before you configure an Azure proxy, check prerequisites. Then follow the Azure Proxy wizard steps to deploy the proxy.

Before You Begin

Before you configure an Azure proxy, check the following prerequisites:

- You must import information about your Microsoft Azure user account to Veeam Backup & Replication. For more information, see Adding Azure Accounts or Adding Azure Stack Accounts.

- You must configure the following objects in Microsoft Azure beforehand:
  - Storage account whose resources you plan to use to store disks of the Azure proxy.
  - Networks to which you plan to connect the Azure proxy.

  For storage accounts and network configuration, you must use the same deployment model that you plan to use for Azure proxy creation.

**NOTE**

For restore to Microsoft Azure for environments with ExpressRoute or site-to-site VPN connectivity to Azure, you may need to create a registry key. For more information, see this Veeam KB article.

**IMPORTANT!**

When you deploy Azure proxy for Azure Stack, make sure that Windows Server 2012 R2 is available in Azure marketplace.
Step 1. Launch Azure Proxy Wizard

To launch the Azure Proxy wizard, do one of the following:

- Open the Backup Infrastructure view. In the inventory pane, select Backup Proxies, click the Backup Proxy node, and click Add Proxy > Azure on the ribbon.

- Open the Backup Infrastructure view. In the inventory pane, right-click Backup Proxies and select Add Azure Proxy.

IMPORTANT!

Before you start to configure an Azure proxy, you must import information about the Microsoft Azure user account. In the opposite case, the Add Azure Proxy option will not be available. For more information, see Adding Azure Accounts or Adding Azure Stack Accounts.
Step 2. Specify Azure Proxy Name

At the Name step of the wizard, specify a name and description for the Azure proxy.

1. In the Name field, specify a name for the Azure proxy. The name must meet the following requirements:
   - The name must not be longer than 15 characters.
   - The name must contain only alphanumeric characters and hyphens.
   - The name must start with a letter and end with a letter or number.
   - The name must not contain only numeric characters.
   - The name must not contain special characters: `!@#$%^&*()+=_\[]{}|;:.'",<>/?`.

2. In the Description field, provide a description for the Azure proxy. The default description contains information about the user who added the proxy, date and time when the proxy was added.

3. At the Max concurrent tasks field, specify the number of tasks that the Azure proxy must handle in parallel. If the Max concurrent tasks value is exceeded, the Azure proxy will not start a new task until one of current tasks finishes.

   Veeam Backup & Replication creates one task per one machine disk. By default, Azure proxy handles 4 concurrent tasks.

![Add Azure Proxy](image)
Step 3. Specify Credentials and Transport Port

At the **Credentials** step of the wizard, specify credentials of the local administrator account on the Azure proxy and define the transport port.

1. When you configure an Azure proxy, Veeam Backup & Replication creates an account with the Local Administrator permissions on this proxy. To specify a user name and password for this account, do the following:
   a. On the right of the **Credentials** list, click the **Manage accounts** link or click **Add**.
   b. In the **Credentials** window, enter a user name, password and description for the account.
      
      You must specify the user name without a domain or Microsoft Azure machine name. The password must be at least 8 characters long, and must contain at least 1 uppercase character, 1 lowercase character, 1 numeric character and 1 special character.
   c. Click **OK**.

2. In the **Traffic port** field, specify a port over which Veeam Backup & Replication will control components installed on the Azure proxy and transport VM disks data to blob storage. By default, port 443 is used. The port must be opened on the backup server and backup repository that stores VM backups.

**IMPORTANT!**

You cannot use reserved names such as 'administrator', 'admin', 'user', 'abc@123', 'P@$wOrd' and so on as a user name and password of the local administrator account.
Step 4. Select Subscription and Location

At the **Subscription** step of the wizard, select a subscription and location for the Azure proxy.

1. From the **Subscription** list, select a subscription whose resources you want to use to deploy the Azure proxy. The subscription list contains all subscriptions associated with the user accounts that you have added to Veeam Backup & Replication.

2. From the **Locations** list, select a geographic region to which you want to place the Azure proxy. Make sure that you select a geographic region with which at least one storage account of the subscription is associated.
Step 5. Select VM Size

At the **VM size** step of the wizard, you can select the size for the Azure proxy VM and specify what storage account you want to use to deploy the Azure proxy VM.

1. From the **Size** list, select the size for the Azure proxy.

   The default size is *Standard_F4s_v2*. If *Standard_F4s_v2* is not available, we recommend to select a similar compute optimized VM size of the previous generation — F-series. For example, *Standard_F4*, *Standard_F4s*. These sizes are sufficient to transport VM disks data to blob storage. If necessary, you can select a greater size for the Azure proxy.

   If you select a premium storage account, make sure that the VM size is compatible with the selected account.

   **NOTE:**

   Azure proxy VMs created in Veeam Backup & Replication version prior 10a have smaller sizes — *Basic_A2*. We recommend you to change sizes of such proxies to the sizes listed above. This will enhance the performance of restore to Azure.

   You can change VM sizes in [Microsoft Azure Portal](https://portal.azure.com) or deploy new proxies with the required sizes in Veeam Backup & Replication.

2. From the **Storage account** list, select a storage account whose resources you want to use to store disks of the Azure proxy. The storage account must be compatible with the VM size you select.

   The list of storage accounts will contain only general purpose storage accounts. Blob storage accounts will not be displayed in the list of subscriptions. For more information about account types, see [Microsoft Docs](https://docs.microsoft.com).
TIP:
Microsoft Azure subscriptions have default limits on the number of CPU cores. Make sure that the VM size you select does not exceed limits of the subscription.
Step 6. Select Resource Group

At the Resource Group step of the wizard, you can specify settings of the resource group to which the Azure proxy must be placed.

By default, Veeam Backup & Replication creates a new resource group for the Azure proxy and places the proxy to it. If necessary, you can place the proxy to an existing resource group.

Select the necessary option for the Azure proxy:

- If you want to place the Azure proxy to an existing resource group, select Place VM into the existing resource group. From the list below, select the necessary resource group.

- If you want to create a dedicated resource group for the Azure proxy, select Create a new resource group. In the Name field, enter a name for the new resource group. The resource group name can be up to 64 characters long, and can contain only alphanumeric, underscore and hyphen characters.

In the new resource group, Veeam Backup & Replication automatically creates a Network Security Group, dynamic public IP and network interface. In the DNS name label field, enter a name for the new dynamic public IP created with Veeam Backup & Replication. The DNS name label can be up to 80 characters long, and can contain only alphanumeric, dash and underscore characters. For more information, see Microsoft Docs.

TIP:

Microsoft Azure subscriptions have default limits on the number of resource groups. If you decide to create a new resource group, make sure that you do not exceed limits of the subscription.

![Add Azure Proxy](image)
Step 7. Select Virtual Network

At the **Network** step of the wizard, you can select to which network and subnet the Azure proxy must be connected.

To define network settings for the Azure proxy:

1. From the **Virtual network** list, select a network to which the Azure proxy must be connected.

   **IMPORTANT!**
   
   If you want to restore from backups in an on-premises object storage repository, the selected virtual network must have access to the source object storage repository. To provide access to object storage repositories, you can use VPN or Azure ExpressRoute.

2. From the **Subnet** list, select a subnet for the Azure proxy.
Step 8. Start Azure Proxy Configuration

At the **Apply** step of the wizard, Veeam Backup & Replication deploys the Azure proxy with specified settings. You can view the deployment progress in the real-time mode.

When the configuration process is over, click **Next**. At the **Summary** step of the wizard, click **Finish** to close the wizard.

**TIP:**

The Azure proxy deployment may take several minutes. You can close the Azure Proxy wizard and continue working with Veeam Backup & Replication while the proxy is being deployed. To view the deployment progress, open the **History** view, in the inventory pane select **System**, and double-click the task of the proxy deployment in the working area.
Removing Azure Proxies

Veeam Backup & Replication does not provide a possibility to edit settings of deployed Azure proxies. If you want to change Azure proxy configuration, remove the Azure proxy and create a new proxy.

To remove an Azure proxy, do the following:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select **Backup Proxies**.
3. In the working area, right-click the Azure proxy and select **Remove**.

**IMPORTANT!**

If you want to remove an Azure or an Azure Stack account from Veeam Backup & Replication, you must remove all Azure proxies first.
Restoring Machines

You can restore machines from backups to Microsoft Azure or Azure Stack. The restored machine appears in the Microsoft Azure portal, and you can use it as a regular Microsoft Azure VM.

**IMPORTANT!**

After the restore process is finished, Veeam Backup & Replication immediately powers on the restored VM.

Before you restore a machine to Microsoft Azure, check prerequisites. Then use the Restore to Azure wizard to restore the machine.
Before You Begin

Before you restore a machine to Microsoft Azure, mind the following prerequisites and limitations.

Prerequisites

The following are prerequisites for restoring VMs:

- You must add a Microsoft Azure account to Veeam Backup & Replication. For more information, see Adding Microsoft Azure Accounts.

- You must configure the following objects in Microsoft Azure beforehand:
  - Storage account whose resources you plan to use to store disks of the restored machine.
  - Networks to which you plan to connect the restored machine.

For storage accounts and network configuration, you must use the same deployment model that you plan to use for machine restore.

- [For restore of Linux machines] You must configure a helper appliance in the location to which you plan to restore a machine. For more information, see Configuring Helper Appliances.

- [For speeding up the restore] If you plan to restore machines to a distant location, you can configure Azure proxies through which machine disks will be transported to blob storage. For more information, see Configuring Microsoft Azure Proxies.

- [For speeding up restore from Capacity Tier] It is strongly recommended to use Azure proxy when you restore from backups residing on a Capacity Tier. For more information, see Configuring Microsoft Azure Proxies.

- You must create a backup of the machine that you want to restore in Microsoft Azure. For the list of supported backups, see Restore to Microsoft Azure.

- You must set up correct time on the backup server. Otherwise you may not be able to add a Microsoft Azure account to Veeam Backup & Replication, or the restore process may fail.

Limitations

The following are limitations for restore to Azure:

- Veeam Backup & Replication supports restore to Microsoft Azure for the following machines:
  - Microsoft Windows machines running Windows Server 2008/Windows Vista and later
  - Linux machines (see the Supported Distributions & Versions section in Microsoft Docs).

- [Azure VMs] Veeam Backup & Replication does not support restore of Azure Ultra Disks.

- [Azure VMs] Mind the following limitations for disk sizes:
  - [Unmanaged VM disks] Veeam Backup & Replication does not allow you to restore VM disks larger than 4093 GB. This is due to the following reasons: VM disks can increase in size up to 2 GB because of conversion during the restore process; Azure supports disk up to 4095 GB. For more information on supported disk sizes, see Microsoft Docs.
[Managed VM disks] Veeam Backup & Replication does not allow you to restore VM disks larger than 8190 GB. During the restore process, VM disks can increase in size up to 2 GB because of conversion.

For more information on managed disk sizes that Azure supports, see Microsoft Docs.

**IMPORTANT**

The price of a restored VM disk can become higher because of the increase in disk size during the restore process. For more information on pricing, see Managed Disks pricing and Unmanaged Disk and Page Blob pricing.

- [Azure Stack VMs] Veeam Backup & Replication does not allow you to restore managed and unmanaged disks larger than 1021 GB. This is due to the following reasons: VM disks can increase in size up to 2 GB because of conversion during the restore process; Azure Stack supports disk up to 1023 GB. For more information on supported disk sizes, see Microsoft Docs.

You can change the maximum supported size for unmanaged VM disks with a registry key. For more information, contact Veeam Customer Support.

**IMPORTANT**

The price of a restored VM disk can become higher because of the increase in disk size during the restore process. For more information on pricing, see Azure Stack Hub Pricing.

- If the system disk of an initial machine uses the GPT partitioning scheme, the number of partitions on the disk cannot exceed 4. During restore such disk will be converted to a disk with the MBR partitioning scheme.
- The restore to Microsoft Azure functionality does not support the Azure Hybrid Use Benefit program.
- [For restore from backups created with Veeam Agent for Microsoft Windows] Machines from a backup that contains a failover cluster are restored as separate VMs, not as a cluster. Shared cluster disks of these VMs are restored as regular disks.
Step 1. Launch Restore to Azure Wizard

To begin the restore process, do the following:

1. Open the **Home** view.
2. In the inventory pane, click **Backups**.
3. In the working area, expand the necessary backup, right-click the machine that you want to restore and select **Restore to Microsoft Azure**.

   In this case, you will pass to the **Subscription** step of the wizard.

Alternatively, you can do one of the following:

- [Microsoft Hyper-V] On the **Home** tab, click **Restore > Microsoft Hyper-V > Restore from backup > Entire VM restore > Restore to Microsoft Azure**.
- [Amazon EC2] On the **Home** tab, click **Restore > AWS EC2 backup > Entire machine restore > Restore to Microsoft Azure**.
- [Nutanix AHV] Open the **Home** view; click **Backups**; in the working area, expand the necessary backup, right-click the AHV VM that you want to restore and select **Restore to Microsoft Azure**.
- [Agents] On the **Home** tab, click **Restore > Agents > Entire machine restore > Restore to Microsoft Azure**.
- Double-click a full backup file (VBK) or backup metadata file (VBM) in a file browser. Veeam Backup & Replication will start its console. In the **Backup Properties** window, select the necessary machine and click **Restore > Restore to Microsoft Azure**. In this case, you will pass to the **Subscription** step of the wizard.
Step 2. Select Machine and Restore Point

At the Machine step of the wizard, specify the machine that you want to restore and specify restore points to which you want to restore the machine.

To select a machine to restore:

1. On the right of the Machine list, click Add.
2. In the Backup Browser window, expand the required backup, select the machine and click Add. You can add several machines to the list to perform batch restore.

By default, Veeam Backup & Replication restores a machine to the latest valid restore point in the backup chain. However, you can restore the machine to an earlier restore point.

To select a restore point, do the following:

1. In the Machine list, select the machine.
2. Click Point on the right.
3. In the **Restore Points** window, select a restore point to which you want to restore the machine.
Step 3. Select Subscription and Location

At the **Subscription** step of the wizard, you must select a subscription, location for the restored machine and define how machine data must be transported to Microsoft Azure or Azure Stack.

1. From the **Subscription** list, select a subscription whose resources you want to use. The subscription list contains all subscriptions associated with the user accounts that you have added to Veeam Backup & Replication.

2. From the **Locations** list, select a geographic region to which you want to place the restored machine. Make sure that you select a geographic region with which at least one storage account of the subscriptions is associated.

3. If you are restoring the machine to a distant location and want to speed up the restore process, select the **Use Azure proxy VM** check box. From the **Proxy VM** list, select a Microsoft Azure proxy.

   It is recommended that you configure the Azure proxy in the same location to which you plan to restore the machine. For more information, see [Configuring Azure Proxies](#).

<table>
<thead>
<tr>
<th>Machine</th>
<th>Subscription</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Visual Cloud with MSDN (<a href="mailto:veeam@cloudbackup.onmicrosoft.com">veeam@cloudbackup.onmicrosoft.com</a>)</td>
<td>North Europe</td>
</tr>
</tbody>
</table>

**IMPORTANT!**

[For restore of Linux machines] You must have a preconfigured helper appliance in the location to which you are restoring a Linux machine. If the appliance is not configured, Veeam Backup & Replication will display the **Initial Configuration** wizard so that you can configure the appliance in the selected location.
Step 4. Specify VM Size

At the **VM Size** step of the wizard, you can:

- Select a size and storage account for the restored machine
- Select disks to restore and change their type

Selecting VM Size and Storage Account

To select a size and storage account for the machine:

1. In the **Azure VM Configuration** list, select the machine and click **Edit**.

2. From the **Size** list, select a size for the restored VM. By default, Veeam Backup & Replication selects the smallest VM size that can support the number of disks for the restored machine.

   Make sure that you select the right VM size that corresponds to the initial machine configuration. The VM size affects the number of CPU cores, memory and disk resources that will be allocated to the restored machine. For more information, see [Microsoft Docs](https://docs.microsoft.com).

3. From the **Storage account** list, select a storage account whose resources you want to use to store disks of the restored machine. The storage account must be compatible with the VM size you select.

   The list of storage accounts contains only general purpose storage accounts. Blob storage accounts are not be displayed in the list of subscriptions. For more information about account types, see [Microsoft Docs](https://docs.microsoft.com).

   If you select a premium storage account, make sure that the VM size is compatible with the selected account.

4. From the **Storage type** list, select the *managed* or *unmanaged* disk type. Note the limitations for VM disk sizes in [Before You Begin](https://docs.microsoft.com).

5. Click **OK**.
Microsoft Azure subscriptions have default limits on the number of CPU cores. Make sure that the VM size you select does not exceed limits of the subscription.

To select specific disks and change their type, do the following:

1. In the Azure VM Configuration list, select the machine and click Disks.
2. In the Disks to restore window, check that check boxes next to disks that you want to restore are selected. Clear check boxes next to disks that you do not want to restore.
3. [If you have selected the managed storage type] Select a disk and click the Disk Type button. In the Select Azure VM Disk Type window, select one of the following types: Standard HDD, Standard SSD or Premium SSD. For more information on disk types, see Microsoft Docs.

Selecting Disks to Restore and Changing Their Types

You can restore all disks or specific disks of a machine. You can also change disk types of the restored disks if you have selected the managed storage type.
IMPORTANT!
The selected disk type must be compatible with the selected VM size.

Select Azure VM Disk Type window
Step 5. Specify VM Name and Resource Group

At the Resource Group step of the wizard, you can:

- Specify a new name for the restored machine
- Select a resource group for the restored machine

Specifying Name for Machine

By default, Veeam Backup & Replication restores a machine with its original name. However, you can define a new name for the restored machine if necessary.

To define a new name for the machine:

1. In the Resource group list, select the machine and click Name.
2. In the Change Name window, enter a new name explicitly or specify a change name rule — add a prefix and/or suffix to the original machine name.

Selecting Resource Group

By default, Veeam Backup & Replication creates a new resource group for the restored machine and places the machine to it. If necessary, you can place the machine to an existing resource group.

1. In the Resource group list, select the machine and click Group.
2. In the VM Resource Group window, select the necessary option for the machine:
   - Select Place VM into the existing resource group if you want to place the machine to an existing resource group. From the list below, select the necessary resource group.
- Select **Create a new resource group** if you want to create a dedicated resource group for the restored machine. In the **Name** field, enter a name for the new resource group.

In the new resource group, Veeam Backup & Replication automatically creates a Network Security Group, a dynamic public IP and network interface.

**TIP:**

Microsoft Azure subscriptions have default limits on the number of resource groups. If you decide to create a new resource group, make sure that you do not exceed limits of the subscription.
Step 6. Select Virtual Network

At the **Network** step of the wizard, you can select to which network and subnet the restored machine must be connected.

Veeam Backup & Replication can connect the machine only to one virtual network. If necessary, you can manually configure additional network connections in Microsoft Azure after the machine is restored.

To define network settings for the machine, do the following:

1. In the **Virtual network** list, select the machine and click **Network**.
2. From the **Virtual network** list, select a network to which the machine must be connected.
3. From the **Subnet list**, select a subnet for the machine and click **OK**.
4. Veeam Backup & Replication can assign a public IP for the restored VM which can be used for communications over the internet. By default, a public IP is not assigned. From the **Public IP** list, select one of the options:
   - **Assign (restored VM will be accessible from the Internet)**: A public IP will be assigned to the restored VM. For security reasons, make sure traffic filtration rules are properly configured in the security group.
   - **Do not assign (more secure)**: A public IP will not be assigned. You can assign a public IP later in the settings of the restored VM.
5. From the **Virtual network** list, select the machine and click **Group**.
6. [Optional] Select the network security group from the list and click OK. The restored machine will be added to the selected network security group.

If you leave the field empty, Veeam Backup & Replication will create a new network security group.
Step 7. Specify Secure Restore Settings

This step is available if you restore Microsoft Windows workloads.

You can instruct Veeam Backup & Replication to perform secure restore — scan machine data with antivirus software before restoring the machine to Microsoft Azure or Azure Stack. For more information on secure restore, see Secure Restore.

To specify secure restore settings:

1. At the Secure Restore step of the wizard, select the Scan VM for virus threats prior performing recovery check box.

2. Select which action Veeam Backup & Replication will take if the antivirus software finds a virus threat:
   - **Abort VM recovery.** Select this action if you want Veeam Backup & Replication to cancel the restore session.
   - **Proceed recovery but connect VM to a different network.** Select this action if you want to restore the machine to a different Microsoft Azure virtual network.
     Click the Click to change link to select the virtual network.

3. Select the Scan entire VM for virus threats check box if you want the antivirus software to continue machine scan after the first malware is found. For information on how to view results of the malware scan, see Viewing Malware Scan Results.
Step 8. Specify Restore Reason

At the Reason step of the wizard, enter a reason for restoring the machine. The information you provide will be saved in the session history in Veeam Backup & Replication, and you can view it later.

**TIP:**

If you do not want to display the Reason step of the wizard in future, select the Do not show me this page again check box.
Step 9. Start Restore Process

At the Ready to Restore step of the wizard, review the restore settings.

1. By default, the target VM will be powered on after the restore. If you don't want to power on the VM after the restore, uncheck the **Power on target VM** after restoring check box.

2. Check the specified settings and click **Finish**. Veeam Backup & Replication will start the restore process.

You can trace the restore process in the **Restore Session** window. If you need to cancel the machine restore, click the **Cancel** restore task link.
Restore to Amazon EC2

Veeam Backup & Replication allows you to restore physical or virtual machines to Amazon Elastic Compute Cloud (Amazon EC2) as EC2 instances.

You can use Veeam Backup & Replication to perform the following operations:

- Restore machines to Amazon EC2 from backups.
- Migrate machines from the on-premises infrastructure to the cloud.
- Create a test environment in the cloud for troubleshooting, testing patches and updates, and so on.

You can restore machines from the following types of backups:

- Backups of VMware vSphere or vCloud Director virtual machines created with Veeam Backup & Replication
- Backups of Microsoft Hyper-V virtual machines created with Veeam Backup & Replication
- Backups of virtual and physical machines created with Veeam Agent for Microsoft Windows or Veeam Agent for Linux
  
  Backups must be created at the entire machine level or volume level.
- Backups of Amazon EC2 instances created with Veeam Backup for AWS
- Backups of Microsoft Azure virtual machines created with Veeam Backup for Microsoft Azure
- Backups of Nutanix AHV virtual machines created with Veeam Backup for Nutanix AHV
How Restore to Amazon EC2 Works

You can perform restore to Amazon EC2 from backups of EC2 instances, virtual and physical machines. To upload backed-up data to Amazon EC2, Veeam Backup & Replication may use an auxiliary EC2 instance — a proxy appliance. Veeam Backup & Replication deploys the proxy appliance in Amazon EC2 only for the duration of the restore process and removes it immediately after that.

Depending on the type of backups you are restoring from and their location, the proxy appliance may be required or optional. The proxy appliance is required when you restore from:

- Backups of EC2 instances that are stored in external repositories.
- Backups of virtual and physical machines that are stored in object storage repositories.

The proxy appliance is optional when you restore from backups of virtual and physical machines stored in backup repositories, or backups of EC2 instances copied to backup repositories with backup copy jobs. It is recommended, however, to use the proxy appliance in scenarios where it is optional, as the proxy appliance may significantly improve restore performance. You can specify the proxy appliance settings at the Proxy Appliance step of the Restore to Amazon EC2 wizard.

The workflow of the restore process depends on whether the proxy appliance is used or not.

**NOTE:**

If you installed Plug-in for Veeam Backup for AWS, and the Veeam Backup for AWS appliance is present in the Veeam Backup & Replication infrastructure, you do not need the proxy appliance. Also, restore to Amazon EC2 works as described in the Entire EC2 Instance Restore section in the Veeam Backup for AWS User Guide.

Restoring to Amazon EC2 with Proxy Appliance

If the proxy appliance is required or you selected to use it for restore to Amazon EC2, Veeam Backup & Replication performs the following operations:

1. Veeam Backup & Replication creates a proxy appliance in Amazon EC2.
   During the restore process, the proxy appliance communicates with backup infrastructure components over the SSH protocol and the network redirector that is deployed on the proxy appliance.
2. For every disk of a backed-up machine, Veeam Backup & Replication creates an empty EBS volume in Amazon EC2.
3. Veeam Backup & Replication hot-adds empty disks to the proxy appliance and restores backed-up data to the EBS volumes.
4. Veeam Backup & Replication creates a target instance in Amazon EC2.
5. Veeam Backup & Replication detaches the EBS volumes from the proxy appliance and attaches them to the target instance.
6. After the restore process is complete, Veeam Backup & Replication removes the proxy appliance from Amazon EC2.
Restoring to Amazon EC2 without Proxy Appliance

If you selected not to use the proxy appliance for restore to Amazon EC2, Veeam Backup & Replication performs the following operations:

1. Veeam Backup & Replication uploads disks of a backed-up machine to Amazon S3.
   - In Amazon S3, the uploaded disks are stored to the temporary bucket in the RAW format.
2. Veeam Backup & Replication imports the backed-up data from the temporary bucket in Amazon S3 to EBS volumes in Amazon EC2.
3. Veeam Backup & Replication creates a target instance in Amazon EC2 and attaches the EBS volumes to it.
4. After the import process is complete, Veeam Backup & Replication removes the temporary bucket from Amazon S3.
AWS IAM User Permissions

To restore to Amazon EC2, it is recommended that the IAM user whose credentials you plan to use to connect to AWS has administrative permissions — access to all AWS actions and resources.

If you do not want to provide full access to AWS, you can grant to the IAM user a minimal set of permissions that will be sufficient for restore. To do that, create the following policy in the JSON format and attach it to the IAM user:

```json
{
    "Version": "2012-10-17",
    "Statement": [
        {
            "Action": [
                "ec2:DescribeInstances",
                "ec2:RunInstances",
                "ec2:TerminateInstances",
                "ec2:StartInstances",
                "ec2:StopInstances",
                "ec2:ModifyInstanceAttribute",
                "ec2:DescribeImages",
                "ec2:ImportImage",
                "ec2:DeregisterImage",
                "ec2:DescribeVolumes",
                "ec2:CreateVolume",
                "ec2:ModifyVolume",
                "ec2:ImportVolume",
                "ec2:DeleteVolume",
                "ec2:AttachVolume",
                "ec2:DetachVolume",
                "ec2:CreateSnapshot",
                "ec2:DescribeSnapshots",
                "ec2:DeleteSnapshot",
                "ec2:DescribeSubnets",
                "ec2:DescribeNetworkInterfaces",
                "ec2:DescribeSecurityGroups",
                "ec2:DescribeKeyPairs",
                "ec2:CreateKeyPair",
                "ec2:DeleteKeyPair",
                "ec2:DescribeAvailabilityZones",
                "ec2:DescribeVpcs",
                "ec2:DescribeConversionTasks",
                "ec2:DescribeImportImageTasks",
                "ec2:DescribeVolumesModifications",
                "ec2:CancelImportTask",
                "ec2:CancelConversionTask",
                "ec2:CreateTags",
                "ec2:DescribeAccountAttributes",
                "ec2:DescribeDhcpOptions",
                "ec2:DescribeVpcAttribute",
                "iam:GetRole",
                "iam:CreateRole",
                "iam:PutRolePolicy",
                "iam:DeleteRolePolicy",
                "s3:CreateBucket",
                "s3:ListBucket",
                "s3:ListAllMyBuckets",
                "s3:DeleteBucket",
                "s3:PutObject"
            ],
            "Effect": "Allow",
            "Resource": "*"
        }
    ]
}
```
Alternatively, you can attach the created policy to the IAM group or role to which the IAM user is assigned.

For information on how to create and attach a policy to an IAM user, see the Creating IAM Policies and Adding and Removing IAM Identity Permissions sections in the AWS IAM User Guide.
Restoring Machines

You can restore physical or virtual machines from backups to Amazon EC2. The restored machine appears in the Amazon EC2 console, and you can use it as a regular EC2 instance.

NOTE:

If you installed Plug-in for Veeam Backup for AWS, and the Veeam Backup for AWS appliance is present in the Veeam Backup & Replication infrastructure, the steps of the restore wizard differ from the steps described in this guide. For more information, see the Restoring to Amazon section in the Plug-in for Veeam Backup for AWS User Guide.

Before you restore a machine to Amazon EC2, check prerequisites. Then use the Restore to Amazon EC2 wizard to restore the machine.
Before You Begin

Before you restore a machine to Amazon EC2, mind the following requirements and limitations:

- The Veeam backup server and repositories with machine backup files must have access to the Internet.
  If backup files are located on deduplicating storage appliances or shared folder repositories, the Internet connection is required for gateway servers that communicate with these repositories.

- You must have a backup of the machine that you plan to restore to Amazon EC2.

- Make sure that a user whose credentials you plan to use to connect to AWS has permissions to restore to Amazon EC2. For more information, see AWS IAM User Permissions.

- If you restore machines from backups of virtual and physical machines (non-EC2 instances), check the supported OS, EC2 instance and file system types in the AWS Documentation.

- If you plan to assign AWS tags to the restored machine, check limitations for tags in the AWS Documentation.
Step 1. Launch Restore to Amazon EC2 Wizard

To begin the restore process, do one of the following.

- On the **Home** tab, click **Restore** and select the type of backups from which you want to restore:
  - VMware vSphere or vCloud Director
  - Microsoft Hyper-V
  - Agent
  - AWS EC2 backup
  - Nutanix AHV

In the displayed window, click **Entire machine restore > Restore to Amazon EC2**.

- Open the **Home** view. In the inventory pane, click **Backups**. In the working area, expand the necessary backup and do one of the following:
  - Select the machine that you want to restore and click **Restore to Amazon EC2** on the ribbon.
  - Right-click the machine that you want to restore and select **Restore to Amazon EC2**.

In this case, you will pass to the **Account** step of the wizard.

- Double-click a full backup file (VBK) or backup metadata file (VBM) in a file browser.

Veeam Backup & Replication will start its console. In the **Backup Properties** window, select the necessary machine and click **Restore > Restore to Amazon EC2**. In this case, you will pass to the **Account** step of the wizard.
Step 2. Select Machine and Restore Point

At the Machine step of the wizard, specify the machine that you plan to restore and specify a restore point to which you want to restore the machine.

To select a machine to restore:

1. On the right of the Machine list, click Add.
2. In the Backup Browser window, expand the required backup, select the machine and click Add. You can add several machines to the list to perform batch restore.

By default, Veeam Backup & Replication restores a machine to the latest valid restore point in the backup chain. However, you can restore the machine to an earlier restore point.

To select a restore point, do the following:

1. In the Machine list, select the machine.
2. Click Point on the right.
3. In the **Restore Points** window, select a restore point to which you want to restore the machine.
Step 3. Specify Credentials and Region Settings

At the Account step of the wizard, you can specify AWS user credentials and region settings.

To specify AWS user credentials and region settings:

1. From the AWS account list, select user credentials to connect to AWS. If you have not set up credentials beforehand in the Cloud Credentials Manager, click the Manage accounts link or click Add on the right to add the necessary credentials.

   When you add AWS user credentials, Veeam Backup & Replication imports information about resources associated with this user. During the restore process, Veeam Backup & Replication accesses these resources and uses them to create a target instance in Amazon EC2.

2. From the AWS region list, select the AWS region type: Global, GovCloud (US), or China.

3. From the Data center region list, select the geographic region where Veeam Backup & Replication will create an Amazon EC2 instance for your restored machine.
If you restore an EC2 instance from backups created with Veeam Backup for AWS to the same AWS region where the instance is placed, after you click **Next**, the wizard will offer you to use region settings associated with this instance.
Step 4. Specify Instance Name

At the **Name** step of the wizard, you can:

- Specify the name for the target instance
- Manage AWS tags for the target instance

### Specifying Instance Name

Veeam Backup & Replication restores the machine to Amazon EC2 as an instance. An instance is a virtual machine in Amazon EC2 with a preconfigured combination of computing resources. By default, Veeam Backup & Replication uses the original machine name for the target instance. However, you can define a new name for the instance if necessary.

To define a new name for the instance:

1. In the **Machines to restore** list, select the machine and click **VM name**.
2. In the **Change Name** window, enter a new name explicitly or specify a change name rule — add a prefix and/or suffix to the original machine name.

### Managing AWS Tags for Machine

You can use AWS tags to categorize instances in Amazon EC2. A tag is a label with metadata that includes two properties: a key and a value. For more information on AWS tags, see the AWS Documentation.

By default, Veeam Backup & Replication adds the **Original name** and **Restore start time** tags for the target instance. However, you can modify or delete these tags, or add new ones.
To add a new tag:

1. In the **Machines to restore** list, select the machine and click **Tags**.
2. In the **Tags** window, click **Add**.
3. In the **EC2 VM Tag** window, specify the **Key** and **Value** properties.
   - Note that you cannot add the tag with the **Name** key. Veeam Backup & Replication uses the **Name** tag to set the name for the target instance in Amazon EC2.

To modify a tag:

1. In the **Machines to restore** list, select the machine and click **Tags**.
2. In the **Tags** window, select the needed tag and click **Edit**.
3. In the **EC2 VM Tag** window, edit the **Key** or **Value** properties.

To delete a tag:

1. In the **Machines to restore** list, select the machine and click **Tags**.
2. In the **Tags** window, select the needed tag and click **Remove**.

**NOTE:**
If you restore a machine from backups of an Amazon EC2 instance, Veeam Backup & Replication displays tags that were assigned to this instance. You can modify or delete these tags as well.
Step 5. Specify Instance Type

At the **Instance Type** step of the wizard, you can:

- Select the instance type for the restored machine
- Select disks for the restored machine

Selecting Instance Type

You can select the amount of computing resources that AWS will provision for your restored machine — an Amazon EC2 instance type. Each instance type offers a unique combination of CPU, memory, storage, and networking resources.

To select an instance type for the machine:

1. In the **Virtual machines** list, select the machine and click **Edit**.
2. From the **EC2 instance type** list, select the instance type for the restored machine.
   
   Make sure that you select the right instance type that corresponds to the initial machine configuration. For information on instance types, see [Amazon EC2 Instance Types](#).
   
   Note that if you restore an EC2 instance from backups created with Veeam Backup for AWS, Veeam Backup & Replication will identify the type of a backed-up instance and select it by default.
3. [For Microsoft Windows machines] From the **OS license** list, select the license policy that AWS will apply for Microsoft software on the target instance:
   
   - **Provided by Amazon AWS**. Select this option if you want to obtain licenses for Microsoft software from AWS.
   - **Bring Your Own License (BYOL)**. Select this option if you want to use your existing licenses for Microsoft software.

   For more information on Microsoft software licensing in AWS, see [Microsoft Licensing on AWS](#).
4. Click OK.

Selecting Machine Disks

If necessary, you can restore only specific machine disks.

To select machine disks for restore:

1. In the **Virtual machines** list, select the machine and click **Disks**.
2. In the **Disks To Restore** window, select check boxes next to disks that you want to restore.

In Amazon EC2, Veeam Backup & Replication saves disks of the restored machine as Amazon Elastic Block Store (EBS) volumes. By default, Veeam Backup & Replication creates EBS volumes of the General Purpose SSD type. For information on types of EBS volumes, see the AWS Documentation.

If necessary, you can change the EBS volume type. To do that, perform the following steps:

1. In the **Virtual machines** list, select the machine and click **Disks**.
2. In the **Disks To Restore** window, select the machine disk and click **Disk type**.
3. In the **Select EC2 Disk Type** window, choose the volume type.

   If you selected the **Provisioned IOPS SSD (IO1)** type, you can also specify the maximum number of input/output operations per second (IOPS) for the volume. For more information on IOPS, see the AWS Documentation.
TIP:
For your convenience, Veeam Backup & Replication uses the AWS Simple Monthly Calculator tools to estimate an approximate price per month for using a selected instance. The estimated price is calculated based on the instance type, license policy and disk configuration.
Step 6. Select Amazon VPC

At the **Network** step of the wizard, you can select to which Amazon Virtual Private Cloud (Amazon VPC) the target Amazon EC2 instance must be connected. You can also specify a subnet, and a security group — a virtual firewall for the target instance. For more information on Amazon VPC, see the [AWS Documentation](https://docs.aws.amazon.com/).

To define network settings for the target instance, do the following:

1. From the **Amazon VPC** list, select the Amazon VPC where the target instance will be launched.
2. From the **Subnet** list, select the subnet for the target instance.
3. From the **Security group list**, select a security group that will be associated with your target instance.
4. From the **Public IP address** list, select one of the following:
   - **Assign (restored VM will be accessible from the Internet)** — if you want to assign a public IP to the target instance. For security reasons, make sure traffic filtration rules are properly configured in the security group.
   - **Do not assign (more secure)** — if you do not want to assign a public IP.
5. Click **OK**.
Step 7. Specify Secure Restore Settings

This step is available if you restore Microsoft Windows workloads.

You can instruct Veeam Backup & Replication to perform secure restore — scan machine data with antivirus software before restoring the machine to Amazon EC2. For more information on secure restore, see Secure Restore.

To specify secure restore settings:

1. At the Secure Restore step of the wizard, select the Scan the restored VM for malware prior to performing the recovery check box.

2. Select which action Veeam Backup & Replication will take if the antivirus software finds a virus threat:
   - **Abort VM recovery.** Select this action if you want to cancel the restore session.
   - **Proceed with recovery but connect the VM to a different network.** Select this action if you want to restore the machine to a different AWS security group.
     
     Click the **Click to change** link to select the security group.

3. Select the **Scan the entire image** check box if you want the antivirus software to continue machine scan after the first malware is found. For information on how to view results of the malware scan, see Viewing Malware Scan Results.
Step 8. Specify Proxy Appliance

At the Proxy Appliance step of the wizard, you can specify the proxy appliance settings. A proxy appliance is an auxiliary Linux-based instance. During the restore process, Veeam Backup & Replication may require the proxy appliance to upload disks of a backed-up machine to Amazon EC2.

The proxy appliance is non-persistent. Veeam Backup & Replication automatically deploys the appliance in Amazon EC2 only for the duration of the restore process and removes it immediately after that.

**NOTE:**
The proxy appliance is required if you restore machines from backups stored in external repositories or object storage repositories, and is recommended to use if you restore machines from backup repositories.

**IMPORTANT!**
If you want to restore from backups in an on-premises object storage repository, the proxy appliance machine must have access to the source object storage repository. To provide access to object storage repositories, you can use VPN or AWS Direct Connect.

To specify proxy appliance settings, do the following:

1. Select the Use the proxy appliance check box.
2. Click Customize.
3. From the EC2 instance type list, select the instance type for the proxy appliance.

**IMPORTANT!**
To upload one machine disk to Amazon EC2, the proxy appliance requires 1 GB RAM. Make sure that the type of EC2 instance selected for the proxy appliance offers enough memory resources to upload all machine disks. Otherwise, the restore process may fail.

4. From the Subnet list, select the subnet for the proxy appliance.
5. From the Security group list, select a security group that will be associated with the proxy appliance.
6. In the Redirector port field, specify the port that Veeam Backup & Replication will use to route requests between the proxy appliance and backup infrastructure components.
7. Click **OK**.
Step 9. Specify Restore Reason

At the **Reason** step of the wizard, enter a reason for restoring the machine. The information you provide will be saved in the session history in Veeam Backup & Replication, and you can view it later.

**TIP:**

If you do not want to display the **Reason** step of the wizard in future, select the **Do not show me this page again** check box.
Step 10. Start Restore Process

At the **Ready to Restore** step of the wizard, check the specified settings and click **Finish**. Veeam Backup & Replication will start the restore process.

You can track the restore process in the **Restore Session** window. If you need to cancel the machine restore, click the **Cancel** restore task link.
Secure Restore

Veeam Backup & Replication allows you to perform secure restore — scan machine data with antivirus software before restoring the machine to the production environment.

During secure restore, Veeam Backup & Replication mounts disks of the machine that you plan to restore to the mount server. On the mount server, Veeam Backup & Replication triggers an antivirus to scan files from the mounted disks. If during the scan the antivirus detects malware, Veeam Backup & Replication will either abort the restore process, or restore the machine with restrictions depending on secure restore settings.

Secure restore is available for the following restore operations:

- Instant VM Recovery
- Entire VM Restore
- Restore to Microsoft Azure
- Restore to Amazon EC2
- Amazon EC2 Instance Disks Export
- SureBackup

To perform secure restore, you must enable the **Scan the restored machine for malware prior to performing the recovery** option at the **Secure Restore** step of the restore wizard.

**TIP:**

You can also scan machine data for malware regularly within a SureBackup job. For information on how to enable the malware scan for a SureBackup job, see the **Settings step** of the SureBackup job wizard.
Requirements and Limitations for Secure Restore

Before you perform secure restore, check the following prerequisites:

- You can perform secure restore only for machines that run Microsoft Windows.
- The antivirus software must be installed on the mount server and support the command line interface (CLI).
- The antivirus configuration file must be located on the mount server and must be properly configured. For details, see Antivirus XML Configuration File.
- Veeam Backup & Replication does not perform malware scan for disks or volumes that cannot be mounted to the mount server.
  
  For example, Storage Spaces disks or ReFS volumes (if ReFS is not supported by the mount server OS) are skipped from the scan and restored in a regular way.
How Secure Restore Works

Veeam Backup & Replication uses the mount server as a staging server for scanning machine data with antivirus software. By default, the mount server role is assigned to one of the following machines: the Veeam backup server or a repository that stores machine backups. However, you can assign the mount server role to any 64-bit Microsoft Windows machine in your backup infrastructure. For example, you may want to run the malware scan process on a different server for security reasons. For details on mount server deployment and requirements, see Mount Server.

To run the malware scan, Veeam Backup & Replication performs the following actions:

1. On the mount server, Veeam Backup & Replication runs Veeam Mount Service to check the antivirus configuration file and antivirus software:
   a. Veeam Mount Service verifies if the AntivirusInfos.xml configuration file is located in the %ProgramFiles%\Common Files\Veeam\Backup and Replication\Mount Service folder.
   b. Veeam Mount Service checks the scan settings in the configuration file and verifies if the antivirus is installed on the mount server.
   
   Note that if the antivirus is not installed or the configuration file is improperly configured, Veeam Backup & Replication will not start the restore process. In the restore wizard, you will not be able to pass the step with secure restore settings.

2. Veeam Backup & Replication mounts machine disks from backups to the mount server under the C:\VeeamFLR\<machinename> folder.

3. Veeam Backup & Replication triggers the antivirus to scan files in the C:\VeeamFLR\<machinename> folder.

If during the scan the antivirus does not detect malware, Veeam Backup & Replication restores the machine to the target location.

If the antivirus detects malware, Veeam Backup & Replication will either abort the restore process, or restore the machine with restrictions depending on the following secure restore settings:

- Disable the network adapter (NIC) on the restored machine.
- Connect the restored machine to a different Microsoft Azure virtual network.
- Change the AWS security group for the restored machine.

You can further access the restored machine or its disks in the isolated environment and clean the infection.
Antivirus XML Configuration File

The antivirus software that you plan to use for scanning backups is described in the AntivirusInfos.xml file. Veeam Backup & Replication creates this configuration file on every machine with the mount server role and stores the file in the %ProgramFiles%\Common Files\Veeam\Backup and Replication\Mount Service folder.

During secure restore, Veeam Backup & Replication reads settings from the configuration file and triggers the antivirus to scan backup files. The settings in the file are already predefined for the following antivirus software:

- Symantec Protection Engine
- ESET
- Windows Defender
- Kaspersky Security 10

If you want to scan machine data with other antivirus software, you must add configuration for this software to the AntivirusInfos.xml file. The configuration must contain the same elements and attributes as the antivirus supported out-of-the-box. Mind that the antivirus software must support the command line interface (CLI).

**NOTE:**

If you made changes to the antivirus configuration file, you do not need to restart Veeam services on the backup server — Veeam Backup & Replication will perform the next malware scan with new settings.
XML File Structure

The XML file describing antivirus settings has the following structure:
<Antiviruses>
  <!-- Symantec -->
  <AntivirusInfo Name='Symantec' IsPortableSoftware='false' ExecutableFilePath='Veeam.Backup.Antivirus.Scan.exe' CommandLineParameters='/p:%Path%\ RegPath='HK\LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\symcs\can\ ThreatExistsRegEx='\ Threat\s+found\ IsParallelScanAvailable='false'>
  <ExitCodes>
    <ExitCode Type='Success' Description='No threats detected'>0</ExitCode>
    <ExitCode Type='Error' Description='Invalid command line argument'>1</ExitCode>
  </ExitCodes>
  </AntivirusInfo>
  <!-- Eset -->
  <AntivirusInfo Name='Eset File Security' IsPortableSoftware='true' ExecutableFilePath='%ProgramFiles%\ESET\ESET File Security\ecls.exe' CommandLineParameters='%Path% /clean-mode=None /no-symlink' RegPath='' ServiceName='ThreatExistsRegEx='\ threat\s=\s*["\apos;]?\is OK["\apos;]^["\apos;]+["\apos;]' IsParallelScanAvailable='false'>
  <ExitCodes>
    <ExitCode Type='Success' Description='No threats detected'>0</ExitCode>
    <ExitCode Type='Infected' Description='Virus threat was detected'>1</ExitCode>
  </ExitCodes>
  </AntivirusInfo>
  <AntivirusInfo Name='ESET Antivirus' IsPortableSoftware='true' ExecutableFilePath='%ProgramFiles%\ESET\ESET Security\ecls.exe' CommandLineParameters='%Path% /clean-mode=None /no-symlink' RegPath='' ServiceName='ThreatExistsRegEx='\ threat\s=\s*["\apos;]?\is OK["\apos;]^["\apos;]+["\apos;]' IsParallelScanAvailable='false'>
  <ExitCodes>
    <ExitCode Type='Success' Description='No threats detected'>0</ExitCode>
    <ExitCode Type='Infected' Description='Virus threat was detected'>1</ExitCode>
  </ExitCodes>
  </AntivirusInfo>
  <!-- Windows Defender -->
  <AntivirusInfo Name='Windows Defender' IsPortableSoftware='false' ExecutableFilePath='%ProgramFiles%\Windows Defender\mpcmdrun.exe' CommandLineParameters='-Scan -ScanType 3 -File %Path%\ -DisableRemediation -BootSectorScan' RegPath='HK\LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WinDefend\ ServiceName='WinDefend' ThreatExistsRegEx='\ Threat\s+information\ IsParallelScanAvailable='false'>
  <ExitCodes>
    <ExitCode Type='Success' Description='No threats detected'>0</ExitCode>
    <ExitCode Type='Error' Description='Invalid command line argument'>1</ExitCode>
  </ExitCodes>
  </AntivirusInfo>
</Antiviruses>
The XML file contains the following elements:

- **Antiviruses.** The element encapsulates the file with antivirus settings.
- **AntivirusInfo.** The element describes the antivirus software.
- **ExitCodes.** The element encapsulates messages that Veeam Backup & Replication displays on scan results.
- **ExitCode.** The element describes the subject and the body of the message that Veeam Backup & Replication displays on scan results.

**AntivirusInfo**

The element has the following attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the antivirus name. Veeam Backup &amp; Replication will display this name in restore session logs.</td>
</tr>
<tr>
<td>IsPortableSoftware</td>
<td>Indicates if antivirus software is portable:</td>
</tr>
<tr>
<td></td>
<td>• If you set this attribute to True, Veeam Backup &amp; Replication will treat the antivirus software as portable. Before performing secure restore, Veeam Backup &amp; Replication will verify if the antivirus executable file exists. The path to the file is specified by the ExecutableFilePath attribute.</td>
</tr>
<tr>
<td></td>
<td>• If you set this attribute to False, Veeam Backup &amp; Replication will treat the antivirus software as non-portable. Before performing secure restore, Veeam Backup &amp; Replication will verify if the antivirus registry key exists and if the antivirus service is running. The key is specified by the RegPath attribute. The service name is specified by the ServiceName attribute.</td>
</tr>
<tr>
<td>ExecutableFilePath</td>
<td>Specifies the path to the antivirus executable file.</td>
</tr>
<tr>
<td>CommandLineParameters</td>
<td>Specifies antivirus commands that you want to execute during the scan. Make sure that the antivirus supports the specified commands. For example, the list of commands for ESET is available in this ESET KB article.</td>
</tr>
<tr>
<td>Note:</td>
<td>The %Path% variable is required for this attribute. During secure restore, Veeam Backup &amp; Replication substitutes this variable for the path to the folder with mounted disks (C:\VeeamFLR&lt;machinename&gt;).</td>
</tr>
<tr>
<td>ServiceName</td>
<td>Specifies the name of the antivirus service. The service must be responsible for data scanning. The attribute value can be an empty string if IsPortableSoftware = True and ExecutableFilePath is specified.</td>
</tr>
<tr>
<td>RegPath</td>
<td>Specifies the registry key of the antivirus service. The attribute value can be an empty string if IsPortableSoftware = True and ExecutableFilePath is specified.</td>
</tr>
</tbody>
</table>
## ThreatExistsRegEx

Specifies regular expressions. A regular expression is a sequence of characters that form a search pattern. Veeam Backup & Replication will search the antivirus output messages for the specified regular expression. If any of the output messages match the expression, Veeam Backup & Replication will notify you on detected threat.

**Note:** You must have a good understanding of the regular expression language to specify this attribute properly. For more information on the regular expression language, see [Microsoft Docs](#).

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ThreatExistsRegEx</td>
<td>Specifies regular expressions. A regular expression is a sequence of characters that form a search pattern. Veeam Backup &amp; Replication will search the antivirus output messages for the specified regular expression. If any of the output messages match the expression, Veeam Backup &amp; Replication will notify you on detected threat.</td>
</tr>
</tbody>
</table>

## IsParallelScanAvailable

Indicates if the antivirus will run multiple jobs to scan files on mounted disks simultaneously.

If you set this attribute to `True`, Veeam Backup & Replication will lock the antivirus to perform the scan for the current restore session. The antivirus will not be available for other sessions with enabled secure restore until the scan completes.

The default value for antivirus lock time-out is 24 hours. If the scan does not complete after this period, Veeam Backup & Replication will finish other restore sessions as specified in the restore wizard: abort restore sessions or restore machines with restrictions.

**Note:** You can change the lock time-out using registry keys. For more information, contact Veeam Support.

If the antivirus CLI does not support multiple scan jobs, set this attribute to `False`.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IsParallelScanAvailable</td>
<td>Indicates if the antivirus will run multiple jobs to scan files on mounted disks simultaneously.</td>
</tr>
</tbody>
</table>

## ExitCode

The element has the following attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Specifies the subject of the message that Veeam Backup &amp; Replication will display on scan results:</td>
</tr>
<tr>
<td></td>
<td>• Success</td>
</tr>
<tr>
<td></td>
<td>• Infected</td>
</tr>
<tr>
<td></td>
<td>• Warning</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td>Description</td>
<td>Specifies the body of the message that Veeam Backup &amp; Replication will display on scan results.</td>
</tr>
</tbody>
</table>
TIP:
You can distribute the XML configuration file among other mount servers in your backup infrastructure using Veeam PowerShell. For more information, see the Copy-VBRAntivirusConfigurationFile section in the Veeam PowerShell Reference.
Viewing Malware Scan Results

Results of the malware scan are available in restore session statistics.

To view restore session statistics, do one of the following:

- Open the Home view, in the inventory pane select Last 24 hours. In the working area, double-click the necessary restore session. Alternatively, you can select the session and click Statistics on the ribbon or right-click the session and select Statistics.

- Open the History view, in the inventory pane select Restore. In the working area, double-click the necessary restore session. Alternatively, you can select the session and click Statistics on the ribbon or right-click the session and select Statistics.

To view the detailed logging of the malware scan, click the Scan Log button at the bottom of the window with restore session statistics. Veeam Backup & Replication will display the most recent logs in a file of 1 MB in size.

Full logs of the scan are stored on the mount server in the following folder:
C:\ProgramData\Veeam\Backup\FLRSessions\Windows\FLR__<machinename>\Antivirus.
Staged Restore

Veeam Backup & Replication allows you to perform staged restore — run an executable script for VMs before recovering them to the production environment.

Staged restore can help you ensure that recovered VMs do not contain any personal or sensitive data. For example, you can instruct Veeam Backup & Replication to run a Windows PowerShell script that removes Active Directory users:

```powershell
$UserName = "John.Smith"
$ADUser = Get-ADUser -Filter 'Name -like $UserName'
if (!$ADUser)
{
    [Environment]::Exit(1)
}
Remove-ADUser -Identity $UserName -Confirm:$false
```

Stage restore is available only for entire VM restore operations. To perform staged restore, you must select the Staged Restore mode in the Full VM Restore wizard and specify staged restore settings.

Requirements and Limitations for Staged Restore

Before you perform staged restore, check the following prerequisites:

- The staged restore functionality is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication.
- You must have a preconfigured virtual lab in your backup infrastructure. For more information, see Virtual Lab.
• Scripts that you plan to run must reside in a local folder on a backup server.

• If you plan to perform staged restore for several VMs within one restore session, make sure these VMs run OS of the same type: either Microsoft Windows or Linux. In the current version of Veeam Backup & Replication, you cannot specify credentials and scripts for each VM individually.

How Staged Restore Works

For staged restore, Veeam Backup & Replication uses a preconfigured virtual lab, an executable script located on the backup server, and credentials to connect to VMs and run the script. Veeam Backup & Replication performs staged restore in the following way:

1. In the virtual lab, Veeam Backup & Replication starts VMs directly from compressed and deduplicated backup files that reside in the backup repository. To achieve this, Veeam Backup & Replication uses Instant VM Recovery.

   If you use an application group to run a script, Veeam Backup & Replication first starts VMs from the application group in the required order.

2. Veeam Backup & Replication copies the script from the backup server to VMs that you plan to restore.

   To connect to VMs, Veeam Backup & Replication uses credentials specified in staged restore settings.

3. Veeam Backup & Replication runs the copied script on every VM.

   To run the script, Veeam Backup & Replication uses the same technology as for pre-freeze and post-thaw scripts. For more information, see Pre-Freeze and Post-Thaw Scripts.

4. Veeam Backup & Replication writes all VM changes that take place during script execution to the differencing disk (AVHD/AVHDX file).

   Veeam Backup & Replication stores differencing disks on the Hyper-V host where the virtual lab is created.

5. After the script execution is complete, Veeam Backup & Replication makes a safe shutdown of VMs in the virtual lab.

6. Veeam Backup & Replication restores VMs in a changed state to the production environment.
WAN Acceleration

WAN acceleration is a Veeam technology that optimizes data transfer to remote locations. It is specific for offsite backup copy jobs and replication jobs.

Offsite backup copy and replication always involve moving large volumes of data between remote sites. The most common problems that backup administrators encounter during offsite backup and replication are insufficient network bandwidth to support VM data traffic and transmission of redundant data. To solve these problems, Veeam Backup & Replication offers the WAN acceleration technology that combines:

- Network traffic compression
- Multistreaming upload
- Global data deduplication
- Variable block size deduplication.

These technologies help optimize the data transfer and reduce the amount of data going over WAN.

**NOTE:**

WAN acceleration is available in the Enterprise and Enterprise Plus editions of Veeam Backup & Replication. For details, see Veeam Editions Comparison.

High Bandwidth Mode

Starting with Veeam Backup & Replication 10, Veeam WAN acceleration introduces the **High bandwidth mode**. We recommend to use it for WAN connections faster than 100 Mbps. If compared with the **Low bandwidth mode**, it does not leverage the global cache, but utilizes a faster compression method, optimized digests processing and an alternative deduplication mechanism. As a result, the new mode provides better performance and higher speed of data transfer.

Mind that to use the **High bandwidth mode**, you must enable this option for WAN accelerators at both sites of the data transfer: the source and the target. If the target WAN accelerator has the **High bandwidth mode** enabled, different source accelerators can parallelly interact with it in different modes, depending on the mode selected for each source WAN accelerator.
Global Data Deduplication

The goal of WAN acceleration is to send less data over the network. To reduce the amount of data going over WAN, Veeam Backup & Replication uses the global data deduplication mechanism.

1. When you first run a job to the remote location, Veeam Backup & Replication analyzes data blocks going over WAN.

2. With every new cycle of a job to the remote location, Veeam Backup & Replication uses the data redundancy algorithm to find duplicate data blocks in copied files. Veeam Backup & Replication analyzes data blocks in files on the source side and compares them with those that have been previously transferred over WAN. If an identical data block is found, Veeam Backup & Replication deduplicates it.

As a result, only unique data blocks go over WAN. Data blocks that have already been sent are not sent. This way, Veeam Backup & Replication eliminates transfer of redundant data over WAN.

Veeam Backup & Replication uses three sources for data deduplication:

- VM disks. Veeam Backup & Replication analyses data blocks within the same VM disk. If identical blocks are found, duplicates are eliminated. For example, in case of a virtualized Microsoft Exchange server, the same email is typically stored in sender’s Outbox folder and recipient’s Inbox folder, which results in duplicate data blocks. When a job to the remote location runs, Veeam Backup & Replication detects such VM data blocks and performs deduplication.

- Previous restore points for the processed VM on the target repository. Veeam Backup & Replication analyses data in the restore point that is about to be copied and the restore points that are already stored on the target side. If an identical block is found on the target side, Veeam Backup & Replication eliminates the redundant data block in the copied restore point.

- Global cache. Veeam Backup & Replication creates a global cache holding data blocks that repeatedly go over WAN. In a new job session, Veeam Backup & Replication analyzes data blocks to be sent and compares them with data blocks stored in the global cache. If an identical data block is already available in the global cache, its duplicate on the source side is eliminated and not sent over WAN.

NOTE:

Mind the following:

- Veeam Backup & Replication deduplicates data blocks within one VM disk and in restore points for one VM only. Deduplication between VM disks and restore points of different VMs is performed indirectly, via the global cache. For more information, see WAN Global Cache.

- Global data deduplication and deduplication within the same VM disk are not used if both WAN accelerators in the pair (the source one and the target one) operate in the High bandwidth mode.
WAN Accelerators

For WAN acceleration, Veeam Backup & Replication uses dedicated components — WAN accelerators. WAN accelerators are responsible for global data caching and data deduplication. Technically, WAN accelerators add a new layer in the backup infrastructure — between the Veeam Data Movers on the source side and the Veeam Data Mover on the target side.

WAN Accelerators Deployment

To enable WAN acceleration and data deduplication technologies, you must deploy a pair of WAN accelerators in your backup infrastructure.

- One WAN accelerator is deployed on the source site, closer to the source backup repository or source host.
- The other WAN accelerator is deployed on the target site, closer to the target backup repository or target host.

On each WAN accelerator Veeam Backup & Replication creates the VeeamWAN folder containing the following data:

- The VeeamWAN folder on the source WAN accelerator stores files with digests required for deduplication. For more information, see How WAN Acceleration Works.
- The VeeamWAN folder on the target WAN accelerator stores global cache data.

NOTE:
Global cache is not used if both WAN accelerators in the pair (the source one and the target one) operate in the High bandwidth mode.

To learn how to add a WAN accelerator to the Veeam Backup & Replication infrastructure, see Adding WAN Accelerators.
Recommendations for WAN Accelerators

You should not assign one source WAN accelerator to several jobs to remote locations that you plan to run simultaneously. The source WAN accelerator requires a lot of CPU and RAM resources, and does not process multiple tasks in parallel. As an alternative, you can create one job to the remote location for all VMs you plan to process over one source WAN accelerator.

The target WAN accelerator, however, can be assigned to several jobs to remote locations.
How WAN Acceleration Works

When you create a job to the remote location, you can select to use WAN acceleration in its properties.

The procedure of data copying with WAN acceleration enabled is performed in the following way:

1. [For backup copy job] Veeam Backup & Replication decompresses the backup file to analyze its content.

2. The Veeam WAN Accelerator Service on the source WAN accelerator analyzes data blocks of the file to be transferred and creates a file with digests for these data blocks. The created file with digests is stored to the VeeamWAN folder on the source WAN accelerator.

3. Veeam Backup & Replication compresses the backup file data (for backup copy) or VM data (for replication) and copies it to the target side.

   At this point, Veeam Backup & Replication can perform deduplication within the VM itself — that is, deduplicate identical data blocks in every VM disk.

4. During the data transfer process, the Veeam WAN Accelerator Service on the target WAN accelerator populates the global cache storage with data blocks from the copied file.

5. During the next job cycle, the Veeam WAN Accelerator Service on the source WAN accelerator analyzes data blocks in the file that must be transferred this time and creates digests for these data blocks.

6. The Veeam WAN Accelerator Service compares the created digests with the digests that have been previously stored to the VeeamWAN folder on the source WAN accelerator. If duplicate data blocks are found, the actual data block in the backup file is not copied over WAN. Instead, it is taken from the global cache and written to the restore point in the backup copy folder or on the target data volume.

7. Additionally, Veeam Backup & Replication analyzes restore points that have been previously copied to the target side. If duplicates are found, Veeam Backup & Replication does not copy such blocks over WAN but takes them from the previously copied restore points.

As a result, Veeam Backup & Replication copies only new data blocks to the target side and uses data blocks that are already stored in the global cache or in restore points in the target backup repository.

If the target WAN accelerator is used by several jobs, the target backup repository may already contain data blocks of the necessary VM type. In this situation, Veeam Backup & Replication will copy the required data blocks to the global cache before the copying process starts and use these data blocks further on. For more information, see Many to One WAN Acceleration.
If WAN acceleration is performed in the **High bandwidth mode**, the procedure of data transfer with WAN acceleration has the following peculiarities:

- Global cache is not used. Thus, the target WAN accelerator does not need extra disk space to store the global cache folder.

- Deduplication is performed only by using previous restore points for the processed VM on the target repository. Therefore, Veeam Backup & Replication performs less deduplication operations and saves resources and time for data processing.

- The data chunk size used by the Changed Block Tracking mechanism during deduplication is smaller if compared with the **Low bandwidth mode**. This reduces the size of redundant data to transfer.
WAN Global Cache

From the technical point of view, the global cache is a folder on the target WAN accelerator. By default, global cache data is stored in the VeeamWAN folder on the disk with the most amount of space available. However, you can define any folder of your choice when you configure the target WAN accelerator.

NOTE:
Global cache is not used if both WAN accelerators in the pair (the source one and the target one) operate in the High bandwidth mode.

By default, the size of the global cache is 100 GB. You can increase the size or decrease it if necessary. The more space you allocate, the more repeating data blocks will be written to the global cache and the more efficient WAN acceleration will be. It is recommended that you allocate at least 40 GB to the global cache storage.

The global cache size is specified per source WAN accelerator. That is, if you plan to use one target WAN accelerator with several source WAN accelerators, the specified amount of space will be allocated for every source WAN accelerator that will be working with the target WAN accelerator and the size of the global cache will increase proportionally. For more information, see WAN Accelerator Sizing.

The WAN global cache is a “library” that holds data blocks repeatedly going from the source side to the target side. The global cache is populated at the first cycle of a job to the remote location. The priority is given to data blocks of Windows-based OSes, other OSes like Linux/Unix, and Microsoft Exchange Server.

Veeam Backup & Replication constantly maintains the global cache in the actual state. To do that, it continuously monitors data blocks going over WAN and data blocks in the global cache.

• If some new data block is constantly sent over WAN, it is added to the global cache.
• If some data block in the global cache is not sent over WAN and are not re-used for some period of time, it is removed from the global cache to make room for new data blocks.

Veeam Backup & Replication also performs periodic consistency checks. If some data block in the global cache gets corrupted, Veeam Backup & Replication removes it from the global cache.

The efficiency of the WAN acceleration increases with every new backup copy interval in the backup copy job. During the first backup copy interval in the backup copy job, the WAN acceleration level is minimal. Veeam Backup & Replication populates the global cache. With every new job cycle, Veeam Backup & Replication updates the global cache to include the most “popular” data blocks and the WAN acceleration efficiency increases.

NOTE:
You can populate the global cache before you run the job to the remote location for the first time. In this case, Veeam Backup & Replication will use the global cache starting from the first session of the job to the remote location, and the WAN traffic will be minimal. For more information, see Population of Global Cache.

Many to One WAN Acceleration

The WAN global cache can be used by several source WAN accelerators simultaneously. For example, if you have several remote/branch offices, you can configure several source WAN accelerators in remote sites and one target WAN accelerator in the head office.
In this case, the global cache will hold cache data for separate source WAN accelerators. The cache data for every source WAN accelerator will be stored in a dedicated subfolder in the global cache folder.

When one target WAN accelerator is used by several source WAN accelerators, Veeam Backup & Replication can copy data blocks between global cache of these WAN accelerators. This mechanism works if there are no matching backups of VMs in the target backup repository, but matching data is available in cache of other WAN accelerators.

For example, you have two backup copy jobs: Job 1 and Job 2. The Job 1 uses the source WAN accelerator Source 1 and the target WAN accelerator Target 3. The Job 2 uses the source WAN accelerator Source 2 and the same target WAN accelerator Target 3. In the global cache folder, Veeam Backup & Replication will store data for 2 WAN accelerators: Source 1 and Source 2.

- **Job 1** processes a VM running Microsoft Windows Server 2008 R2, and it has been running for some time. In the global cache, there is already data for this type of OS.

- **Job 2** also processes a VM running Microsoft Windows Server 2008 R2. When you start Job 2 for the first time, there is no data for this type of OS in the global cache for Source 2 WAN accelerator. In such situation, Veeam Backup & Replication will copy the necessary data block from the Source 1 cache to the Source 2 cache and will not transport this data block over WAN.

**NOTE:**

Beside using global cache of other WAN accelerator, Veeam Backup & Replication also utilizes backup files residing in the backup repository. For example, if the backup repository contains a backup file created with a backup job and the backup copy job starts copying a backup of a VM of the same type, Veeam Backup & Replication will populate global cache on the WAN accelerator from the backup file not to transfer redundant data over WAN.

### Manual Population of Global Cache

You can manually pre-populate the global cache to avoid the situation where the cache remains empty. As a result, by the time a job to the remote location starts, the global cache will contain data blocks that can be used for data deduplication.

Manual population of the global cache can be helpful in the following scenarios:

- First run of a job to the remote location. When you run a first session of a job to the remote location, the global cache is empty, and the whole amount of VM data needs to be transferred over WAN. It is recommended that you manually populate the global cache before you start a job to the remote location for the first time.
Global cache corruption. If the global cache gets corrupted for some reason, Veeam Backup & Replication needs to perform at least one session of the job to the remote location to replace corrupted data blocks with valid data blocks. In this situation, you can clean the global cache and manually populate it with valid data before the job to the remote location begins.

**IMPORTANT!**
Veeam Backup & Replication does not use encrypted backups for manual global cache population.

**Limitations for Manual Population of Global Cache**

The manually performed global cache population task has the following limitations:

- Veeam Backup & Replication does not use encrypted backups for global cache population.
- Veeam Backup & Replication writes only data blocks for Windows-based OSes to the default cache. Data blocks for other OSes like Linux/Unix and application data blocks are not written to the cache.
- You can start the global cache population task for the target WAN accelerator that is not currently used by any job to the remote location.
- If the global cache population task is currently running, the corresponding target WAN accelerator is locked. You cannot start any job to the remote location by using this target WAN accelerator.
- [For global cache corruption scenario] You must clean the global cache before you populate it with valid data.
- [Veeam Cloud Connect] Veeam Backup & Replication does not use tenant backups to populate global cache on the service provider side.

**How Manual Population of Global Cache Works**

Global cache population is a manual operation performed by the user. When you run the global cache population task, Veeam Backup & Replication creates a ‘default cache’ on the target WAN accelerator. The default cache is used as a basic, universal cache for every new job to the remote location.

To populate the default cache, Veeam Backup & Replication uses backup files stored in backup repositories as a source of data.

The procedure of global cache population includes the following steps:

1. The user manually starts the global cache population tasks and selects backup repositories from which data blocks should be retrieved.
2. Veeam Backup & Replication scans backup repositories and makes up a list of OSes whose data blocks are available in backup files.
3. Veeam Backup & Replication copies data blocks from backup repositories and populates the default cache with these data blocks.
When a job to the remote location starts, Veeam Backup & Replication renames the default cache to a folder for the source WAN accelerator engaged in the job. As a result, Veeam Backup & Replication can use data blocks in this folder for deduplication starting from the very first session of the job to the remote location.

In many-to-one WAN accelerator deployment scenarios, the global cache may have folders for other source WAN accelerators, and these folders may contain data blocks for some OSes. If the global cache already contains some data, the procedure of global cache population includes the following steps:

1. The user manually starts the global cache population tasks and selects backup repositories from which data blocks should be retrieved.
2. Veeam Backup & Replication scans backup repositories and makes up a list of OSes whose data blocks are available in backup files.
3. Veeam Backup & Replication scans folders for other source WAN accelerators in the global cache and makes up a list of OSes whose data blocks are available there.
4. The list of OSes in the global cache is compared to the list of OSes in backup repositories. This way, Veeam Backup & Replication detects data blocks for which OSes are missing in the global cache.
5. In the global cache, Veeam Backup & Replication detects a folder with the maximum amount of data. This folder is used as a basis for the default cache.
6. Veeam Backup & Replication copies data blocks only for missing OSes from backup repositories and populates the default cache with these blocks. Data blocks for OSes available in folders for other source WAN accelerators are not copied to the default cache during the population task. Veeam Backup & Replication copies these data blocks on the fly, when a job to the remote location runs. For more information, see Many to One WAN Acceleration.
Manually Populating Global Cache

To manually populate the global cache:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select the **WAN Accelerators** node.
3. In the working area, right-click the target WAN accelerator and select **Populate cache**.
   
   If the selected WAN accelerator is not assigned as a target WAN accelerator to any job to the remote location, Veeam Backup & Replication will display a warning.
4. In the **Source Backup Repositories** window, select backup repositories from which OS data blocks must be retrieved.

   It is strongly recommended that you select backup repositories on the same site where the target WAN accelerator is located. In the opposite case, the traffic will travel between sites, which will increase load on the network.
5. Click **OK**.

### Clearing Global Cache

You can clear the global cache on the target WAN accelerator. It is recommended that you clear the global cache in the following situations:

- Global cache is corrupted.
- Global cache contains data that is no longer needed. This situation may occur, for example, if you have decided to fully switch to the **High bandwidth mode** that does not use the global cache data.

In such cases, it is recommended that you clear the global cache and **populate it anew** before you start jobs to remote locations processing new types of VMs.
To clear the global cache:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, click **WAN Accelerators**.
3. In the working area, right-click the target WAN accelerator and select **Clear cache**.

**IMPORTANT!**

Mind the following:

- Before you clear the global cache, make sure that you do not have any running jobs that use this target WAN accelerator. When the global cache is cleared, Veeam Backup & Replication will restart the Veeam WAN Accelerator Service, and running jobs will complete with the Failed status.
- When you clear the global cache, you also clear all digest data stored at this WAN accelerator.
WAN Accelerator Sizing

To ensure correct work of remote jobs over WAN accelerators, you must provide enough free space for service data on source and target WAN accelerators.

When configuring WAN accelerators, mind that there can be situations when WAN acceleration switches from the **High bandwidth mode** to the **Low bandwidth mode**: for example, the link to the remote location changes and you decide to disable the **High bandwidth mode** for one of the accelerators in the pair. If you disable the **High bandwidth mode** and start a job which utilizes this WAN accelerator, Veeam Backup & Replication deletes digest data that was used in the **High bandwidth mode** and recreates it for the **Low bandwidth mode**. Besides, Veeam Backup & Replication will also use the global cache at the target WAN accelerator.

To avoid problems caused by the lack of free space when switching from the **High bandwidth mode** to the **Low bandwidth mode**, we recommend that you configure WAN accelerators as if you planned to use them in the **Low bandwidth mode**.

Source WAN Accelerator

When you run a remote job over WAN accelerators, Veeam Backup & Replication analyses data blocks going to target and calculates digests for these data blocks. Digests data is stored on the source WAN accelerator, in the **VeeamWAN** folder on the disk that you select when you configure the WAN accelerator.

You must make sure that there is enough disk space on the source WAN accelerator to store digest data.

The amount of disk space required for a source WAN accelerator operating in the **Low bandwidth mode** is calculated by the following formula:

\[
\text{Digest Size} = 2\% \text{ of Provisioned VM Size}
\]
For example, if you plan to process 10 VMs whose provisioned size is 2 TB, you must allocate 40 GB of disk space for digest data on the source WAN accelerator operating in the **Low bandwidth mode**.

The amount of disk space required for a source WAN accelerator operating in the **High bandwidth mode** is calculated by the following formula:

\[ \text{Digest Size} = 1\% \text{ of Provisioned VM Size} \]

For example, if you plan to process 10 VMs whose provisioned size is 2 TB, you must allocate 20 GB of disk space for digest data on the source WAN accelerator operating in the **High bandwidth mode**.

**Target WAN Accelerator**

You must make sure that you provide enough free space for the following data on the target WAN accelerator:

- Global cache data
- Digest data

**NOTE:**

For the target WAN accelerator operating in the **High bandwidth mode** only, you must provide enough free space to generate digest data. Global cache data is not used in the **High bandwidth mode**.

When you enable the **High bandwidth mode** for an existing WAN accelerator, Veeam Backup & Replication does not automatically remove the global cache that was previously used for acceleration. If you are planning to use the **High bandwidth mode** for WAN acceleration and you do not need the global cache anymore, you can free the disk space by manually removing the cache. If you are planning to use WAN acceleration in the **Low bandwidth mode** in the future, we recommend that you keep the global cache. You can disable the **High bandwidth mode** and switch back to the **Low bandwidth mode** at any time.
Global Cache Data

Global cache is stored on the target WAN accelerator, in the VeeamWAN folder on the disk that you select when you configure the WAN accelerator. The size of global cache is specified in the properties of the target WAN accelerator.

You must provide enough free space for global cache data. It is recommended that you provide 10 GB per every type of OS on VMs that you plan to process. By default, Veeam Backup & Replication allocates 100 GB for the global cache size.

For example, you want to process the following VMs:

- 1 VM that runs Microsoft Windows 7
- 3 VMs that run Microsoft Windows Server 2008 R2
- 2 VMs that run Microsoft Windows Server 2012 R2

There are 3 types of OSes so you must allocate 30 GB for the global cache on the target WAN accelerator.

**NOTE:**

Global cache is stored only on the target WAN accelerator. You do not have to provide space for global cache on the source WAN accelerator.
Digest Data

In some cases, Veeam Backup & Replication may require more space on the target WAN accelerator than specified in the WAN accelerator properties. This can happen if digest data on the source WAN accelerator is missing or cannot be used. For example:

- You have performed the Clear Cache operation on the source WAN accelerator and it no longer contains digest data. For more information, see Clearing Global Cache.

- Veeam Backup & Replication has attempted to resume operation of backup data transfer, but the backup file was not prepared for the operation in a proper way. The digest data must be re-calculated.

In such situations, the target WAN accelerator calculates digest data on its own, which requires additional space. After the digest data is calculated, the target WAN accelerator transfers it to the source WAN accelerator. After the transfer, the copy of the digest data is removed from the target WAN accelerator.

For safety reasons, it is recommended that you provide the following amount of space for digest data on the target WAN accelerator:

The amount of disk space required for digest data at a target WAN accelerator operating in the **Low bandwidth mode** is calculated by the following formula:

\[
\text{Digest Size} = 2\% \text{ of Provisioned VM Size}
\]

The amount of disk space required for digest data at a target WAN accelerator operating in the **High bandwidth mode** is calculated by the following formula:

\[
\text{Digest Size} = 1\% \text{ of Provisioned VM Size}
\]

This amount of space is required for digest data recalculation. If you do not provide this amount of space and a situation where Veeam Backup & Replication needs to recalculate digest data occurs, the job to the remote location will work in the limited mode. Veeam Backup & Replication will not deduplicate data against the previous restore points copied to target. For more information, see Global Data Deduplication.

**IMPORTANT!**

When you specify the global cache size for a target WAN accelerator, you do not allocate any space for storing digest data. To let Veeam Backup & Replication recalculate digest data, you must make sure that necessary amount of free space is available on the target WAN accelerator (in addition to the space allocated for the global cache).

For example:

- You have allocated 100 GB for global cache on the target WAN accelerator operating in the **Low bandwidth mode**.

- Provisioned size of VMs to be processed is 2 TB.

In this case, the needed amount of free disk space for the global cache on the target WAN accelerator is:

\[
100 \text{ GB} + 40 \text{ GB} = 140 \text{ GB}
\]
Many-to-One WAN Acceleration Scenario

Global cache size is calculated per 1 source WAN accelerator working with the target WAN accelerator. If you plan to use several source WAN accelerators with 1 target WAN accelerator, you must increase the size of the global cache proportionally. The cache data for every source WAN accelerator will be stored in a dedicated subfolder in the global cache folder of the target WAN accelerator. The global cache size is calculated by the following formula:

\[
\text{Total Global Cache Size} = (\# \text{ of Source WAN Accelerators}) \times (\text{Size of Global Cache Configured in Target WAN Accelerator Properties})
\]

\[
\text{Total Free Disk Space to Provide} = \text{Total Global Cache Size} + \text{Digest Size}
\]

For example:

- You have 4 source WAN accelerators in the source side working with 1 target WAN accelerator in the disaster recovery (DR) site.
- The global cache size configured in properties of the target WAN accelerator is 100 GB.
- The size of VMs to be processed is 2 TB.

In this case, the needed amount of free disk space for the global cache and digests on the target WAN accelerator is:

\[
4 \times 100 \text{ GB} + 40 \text{ GB} = 440 \text{ GB}
\]

**NOTE:**

For more information and recommendations on WAN accelerator cache sizing, see the Veeam KB1877 article.
Adding WAN Accelerators

To add a WAN accelerator, you must assign the WAN accelerator role to a Microsoft Windows server added to the backup infrastructure.

You must deploy a pair of WAN accelerators: one WAN accelerator on each side of the WAN link.

Before you add a WAN accelerator, check prerequisites. Then use the New WAN Accelerator wizard to add a WAN accelerator.

Before You Begin

Before you add a WAN accelerator, check the following prerequisites:

- The machine that will operate as a WAN accelerator must meet the system requirements. For more information, see System Requirements.

- You must assign the WAN accelerator role to a Microsoft Windows server (physical or virtual). The WAN accelerator role can be assigned to backup proxies and Microsoft Windows backup repositories already configured in the backup infrastructure.

- You must use 64-bit Microsoft Windows machines as WAN accelerators. Veeam Backup & Replication does not support 32-bit versions of Microsoft Windows used as WAN accelerators.

- WAN acceleration operations are resource-consuming. When assigning the WAN accelerator role, mind available CPU and memory resources of the Microsoft Windows server. It is recommended that you assign the WAN accelerator role to servers with 8 GB RAM and more.

- The machine must have enough free disk space to store digests or global cache data. For more information, see WAN Accelerator Sizing.

- You must add the machine to the Veeam Backup & Replication console as a managed server before adding it as a WAN accelerator.
Step 1. Launch New WAN Accelerator Wizard

To launch the **New WAN Accelerator** wizard, do either of the following:

- Open the **Backup Infrastructure** view, in the inventory pane select **WAN Accelerators** and click **Add WAN Accelerator** on the ribbon.
- Open the **Backup Infrastructure** view, in the inventory pane right-click **WAN Accelerators** and select **Add WAN Accelerator**.
Step 2. Choose Server

At the Server step of the wizard, select a Microsoft Windows server that you plan to use as a WAN accelerator and define port and connection settings for this server.

1. From the Choose server list, select a Microsoft Windows server added to the backup infrastructure. If the server is not added to the backup infrastructure yet, you can click Add New to open the New Windows Server wizard. For more information, see Adding Microsoft Windows Servers.

2. In the Description field, provide a description for future reference.
   It is recommended that you describe the added WAN accelerator as the source or target one. When you create a job to the remote location, this hint will be displayed in brackets next to the WAN accelerator name, which will help you choose the necessary WAN accelerator to be used on the source or target side.

3. In the Traffic port field, specify the number of the port over which WAN accelerators must communicate with each other. By default, port 6165 is used.

4. In the Streams field, specify the number of connections that must be used to transmit data between WAN accelerators. By default, 5 connections are used.
   This setting applies only to the source WAN accelerator. The greater is the number of streams, the more bandwidth resources Veeam Backup & Replication will use. A great number of streams engage more CPU and memory resources of the source WAN accelerator.

5. If your network bandwidth is more than 100 Mbps, we recommend that you use the High bandwidth mode option. This mode provides significant bandwidth savings comparable to the direct mode on WAN links under 1 Gbps.
   To use the High bandwidth mode, enable the option for WAN accelerators at both sites of the data transfer: the source one and the target one. If the High bandwidth mode is enabled for the target WAN accelerator, different source accelerators can parallelly interact with it in different modes, depending on the mode selected for each source WAN accelerator.
When you enable the **High bandwidth mode** for an existing pair of WAN accelerators, Veeam Backup & Replication does not automatically remove the global cache that was previously used for acceleration. If you are planning to use only the **High bandwidth mode** for WAN acceleration and you do not need the global cache anymore, you can free the disk space by manually removing the cache. If you are planning to use WAN acceleration in the **Low bandwidth mode** in the future, we recommend that you keep the global cache. You can disable the **High bandwidth mode** at any time.
Step 3. Define Cache Location and Size

At the Cache step of the wizard, define settings for the folder where service files and global cache data will be stored.

**NOTE:**

If both WAN accelerators (the source one and the target one) work in the **High bandwidth mode**, WAN acceleration does not use the global cache. But bear in mind that you can disable the **High bandwidth mode** and switch back to the **Low bandwidth mode** at any time, which will require to use the global cache.

To provide correct operation of WAN accelerators, we recommend that you allocate enough disk space for the global cache folder when adding a new WAN accelerator, no matter if the **High bandwidth mode** is enabled for it or not.

1. In the **Folder** field, specify a path to the folder in which service files (for source and target WAN accelerators) and global cache data (for target WAN accelerator) must be stored. When selecting a folder on the target WAN accelerator, make sure that there is enough space for storing global cache data.

2. [For target WAN accelerator] In the **Cache size** field, specify the size for the global cache. The global cache size is specified per source WAN accelerator. If you plan to use one target WAN accelerator with several source WAN accelerators, the specified amount of space will be allocated to every source WAN accelerator and the size of the global cache will increase proportionally. For more information, see **WAN Accelerator Sizing**.

**IMPORTANT!**

Do not nest the global cache folder deep in the file tree. During WAN acceleration operations, Veeam Backup & Replication generates service files with long file names. Placing such files to a folder of significant depth may cause problems on the NTFS file system.
Step 4. Review Components

Veeam Backup & Replication installs the following components on the server used as a WAN accelerator:

- Veeam Data Mover Service
- Veeam WAN Accelerator Service

At the Review step of the wizard, review what components are already installed on the server and what components will be installed.

1. Review the components.
2. Click Next to install the components on the server.

![New WAN Accelerator window]

Show the settings, and click Apply to continue.

<table>
<thead>
<tr>
<th>Review</th>
<th>Server names: \textit{fileserv05.tech.local}</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review</td>
<td>Server type: Virtual (VMware)</td>
</tr>
<tr>
<td>Review</td>
<td>Cache size: 50 GB</td>
</tr>
<tr>
<td>Review</td>
<td>Cache path: C:\VeeamWAN</td>
</tr>
</tbody>
</table>

The following components will be processed on fileserv05.tech.local:

<table>
<thead>
<tr>
<th>Component name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport</td>
<td>already exists</td>
</tr>
<tr>
<td>WAN Accelerator</td>
<td>will be installed</td>
</tr>
</tbody>
</table>
Step 5. Finish Working with Wizard

At the **Apply** step of the wizard, complete the procedure of WAN accelerator configuration.

1. Wait for the WAN accelerator to be added to the backup infrastructure.
2. Click **Next**, then click **Finish** to exit the wizard.
Removing WAN Accelerators

You can permanently remove a WAN accelerator from the backup infrastructure. When you remove a WAN accelerator, Veeam Backup & Replication unassigns the WAN accelerator role from the server, and this server is no longer used as a WAN accelerator. The server itself remains in the backup infrastructure.

To remove a WAN accelerator:

1. Open the **Backup Infrastructure** view.
2. In the inventory pane, select **WAN accelerators**.
3. In the working area, select the WAN accelerator and click **Remove WAN Accelerator** on the ribbon or right-click the WAN accelerator and select **Remove**.
Data Block Verification

During the VM copy process, Veeam Backup & Replication performs a CRC check for the VM traffic going between the source and target WAN accelerators. The CRC check helps ensure that the correct VM data goes to the target side and no corrupted data blocks are written to the global cache or to backup files in the target backup repository.

The check is performed in the following way:

1. Before sending a data block to the target side, Veeam Backup & Replication calculates a checksum for the copied data block.

2. Once the data block is copied over WAN and before it is written to the global cache or to the target backup repository, Veeam Backup & Replication re-calculates the checksum for this data block on the target side.

3. The source and target checksums are compared. If the checksums do not coincide, the target WAN accelerator sends a request to the source WAN accelerator for the correct data block. The source WAN accelerator re-sends the necessary data blocks to the target WAN accelerator as is and the re-sent data block is written to the global cache or to the backup file in the target backup repository on the fly.
Data Transport on WAN Disconnect

If you replicate VMs over WAN accelerators, and a WAN connection drops for short periods of time (less than 30 minutes), Veeam Backup & Replication transparently handles disconnect issues. It automatically resumes the data transport process from the point when the connection was lost. The resume on disconnect capability improves the reliability of offsite replication, reduces the backup window and minimizes the load on the WAN link.

If a WAN connection is lost for more than 30 minutes, Veeam Backup & Replication still does not finish the job with a failed status. After a WAN connection is resumed, Veeam Backup & Replication starts a new data transfer cycle. Data transported with every new transport cycle is written to a new working snapshot of a VM replica. As the WAN connection may drop several times, Veeam Backup & Replication can create a number of working snapshots.

Not to keep long snapshot chains, Veeam Backup & Replication merges earlier snapshots and maintains only two working snapshots for the VM replica. When all VM data is transferred to the target host, the two working snapshots are also merged to create one fully functional VM restore point.

If the WAN link is weak and drops constantly, Veeam Backup & Replication may fail to transport VM data by the time a new replication job session starts. In this case, during a new replication job session Veeam Backup & Replication attempts to transfer VM data that have changed since the last replication job session and VM data that were not transferred during the previous replication job session.
Data Encryption

Data security is an important part of the backup strategy. You must protect your information from unauthorized access, especially if you back up sensitive VM data to offsite locations or archive it to tape. To keep your data safe, you can use data encryption.

Data encryption transforms data to an unreadable, scrambled format with the help of a cryptographic algorithm and a secret key. If encrypted data is intercepted, it cannot be unlocked and read by the eavesdropper. Only intended recipients who know the secret key can reverse encrypted information back to a readable format.

In Veeam Backup & Replication, encryption works at the following levels:

- Backup job
- Transaction log backup job
- Backup copy job
- VeeamZIP
- Tapes in media pools

Veeam Backup & Replication uses the block cypher encryption algorithm. Encryption works at the source side. Veeam Backup & Replication reads VM or file data, encodes data blocks, transfers them to the target side in the encrypted format and stores the data to a file in the backup repository or archives the data to tape. Data decryption is also performed on the source side: Veeam Backup & Replication transfers encrypted data back to the source side and decrypts it there.

![Diagram of encryption process]

**NOTE:**

Veeam Backup & Replication will pass encryption keys to the target backup repository or cloud repository in the following cases:

- If you run a backup copy job over WAN accelerators
- If you perform health check for the encrypted backup files

Beside the job-level encryption, Veeam Backup & Replication allows you to encrypt network traffic going between the primary site and the disaster recovery site. Network traffic encryption is configured as part of global network traffic rules that are set for backup infrastructure components. For network traffic encryption, Veeam Backup & Replication uses the 256-bit Advanced Encryption Standard (AES).
Data Encryption and Deduplication

Data encryption has a negative effect on the deduplication ratio if you use a deduplicating storage appliance as a target. Veeam Backup & Replication uses different encryption keys for every job session. For this reason, encrypted data blocks sent to the deduplicating storage appliances appear as different though they may contain duplicate data. If you want to achieve a higher deduplication ratio, you can disable data encryption.

Data Encryption and Compression

If data compression and data encryption are enabled for a job, Veeam Backup & Replication compresses VM data first and after that encodes the compressed data blocks. Both operations are performed at the source side.

Note, however, that if the Decompress backup data blocks before storing check box is selected in the backup repository settings, Veeam Backup & Replication does not compress VM data before encryption. Therefore, in the job statistics, you may observe a higher amount of transferred data (the Transferred counter) as compared to a job for which encryption is disabled. For details on job statistics, see Viewing Real-Time Statistics.
Encryption Standards

Veeam Backup & Replication uses the following industry-standard data encryption algorithms:

Data Encryption

- To encrypt data blocks in backup files and files archived to tape, Veeam Backup & Replication uses the 256-bit AES with a 256-bit key length in the CBC-mode. For more information, see Advanced Encryption Standard (AES).
- To generate a key based on a password, Veeam Backup & Replication uses the Password-Based Key Derivation Function, PKCS #5 version 2.0. Veeam Backup & Replication uses 10,000 HMAC-SHA1 iterations and a 512-bit salt. For more information, see Recommendation for Password-Based Key Derivation.

Enterprise Manager Keys

- To generate Enterprise Manager keys required for data restore without a password, Veeam Backup & Replication uses the RSA algorithm with a 4096-bit key length.
- To generate a request for data restore from a backup server, Veeam Backup & Replication uses the RSA algorithm with a 2048-bit key length.

For more information, see RSA Cryptography Specifications.

Hashing Algorithms

Veeam Backup & Replication uses the following hashing algorithms:

- For digital signature generation: SHA-1, SHA-256
- For HMAC generation: HMAC_SHA-1
- For random number generation: SHA-1

Encryption Libraries

For Microsoft Windows-based repositories and software-based encryption for tapes, Veeam Backup & Replication uses the Windows Crypto API complying with the Federal Information Processing Standards (FIPS 140). For more information, see Cryptographic Module Validation Program.

Veeam Backup & Replication uses the following cryptographic service providers:

- Microsoft Base Cryptographic Provider. For more information, see Microsoft Docs.
- Microsoft Enhanced RSA and AES Cryptographic Provider. For more information, see Microsoft Docs.
- Microsoft Enhanced Cryptographic Provider. For more information, see Microsoft Docs.

For Linux-based repositories, Veeam Backup & Replication uses a statically linked OpenSSL encryption library, without the FIPS 140 support. For more information, see OpenSSL.

Veeam Backup & Replication encrypts stored credentials using the Data Protection API (DPAPI) mechanisms. For more information, see Microsoft Docs.
Encryption Algorithms

To encrypt data in backups and files, Veeam Backup & Replication employs a symmetric key encryption algorithm.

The symmetric, or single-key encryption algorithm, uses a single, common secret key to encrypt and decrypt data. Before data is sent to target side, it is encoded with a secret key. To restore encrypted data, you must have the same secret key. Users who do not have the secret key cannot decrypt data and get access to it.

Veeam Backup & Replication relies on a hierarchical encryption scheme. Each layer in the hierarchy encrypts the layer below with a key of specific type.
Encryption Keys

An encryption key is a string of random characters that is used to bring data to a scrambled format and back to unscrambled. Encryption keys encode and decode initial data blocks or underlying keys in the key hierarchy.

Veeam Backup & Replication uses 8 types of keys:

- 3 service keys generated by Veeam Backup & Replication:
  - Session key
  - Metakey
  - Storage key
- 1 key generated based on a user password: a user key.
- A pair of keys used for data recovery without a password — Enterprise Manager keys.
- A pair of keys used for identity verification of the backup server — backup server keys.

Session Keys and Metakeys

The session key is the lowest layer in the encryption key hierarchy. When Veeam Backup & Replication encrypts data, it first encodes every data block in a file with a session key. For session keys, Veeam Backup & Replication uses the AES algorithm with a 256-bit key length in the CBC-mode.

Veeam Backup & Replication generates a new session key for every job session. For example, if you have created an encrypted backup job and run 3 job sessions, Veeam Backup & Replication will produce 3 backup files that will be encrypted with 3 different session keys:

- Full backup file encrypted with session key 1
- Incremental backup file encrypted with session key 2
- Incremental backup file encrypted with session key 3

The session key is used to encrypt only data blocks in backup files or files archived to tape. To encrypt backup metadata, Veeam Backup & Replication applies a separate key — metakey. Use of a metakey for metadata raises the security level of encrypted backups.

For every job session, Veeam Backup & Replication generates a new metakey. For example, if you have run 3 job sessions, Veeam Backup & Replication will encrypt metadata with 3 metakeys.
In the encryption process, session keys and metakeys are encrypted with keys of a higher layer — storage keys. Cryptograms of session keys and metakeys are stored to the resulting file next to encrypted data blocks. Metakeys are additionally kept in the configuration database.

**Storage Keys**

Backup files in the backup chain often need to be transformed, for example, in case you create a reverse incremental backup chain. When Veeam Backup & Replication transforms a full backup file, it writes data blocks from several restore points to the full backup file. As a result, the full backup file contains data blocks that are encrypted in different job sessions with different session keys.

To restore data from such "composed" backup file, Veeam Backup & Replication would require a bunch of session keys. For example, if the backup chain contains restore points for 2 months, Veeam Backup & Replication would have to keep session keys for a 2-month period.

In such situation, storing and handling session keys would be resource consuming and complicated. To facilitate the encryption process, Veeam Backup & Replication introduces another type of service key — a storage key.

For storage keys, Veeam Backup & Replication uses the AES algorithm. A storage key is directly associated with one restore point in the backup chain. The storage key is used to encrypt the following keys in the encryption hierarchy:

- All session keys for all data blocks in one restore point
- Metakey encrypting backup metadata

During the restore process, Veeam Backup & Replication uses one storage key to decrypt all session keys for one restore point, no matter how many session keys were used to encrypt data blocks in this restore point. As a result, Veeam Backup & Replication does not need to keep the session keys history in the configuration database. Instead, it requires only one storage key to restore data from one file.

In the encryption process, storage keys are encrypted with keys of a higher layer — user keys and optionally a public Enterprise Manager key. Cryptograms of storage keys are stored to the resulting file next to encrypted data blocks, and cryptograms of session keys and metakeys.

Storage keys are also kept in the configuration database. To maintain a set of valid storage keys in the database, Veeam Backup & Replication uses retention policy settings specified for the job. When some restore point is removed from the backup chain by retention, the storage key corresponding to this restore point is also removed from the configuration database.
User Keys

When you enable encryption for a job, you must define a password to protect data processed by this job, and define a hint for the password. The password and the hint are saved in the job settings. Based on this password, Veeam Backup & Replication generates a user key.

The user key protects data at the job level. In the encryption hierarchy, the user key encrypts storage keys for all restore points in the backup chain.

During the encryption process, Veeam Backup & Replication saves a hint for the password to the encrypted file. When you decrypt a file, Veeam Backup & Replication displays a hint for the password that you must provide. After you enter a password, Veeam Backup & Replication derives a user key from the password and uses it to unlock the storage key for the encrypted file.

According to the security best practices, you must change passwords for encrypted jobs regularly. When you change a password for the job, Veeam Backup & Replication creates a new user key and uses it to encrypt new restore points in the backup chain.

**IMPORTANT!**

You must always remember passwords set for jobs or save these passwords in a safe place. If you lose or forget the password, you can restore data from a backup file by issuing a request to Veeam Backup Enterprise Manager. For more information, see How Decryption Without Password Works.

Enterprise Manager Keys

In some cases, a password required for data decryption may be lost or forgotten, or a user who knows the password may leave your organization. As a result, you cannot recover data from backups or tapes encrypted with this password, and encrypted data becomes unusable.

Veeam Backup & Replication offers you a way to restore encrypted data even if you do not have a password. For this purpose, Veeam Backup & Replication employs an additional pair of keys in the encryption process — Enterprise Manager keys.
Enterprise Manager keys is a pair of matching RSA keys: a public key and a private key. The public Enterprise Manager key is used to encrypt data, while the private Enterprise Manager key is used to decrypt data encrypted with the public key.

In the encryption process, Enterprise Manager keys perform a role similar to the user key: the public Enterprise Manager key encrypts storage keys and the private Enterprise Manager key decrypts them. Technically, Enterprise Manager keys offer an alternative to the user key. When you create an encrypted backup file or archive encrypted data to tape, Veeam Backup & Replication encrypts storage keys with two types of keys simultaneously:

- User key
- Public Enterprise Manager key

When you decrypt a file and the password is lost, Veeam Backup & Replication cannot derive the user key from the password. In this situation, you can send a request to Veeam Backup Enterprise Manager. Veeam Backup Enterprise Manager will employ the private Enterprise Manager key instead of the user key to unlock storage keys and decrypt the file content. For more information, see How Decryption Without Password Works.

Enterprise Manager keys take part in the encryption process if the following two conditions are met:

1. You have the Enterprise or Enterprise Plus edition of Veeam Backup & Replication.
2. You have Veeam Backup Enterprise Manager installed and your backup servers are connected to Veeam Backup Enterprise Manager.

Enterprise Manager keys make up a pair of matching keys – a keyset. Enterprise Manager keysets are created and managed on the Veeam Backup Enterprise Manager server. During installation of Veeam Backup Enterprise Manager, the setup automatically generates a new keyset containing a public Enterprise Manager key and a private Enterprise Manager key. You can use Veeam Backup Enterprise Manager to create new Enterprise Manager keysets, activate them, import and export keysets and specify retention for their lifetime.
The public Enterprise Manager key is made publicly available to backup servers. When you connect backup servers to Veeam Backup Enterprise Manager, the public Enterprise Manager key is automatically propagated to these backup servers.

Veeam Backup Enterprise Manager acts as a manager for public Enterprise Manager keys but does not store these keys. After the public Enterprise Manager key is propagated to the backup server, it is kept in the configuration database.

Private Enterprise Manager keys, on the contrary, are not distributed anywhere: they are kept only on Veeam Backup Enterprise Manager.

Backup Server Keys

Eavesdroppers may potentially use Veeam Backup Enterprise Manager to unlock files encrypted with Veeam Backup & Replication. If the eavesdropper intercepts an encrypted file, s/he may generate a request for file unlocking and send such request to Veeam Backup Enterprise Manager Administrators. Having received a response from Veeam Backup Enterprise Manager, the eavesdropper will be able unlock the encrypted file without a password.

To protect you against the "man-in-the-middle" attack, Veeam Backup & Replication uses backup server keys. Backup server keys are a pair of RSA keys, public and private, that are generated on the backup server.

- The public backup server key is sent to Veeam Backup Enterprise Manager to which the backup server is connected, and saved in the Veeam Backup Enterprise Manager configuration database.
- The private backup server key is kept on the backup server in the Veeam Backup & Replication configuration database.

Backup server keys are used to authenticate the identity of the request sender. When the backup server generates a request to unlock a file, it adds a signature encrypted with the private backup server key to this request.

When Veeam Backup Enterprise Manager processes the request, it uses the public backup server key to decrypt the signature and identify the request sender. If the backup server used for request generation is not added to Veeam Backup Enterprise Manager, Veeam Backup Enterprise Manager will not find a matching public key in its database. As a result, Veeam Backup Enterprise Manager will not be able to identify the sender and the storage key decryption process will fail.
How Data Encryption Works

Data encryption is performed as part of backup, backup copy or archiving to tape processes. Encryption works at the source side, before data is transported to the target. Encryption keys are not passed to the target side, unless you run a backup copy job over WAN accelerators or perform health check for the encrypted backup files.

NOTE:
The procedure below describes the encryption process for backup, backup copy jobs and VeeamZIP tasks. For more information about encrypting data on tapes, see Tape Encryption.

The encryption process includes the following steps:

1. When you create a new job, you enable the encryption option for the job and enter a password to protect data at the job level.
2. Veeam Backup & Replication generates a user key based on the entered password.
3. When you start an encrypted job, Veeam Backup & Replication creates a storage key and stores this key to the configuration database.
4. Veeam Backup & Replication creates a session key and a metakey. The metakey is stored to the configuration database.
5. Veeam Backup & Replication processes job data in the following way:
   a. The session key encrypts data blocks in the backup file. The metakey encrypts backup metadata.
   b. The storage key encrypts the session key and the metakey.
   c. The user key encrypts the storage key.
   d. If you use the Enterprise or Enterprise Plus edition of Veeam Backup & Replication and the backup server is connected to Veeam Backup Enterprise Manager, the Enterprise Manager key also encrypts the storage key.
6. Encrypted data blocks are passed to the target. The cryptograms of the public Enterprise Manager key (if used), user key, storage key, session key and metakey are stored to the resulting file next to encrypted data blocks.

If you use the Enterprise or Enterprise Plus edition of Veeam Backup & Replication and the backup server is connected to Veeam Backup Enterprise Manager, Veeam Backup & Replication saves two cryptograms of the storage key to the resulting file: one encrypted with the user key (c) and one encrypted with the Enterprise Manager key (d). Saving the cryptogram twice helps Veeam Backup & Replication decrypt the file even if a password is lost or forgotten. For more information, see How Decryption Without Password Works.
How Data Decryption Works

When you restore data from an encrypted backup file, Veeam Backup & Replication performs data decryption automatically in the background or requires you to provide a password.

- If encryption keys required to unlock the backup file are available in the Veeam Backup & Replication configuration database, you do not need to enter the password. Veeam Backup & Replication uses keys from the database to unlock the backup file. Data decryption is performed in the background, and data restore does not differ from that from an unencrypted one.

Automatic data decryption is performed if the following conditions are met:

a. You encrypt and decrypt the backup file on the same backup server using the same Veeam Backup & Replication configuration database.

b. [For backup file] The backup is not removed from the Veeam Backup & Replication console.

- If encryption keys are not available in the Veeam Backup & Replication configuration database, you need to provide a password to unlock the encrypted file.

Data decryption is performed at the source side, after data is transported back from the target side. As a result, encryption keys are not passed to the target side, which helps avoid data interception.

NOTE:

The procedure below describes the decryption process for backup, backup copy jobs and VeeamZIP tasks.
For more information about decrypting tape data, see Tape Encryption.

The decryption process includes the following steps. Note that steps 1 and 2 are required only if you decrypt the file on the backup server other than the backup server where the file was encrypted.

1. You import the file to the backup server. Veeam Backup & Replication notifies you that the imported file is encrypted and requires a password.

2. You specify a password for the imported file. If the password has changed once or several times, you need to specify the password in the following manner:
   
   o If you select a .vbm file for import, you must specify the latest password that was used to encrypt files in the backup chain.
   
   o If you select a full backup file for import, you must specify the whole set of passwords that were used to encrypt files in the backup chain.

3. Veeam Backup & Replication reads the entered password and generates the user key based on this password. With the user key available, Veeam Backup & Replication performs decryption in the following way:
   
   a. Veeam Backup & Replication applies the user key to decrypt the storage key.
   
   b. The storage key, in its turn, unlocks underlying session keys and a metakey.
   
   c. Session keys decrypt data blocks in the encrypted file.

After the encrypted file is unlocked, you can work with it as usual.
If you have lost or forgotten a password for an encrypted file, you can issue a request to Veeam Backup Enterprise Manager and restore data from an encrypted file using Enterprise Manager keys. For more information, see Enterprise Manager Keys and How Decryption Without Password Works.
How Decryption Without Password Works

When you import an encrypted backup file or tape media to the backup server, you need to enter a password to decrypt data. In some cases, however, a password can be lost or forgotten. Veeam Backup & Replication offers a way to restore data from encrypted backups or tapes even if a password is not available.

You can restore data from encrypted backups or tapes without a password only if your backup infrastructure meets the following conditions:

1. You use the Enterprise or Enterprise Plus edition of Veeam Backup & Replication.
2. The backup servers on which you encrypted data is added to Veeam Backup Enterprise Manager.
3. The backup server on which you generate a request for data decryption is added to Veeam Backup Enterprise Manager.

If the backup server on which you encrypt data is added to Veeam Backup Enterprise Manager, Veeam Backup & Replication employs the public Enterprise Manager key in the encryption process. To decrypt backups or tapes encrypted with the public Enterprise Manager key, you can apply a matching private Enterprise Manager key, instead of a password. The private Enterprise Manager key unlocks the underlying storage keys and lets you access the content of an encrypted file.

The restore process is accomplished with the help of two wizards that run on two servers:

1. The **Encryption Key Restore** wizard on the backup server.
2. The **Password Recovery** wizard on the Veeam Backup Enterprise Manager server.

The restore process includes the next steps:

1. You start the **Encryption Key Restore** wizard on the backup server to issue a request for data recovery.
2. The **Encryption Key Restore** wizard generates a request to Veeam Backup Enterprise Manager. The request has the format of a text document and contains cryptograms of storage keys that must be decrypted, together with information about the public Enterprise Manager key that was used to encrypt data. At the end of the request, the backup server adds a signature encrypted with a private backup server key.
3. You send the request to the Veeam Backup Enterprise Manager Administrator, for example, via email.
4. The Veeam Backup Enterprise Manager Administrator starts the **Password Recovery** wizard on Veeam Backup Enterprise Manager and inserts the text of the request to the wizard.
5. Veeam Backup Enterprise Manager finds a matching public backup server key in Veeam Backup Enterprise Manager configuration database and decrypts the signature with this key.
6. Veeam Backup Enterprise Manager decrypts storage keys with the private Enterprise Manager key available on Veeam Backup Enterprise Manager, and generates a response in the **Password Recovery** wizard. The response has the format of a text document and contains decrypted storage keys.
7. The Veeam Backup Enterprise Manager Administrator sends the response to you, for example, via email.
8. You input the request to the **Encryption Key Restore** wizard. Veeam Backup & Replication processes the response, retrieves the decrypted storage keys and uses them to unlock encrypted backups or tapes and retrieve their content.
IMPORTANT!

You can recover data only if Veeam Backup Enterprise Manager has a private Enterprise Manager key matching the public Enterprise Manager key that was used for data encryption. If a matching private Enterprise Manager key is not found in the Veeam Backup Enterprise Manager configuration database, the **Password Recovery** wizard will fail. In such situation, you can import a necessary private Enterprise Manager key via the import procedure. For more information, see *Exporting and Importing Enterprise Manager Keys* in Veeam Backup Enterprise Manager User Guide.
Encrypted Objects

The encryption algorithm works at the job level and media pool level. You can enable encryption for the following types of jobs:

- Backup job
- Backup copy job
- Backup to tape job
- VeeamZIP
- Tape encryption
Backup Job Encryption

Encryption for a backup job is configured in the advanced job settings. You should enable the encryption option and specify a password to protect data in backup files produced by the backup job.

The backup job processing with encryption enabled includes the following steps:

1. You enable encryption for a backup job and specify a password.
2. Veeam Backup & Replication generates the necessary keys to protect backup data.
3. Veeam Backup & Replication encrypts data blocks in the backup proxy, either the dedicated or default one, and transfers them to the backup repository already encrypted.
4. On the backup repository, encrypted data blocks are stored to a resulting backup file.
Restore of an encrypted backup file includes the following steps:

1. You import a backup file and define a password to decrypt the backup file. If the password has changed once or several times, you need to specify the password in the following manner:
   - If you select a metadata file (VBM) for import, you must specify the latest password that was used to encrypt files in the backup chain.
   - If you select a full backup file (VBK) for import, you must specify the whole set of passwords that were used to encrypt files in the backup chain.

2. Veeam Backup & Replication uses the provided passwords to generate user keys and unlock the subsequent keys for backup file decryption.

3. Veeam Backup & Replication retrieves data blocks from the backup file, sends them to the source side and decrypts them on the backup proxy, either the dedicated or default one.
Backup Copy Job Encryption

Encryption for a backup copy job is configured in the advanced job settings. You should enable the encryption option and specify a password to protect data in backup files produced by the backup copy job.

The workflow of the encrypted backup copy job depends on the path for data transfer:

- **Direct data path**
- **Over WAN accelerators**

### Direct Data Path

If you use a direct data path to transfer backups to the target backup repository, the encrypted backup copy job includes the following steps:

1. You enable encryption for a backup copy job and specify a password.
2. Veeam Backup & Replication generates the necessary keys to protect backup files produced by the backup copy job.
3. Veeam Backup & Replication encrypts data blocks on the source side and transfers them to the target backup repository.
4. On the target backup repository, encrypted data blocks are stored to a resulting backup file.

An encrypted backup copy job may use an encrypted backup file as a source. In this situation, Veeam Backup & Replication does not perform double encryption. The backup copy job includes the following steps:

1. Veeam Backup & Replication decrypts data blocks of the encrypted source backup file. For the decryption process, it uses the storage key and metakeys stored in the configuration database.
2. Veeam Backup & Replication generates the necessary keys to protect backup files produced by the backup copy job.
3. Veeam Backup & Replication encrypts data blocks on the source side using these keys and transfers encrypted data blocks to the target backup repository.
4. On the target backup repository, encrypted data blocks are stored to a resulting backup file.

The restore process for backups produced by backup copy jobs does not differ from that for backup jobs.

**Over WAN Accelerators**

WAN accelerators require reading data on the target side to perform such operations as global data deduplication, backup health check and so on. For this reason, if you use WAN accelerators for backup copy jobs, the encryption process is performed on the target side.

The backup copy job processing over WAN accelerators includes the following steps:

1. You enable encryption for a backup copy job and specify a password.
2. Veeam Backup & Replication generates necessary keys to protect backup files produced by the backup copy job.
3. Data blocks are passed to the target backup repository in the unencrypted format.
4. Received data blocks are encrypted on the target site and stored to a resulting backup file in the target backup repository.

The restore process in this case does not differ from that for backup jobs. Veeam Backup & Replication retrieves data blocks from the backup file in the target backup repository, sends them to the source side and decrypts them on the source side.

When transporting data between WAN accelerators that face external networks, Veeam Backup & Replication encrypts the network traffic by default. For network traffic encryption, Veeam Backup & Replication uses the 256-bit Advanced Encryption Standard (AES). For more information, see Enabling Network Data Encryption.
VeeamZIP Encryption

If you want to create an encrypted VeeamZIP file, you should enable the encryption option and specify a password in VeeamZIP task options.

Data processing during VeeamZIP file creation and restore from a VeeamZIP file does not differ from that of a backup job.
Tape Encryption

Veeam Backup & Replication supports two types of encryption for tape media:

- Hardware level: library- and driver-managed encryption mechanisms provided by the tape vendor
- Software level: the encryption mechanism provided by Veeam Backup & Replication

Hardware encryption has a higher priority. If hardware encryption is enabled for the tape media, Veeam Backup & Replication automatically disables its software encryption mechanism for such tape libraries. The Veeam encryption mechanism can only be used if hardware encryption is disabled at the tape device level or not supported.

To use the Veeam encryption mechanism, you need to enable encryption at the level of media pool. In this case, Veeam Backup & Replication will encrypt data for all jobs that use tapes from this media pool. Encryption is supported for both types of tape jobs:

- Backup to tape jobs
- File to tape jobs

Encryption of data on tapes includes the following steps:

1. You enable encryption for a media pool and specify a password.
2. You select the media pool as a target for a backup to tape or file to tape job.
3. Veeam Backup & Replication generates the necessary keys to protect data archived to tape.
4. During the backup to tape or file to tape job, the key is passed to the target side. In case of hardware encryption, Veeam Backup & Replication passes the key to the tape device, and the tape device uses its mechanism to encrypt data on tapes. In case of software encryption, Veeam Backup & Replication passes the keys to the tape server, and encrypts data when it is archived to tape.

Backup to tape jobs allow double encryption. The backup to tape job uses a backup file as a source of data. If the backup file is encrypted with the initial backup job and the encryption option is enabled for the backup to tape job, too, the resulting backup file will be encrypted twice. To decrypt such backup file, you will need to subsequently enter two passwords:

- Password for the initial backup job
- Password for the media pool

Restore of encrypted data from tape includes the following steps:

1. You insert tape with encrypted data into the tape drive and perform tape catalogization. The catalogization operations let Veeam Backup & Replication understand what data is written to tape.

2. You provide a password to decrypt data archived to tape.
3. Veeam Backup & Replication uses the provided password to generate a user key and unlock the subsequent keys for data. Veeam Backup & Replication retrieves data blocks from encrypted files on tapes and decrypts them.
Encryption Best Practices

To guarantee the flawless process of data encryption and decryption, consider the following recommendations.

Password

1. Use strong passwords that are hard to crack or guess:
   - The password must be at least 8 characters long.
   - The password must contain uppercase and lowercase characters.
   - The password must be a mixture of alphabetic, numeric and punctuation characters.
   - The password must significantly differ from the password you used previously.
   - The password must not contain any real information related to you, for example, date of birth, your pet’s name, your logon name and so on.

2. Provide a meaningful hint for the password that will help you recall the password. The hint for the password is displayed when you import an encrypted file or tape to the backup server and attempt to unlock it.

3. Keep passwords in the safe place. If you lose or forget your password, you will not be able to recover data from backups or tapes encrypted with this password, unless you use Enterprise Manager keys in the encryption process.

4. Change passwords for encrypted jobs regularly. Use of different passwords helps increase the encryption security level.

Data recovery without a password and Enterprise Manager keys

1. If you use the Enterprise or Enterprise Plus edition of Veeam Backup & Replication, connect backup servers to Veeam Backup Enterprise Manager. In this case, Veeam Backup & Replication will employ Enterprise Manager keys in the encryption process, which will let you to recover data from encrypted backups and tapes even if the password is lost or forgotten. For more information, see Decrypting Data Without Password.

2. Create and activate new Enterprise Manager keysets regularly. When you activate a keyset, the public Enterprise Manager key is automatically propagated to backup servers connected to Veeam Backup Enterprise Manager and used for encrypted jobs on these servers.

3. Create backup copies of Enterprise Manager keysets and keep them in a safe place. If your installation of Veeam Backup Enterprise Manager goes down for some reason, you will lose private Enterprise Manager keys. As a result, you will not be able to use the Veeam Backup Enterprise Manager functionality to recover data from backups and tapes without a password. For more information, see Decrypting Data Without Password.

Encryption for Existing Jobs

If you enable encryption for an existing job, during the next job session Veeam Backup & Replication will create a full backup file. The created full backup file and subsequent incremental backup files in the backup chain will be encrypted with the specified password.
NOTE:
After enabling or disabling encryption for an existing backup copy job you will need to create an active full backup manually. For more information, see Creating Active Full Backups.

Encryption is not retroactive. If you enable encryption for an existing job, Veeam Backup & Replication does not encrypt the previous backup chain created with this job. If you want to start a new chain so that the unencrypted previous chain can be separated from the encrypted new chain, follow this scenario: this Veeam KB article.

If you change the password for the already encrypted job, during the next job session Veeam Backup & Replication will create a new incremental backup file. The created backup file and subsequent backup files in the backup chain will be encrypted with the new password.

NOTE:
To unlock a backup encrypted with several passwords, you must decrypt it in the following manner:

- If you import a metadata file (VBM), provide the latest password that was used to encrypt files in the backup chain.
- If you import a full backup file (VBK), provide the whole set of passwords that were used to encrypt files in the backup chain.

For more information, see Decrypting Data with Password.
Restoring Data from Encrypted Backups

When you restore data from an encrypted backup, Veeam Backup & Replication performs data decryption automatically in the background or requires you to specify a password.

- If encryption keys required to unlock the backup file are available in the configuration database, you do not need to specify the password. Veeam Backup & Replication uses keys from the database to unlock the backup file. Data decryption is performed in the background, and data restore from the encrypted backup does not differ from that from an unencrypted one.

  Automatic backup file decryption is performed if the following conditions are met:

  a. You encrypt and decrypt the backup file on the same backup server that uses the same configuration database.

  b. The backup is not removed from the Veeam Backup & Replication console.

- If encryption keys are not available in the configuration database, you can restore data from the encrypted backup with the following methods:

  - You can provide a password or a set of passwords to unlock an encrypted file. For more information, see Decrypting Data with Password.

  - You can use Veeam Backup Enterprise Manager to unlock an encrypted file without a password. For more information, see Decrypting Data Without Password.
Decryption with Password

To unlock an encrypted file, you must specify a password. The password must be the same as the password that was used to encrypt the backup file.

To decrypt a backup file:

1. Import an encrypted backup file to the Veeam Backup & Replication console. After the import, the encrypted backup will appear under the Backups > Disk (encrypted) node in the inventory pane.

2. In the inventory pane, select Disk (encrypted).

3. In the working area, select the imported backup and click Specify Password on the ribbon or right-click the backup and select Specify password.

4. In the Description field of the Specify Password window, Veeam Backup & Replication displays a hint for the password that was used to encrypt the backup file. Use the hint to recall the password.

5. In the Password field, enter the password for the backup file.

If you changed the password one or several times while the backup chain was created, you must enter passwords in the following manner:

- If you select a metadata file (VBM) for import, you must specify the latest password that was used to encrypt files in the backup chain.

- If you select a full backup file (VBK) for import, you must specify the whole set of passwords that were used to encrypt files in the backup chain.

If you enter correct passwords, Veeam Backup & Replication will decrypt the backup file. The backup will be moved under the Backups > Disk (imported) node in the inventory pane. You can perform restore operations with the backup file in a regular manner.

NOTE:

If you use the Enterprise or Enterprise Plus edition of Veeam Backup & Replication and the backup servers are connected to Veeam Backup Enterprise Manager, you can recover data from an encrypted backup even if the password is lost. For more information, see Decrypting Data Without Password.
Decrypted Data Without Password

If you have lost or forgotten a password, you can unlock an encrypted file with the help of Veeam Backup Enterprise Manager.

You can restore data without a password only if your backup infrastructure meets the following conditions:

1. You use the Enterprise or Enterprise Plus edition of Veeam Backup & Replication.
2. The backup server on which you encrypted data is connected to Veeam Backup Enterprise Manager.
3. The backup server on which you generate a request for data decryption is connected to Veeam Backup Enterprise Manager.

**IMPORTANT!**

Backup servers that you use for data decryption must be connected to the same instance of Veeam Backup Enterprise Manager. If you connect a backup server to several instances of Veeam Backup Enterprise Manager, this may cause unexpected behavior, and the decryption process may fail.

The restore process is accomplished with the help of two wizards that run on two servers:

1. The **Encryption Key Restore** wizard on the backup server.
2. The **Password Recovery** wizard on the Veeam Backup Enterprise Manager server.

To restore encrypted data without a password:

1. Create a request for data restore
2. Process the request in Veeam Backup Enterprise Manager
3. Complete the key restore process
Step 1. Create Request for Data Restore

This procedure is performed by the Veeam Backup Administrator on the backup server.

1. Import encrypted backup to the Veeam Backup & Replication console.

2. Select the imported backup and click **Specify Password** on the ribbon or right-click the backup and select **Specify password**.

3. In the **Specify Password** window, click the **I have lost the password** link.

4. Veeam Backup & Replication will launch the **Encryption Key Restore** wizard. At the **Request** step of the wizard, review the generated request for data recovery. Use buttons at the bottom of the wizard to copy the request to the Clipboard or save the request to a text file.

5. Send the copied request by email or pass it in any other way to the Veeam Backup Enterprise Manager Administrator.
TIP:
You can close the Encryption Key Restore wizard on the backup server and start it anew when you receive a response from the Veeam Backup Enterprise Manager Administrator.
Step 2. Process Request in Veeam Backup Enterprise Manager

This procedure is performed by the Veeam Backup Enterprise Manager Administrator on the Veeam Backup Enterprise Manager server.

1. Copy the obtained request to the Clipboard.
2. In Veeam Backup Enterprise Manager, go to the Configuration > Key Management section.
3. Click Password Recovery at the top of the section to open the Password Recovery wizard.
4. Paste the request that you have received from the Veeam Backup Administrator. You can use the [CTRL+V] key combination or click Paste at the bottom of the wizard.
5. Follow the next steps of the wizard. At the Response step of the wizard, copy the text displayed in the wizard to the Clipboard.
6. Send the copied response by email or pass it in any other way to the Veeam Backup Administrator working on the backup server.
Step 3. Complete Key Restore Process

This procedure is performed by the Veeam Backup Administrator on the backup server.

1. In Veeam Backup & Replication, get back to the Encryption Key Restore wizard.
2. Enter the copied response to the text window at the Response step of the Encryption Key Restore wizard.
3. Follow the next steps of the wizard. At the last step, click Finish. Veeam Backup & Replication will retrieve the decrypted storage keys from the response, apply them to the encrypted file and unlock the file content.
Restoring Encrypted Data from Tapes

When you restore data from encrypted tapes, Veeam Backup & Replication performs data decryption automatically in the background or requires you to provide a password.

- If encryption keys required to unlock the tape are available in the Veeam Backup & Replication database, you do not need to enter the password to decrypt the tape. Veeam Backup & Replication uses keys from the database to unlock the encrypted tape. Data decryption is performed in the background and data restore from encrypted tapes does not differ from that from an unencrypted ones.

  Automatic tape decryption is performed if the following conditions are met:

  o You encrypt and decrypt tapes on the same Veeam backup server.
  o The tape is loaded to the tape library and information about this tape is available in the catalog.
  o The password specified in the settings of the media pool to which the tape belongs is the same as the password that was used for tape encryption.

- If encryption keys are not available in the Veeam Backup & Replication database, you can restore data from encrypted tapes with the following methods:

  o You can provide a password or a set of passwords to unlock the encrypted tape. For more information, see Decrypting Tapes with Password.
  o You can use Veeam Backup Enterprise Manager to unlock the encrypted tape without a password. For more information, see Decrypting Data Without Password.
Decrypted Tapes with Password

When you restore encrypted files or backups from tape, you need to specify a password that was used to encrypt data archived to tape.

To unlock encrypted tapes:

1. Insert encrypted tapes into the tape library.

2. Catalog the tapes so that Veeam Backup & Replication can read data archived on tape. After you perform catalogization, encrypted tapes will be displayed under the Media > Encrypted node in the corresponding tape library. On the cataloged tape, Veeam Backup & Replication displays the key icon to mark it as encrypted.

3. In the inventory pane, select the Encrypted node under Media node.

4. In the working area, select the imported tape and click Specify password on the ribbon or right-click the tape and select Specify password.

5. In the Description field of the Specify Password window, Veeam Backup & Replication displays a hint for the password that was used to encrypt the tape. Use the hint to recall the password.

6. In the Password field, enter the password for the tape.

7. If the imported tape is a part of a backup set but is not the last tape in this set, perform catalogization once again.

   When Veeam Backup & Replication creates a backup set, it writes catalog data to the last tape in this set.

      o If the imported group of tapes contains the last tape in the backup set, Veeam Backup & Replication retrieves catalog data from the last tape during the initial catalogization process (see point 2 of this procedure).

      o If the imported group of tapes does not contain the last tape in the backup set, Veeam Backup & Replication needs to additionally catalog files on imported tapes.

If you enter a correct password, Veeam Backup & Replication will decrypt the tape media. The tape will be moved under the corresponding media pool in the inventory pane. You can perform restore operations for data archived to tape as usual.

If you import a backup file from tape and the backup file was encrypted twice, with the initial backup job and with the backup to tape job, you must sequentially specify two passwords:

1. Password that was used to encrypt tapes in the media pool.

2. Password for the primary backup job.

After you enter the first password, backups from the tape will be moved under the Backup > Encrypted node in the inventory pane. You must then enter the second password to decrypt the backup and get access to its content.
**NOTE:**

If you use the Enterprise or Enterprise Plus edition of Veeam Backup & Replication and your Veeam backup servers are connected to Veeam Backup Enterprise Manager, you can recover data from encrypted tapes even if the password is lost. For more information, see [Decrypting Data Without Password](#).
Decrypting Tapes Without Password

If you have lost or forgotten a password, you can unlock encrypted tapes with the help of Veeam Backup Enterprise Manager.

You can restore data from tapes without a password only if your backup infrastructure meets the following conditions:

1. You use the Enterprise or Enterprise Plus edition of Veeam Backup & Replication.
2. Veeam backup server on which you encrypted tapes is added to Veeam Backup Enterprise Manager.
3. Veeam backup server on which you generate a request for data decryption is added to Veeam Backup Enterprise Manager.

The restore process is accomplished with the help of two wizards that run on two servers:

1. The Encryption Key Restore wizard on the Veeam backup server.
2. The Password Recovery wizard on the Veeam Backup Enterprise Manager server.

To restore encrypted data from tapes without a password:

1. Create a request for data restore.
2. Process the request in Veeam Backup Enterprise Manager.
3. Complete the key restore process.
Step 1. Create Request for Data Restore

This procedure is performed by the Veeam Backup Administrator on the Veeam backup server.

1. Import encrypted tapes to the Veeam backup server.

2. Select the imported tape and click **Specify Password** on the ribbon or right-click the tape and select **Specify password**.

3. In the **Specify Password** window, click the **I have lost the password** link.

4. Veeam Backup & Replication will launch the **Encryption Key Restore** wizard. At the **Request** step of the wizard, review the generated request for data recovery. Use buttons at the bottom of the wizard to copy the request to the Clipboard or save the request to a text file.
5. Send the copied request by email or pass it in any other way to the Veeam Backup Enterprise Manager Administrator.

TIP:
You can close the Encryption Key Restore wizard on the Veeam backup server and start it anew when you receive a response from the Veeam Backup Enterprise Manager Administrator.
Step 2. Process Request in Veeam Backup Enterprise Manager

This procedure is performed by the Veeam Backup Enterprise Manager Administrator on the Veeam Backup Enterprise Manager server.

1. Copy the obtained request to the Clipboard.
2. In Veeam Backup Enterprise Manager, go to the Configuration > Settings > Key Management section.
3. Click Password Recovery to open the Password Recovery wizard.
4. Use the [CTRL+V] key combination to paste the request that you have received from the Veeam Backup Administrator. You can also use the Import from File link to import the request from a text file.

5. Follow the next steps of the wizard. At the Response step, copy the text displayed in the wizard to the Clipboard.
6. Send the copied response by email or pass it in any other way to the Veeam Backup Administrator working on the Veeam backup server.
Step 3. Complete Key Restore Process

This procedure is performed by the Veeam Backup Administrator on the Veeam backup server.

1. In Veeam Backup & Replication, get back to the **Encryption Key Restore** wizard.
2. Enter the copied response to the text window at the **Response** step of the **Encryption Key Restore** wizard.
3. Follow the next steps of the wizard. At the last step, click **Finish**. Veeam Backup & Replication will retrieve the decrypted storage keys from the response, apply them to the encrypted tape and unlock the tape content.
NAS Backup Support

With Veeam Backup & Replication you can easily back up and restore content of various NAS file shares. The solution can be flexibly scaled to reliably protect massive amounts of data, even for the largest of enterprise organizations.

To protect your NAS file shares, you can use your existing Veeam Backup & Replication infrastructure. Just configure the following components:

- **File share**
- **File proxy**
- **Cache repository**
- **Storage repositories**

For system requirements for NAS backup components, see [System Requirements](#).

To learn how NAS backup components interact during file share backup, see [How File Share Backup Works](#).

### File Share

A file share is a storage device or data source available to multiple hosts through a computer network. For supported file shares, see [Platform Support](#).

File share backup jobs in Veeam Backup & Replication can read data from the following sources:

- CIFS path
- NFS path
- Path to the storage snapshot folder
- VSS snapshot
NOTE:

Reading from VSS snapshots is available only if the following conditions are met:

- The source file share is running on the machine with SMB v3 feature enabled.
- The file proxy role is assigned to the machine running Microsoft Windows Server 2012 R2 or later with SMB v3 feature enabled.

To learn how to add NAS file shares to the backup infrastructure, see Adding File Share.

File Proxy

A file proxy is an architecture component that sits between the file share and other components of the backup infrastructure. The file proxy operates as a data mover that transfers data between the source file share and the backup repository. The file proxy processes jobs and delivers backup and restore traffic.

You can assign the role of a file proxy to any Windows-managed server added to your Veeam Backup & Replication infrastructure. By default, this role is assigned to the backup server. But this option is sufficient only for small installations where all components are located in the same network segment. For larger installations with larger workload, assign the role of a file proxy to a dedicated server, as described in Adding File Proxy. After that, choose this file proxy to process the backup traffic from file shares, as described in Adding NFS File Share and Adding SMB File Share.

To optimize performance of several concurrent tasks, you can use several file proxies. In this case, Veeam Backup & Replication will distribute the backup or restore workload between available file proxies on per-task basis, taking into account proxy connectivity and their current load. You can deploy file proxies both in the primary site and in remote sites.

Cache Repository

A cache repository is a storage location where Veeam Backup & Replication keeps temporary metadata and uses it to reduce the load on the file share during the backup procedure. The cache repository keeps track of all objects that have changed between each backup session. This allows performing incremental backups from the file share super fast and very efficiently.

You can assign the role of a cache repository to a simple backup repository added to the Veeam Backup & Replication infrastructure. To assign this role, select the backup repository as a cache repository, as described in Specify File Share Processing Settings.

To minimize the network load during backup, locate the cache repository closer to the file share in the computer network: at the best they should be one hop away from each other.

Storage Repositories

A backup repository is a main storage location where Veeam Backup & Replication keeps all versions of backed up files for the configured period and metadata files. Backups stored in the backup repository can be used to quickly restore the entire file share to the state as of a specific restore point.

[Optional] If you want to retain specific files for a longer period of time, you can use cheaper devices for archive purposes. To enable file archiving, configure Veeam Backup & Replication to move backup files and metadata files from the backup repository to an archive repository. By default, usage of the archive repository is disabled and, after the retention period for the backup repository is over, backup files are deleted.
[Optional] If you want to store a copy of the file share backup in a different repository, you can configure a secondary repository where Veeam Backup & Replication will copy all backups created in the backup repository. The secondary repository can have its own retention policy and encryption settings. By default, no secondary repository is configured.

The table below describes which roles can be assigned to the different storage types.

<table>
<thead>
<tr>
<th>Storage Type</th>
<th>Backup Repository</th>
<th>Archive Repository</th>
<th>Secondary Repository</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows server</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Linux server</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>CIFS (SMB) share ¹</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>NFS share</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Dell EMC Data Domain</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>ExaGrid</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Quantum DXi</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>HPE StoreOnce ²</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scale-out backup repository (SOBR) ³</td>
<td>●</td>
<td>○</td>
<td>●</td>
</tr>
<tr>
<td>Object storage repository ⁴</td>
<td>○</td>
<td>●</td>
<td>○</td>
</tr>
<tr>
<td>Repository with rotated drives</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Veeam Cloud Connect repository</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

¹ If you use a Dell EMC Isilon storage system in the CIFS Share Access mode, make sure that you have assigned your service account to the built-in BackupAdmin role within Isilon. Otherwise, the access to the share will be denied.

² If you plan to use HPE StoreOnce storage appliances added via SMB, NFS, or Catalyst, mind that due to performance considerations the vendor recommends to use the repository of this type to store up to 1,000,000 backup files per storage system including different versions of files and not more than 10 TB of backup data.

³ The object storage repository added as a Capacity Tier in SOBR is not used for storing NAS backups. To archive NAS backup files to an object storage repository, assign it as an archive repository when creating a file share backup job.

⁴ You can create two object storage repositories pointing to the same folder/bucket and use these repositories for storing both NAS backups and Capacity Tier backups at the same time. However, these object storage repositories (mapped to the
same cloud folder) must not be used across multiple Veeam Backup & Replication servers for the same purposes as it leads to unpredictable system behavior and inevitable data loss.

Deployment of Backup, Archive and Secondary Repositories

To use a storage, which is already added to the Veeam Backup & Replication Backup Infrastructure, to store file share backups, define it as a target storage when creating a file share backup job:

- Configure the backup repository and the archive repository as described in Define Target Backup Storage Settings.
- Configure the secondary repository as described in Specify Secondary Repository.

If the required storage is not added as a backup repository in your Veeam Backup & Replication Backup Infrastructure, add it as described in Adding Backup Repositories.

Data Structure in Backup, Archive and Secondary Repositories

Backup, archive and secondary repositories store file share backups as objects in VBLOB files (up to 64 MB each) of unstructured data. They also store metadata about the original files and folders on the file share and their structure.

When you run the file share backup job for the first time, Veeam Backup & Replication creates a full backup for all files and folders of the file share. During subsequent backup job sessions, Veeam Backup & Replication copies only files and folders that have changed since the last backup job session.

Although the file share backup job first creates a full backup and afterwards incremental backups, Veeam Backup & Replication does not create a separate file for each backup job run as it does during VM backup. Instead of this, it consistently creates multiple VBLOB files accompanied by metadata files that track all the changes on the file share.
How File Share Backup Works

Veeam Backup & Replication performs file share backup to the backup storage in the following way:

1. When a new backup job session starts, Veeam Backup & Replication assigns a file proxy to process the file share data.
2. The file proxy enumerates files and folders on the file share and creates a cyclic redundancy check (CRC) tree.
3. The file proxy transfers the CRC tree to the cache repository.
4. The cache repository saves the CRC tree.
   - When the cache repository receives a new CRC tree structure from the proxy, it compares it with the CRC tree created during the previous run of the backup session. If any files or folders of the file share have changed since the previous backup session run, the cache repository instructs the file proxy to start reading changed data from the source file share.
5. The file proxy reads new data from the file share.
6. The file proxy creates data packages and transfers them to the target backup repository.
   - Data packages comprise backup data files (each 64 Mb in size) and metadata files that contain names and versions of backup files and allocation of data in backup files.
7. Veeam Backup & Replication checks file versions in the backup repository against retention settings and moves backup data from the backup repository to the archive repository if necessary.

Retention Scenarios

There can be a number of backup retention scenarios depending on the configuration of backup and archive repositories. Below you can find example cases that illustrate NAS backup retention with different settings.
Case 1

Only 1 file version is created. The file does not change.

File version 1 remains in the backup repository and is not moved to the archive repository even if it is enabled and configured.

<table>
<thead>
<tr>
<th>Backup repository</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>File v1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Day 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Case 2

Retention for the backup repository is set to 5 days. No archive repository is configured. The file changes once a day. The backup is performed once a day.

On day 6, file version 6 is added to the backup repository, file version 1 is deleted by retention.

<table>
<thead>
<tr>
<th>Backup repository</th>
<th>File v1</th>
<th>File v2</th>
<th>File v3</th>
<th>File v4</th>
<th>File v5</th>
<th>File v6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Case 3

Retention for the backup repository is set to 3 days. The file changes every hour. The backup is performed 2 times a day.

On day 4, versions 7 and 8 are added to the backup repository, file versions 1 and 2 added to the backup repository on day 1 are deleted by retention.

<table>
<thead>
<tr>
<th>Backup repository</th>
<th>File v1</th>
<th>File v2</th>
<th>File v3</th>
<th>File v4</th>
<th>File v5</th>
<th>File v6</th>
<th>File v7</th>
<th>File v8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Day 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Day 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Day 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Case 4

Retention for the backup repository is set to 3 days. The file changes once a day.
On day 3, the source file is deleted from the source share, the backup repository considers file version created on this day as deleted.

![Backup repository diagram]

On day 4, the backup repository still detects the file as deleted, file version 1 is deleted from the backup repository by retention.

![Backup repository diagram]

On day 5, the backup repository still detects the file as deleted, file version 2 is deleted from the backup repository by retention.

![Backup repository diagram]

Thus, no file versions are stored in the backup repository for this file any longer.

**Case 5**

Retention for the backup repository is set to 5 days. The archive repository is enabled with default settings. The file changes every day. The backup is performed once a day.
On day 6, file version 6 is added to the backup repository, file version 1 is moved to the archive repository by retention.

**Case 6**

Retention for the backup repository is set to 3 days. The archive repository is enabled with DOCX files to be excluded from archiving. The files change once a day. The backup is performed once a day.

On day 4, file versions created on day 1 are removed from the backup repository. File version 1 for DOCX file is deleted, file version 1 for XLSX file (non-DOCX) is moved to the archive repository.

**Case 7**

Retention for the backup repository is set to 4 days. The archive repository is enabled and configured to keep 3 versions of active files and 2 versions of deleted files.
On day 8, file version 8 is added to the backup repository, file version 4 is moved from the backup repository to the archive repository to keep file versions for 4 days, file version 1 is deleted from the archive repository to keep 3 file versions of the active file (versions 2, 3, 4).

On day 9, the file is removed from the source, file version 9 (denoting the missing file) is added to the backup repository, file version 5 is moved from the backup repository to the archive repository, file versions 2 and 3 are deleted from the archive repository to keep 2 file versions of the deleted file (versions 4 and 5).

On day 10 and 11, file versions 6 and 7 are successively moved from the backup repository to the archive repository. File versions 4 and 5 are deleted from the archive repository.
On day 12, file version 8 (the last file version) is moved from the backup repository to the archive repository, file version 6 is deleted from the archive repository. After that, versions 7 and 8 are stored in the archive repository further on.
Adding File Share

You must add to the backup infrastructure file shares that you plan to use as sources for backup. You can add file shares of the following types:

- Windows-managed or Linux-managed server
- NFS file share
- SMB file share
Adding Managed Server File Share

Before you add a Windows- or Linux-managed server as a file share to the inventory of the virtual infrastructure, check the following prerequisites:

- This server meets system requirements.
- You have this server added in Backup Infrastructure.
  For more information on how to add servers, see Adding Microsoft Windows Servers and Adding Linux Servers.
- If you plan to use a devoted file proxy server or cache repository, make sure these components are added in Backup Infrastructure.
Step 1. Launch New File Share Wizard

To launch the **New File Share** wizard:

1. Open the **Inventory** view.
2. Do one of the following:
   - In the inventory pane, right-click the **File Shares** node and select **Add File Share**.
   - Select the **File Shares** node and click **Add File Share** on the ribbon.
   - Select the **File Shares** node and click **Add File Share** in the working area.
3. In the **Add File Share** window, click **File server**.

---

Add File Share

Select the type of a file share you want to add to inventory.

- **File server**
  Adds a managed Windows or Linux server. This is the recommended way to access files and file shares hosted on regular servers, as opposed to NAS devices.

- **NFS share**
  Adds an NFS file share hosted on a NAS device. Supported NFS protocol versions are 3.0 and 4.1.

- **SMB share**
  Adds an SMB (CIFS) file share hosted on a NAS device. Backup from Microsoft VSS snapshots requires SMB protocol version 3.0 or later.
Step 2. Add Managed Server as File Server

At the File Server step of the wizard, choose the server, which you want to use as a file share server. Select it from the Managed Server drop-down list.

**NOTE:**
If you plan not only to back up the Linux-managed file share, but also to restore files to it, use an account with root access when adding the server to the backup infrastructure.

If the drop-down list does not display the required server, you must add it to the backup infrastructure. To add the server, do the following:

1. Click Add New.
2. Select New Windows Server or New Linux Server.
3. Add a new Windows or Linux server to the backup infrastructure as described in Adding Microsoft Windows Servers and Adding Linux Servers.
4. Select the newly added server from the Managed Server drop-down list.
Step 3. Specify File Share Processing Settings

At the **Processing** step of the wizard, do the following:

1. From the **Cache repository** drop-down list, select a cache repository where temporary cache files must be stored. This repository must be located as close to the source file share as possible.

2. Use the **Backup I/O control** slider to define how fast the file proxy can read data from the source file share. This setting is based on the number of parallel threads that can be used by the proxy configured for processing the file share. If resources of your NAS device are limited, it is recommended that you select the **Lower impact** option. If your NAS device is powerful enough, select the **Faster backup** option.

3. Click **Next** to save the configure settings.
Step 4. Review Components to Install

At the **Review** step of the wizard, review what Veeam Backup & Replication components are already installed on the server and click **Apply** to start installation of missing components.

```
<table>
<thead>
<tr>
<th>Component name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport</td>
<td>already exists</td>
</tr>
<tr>
<td>Veeam Backup VSS Integration</td>
<td>already exists</td>
</tr>
</tbody>
</table>
```
Step 5. Apply File Share Settings

At the **Apply** step of the wizard, wait till Veeam Backup & Replication installs and configures all required components. Click **Next** to complete the procedure of the file share role assignment to the managed file server.
Step 6. Finish Working with Wizard

At the **Summary** step of the wizard, review details of the file server added as a file share and click **Finish to exit the wizard**.

![Summary step of the wizard](image)
Adding NFS File Share

Before you add an NFS file share to the inventory of the virtual infrastructure, check the following prerequisites:

- The file share meets system requirements.
- If you plan to use a devoted file proxy server or cache repository, make sure these components are added in Backup Infrastructure.
Step 1. Launch New File Share Wizard

To launch the **New File Share** wizard:

1. Open the **Inventory** view.
2. Do one of the following:
   - In the inventory pane, right-click the **File Shares** node and select **Add File Share**.
   - Select the **File Shares** node and click **Add File Share** on the ribbon.
   - Select the **File Shares** node and click **Add File Share** in the working area.
3. In the **Add File Share** window, click **NFS share**.

### Add File Share

Select the type of a file share you want to add to inventory.

- **File server**
  Adds a managed Windows or Linux server. This is the recommended way to access files and file shares hosted on regular servers, as opposed to NAS devices.

- **NFS share**
  Adds an NFS file share hosted on a NAS device. Supported NFS protocol versions are 3.0 and 4.1.

- **SMB share**
  Adds an SMB (CIFS) file share hosted on a NAS device. Backup from Microsoft VSS snapshots requires SMB protocol version 3.0 or later.
Step 2. Specify Path to NFS File Share

At the NFS File Share step of the wizard, specify the path to an NFS file share in the server:/folder format.
Step 3. Specify Advanced NFS File Share Settings

You can instruct Veeam Backup & Replication to back up data from native storage snapshots. During backup jobs, Veeam Backup & Replication will read data of shared files and folders from snapshots, which speeds up backup operations and improves RPOs.

To define if Veeam Backup & Replication will use snapshots for backups:

1. At the **NFS File Share** step of the wizard, click **Advanced**.
2. In the **Advanced** window, select one of the following options:
   - To ignore the snapshot functionality, select **Backup directly from the file share**. Veeam Backup & Replication will ignore locked files and folders. When creating a backup job, you can configure notifications to list files and folders that are skipped during the backup procedure. For more information see **Notification Settings**.
   - To back up files from the native storage snapshot, select **Backup from a native storage snapshot at the following path** and specify the path in the `server:/folder` format to the folder on the NFS file share where the file share snapshot is saved.
     
     If you select this option, you can additionally use custom scripts written by you, for example, to create a snapshot before the backup and remove it after the backup. You can define these scripts when creating a new file share backup job, as described in **Script Settings**.

   **NOTE:**

   Mind that Veeam Backup & Replication does not take snapshots itself, but it can use a snapshot taken by the storage system.

   File share backup jobs do not trigger the storage snapshot creation and deletion automatically. You can specify the folder where the storage snapshot is stored. In this case file share backup jobs can access this folder and read data from the storage snapshot.
3. Select **Failover to direct backup if a snapshot is not available** if you want Veeam Backup & Replication to read data for backup directly from the file share when the snapshot is unavailable. If you do not select the option and the snapshot is unavailable, the file share backup job will stop with a failure.
Step 4. Specify File Share Processing Settings

At the Processing step of the wizard, do the following:

1. Click Choose next to the File proxy field to select a file proxy.

2. In the File Proxy window, select backup proxy servers:
   - If you select All proxies, Veeam Backup & Replication will use all available file proxies for file backup. The number of proxies in use defines the number of data threads that transfer data from the file share to the backup repository. The more data transfer threads Veeam Backup & Replication uses, the higher is the data transfer speed.
   - If you select Use the selected file proxies only, you can explicitly specify file proxies that Veeam Backup & Replication must use for file backup. It is recommended that you select at least two file proxies to ensure that the backup jobs start even if one of the proxies fails or loses its connectivity to the source file share. The more proxies you select, the more data transfer threads Veeam Backup & Replication will use for backup jobs, thus improving performance.

If the file share is used as a source for a file to tape backup job, the tape server utilized for this job is added as yet another file proxy when creating a file to tape backup job. This file proxy has the highest priority over all others and is used by default if it has access rights to the file share, no matter what option is selected in the File Proxy window. For details on file backup to tape, see File Backup to Tape.

3. From the Cache repository drop-down list, select a cache repository where temporary cache files must be stored. This repository must be located as close to the source file share as possible.

4. Use the Backup I/O control slider to define how fast all proxies can read data from the source file share. This setting is based on the number of parallel threads that can be used by all the proxies configured for processing the file share. If resources of your NAS device are limited, it is recommended that you select the Lower impact option. If your NAS device is powerful enough, select the Faster backup option.
5. Click **Apply** to save the configured settings.

---

![New File Share dialog box](image)
Step 5. Apply File Share Settings

At the **Apply** step of the wizard, wait till Veeam Backup & Replication installs and configures all required components and adds the NFS file share to the backup infrastructure. Click **Next** to proceed.
Step 6. Finish Working with Wizard

At the **Summary** step of the wizard, review details of the added NFS share and click **Finish** to exit the wizard.
Adding SMB File Share

Before you add an SMB file share to the inventory of the virtual infrastructure, check the following prerequisites:

- The file share meets system requirements.
- If you plan to use a devoted file proxy server or cache repository, make sure these components are added in Backup Infrastructure.
Step 1. Launch New File Share Wizard

To launch the **New File Share** wizard:

1. Open the **Inventory** view.
2. Do one of the following:
   - In the inventory pane, right-click the **File Shares** node and select **Add File Share**.
   - Select the **File Shares** node and click **Add File Share** on the ribbon.
   - Select the **File Shares** node and click **Add File Share** in the working area.
3. In the **Add File Share** window, click **SMB share**.

---

Add File Share

Select the type of a file share you want to add to inventory.

- **File server**
  Adds a managed Windows or Linux server. This is the recommended way to access files and file shares hosted on regular servers, as opposed to NAS devices.

- **NFS share**
  Adds an NFS file share hosted on a NAS device. Supported NFS protocol versions are 3.0 and 4.1.

- **SMB share**
  Adds an SMB (CIFS) file share hosted on a NAS device. Backup from Microsoft VSS snapshots requires SMB protocol version 3.0 or later.
Step 2. Specify Path to SMB File Share and Access Credentials

At the **SMB File Share** step of the wizard, specify access settings for the SMB file share:

1. In the **Shared folder** field, specify the path to an SMB file share in the `\server\folder` format. You can also click **Browse** and select the shared folder from the list of available network shares.

2. If you must specify user credentials to access the shared folder, select the **This share requires access credentials** check box. From the **Credentials** drop-down list, select a credentials record for a user account that has **Full Control** permissions on the shared folder.

   To access the SMB share, you must use an account that meets either of the following requirements:
   - If you only plan to back up the share, you can use an account with read-only permissions.
   - If you plan not only to back up the share, but also to restore files to it, use an account with read/write permissions.

   **NOTE:**

   Accessing the SMB file share with credentials in the User Principal Name format (`user@domain.xxx`) is not supported.

   If you have not set up credentials beforehand, click the **Manage accounts** link at the bottom of the list or click **Add** on the right to add the credentials. For more information, see **Managing Credentials**.

   **NOTE:**

   If the **This share requires access credentials** check box is not selected, to access the file share Veeam Backup & Replication uses the computer account of the file proxy server.
Step 3. Specify Advanced SMB File Share Settings

You can instruct Veeam Backup & Replication to back up data from Microsoft VSS snapshots or native storage snapshots. During backup jobs, Veeam Backup & Replication will read data of shared files and folders from snapshots, which speeds up backup operations and improves RPOs.

To define if Veeam Backup & Replication will use snapshots for backups:

1. At the SMB File Share step of the wizard, click Advanced.
2. In the Advanced window, select one of the following options:
   - To ignore the snapshot functionality, select Backup directly from the file share. Veeam Backup & Replication will ignore locked files and folders. When creating a backup job, you can configure notifications to list files and folders that are skipped during the backup procedure. For more information see Notification Settings.
   - To back up files from Microsoft VSS snapshots, select Backup from Microsoft VSS snapshot. If you select this option, make sure that the file share and the file proxy used for the file backup job support SMB protocol version 3.0 or later.
   - To back up files from the native storage snapshot, select Backup from a native storage snapshot at the following path and specify the path in the \|server\|folder format to the folder on the SMB file share where the file share snapshot is saved.
     - If you select this option, you can additionally use custom scripts written by you, for example, to create a snapshot before the backup and remove it after the backup. You can define these scripts when creating a new file share backup job, as described in Script Settings.

NOTE:

Mind that Veeam Backup & Replication does not take snapshots itself, but it can use a snapshot taken by the storage system.

File share backup jobs do not trigger the storage snapshot creation and deletion automatically. You can specify the folder where the storage snapshot is stored. In this case file share backup jobs can access this folder and read data from the storage snapshot.
3. Select **Failover to direct backup if snapshot is unavailable** if you want Veeam Backup & Replication to read data for backup directly from the file share when the snapshot is unavailable. If you do not select the option and the snapshot is unavailable, the file share backup job will stop with a failure.
Step 4. Specify File Share Processing Settings

At the **Processing** step of the wizard, do the following:

1. Click **Choose** next to the **File proxy** field to select a file proxy.
2. In the **File Proxy** window, select backup proxy servers:
   - If you select **All proxies**, Veeam Backup & Replication will use all available file proxies for file backup. The number of proxies in use defines the number of data threads that transfer data from the file share to the backup repository. The more data transfer threads Veeam Backup & Replication uses, the higher is the data transfer speed.
   - If you select **Use the selected file proxies only**, you can explicitly specify file proxies that Veeam Backup & Replication must use for file backup. It is recommended that you select at least two file proxies to ensure that the backup jobs start even if one of the proxies fails or loses its connectivity to the source file share. The more proxies you select, the more data transfer threads Veeam Backup & Replication will use for backup jobs, thus improving performance.

   If the file share is used as a source for a file to tape backup job, the tape server utilized for this job is added as yet another file proxy when creating a file to tape backup job. This file proxy has the highest priority over all others and is used by default if it has access rights to the file share, no matter what option is selected in the **File Proxy** window. For details on file backup to tape, see File Backup to Tape.

3. From the **Cache repository** drop-down list, select a cache repository where temporary cache files must be stored. This repository must be located in the close proximity to the source file share and file proxies.
4. Use the **Backup I/O control** slider to define how fast all proxies can read data from the source file share. This setting is based on the number of parallel threads that can be used by all the proxies configured for processing the file share. If resources of your NAS device are limited, it is recommended that you select the **Lower impact** option. If your NAS device is powerful enough, select the **Faster backup** option.
5. Click **Apply** to save the configured settings.
Step 5. Apply File Share Settings

At the **Apply** step of the wizard, wait till Veeam Backup & Replication installs and configures all required components and adds the SMB file share to the backup infrastructure. Click **Next** to proceed.

![New File Share](image)

At the **Apply** step, Veeam Backup & Replication waits while required components are installed and configured, which may take a few minutes.

**Message:**
- Starting infrastructure item update process
- Creating database records for server

**Duration:** 0:00:03
Step 6. Finish Working with Wizard

At the **Summary** step of the wizard, review details of the added SMB share and click **Finish** to exit the wizard.
Adding File Proxy

You must add to the backup infrastructure one or more file proxies that you plan to use for moving backup data from the file share to the backup repository.

Before you add a file proxy to the inventory of the virtual infrastructure, check the following prerequisites:

- The file share meets system requirements.
- The file proxy is a Windows-managed server.
Step 1. Launch New File Proxy Wizard

To launch the New File Proxy wizard, do one of the following:

- Open the Backup Infrastructure view, in the inventory pane select the Backup Proxies node, click Add Proxy on the ribbon and select File share.

- Open the Backup Infrastructure view, in the inventory pane right-click the Backup Proxies node and select Add file backup proxy.
Step 2. Choose Microsoft Windows Server

At the Server step of the wizard, specify server settings for the file proxy.

1. From the Choose server list, select a Microsoft Windows server that you want to use as a file proxy.
   
   The list of servers contains only those managed servers that are added to the backup infrastructure. If the server is not added to the backup infrastructure yet, you can click Add New to open the New Windows Server wizard. For more information, see Adding Microsoft Windows Servers.

2. In the Proxy description field, provide a description for future reference. The default description contains information about the user who added the file proxy, date and time when the file proxy was added.

3. In the Max concurrent tasks field, specify the number of tasks that the file proxy can process in parallel.
   
   If the number of parallel tasks reaches this value, the file proxy will not start a new task until one of current tasks completes. Veeam Backup & Replication creates one task per every source file share. The recommended number of concurrent tasks is calculated automatically based on the amount of available resources. File proxies with multi-core CPUs can handle more concurrent tasks.
   
   For example, for a 4-core CPU, it is recommended that you specify a maximum of 4 concurrent tasks, for an 8-core CPU — 8 concurrent tasks. When defining the number of concurrent tasks, keep in mind network traffic throughput in the virtual infrastructure.
Step 3. Configure Traffic Rules

At the Traffic Rules step of the wizard, configure network traffic rules. These rules help you throttle and encrypt traffic transferred between backup infrastructure components. For more information, see Configuring Network Traffic Rules.

The list of network traffic rules contains only rules applied to the file proxy: its IP address falls into the IP range configured for the rule.

To view settings configured for the rule:

1. Select the rule in the list.
2. Click View. The View Network Traffic Rule window will display settings configured for the rule.

To modify network traffic settings:

1. Click the Manage network traffic rules link.
2. The Global Network Traffic Rules window will display the full list of all existing global network traffic rules.
3. Select the rule that you want to modify and click Edit. For more information on how to configure network traffic rules, see Configuring Network Traffic Rules.
Step 4. Review Components to Install

At the **Review** step of the wizard, review what Veeam Backup & Replication components are already installed on the server and click **Apply** to start installation of missing components.

![New File Proxy dialog box](image)

### Review

Please review the settings and click **Apply** to continue.

<table>
<thead>
<tr>
<th>Server</th>
<th>File proxy settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Server name: proxy01tech.local</td>
</tr>
<tr>
<td></td>
<td>Server type: Microsoft Windows Server</td>
</tr>
<tr>
<td></td>
<td>Cores: 2</td>
</tr>
<tr>
<td></td>
<td>Max tasks: 2</td>
</tr>
</tbody>
</table>

**The following components will be processed:**

<table>
<thead>
<tr>
<th>Component name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport</td>
<td>already exists</td>
</tr>
<tr>
<td>Veeam Backup VSS Integration</td>
<td>will be installed</td>
</tr>
</tbody>
</table>
Step 5. Apply File Proxy Settings

At the **Apply** step of the wizard, wait till Veeam Backup & Replication installs and configures all required components. Click **Next** to complete the procedure of the file proxy role assignment to the server.
Step 6. Finish Working with Wizard

At the **Summary** step of the wizard, review details of the added file proxy and click **Finish** to exit the wizard.
Creating File Share Backup Jobs

To protect files and folders on the file share, you must configure a file share backup job. The backup job defines how, where and when to back up data from the file share. One job can be used to process one or more file shares. Jobs can be started manually or scheduled to run automatically at a specific time.

Before you create a file share backup job, check prerequisites.
Before You Begin

Before you create a file share backup job, check the following prerequisites:

- Backup infrastructure components that will take part in the file share backup process must be added to the backup infrastructure and properly configured. These include source file shares to back up, file proxy, and all repositories, including cache, backup and archive repositories.

- The target backup repository must have enough free space to store created backup files. If you want to receive notifications on the repository running low on free space, configure global notification settings as described in Specifying Other Notification Settings.

- If you plan to map a file share backup job to a backup that already exists in the backup repository, you must perform the rescan operation for this backup repository. Otherwise, Veeam Backup & Replication will not be able to recognize backup files in the backup repository.

  For more information on how to rescan backup repositories, see Rescanning Backup Repositories.

- If you plan to use pre-job and/or post-job scripts, you must create scripts before you configure the file share backup job.

Antivirus software may significantly slow down file share backup jobs. To improve performance, we recommend you exclude the `c:\Program Files (x86)\Veeam\Backup Transport\x64\VeeamAgent.exe` process from the antivirus scan on machines running the file backup proxy and backup repository roles. Keep in mind that it can weaken the security of these machines.
Step 1. Launch New File Backup Job Wizard

To launch the New File Share Backup Job wizard, do one of the following:

- On the Home tab, click Backup Job > File Share.
- Open the Inventory view. In the inventory pane, click File Shares. In the working area, click Create Job.
- Open the Home view. In the inventory pane, right-click Jobs and select Backup > File Share.
- You can quickly add the file share to an already existing job. Open the Inventory view. Under the File Shares node in the inventory pane, select type of the file share you want to back up. In the working area, right-click the file share you want to back up and select Add to backup job > name of the job.
Step 2. Specify Job Name and Description

At the **Name** step of the wizard, specify a name and description for the file share backup job.

1. In the **Name** field, enter a name for the file share backup job.

2. In the **Description** field, provide a description for future reference. The default description contains information about the user who created the job, date and time when the job was created.
Step 3. Select Files and Folders to Back Up

At the **Files and Folders** step of the wizard, select files and folders that you want to back up.

1. Click **Add**.
2. From the **Server** list, select a file share on which the necessary files or folders reside.
3. In the **Folders** tree, select folders you want to backup.

   To select multiple folders, hold [Ctrl] and click necessary folders. Although different folders of the same share form separate records in the table, they will be processed by one job task.

   Mind the following:
   
   - Hard links in file shares are protected with content included.
   - Backup of symbolic links in file shares is supported for managed server and SMB file shares: they are backed up as links, without the content they refer to. For NFS file shares, symbolic links are skipped from processing.

4. In the **Files and Folders** screen, use the **Up** and **Down** buttons on the right to move sources up or down. The sources of the job are processed in the order in which the list displays them.

5. If you add a folder to the job, all the folder contents will be processed.

   If necessary, you can choose only specific files from the added folder. To do so, select a folder in the list and click **Advanced**. In the **File Filters** window, use **Include masks** and **Exclude masks** fields to filter the folder contents. You can use exact file names or create name masks (for example, *.*EVT or *.*PDF).

   You can exclude a certain folder from the backup. To do so, specify the path to such a folder in the **Exclude masks** field and click **Add** to add the path to the list of exclusions.
Step 4. Define Target Backup Storage Settings

At the Storage step of the wizard, define the backup and archive repositories where the file share backup job must store backup files, and settings for moving files and folders to these repositories.

NOTE:
To learn what storage types you can assign the role of the backup or archive repository to, see NAS Backup Support.

1. From the Backup repository drop-down list, select a repository where backup files must be stored. When you select a backup repository, Veeam Backup & Replication automatically checks the amount of free space left. Make sure that you have enough free space to store backups.

2. You can map the job to a specific backup stored in the backup repository. Backup job mapping allows you to move backup files to a new backup repository and to point the job to existing backups on this new backup repository. You can also use backup job mapping if the configuration database got corrupted and you need to reconfigure backup job settings.

   To map the job to a backup, click the Map backup link. In the opened Select Backup window, select a backup in the backup repository. Backups can be easily identified by job names. To find the backup, you can also use the search field at the bottom of the window.

3. Use the Keep all file versions for the last field to specify how long copies of all recent file versions in the selected file share must be kept in the backup repository. You can restore the entire file share to any restore point within the period specified in this setting.

   If, for example, Keep all file versions for the last is set to 30 days, the backup repository will store all file versions that appeared at the file share during the last 30 days. At the scheduled time on the 31st day, the file share backup job first backs up new file versions and saves them to the backup repository. Right after that, file versions older than 30 days (created on the 1st day) are either deleted from the backup repository or moved to the archive repository if the Keep previous file version for check box is selected and the archive retention is configured.

4. If you need to keep versions of some files for a longer time after they are moved from the backup repository, you can configure archiving options to move file versions to a cheaper archive storage, for example, an object storage.

   To use the archive repository, select the Keep previous file versions for check box. In the fields on the right, specify the number of months or years during which backup files must be retained.

   This setting denotes a time period starting from the creation of the backup files in the backup repository, not from the moment when the file versions are moved from the backup repository to the archive repository.

5. In the Archive repository drop-down list, select the storage to be used as a repository to store archived files and folders.

   By default, all files deleted from the backup repository will be moved to the archive repository. If you do not need all the files in the archive, you can choose what files to keep.

6. To specify what files must be archived or excluded from the archive, do the following:

   a. Click Choose to open the File Archive Settings window.

   b. Under Limit number of file versions to keep, specify how many file versions must be archived:

      ▪ Active file versions to keep — select this check box to archive files currently existing in the source file share. Specify how many recent versions of active files copied from the backup repository to store in the archive repository.
**Deleted file versions to keep** — select this check box to keep in the archive files deleted from the source file share. Specify how many latest versions of deleted files copied from the backup repository to store in the backup repository.

c. Under **Files to archive**, specify what files must be archived:

- **All files** — select this option to archive all files moved from the backup repository to the archive repository.

- **All files except the following extensions** — select this option to exclude files with certain extensions from the selection to be archived. Specify extensions for files to exclude from the selection. Files with the specified extensions will not be copied from the backup repository to the archive repository.

- **Files with the following extensions only** — select this option to archive files with certain extensions only. Specify extensions for files to archive. Files with these extensions will be copied from the backup repository to the archive repository.
Step 5. Specify Advanced Backup Settings

At the Storage step of the wizard, specify advanced settings for the file share backup job:

- ACL handling settings
- Storage settings
- Maintenance settings
- Notification settings
- Script settings

**TIP:**
After you specify necessary settings for the backup job, you can save them as default settings. To do this, click *Save as Default* at the bottom left corner of the Advanced Settings window. When you create a new backup job, Veeam Backup & Replication will automatically apply the default settings to the new job.

**ACL Handling Settings**

To specify how the backup job will process permissions and attributes:

1. At the Storage step of the wizard, click *Advanced*.
2. On the ACL Handling tab, specify how the backup job will process permissions and attributes:
   - Select *Folder-level only (recommended)* to back up permissions and attributes from folders only. The restored files will inherit permissions from the target folder.
Select **Files and folders (slower)** to back up permissions and attributes from both folders and individual files. This option can significantly reduce the backup performance.

### Storage Settings

To specify advanced storage settings for the file share backup job:

1. **At the Storage step of the wizard, click Advanced.**

2. **On the Storage tab, specify data reduction and encryption settings:**
   - **From the Compression level list,** select a compression level for the backup: None, Dedupe-friendly, Optimal, High or Extreme.
   - **To encrypt the content of backup files,** select the Enable backup file encryption check box. In the Password field, select a password that you want to use for encryption. If you have not created the password beforehand, click Add or use the Manage passwords link to specify a new password. For more information, see Managing Passwords for Data Encryption.

   If the backup server is not connected to Veeam Backup Enterprise Manager and does not have the Enterprise or Enterprise Plus license installed, you will not be able to restore data from encrypted backups in case you lose the password. Veeam Backup & Replication will display a warning about it. For more information, see Decrypting Data Without Password.
NOTE:
If you enable encryption for an existing backup job, during the next job session Veeam Backup & Replication will back up all the files of the file share to a new backup file irrespective of whether they changed or not. The created backup files and subsequent backup files will be encrypted with the specified password.

If you enable encryption for an existing job, Veeam Backup & Replication does not encrypt the previous backup chain created with this job.

Maintenance Settings
You can instruct Veeam Backup & Replication to periodically perform a health check for the latest restore point in the backup chain. The health check helps make sure that the restore point is consistent, and you will be able to restore data from this restore point.

During the health check, Veeam Backup & Replication performs a CRC check for metadata and a hash check for data blocks in the file share backup files to verify their integrity. For more information, see Health Check for File Share Backup Files.

To configure the health-check settings for the backup job:
1. At the Storage step of the wizard, click Advanced.
2. On the Maintenance tab, enable the Perform backup files health check check box to ensure that all data and metadata is backed up correctly.
3. Specify the time schedule for the health check.

Notification Settings

To specify notification settings for the backup job:

1. At the Storage step of the wizard, click Advanced.
2. Click the Notifications tab.
3. Select the Send SNMP notifications for this job check box if you want to receive SNMP traps when the job completes successfully.
   SNMP traps will be sent if you specify global SNMP settings in Veeam Backup & Replication and configure software on recipient’s machine to receive SNMP traps. For more information, see Specifying SNMP Settings.
4. Select the Send email notifications to the following recipients check box if you want to receive notifications about the job completion status by email. In the field below, specify recipient’s email address. You can enter several addresses separated by a semicolon.
   Email notifications will be sent if you configure global email notification settings in Veeam Backup & Replication. For more information, see Configuring Global Email Notification Settings.
5. You can choose to use global notification settings or specify custom notification settings:
   o To receive a typical notification for the job, select Use global notification settings. In this case, Veeam Backup & Replication will apply to the job global email notification settings specified for the backup server. For more information, see Configuring Global Email Notification Settings.
   o To configure a custom notification for the job, select Use custom notification settings specified below. You can specify the following notification settings:
i. In the **Subject** field, specify a notification subject. You can use the following variables in the subject: %Time% (completion time), %JobName%, %JobResult%, %ObjectCount% (number of file shares in the job) and %Issues% (number of file shares in the job that have finished with the **Warning** or **Failed** status).

ii. Select the **Notify on success**, **Notify on warning**, and/or **Notify on error** check boxes to receive email notification if the job completes successfully, fails, completes with a warning or is waiting for the tape to get available.

iii. Select the **Suppress notifications until the last retry** check box to receive a notification about the final job status. If you do not enable this option, Veeam Backup & Replication will send one notification per every job retry.

### Script Settings

You can configure custom scripts to run before or after the file share backup job. For example, you can configure scripts to take a VSS snapshot before running the job and to delete it after completing the job.

To specify script settings for the backup job:

1. At the **Storage** step of the wizard, click **Advanced**.
2. Click the **Scripts** tab.
3. If you want to execute custom scripts, select the **Run the following script before the job** and **Run the following script after the job** check boxes and click **Browse** to choose executable files from a local folder on the backup server. The scripts are executed on the backup server.

You can select to execute pre- and post-backup actions after a number of backup sessions or on specific week days.

- If you select the **Run scripts every <N> backup session** option, specify the number of the backup job sessions after which the scripts must be executed.

- If you select the **Run scripts on the selected days only** option, click **Days** and specify week days on which the scripts must be executed.
Step 6. Specify Secondary Repository

At the **Secondary Target** step of the wizard, you can specify a secondary repository that will be used to store additional copies of backup files from the backup storage for redundancy. If you add a secondary repository, Veeam Backup & Replication will create a separate job for backup copy to it. The data copy process will start automatically after each primary job runs.

**NOTE:**

To learn what storage types you can assign the role of the secondary repository to, see [NAS Backup Support](#).

To add a secondary repository:

1. Click **Add**.
2. From the list of existing repositories, select a repository that will keep additional copy of the backup files. You can add several secondary repositories for copying files of the primary backup job. To quickly find the repository, use the search field at the bottom of the wizard.

3. By default, retention and encryption settings for the secondary target repository are inherited from the primary job. To customize them, select the necessary repository in the **Secondary repositories** list and click **Edit**.
   - To enable custom retention settings:
     1. Select **Use custom retention policy**.
     2. Specify how long all versions of each file will be kept in the secondary repository.
   - To specify encryption settings different from those of the primary repository:
i. Select **Use custom data encryption settings**.

ii. In the **Password** field, select a password that you want to use for encryption. If you have not created the password beforehand, click **Add** or use the **Manage passwords** link to specify a new password. For more information, see **Managing Passwords for Data Encryption**.

If the backup server is not connected to Veeam Backup Enterprise Manager and does not have the Enterprise or Enterprise Plus license installed, you will not be able to restore data from encrypted backups in case you lose the password. Veeam Backup & Replication will display a warning about it. For more information, see **Decrypting Data Without Password**.

- Configure time intervals at which the data can be copied to the secondary repository.
  - If you select the **Any time (continuously)** option, Veeam Backup & Replication will copy backup files to the secondary repository as soon as the primary file share backup job completes.
  - If you want to specify time periods when copying backup to the secondary repository is permitted, select the **During the following time periods only** option and configure allowed and prohibited hours.
Step 7. Define Job Schedule

At the Schedule step of the wizard, select to run the backup job manually or schedule the job to run on a regular basis.

To specify the job schedule:

1. Select the Run the job automatically check box. If this check box is not selected, you will have to start the job manually to create the file share backup.

2. Define scheduling settings for the job:
   - To run the job at specific time daily, on defined week days or with specific periodicity, select Daily at this time. Use the fields on the right to configure the necessary schedule.
   - To run the job once a month on specific days, select Monthly at this time. Use the fields on the right to configure the necessary schedule.

   **NOTE:**
   When you configure the job schedule, keep in mind possible date and time changes (for example, related to daylight saving time transition).

   - To run the job repeatedly throughout a day with a specific time interval, select Periodically every. In the field on the right, select the necessary time unit: Hours or Minutes. Click Schedule and use the time table to define the permitted time window for the job. In the Start time within an hour field, specify the exact time when the job must start.

   A repeatedly run job is started by the following rules:
   - Veeam Backup & Replication always starts counting defined intervals from 12:00 AM. For example, if you configure to run a job with a 4-hour interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 PM and so on.
   - If you define permitted hours for the job, after the denied interval is over, Veeam Backup & Replication will immediately start the job and then run the job by the defined schedule.

   For example, you have configured a job to run with a 2-hour interval and defined permitted hours from 9:00 AM to 5:00 PM. According to the rules above, the job will first run at 9:00 AM, when the denied period is over. After that, the job will run at 10:00 AM, 12:00 PM, 2:00 PM and 4:00 PM.

   - To run the job continuously, select the Periodically every option and choose Continuously from the list on the right. A new backup job session will start as soon as the previous backup job session finishes.

   - To chain jobs, use the After this job field. In the common practice, jobs start one after another: when job A finishes, job B starts and so on. If you want to create a chain of jobs, you must define the time schedule for the first job in the chain. For the rest of the jobs in the chain, select the After this job option and choose the preceding job from the list.

3. In the Automatic retry section, define whether Veeam Backup & Replication must attempt to run the backup job again if the job fails for some reason. During a job retry, Veeam Backup & Replication processes failed file shares only. Enter the number of attempts to run the job and define time intervals between them. If you select continuous backup, Veeam Backup & Replication will retry the job for the defined number of times without any time intervals between the job runs.
4. In the **Backup window** section, define the time interval within which the backup job must complete. The backup window prevents the job from overlapping with production hours and ensures that the job does not provide unwanted overhead on the production environment. To set up a backup window for the job:

   a. Select the **Terminate job if it exceeds allowed backup window** check box and click **Window**.

   b. In the **Time Periods** section, define the allowed hours and prohibited hours for backup. If the job exceeds the allowed window, it will be automatically terminated.

**NOTE:**

The **After this job** function will automatically start a job if the first job in the chain is started automatically by schedule. If you start the first job manually, Veeam Backup & Replication will display a notification. You will be able to choose whether Veeam Backup & Replication must start the chained job as well.

![New File Backup Job](image)

*Schedule*

Specify the schedule options. If you do not set the schedule, the job will need to be controlled manually.

<table>
<thead>
<tr>
<th>Name</th>
<th>Files and Folders</th>
<th>Storage</th>
<th>Secondary Target</th>
<th>Schedule</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Run the job automatically</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Daily at this time:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monthly at this time:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Periodically every:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>After this job:</td>
<td>QA02 Backup (Daily backup job for QA02)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Automatic retry**

- Retry failed items processing: 1 times
- Wait before each retry attempt for 10 minutes

**Backup window**

- Terminate job if it exceeds allowed backup window

If the job does not complete within allocated backup window, it will be terminated to prevent snapshot commit during production hours.
Step 8. Finish Working with Wizard

At the Summary step of the wizard, complete the procedure of backup job configuration.

1. Review details of the backup job.

2. Select the Run the job when I click Finish check box if you want to start the job right after you finish working with the wizard.

3. Click Finish to close the wizard.
Starting New Backup Chain

You can start a new backup chain for the file share backup job. Veeam Backup & Replication then creates a new active full backup that starts the new chain for the entire file share. All existing backup files are moved to the Disk (Imported) node under the Backups node in the Veeam Backup & Replication Console. Data files are stored to the same folder in the backup repository. The data files for the new backup chain are stored to a new separate folder in the backup repository.

To start a new backup chain:

1. Open the Home view.
2. In the inventory pane, select Jobs.
3. In the working area, select a job of the File Backup type, press and hold the [Ctrl] key, right-click the job and select Start new backup.
Health Check for File Share Backup Files

You can manually perform a health check for the latest restore point in the backup chain. During the health check, Veeam Backup & Replication performs a CRC check for metadata and a hash check for data blocks in backup files to verify their integrity. The health check helps make sure that the restore point is consistent, and you will be able to restore data from this restore point.

To run the health check:

1. Open the **Home** view.
2. In the inventory pane, select **Jobs**.
3. In the working area, select a job of the **File Backup** type and click **Run Health Check** on the ribbon or right-click the job and select **Run health check**.

To run the health check periodically, you must enable the **Perform backup files health check** option in the backup job settings and define the health check schedule. By default, the health check is performed on the last Friday of every month. You can change the schedule and run the health check weekly or monthly on specific days. To learn how to configure periodic health check, see **Maintenance Settings**.
Viewing File Share Backup Properties

You can view summary information about the file share backup. The summary information provides the following data:

- Name and path to the backup repository that stores file share backup files.
- Name and path to the archive repository that stores archived backup data.
- Path to the file share backup source and its original size.
- Available restore points: date of their creation, their type (Backup or Archive) and status.

For the Backup type, the table shows all restore points stored in the backup repository. You can restore the file share to the state as of any of these points. To learn how to restore the file share, see File Share Data Recovery.

For the Archive type, the table shows only a single record. The time stamp of this record denotes the date and time of the restore point, which was created in the backup repository and files of which were the latest to be moved to the archive repository according to retention settings. To learn how to restore files from the archive, see Restoring Backup Files from Archive Repository.

To view summary information for backups:

1. Open the Home view.
2. In the inventory pane, select Backups.
3. In the working area, right-click the backup and select Properties.
4. To see the list of available restore points, select the required object from the Objects list.
File Share Data Recovery

You can restore data previously backed up with file share backup jobs. You can restore the following data:

- SMB file share files and folders
- NFS file share files and folders
- Files and folders of a managed Microsoft Windows server
- Files and folders of a managed Linux server

Veeam Backup & Replication offers several recovery options for different recovery scenarios:

- **Restore of the entire file share** allows you to recover all files and folders of the file share to one of the restore points.
- **Rollback to a point in time** allows you to restore only changed files to one of the restore points.
- **Restore of files and folders** allows you to select files and folders to restore to one of the restore points.
Restoring Entire File Share

You can restore the entire file share from the backup to a specific restore point. That can be helpful, for example, if your file share device gets out of order and you need to restore the entire file share to the original or other location.

Before you restore an entire file share, check prerequisites.

Before You Begin

Before you restore the entire file share, consider the following:

- You can restore files and folders of the file share from a backup that has at least one successfully created restore point.
- The file share on which you plan to save restored files and folders must be added to the backup infrastructure.
Step 1. Launch File Restore Wizard

To launch the **File Restore** wizard, do one of the following:

- On the **Home** tab, click **Restore > File Share > Restore entire share**.
- Open the **Home** view. In the inventory pane, select **Backups**. In the working area, expand the necessary backup and do one of the following:
  - Click the file share that you want to restore and click **File Share > Restore entire file share** on the ribbon.
  - Right-click the file share that you want to restore and select **Restore > Entire file share**.

In this case, you will pass to the **Restore Point** step of the wizard.

You can restore the file share to the state as of a specific restore point by using a backup copy. Backup copies created in the secondary repositories are represented in the **Backups > Disk (Copy)** node in the inventory pane.
Step 2. Select File Share to Restore

At the **Backup** step of the wizard, select the file share that you want to restore:

1. In the **Object to restore** list, expand the necessary backup job.
2. Select the file share.

To quickly find a file share, you can use the search field at the bottom of the window.

1. Enter a file share name or a part of it in the search field.
2. Click the **Start search** button on the right or press [Enter].
Step 3. Select Restore Point

At the **Restore Point** step of the wizard, select the restore point from which you want to restore the file share. To select the required restore point, do one of the following:

- **Use the **Restore point** slider.**
- **Click the date link under the **Restore point** slider.** In the calendar in the left pane of the **Restore points** window, select the date when the required restore point was created. The list of restore points on the right pane displays restore points created on the selected date. Select the point to which you want to restore the file share.

In the **Files in backup** tree, you can see what folders and files are covered by the selected restore point and the date when files and folders were modified.

![File restore](image)

In the **File restore** window, you can see the restore point selected, the date when the restore point was created, and a list of files and folders covered by the restore point. You can click on the dates to open the calendar and select the date when the restore point was created. The list of files and folders includes their names, dates of modification, and types (folder or file).
Step 4. Specify Destination for Data Restore

At the Destination step of the wizard, specify the location to which you want to restore the file share.

- Select Original location to restore data to the location where it resided originally. This type of restore is only possible if the original device is connected to Veeam Backup & Replication and powered on.

- Select This server to restore data to another location:
  
a. In the This server field, select a file share to which files must be restored. You can select any file share added to the backup inventory. If the required file share is missing in the drop-down list, click Add and add a new file share to Veeam Backup & Replication. For more information on how to add a new file share, see File Share.

b. In the Path to folder field, specify a path to the folder on the selected file share where files must be restored.

To select a specific folder on the file share to restore files to, click Browse, in the Select Folder window, select the target location for the file share.

If you want to restore the file share to a new folder, click New Folder at the bottom of the window, enter the folder name and click OK to confirm the new folder creation.
Step 5. Specify Restore Options

At the **Restore Options** step of the wizard, specify overwrite options in case the file with the same name already exists in the target folder:

- **Skip restoring (keeps the existing file).** Select this option if you do not want to overwrite the existing file with the restored one.

- **Replace older files only (use if a share was reverted to a storage snapshot).** Select this option if you want to overwrite the existing file only if it is older than the restored file.

- **Replace newer files only (use to discard unwanted contents changes).** Select this option if you want to overwrite the existing file only if the restored file is older than the source share file.

- **Restore anyway (overwrites the existing file).** Select this option if you want to overwrite the existing file with the restored file in all cases.

Select the **Restore permissions and security attributes** check box if you want the restored files to keep their original ownership and security permissions. If you do not select this check box, Veeam Backup & Replication will change security settings. The user account under which the Veeam Backup Service runs will be set as the owner of the restored objects. Access permissions will be inherited from the target folder to which the objects are restored.
Step 6. Finish Working with Wizard

At the **Summary** step of the wizard, review the file share restore settings and click **Finish**. Veeam Backup & Replication will restore the file share to the specified location.
Rolling Back to a Point in Time

You can roll back changes made to files and folders on the file share to a specific restore point. This option can be useful, for example, when the original file share was attacked by ransomware. In this case you can roll back all the files that were changed by the ransomware to the state before the attack.

Before you roll back the file share to a point in time, check prerequisites.

Before You Begin

Before you restore files and folders to a point in time, mind that you can restore files and folders of the file share from a backup that has at least one successfully created restore point.
Step 1. Launch File Restore Wizard

To launch the **File Restore** wizard, do one of the following:

- On the **Home** tab, click **Restore > File Share > Rollback to a point in time**.
- Open the **Home** view. In the inventory pane, select **Backups**. In the working area, expand the necessary backup and do one of the following:
  - Click the file share backup whose files you want to restore and click **File Share > Rollback to a point in time** on the ribbon.
  - Right-click the file share backup whose files you want to restore and select **Restore > Rollback to a point in time**.

In this case, you will pass to the **Restore Point** step of the wizard.

You can roll back the file share to a point in time by using a backup copy. Backup copies created in the secondary repositories are represented in the **Backups > Disk (Copy)** node in the inventory pane.
Step 2. Select Object to Restore

At the **Backup** step of the wizard, select the file share whose files you want to roll back:

1. In the **Object to restore** list, expand the necessary backup job.
2. Select the file share.

To quickly find a file share, you can use the search field at the bottom of the window.

1. Enter a file share name or a part of it in the search field.
2. Click the **Start search** button on the right or press [Enter].

---

**File restore**

<table>
<thead>
<tr>
<th>Backup</th>
<th>Object to restore</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Point</td>
<td>Job name</td>
</tr>
<tr>
<td>Summary</td>
<td>QA DB</td>
</tr>
<tr>
<td></td>
<td>File server DB (SMB)</td>
</tr>
<tr>
<td></td>
<td>\FILESERVER\Documents</td>
</tr>
</tbody>
</table>

- Type in an object name to search for
Step 3. Select Restore Point

At the Restore Point step of the wizard, select the restore point to which you want to roll back the files. To select the required restore point, do one of the following:

- Use the Restore point slider.
- Click the date link under the Restore point slider. In the calendar in the right pane of the Restore points window, select the date when the required restore point was created. The list of restore points on the left pane displays restore points created on the selected date. Select the point to which you want to roll back the files to.

In the Files in backup tree, you can see what folders and files are covered by the selected restore point and the date when each of them was modified.
Step 4. Finish Working with Wizard

At the **Summary** step of the wizard, review the file share restore settings and click **Finish**. Veeam Backup & Replication will restore the files to the specified point in time.
Restoring Specific Files and Folders

You can restore specific files and folders to the original or a new location. This option can be useful, for example, if you need to get an older version of some files and folders from the backup.

When you restore specific files and folders you can extract file versions not only from the backup repository, but also from the archive repository. Besides, you can restore multiple versions of the same file.

Before you restore specific files and folders, check prerequisites.

Before You Begin

Before you restore files and folders from the backup, mind the following:

- You can restore files and folders from a backup that has at least one created restore point, even if it is incomplete.
- The file share on which you plan to save restored files and folders must be added to the backup infrastructure.
Step 1. Launch File Restore Wizard

To launch the File Restore wizard, do one of the following:

- On the Home tab, click Restore > File > Restore individual files and folders.
- Open the Home view. In the inventory pane, select Backups. In the working area, expand the necessary backup and do one of the following:
  - Click the file share backup whose files you want to restore and click File Share > Restore files and folders on the ribbon.
  - Right-click the file share backup whose files you want to restore and select Restore > Files and folders.
In this case, you will pass directly to the Backup Browser.

You can restore files and folders from a backup copy. Backup copies created in the secondary repositories are represented in the Backups > Disk (Copy) node in the inventory pane.
Step 2. Select Object to Restore

At the **Backup** step of the wizard, select the file share backup whose files you want to restore:

1. In the **Object to restore** list, expand the necessary backup job.
2. Select the file share.

To quickly find a file share, you can use the search field at the bottom of the window.

1. Enter a file share name or a part of it in the search field.
2. Click the **Start search** button on the right or press [Enter].
Step 3. Verify Restore Object Settings

At the **Summary** step of the wizard, review selected restore object and click **Finish** to switch to the **Backup Browser** and select files and folders to restore.
Step 4. Select Files and Folders to Restore

In the Backup Browser, select files and folders to restore. Backup browser has three representations of restore points. You can select one of the following options in the Restore Point group on the ribbon to display file versions:

- **Latest** – the Backup Browser shows the latest versions of files and folders on the file share.

- **All Time** – the Backup Browser shows all files and folders ever backed up by the backup job. This option retrieves file versions stored both in the backup and archive repositories. This representation additionally shows how many file versions of each file are stored in the backup and the date when the latest file version was created.

After you select this option:

- If you restore a whole folder, you will be prompted to the Select Restore Point to Use step to select a restore point to restore files and folders from.

  **NOTE**
  
  Mind that during file-level restore you cannot restore whole folders from the archive restore points. If the files are already moved to the archive repository, you have to restore them one by one.

- If you restore a single file, you will be prompted to the Select File Version to Restore step to select a file version to restore the file from.

- **Selected** – the Backup Browser shows versions of files and folders backed up as of the certain restore point. Select the restore point in the list on the right of the Selected option on the ribbon.

You can use the search field at the top of the working area to search for specific files and folders.

**NOTE:**

In order to keep the operation of the Backup Server stable, the number of retrieved search result records is limited to 1000. Therefore, if you work with backup folders that store large volumes of data, it is recommended to narrow the search criteria to fit into the limitation.

You can restore files and folders to their original location or a new location.

### Restoring Files to Original Location

To restore files and folders to the original location, in the Veeam Backup browser right-click a file or folder and select one of the following commands:

- To overwrite the original file on the file share with the file restored from the backup, select **Restore > Overwrite**.
• To save the file restored from the backup next to the original file, select *Restore > Keep*.

Veeam Backup & Replication will add the `_RESTORED_YYYYMMDD_HHMMSS` suffix to the original file name and store the restored file in the same folder where the original file resides.

### Saving Files to New Location

To save files and folders to a new location, right-click the necessary file or folder and select *Copy To*. If you restore files and folders to a new location, you will be prompted to the *Specify Destination for File Restore* step to specify a new destination.
Step 5. Select Restore Point

The **Restore Point** step is required if you use the **All Time** option at the **Select Files and Folders to Restore** step and the selected folders have more than one restore point.

Specify the restore point to which you want to restore files and folders:

- To restore the folder to the latest available restore point, select **Latest state**.
- To select a specific restore point, select **Earlier restore point**, click **Next** and specify the restore point. To select the required restore point, do one of the following:
  
  o Use the **Restore point** slider.
  
  o Click the date link under the **Restore point** slider. In the calendar in the left pane of the **Restore points** window, select the date when the required restore point was created. The list of restore points on the left pane displays restore points created on the selected date. Select the point to which you want to restore the file share.

In the **Files in backup** tree, you can see what folders and files are covered by the selected restore point and the date when files and folders were modified.
Step 6. Select File Version to Restore

The **File Version** step is required if you use the **All Time** option at the **Select Files and Folders to Restore** step and the selected files have more than one file version.

Select one or more versions to restore. You can restore files both from the backup repository and archive repository. To select several file versions, hold [Ctrl] and select multiple records in the table. Restore of multiple file versions can be helpful, for example, when you need to search for a specific version of the file, but you do not know for sure which one contains required changes.

![File Version GUI](image-url)
Step 7. Specify Destination for File Restore

The Destination step is required if you choose the Copy To option at the Select Files and Folders to Restore step. Specify the destination where the restored files must be stored:

1. In the Restore files and folders to field, select a file share to which the files must be restored. All file shares added to the inventory of Veeam Backup & Replication are available. If the required file share is missing in the drop-down list, click Add and add a new file share to Veeam Backup & Replication.

   For more information on how to add a new file share, see Adding File Share.

2. In the Path to folder field, specify a path to the folder on the selected file share where files must be restored.

   To create a dedicated folder for restored files, click Browse. In the Select Folder window, select the target location for the file share.

   If you want to restore the file share to a new folder, click New Folder at the bottom of the window. Confirm the new folder creation.
Step 8. Finish Working with Wizard

At the **Summary** step of the wizard, review the file restore settings and click **Finish**.

![Image of the Summary step in the Veeam Backup & Replication User Guide for Microsoft Hyper-V](image-url)

### Summary

- **File Version:** 2/15/2019 6:00:36 AM
- **Destination:** Server qa09/techlocal
- **Path to folder:** C:\Backup Restore\files005
Restoring Backup Files from Archive Repository

You can restore any file from the archive repository to the state of any file version stored in the archive. Depending on the circumstances, such a restore can require different actions.

Regular Restore from Archive

To perform a regular restore from the archive repository when you have all required backup data stored both in the backup repository and archive repository, follow the instructions given in Restoring Specific Files and Folders. Mind that to restore data from the archive repository, you must select the All Time option for selecting files and folders to restore.

Emergency Restore from Archive

There can be different situations where backups are not available in the backup repository: for example, backup files are broken or deleted from the backup repository, backup configuration files are removed from the configuration, archive repository is added into backup infrastructure of another backup server, or backup archive is moved from one archive repository to another one. In these cases, you can restore specific files and folders from the backup archive.

To restore files from the archive repository, for example, from an object storage:

1. If necessary, add the storage that keeps the required archive to the backup infrastructure as described in Adding Backup Repositories.
2. Rescan the added archive repository as described in Rescanning Backup Repositories.
3. Download metadata for the archive backup:
   a. Locate the required file backup archive under Backups - Disk (Imported) node in the Home view.
   b. Right-click the file backup and select Download backup metadata.
c. From the drop-down list, select a backup repository to store the downloaded metadata of files archive and click **OK**.

4. Restore files and folders from the archive backup as described in *Restoring Specific Files and Folders*. 
Integration with Veeam Backup for AWS

Veeam Backup & Replication allows you to create and manage data protection and restore tasks for Amazon Elastic Compute Cloud (Amazon EC2) environments. For this, you need to install a Plug-in for Veeam Backup for AWS component. This component extends Veeam Backup & Replication functionality and provides access to Veeam Backup for AWS from the Veeam Backup & Replication console. For more information, see the Integration with Veeam Backup for AWS User Guide.
Veeam Agent Management

Veeam Backup & Replication lets you deploy and manage Veeam Agent for Microsoft Windows and Veeam Agent for Linux (Veeam Agents) on computers in your infrastructure.

For more information about Veeam Agents, see the Veeam Agent Management Guide.
Veeam Cloud Connect

If you want to store your data in the cloud, you can connect to the service provider and write VM backups to cloud repositories or create VM replicas on cloud hosts.

For more information about Veeam Cloud Connect, see the Veeam Cloud Connect Guide.
Veeam Backup & Replication Utilities

You can use the following Veeam Backup & Replication utilities to perform advanced administration tasks in your backup infrastructure:

- Extract.exe utility
- Veeam.Backup.DBCfg.exe utility
- Veeam backup validator
Extract Utility

Veeam Backup & Replication comes with an extract utility that can be used to recover machines from backup files. The extract utility does not require any interaction with Veeam Backup & Replication and can be used as an independent tool on Linux and Microsoft Windows machines.

The extract utility can be helpful, for example, if it is written to the tape next to machine backup files. In this case, you get a possibility to recover machines from backups at any moment of time even if backups are removed from Veeam Backup & Replication or Veeam Backup & Replication is uninstalled at all.

IMPORTANT!
The extract utility does not work with backups that are stored in scale-out backup repositories.

The extract utility can be used in two interfaces:

- Graphic user interface (GUI)
- Command-line interface working in the interactive and regular mode

The extract utility is located in the installation folder of Veeam Backup & Replication, by default: %PROGRAMFILES%\Veeam\Backup and Replication\Backup. The folder contains two files for the extract utility:

- Veeam.Backup.Extractor.exe — utility working in GUI (can be used on Microsoft Windows machines only)
- extract.exe — utility working in the command-line interface, a version for Microsoft Windows
Using Extract Utility in GUI

To restore machine data in the extract utility GUI:

2. In the Backup file field, specify a path to the backup file from which you want to restore machine data.
3. If the backup file is encrypted, the extract utility will require you to provide a password to unlock the backup file. Enter the password that was used for backup file encryption.
4. In the Target folder field, specify a path to the destination folder where machine data must be restored.
5. From the Machines list, select machines whose data you want to restore.
6. Click Extract. Machine data will be restored to the specified folder.

IMPORTANT!

If you restore machine data in the extract utility GUI, consider the following:

- The extract utility can be started on Microsoft Windows machines only.
- If you plan to start the extract utility on the machine other than the backup server, make sure that you copy the Veeam.Backup.Extractor.exe file together with the extract.exe file from the product installation folder and store these files to the same folder on the destination machine. In the opposite case, the extract utility will fail to start.

![Veeam Backup Extraction Utility dialog box](image.png)
Using Extract Utility in Interactive Mode

To start the extract utility in the interactive mode, run the `extract.exe` file from the product installation folder).

You will have to sequentially enter the following arguments:

1. A path to the backup file from which the machine must be restored. After you enter the path, the extract utility will display a list of all machines included in the backup and their description.

2. A name of the machine that you want to restore. If there is more than one machine with the specified name in the backup, you will be asked to specify the host on which the backed-up machine resides. If you want to restore all machines from the backup, press [Enter] on the keyboard.

3. If the backup was encrypted, password that was used to encrypt the backup file.

4. An output directory to which machines must be restored. If you want to restore machines to the current directory, press [Enter] on the keyboard.

5. The operation confirmation. Press [Y] on the keyboard to restore a machine to the directory you specified. If you want to abort the operation, press [Enter] on the keyboard.
Using Extract Utility from Command Line

To run the extract utility from the command line, do one of the following:

- In the command line, change the current directory to the directory where the extract utility locates.
- Add the directory where the extract utility locates to the PATH variable.

Then you can perform the following actions:

- Run the extract utility in the interactive mode
- Display help information for the utility usage
- Display the list of all VMs in the backup file
- Getting encryption status of a backup file
- Restore all or selected VMs from the backup

Running Extract Utility in Interactive Mode

This command runs the extract utility in the interactive mode.

Syntax

```
extract.exe [-password backupkey] [path to backup]
```

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Required/Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>password</td>
<td>Password for the encrypted backup file.</td>
<td>Required for encrypted backup files</td>
</tr>
<tr>
<td>path to backup</td>
<td>Path to the backup file from which machines must be restored.</td>
<td>Optional</td>
</tr>
</tbody>
</table>

Displaying Help Information for Utility Usage

This command prints all variants of the extract utility usage along with required and optional parameters.

Syntax

```
extract.exe -help
```
Displaying List of Machines in Backup

This command displays the list of all machines in the backup file from which you want to perform restore.

Syntax

```
extract.exe -dir [-vm vmname] [-host hostname] [-password backupkey] pathtobackup
```

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Required/Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>vm</td>
<td>Name of the machine that you want to restore. Use this parameter to filter machines in the backup.</td>
<td>Optional</td>
</tr>
<tr>
<td>host</td>
<td>Name of the host on which the initial machine resides. Specify this parameter to filter machines that have the same name but reside on different hosts. Note: This parameter must be specified if the vm parameter is used.</td>
<td>Optional</td>
</tr>
<tr>
<td>password</td>
<td>Password for the encrypted backup file.</td>
<td>Required for encrypted backup files</td>
</tr>
<tr>
<td>pathtobackup</td>
<td>Path to the backup file from which the machine must be restored.</td>
<td>Required</td>
</tr>
</tbody>
</table>

Getting Encryption Status of Backup File

This command gets the encryption status of the backup file: encrypted or not encrypted.

Syntax

```
extract.exe -getEncryptionStatus pathtobackup
```
Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Required/Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>path to backup</td>
<td>Path to the backup file from which the machine must be restored.</td>
<td>Required</td>
</tr>
</tbody>
</table>

Restoring VMs from Backup

This command restores data for all machines or for the selected machine from the backup file.

Syntax

extract.exe -restore [-vm vmname] [-host hostname] [-password backupkey] path to backup [outputdir]

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Required/Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>vm</td>
<td>Name of the machine that you want to restore. Use this parameter to filter machines in the backup. If you want to restore all machines from the backup file, do not specify this parameter.</td>
<td>Optional</td>
</tr>
<tr>
<td>host</td>
<td>Name of the host on which the initial machine resides. Specify this parameter to filter machines that have the same name but reside on different hosts. Note: This parameter must be specified if the vm parameter is used.</td>
<td>Optional</td>
</tr>
<tr>
<td>path to backup</td>
<td>Path to the backup file from which the machine must be restored.</td>
<td>Required</td>
</tr>
<tr>
<td>password</td>
<td>Password for the encrypted backup file.</td>
<td>Required for encrypted backup files</td>
</tr>
<tr>
<td>outputdir</td>
<td>Path to the directory to which machine data must be restored. If this parameter is not specified, the machine will be restored to the current directory.</td>
<td>Optional</td>
</tr>
</tbody>
</table>
Veeam Backup & Replication comes with the `Veeam.Backup.DBConfig.exe` utility that allows you to manage connection settings for Veeam Backup & Replication and/or Veeam Backup Enterprise Manager configuration database. Using this utility, you can:

- Connect to a different database on the same or another Microsoft SQL Server instance. If you specify a database that does not exist yet, it will be created on the selected server.
- Change authentication method for database connection. Possible methods are Microsoft Windows authentication and Microsoft SQL server authentication.

**NOTE:**
The `Veeam.Backup.DBConfig.exe` utility supports only connection to configuration databases of the current version.
Using Veeam.Backup.DBConfig.exe Utility

You can launch the Veeam.Backup.DBConfig.exe utility from the Start menu by clicking Configuration Database Connection Settings.

Alternatively, you can use the Veeam.Backup.DBConfig.exe file located in the installation folder. By default, the path to the folder is the following: %PROGRAMFILES%\Common Files\Veeam\Backup and Replication\DBConfig

To run the utility, you must have administrative rights on the local machine, as long as the utility makes changes to the registry. If prompted at the launch, choose Run as administrator.

To manage connection settings for Veeam Backup & Replication and/or Veeam Backup Enterprise Manager configuration database, use the launched Veeam Backup & Replication Configuration Database Connection Settings wizard.
Step 1. Select Product

At the **Product** step of the wizard, select the database whose settings you want to configure.

The utility detects what server is installed on the local machine (backup server, Veeam Backup Enterprise Manager server or both) and displays available products for your choice. If Veeam Backup Enterprise Manager is not installed on the local machine, you will only have an opportunity to change Veeam Backup & Replication database settings (and vice versa). In this case, the **Product** step of the wizard will be skipped.

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veeam Backup and Replication</td>
<td>Update configuration database connection settings for Veeam Backup &amp; Replication server.</td>
</tr>
<tr>
<td>Veeam Backup Enterprise Manager</td>
<td>Update configuration database connection settings for Veeam Backup Enterprise Manager server.</td>
</tr>
</tbody>
</table>
Step 2. Specify Connection Settings

At the **Connection Settings** step of the wizard, provide the connection settings for the selected database.

1. Specify the Microsoft SQL Server\instance and database name to which you want the Veeam Backup & Replication installation to connect. Both local and remote Microsoft SQL server instances are supported. Microsoft SQL server instances available on the network are shown in the **Server name** list. If necessary, click **Refresh** to get the latest information.

   If a database with the specified name does not exist on the selected Microsoft SQL Server (instance), it will be created anew.

2. Select the authentication method that will be used for database connection:
   - If you plan to use the Microsoft Windows authentication, consider that the current service account will be used (that is, the account under which the Veeam Backup Service is running).
   - If you plan to use the Microsoft SQL authentication, provide a login name and password. To view the entered password, click and hold the eye icon on the right of the **Password** field.

![Veeam Backup and Replication Configuration Database Connection Settings](image)
Step 3. Apply Connection Settings

Before proceeding, the utility validates the specified settings to make sure that the user account has enough privileges to access the database.

- If you have selected the Microsoft Windows authentication method, the utility will check the privileges of the current user account (that is, the account under which the utility is running) to connect to specified Microsoft SQL server.

- If you have selected the Microsoft SQL authentication method, the utility will check the privileges of the account you have specified.

To ensure that these accounts (as well as the account under which the Veeam Backup Service is running) have sufficient privileges for database access, you can contact your database administrator. Refer to the list of system requirements for Veeam Backup & Replication for detailed information about required permission.

For the new settings to be applied, the utility needs to stop Veeam Backup & Replication services and jobs that are currently running. Before proceeding to the Apply step, you must confirm the operation. For example, if you are configuring Veeam Backup & Replication database settings, the following prompt will be displayed.

Confirm the operation by clicking Yes and wait for the services to be stopped. Then database connection settings will be applied, and you can view the operation progress in the log.
Wait for the operation to complete and click **Next** to proceed to the **Summary** step of the wizard. Previously stopped services will be started again at this moment.
Step 4. Finish Working with Wizard

At the **Summary** step of the wizard, view the information about the changes in database connection settings. If you were configuring Veeam Backup & Replication database settings and you want the Veeam backup management console to be open automatically after you finish working with the wizard, select the **Start the product automatically** check box.

**NOTE:**

The **Start the product automatically** option is not available for Veeam Backup Enterprise Manager.
Veeam Backup Validator

In some cases, a backup can get corrupted due to accidental changes in the backup file data. For example, the file can be damaged after transfer over the network or from hardware failures on the backup storage side. With Veeam Backup Validator, you can quickly verify the integrity of any backup file, without extracting the VM data from the archive.

Veeam Backup Validator is a command-prompt CRC check utility that tests a backup at the file level. For integrity validation, Veeam Backup Validator uses the checksum algorithm. When Veeam Backup & Replication creates a backup of a VM, it calculates a checksum for every data block in the backup file and attaches these checksums to the data blocks. Veeam Backup Validator re-calculates checksums for data blocks and compares them against the initial checksum values. If the results match, the backup file is viable. This works similarly to the backup file integrity check performed at SureBackup.

Veeam Backup Validator is located in the installation folder of Veeam Backup & Replication — by default, %ProgramFiles%\Veeam\Backup and Replication\Backup\Veeam.Backup.Validator.exe.

If the default path was changed, you can find the actual path in the registry value:
[HKEY_LOCAL_MACHINE\SOFTWARE\Veeam\Veeam Backup and Replication\CorePath]
Working with Veeam Backup Validator

You can run the utility from the command prompt on the backup server, the machine on which Veeam Backup & Replication is installed.

To run Veeam Backup Validator, an account with administrative rights is required.

To display Veeam Backup Validator help information, run the following command:

```
Veeam.Backup.Validator /?
```

- In the **Parameters** section, you will see the list of all possible parameters and their descriptions.
- In the **Examples** section, you will see the usage examples for each of these parameters:
Validating Content of Backup File

Syntax

The following command validates for integrity the content of all VMs or selected VMs in the specified backup:

```
```

The following command validates for integrity the content of VMs in the specified backup file:

```
```

**IMPORTANT!**

Veeam Backup Validator utility does not work with backups stored in scale-out backup repositories.

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Required/Optional</th>
<th>Parameter Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>/backup:backupname</td>
<td>Specify a name or an ID* of the backup file that you want to validate.</td>
<td>Required</td>
<td>String</td>
<td>—</td>
</tr>
<tr>
<td>backupID</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| /file:backupfile{1..*} | Specify one or more backup files (VBM, VBK, VIB).                  | Required          | String         | • If the file is located on a network share, make sure you specify a full path, for example: \\172.16.16.198\TestShare\Empty VM encryptedD2017-09-22T172639.vbk  
• Mapped network drives (like net use z: \\172.16.16.198\TestShare) are not supported. |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Required/Optional</th>
<th>Parameter Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>/username:</td>
<td>To access files on a network share, specify account credentials.</td>
<td>Required</td>
<td>String</td>
<td>If you want to validate files located on different shares, make sure this account has access rights to all these shares.</td>
</tr>
<tr>
<td>/password:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>/vmname:vmname</td>
<td>Specify a name of the VM in the backup file that you want to validate.</td>
<td>Optional</td>
<td>String</td>
<td>If not specified, Veeam Backup Validator will check all VMs in the backup file.</td>
</tr>
<tr>
<td>/point:pointID</td>
<td>Specify an ID* of the restore point that you want to validate.</td>
<td>Optional</td>
<td>String</td>
<td>If not specified, Veeam Backup Validator will verify the latest restore point.</td>
</tr>
<tr>
<td>/date:pointdate</td>
<td>Specify the date when the restore point that you want to validate was created.</td>
<td>Optional</td>
<td>Date</td>
<td>Make sure to specify the date in the same format as used on the Veeam Backup server. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• For the mm/dd/yyyy format, specify 08.30.2012.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• For the dd/mm/yyyy format, specify 30.08.2012.</td>
</tr>
<tr>
<td>/time:pointtime</td>
<td>Specify approximate time when the restore point you want to validate was created.</td>
<td>Optional</td>
<td>Time</td>
<td>—</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Required/Optional</td>
<td>Parameter Type</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>/silence</td>
<td>Specify this parameter if you want to run validation in the silence mode.</td>
<td>Optional</td>
<td>Boolean</td>
<td>—</td>
</tr>
<tr>
<td>/skip</td>
<td>Specify this parameter if you want to skip VMs listed in the vmname parameter.</td>
<td>Optional</td>
<td>Boolean</td>
<td>In the vmname parameter, list all VMs that you want to skip</td>
</tr>
<tr>
<td>/report:reportpath[/format:xml</td>
<td>html]</td>
<td>Specify this parameter if you want to generate a report on validation results and store it at the specified path.</td>
<td>Optional</td>
<td>String</td>
</tr>
</tbody>
</table>

* You can get IDs of backup jobs and restore points from the Veeam Backup & Replication database, for example, using scripts or using Management Studio.

**Example 1**

This command validates the exch01 VM in the Exchange Backup Job file.

```bash
```
Example 2

This command validates all VMs in the Exchange Backup Job file created on December 18, 2018 around 12:00 AM.

```
```